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FIRST THINGS FIRST

Copyright and Support Resources

5

Fox Village Dressage is produced by Fox Village Software®
Copyright © 1993-2021 Fox Village Software®

All Rights Reserved
Fox Village Software
2020 A St. SE, #101
Auburn, WA 98002

The Fox Village Dressage (FVD) software program is a fully functional dressage show management, online 
entry and scoring application.  It makes dressage show management and scoring simple.  The FVD staff 
designed this all-inclusive software package with the experience and know-how of some of the top show 
secretaries, managers, and organizers in the United States and Canada.  Now you can manage your 
competitions from beginning to end, from a schooling show or pony club rally to an international FEI CDI*** 
with wireless instant scoring capabilities in the judges' booths.  This software makes it easy.

New for 2021:  Click here for information.
Paperless Show Setup
Cloud Server Desktop

Support Resources:
Discussion Board Support (via Facebook):  https://www.facebook.com/profile.php?id=100057278425568.
Direct Email Support:  helpdesk@foxvillage.com.
Telephone Support: FVD staff offer 30-minute phone support for $25. If you need to set up a telephone 
support session, first purchase a support ticket (click here), then contact FVD by e-mail at 
helpdesk@foxvillage.com to schedule a telephone support session. They will reply to your e-mail as soon as 
possible to confirm your appointment.

User Manuals:
Quick Start User Manual: Click here.
Comprehensive User Manual (this manual): Click here.
Comprehensive DSHB User Manual: Click here.
Equestrian Entries Online Entries Guides: Click here.

Warning: This computer program is protected by copyright law and international treaties.  Unauthorized 
reproduction or distribution of this program, or any portion of it, may result in civil and criminal 
penalties, and will be prosecuted to the maximum extent possible under law.

FVD

https://www.foxvillage.com/post?id=22
https://www.facebook.com/profile.php?id=100057278425568
mailto:helpdesk@foxvillage.com
https://www.paypal.com/webapps/hermes?token=9NV71299BU901973R&useraction=commit&mfid=1637078868615_f355888f58ebb
mailto:helpdesk@foxvillage.com
http://www.foxvillage.com/FVDQuickStart.asp
http://www.foxvillage.com/FVDUserManual.asp
http://www.foxvillage.com/FVDUserManualDSHB.asp
http://www.foxvillage.com/FVDOnlineEntriesGuide.asp
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About the FVD User Manual
• The FVD User Manual was prepared by Leslie Raulin, a volunteer and a FVD user, with the assistance of the FVD 

developers (Pete Jorgensen and Ron Nitzinger) and Equestrian Entries staff (Georges Schneider). It was 
expanded from the original Handy Book written by Lothar Pinkers.   

• This manual concentrates on USEF licensed / USDF Recognized (USEF/USDF) dressage shows.  FVD and EE can 
also be used for Equine Canada, CDIs, schooling dressage shows, and dressage shows for other disciplines.

• The FVD User Manual assumes the user is familiar with the MS Windows operating system and its basic 
features and operation.   The manual was written using Windows 10 and Office 365.  If you use different 
versions, your screens and procedures will be somewhat different.

• The FVD User Manual is a comprehensive companion document to the FVD Quick Start.  You may want to 
begin with the FVD Quick Start.  If you need help or further information, refer to the FVD User Manual.  The 
FVD Quick Start chapter numbers match the FVD User Manual chapter numbers; therefore, if you are having 
difficulty in a particular FVD Quick Start chapter, go to the same chapter in the FVD User Manual for more 
details. 

• Do not let the size of the FVD User Manual concern you – the FVD program is easy to use!  However, the FVD 
User Manual is meant to be very comprehensive with step-by-step instructions, thus its size.   

• Although you may print the FVD User Manual, we recommend that you download and save it on your 
computer so you can readily use the PDF Bookmarks (the hyperlinked “Table of Contents” on the left-hand 
margin), the Search to readily find information you may need, and to use links built into the document (internet 
access required).  Also, since the FVD User Manual is comprehensive (= large), having it on your computer will 
be much easier than lugging around a big notebook!

• The FVD User Manual has the following basic organization:

o Sections I-IV – sequential steps to install and use the FVD program to run a dressage show.

o Section V Backup and Restore – information to backup and restore your program files.

o Section VI Appendices – additional information to assist in running your show with FVD.

o Section VII. Networking Computers – covers local networks and FVD Cloud Server.

o Section VIII (Program Functions) – explanation of each program function.

o Section IX (Tips & Tricks) – additional ideas to help you run your show.

• Additional information for Breed Shows is in the companion manual, the FVD DSHB User Manual.

• DISCLAIMER: Every effort is made to make the FVD Quick Start, FVD User Manual, and the FVD DSHB User 
Manual accurate and current; however, errors can occur, and rules change frequently.  It is your responsibility 
to always check the FEI, USEF, and USDF web sites for updated rules and guidance.

• For suggestions and comments about the FVD Program and to report errors or provide suggestions for the FVD 
Quick Start, FVD User Manual, or FVD  DSHB User Manual, please refer to the online FVD Support page (click 
here) and the FVD Facebook page (click here).

• Manual Conventions:

NOTES:  Comments about the current procedure being explained.  Notes are in peach-colored boxes with 
burnt orange outlines. 

USEF Rules:  When specific USEF rules apply to a FVD procedure, the rule is quoted in a yellow box with a gold 
outline.  It is recommended that you consult the online USEF rulebook to ensure the information is current.

o Red number and red bold text such as ❺ Rider:  A reference to a feature demonstrated on an adjacent 
graphic. 

o Black bold text such as Rider:  A reference to a specific FVD element or other key term without a specific 
reference to an adjacent graphic.

o Royal blue underlined click here is a hyperlink to a web site/page or online document.  

o Royal blue underlined text is a hyperlink to a topic in this document, such as Integration Between FVD and 
EE.

FIRST THINGS FIRST

https://www.foxvillage.com/Support
https://www.facebook.com/Foxvillage-Dressage-Software-83231149491/
http://www.foxvillage.com/
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FIRST THINGS FIRST

7

Integration Between Fox Village Dressage and Equestrian Entries

Fox Village Dressage
(FVD)

https://www.foxvillage.com

Equestrian Entries
(EE)

https://www.eqentries.com

Fox Village Dressage (FVD) is a show management 
desktop and online software program used by many 
dressage shows in the US, Canada and elsewhere.  The 
program has many features that allow the management 
of dressage show data, including People (Riders, 
Owners, Trainers, Coaches, etc.) and Horse data, show 
classes, stabling, entries, financial data, scheduling, 
scoring, show results, etc.  FVD data is easily sent 
electronically to USEF and USDF for their official show 
records.  It also provides online tools for people to view 
the status of a show real-time, sorted by Class or Rider, 
as well as rides available due to scratches.

Equestrian Entries (EE) consists of online tools used by 
show participants to enter dressage shows that use 
Fox Village Dressage for show management.  The EE 
online tools are used by People (Riders, Owners, 
Trainers, Coaches, etc.) to enter their data and their 
Horse data, including USEF and USDF People and Horses 
membership numbers.  The users also upload 
documents required by shows such as signed 
USEF/USDF release forms (signature page), Coggins, 
proof of vaccination, proof of SafeSport training, and 
other documents.  When notified of a new entry, the 
Show Secretary downloads the data into FVD.

The fact that FVD and EE integrate with each other simplifies data entry while ensuring 
more accurate data, which is critical for correct USEF and USDF official show records.

Show Entrant Using EE
to Submit an Entry

Show Secretary Using FVD
To Manage Show

INTEGRATED ONLINE ENTRIES

FVD EE

https://www.foxvillage.com/
https://www.eqentries.com/
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• For Show Managers:  
o Show Managers using FVD sign up their shows with EE, after which show participants can use EE to enter 

and pay for a show entry online.  The data is then easily downloaded into the show’s FVD database.  No 
more typing entries!  

o Cost - Accepting entries through EE costs show management NOTHING.
o Save Time
➢ Correct, legible entries.
➢ Direct feed into FVD; no more data entry.
➢ ALL required entry info included, or problems are noted.
➢ All people and horse memberships verified directly with USEF/USDF.
➢ All fees automatically calculated (including non-member fees).
➢ Each entry checked against USEF/USDF rules for correctness.
➢ Refunds done online while the show is open. 

o Customer Service
➢ Easy online entries.
➢ Accept credit card payments at NO COST to show/event owner.
➢ Easily get important updates/messages to competitors.
➢ Easily extend/shorten entry dates.
➢ Paid entries get to you in seconds, not days.

• For Show Participants:
o For a nominal fee, show participants can enter a show, provide all required documents (memberships, 

Coggins, proof of vaccination, USEF Waiver, USEF Entry Agreement, proof of eligibility, etc.), and pay, all 
in one easy procedure.

o No more rushing to the post office to mail last-minute information or documents as EE reminds the user 
of missing information, thereby ensuring all required information is provided or providing reminders that 
additional information is needed.

8

Integration Between Fox Village Dressage and Equestrian Entries, Cont’d.

FIRST THINGS FIRST

INTEGRATED ONLINE ENTRIES

INTEGRATED ONLINE ENTRIES

FVD EE
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Integration Between Fox Village Dressage and Equestrian Entries, Cont’d.

FIRST THINGS FIRST

INTRODUCTION:
• FVD integrates with Equestrian Entries (EE) to provide online entries.  This partnership between FVD and EE 

provides show management with (hopefully complete) entries and payment through EE.
• EE provides online entries for FVD-based shows, featuring: 
o Simple Interface for Show Management:
▪ Create show with FVD then upload to EE (step-by-step guided instructions are provided). 
▪ EE can be required or optional for entrants.
▪ After competitors enter your show via EE, import the EE entry data to FVD – no more hand data entry! 
▪ You then you review the entries. 
▪ Receive payment (at your chosen interval/time frame or when show closes) from EE for entries submitted 

and paid online.
o Easy Guided Entries for Competitors:
▪ Enter Rider/Owner/Trainer/Coach/Horse information once.
▪ Choose show. 
▪ Choose Rider/Owner/Trainer/Coach/Horse. 
▪ Choose Classes/Stabling/Shavings/Party Tickets, etc. 
▪ Submit and pay online or print and mail to show management with check (if allowed by show). 

• Open the EE web site (click here), particularly the FAQ (click here), to learn about EE and how it can provide 
an easy entry process for your competitors and a simpler data collection and payment process for your show. 

• To use online entries with EE, you need to:
o On the EE web site, establish an EE User Name and Password (see below).
o In FVD, REGISTER A SHOW WITH FVD. 
o In FVD, PUBLISH A SHOW WITH EE.
o In FVD, Import Entry into FVD.

OBTAIN AN EE USERNAME AND PASSWORD:
• Log on to EE (click here). 
• To learn more about EE, click the VIEW DEMO tab.
• Click the SHOW MANAGERS tab and read the information on the screen.
• Click the JOIN NOW! tab.
• The EE User Registration window opens.
• Fill in the boxes (Username, Password, Confirm Password, Email).
• You have three membership options – click the appropriate radial button:
o Show Manager Account:  You are part of show management but do not compete.
o Entrant Account: You compete in shows but are not part of show management.
o Combination Account:  You are both part of show management and a competitor.

• Click Register.  You are now a registered member of EE.  Remember your username and password!

http://www.foxvillage.com http://www.equestrianentries.com FVD FVD

http://www.equestrianentries.com/
http://equestrianentries.com/faq
http://www.equestrianentries.com/
http://www.foxvillage.com/
http://www.equestrianentries.com/
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SAVE:
• Unlike word processing and spreadsheet programs, database programs do not have a Save button.   
• In most word processors and spreadsheets, if autosave is not turned on, you must click Save in order to 

save your changes.  
• In database programs, the program automatically saves each and every entry when you move to a new 

data box on the screen and/or a new function.  This means you are less likely to lose data; however, it 
also means almost everything you enter is saved, whether or not that is your plan.

CHECK BOXES:

• Check boxes are used to indicate a YES/NO response.  

• If the box is checked (), the answer is YES; if the box is not checked (), the answer is NO.  

• Some FVD examples:

o  Need Coggins: If the Need Coggins box is checked, then YES you need to get the Coggins report as 
part of the show entry packet. 

o  Need Coggins: If the Need Coggins box is NOT checked, then NO you do not need to get the 
Coggins report as part of the show entry packet. 

o  Coggins: If the Coggins box is checked, then YES you received the Coggins report. 

o  Coggins: If the Coggins box is NOT checked, then NO you did not receive the Coggins report. 

o  For Sale: If the For Sale box is checked, then YES the horse is for sale. 

o  For Sale: If the For Sale box is NOT checked, then NO the horse is not for sale. 

o  Volunteer: If the volunteer box is checked,  then YES the person is a volunteer. 

o  Volunteer: If the volunteer box is NOT checked,  then NO the person is not a volunteer. 

o  Need Owner’s Signature: If the Need Owner’s Signature box is checked, then YES you need to get 
the original owner’s signature on the original entry form because it was not provided.  

o  Need Owner’s Signature: If the Need Owner’s Signature box is NOT checked, then NO you do not 
need to get the original owner’s signature on the original entry form because it was provided.  

o Etc.

TERMINOLOGY:
• Databases are arranged in related tables.  Each Table is composed of Fields, Records, and Data:

First Name Last Name Address City State Zip

Mary Smith 123 Main St. San Jose CA 12345

John Doe 456 Maple Rd. Boyds MD 40671

Susan Brown 385 Green Ave. Boston MA 49672

Fields (Columns) = specific types of data (such as names, addresses, & cities.

Records (Rows) 
= entities (such as 
horses and 
people) about 
which / whom  
data are collected.

Data (Cells) = 
each individual 
piece of 
information in the 
light blue boxes.

FORMS VS REPORTS:
• Forms are input to an information system.  They are formalized presentations of a record that can be 

edited.  Some FVD forms can be printed.
• Reports are output from an information system.  They are formalized presentations of more than one 

record.  Reports cannot be edited; they can be saved as a file and printed. 

10

Some Notes About Database Programs

FIRST THINGS FIRST
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COMPUTER(S):
• One or more computer(s) – preferably a laptop that you use prior to, during, and after the show.
• As of FVD 2021, using FVD Cloud Server, you can also use a tablet for scribing at the judge stand.  Tablet 

keyboard and mouse are highly recommended.
• If you plan to network computers, you will also need networking equipment (modem, router, bridge, 

etc.) and cables (see CONNECTING COMPUTERS).
• Backup drive(s) (external hard drive, thumb drive, and/or the cloud).

11

Computer Equipment

FIRST THINGS FIRST

OTHER:
• Uninterruptable power supply with 

surge protector.
• Many heavy-duty extension cords.
• Any other office equipment of your 

choice.

PRINTER(S):
• Multi-function (print, scan, copy) laser printer 

recommended.  Monochrome is preferred as you 
only need one replacement toner cartridge.  In my 
experience, ink jet printers do not travel well.

• A reasonably-priced monochrome multi-function 
printer the Brother line.

• Extra printer laser cartridge(s).



Fox Village Dressage User Manual – 2021 Update 1.0.5. helpdesk@foxvillage.com                 www.foxvillage.com

FILING SUPPLIES:
• Two large hanging file boxes (one for entry documents, one for 

rider packets).
• Hanging files with alphabetical tabs, extra hanging files.
ENVELOPES:
• 9” x 12” Kraft envelopes (or clear document protectors) for entry 

packets (or three ring binders and hole punch, if that is your 
cataloging method).

• 9” x 12” (or smaller size) white envelopes for rider packets.
WHITE LABELS AND INDEX CARDS:

12

Supplies to Have on Hand

FIRST THINGS FIRST

PAPER SUPPLIES:
• Reams of 8½ x 11 white paper and 8½ x 14 white paper.
• Legal-sized colored paper of the colors used on USEF tests (white paper is now the standard; however, 

optional colored paper helps the scoring section track tests):
o Introductory - white (can be purchased anywhere!).
o Training – pink (click here AM) (click here OS).
o First – blue (click here AM) (click here OS)
o Second – yellow (click here AM) (click here OS)
o Third – lavender (click here Staples)
o Fourth – green (click here AM) (click here OS)
o FEI – ivory (click here AM) (click here OS)
o Eventing – gray (click here AM)

• Sufficient 5 ½ x 8 ½ paper for instant scoring (you can also use 8½ x 11 paper).
• Deficiency slips (if to be used).
OTHER SUPPLIES:
• Paper clips – both jumbo and regular.
• Stapler and staples.
• Sticky pads.
• Calculators for scoring.
• Pens, pencils, highlighters.
• Any other office supplies of your choice.

AM = Amazon.com                 OS = OfficeSupply.com

NOTE: Dressage tests often change; therefore, it is 
best to print a supply just before a show using the 
online links.

NOTE: Traditionally, the TD 
reviewed paper copies of the 
entry documents.  COVID has 
changed all that as TD entry 
reviews were halted as a safety 
precaution.  When TD entry 
reviews resume, digital entries 
will be acceptable, provided 
they are easy to use and have 
all required documentation.  If 
you plan to use a digital 
method, check with your TD to 
ensure your method is 
acceptable.  If you use a digital 
review method, many of these 
supplies are no longer needed –
this saves money and trees!

Size Use Resources

1” x 2-5/8” shipping labels

• Prize List Mailing Labels
• Horse Stall Labels
• Tack Stall Labels
• Owner Mailing Labels

Avery 5260 (AM)
Or generic versions

1-1/3” x 4” address labels
• Dressage Test Sheets

(small labels)
Avery 5962 (AM)
Or generic versions

2” x 4” shipping labels
• Dressage Test Sheets
• Packet Labels (Standard)

Avery 5163 (AM)
Or generic versions

3-1/2” x 5” shipping labels • Packet Labels (Detail)
Avery 5168 (AM)
Or generic versions

3” x 5” laser index cards
• Horse Stall Cards
• Tack Stall Cards

Avery 5388 (AM)

http://www.amazon.com/Boise-Fireworx-Colored-Multi-Use-Powder/dp/B001AFM7ZK/ref=sr_1_5?s=office-products&ie=UTF8&qid=1418124374&sr=1-5&keywords=8-1+2+x+14+paper+blue
http://www.officesupply.com/office-supplies/paper-pads/copy-multi-paper/copy-multi-colored-paper/boise-fireworx-colored-copy-paper/p73506.html
http://www.amazon.com/Hammermill-Colors-Legal-Sheets-103317R/dp/B000CD0C9Y/ref=sr_1_8?ie=UTF8&qid=1459268991&sr=8-8&keywords=8.5+x+14+paper+blue
http://www.officesupply.com/office-supplies/paper-pads/copy-multi-paper/copy-multi-colored-paper/boise-fireworx-colored-copy-paper/p73508.html
http://www.amazon.com/Boise-MP2204-CY-FIREWORX-20-Pound-Crackling/dp/B001AFK92I/ref=pd_sbs_op_3?ie=UTF8&refRID=1WFNSG1QE0JTB2869GJN
http://www.officesupply.com/office-supplies/paper-pads/copy-multi-paper/copy-multi-colored-paper/boise-fireworx-colored-copy-paper/p73509.html
http://www.staples.com/HammerMill-Fore-MP-Color-Paper-8-1-2-inch-x-14-inch/product_640197?cid=PS:GooglePLAs:640197&ci_src=17588969&ci_sku=640197&KPID=640197&lsft=cid:PS-_-GooglePLAs-_-640197,kpid:640197,adtype:pla,channel:online&gclid=CK74gNeT0swCFcYfhgodGV8Eqw
http://www.amazon.com/Boise-MP2204-GN-FIREWORX-20-Pound-Popper-mint/dp/B001AFF9NW/ref=pd_sim_op_1?ie=UTF8&refRID=06YMPFB674A8ERN90S43
http://www.officesupply.com/office-supplies/paper-pads/copy-multi-paper/copy-multi-colored-paper/boise-fireworx-colored-copy-paper/p73507.html
http://www.amazon.com/Boise-MP2204IY-Fireworx-Flashing-Ream-CASMP2204IY/dp/B0057V6UVU/ref=sr_1_7?s=office-products&ie=UTF8&qid=1418124696&sr=1-7&keywords=8-1+2+x+14+paper+ivory
http://www.officesupply.com/office-supplies/paper-pads/copy-multi-paper/copy-multi-colored-paper/boise-fireworx-colored-copy-paper/p74004.html
http://www.amazon.com/Domtar-Colors-Earthchoice-Opaque-Paper/dp/B008UWVS5G/ref=sr_1_1?s=office-products&ie=UTF8&qid=1418124798&sr=1-1&keywords=8-1+2+x+14+paper+gray
https://www.amazon.com/Avery-Mailing-Printers-Permanent-Adhesive/dp/B00004Z5SN/ref=sr_1_4?crid=MAYW4YPYJAR5&keywords=avery+5260+labels&qid=1579881591&s=office-products&sprefix=Avery+5260+labels%2Coffice-products%2C301&sr=1-4
https://www.amazon.com/Avery-Laser-Labels-Mailing-White/dp/B00BT33VCG/ref=sr_1_7?keywords=avery+5962+labels&qid=1579881753&s=office-products&sr=1-7
https://www.amazon.com/Avery-Shipping-Printers-Permanent-TrueBlock/dp/B00004Z6LV/ref=sr_1_7?keywords=avery+%225163%22+labels&qid=1579882044&s=office-products&sr=1-7
https://www.amazon.com/Avery-Shipping-Printers-Permanent-TrueBlock/dp/B00004Z6LW/ref=sr_1_10?keywords=avery+%225168%22+labels&qid=1579882111&s=office-products&sr=1-10
https://www.amazon.com/Avery-Printable-Cards-Inkjet-Printers/dp/B00006HPWA/ref=sr_1_8?keywords=avery+%225388%22+label&qid=1579882395&s=office-products&sr=1-8
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FVD Icons > Previous, Next, Add

The following are icons you will encounter while using FVD.

FIRST THINGS FIRST

Continued on next page…
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FVD Icons > Delete, Other

FIRST THINGS FIRST
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SECTION I. GETTING STARTED
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Introduction to FVD > Purchase FVD

SECTION I. GETTING STARTED

PURCHASE FVD:

• FVD Program with Access to FVD Cloud Server (FVDCS):
o The FVD Program is purchased from the FVD web site (click here for initial purchase, click here for 

renewal).
o As of December 2021, the purchase price is $299 USD plus an annual subscription of $139.95 USD, for 

a total of $438.95 for the first year and $139.95 each year thereafter (prices increase periodically).  
o After paying this fee online, the purchaser will be emailed a code and license that enable all the 

program features except FVD Paperless Dressage Scoring and CDI/FEI show capability.  

• FVD Paperless Dressage Tests (FVDPDS):
o FVD offers paperless dressage tests whereby a scribe enters POINTS, ERRORS and judge comments 

into a computer/laptop/tablet, after which electronic dressage tests are generated.  Click here for 
information.

o The fee for FVD Paperless Dressage Tests is $150 per show.

• FVD for CDI/FEI Shows:  Contact FVD for information.

NOTE:  BEFORE using FVD Cloud Server and/or FVD Paperless 
Scoring, you must contact FVD at helpdesk@foxvillage.com
to get set up with your user accounts.

http://www.foxvillage.com/purchase.asp
https://www.foxvillage.com/Software/Renew
https://www.foxvillage.com/post?id=22
mailto:helpdesk@foxvillage.com
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Introduction to FVD > Computer Connections for File Sharing

SECTION I. GETTING STARTED

• Small shows (1-2 rings) can operate with one computer at the show.  All on-site show secretary duties 
and entry of scores is done on one computer.  This double-duty often does not work well.

• Shows with two or more competition arenas usually need at least two computers – one for the show 
secretary and one for scoring.  

• Shows with two or more competition arenas that have scribes enter scores at the judge stands usually 
need four or more computers (as a new feature of FVD, tablets may be used for scoring in the judge 
stands) – one for the show secretary, one for scoring/results (place classes, print results sheets, etc.), and 
one for each scribe/arena.

• When two or more computers are used at the show, they must be connected to each other to share files 
(see next page for details of FVD files).  File sharing is accomplished by using a Local Network or by using 
FVD Cloud Server, which uses the FVD Cloud Server (see LOCAL NETWORK VS. FVD CLOUD SERVER).

1. ONE STAND-ALONE COMPUTER

• FVD can be run in one of three methods:
1. One stand-alone computer w/ or w/o internet.
2. Two or more computers connected via a traditional network.
3. Two or more computers and tablets connected via FVD Cloud 

Server (new for FVD Version 2020 1.0.4., recommended 
approach).

NOTE: See Local Network vs. FVD 
Cloud Server > Comparison Chart for a 
comparison of these three methods.

3. FVD CLOUD SERVER

SHOW DEVICES

2. LOCAL NETWORK
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Introduction to FVD > System Requirements, Software Requirements, Additional Software

SECTION I. GETTING STARTED

SYSTEM REQUIREMENTS: 
• Stand-alone or networked computers:  Must have specific features to run MS Windows and MS Office 

with the above specifications.  Click here for more information from the Microsoft web site.
• FVD Cloud Server: Windows, MAC and/or tablet (Win, iOS, or Android) with internet access and ability to 

run Remote Desktop software.

SOFTWARE REQUIREMENTS: 
• Stand-alone or networked computers:
o MS Windows:  
▪ It is recommended that you run the most current version of Windows 10.  Set Windows 10 to 

automatically update and you should have the most current version.  
▪ Stand-alone or networked computers: FVD does not run on Apple products as Access does not run 

on them.
▪ FVD Cloud Server: Win 10 PCs, MACs, and tablets (Win, iOS, and Android) may be used.

o MS Access: 
▪ Stand-alone or networked computers: 
➢ FVD 2020 requires the 32-bit version of MS Access 2013, 2016, 2019 or 365 or MS Access 2013, 

2016 or 2019 Runtime Version
➢ FVD 2021 is not compatible with the 64-bit version or earlier versions of MS Access.  
➢ If you do not have MS Access 2013, 2016, 2019 or 365, download the Runtime version, which is 

free (click here).
▪ FVD Cloud Server: Win, iOS, and Android operating systems may be used.

o MS Excel, MS Word: 
▪ Needed to view and edit exported data.  
▪ It is recommended that you have Office 365.   It is a $99.99 annual subscription for 5 computers.  It 

provides Word, Excel, PowerPoint, Outlook, OneDrive, Publisher, Access and Skype.  Updates are 
automatically installed (unless you turn it off) so you will always have updated software.

• FVD Cloud Server:  Specific software not required except that associated with setting up Remote 
Desktop (see FVD Cloud Server) but Win 10 PC recommended for secretary computer.

ADDITIONAL SOFTWARE RECOMMENDATIONS:
• PDF Maker Program: For exporting to PDF files.  Most computers now have the software required for 

this.  If you do not have this capability,  or if you want more PDF features, recommended are the for-
purchase expensive Adobe Acrobat (click here), moderately priced Nitro Pro 10 (click here), Foxit 
PhantomPDF (click here), or the free download Pdf995 (click here).

NOTE: You cannot simultaneously run a 32-bit version and a 64-bit version of MS Office, including MS Access.  If 
your computer has 64-bit Office, you must uninstall 64-bit Office then install 32-bit Office.  Click here for 
information and instructions from Microsoft (for Office 365 users).

https://products.office.com/en-us/office-system-requirements
https://support.microsoft.com/en-us/office/download-and-install-microsoft-365-access-runtime-185c5a32-8ba9-491e-ac76-91cbe3ea09c9
https://acrobat.adobe.com/us/en/acrobat/pricing.html?mv=search&sdid=J7XBWTSV
https://www.gonitro.com/pro/for-you
https://www.foxitsoftware.com/
http://www.pdf995.com/
https://support.office.com/en-us/article/download-and-install-or-reinstall-office-365-or-office-2019-on-a-pc-or-mac-4414eaaf-0478-48be-9c42-23adc4716658#installsteps=pc_step-by-step
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FVD FILE LOCATIONS: Your FVD files must be located in one of two folders:
• Stand-alone or networked computers:  C: > Users > [UserName] > Documents > FVD (Local C: FVD Folder).
• FVD Cloud Server:  You will be assigned a dedicated folder on the FVD Cloud Server E: drive (Server E: FVD 

Folder).

Introduction to FVD > FVD File Locations, File Structure

❻ Support (folder) – Folder where FVD support files are located, including template files.
❼ Temp (folder) – Folder where FVD temporary folders are located.  Do not store files in this folder.
❽ Fox Village Dressage Shortcut – send to the Desktop to have a shortcut to open the FVD program.
❾ FVD.accde – Microsoft Access file that is the FVD program.
❿ FVD.ico – Icon file that can be used to create shortcuts on the Desktop.
⓫ FVD2.ico – Icon file that can be used to create shortcuts on the Desktop.
⓬ HR.hdf – Horse and Rider file; contains all the data related to horses and people.
⓭ License.dll – The license file that allows you to use FVD after paying for it.  You receive your version of  

the file after you purchase the program.
⓮ Logo.gif – Image file of the FVD logo.  This or another image file can be used in reports.
⓯ Setup.bat – Batch file that was used to install the program.
⓰ Test.tdf – FVD test file.  The file is updated by FVD when new dressage tests are released.  You can edit 

the file within the FVD program to add additional tests.

SECTION I. GETTING STARTED

6

17

⓱ Blank.jdf – Located in the ❻ Support folder; a 
blank show template from which FVD creates shows.
See next pages for more information…

⓲ Readme.txt – Located in the ❼ Temp folder.  Do 
not store files in this folder.  See next pages for more 
information…

7

18

20

1

1

2 3 4 5

6

7
8

9

10
11

12
13
14
15
16

LOCAL C: FVD FOLDER SERVER E: FVD FOLDER

NOTE: In this manual, when procedures are the same for the Local C: Folder and the Server E: Folder, the term Your 
FVD Folder is used.  If procedures are different for the Local C: Folder and the Server E: Folder, the procedures for 
each are described.  The figures show the Local C: Folder unless they are different for the Server E: Folder.

FVD FILE STRUCTURE:
• When FVD is installed on the local C: drive or the server E: drive, it will have the following files:
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File Name Description

fvd.accde Fox Village Dressage Program File (a Microsoft Access file). This is the application file. Better known as the front-end, as 
opposed to the back-end where the data is stored.

*.sdf Fox Village Dressage Show Data Files.  Each show has a separate *.sdf file.  The “*” represents the name you give your 
show file.  

hr.hdf Fox Village Dressage Blank Horse & Rider File.  This is a blank horse & rider file.  This file is used to store the horse and 
people (riders, owners, trainers, and coaches) information and is used from show to show.

*.kdf Fox Village Dressage Template File.  This is a file you create before creating a show file.  It stores information you will use 
in multiple shows with the same tests, stabling, fees, etc., thereby avoiding the re-entry of standard information for each 
of your shows. The “*” represents the name you give your template file. 

test.tdf Fox Village Dressage Test File. This file is used to store the tests information and is used from show to show.

license.dll File provided when you first install and license the program – required to run the full program.  Must be located on the 
same directory (folder) as the Fox Village Dressage Program File (fvd.accde).  Must be updated on an annual basis.

fvd.ico Fox Village Dressage Short-cut Icon.

fvd2.ico Fox Village Dressage Program Icon .  

logo.gif Sample logo.

blank.jdf Fox Village Dressage Blank Show Template. This is the blank show template that is automatically used by the FVD 
Program to create new shows or a new show template. It does not contain any data, only the show file structure. When 
you create a new blank show or a new show template, the program makes a copy of this file to create the new blank 
show or show template.

Readme.txt The folder this file resides in, "\Temp", is for compacting and repairing database files and other internal operations. It is 
advised that you not store files in this folder.

FVD FILES:

21

Introduction to FVD > FVD Files, Suggestions for HR.hdf and Test.tdf File Filenames, 
Suggestions for *.sdf (Show) File Filenames

SECTION I. GETTING STARTED

NOTE: The HR.hdf and Test.tdf files can retain the original file names.  However, if you are the secretary for a 
variety of shows with different people, different horses, and requiring different test durations, you can copy 
the original files and name the copies for the specific show type or show name.  In this manner you are only 
working with the data that you need.  For example, if you are secretary for licensed shows and for schooling 
shows, you might want to have the following files:

• Licensed-HR.hdf
• Licensed-Test.tdf
• Schooling-HR.hdf
• Schooling-Test.tdf

SUGGESTIONS FOR *HR.hdf (HORSE AND RIDER) AND *Test.tdf (TEST) FILE FILENAMES:

NOTE: You will have a different *.sdf file for each show.  It is recommended that you use file names that will 
clearly differentiate your different shows.  For example, if your organization is ABC and you give three shows 
every year called Spring, Summer, and Fall, you may want a file naming standard similar to:

Method to sort by year then show name:
• 2015ABC_1SpringDressageShow.sdf
• 2015ABC_2SummerDressageShow.sdf
• 2015ABC_3FallDressageShow.sdf
• 2016ABC_1SpringDressageShow.sdf
• 2016ABC_2SummerDressageShow.sdf
• 2016ABC_3FallDressageShow.sdf

Method to sort by show name then year:
• ABC_1SpringDressageShow2015.sdf
• ABC_2SummerDressageShow2015.sdf
• ABC_3FallDressageShow2015.sdf
• ABC_1SpringDressageShow2016.sdf
• ABC_2SummerDressageShow2016.sdf
• ABC_3FallDressageShow2016.sdf

SUGGESTIONS FOR *.sdf (SHOW) FILE FILENAMES:
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SECTION I. GETTING STARTED
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Install FVD for the FIRST Time > Server E: FVD Cloud Server Folder vs. Local C: FVD Folder,  
New Installation on Your Local C: FVD Folder

SECTION I. GETTING STARTED

VERY VERY VERY IMPORTANT: These instructions assume you have not previously used Fox Village Dressage
(FVD) and therefore do not yet have a license.dll (FVD license) file nor do you have a previously used HR.hdf
(Horse & Rider) and Test.tdf (Test) files with data.  If you have these files and install the program using these 
instructions, you will over-write the files and lose your license and your data.  If you want to use this method of 
installation, first move your files to another folder (not FVD) first (or temporarily rename them).  After the 
installation, move your license.dll and HR.hdf files back to the FVD folder to overwrite the newly installed files 
and keep your data (or change the names back to the original file names).

• Open the FVD web site (www.foxvillage.com).
• Click ❶ Downloads.

1

Continued on next page…

SERVER E: FOLDER VS LOCAL C: FOLDER:
• Server E: Folder: After you purchase FVD for the first time, the FVD files will be loaded on your Server E: 

FVD Folder by FVD staff.  You do not need to perform an installation.
• Local C: Folder: After you purchase FVD for the first time, if you want the FVD files on your Local C: FVD 

Folder, you must download the installation file and install the program.
• The following instructions cover installation onto your Local C: FVD Folder.

NEW INSTALLATION ON YOUR LOCAL C: FVD FOLDER:

http://www.foxvillage.com/
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• Click ❷ Fox Village Dressage 202# NEW USER Installation Package.

Install FVD for the FIRST Time > New Installation on Your Local C: FVD Folder, Cont’d.

24

SECTION I. GETTING STARTED

2

Continued on next page…
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• Read everything on this screen.
• Click ❸ Download.

Install FVD for the FIRST Time > New Installation on Your Local C: FVD Folder, Cont’d.

25

SECTION I. GETTING STARTED

3

Continued on next page…
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• The ❹ Opening FVD_YYYY_Install.exe form
opens.

• Click the ❺ Save File box.
• Where is the file saved?
o Some browser configurations automatically 

save the file in your 
C:\Users\[username]\Downloads folder.

o Some browser configurations let you choose 
the folder where the file is saved.  If this is 
your type of browser, save the file in your C: > 
Users > [UserName] > Documents folder.

• If the ❻ FVD_YYYY_Install.exe file was saved in 
the ❼ C: > Users > [UserName] > Downloads 
folder, use cut/paste to move the file to ❽ C: > 
Users > [UserName] > Documents folder.

• Double click ❼ FVD_YYYY_Install.exe.

Install FVD for the FIRST Time > New Installation on Your Local C: FVD Folder, Cont’d.

26

SECTION I. GETTING STARTED

4

5

• The ⓬ Fox Village Dressage YYYY form opens.
• Click ⓭ OK to install the program for the first 

time.  If you have a previous installation of the 
program, do not click OK.

• A ⓮ FVD Folder is created and the ⓯ FVD 
folders and files are placed in it.

• If a ❾ Windows protected your PC window 
opens, click ❿ More info. (The window may 
have a different appearance.)

• Click ⓫ Run anyway.

9

10

11

13

14

15

YYYY

7

6YYYY

YYYY

8

7YYYY

#YYYY

YYYY

NOMENCLATURE NOTE:  FVD versions are numbered by 
the year and the version number, such as 2021 Update 
1.0.5.  This manual uses YYYY for the year and #.#.# as 
the versions change faster than the manual.

12
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SECTION I. GETTING STARTED
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VERY VERY VERY IMPORTANT: These instructions assume you have previously used Fox Village Dressage (FVD) 
and therefore you have a license.dll (FVD license) file and previously used HR.hdf (Horse & Rider) and Test.tdf
(Test) files with data. Do not install a new HR.hdf file as it will overwrite your file; to avoid this, you can also 
rename your HR.hdf file.

• You will be performing one, two, three or four separate installations:
o STEP 1: FVD YYYY Update – mandatory – new program files.  You will download a zip (*.exe) 

(compressed) file then extract it to the following uncompressed files:
▪ FVD.accde (FVD application)
▪ Support/Blank.tdf (blank show template)
▪ Temp/Readme.txt (readme file)
▪ Setup.bat (batch file to copy desktop shortcut to desktop)
▪ Fox Village Dressage.lnk (desktop shortcut)
▪ FVD.ico (icon for desktop shortcut)
▪ FVD2.ico (icon for internal forms and reports)

o STEP 2: Blank.tdf – optional – blank template file.  This file is automatically updated with step 1; 
however, you can use this step if you need to update the file on your computer.

o STEP 3: Test.tdf – if needed – test files.  If any tests have changed, you will need to download the new 
test file. This will be in the FVD folder.  The new file will replace your old file so any changes you have 
made to tests (such as durations, addition of additional tests, etc.) will be lost.

o STEP 4: HR.hdf – optional – Horse and Rider file.  Optionally, you can also download a new HR.hdf
file, but this will overwrite your file (if it is still named HR.hdf) so you would lose all your horse and 
rider data.  If you renamed your HR.hdf file, it would not overwrite that file.

SECTION I. GETTING STARTED

Update FVD Over an EXISTING Installation > Introduction

NOTE: If you receive an Errror3265 message while using FVD, the accde.exe file 
may be corrupted.  If this occurs, reinstall the program using these instructions.

• When FVD has an update to the program, you will get a message when you open the program.
• You will need to install the update on your Local C: FVD Folder or your Server E: FVD Folder.

INTRODUCTION:

• You initiate an update of your program in one of two methods:
1. Update While Opening FVD File
2. Update via FVD Downloads
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• The ❷ FVD UPDATE FILES window opens.  See the next method for use of this window.

SECTION I. GETTING STARTED

Update FVD Over an EXISTING Installation > Update While Opening FVD File

Continued on next page…

• When you click the FVD *.accde file to open it, if a newer version is available, you get the following 
window.

• Click ❶ Update Now. 

UPDATE WHILE OPENING FVD FILE:

2

1

YYYY #.#.#

YYYY #.#.#
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• Open the FVD web site (click here). 
• From the home screen, click ❶ Downloads.  

STEP 1 – DOWNLOAD UPDATE FILE (*.exe):

SECTION I. GETTING STARTED

Update FVD Over an EXISTING Installation > Update via Downloads

Continued on next page…

1

http://www.foxvillage.com/
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• The ❷ DOWNLOADS window opens.
• Click ❸ YYYY FILE UPDATES > Fox Village Dressage.

SECTION I. GETTING STARTED

Update FVD Over an EXISTING Installation > Update via Downloads, Cont’d.

Continued on next page…

2

3

YYYY
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• The ❹ FVD UPDATE FILES page opens.
• Read everything on the page.
• Click ❺ Download.

SECTION I. GETTING STARTED

Update FVD Over an EXISTING Installation > Step 1. Download/Install Update File

Continued on next page…

4

5

#.#.#YYYY

YYYY ###

MM/DD/YYYY

#.#.#YYYY
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• The ❻ Opening FVD_202#_Update_10#.exe 
form opens.

• Click ❼ Save File.
• Where is the file saved?
o Browsers may be configured to automatically 

save downloaded files in the ❽ C > Users > 
[Username] > Downloads folder.

o Browsers may be configured to let you choose 
where the file is saved.  If you have a choice 
and you are updating files in your Local C: FVD 
Folder, choose that folder.

SECTION I. GETTING STARTED

Update FVD Over an EXISTING Installation > Step 1. Download/Install Update File, Cont’d.

• If the ❾ FVD_202#_Update_10#.exe file is 
saved in the ❽ C: > Users > [UserName] > 
Downloads folder, using cut/paste, move the ❾
FVD_202#_Update_10#.exe file to:
o Your ❿ Local C: FVD Folder

OR
o Your⓫ Server E: FVD Folder (you must first 

be logged onto your Server E: FVD Folder).

7

6

9

8

Continued on next page…

• Double click ⓬ FVD_202#_Update_10#.exe.

10

Local C: FVD Folder

12

#

#

11

12

Server E: FVD Folder

11

# #

#
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SECTION I. GETTING STARTED

Update FVD Over an EXISTING Installation > Step 1. Download/Install Update File, Cont’d.

• The ⓰ Install Fox Village Dressage 202# Update 
1.0.# form opens.

• Click ⓱ OK.

• If a ⓭Windows protected your PC window 
opens, click ⓮More info.  (The window may 
have a different appearance.)

• Click ⓯ Run anyway.

• Open the program as usual and repair all links (see REPAIR ALL LINKS).

• The updated files are installed in your Local C: FVD Folder or your Server E: FVD Folder.  The new files 
OVERWRITE your previous files.

13

14

15

16

17

YYYY #.#.#

YYYY #.#.#
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• This file is downloaded with Fox Village Dressage YYYY Update.  If needed, you can update it separately.
• As in STEP 1, click Downloads. 
• The ❶ DOWNLOADS page opens.
• Click ❷ Blank Show Template.

SECTION I. GETTING STARTED

Update FVD Over an EXISTING Installation > Step 2. Download Blank Show Template 
(Optional)

STEP 2 – DOWNLOAD BLANK SHOW TEMPLATE (Blank.jdf) (OPTIONAL).

Continued on next page…

1

2

YYYY
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• The ❸ BLANK SHOW TEMPLATE page opens.
• Read everything on the page.
• Click ❹ Download.

SECTION I. GETTING STARTED

Update FVD Over an EXISTING Installation > Step 2. Download Blank Show Template 
(Optional), Cont’d.

Continued on next page…

3

4

YYYY

YYYY
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• The ❺ Opening blank.jdf form opens.
• Click the ❻ Save File radial button.
• Click ❼ OK.
• Where is the file saved?
o Browsers may be configured to automatically 

save downloaded files in the ❽ C > Users > 
[Username] > Downloads folder.

o Browsers may be configured to let you choose 
where the file is saved.  If you have a choice 
and you are updating files in your Local C: FVD 
Folder > Support folder, choose that folder.

SECTION I. GETTING STARTED

Update FVD Over an EXISTING Installation > Step 2. Download Blank Show Template 
(Optional), Cont’d.

5

6

7

8

9

• The ❾ Blank.jdf file is now in:
o Your ⓭ Local C: FVD Folder > Support

OR
o Your ⓮ Server E: FVD Folder > Support

• A Windows ❿ Replace or Skip Files window 
opens.

• Since you are replacing the old Blank.jdf file, click 
⓫ Replace the file in the destination.

• If the ❾ blank.jdf file is saved in the ❽ C: > 
Users > [UserName] > Downloads folder, using 
cut/paste, move the ❾ blank.jdf file to:
o Your Local C: FVD Folder > Support folder

OR
o Your Server E: FVD Folder > Support folder

(you must first be logged onto your Server E: 
FVD Folder).

11
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9

14
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13

Local C: FVD Folder

Server E: FVD Folder
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• Download this file if it has been updated by FVD (occurs when any test(s) is/are updated).  If you have 
not renamed your Test.tdf file, this download will overwrite you existing file and you will lose any editing 
you have previously done to the file.

• As in STEP 1, click Downloads.
• The ❶ DOWNLOADS page opens.
• Click ❷ Test File.

SECTION I. GETTING STARTED

Update FVD Over an EXISTING Installation > Step 3. Download Test File

STEP 3 – DOWNLOAD TEST FILE (Test.tdf).

Continued on next page…
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• The ❸ TEST FILE page opens.
• Read everything on the screen.
• If you want to download the new Test.tdf file, click ❹ Download.

SECTION I. GETTING STARTED

Update FVD Over an EXISTING Installation > Step 3. Download Test File, Cont’d.

Continued on next page…

4

3

NOTE: Doing this will overwrite your current file if 
you have not renamed it; however, you need to do 
this if tests have changed.  Then you need to make 
any edits you made to your previous file.

YYYY #.#.#
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• The ❺ Opening test.tdf form opens.
• Click the ❻ Save File radial button.
• Click ❼ OK.
• Where is the file saved?
o Browsers may be configured to automatically 

save downloaded files in the ❽ C > Users > 
[Username] > Downloads folder.

o Browsers may be configured to let you choose 
where the file is saved.  If you have a choice 
and you are updating files in your Local C: FVD 
Folder, choose that folder.

SECTION I. GETTING STARTED

Update FVD Over an EXISTING Installation > Step 3. Download Test File, Cont’d.

• If the ❾ Test.tdf file is saved in the ❽ C: > 
Users > [UserName] > Downloads folder, using 
cut/paste, move the ❾ Test.tdf file to:
o Your Local C: FVD Folder

OR
o Your Server E: FVD Folder (you must first be 

logged onto your Server E: FVD Folder).

• The new ⓬ Test.tdf file is now in:
o Your ⓭ Local C: FVD Folder

OR
o Your ⓮ Server E: FVD Folder

5

6

7

• A Windows ❿ Replace or Skip Files window 
opens.

• Since you are replacing the old test.tdf file, click 
⓫ Replace the file in the destination.
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Local C: FVD Folder
10

14

Server E: FVD Folder
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STEP 4 – DOWNLOAD HORSE AND RIDER FILE (HR.hdf) (Optional)

WARNING!!!!!  Do this step only if you want a new blank horse and rider file.  If you download a new 
HR.hdf file, and if you have not moved or renamed your HR.hdf file, YOU WILL LOSE ALL THE DATA IN 
YOUR HR.HDF FILE.  This means you will lose all the people and horse data you previously entered.

Update FVD Over an EXISTING Installation > Step 4. Download Horse & Rider File (HR.hdf) 
(Optional)

SECTION I. GETTING STARTED

Follow the same steps as in STEP 3, except download the ❶ HR.hdf file.

1

YYYY
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SECTION I. GETTING STARTED
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Start the FVD Program & Create First Template > What is a Show Template?

SECTION I.  GETTING STARTED

ETC.

1st ACCESS SHOW FILE (*.sdf)

2nd ACCESS SHOW FILE (*.sdf)

3rd ACCESS SHOW FILE (*.sdf)

ACCESS TEMPLATE FILE (*.kdf)

• In previous versions of FVD you started by creating a Show file.  Use of Show Template files was 
optional.

• Now you must first create a Show Template file.  You then use the Show Template file to create the 
Show file(s).   

• The Show Template file contains information that is shared by multiple shows. 
• By using a Show Template file, you avoid re-entering recurring information such as classes, stalls, etc. 

WHAT IS A SHOW TEMPLATE?:
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Start the FVD Program & Create First Template > Click FVD.accde or FVD Icon

SECTION I. GETTING STARTED

• On your local computer, there are two easy 
methods to open the FVD program:

1. In your ❶ Local C: FVD Folder, double-click 
the ❷ FVD.accde icon. 

NOTE: You can also use one of the many 
navigation tools available to Window users.

• The FVD program will open.

2

1

3

2. Double click the ❸ Fox Village Dressage icon 
on your desktop.  This is created during the 
installation.  (The icon is not on the FVD Cloud 
Server)

OR

CLICK FVD.accde or FVD ICON:

Local C: FVD Folder Server E: FVD Folder

• On the FVD Cloud Server, double-click the ❹
FVD icon on the top right of the screen:

4

• The FVD program will open.
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Start the FVD Program & Create First Template > Microsoft Access Security Notice

SECTION I. GETTING STARTED

• A ❶Microsoft Office Access Security Notice opens.
• Click ❷More information if you want more information.
• Click ❸ Open.

Depending upon your version of Microsoft Windows and the level of security you have set on your 
computer, when opening FVD, you might get the following warning notice.

3

1

2

MICROSOFT SECURITY NOTICE:

• Wait while FVD verifies that you have a current license.
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Start the FVD Program & Create First Template > FVD Create New Template Form

SECTION I. GETTING STARTED

• If this is the first time you are running the program after a first installation, or after an update:
o If you have just purchased/renewed the program, you will be asked for your Activation Key (a series of 

numbers, letters, and dashes), which is provided to you via email after you purchase/renew FVD.  
o Type in your activation key to activate your license.  This updates your License.dll file, which is 

necessary to run FVD.  The license is good for one year.  Create a backup of this file!

• A ❶ Fox Village Dressage XXXX information box opens.
• There is a pause as FVD verifies your license.
• A ❷ Fox Village Dressage form opens with the question “Would you like to create a new template?
• Since you are creating a new template for the first time, click ❸ Yes.
• [If you have already created a template or show, it usually opens automatically.  If not, click ❹ No.]

Continued on next page…

NOTE: With previous versions of FVD, you first create a show; you could optionally 
also create a template.  With FVD 2020, you must first create a template, then you 
create a show (or shows) based on the template.

FVD CREATE NEW TEMPLATE FORM:

1

2

3 4

XXXX
XXXX
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Start the FVD Program & Create First Template > Name Template File (*.kdf)

SECTION I. GETTING STARTED

• The ❶ New Show Template File form opens.
• In the ❷ File name box, type in a name for your template file.  In this example, XXXX-BHD-Template

was entered:  (See the NOTE below for show filename suggestions.)
o XXXX = placeholder for year or date when you create a show from the template.
o BHD = abbreviation for the specific type of show (in this example, Blue Horse Dressage)
o Template = used to clearly demonstrate it is a template file.

• FVD automatically gives it the kdf extension. Click ❸ Save.

Continued on next page…

NOTE: You will have a different *.sdf file for each show.  It is recommended that you use file names that will 
clearly differentiate your different shows.  For example, if your organization is ABC and you give three shows 
every year called Spring, Summer, and Fall, you may want a file naming standard similar to:

Method to sort by year then show name:
• 2020ABC_1SpringDressageShow.sdf
• 2020ABC_2SummerDressageShow.sdf
• 2020ABC_3FallDressageShow.sdf
• 2021ABC_1SpringDressageShow.sdf
• 2021ABC_2SummerDressageShow.sdf
• 2021ABC_3FallDressageShow.sdf

Method to sort by show name then year:
• ABC_1SpringDressageShow2020.sdf
• ABC_2SummerDressageShow2020.sdf
• ABC_3FallDressageShow2020.sdf
• ABC_1SpringDressageShow2021.sdf
• ABC_2SummerDressageShow2021.sdf
• ABC_3FallDressageShow2021.sdf

SUGGESTIONS FOR SHOW FILENAMES:

1

2

3

2

NAME TEMPLATE FILE (*.kdf):
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Start the FVD Program & Create First Template > Link Files

SECTION I. GETTING STARTED

• The ❺ Link Test File form
opens.  This lets you 
designate the Test.tdf file for 
this show.

• Click ❻ Test.tdf.
• The file name appears in the 
❼ File name box.

• Click ❽ Open.

• The ❶ Link Horse & Rider 
File form opens.  This lets 
you designate the HR.hdf for 
this show.

• For this example, click ❷
HR.hdf.

• The file name appears in the 
❸ File name box.

• Click ❹ Open.

LINK HR.hdf AND Test.tdf FILES:

• The *.sdf (Show) and *.kdf (Template) files must be “linked” with the HR.hdf  (Horse & Rider) and 
Test.tdf (Test) files so they can work together.  The linking procedure starts automatically after you create 
a new template or show.  (You may also need to do the links manually; see REPAIR ALL LINKS for more 
information.)

1

2

3
4

3

5

6

7
8

7

*.kdf file

*.sdf file

HR.hdf file

Test.tdf file
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SECTION I. GETTING STARTED
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FVD Interface > FVD Ribbon, FVD & EE Tools

FVD RIBBON:
The FVD main form is very simple.  It has 
the following major components:
• ❶ File – Feedback [to Microsoft, Exit.  
• ❷ Fox Village Dressage – Opens a 

Ribbon with many FVD features.  
• ❸ Utilities – Opens a ribbon with 

FVD utilities (Compact, Backup/ 
Restore).

• ❹ Help – Opens a ribbon with links 
to manuals and other support 
features.

• ❺ The program name – Fox Village 
Dressage.

• ❻ Minimize button – click to 
minimize the program.

• ❼Maximize button – click to 
maximize the program on your 
monitor.  

• ❽ Close button – click to close the 
FVD program.

• ❾Main Menu - The area from 
which you will perform most of your 
work.  The Main Menu has four tabs:
o ❿ Show Office – Click for many of 

the functions to set-up and manage 
your show.

o ⓫ Scoring – Click for the functions 
for scoring dressage tests.

o ⓬ Reports – Click for a wide 
variety of reports ranging from test 
labels, to stall assignments, to 
show results.

o ⓭Breed Show Reports – Click for 
special reports that pertain to 
breed shows.

• ⓮ Show Name – Right now it is 
Blank Show.  You will name it shortly.

SECTION I. GETTING STARTED

NOTE: The FVD forms are of variable sizes and positions.  If using a laptop or PC with a smaller monitor, it is 
recommended that you run the program “maximized” by clicking the ❼Maximize button, which causes the 
FVD program to fill the entire monitor screen.  This is not necessary if you have a very large monitor.

NOTE: To save space, the ⓯ Fox Village Dressage Online Tools and⓲ Equestrian Entries Integrated Online 
Tools section of the main form are not depicted in many of the graphics in this manual.

FVD & EE TOOLS:
• ⓯ Fox Village Dressage Online Tools – links to the FVD 

online reporting.
• ⓰ Link to the Fox Village Dressage web site.
• ⓱ Link to the Fox Village Dressage Facebook page.
• ⓲ Equestrian Entries Integrated Online Tools – allow you 

to use entry data from Equestrian Entries (EE).
• ⓳ Link to Equestrian Entries web site.

1 2 3 4
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FVD Interface > Collapse and Expand the Ribbon

SECTION I. GETTING STARTED

• The FVD ribbon contains program and file management features.
• The ribbon can be collapsed or expanded to give you more or less working space. 
• The program first opens with the menu ❶ collapsed so menu items cannot be seen.
• Click any ribbon item.  In this example, click ❷ Fox Village Dressage.

COLLAPSE AND EXPAND THE RIBBON:

1

2

3

4

5

• The ❸ Fox Village Dressage ribbon list expands (opens).
• The ribbon list collapses (closes) when you click anywhere on the window.
• To permanently expand (open) the ribbon, click the ❹ pushpin then click ❺ Always show ribbon. 
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FVD Interface > File Menu, Fox Village Dressage Ribbon

• Click ❶ File. 

SECTION I. GETTING STARTED

1

2

3

4

5 3

• Click ❻ Fox Village Dressage.  
• The ❼ Fox Village Dressage ribbon opens.
• It has three sections:

1. ❽ Show Template: 
o ❾ Create Show Template: Used to create a show template.  Must be done before creating a 

show.
o ❿ Open Show Template: Used to open a previously created show template to edit the 

template.
2. ⓫ Show File:

o ⓬ Create Show File: Used to open a previously created show template to use it to create a 
show.

o ⓭ Open Show File: Used to open a show file that was previously created.
3. ⓮ File Linking: Used to link the *.sdf, HR.hdf, and Test.tdf files you are using for a show.  This allows 

the files to work together (see REPAIR ALL LINKS).

• The ❷ File menu opens.
• This lets you:
o Provide❸ Feedback to Microsoft.
o ❹ Exit FVD.

• Click the ❺ left arrow to return to FVD.

FILE MENU:

FOX VILLAGE DRESSAGE RIBBON:
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FVD Interface > Utilities Ribbon

• Click ❶ Utilities.
• The ❷ Utilities ribbon opens.
• The ribbon has six sections:

1.❸ Program File > Compact:  Used to compact a Program File (FVD.accde) to make it a smaller file.
2.❹ Show Template File > Compact:  Used to compact a Template File (*.kdf) to make it a smaller file.
3.❺ Show File > Compact:  Used to compact the Show File (*.sdf) to make it a smaller file.
4.❻ Horse & Rider File > Compact:  Used to compact the Horse & Rider File (FHR.hdf) to make it a 

smaller file.
5.❼ Test File > Compact:  Used to compact the Test File (Test.tdf) to make it a smaller file.
6.❽ Back / Restore > Instructions: Previous versions of FVD had a Backup and Restore utility.  Starting 

with version 2020, that utility has been removed.  Instructions show users how to use files created 
with the legacy utility.

• Each of these utilities will be explained later in this manual.

SECTION I. GETTING STARTED

1

2

3 4 5 6 7 8

UTILITIES RIBBON:

1
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FVD Interface > Help Ribbon

SECTION I. GETTING STARTED

• Click ❶ Help.
• The ❷ Help ribbon opens.
• The ribbon has four sections:

1.❸ Online Manuals:
o ❹ Quick Start: A short manual that provides the FVD basics.
o ❺ User Manual: This manual, which is a detailed step-by-step manual for using FVD.
o ❻ User Manual (DSHB): Companion manual for using FVD for breed shows.

2.❼ Support:
o ❽ GoToAssist:
o ❾ GoToMeeting:  An online meeting and web conferencing tool that enables businesses to 

collaborated with customers via the internet in real time.  
3. ❿ License > ⓫ Activate: Used to activate a FVD license.
4. ⓬ About:
o ⓭About Fox Village Dressage: Opens a window that provides information about the FVD company 

and the license you are using.  
o ⓮ Check for Updates: Opens a window that advises you if a new version of FVD is available.

HELP RIBBON:
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FVD Interface > Fox Village Dressage Online Tools & EE Integrated Online Tools

SECTION I. GETTING STARTED

• There are four ❶ Fox Village Dressage Online Tools:
1.❷ Register Show: Registers your show with FVD so select show data is available to users. Used after

your show is completely and correctly set up. 
2.❸ Upload Confirmations:  Used to email entrants with the status of their entry.
3.❹ Upload Ride Times:  Used to send ride times to FVD so they are available online.
4.❺ Upload Results: Used to upload show results.  Can be uploaded “live” so entrants can obtain their 

scores as soon as the show office posts them in FVD.

1

2 3 4 5
6

7 8 9

• There are three ❻ Equestrian Entries Integrated Online Tools:
1.❼ Publish Show: Used to send your show information to EE, which makes it available to entrants so 

they can enter your show online using EE. 
2.❽ Import Online Entries:  Used to import your show entries that have been created through EE.
3.❾ Close Show:  Closes your show so entrants can no longer create entries through EE.

FOX VILLAGE DRESSAGE ONLINE TOOLS:

EE INTEGRATED ONLINE TOOLS:
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FVD Interface > Main Menu Tabs > Show Office, Scoring

SECTION I. GETTING STARTED

Show Office: Used to set up and run a show.

Scoring: Used to record scores and place 
classes.

Each Main Menu tab has a different function and displays different program features.
MAIN MENU TABS:
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Reports: Used to create reports (documents) 
needed Pre-Show, During-Show, and Post-
Show.

Breed Show Reports: Used to create reports 
(documents) for breed shows.  

57

FVD Interface > Main Menu Tabs > Reports, Breed Show Reports

SECTION I. GETTING STARTED

Each Main Menu tab has a different function and displays different program features.
MAIN MENU TABS:
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SECTION II. BEFORE THE SHOW
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Create a Show Template & Open a Show Template > Create a Show Template

1

2

• Before you create a show, you must create a template; the template can then be used for the current 
and subsequent similar shows.  This section shows you how to create a new show template file.

• From the ❶ Fox Village Dressage ribbon list, click ❷ Create Show Template.

• The ❸ New Show Template File form opens.
• Template files have a ❹ *.kdf extension.  By default, they are stored in ❺ Your FVD Folder > Support 

folder.
• In the ❻ File name box, type in a file name that will remind you the file is a template that is associated 

to a particular recurring show.   For example, if you have an annual show called Blue Horse Dressage 
(BHD), you may want to call the file XXXX-BHD-Template.kdf, where XXXX represents the year (or the 
date) that will be typed in each year (or show date) when you create the show from the template.

• Click ❼ Save.

SECTION II. BEFORE THE SHOW

3

5

6

7

4

• The file ❽ XXXX-BHD-Template.kdf has been saved in the ❾ Your FVD Folder > Support folder.

8

9

CREATE A SHOW TEMPLATE:
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Create a Show Template & Open a Show Template > Open a Show Template

1

2

• If you want to edit a show template file, you first need to open the file.
• From the ❶ Fox Village Dressage ribbon, click ❷ Open Show Template.

• The ❸ Open Show 
Template File form 
opens.

• Click the ❹ file name of 
the template you want to 
open.

• The file name appears in 
the ❺ File name box.

• Click ❻ Open.
• Alternately, double click 

on the file name.

SECTION II. BEFORE THE SHOW

3

5
6

4

• If you have not yet entered the show 
template name, a ❼ Blank Template 
opens.

• If you previously entered the show 
template name, the ❽ name of the 
template is seen.

7

8

OPEN A SHOW TEMPLATE:
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SECTION II. BEFORE THE SHOW
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• Click ❶ Repair All Links.

• In addition to the fvd.accde program file, FVD consists of three 
files that work with each other: 
1. Template file (*.kdf) or Show file (*.sdf)
2. Horse & Rider file (HR.hdf)
3. Test file (Test.tdf).

• Before they can work together, they need to be linked.
• Each time you update the FVD program file, create a new 

template, create a new show, backup and restore the files, move 
the files to another computer, etc., the files need to be linked.

• This procedure links the files.

• The ❷ Link Show or Template File 
form opens in ❸ Your FVD Folder.

• Only *.sdf files will be seen.
• To link a show file:
o Click on the ❹ name of the 

show you wish to link (in this 
example, the name of the show 
file is 2020-BHD-Show.sdf).

o The name of the show appears in 
the ❺ File name box.

o Select ❻ Open. 
o Alternately, you can double click 

the ❹ show file name.
• To link a template file:
o Double click on the ❼ Support 

folder.
o The ❽ Support folder opens.
o Click on the ❾ name of the 

template you wish to link.
o The name of the template 

appears in the ❿ File name box.
o Select ⓫ Open. 
o Alternately, you can double click 

the ❾ template file name.

63

Repair All Links > What is Linking?, Select Show File or Template File

SECTION II. BEFORE THE SHOW

1

REPAIR ALL LINKS

*.kdf

*.sdf

HR.hdf

Test.Tdf

FVD.accde

6

4

3

5

2

5

7

WHAT IS LINKING?:

SELECT SHOW OR TEMPLATE FILE:
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1110
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• The ❶ Link Horse & Rider File form opens in ❷ Your FVD Folder, which displays your list of Horse & 
Rider files(*.hdf).

• Only *.hdf files will be seen.
• Select your *.hdf file.  This is usually ❸ HR.hdf, unless you renamed the file.
• The filename will appear in the ❹ File name box.  
• Click ❺ Open. 
• Alternately, double click the *.hdf file.

• The ❻ Link Test File form opens.  
• Only files with the tdf extension will be seen.
• Select your *.tdf file.  This is usually ❼ Test.tdf unless you renamed the file.
• The filename will appear in the ❽ File name box.  
• Click ❾ Open. 
• Alternately, double click the *.tdf file

64

Repair All Links > Link Horse & Rider File, Link Test File

SECTION II. BEFORE THE SHOW

2

3

1

Continued on next page…
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LINK HORSE & RIDER FILE:

LINK TEST FILE:
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• You are brought back to your ❶ show or template.
• Repeat this sequence each time you update the FVD program file, create a new template, create a new 

show, backup and restore the files, move the files to another computer, etc.

65

Repair All Links > Check the Links

SECTION II. BEFORE THE SHOW

IMPORTANT NOTE: Use the Repair All Links sequence whenever you install a FVD update, copy a 
file from another computer, or get a “can’t find . . . file” error message.  If in doubt, link!

• If desired, click ❷ Linked Files to see a list of the 
linked files.

• The ❸ Fox Village Dressage Link Files form 
opens. 

• You see the path and filename of the linked ❹
Show File or Template File, ❺ Horse & Rider 
File, and ❻ Test File.

• Click ❼ Close to close the form.

1

2

3

4

5

6

7

CHECK THE LINKS:
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SECTION II. BEFORE THE SHOW
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Edit a Show Template > Overview

• You will next enter all the recurring show details, which includes the following:
o ❶ Show Information
o ❷ Show Preferences
o ❸ Show Fees
o ❹ Payment Types
o ❺ Credit Card Types
o ❻ Stalls [Numbers]
o ❼ Stall Groups (if you have recurring stall groups).
o ❽ Classes
o ❾ Test Durations (if you want to change them for your recurring shows)
o ❿ Test Editor (if you need to add new tests for your recurring shows)

• This includes EVERYTHING for ALL of your recurring shows that will be based on this template.  You can 
add dates and other differences later in the show file that is created from the template.

• Since this is a template file, the FVD Program will not let you enter any entries or other items that would 
be specific to one particular show.  The key for templates is to think about what you want pre-entered 
for you every time you start a new show – this will save you time from re-entering standard information.

• You will now have a template file that you can use to get a head start on every recurring show you 
create.

SECTION II. BEFORE THE SHOW

NOTES: 
• After you create a template you can go back and 

edit it if information changes.  However, the edits do 
not apply to shows that have already been created 
by using the template.

• After you create a show file from a template, you 
can edit anything in the show that may be different 
from the template.  If these changes will apply to 
future shows, also edit the appropriate template.

OVERVIEW:

1
2
3
4
5
6
7
8

9
10
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• Select ❶Main Menu / ❷ Show Office / 
❸ Show Information.

68

Edit a Show Template > 1. Show Information > General Tab

SECTION II. BEFORE THE SHOW

1

2

3

• The ❹ Show Information form opens.
• ❺ General Tab:
o In the ❻ Show [Template] Name box, enter a name that will identify the template while you are editing 

it.   I usually use the same name as the template filename; therefore, in this example the name ❼ XXXX-
BHD-Template is used since it is also the name of the template file.

o Fill in as many of the boxes as possible at this time.  
o Since this is a template, the ❽ Date(s) and ❾ Technical Delegate boxes are left blank (they are 

completed in the show file).
o If your ❿ Show Manager and/or ⓫ Show Secretary vary from show-to-show, leave this information 

blank.
o Boxes with a * are required for registering the show for EE online tools.  
o You may return to this screen at any time to complete/update the data for this show template.

1. SHOW INFORMATION > GENERAL TAB:

5

7

8

4

9

6 10

11
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Edit a Show Template > 1. Show Information > Additional Tab

SECTION II. BEFORE THE SHOW

• The ❻ show template name will now appear at the top of the Main Menu.

• ❶ Additional Tab:
o Fill in as many of the boxes as possible at this time.  
o If the ❷ Global Memo, ❸ Prize List URL, and/or ❹ Show URL will be the same for all shows based on 

this template, complete the boxes.  Otherwise, leave them blank (they will be completed in the show file).
o You may return to this screen at any time to complete/update the data for this show template.

• When you are finished, click ❺ Close.

Continued on next page…

1. SHOW INFORMATION > ADDITIONAL TAB:

NOTE: FEI sections require a FVD FEI 
license.  FEI information is not covered 
in this manual.

1

2

3
4

5

6
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• Select ❶Main Menu / ❷ Show Office / 
❸ Show Preferences.
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Edit a Show Template > 2. Show Preferences > General Tab

SECTION II. BEFORE THE SHOW

1

2

3

• The ❹ Show Preferences form opens.
• Click on the ❺ General Tab.
• Scoring:
o ❻ Standard Scoring (Recommended): The scoring computer operators enter movement-by-

movement scores for each judge using the test score sheet(s).  The program calculates the Final Score 
and the Percent.  This method is appropriate for shows that have sufficient scoring staff and 
equipment to enter and check all the scores.

o ❼Manual Scoring (Totals only): The scores for each movement are not entered in the computer; 
instead, the scoring computer operator enters each judge score and the program calculates the Final 
Score and the Percent. This method is appropriate for shows that do not have sufficient scoring staff 
to enter and check all the scores.

o This decision is usually made by show management based upon available computer equipment, 
scoreboard equipment, and personnel.  See SCORING for detailed scoring information.

2. SHOW PREFERENCES > GENERAL TAB:

5

7

4

6

Continued on next page…
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Edit a Show Template > 2. Show Preferences > General Tab, cont’d.

SECTION II. BEFORE THE SHOW

• ❽ Display Prep Utility:  Used in the show file after the show is scheduled.
• ❾ Conflict Time:  

o A rider competing more than one horse needs time to warm-up each horse before their class time.  
USEF rule DR126.1.b(5) requires at least 50 minutes between the start time of rides for the same
rider on different horses.  If there is insufficient time, there is a conflict.  

o The FVD program can flag conflicts during show scheduling.  This is only a flag – you must make ride 
time adjustments.  See Conflict Resolution for the procedure.

o To set the conflict time, ensure 50 minutes (the default) is in the ❿ Conflict Time box.

Continued on next page…

USEF rule DR126.1.b(5):  At least 50 minutes must be scheduled between start times for a rider’s 
tests on different horses unless he/she has agreed, in writing, to a shorter interval between tests.

START TIME 1

RIDER 1, HORSE 1

START TIME 2 =
START TIME 1 + > 50 MIN

RIDER 1, HORSE 2

8

9 10
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Edit a Show Template > 2. Show Preferences > General Tab, cont’d.

SECTION II. BEFORE THE SHOW

o ⓫ Use Coggins:  
▪ If your show requires a current copy of the Coggins report, check the box.  
▪ If a Coggins test is not required, do not check this box.

o ⓬ Use Vaccines:
▪ If your show packet entries require a current proof of vaccination IAW USEF GR845, check the 

box.  (Click here for USEF GR845.)
▪ If a proof of vaccination is not required, do not check this box.

o ⓭ Use SafeSport:
▪ If your show requires proof of current SafeSport training for USEF adult member participants, 

check the box.  (Click here for USEF SafeSport information.)
▪ If SafeSport training is not required, do not check this box.

o ⓮ Auto Fill Trainer:  
▪ Check the ⓯ Auto Fill Trainer box if you want FVD to automatically fill the trainer box when an 

entry is input by hand.  In the show file, the rider is automatically filled in as the trainer (it can be 
edited).

▪ Uncheck the box if you do not want this done.
o ⓰ Use Logo Graphic on Reports:

▪ If you wish to use a logo on the show reports, check the ⓱ Use Logo Graphic on Reports box.
▪ Use the ⓲ Browse button to designate the logo file.  
▪ The logo must be in Your FVD Folder or on another folder on the hard drive.  This location may 

need to be changed if you move your show to another computer.
o ⓳ Use USEF Rules for Rider’s Age:  If your show will use USEF rules for the age of riders, check the 

box.
o ⓴ Pony Club Show: If your show is a Pony Club show, check the box.

▪ If you wish to use a logo on the show reports, check the ❹ Use Logo Graphic on Reports

11
12
13

14

15

16
17

18

19

20

https://www.google.com/url?sa=t&rct=j&q=&esrc=s&source=web&cd=4&cad=rja&uact=8&ved=2ahUKEwi5ov78jZHnAhUuwFkKHfNOBB8QFjADegQIAxAB&url=https%3A%2F%2Fwww.usef.org%2Fforms-pubs%2FANcxoLX1gNs%2Fequine-vaccination-rule-gr845&usg=AOvVaw3Y_8XZbFp9_y1tFowQBwPu
https://www.usef.org/safe-sport
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Edit a Show Template > 2. Show Preferences > Membership (1) Tab

SECTION II. BEFORE THE SHOW

• Click the ❶ Membership (1) tab.
• The ❷ Membership (1) tab opens.  It covers National (USEF or EC), Discipline (USDF), and International 

(FEI) membership rules.
• ❸ National Level (USEF or EC):

o Check Box: 
▪ USEF is the default.  USEF licensed shows require USEF competing membership for riders, owners and 

trainers (non-members may pay a show pass fee and people participating in only exempt classes pay no fee 
– more later).  Therefore, ensure the USEF check box is checked.

▪ Change label to EC (Equine Canada) if your show follows Canadian membership rules.
o Date: 
▪ USEF annual membership can now start at any time and end one year later; therefore, there is no universal 

membership expiration date.  However, many members still renew their membership as previously; 
therefore, enter November 30 of the competition year.

▪ EC: Enter the EC membership expiration date for the competition year.
• ❹ USDF:

o Check Box: USDF recognized shows require USDF participating or group membership for riders and 
owners (non-members may pay a non-member fee and people participating in only exempt classes 
pay no fee – more later).  Therefore, ensure the USDF check box is checked.

o Date: USDF annual membership begins on December 1 of a year and ends November 30 of the 
following year.  Therefore, enter November 30 of the competition year.

• ❺ FEI:  Used for FEI shows, which are not covered in this manual.

IMPORTANT NOTE: For Show Preferences > Membership Tab instructions from EE, click here and look at page 2.  
These additional instructions are important to optimally setup your show so it can be published to EE and enable 
the entries created on EE to be imported back into FVD.

2. SHOW PREFERENCES > MEMBERSHIP (1) TAB:

2

1

3

4

5

NOTE: For Equine Canada (EC) shows, the National Level must be 
EC.  When EC is entered in the USEF Label box, FVD changes the 
National Level to Use EC and applies EC rules, section codes, etc.

XXXX

XXXX

XXXX

XXXX

https://www.equestrianentries.com/public/bluesteel/img/pdf/Part%20I%20Show%20and%20Class%20Set%20up%20Guide.pdf
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Edit a Show Template > 2. Show Preferences > Membership (2) Tab

SECTION II. BEFORE THE SHOW

• Click the ❶ Membership (2) tab.
• The ❷ Membership (2) tab opens. It covers local organization membership rules.  

o There is a ❸ FVD Section and an ❹ EE Section.
o Each ❺ row represents FVD and EE data for each local organization.

• ❻ Local 1 Level:
o ❼ FVD Section:

▪ Check Box: Check the box if your show complies with local organization membership rules.
▪ Date: Enter the local membership expiration date for the current competition year.
▪ Label: Enter a label that represents the local organization.

o ❽ EE Section:
▪ Non-member Fee Type:  Click the drop-down arrow and select one:
➢ No: no non-member fee (default).
➢ Per Show: non-member fee per show.
➢ Per Class - Non-exempt:  non-member fee for each non-exempt class.
➢ Per Class - All: non-member fee for all classes.

▪ Fee for:  Check each applicable box if there is a membership requirement or a non-member fee for the 
Horse, Owner, Rider, Trainer and/or Coach.

▪ Organization Partner:  GMOs that have an agreement whereby a membership in one GMO affords 
membership benefits in a second GMO.  Applies to non-member fees in non-USEF/USDF GMO shows.

▪ Edit Show Fees: Click the box to open the Show Fees form so you can enter the local fees (see Show Fees). 
• ❾ Local 2 Level and Local 3 Level:  Complete as for Local 1 Level if your show follows additional local organization 

membership rules.

❸ FVD Section ❹ EE Section

❺ Row of Data

7

1

2

6 8

9

9

MM/DD/YYYY

MM/DD/YYYY

MM/DD/YYYY

NOTE: USEF GR1210.12 prohibits the collection of mandatory membership fees or non-member fees from local organizations, as 
concisely explained in an October 22, 2019 USEF letter: “No organization, other than the USEF and its Recognized Breed and Discipline 
Affiliates, may require mandatory membership or a non-member fee as a condition of participation in a USEF Licensed Competition. (See 
GR1210.13 for further information regarding the collection of mandatory participation fees at USEF licensed competitions).”  Therefore, 
the fees on this tab do not apply to USEF licensed / USDF recognized shows; they may apply to schooling shows, Western shows, etc.

IMPORTANT NOTE: Local 
membership fees are not allowed 
for USEF licensed / USDF 
recognized shows.  (See note 
below.)  Therefore, Membership (2) 
is mainly for non-USEF/USDF 
shows.

2. SHOW PREFERENCES > MEMBERSHIP (2) TAB:
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SECTION II. BEFORE THE SHOW

• Click the ❶ Divisions tab.
• The ❷ Divisions tab opens.
• The default divisions (Yes, No, Adult Amateur, JR/YR and Open) are specifically used for, and to identify, 

GAIG qualifying rides.  See Class Entries > Qualifying Status for GAIG Regional Championships for 
information on entering the GAIG divisions. 

• If your show has special divisions, enter the division name(s) in the ❸ Divisions box.  As examples, your 
show may have separate JR and YR divisions, an AJY (Amateur, Junior, Young rider) division, a Vintage 
division, etc.  You are limited to 13 characters and spaces.  If you use a special division for a ride, it 
cannot simultaneously be entered as a GAIG Q ride.

• Click ❹ Close to save your Show Preferences data.

75

Edit a Show Template > 2. Show Preferences > Divisions Tab

1

23

4

2. SHOW PREFERENCES > DIVISIONS TAB:
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SECTION II. BEFORE THE SHOW

• Select ❶Main Menu / ❷ Show Office / 
❸ Show Fees.

• The ❹ Show Fees form opens.

• The show fees table has two sections and 
multiple rows of data:
o ❺ FVD Section – highlighted in orange 

below.  This fee information is integral 
to the FVD program and is reflected in 
the program reports, etc.

1

2

3

76

Edit a Show Template > 3. Show Fees > Overview

IMPORTANT NOTE: For Show Fees instructions from EE, click here.  These additional instructions are important to 
optimally set up your show so it can be published to EE and enable the entries created on EE to be imported back 
into FVD.

NOTE: USDF and USEF fees change often; 
therefore, the default FVD value is $0.00.  
Enter the USEF and USDF fees in force at the 
time you create the template (or the show). 
Check the fees before each show to ensure 
you are charging riders the correct fees.  
Update the fees in the template as they 
change.  

4

❺ FVD Section ❻ EE Section

❼ Row of Data

3. SHOW FEES > OVERVIEW:

o ❻ EE Section – highlighted in blue below.  This fee 
information is an expansion of the FVD section 
information and provides additional information 
required for uploading the fee information to EE and 
for downloading entries from EE into the FVD 
program.  If a show is not using EE, this information 
can be disregarded.

o ❼ Rows of Data - Each complete row in the table (a 
row is outlined in red below) represents one fee.  For 
example, the FVD Daily Stabling = EE Day Stall.

https://www.equestrianentries.com/public/bluesteel/img/pdf/Part%20II%20Fees.pdf
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SECTION II. BEFORE THE SHOW

• The FVD program has two sets of fees, each with a separate tab: 
o ❶ System Fees are built into the program and some FVD features cannot be edited.
o ❷ Custom Fees are entered by show management and all FVD and EE features can be edited.

77

Edit a Show Template > 3. Show Fees > System Fees & Custom Fees

❸ Description FVD description of the fee.  This will also be seen by entrants using the EE system.

❹ Rate Cost of one unit of the fee.  For example, $8 for one bag (one unit) of bedding.  This 
is the fee that will be charged in FVD and EE.

❺ [FVD Fee] Type FVD fee type.  See Show Fees > Custom Fees > Options for the options.

❻ A (Automatic) • If the A box is checked, the FVD program automatically enters this fee for all hand-
typed entries for which the user clicks the Add Auto Fees button (see Stabling >  
Fees and Other Fees, item 2).  The fee is automatically entered for EE entries if OE
is also checked.

• If the A box is not checked, for hand-typed entries the fee must be entered.  For  
EE entries, the entrant must select each fee that applies to that particular entry.

❼ OE* (Online Entry) • If the OE box is checked, the fee is uploaded to the EE web site.  
• If the OE box is not checked, the fee is not uploaded to the EE web site so riders 

cannot select the fee.

❽ OE Fee Type* EE fee type. See Show Fees > Options for the options.

❾ OE Occurrence* Frequency the fee is paid.  See Show Fees > Options for the options.

• For both System Fees and Custom Fees, there are specific FVD and EE fee data headings:

1

5

2

43 6 7 8 9

3. SHOW FEES > SYSTEM FEES & CUSTOM FEES:
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• In the ❶ Show Fees form, select the ❷ System Fees tab.  
• In the System Fees table new fees cannot be added.
• ❸ Description – Cannot be edited in System Fees.
• ❹ Rate – Can be edited.  For the fees you want to use, enter the costs per unit for the current competition. 
• ❺ [FVD Fee] Type – Cannot be edited in System Fees.
• ❻ [FVD] A (Automatic) – Can be edited.  Check the A box for fees that apply to all entries.  The FVD program 

automatically enters the fees for all entries for which the user clicks the Add Auto Fees button (see Stabling 
Fees and Other Fees/Payments, item 2).

• ❼ OE* (Online Entry) – Check the box for all fees that you want to have uploaded to the EE system so riders 
can select the fees when entering the show. 

• ❽ OE Fee Type* - Using the drop-down arrow, select the fee type that corresponds to the fee.  See Show 
Fees > Options for the options.

• ❾ OE Occurrence* – Using the drop-down arrow, select the occurrence that applies to the fee. See Show 
Fees > Options for the options.

• ❿ Qualifying Class Entry Fee – Enter the current fee for GAIG qualification.  For 2021 it is $15 additional for 
each qualifying ride.  This fee must be paid BEFORE the ride.

78

Edit a Show Template > 3. Show Fees > System Fees

SECTION II. BEFORE THE SHOW

• IMPORTANT NOTE 1: EE instructions recommend using System Fees only for the most basic fees.  This 
includes Drug/Horse USEF, Haul In Fee, RV Hookup, USDF Non-member fee and USEF Show Pass fee, using 
the settings below.  Click here for more information from the EE web site.

• IMPORTANT NOTE 2: Since FVD tracks the Drug/Horse USEF, USDF Non-member, and USEF Show Pass fees 
for after-show reports and payments to USEF and USDF, it is best to use these built-in FVD system fees.

3. SHOW FEES > SYSTEM FEES:

2 5 6 7 843 9

1

= System Fees and settings recommended by EE.  Click here for more information.

[See NOTE 2]

[See NOTE 2]
[See NOTE 2]

10

EE E E E

https://www.equestrianentries.com/public/bluesteel/img/pdf/Part%20II%20Fees.pdf
https://www.equestrianentries.com/public/bluesteel/img/pdf/Part%20II%20Fees.pdf
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SECTION II. BEFORE THE SHOW

• In the ❶ Show Fees form, select the ❷ Custom Fees tab.  All cells in the custom fees table can be edited.
• ❸ [FVD] Description - Type in nomenclature for the fee.  This is what the competitor sees on the entry so 

be very clear.  For example, enter Competitor Party ($30) if you are having a party.
• ❹ [FVD] Rate - Enter the cost of the custom fee.  For example, if your party fee is $30, enter $30.  
• ❺ [FVD] Type - Using the drop-down arrow, select the fee type. See Show Fees > Options for the options.  

This example is OF (Other Fee).
• ❻ [FVD] A (Automatic) - The FVD program enters this fee for all entries for which the user clicks the Add 

Auto Fees button (see Stabling Fees and Other Fees/Payments).  In this example, the party is optional, so the 
A box is not checked.

• ❼ OE* (Online Entry) - Check the boxes for all fees that you want to be uploaded to the EE system so riders 
can select them when entering yours show.  You want riders to go to the party, so the OE box is checked.

• ❽ OE Fee Type*- Using the drop-down arrow, select the OE Fee Type. See Show Fees > Options for the 
options.  Leave blank for all fees for which OE is not checked.  This example is a Custom fee.

• ❾ OE Occurrence* - Using the drop-down arrow, select the frequency by which the fee is applied. Leave 
blank for all fees for which OE is not checked. See Show Fees > Options for the options.  This example is a 
Yes.

• When you are finished entering your custom fees, click ❿ Close.

79

Edit a Show Template > 3. Show Fees > Custom Fees

IMPORTANT NOTE: EE instructions recommend most fees be listed in the Custom Fees tab.  Click here for more 
information from the EE web site (downloads a PDF file).

3. SHOW FEES > CUSTOM FEES:

2
1

3 5 6 7 84 9

NOTE: See next page for examples of Custom Fees.

10

EE E E EEE

https://www.equestrianentries.com/public/bluesteel/img/pdf/Part%20II%20Fees.pdf
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SECTION II. BEFORE THE SHOW

• Example of completed Custom Fees:

80

Edit a Show Template > 3. Show Fees > Custom Fees > Examples

= Custom Fees and settings recommended by EE.  There are many variations and explanations.  
Click here for more information.

3. SHOW FEES > CUSTOM FEES > EXAMPLES:

https://www.equestrianentries.com/public/bluesteel/img/pdf/Part%20II%20Fees.pdf
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Per 
Day

Charged to entries for each DAY the item is used.  For example, stall that is charged for each DAY the stall 
is used.  Example: Fee of $80/day for Fri & Sat = $160.

Per 
Night

Charged to entries for each NIGHT the item is used.  For example, stall that is charged for each NIGHT the 
stall is used.  Example: Fee of $80/night for Fri & Sat = $160 (it is used Fri night).

Per 
Show

Charged to entries one time per SHOW.  For example, stall that is charged one time for the entire SHOW.  
The stall is used the entire show.

Yes The fee is charged if the competitor selects the applicable fee. The fee is also used for mandatory fees. 

No The fee is charged if the competitor does not select the fee.  

81

Edit a Show Template > 3. Show Fees > Custom Fees > Options

SECTION II. BEFORE THE SHOW

❽
O

E*
 Fee Typ

e
❾

O
E*

 O
ccu

rren
ce

❺
[FV

D
 Fee] Typ

e

SS Stabling - Stall Fee for a horse stall.

ST Stabling - Tack Fee for a tack stall.

SB Stabling - Bedding Fee for stall bedding, per bale.

SO Stabling - Other Fee for any other stall item.

OF Other Fees Fee for all other items.

USEF Drug & Medication Fee Per horse fee required by USEF to cover drug testing.   Some exemptions.

USEF Discipline Fee Fee charged by an equestrian discipline.  There is no dressage fee.

USEF Non-Member Fee Per person fee charged by USEF for a non-exempt non-member person.

USDF HID Fee HID = USDF horse identification number.  Required by USDF for horses in 
non-exempt classes. A one-time fee, not annual.  

USDF Non-Member Fee Per person fee charged by USDF for non-member non-exempt people.

Grounds/Haul-In Fee Per horse fee to use the show grounds.  Can be a daily fee or a show fee.

Late Fee – per Entry (if applicable) Fee for acceptance of a late entry, per entry.

Late Fee – per Class (if applicable) Fee for acceptance of a late entry, per class.

RV (hook-up) Fee Fee for a recreational vehicle hook-up, usually to electricity.

RV/Camping Fee (no hook-up) Fee for a recreational vehicle without a hook-up.

Overnight Stabling Fee for an overnight horse stall.  Can be a Per Night or a Per Show fee.

Day Stall Fee for a day horse stall.  Usually a Per Day fee.  Horse cannot stay 
overnight.

Tack Stall Fee for a tack stall.  Can be a daily, nightly, or show fee.

Grooming Stall Fee for a grooming stall.  Can be a daily, nightly, or show fee.

Non-Compete Horse Stall Fee for a horse stall for a non-competing horse.  Daily, nightly, or show fee.

Local 1 Level Fee for first local organization.

Local 2 Level Fee for second local organization.

Local 3 Level Fee for third local organization.

Custom Fee Any other type of fee without a quantity.

Custom Fee w/ Quantity Any other type of fee with a quantity.  Example: Party ticket(s).

Office Fee Fee for show office activities.  Usually a show fee charged per entry.

Shavings/Bedding Fee for stall bedding, per bale.

Mandatory A fee that is required (mandatory) for all entries.

See next page for more information on Yes/No.
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Edit a Show Template > 3. Show Fees > Custom Fees > Options (Yes/No)

SECTION II. BEFORE THE SHOW

Additional information for OE Occurrence Yes/No (provided by EE)

• OE OCCURRENCE Yes/No for Custom Fees:
• Entrants have a box they can check for each fee if they want what that fee is offering.  Sometimes this 

box also comes with a pull down list of numbers for quantity.  Other times they can check YES or NO.
• Yes:
o If the box for the fee is checked, the fee will be charged.
o If the box for the fee is not checked, the fee will not be charged.

• Yes examples:
• Would you like an extra bag of shavings ($8) – if they check the box, then yes they get charged the 

$8.
• Would you like extra tickets to the party ($10 each) – if they check the box, then yes they get 

charged the $10; if they choose more than the default of 1 they will be charged $10 for each ticket.
• No:
o If the box for the fee is checked, the fee will not be charged.
o If the box for the fee is not checked, the fee will be charged.  (No is rarely used but is available if 

needed.)
• No example:

• Are you a resident of XYZ County?  (If not, there is a $10 fee).  If they check the box, they are saying 
yes, they are a resident of XYZ County and they are not charged the fee.  If they do NOT check the 
box, they are saying no they are not a resident of XYZ County and they get charged $10.

• OE Occurrence Yes for Mandatory Fees:
• A Yes OE Occurrence for a mandatory fee means every entry will be charged the fee.
• Example: XYZ Agriculture Ministry Fee ($5) – all entries are charged the fee whether or not they check 

the box.

3. SHOW FEES > CUSTOM FEES > OPTIONS (YES/NO):
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Edit a Show Template > 3. Show Fees > Custom Fees > USEF & USDF

SECTION II. BEFORE THE SHOW

Description Rate Type Auto

2022 USEF Membership – 3-year Active – expires three years from start $225 OF (Other Fee) 

2022 USEF Membership – 1-year Active – expires one year from start $80 OF (Other Fee) 

2022 USEF Membership – Life Member $2,500 OF (Other Fee) 

2022 USEF Membership – Fan – expires one year from start $25 OF (Other Fee) 

2021 USEF Lifetime Horse Recording – Birth to December 31st of birth year $35 OF (Other Fee) 

2021 USEF Lifetime Horse Recording – One year of age (from Jan 1st to Dec 31st

of first year after foaling) and older
$300 OF (Other Fee) 

2021 USEF Annual Horse Recording – expires Nov 30th $95 OF (Other Fee) 

2021 USDF Membership – 1-year Participating Membership – expires Nov 30th $90 OF (Other Fee) 

2021 USDF Membership – 1-year Youth Participating Membership – expires Nov 
30th $72 OF (Other Fee) 

2021 USDF Membership – 5-year Participating Membership – expires Nov 30th $360 OF (Other Fee) 

2021 USDF Membership – Lifetime Participating Membership – expires Nov 30th $1800 OF (Other Fee) 

2021 USDF Membership – Business – expires Nov 30th $240 OF (Other Fee) 

2021 USDF Lifetime Horse Registration (LHR) $115 OF (Other Fee) 

2021 USDF Upgrade from HID to Lifetime Horse Registration $80 OF (Other Fee) 

2021 USDF Horse Identification Number (HID) $35 OF (Other Fee) 

• During your show, some participants may want to become USEF and/or USDF members and/or may want 
to USEF record and/or USDF register a horse (the Show Office should have the required forms).  The 
associated fees must be entered in the FVD program and submitted, in full, to USEF or USDF at the end 
of the show.   It is much easier if these fees are paid by a separate check made out to USEF or USDF, 
which keeps these funds separate from the show funds.  However, some participants may want to pay in 
cash or the fee may be included in the same check/credit card payment submitted for the show.  
Regardless of the type of payment, you must track the fees to ensure they are sent to USEF or USDF, by 
including them in or with your USEF or USDF payment. 

• To ensure tracking of these USEF and USDF fees, you can enter any of the following as Custom Fees if 
they are paid to the show by a competitor.  The fees are tracked using the Reports > Post-Show > Profit 
(Loss) Statement.  It will be easier for you if you enter these fees BEFORE the show so they will already 
be available to you if you need to use them.  

• As you do not need these fees in EE, do not use the EE Section of the Custom Fees table.
• The following are fees as of January 2020:

NOTE:  Requirements and fees may change year-to-year.  For the 2022 online information and fees, go to:
2022 USEF People Memberships – Click here.
2021 USEF Horse Recording – Click here.
2021 USDF Human/Business Memberships – Click here.
2020 USDF Horse Registration – Click here.

3. SHOW FEES > CUSTOM FEES > USEF & USDF:

https://www.usef.org/join-usef
https://www.usef.org/compete/resources-forms/horse-services
https://www.usdf.org/join/
https://www.usdf.org/join/horse.asp
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• Select ❶Main Menu / ❷ Show 
Office / ❸ Payment Types.  

84

Edit a Show Template > 4. Payment Types

SECTION II. BEFORE THE SHOW

4

5

1

2

3

• The ❹ Payment Types form opens.
• Make additions, if needed.  For example, if you 

accept payment via PayPal, add PayPal to the list 
by typing PayPal into the blank row adjacent to 
the *. 

• Make deletions, if needed/desired.  For example, 
if you do not accept cash, delete Cash by clicking 
the small box corresponding to the Cash row, 
then click the  – button.

• Click ❺ Close to save the changes.

4. PAYMENT TYPES:
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• Select ❶Main Menu / ❷ Show Office /        
❸ Credit Card Types.  

4

5

85

Edit a Show Template > 5. Credit Card Types

SECTION II. BEFORE THE SHOW

• The ❹ Credit Card Types form opens.
• Make additions or deletions, if needed.  
• Click ❺ Close to save the changes.

• This step is required only if you accept credit cards.

1

2

3

5. CREDIT CARD TYPES:
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• Select ❶Main Menu / ❷ Show Office /        
❸ Stalls.  

86

Edit a Show Template > 6. Stalls

SECTION II. BEFORE THE SHOW

• The ❹ Stalls form opens.
• The values are alpha/numeric, which means you 

can enter letters and numbers.
• You can enter up to 10 letters and numbers; 

however, to fit on forms, short nomenclature is 
recommended.

• Enter your stall numbers.  Use a system that is 
easy for you and understandable by show 
participants.
o If you have 1-99 stalls, start with 01, 02, 03, 

04, …, 10, 11, 12, 13 … .   This results in the 
numbers sorting numerically.

o If you have 1-100+ stalls, start with 001, 002, 
003, 004, …, 010, 011, 012, 013, 014, …, 100, 
101, 102, … . This results in the numbers 
sorting numerically.

o If you have stalls in different barns, for 
example Barn A and Barn B, you could enter 
something like A-01, A-02, …, B-01, B-02, etc.

• Click ❺ Close to save the changes.

1

2

3

4

5

• This step is required if you have stalls and you 
want to assign stalls via FVD.

6. STALLS:
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• Select ❶Main Menu / ❷ Show Office /        
❸ Stall Groups.  

87

Edit a Show Template > 7. Stall Groups

SECTION II. BEFORE THE SHOW

• The ❹ Stall Groups form opens.
• Enter the names of Stall Groups that participate 

in many of your shows that will be based on this 
template.

• Click ❺ Close when you are done.
• Additional Stall Groups can be added to the 

template later, or can be added in the show file.

1

2

3

• A Stall Group is a name declared by a group of people who want to stable together.  For example, you 
might have Green Tree Dressage or Suzy Parker Group.

• Stall Group names are only entered in a template if you have recurring Stall Group names.
• For most shows, Stall Group names are established in the show file as you receive entries.

4

5

• This step is required if you have stalls and want to use FVD to track groups of people that want to be 
stalled together.

7. STALL GROUPS:
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SECTION II. BEFORE THE SHOW

• Select ❶Main Menu / ❷ Show Office /        
❸ Classes.

88

Edit a Show Template > 8. Classes

• The ❹ Class form opens.
• ❺ Class Number: Each class must have a unique class number.  Enter the class number, which should 

match the number in the Prize List.  You can only use numbers; one decimal is allowed.  See 
RECOMMENDED DRESSAGE CLASS NUMBERS for recommendations on a convenient (but not required) 
method to number classes.

• ❻ Text: Each class must have a unique class text.  Enter text applicable to the Class; for example, Class # 
plus O, AA, JYR, AJY, etc.  Up to ten letters, numbers, punctuations, and spaces may be entered.

• ❼ Closed: Check the box if the class is filled and therefore closed to additional entries.
• ❽ Class Name: Enter the name of the class. If the class is Open, AA,  JYR, or AJY, include these terms in 

the name.  If the class is a GAIG qualifier, include GAIG in the name.  If it is a championship class, indicate 
that.  Etc.  Up to 50 letters, numbers, punctuations, and spaces may be entered.

Continued on next page…

1

2

3

IMPORTANT NOTE: For Classes instructions 
from EE, click here and look at page 4.  These 
additional instructions are important to 
optimally set up your show so it can be 
published to EE and enable the entries created 
on EE to be imported back into FVD.

8. CLASSES:

4
5 6 7

8

NOTE 1:  ❺ Class numbers may not contain letters 
but may contain a decimal to one place (for 
example, 103.3 but not 103 AJY and not 103.31).

NOTE 2:  It will be easier for you if you use a 
standard ❺ Class numbers method.  Although 
NOT required, the following is suggested:
• Open Class: 103.0 (0 = Open = all rider statuses 

may ride in the class; USEF non-members must 
be in open classes)

• AA Class: 103.1 (1 = one status of rider = AA)
• JYR Class: 103.2 (2 = 2 statuses of rider = JR and 

YR)
• AJY Class: 103.3 (3 = 3 statuses of rider = AA, JR, 

and YR)

https://www.equestrianentries.com/public/bluesteel/img/pdf/Part%20I%20Show%20and%20Class%20Set%20up%20Guide.pdf
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Edit a Show Template > 8. Classes, cont’d.

SECTION II. BEFORE THE SHOW

Continued on next page…

• ❾ Default Test: Using the drop-down arrow, select the test for this class.  Alternately, start to type the test 
and the similar text will be seen.  For EE, if it is a TOC class, select Online Test Place Holder. See DRESSAGE 
AND OTHER TESTS BUILT INTO FVD for a list of Default Tests built into FVD.  See Edit a Show Template > Test 
Editor, Set Up a New Show > 12. Test Editor and Show Office > Test Editor for the procedure to edit tests and 
add new tests.

• ❿ USEF Code (or EC Code): For submission to the USEF or EC.  Using the USEF Codes drop-down arrow (or EC 
Codes drop-down arrow), select the correct Dressage USEF or EC Section Code.  See USEF DRESSAGE SECTION 
CODES for the USEF codes list, which is a bit different from the FVD list (USEF no longer separates out Open, 
AA, and JYR classes; they are all Open).  See EQUINE CANADA (EC) SECTION CODES for the EC codes.

• ⓫ AHA Code: For submission to the Arabian Horse Association (AHA).  Click the Edit AHA Codes button and 
type in the code and description in the boxes.  Click here to open the AHA codes list (PDF file from the AHA web 
site).  Leave blank if your show is not an AHA show.

• ⓬ Date:  Since this is a template file, leave this box blank.
• ⓭ Ring: Since this is a template file, leave this box blank.

NOTE: EC Codes show only if EC was selected as the 
National Level in Show Preferences.  See Show Preferences > 
Membership (1) Tab.  See EQUINE CANADA (EC) SECTION 
CODES for a list of the EC Section Codes.

9

9

10
11

12
13

10

11

https://www.google.com/url?sa=t&rct=j&q=&esrc=s&source=web&cd=1&cad=rja&uact=8&ved=2ahUKEwivl-akhpXnAhWuV98KHV3XBdMQFjAAegQIARAB&url=https%3A%2F%2Fwww.arabianhorses.org%2F.content%2Faha-docs%2FAHA_Class_Code_List.pdf&usg=AOvVaw2miFC83m2RPrciIcHrDMbx
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SECTION II. BEFORE THE SHOW

90

Edit a Show Template > 8. Classes, cont’d.

Continued on next page…

• ⓮ Standard Fee: Enter the standard fee for the class. This should match the fee in the Prize List.  For EE, 
if the fee is not entered the rider will not be charged for the class!

• ⓯ Qualifying Fee: The Qualifying Class Entry Fee is entered in Show Fees.  FVD automatically adds the 
Qualifying Class Entry Fee to the Standard [Class] Fee, to determine the total Qualifying Fee, even if it is 
not a qualifying class.

• ⓰ Prize: Enter the prize only if it is the same for all of your shows that will be based on this template.
• ⓱ Sponsor: Enter the sponsor only if it is the same for all of your shows that will be based on this 

template.
• ⓲ Report Style: The program’s default is Standard and Breed.  For freestyle and quadrille tests, use the 

drop-down menu and change to USDF Freestyle and Quadrille or FEI Freestyle.
• ⓳Max Ribbons: Enter the maximum number of places for the class.  This is usually 6 (the FVD default); 

however, there may be more places for championship classes.
• ⓴ Exclude from eScores:  Check the box if the class should not be reported to USEF and USDF.  

Examples are Introductory and Eventing classes.  Opportunity classes are reportable.
• XX  Split for Awards - USEF eScores Only: If you will split a class for awards by rider status divisions, use 

the drop-down to select the appropriate divisions for the split.  This only affects the USEF eScores report 
(*.dat file); it does not actually split the class for placing, media report, etc.  If you use this FVD feature, 
see Create the FVD eScores (*.dat) File for correct set-up of the USEF eScores report.

• XX  Judge:  Since this is a template, leave this portion blank.

21
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Edit a Show Template > 8. Classes, cont’d.

Continued on next page…

• XX Level Type:  Using the drop-down arrow, select the appropriate class level type. 
o Exempt All:  All people and horses are exempt from USEF/USDF/GMO memberships and USEF Drug & Drug 

fees.  Example: Opportunity classes.
o Exempt Non-Members Only:  All people and horses are exempt from USEF/USDF/GMO membership 

requirements but will still be charged USEF Drug fees for USEF/USDF shows.  Example: Introductory classes.
o Exempt USDF Only: All people and horses in this class are exempt from USDF memberships.
o FEI:  FEI class at a USEF/USDF show; USEF & USDF people and horse membership rules apply.
o Training: Class has USEF/USDF training level tests; USEF & USDF people and horse membership rules apply.
o First: Class has USEF/USDF first level tests; USEF & USDF people and horse membership rules apply.
o Second: Class has USEF/USDF second level tests; USEF & USDF people and horse membership rules apply.
o Third: Class has USEF/USDF third level tests; USEF & USDF people and horse membership rules apply.
o Fourth: Class has USEF/USDF fourth level tests; USEF & USDF people and horse membership rules apply.
o CDI: FEI class at a CDI show; FEI people and horse membership rules apply.
o USDF Sporthorse Breeding: Class is a DSHB class and DSHB membership rules apply.
o Other: Class does not fall under any of the above.  

• XX Test of Choice:  Check the box if the class is a Test of Choice class.  The entrant chooses a test from a 
range defined in the prize list.  For example: FEI TOC would allow any FEI test, FEI GP TOC would allow GP 
and GP Special.  For EE entries, the test is displayed as Place Holder; the show secretary must manually 
enter the chosen test.

• XX Qualify:  Pertains to GAIG qualification.  Using the drop-down arrow, make the appropriate selection.
o No Q:  Rides in this class may not qualify for GAIG.
o Q Allowed: Rides in this class may qualify for GAIG if the GAIG fee is paid before the class.
o Q Required: Rides in this class must qualify for GAIG.  All entrants must pay the GAIG fee before the class.
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Edit a Show Template > 8. Classes, cont’d.

Continued on next page…

• XX Rider Status:  Check the box appropriate for the class.
o Open:  All riders may enter the class.  Professionals and USEF non-members must enter this class.  
o AA: Only Adult Amateur riders may enter the class.
o JR/YR: Only Junior Riders and Young Riders may enter the class.
o Other: Used for another division for your show.  For example, a Vintage Division for 55+ year old 

riders.
• XX Class Navigation:

o XX Previous Class:  Click to view the previous class.
o XX Class (Lookup): Use the drop-down arrow and select the class from the list.
o XX Next Class:  Click to view the next class.
o XX Add Class: Click to open a blank class that is used to add a new class to the template/show.
o XX Delete Class: Click to delete the class currently being viewed.
o XX View Class Copy: Used to copy a class; used with class splitting (see Split Classes).
o XX View Class Splitter: Used with Class Splitting (see Split Classes).
o XX View Wait List: Used to view a wait list for the class (see WAIT LIST).
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• To set up another class, click XX  Add Class and repeat steps ❺ through XX above.
• When you are finished, click XX  Close.
• When additional information is available, go back and enter the new information.
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Edit a Show Template > 9. Test Durations

• Test Durations are the time, in minutes, allowed for a dressage test from the ringing of the bell to the 
end of the time used by the judge to complete the dressage test sheet.

• FVD has built in Test Durations that are ideal for USEF/USDF shows.
• If you want more or less time, you may edit the Test Durations.  This is not recommended for USEF/USDF 

shows; however, it may be beneficial for schooling shows during which a judge may speak to the rider for 
1-2 minutes after the ride.  It may also be beneficial for dressage shows held by other disciplines.

1

2

3

4

5

6

• Click ❶Main Menu > ❷ Show Office > 
❸ Test Durations.

• The ❹ Test Durations form opens.
• Use the ❺ scroll bar until you see the test 

whose duration you want to edit.
• Select the test by clicking on it.
• Edit the time duration.  You can use decimals with 

one decimal place; however, it only makes sense 
to have #.0 and #.5.

• Click ❻ Close when you are finished.

9. TEST DURATIONS:

NOTE: If you hold both USEF/USDF shows and dressage schooling shows, or another type of show, if you edit Test 
Durations in FVD, the Test.tdf file is edited and your changes apply to all shows linked to this file.  You may want 
to copy your Test.tdf file so you have two files.  One is named for licensed shows (perhaps Lic-Test.tdf) and 
another for schooling shows (perhaps Sch-Test.tdf). You then edit the test durations in the test file used for the 
particular show/template.
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Edit a Show Template > 10. Test Editor

• FVD has MANY built in dressage tests including USEF/USDF tests, FEI tests, USEA tests, Western tests, and 
Cowboy tests.  See DRESSAGE AND OTHER TESTS BUILT INTO FVD for the list.

• You use the Test Editor if you need to add a test that is not built-in or if you want to delete a test.  This 
would rarely be done in a USEF/USDF test; however, a local test may be needed for a schooling show or 
your show may need a test written by another discipline.

1

2

3

• Click ❶Main Menu > ❷ Show Office 
> ❸ Test Durations.

• The ❹ Test Editor form opens.
• Go to the next page…

4

Continued on next page…

10. TEST EDITOR:

NOTE: If you hold both USEF/USDF shows 
and dressage schooling shows, or another 
type of show, if you edit Tests in FVD, the 
Test.tdf file is edited and your changes 
apply to all shows linked to this file.  You 
may want to copy your Test.tdf file so you 
have two files.  One is named for licensed 
shows (perhaps Lic-Test.tdf) and another 
for schooling shows (perhaps Sch-Test.tdf).  
You then edit/add/delete the tests in the 
test file used for the particular 
show/template.
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Edit a Show Template > 10. Test Editor, cont’d.

• ❺ Standard Marks numbers are the numbers of the test movements for the test (1, 2, 3, etc.).
• ❻ Standard Marks boxes contain the coefficients for each test movement.

o 0 = There is no such movement in the test.
o 1 = There is no coefficient for the movement in the test.
o 2 = There is a coefficient of 2 for the movement in the test.

• ❼ Collective Marks numbers are the numbers of the collective marks for the test (1, 2, 3, etc.).
• ❽ Collective Marks boxes contain the coefficients for each collective mark.

o 0 = There is no such collective mark in the test.
o 1 = There is no coefficient for the collective mark in the test.
o 2 = There is a coefficient of 2 for the collective mark in the test.

• ❾ Test ID Number is automatically entered by the FVD Program.
• ❿ Test Name is the test name. 
• ⓫ Test Short Name is a short name that you can give a test.  Each test short name must be unique – it 

can only be given to one test. 
• ⓬ Duration (min.) is the time provided to for the test (time to enter + ride time + administrative time).
• ⓭ Report Style: Use the drop-down arrow and select the appropriate style.
• ⓮ Decimal (0-2) is the number of decimal points in the score.  0.1 decimals are allowed in freestyles, 

young horse tests, and others.  0.5 decimals are allowed in USEF/USDF tests and FEI tests.

SECTION II. BEFORE THE SHOW

• ⓯ Group (Level) is the 
grouping for high score 
reports sorted by level.

• ⓰ Standard Count is the 
number of standard marks 
(movements) in the test.

• ⓱ Collective Count is the 
number of collective marks 
in the test.

• ⓲ Possible Score is the 
maximum possible score for 
the test.

• ⓳ Descriptions provide a 
short description of each 
movement.

• Use the ⓴ drop-down 
arrow or the XX Previous 
Test and XX Next Test icons 
to select a test.

• Use the XX  Add Test button 
to open a blank test that 
can be edited and saved.

• Use the XX  Delete Test 
button to delete a test.

• Click XX Close to save your 
edits and close the form.
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Create a Show File from a Show Template File

• From the ❶ Fox Village Dressage ribbon, click ❷ Create Show File.

1

2

• The ❸ Use Show Template File form opens in ❹ Your FVD Folder > Support folder.
• Select the appropriate template file by single clicking on the ❺ File name (it will have the *.kdf 

extension).  The file name will appear in the ❻ File name box.  Then click ❼ Open.
• Alternately, double-click the ❺ File name and the file opens.  The ❼ Open button is not used.

SECTION II. BEFORE THE SHOW

3
4

5

6

7

Continued on next page…

CREATE A SHOW FILE FROM A SHOW TEMPLATE FILE:
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Create a Show File from a Show Template File, cont’d.

SECTION II. BEFORE THE SHOW

• The ❽ New Show Data File form opens in ❾ Your FVD Folder.
• In the ❿ File name box, type the name of your show file.  In this example, it will be XXXX-BHD-Show.  

For your show, it is suggested you use the year (YYYY) or date (YYYY-MM-DD).
• Click ⓫ Save.

• If you open Your FVD Folder, you will see the new show file ⓬ 2020-BHD-Show.sdf.  FVD has 
automatically saved it as a *.sdf file.

• Congratulations, you have created a show file from a template file.

8 9

10

11

10 XXXX

12XXXX
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Open a Show File

• From the ❶ Fox Village Dressage ribbon, click ❷ Open Show File.

1

2

• The ❸ Open Show File form opens in ❹ Your FVD Folder.
• Select the appropriate show file by single clicking on the ❺ File name (it will have the *.sdf extension).  

The file name will appear in the ❻ File name box.  Then click ❼ Open.
• Alternately, double-click the ❺ File name and the file opens.  The ❼ Open button is not used.

SECTION II. BEFORE THE SHOW

3
4

5

6

7

8

• The ❽ New Show opens and is ready for you to 
link and set up.

• Link the show file with your HR.hdf and Test.tdf
files – see CHAPTER II.2. REPAIR ALL LINKS.
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SECTION II. BEFORE THE SHOW
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• Click ❶Main Menu >❷ Show Office >
❸ Show Information.

102

Set Up a New Show > 1. Show Information > General Tab

SECTION II. BEFORE THE SHOW

• The next step is to edit your show file to provide show specific information that is not in the template.
• If not already open, open your show (see OPEN A SHOW FILE).

1

2

3

IMPORTANT NOTE: For Show Information instructions from EE, click here and look at page 3.  These additional 
instructions are important to optimally set up your show so it can be published to EE and enable the entries created 
on EE to be imported back into FVD.

• The ❹ Show Information form opens.  
• Complete the empty boxes in the General tab, including:
o The official ❺ Show Name. In this example it is XXXX Blue Horse Dressage Show where XXXX is 

nomenclature to specify the particular show.   For example, the year as YYYY or the date as YYYY-
MM-DD).  If you have multiple shows per season (perhaps Spring, Summer and Fall), the name could 
be something like XXXX Spring Blue Horse Dressage Show.  This should be a formal show name as it 
will appear on many of your show documents.

o The name of the ❻ Technical Delegate.  Include the level and the state; for example, Terry Technical 
(rTD,ST).

o Any other information not provided by the template.
• Information marked with a * is required for registering the show with EE for online entries.

4

5

6

7

1. SHOW INFORMATION > GENERAL TAB:

https://www.equestrianentries.com/public/bluesteel/img/pdf/Part%20I%20Show%20and%20Class%20Set%20up%20Guide.pdf
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Set Up a New Show > 1. Show Information > Additional Tab

SECTION II. BEFORE THE SHOW

• Complete or update empty boxes in the Additional tab, including:
o The ❶ Global Memo if it was not in the template.
o The ❷Prize List URL if it was not in the template. 
o The ❸ Show URL if it was not in the template. 
o Any other information not provided by the template.

• Click ❹ Close. 

1

2
3

4

• The ❺ Show Name is now on the Main Menu.

5

1. SHOW INFORMATION > ADDITIONAL TAB:
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• Click ❶Main Menu >❷ Show Office >
❸ Show Preferences.

104

Set Up a New Show > 2. Show Preferences > General Tab

SECTION II. BEFORE THE SHOW

1

2

3

• The ❹ Show Preferences form opens.  
• In the ❺ General tab, provide any missing or new information.

4
5

2. SHOW PREFERENCES > GENERAL TAB:
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Set Up a New Show > 2. Show Preferences > Membership (1) Tab, Membership (2) Tab

SECTION II. BEFORE THE SHOW

• Click the ❶Memberships (1) tab.  
• Complete or update any needed information.

2

• Click the ❷Memberships (2) tab.  
• Complete or update any needed information.

2. SHOW PREFERENCES > MEMBERSHIPS (1) TAB:

2. SHOW PREFERENCES > MEMBERSHIPS (2) TAB:

1

YYYY

YYYY
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Set Up a New Show > 2. Show Preferences > Divisions Tab

SECTION II. BEFORE THE SHOW

1

2

• Click the ❶ Divisions tab.  
• Complete or update any needed information.
• Click ❷ Close when you are finished.

2. SHOW PREFERENCES > DIVISIONS TAB:
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• Click ❶Main Menu >❷ Show Office >
❸ Show Fees.

107

Set Up a New Show > 3. Show Fees > System Fees

SECTION II. BEFORE THE SHOW

1

2

3

• The ❹ Show Fees form opens.  
• Complete or update any information in the ❺ System Fees tab.

4

5

Continued on next page…

3. SHOW FEES > SYSTEM FEES:
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Set Up a New Show > 3. Show Fees > Custom Fees

SECTION II. BEFORE THE SHOW

• Click the ❶ Custom Fees tab.  
• Complete or update any needed information.
• Click ❷ Close when you are finished.

1

2

3. SHOW FEES > CUSTOM FEES:
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• Click ❶Main Menu >❷ Show Office >❸
Payment Types.

109

Set Up a New Show > 4. Payment Types, 5. Credit Card Types

SECTION II. BEFORE THE SHOW

1

2

3

• The ❹ Payment Types form opens.  
• Complete or update any needed information.
• Click ❺ Close when you are finished.

4

5

• Click ❻Main Menu >❼ Show Office >❽
Credit Card Types.

6

7

8

• The ❾ Credit Card Types form opens.  
• Complete or update any needed information.
• Click ❿ Close when you are finished.

4. PAYMENT TYPES:

5. CREDIT CARD TYPES:

9

10
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• Click ❶Main Menu >❷ Show Office >
❸ Stalls.

110

Set Up a New Show > 6. Stalls, 7. Stall Groups

SECTION II. BEFORE THE SHOW

1

2

3

• The ❹ Stalls form opens.  
• Complete or update any needed information.
• Click ❺ Close when you are finished.

4

5

• Click ❻Main Menu >❼ Show Office >
❽ Stall Groups.

6

7

8

• The ❾ Stall Groups form opens.  
• Complete or update any needed information.
• Click ❿ Close when you are finished.

6. STALLS:

7. STALL GROUPS:

9

10

NOTE: Stall groups are usually 
added as you process entries.
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• Click ❶Main Menu >❷ Show Office >
❸ Classes.

111

Set Up a New Show > 8. Classes

SECTION II. BEFORE THE SHOW

1

2

3

• The ❹ Class form opens.  
• For each class, complete or update any 

needed information, including:
o ❺ Date: 

▪ Click the ❻ Edit Dates button and 
enter your show date(s) 
(MM/DD/YYYY) then click Close.

▪ For each class, use the date ❼
drop-down arrow to select the class 
date.

Continued on next page…

8. CLASSES:

6 9
o ❽ Ring:

▪ Click the ❾ Edit Rings button and enter 
your show’s rings (# and letters).  Keep the 
name short as there is limited space on 
reports.

▪ After scheduling, for each class, use the ring 
❿ drop-down arrow to select the ring.

o ⓫ Prize: Enter the class prize, if there is one.
o ⓬ Sponsor:  Enter the class sponsor, if there 

is one.

MM/DD/YYYY

4

5
6

7
8

9
10

11
12
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Set Up a New Show > 8. Classes, cont’d.

SECTION II. BEFORE THE SHOW

o ⓭ Judge:
▪ Enter the judge names:
➢ Click the ⓮ Edit Judges button.
➢ The ⓯ Judge form opens.
➢ Enter the judge’s ⓰ First Name.
➢ Enter the judge’s ⓱ Last Name followed by the rating and the state (such as Mary Smith 

(S,VA)).
➢ Click the form’s ⓲ Close button.

▪ Select the judge(s) for the class:
➢ For each dressage letter where you have a judge (E, H, C, M, B), use the ⓳ drop-down arrow to 

select the judge(s) for the class.
• Continue until you have entered the information for all classes.
• You can return and edit this information at any time.
• Click ⓴ Close when you are finished.

13

14

15

16
17

18

19

20

19
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• Click ❶Main Menu >❷ Show Office >
❸ Teams.

113

Set Up a New Show > 9. Teams

SECTION II. BEFORE THE SHOW

1

2

3

• The ❹ Team form opens.  
• If your show has teams, enter the names of the 

teams.
o Click the ❺ Previous Team button to view the 

previous team.
o Use the ❻ Team (Lookup) drop-down arrow 

to open a list of teams, then select the team 
you need to edit.

o Click the ❼ Add Team button to add a line for 
a team.

o Click the ❽ Delete Team button to delete the 
open team.

• During the show, use the ❾ Place box to enter 
each team’s place in the competition.

• Click ❿ Close when you are finished.

NOTE: The following special characters cannot be in a team name:  
• < (less than)
• > (greater than
• & (ampersand)
• ‘ (apostrophe or single quote)
• “ (double quote)

4

5

6

7 8 9 10

NOTE: For details on managing 
teams, see MANAGING TEAMS.

9. TEAMS:
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• Click ❶Main Menu >❷ Show Office 
>❸ Test Durations.
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Set Up a New Show > 10. Test Durations

SECTION II. BEFORE THE SHOW

1

2

3

• The ❹ Test Durations form opens.  
• As in the templates chapter, make any needed 

changes.
• Click ❺ Close when you are finished.

4

5

10. TEST DURATIONS:
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• Click ❶Main Menu >❷ Show Office >
❸ Test Editor.

115

Set Up a New Show > 11. Test Editor

SECTION II. BEFORE THE SHOW

1

2

3

• The ❹ Test Editor form opens.  
• See Test Editor for test editing procedure.
• Click ❺ Close when you are finished.

4

5

11. TEST EDITOR:  
• Used to edit tests in FVD (not recommended) or add tests to FVD.
• FVD has MANY built in dressage tests including USEF/USDF tests, FEI tests, USEA tests, Western tests, 

and Cowboy tests.  See DRESSAGE AND OTHER TESTS BUILT INTO FVD for the list.
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SECTION II. BEFORE THE SHOW



Fox Village Dressage User Manual – 2021 Update 1.0.5. helpdesk@foxvillage.com                 www.foxvillage.com

• After your show has been setup, you need to:
o ❶ Register it with FVD.  When you Register a show with FVD:

▪ It is entered in FVD’s database. 
▪ Your show is on the FVD Online Entries, Ride Times and Results page (click here) which lets 

people look up information about your show.
▪ You can use the FVD Entry Confirmation system, which lets you communicate with your 

entrants regarding their entry.
o ❷ Publish it with EE. When you Publish a show with EE:

▪ It is entered in EE’s database.  
▪ Puts the show on their online show calendar (click here) so people can enter your show online 

using EE.

117

Register Show with FVD

SECTION II. BEFORE THE SHOW

1

2

• This chapter covers registering a show with FVD.

http://www.foxvillage.com/fvdshowresults/(S(1xzk2nrcrsvebyu443lpht1m))/Show.aspx
https://www.eqentries.com/showcalendar
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Register Show with FVD, Cont’d.

SECTION II. BEFORE THE SHOW

1

2

• Click ❶Main Menu / ❷ Register Show.

• The ❸ Show Registration form opens.
• If any required information is missing, you get a 
❹message.  
o Use the ❺ scroll bar to see all the 

information and find the missing information.  
In this example, the ❻ discipline (USDF) show 
number is missing.

o To correct this error, click ❼ Edit Show 
Information button.

3

4

5

Continued on next page…

7

6

REGISTER A SHOW WITH FVD:
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Register Show with FVD, Cont’d.

SECTION II. BEFORE THE SHOW

• The ❽ Show Registration form opens.
o Enter the missing information.  In this example the ❾ USDF show number is entered.
o Click ❿ Close.

Continued on next page…

9

9

10

11

12

• You are returned to the ⓫ Show Registration 
form.

• The ⓬ Validate button is now red so you can 
validate your change.  Click the ⓬ Validate 
button.  (If there are other errors, the Validate 
button does not turn red; if that occurs, go back 
and look for additional error(s).)

• Some types of information are not required at 
this time; for example, the name of the Technical 
Delegate.  Scroll through the information one last 
time to ensure no available information is 
missing.

NOTE: In the past, USEF and USDF had different 
show numbers for the same show.  There is now one 
show number used by both organizations.  Yay!
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Register Show with FVD, Cont’d.

SECTION II. BEFORE THE SHOW

• The completed information will look similar to the following:

• You receive a ⓮ Fox Village Dressage form 
indicating your show has been registered.

• Click ⓲ OK.

13

14

• You are now ready to register your show.
• Click the ⓭ Register button.

15
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SECTION II. BEFORE THE SHOW
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• After your show has been setup, you need to:
o ❶ Register it with FVD.  When you Register a show with FVD:

▪ It is entered in FVD’s database. 
▪ Your show is on the FVD Online Entries, Ride Times and Results page (click here) which lets 

people look up information about your show.
▪ You can use the FVD Entry Confirmation system, which lets you communicate with your 

entrants regarding their entry.
o ❷ Publish it with EE. When you Publish a show with EE:

▪ It is entered in EE’s database.  
▪ Puts the show on their online show calendar (click here) so people can enter your show online 

using EE.

122

Publish a Show with EE

SECTION II. BEFORE THE SHOW

1

2

• This chapter covers publishing a show with EE.

http://www.foxvillage.com/fvdshowresults/(S(1xzk2nrcrsvebyu443lpht1m))/Show.aspx
https://www.eqentries.com/showcalendar


Fox Village Dressage User Manual – 2021 Update 1.0.5. helpdesk@foxvillage.com                 www.foxvillage.com123

Publish a Show with EE, Cont’d.

SECTION II. BEFORE THE SHOW

• The next step is to enter and verify information 
so your show can be published with EE.  

• Click ❶Main Menu > ❷ Publish Show.

• The ❸ Publish Show form 
opens.  

• ❹ Prize List URL:  Enter the web 
address of the prize list.

• ❺ Show URL:  Enter the web 
address for the show.

• ❻ Online Entries Only:  Check 
this box if you will only accept 
online entries.

• ❼ Stabling included in entry 
fee:  Check this box if your 
stabling fee is included in your 
entry fee.

• ❽ Stabling Open Date*: Enter 
the first date stalls can be used.

• ❾ Stabling Close Date*: Enter 
the last date stalls can be used.

• ❿ Entries Open Date*: Enter 
the first date entries can be 
submitted.

• ⓫ Entries Close Date*: Enter the 
last date entries can be 
submitted.

• ⓬ Entries Close Time*: Enter 
the time entries closes.

• ⓭ Entries Close Time Zone*:  
Using the drop-down arrow, 
select the time zone.

IMPORTANT NOTE: For Publish Show instructions from EE, 
click here.  These additional instructions are important to 
optimally prepare your show so it can be published to EE and 
enable the entries created on EE to be imported back into FVD.

* = Required to publish show.

3

4
5
6

7
8
9

NOTE: Date format is 
MM/DD/YYYY

PUBLISH A SHOW WITH EE:

Continued on next page…

1

2

10

11

12

13

13

https://www.equestrianentries.com/public/bluesteel/img/pdf/Part%20III%20Publishing.pdf
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Publish a Show with EE, Cont’d.

SECTION II. BEFORE THE SHOW

NOTE: If you click the ⓮ Late Entries Close Date 
box, entrants may enter the show with EE through 
the late closing date.  If you do not click this box, 
entrants must enter the show through the official 
⓫ Entries Close Date.

11

• ⓮ Do you accept late entries?  
Check the box if you accept late 
entries.  If you check the box, 
the text below can be edited.  
Type in the following:
o ⓯ Late Entries Close Date: 

Enter the closing date for late 
entries.

o ⓰ Late Entries Close Time: 
Enter the closing time for late 
entries.

o ⓱ Late Entries Close Time 
Zone: Using the drop-down 
arrow, select the time zone.

o Click the ⓲ Edit Show Fees
button to open the ⓳ Show 
Fees form.  
➢ Click the ⓴ Custom Fees 

tab.  
➢ If not already done, enter 

a late fee using the 
procedures in Show Fees.

➢ Click XX Close to return to 
the Publish Show form.

21

NOTE: After you have published your 
show:
• DO NOT CHANGE CLASS NUMBERS
• DO NOT DELETE ANY FEES.

14
15

16 17

18

19

20

21

16
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Publish a Show with EE, Cont’d.

SECTION II. BEFORE THE SHOW

• XX Custom message to entrants 
for the entry page where they 
choose “Horse, Owner, Rider, 
Trainer and Coach”: Type in a 
message, if desired.

• XX Custom message to entrants 
for the entry page where they 
choose “Show Classes”: Type in 
a message, if desired.

• XX  Custom message to entrants 
for the entry page where they 
chose “Stabling”: Type in a 
message, if desired. 

• XX  Custom message to entrants 
for the entry page where they 
choose “Custom Fees”: Type in 
a message, if desired.

• XX Custom message to 
entrants for the entry page 
where they attach entry 
documents (Signature Page, 
Coggins, etc.):Type in a 
message, if desired.

• XX Class Report: Click the 
button.  The FVD Class Report 
opens.  Review the report and 
make any corrections.  Close the 
report.  The check box is 
automatically checked.

• XX Show Fee Report: Click the 
button.  The FVD Show Fee 
Report opens.  Review the 
report and make any 
corrections.  Close the report.  
The check box is automatically 
checked.

22

23

24

25

26

27

28

Continued on next page…

• XX Judge Report: Click the button.  The FVD Judge Report opens.  Review the report and make any 
corrections.  Close the report.  The check box is automatically checked. 

• XX Test Report: Click the button.  The FVD Test Report opens.  Review the report and make any 
corrections.  Close the report.  The check box is automatically checked.

• For 27-30 above, if any required information is missing, a XX Fox Village Dressage message opens.  If a 
message opens, first click XX OK then close Publish Show by clicking XX Cancel and enter the needed 
information in FVD.  If the message does not open, all required information has been entered but you still 
need to check for accuracy.

29

30

31

3332

22

23

24

25

26

27

28

29

30

31

32

33
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Publish a Show with EE, Cont’d.

SECTION II. BEFORE THE SHOW

• If you need to change show 
information, click XX  Edit Show 
Information.

• If you need to change show 
preferences, click XX  Edit Show 
Preferences.

• After entering all the required 
information, click the  XX  
Validate button.  The button 
text turns red after all the forms 
have been opened and viewed.  

• The Validate button no longer 
has red text, indicating the 
information has been validated.

• xx  By checking this check box, 
you agree that the information 
in the reports is correct text is 
now in black.  

• xx  Check the box.
• Enter your xx  Equestrian 

Entries Login User Name.
• Click xx  Publish.

• A xx  Fox Village Dressage form opens letting you know the show was 
uploaded successfully.

• Click xx OK.
• You will receive an email called “Publish Show – Your Show Name” informing 

you that the show was published.  You will receive a rejection email if EE finds 
an error.

37

38

39

40

41

42

34

35

36

34 3536

37

38

39 40

41

42
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Publish a Show with EE, Cont’d.

SECTION II. BEFORE THE SHOW

Publish Show Reports
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SECTION II. BEFORE THE SHOW
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• Select ❶Main Menu > ❷ Reports >❸ Pre-
Show > ❹ Prize List Labels. 

• The ❺ Prize List Labels report opens.  
• Enter the ❻ Last Show Date that you would like 

included; use the date format MM/DD/YYYY.  
• Check either ❼ Last Name, First Name sort 

order or ❽ Zip Code, Last Name, First Name 
sort order.

• Click ❾ OK. 

1

2

3

4

5

6

7

8

9

129

Snail Mail and Email Prize List > Snail Mail Prize List

SECTION II. BEFORE THE SHOW

• The ❿ Prize List Labels form opens.
• Check the labels to ensure they are the 

ones you intend to print.
• See PRINT LABELS AND INDEX CARDS

for the procedure to print labels and 
index cards.

• Click ⓫ Close Print Preview to close 
the report.

• Now that you have set up a show, if you have 
names and addresses from previous shows (they 
are in your HR.hdf file), you can easily send them 
the prize list via snail mail using mailing labels.

MAIL PRIZE LIST:

10
11
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• It is a lot easier, and cheaper, to email 
your prize list!

• First you copy the email addresses to 
your clipboard, then you email the prize 
list (or a link to the prize list) using the 
copied email addresses.

• Select ❶Main Menu > ❷ Show Office 
> ❸ E-mails to Clipboard.

• The ❹ E-mails to Clipboard form opens.  
• The ❺ E-mail Filter lets you select 
o Riders in Show
o Owners in Show
o Trainers in Show
o Coaches in Show
o All People in Show
o All People in HR Database

• To copy the email addresses of all People 
in your HR.hdf file to the clipboard: 
o Click the radial button of ❻ All 

People in HR Database to get a list of 
all people in the database.  

o If you only want people that 
participated in a show since a 
particular date, enter the date in ❼
Last Show Date.

o Click ❽ OK. 
o The email addresses are now in your 

clipboard.

130

Snail Mail and Email Prize List > Email Prize List

SECTION II. BEFORE THE SHOW

• Compose and send the email:
o Open your default email program.  
o In the TO: box, enter your email address (so you get the email).
o Place your curser in the BCC: box  (IMPORTANT: using BCC – blind carbon copy – ensures you are not 

broadcasting the email addresses to everyone) and select Paste (or keyboard Ctrl V).  The email 
addresses in your clipboard are pasted into the BCC: box.

o Compose your email with a Subject that clearly indicates the message is about the show.
o Type in any message you want to provide.
o Include your prize list in the email using one of two methods:
➢ Attach the prize list file to the email.  This may not be a good method if it is a large file.
➢ Include the URL (web address) to the prize list that you have already posted on your web site.  This 

is the better method as it does not clog email systems with attachments.

1

2

3

4

5

7

8

6

EMAIL PRIZE LIST:
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SECTION II. BEFORE THE SHOW



Fox Village Dressage User Manual – 2021 Update 1.0.5. helpdesk@foxvillage.com                 www.foxvillage.com

• The HR.hdf file (Horse & Rider data file) contains information (data) for horses and people 
(riders/handlers, owners, trainers, and coaches).  The file can be used for multiple shows and multiple 
years, making repeated entries unnecessary.  However, some of the data can get very old and the file can 
very get large.  After a while, it is therefore necessary perform Horse & Rider Database Management 
and to check the data before adding entries for your show.

• When you created the show on which you are working, you linked the Show Data file (*.sdf), the Horse & 
Rider data file (HR.hdf) and the Test file (Test.tdf) (see File Linking).

1

2

3

• If not already open, open the FVD 
program

• If not already open, open the show file 
on which you wish to work (see Open 
the Show File).  

• Select ❶Main Menu > ❷ Show Office
> ❸ Horses & Rider Database 
Management.

132

Horse & Rider Database Management

SECTION II. BEFORE THE SHOW

Continued on next page…

HORSE & RIDER DATABASE MANAGEMENT:
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• Click the ❻ Purge Records tab.
• Each record is the data for an individual person

or horse.  When a record is purged (deleted), that 
person or horse is no longer in your HR.hdf file.  
FVD helps you purge old records, so the file does 
not get too large or inaccurate due to old data.

• Enter a date for which people and horse data that 
have not been use since that date will be purged.  
Date format is MM/DD/YYYY.

• Click ❼ OK.  
• This deletes old, inactive people and horses. 

• Click the ❽ Clear Check Boxes tab.
• This step clears check boxes that were checked in 

previous shows.  This lets you verify all the data 
as newly entered/verified.

• For ❾ Clear All, select all that apply.  The most 
common selections are USEF Cards, USDF Cards, 
Coggins, and Vaccines.

• Click ❿ OK to save your selections. 
• Click ⓫ Close.

6

7

133

Horse & Rider Database Management, Cont’d.

SECTION II. BEFORE THE SHOW

• The ❹ Horse and Rider Database Management 
form opens.

• Click the ❺ Last Show Date tab.
• Use the default selections. 

5
4

NOTE: The Clear Check Boxes feature allows a show secretary to manage verifications over a season 
(membership year) – you can clear the verifications once a year or for each show, depending upon how you 
want to track the information.

8

9

10

11

9

9
9
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SECTION II. BEFORE THE SHOW
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INTRODUCTION:

135

Enter EE Online Entries > Introduction, EE Email

SECTION II. BEFORE THE SHOW

• When EE receives an entry and payment for your show, you will receive an email from EE similar to the 
following (the appearance will vary, depending upon your default email program):

• Open the email.

Show Name                                                                                                    Date

• The email has:
o ❶ Show Name.
o ❷ Rider Email, Secretary Email, EE Help Email, EE Info Email.
o Verification of online payment, including the ❸ Entrant Email (email of person who submitted entry).
o ❹ Secretary name and address.
o ❺ Link to entry pdf: View Entry

• Click ❺ View Entry.
o You are prompted to login to EE.  Enter your username and password and click Login.
o The entry opens as a PDF file.
o If you will use paper entries for the TD, Print the entry (do not use duplex as you may need to replaces 

pages later on).
o If you will use digital entries for the TD, save the PDF file.  The file’s EE number is the filename.  You 

may want to rename the file.  I use RiderLast-HorseName-Bridle#.pdf so the file is easy to find (you 
can also get the file from the EE web site any time you need it).

• The pages of an EE entry PDF are on the next pages…

Date and Time Email Sent

Show Name

Secretary: Suzy Secretary
Secretary Address:
3967 Red Street
Anytown, ST 12345

RiderEmail, SecretaryEmail, EE-Help, EE-Info, 

EntrantEmail@email.com Date and Time Email Sent

1

2

3

4

5

• You will receive entries in one of three methods:
1. Entries imported electronically via EE.  You receive this entry via email notification.
2. Entries prepared with EE, then printed and snail mailed.  When you receive this entry, you download 

the entry data, less supporting documents, via the EE web site.
3. Entries that did not use EE, are usually handwritten, and are snail mailed.

• The first two methods allow download of entry information directly into FVD.
• The third method requires you to hand-enter the entry information.  Some shows charge a fee for this 

type of entry.
• We will start with method 1.
EE EMAIL:

NOTE: Click here for EE instructions 
on importing online entries.

mailto:EntrantEmail@email.com
https://www.equestrianentries.com/public/bluesteel/img/pdf/Part%20IV%20Entry%20Import.pdf
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Enter EE Online Entries > EE Entry Pages > EE Cover Page

SECTION II. BEFORE THE SHOW

EE ENTRY PAGES > EE COVER PAGE:

Continued on next page…

NOTE 1: 
• If any of the Card columns has a ❶ XX , the Show Secretary is graphically 

informed that Rider, Horse, Owner, Trainer, and/or Coach membership 
information is problematical. The Show Secretary is immediately aware of a 
membership problem that will need correction prior to the show.  If the Entrant 
does not correct the membership issues, s/he may not be allowed to participate in 
the show or may be required to pay non-member fees.

• Some Shows charge a fee for each correction.
• Some shows do not refund overpayments due to missing items in an entry.

NOTE 2:  Even if there are no  XX  , the show secretary must check memberships as 
there may still be problems. 

Show Name
Show Location

Date and Time Email Sent

1

--

MM/DD/YYYY – MM/DD/YYYY

--



Fox Village Dressage User Manual – 2021 Update 1.0.5. helpdesk@foxvillage.com                 www.foxvillage.com137

Enter EE Online Entries > EE Entry Pages > EE Entry Page

SECTION II. BEFORE THE SHOW

EE ENTRY PAGES > EE ENTRY PAGE:

NOTE: The Show Secretary reviews this page to: 
• Verify the ❶ Owner, ❷ Rider, ❸ Trainer, 

and ❹ Coach (if entered).  These must be the 
same people who sign the USEF Waiver and 
Entry Agreement Forms in their pertinent 
roles.    

• Verify that all ❺ show fees have been paid.
• Determine, if GAIG Q is requested, that ❻

GAIG Q membership requirements have been 
met. 

Show Name

1

2

3

4

5

6 6 6 6

MM/DD/YYYY –

MM/DD/YYYY
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Enter EE Online Entries > EE Entry Pages > EE Classes Page

SECTION II. BEFORE THE SHOW

Continued on next page…

NOTE 1: The Show Secretary reviews this page to 
verify the classes entered and ensure the classes 
are appropriate for the horse and rider 
qualifications, if appropriate.

NOTE 2:  This page may not be included in all 
entries.

EE ENTRY PAGES > EE CLASSES PAGE:
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Enter EE Online Entries > EE Entry Pages > EE Stabling Page

SECTION II. BEFORE THE SHOW

Continued on next page…

EE ENTRY PAGES > EE STABLING PAGE:

NOTE: The Show Secretary reviews this page: 
• To verify the stabling information was entered 

correctly.
• To verify a horse ❶ gender is provided to 

assist with stall assignments.
• To ensure a usable ❷ stall group name is 

provided, if applicable.

Show Name

1

2
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Enter EE Online Entries > EE Entry Pages > EE Memberships Page

SECTION II. BEFORE THE SHOW

Continued on next page…

EE ENTRY PAGES > EE MEMBERSHIPS PAGE:

Time    Date  (EE Number)

NOTE: 
• The Show Secretary reviews this 

page to verify the people (Rider, 
Owner, Trainer, and Coach) and 
Horse have the correct and current 
USEF and USDF memberships 
required to participate in the show 
and qualify for championships/ 
awards, if applicable.  

• If a person membership is missing, 
EE will automatically apply USEF 
and/or USDF non-member fee(s).  

• A Horse must have, as a minimum, 
a USDF Horse Identification 
Number (USDF HID), which can be 
applied to the USEF requirement.

NOTE:  
• EE pulls this data from the USEF 

and USDF databases.
• If the information is confusing, use 

any of the following to assist you:
o www.EqVerification.org
o USDF Print Horse Card
o USDF Print Membership Card
o USEF Horse Search
o USEF People Search
o FVD USEF Information

NOTE:  Except for the horse, ignore the ❶ text with the 
gray background as they all say RIDER VERIFICATION.  
Instead, look at the ❷ heading above each people card 
section.

Rider Name
Rider Name

Trainer Name Trainer Name

Owner Name Owner Name

#######

#######

#######

#######

#######

#######

#######

#######

Owner Name
Owner Name

Horse Name

Horse Name

Date

Date

Date

Date

Date

Date

Date

Date

Date

Date

Date

Date

Date

Date

Date

Date

Date

Date

1
2

11

11

1

2

2

NOTE:  The horse ❸ Owner must be 
the same person for USEF and USDF!  
If they are not the same and  cannot 
be corrected before the show (recent 
purchase, etc.), if possible, ensure 
FVD has the actual owner listed.  If 
USEF and/or USDF have a different 
person listed and that person is not a 
USEF and/or USDF member, collect 
the non-member fee.

3 3

3
3

NOTE:  If the horse is leased, the 
owner listed must be the lessee's 
name.  If the legal owner is listed, the 
show results will not be counted by 
USEF/USDF.

NOTE:  USEF requires Trainer membership.  USDF does 
not require Trainer membership.

http://www.eqverification.org/
https://www.usdf.org/card/horse.asp
https://www.usdf.org/card/
https://www.usef.org/search/horses
https://www.usef.org/search/people
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Enter EE Online Entries > EE Entry Pages > EE USEF Waiver Form Page

SECTION II. BEFORE THE SHOW

Continued on next page…

NOTE: 
• This page is important as it is the 

legal document releasing USEF from 
liability.  

• A separate form must be submitted 
for the Rider, Owner, Trainer, and 
Coach (if applicable).  The Rider or 
Trainer may not sign for the Owner.

• The applicable Rider, Owner, 
Trainer, and/or Coach boxes must 
be checked by the person.

• The Owner, Rider, Trainer, and 
Coach names must match the 
Owner, Rider, Trainer, and Coach 
names submitted in the entry.

NOTE: The entrant uploads this page 
while entering the show online via EE.  
If the entrant did not upload the 
document, it will be missing from the 
EE entry.  The show secretary must 
then get the document from the 
entrant, preferably before the show.

EE ENTRY PAGES > EE WAIVER FORM:

NOTE: 
• The Trainer is the person legally 

responsible for the horse while the 
horse is on the show grounds.  This 
may or may not be the at-home 
trainer.

• The Coach is the person paid to 
coach the Rider while on the show 
grounds.  Listing a Coach is optional 
unless the Coach will ride the horse 
on the show grounds.
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Enter EE Online Entries > EE Entry Pages > EE USEF Entry Agreement Page

SECTION II. BEFORE THE SHOW

Continued on next page…

NOTE: 
• The Coach is optional unless the Coach will ride the horse while on the show grounds or 

the entrant prefers to include a Coach.
• The Rider or Trainer may sign for the Owner.
• The Owner, Rider, Trainer, and Coach names must match the Owner, Rider, Trainer, and 

Coach names submitted in the entry.

NOTE: The entrant uploads this page while entering the show online via EE.  If the entrant 
did not upload the document, it will be missing from the EE entry.  The show secretary must 
then get the document from the entrant, preferably before the show.

EE ENTRY PAGES > EE USEF ENTRY AGREEMENT FORM:
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Enter EE Online Entries > EE Entry Pages > EE Coggins Page

SECTION II. BEFORE THE SHOW

Continued on next page…

Owner Name
ADDRESS
CITY, ST ZIP
PHONE

Stable Name
ADDRESS
CITY, ST ZIP
PHONE

Horse Name

Vet Name
ADDRESS
CITY, ST ZIP
PHONE

MM/DD/YYYY

2019-03-15

YYYY-MM-DD YYYY-MM-DD

Name
Date Time

Name

NOTE: The Show Secretary reviews the Coggins 
to ensure:
• The ❶ horse name on the Coggins matches 

the horse name in the entry, etc..
• The ❷ date blood drawn is within one year 

of the show date(s).  The Coggins expires 365 
days from the date blood drawn; for 
example, a Coggins with blood drawn on 
2021-03-19 expires after 2022-03-18.

• The test result is ❸ negative.

1

2

3

NOTE: The entrant uploads this page while 
entering the show online via EE. If the entrant 
did not upload the document, it will be missing 
from the EE entry.  The show secretary must 
then get the document from the entrant, 
preferably before the show.

EE ENTRY PAGES > EE COGGINS PAGE:
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Enter EE Online Entries > EE Entry Pages > EE Vaccinations Page

SECTION II. BEFORE THE SHOW

Continued on next page…

Owner Name
ADDRESS
CITY, ST ZIP

NOTE: The Show Secretary reviews the Proof of Vaccination to ensure:
• The document conforms with the requirements of USEF GR845.
• The vaccination is for ❶ flu/rhino.
• The ❷ horse name on the document matches the horse name in the entry, Coggins, 

etc.
• The ❸ date of administration is within six months of the show date(s).  For example, a 

vaccination administered on 3/20/2020 expires after 9/19/2020.

Vet Name
ADDRESS
CITY, ST ZIP

1

2

3

Horse Name

MM/DD/YYYY

MM/DD/YYYY

MM/DD/YYYY

MM/DD/YYYY

MM/DD/YYYY

MM/DD/YYYY

MM/DD/YYYY

NOTE: The entrant uploads this page while entering the show online via EE. If the entrant 
did not upload the document, it will be missing from the EE entry.  The show secretary 
must then get the document from the entrant, preferably before the show.

EE ENTRY PAGES > EE VACCINATIONS PAGE:

NOTE: USEF GR845 (click here) requires a proof of flu/rhino must be presented if requested 
by show management or the TD while the horse is on the show grounds.  Some shows 
require proof of vaccination with the show entry.

NOTE: Proof of vaccination may be a USEF form, letter from the vet, etc.

https://www.google.com/url?sa=t&rct=j&q=&esrc=s&source=web&cd=&ved=2ahUKEwjn9-r9kKr0AhUwmHIEHcYfCP4QFnoECBUQAQ&url=https%3A%2F%2Fwww.usef.org%2Fforms-pubs%2FANcxoLX1gNs%2Fequine-vaccination-rule-gr845&usg=AOvVaw3Y_8XZbFp9_y1tFowQBwPu
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Enter EE Online Entries > EE Entry Pages > EE SafeSport Page(s)

SECTION II. BEFORE THE SHOW

NOTE: The Show Secretary ensures there is a current document for each USEF adult member involved in the 
entry (Rider, Owner, Trainer, Coach).

EE ENTRY PAGES > EE SAFESPORT PAGE(S):

NOTE: The entrant uploads this/these page(s) while entering the show online via EE. If the entrant did not upload 
the document(s), it/they will be missing from the EE entry.  The show secretary must then get the document(s) 
from the entrant, preferably before the show.

Fname Lname

MM/DD/YYYY
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Enter EE Online Entries > EE Entry Pages > EE Other Documents Page

SECTION II. BEFORE THE SHOW

EE ENTRY PAGES > EE OTHER DOCUMENTS

• If your show requires additional documents, such as horse passport, proof of qualification to ride a 
musical freestyle, etc., they will (should) be part of the EE entry.

NOTE: The entrant uploads other document(s) 
while entering the show online via EE.  If the 
entrant did not upload the document(s), 
it/they will be missing from the EE entry.  The 
show secretary must then get the document(s) 
from the entrant, preferably before the show.
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Enter EE Online Entries > Import Entry into FVD > Import Online Entries Login

SECTION II. BEFORE THE SHOW

• Review and annotate the preceding pages for missing or inaccurate information, as in SCREEN SHOW 
ENTRIES.

• Click ❶ Import Online Entries.

• If you are not currently logged into EE, an ❷
Import Online Entries form opens.

• Enter your ❸ EE User Name.
• Click ❹ OK.

IMPORT ENTRY INTO FVD > IMPORT ONLINE ENTRIES LOGIN:

2

3

4

1
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Enter EE Online Entries > Import Entry into FVD > Online Entry Processing

SECTION II. BEFORE THE SHOW

• The ❶ Online Entry Processing form opens with an entry displayed.
o Click the ❷ Previous Entry button to select the previous entry. 
o Use the ❸ Entry (Lookup) drop-down arrow to select a different entry from the list. 
o Click the ❹ Switch To button to change the sort of the entry list.
o Click the ❺ Next Entry button to select the next entry.

• ❻ EE Tracking # is the number used by EE to track the entry.  If you have a question about an entry, EE 
staff will need this number.

• ❼ Submitted / Paid Online lets you know the entry was paid online and submitted by the entrant.  It takes 
a little while for the payment information to enter into EE; therefore, ensure a bit of time has passed 
before you process the entry.

• ❽ Entry # is where you enter your show’s entry # (the same as the bridle #).  This is required before you 
import.

• ❾ Ready for Import lets you know the entry is ready for you to import into your FVD show file after you 
use the Add and Merge features (see below).

• Click the ❿ Help button for hints on importing entries.
• The ⓫ LEFT group of data is entry data in the EE database.  You do not edit this data.
• The ⓬ RIGHT group of data is entry data to be entered into your show.  
o If there is already data in the right box, the person/horse is already in your HR.hdf file.  If there is no data 

in the box, the person/horse is not already in your HR.hdf.  
o Use the ⓭ right arrow to add the horse or person to the right group of data.  Add the Owner first, then 

the Horse, Rider, Trainer and Coach (if provided).
o If the ⓮Merge button is checked, the data in the EE entry will import into your show and will overwrite

any data already in your HR.hdf.   IMPORTANT - Uncheck the merge button if you know your FVD HR.hdf 
data is correct (perhaps from a previous entry in this show), so you do not want to overwrite existing 
data.

IMPORT ENTRY INTO FVD > ONLINE ENTRY PROCESSING:

Continued on next page…

6

1

3
4 52

Horse Name

Owner Name

Rider Name

Trainer Name

Horse #

Owner #

Rider #

Trainer #

7
8

9

11

10

12

13 14

100
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Enter EE Online Entries > Import Entry into FVD > Online Entry Processing, cont’d.

SECTION II. BEFORE THE SHOW

• The ⓯ Import button is used to import the entry you are viewing.  
• The ⓰ Entries button opens the Entries form of FVD.  Use this to view the entries already in your show.
• ⓱ Filter by  Ready for Import – if the box is checked, you will only see entries that are ready for 

import.  Uncheck to box to see all entries, including those that are not ready to import.
• ⓲ Filter by  Paid Online – if the box is checked, you will only see entries that have paid online.
• If you need to login to EE (you can only stay logged in for a short time), enter your information in the ⓳

Username and ⓴ Password boxes and click XX Login.
• Click XX  Close to close the Online Entry Processing form.

21

22

Owner Name

Rider Name

Trainer Name

Owner #

Rider #

Trainer #

15 16

17 18

19 2120

22

Horse Name Horse #

100
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Enter EE Online Entries > Check the Imported Entry

SECTION II. BEFORE THE SHOW

• Click ❶Main Menu > ❷ Show Office 
> ❸ Entries. 

1

3

2

• The ❹ Entry form opens with the ❺ Summary tab open.
• Using the ❻ Entry (Lookup) drop-down arrow, scroll down to the last entry on the list.  This is the entry 

you just imported.
• To open the entry, click on it.

4

• Screen the entry (see SCREEN 
SHOW ENTRIES and ENTRY REVIEW 
AND MANAGEMENT 
SUGGESTIONS).

• Update the entry as needed.
• Using the ❼ Entry Memo box, 

annotate if the entry is complete, 
if there is a deficiency, etc.

• To notify the entrant of the status 
of the entry, use ❽ Upload 
Confirmations (see ENTRY 
CONFIRMATION NOTIFICATION).

• The ❾ Confirmation Mailed box 
will automatically be checked.

• Congratulations.  You have just 
completed importing an entry!

• Repeat for the next entry you want 
to import.

CHECK THE IMPORTED ENTRY:

5

6

7

8

9



Fox Village Dressage User Manual – 2021 Update 1.0.5. helpdesk@foxvillage.com                 www.foxvillage.com151

SECTION II. BEFORE THE SHOW
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Enter Snail Mailed Entries Created with EE

SECTION II. BEFORE THE SHOW

• Some entrants create an entry on EE but do not pay online; instead, they print the entry and mail it to 
you with a payment check and (hopefully) entry documents (Coggins, waiver form, etc.).

• When you receive such an entry, you can download the entry data into FVD, so you do not have to type it 
in.  Whew!

ENTER SNAIL MAILED ENTRIES CREATED WITH EE:

• Click ❶ Import Online Entries.

• If you are not currently logged into EE, an 
❷ Import Online Entries form opens.

• Enter your ❸ EE User Name.
• Click ❹ OK.

2

3

4

• The ❾ entry data will appear on the left column of information.
• Enter the ❿ Entry # (bridle #).
• Using the ⓫ Add arrow and ⓬Merge box, as needed, populate the entry data on the right column of 

information.

5

6 7

8

9

11

13

101

10

12
Horse Name

Owner Name

Rider Name

Trainer Name

USEF #

USEF #

USEF #

USEF #

1

• The ❺ Online Entry Processing form 
opens.

• Click the ❻ Filter by  Ready for 
Import and ❼ Filter by  Paid Online 
check boxes so they are both unchecked.

• Use the ❽ Entry (Lookup) drop-down 
arrow and click on the entry you want to 
download.

• Click ⓭
Import.

• The data will 
import into 
FVD in the 
usual manner.
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SECTION II. BEFORE THE SHOW
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Enter Snail Mailed Show Entries

SECTION II. BEFORE THE SHOW

• Before we had FVD and EE, dressage show entries were completed by hand by the entrant and snail 
mailed with a check and supporting documents (Coggins, release form, etc.).

• When received by the show secretary, s/he then had to interpret handwriting and avoid typographical 
errors while hand typing in ALL the information.  This was a very labor-intensive and error-prone 
exercise.

• Even though we now have FVD and EE, a few entrants continue to submit handwritten snail mailed 
entries.  
o Some shows avoid this by requiring the use of EE for all their entries.
o Some shows minimize handwritten entries by charging an extra fee for them.
o Some shows just allow handwritten entries without any penalty.

• The process for handwritten entries is similar to that for EE entries, except for entering the data by hand 
and taking a LOT of extra time.

ENTER SNAIL MAILED SHOW ENTRIES:

Typical handwriting on a handwritten show entry!!!!

Typical Show Secretary entering a handwritten show entry!!!!
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SECTION II. BEFORE THE SHOW
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INTRODUCTION:
• While you review/input/correct/update show entries, you are also (1) screening them for the MANY show 

entry requirements and (2) assembling them for review by the TD.  Chapters II.14 – II-15, and supporting 
appendices, are an overview of the screening and assembling of show entries. 

156

Screen and Assemble Show Entries

SECTION II. BEFORE THE SHOW

RESOURCES:
• The following USDF references will assist you:
o USDF Entry Checklist – Click here (downloads a PDF file).
o USDF Membership Information/Requirements – Click here (downloads a PDF file).
o USDF Generic Competition Entry Form – Click here (downloads a PDF file).
o USDF Membership Exception List – Click here (downloads a PDF file).
o USDF Acceptable Proof of Membership – Click here (downloads a PDF file).

• The following materials are provided in this manual’s appendix section to assist you:
o USEF and USDF Membership Requirements for Non-Qualifying Classes.
o USEF and USDF Membership Requirements for GAIG Qualifying and Championship Classes.

• Other unofficial resources:
o Summary of USEF/USDF Show Entry Requirements (web page): Click here.
o Details on How to Enter a USEF/USDF Show (PDF file): Click here.

• The following are sources for people USEF & USDF memberships and horse USEF recordings & USDF 
registrations:
o www.EqVerification.org
o USDF Print Horse Card
o USDF Print Membership Card
o USEF Horse Search
o USEF People Search
o FVD USEF Information
o FVD Main Menu > Show Office >  USDF Membership Verification (see FVD User Manual)
o FVD Main Menu >  Show Office > USEF Membership & SafeSport Verification (see FVD User Manual)

NOTE: Make your TD very happy:  When you have completed an entry, 
include the FVD Entry Confirmation Report (see Confirmation 
Notification) and include it to the front of the entry packet documents or 
digital file.  You can use it to track receipt of originally missing 
information and the TD can use it to understand the entry and help verify 
that it is complete.

ASSEMBLING ENTRIES:
• As you screen each entry, you must also assemble it for review by the TD, who verifies each entry is 

complete and the Horse/Rider/Owner/Trainer/Coach are qualified to participate in the show.  This can be 
done via a paper packet or digital file(s).

• Whatever the method, it must be easy to use by the TD.
• Two methods to screen and assemble the entries for TD review are suggested in the appendices:

o Paper Method:  ENTRY REVIEW AND MANAGEMENT SUGGESTIONS – PAPER METHOD
o Digital Method: ENTRY REVIEW AND MANAGEMENT SUGGESTIONS – DIGITAL METHOD

SCREENING ENTRIES:
• Each entry packet must be screened for completeness.  If the packet is incomplete, the entrant may not be 

allowed to participate in the show.  Additionally, show management may be charged uncollected fees and/or 
fined by USEF and/or USDF; therefore, be meticulous with this step.  

• If the packet was prepared with EE then submitted electronically or snail mailed, it will be electronically pre-
screened by EE; however, you still need to review the packet to ensure everything is included and is correct.  

• If the packet was handwritten and snail mailed to you, it is not pre-screened – you must both screen and 
type in the information.  

https://www.usdf.org/docs/showflash/web/GeneralInfo/Before/EntryChecklist.pdf?t=11/21/2021%204:28:56%20PM
https://www.usdf.org/docs/showflash/web/GeneralInfo/Before/MembershipInformation.pdf?t=11/21/2021%204:28:56%20PM
https://www.usdf.org/docs/showflash/web/Docsprizelist/DressageEntryFormField.pdf?t=11/21/2021%204:28:56%20PM
https://www.usdf.org/docs/showflash/web/GeneralInfo/Before/MembershipExceptionList.pdf?t=11/21/2021%204:28:56%20PM
https://www.usdf.org/docs/showflash/web/GeneralInfo/Before/AcceptableProofofMembership.pdf?t=11/21/2021%204:28:56%20PM
http://www.frederickdressage.org/enter-usefusdf-show.html
http://www.frederickdressage.org/uploads/3/7/3/8/37380471/how-to-enter-usef-usdf-shows.pdf
http://www.eqverification.org/
https://www.usdf.org/card/horse.asp
https://www.usdf.org/card/
https://www.usef.org/search/horses
https://www.usef.org/search/people


Fox Village Dressage User Manual – 2021 Update 1.0.5. helpdesk@foxvillage.com                 www.foxvillage.com157

Screen and Assemble Show Entries, Cont’d.

SECTION II. BEFORE THE SHOW

GRAPHICAL SUMMARY OF ENTRY REQUIREMENTS:  
• Click here to open a webpage that is a quick summary of entry requirements, as depicted in this graphic.

1. Entry form created by EE. 2. Membership Cards provided 
by EE, supplemented by 
EqVerification if needed.

3. USEF Waiver.  One form for 
each person in the entry (rider, 
owner, trainer, coach).

4. USEF Entry Agreement.  One 
form signed by each person in 
the entry (multiple forms ok).

5. Proof of current SafeSport 
training for each adult USEF 
member in the entry (rider, 
owner, trainer, coach).

6. Proof of current Coggins 
with same horse name as on 
the entry.

7. If required by the show, 
proof of current vaccination 
IAW USEF GR845 with same 
horse name as on the entry.

8. If a MFS ride is in the entry, 
proof of Q for the ride.

9. Any other documents required 
by the particular show.

10. Payment via EE (verified on EE 
first page and on (1) entry form).

http://www.frederickdressage.org/enter-usefusdf-show.html
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Screen and Assemble Show Entries, cont’d.

SECTION II. BEFORE THE SHOW

EXAMPLE OF AN ENTRY SCREENING CHECK SHEET:
The following is the check sheet the author uses to screen entries.   See ENTRY REVIEW AND 
MANAGEMENT SUGGESTIONS – DIGITAL ENTRY PACKETS for further information.
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Screen and Assemble Show Entries, Cont’d.

SECTION II. BEFORE THE SHOW

• Entry Numbers:  Assign a unique number that will be the bridle number and entry number.  This number 
is entered in EE and uploaded to FVD and is written on the entry packet.

• USEF and USDF Membership Requirements:
o The USEF and USDF membership requirements are explained in USEF AND USDF PEOPLE & HORSE 

MEMBERSHIP REQUIREMENTS & EXEMPTIONS.  
o GAIG NO: If the entry has NOT requested ANY GAIG qualifying classes:
▪ Horse USEF #: Must have USEF Lifetime Recording, USEF Annual Recording, USDF Lifetime Horse 

Registration (LHR), or USDF Life or Horse Identification Number (HID).
▪ People USEF #: Owner, rider, and trainer must be a current USEF Competing Member or each must 

pay USEF Show Pass fee (one fee per show per person, not one fee per entry).  
▪ Horse USDF #: Must have USDF Lifetime Horse Registration (LHR) or USDF Horse Identification 

Number (HID).
▪ People USDF #: Owner must be a current USDF Participating Member, USDF Business Member, or 

USDF Group Member, or must pay the USDF non-member fee (one fee per show per person, not 
one fee per entry).  Rider must be a current USDF Participating Member, USDF Group Member, or 
must pay the USDF non-member fee (one fee per show per person, not one fee per entry). 

o GAIG YES: If the entry HAS requested ANY GAIG qualifying classes:
▪ Horse USEF #: Must have USEF Lifetime Recording or USEF Annual Recording.
▪ People USEF #: Owner, rider, trainer and coach (if applicable) must be current USEF Competing 

Members.  
▪ Horse USDF #: Must have USDF Lifetime Horse Registration (LHR).
▪ People USDF #: Owner must be a current USDF Participating Member(s) or Business Member.  

Rider must be a current USDF Participating Member. 

o Membership Exemptions:  
▪ Riders/owners/trainers/coaches participating only in USDF Introductory Level and/or Opportunity 

classes are exempt from USDF and USEF memberships (and the USEF show pass and USDF non-
member fees).  Horses entered only in these classes are exempt from USEF horse registration and 
USDF horse recording.   

▪ The trainer parent of a minor is exempt from USEF & USDF memberships. 
▪ Other exemptions: Click here for the USDF exceptions (exemptions) document.

o Entries should include verification of the above.  If information is missing, use the following sources:
▪ www.EqVerification.org (first method to use)
▪ USEF Horse Search (use if EqVerification report is confusing)
▪ USEF People Search (use if EqVerification report is confusing)
▪ USDF Print Horse Card (use if EqVerification report is confusing)
▪ USDF Print Membership Card (use if EqVerification report is confusing)
▪ FVD USEF Information (FVD pulls information from USEF database)

• Owner, Rider/Handler, and Trainer Contact Information: Check that all lines are completed.  If an 
owner, rider/handler, and/or trainer are the same person, use of the word “same” is allowed.  Note the 
blank areas so they can be completed prior to the show or during registration.

• Stabling:  Check the stabling requests to determine the stall group with whom an entry wants to be 
stabled.  Note stallions as they require special stabling arrangements (strong stalls and not near mares).

KEY ITEMS TO BE SCREENED:

http://www.usdf.org/docs/ShowFlash/web/GeneralInfo/Before/MembershipExceptionList.pdf
http://www.eqverification.org/
https://www.usef.org/search/horses
https://www.usef.org/search/people
https://www.usdf.org/card/horse.asp
https://www.usdf.org/card/
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• USEF Waiver Form (click here):  Examine the USEF Waiver Form(s) for correct signatures.  Each person 
(Rider, Owner, Trainer & Coach, if applicable) in the entry must submit a separate form with the 
appropriate boxes checked, signature and printed name. A Coach form is optional unless the coach will 
ride the horse on the show grounds.  Entries with riders under age 18 need both the Rider’s signature 
and a Parent’s/Guardian’s signature. Parents/Guardians who sign for their children in the Trainer box are 
not required to have USEF or USDF memberships, and they are not required to pay a non-member fee. 
Copies and electronic signatures are allowed.

• USEF Entry Agreement (click here):  One form signed by Rider, Owner, Trainer and Coach, if applicable.  I 
Rider = Owner = Trainer, each section still must be signed.

• Freestyle Classes:  Entries for freestyle classes in non-championship shows must include a copy of the 
highest test of the freestyle level or any test of the next highest level that shows a minimum score of 
63% for USEF/USDF tests and 60% for FEI tests.  Examples: To ride a second level freestyle, a copy of the 
score sheet face sheet with the name of the USEF/USDF show, the rider, the horse, the class, the test 
score and the name of the judge from either second level test 3, or any higher level test, must be 
submitted.  To ride a Grand Prix MFS a GP test sheet with a score of 60% or higher must be provided.  
Click here for musical freestyle information on the USDF web site.

• Entry Fees:  Check to ensure the correct entry fees have been provided.  Add the fees to ensure the 
addition is correct (EE and FVD also do the math for you).  Ensure that the USEF D&M fee has been 
included, that the non-member fees have been included.  Note any fee still due or any amount that must 
be refunded.  If one check with payment for two or more entries has been submitted, in FVD you will 
enter the check number and the amount included for each entry.

• Coggins:  In most regions, a legible current Coggins (blood drawn within one year of the show date(s) 
with the same horse name as the name of the horse in the show entry) is required for all entries.   Ensure 
the Coggins form was included.  NOTE: THE HORSE IS NOT ALLOWED OFF THE HORSE TRAILER UNTIL A 
LEGIBLE COPY OF A CURRENT COGGINS IS PRESENTED TO THE SHOW SECRETARY. 

• Proof of Vaccination:  If your show requires this document in the show entry, check to ensure it complies 
with USEF GR845, has the correct horse name, and is dated within six months of the show.

• Other Requirements:  Check for fulfillment of other requirements specific to your competition.
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Screen and Assemble Show Entries, cont’d.

SECTION II. BEFORE THE SHOW

NOTE 1: Incomplete entries are my pet peeve.  Unfortunately, they are VERY common – in my experience they 
comprise over one-half of all entries received for a show.  Also unfortunately, either the show secretary must 
work very hard to have complete entries, time and effort that are not necessary, or many entrants could be 
denied participation on show day.  However, entrants are accustomed to providing incomplete entries then 
bringing information to the show.  This takes time in the show office and the chance of an incomplete entry if 
documents are not adequate or forgotten.  I encourage ALL shows to request complete entries before the show 
so this problem could disappear.  One approach is to only enter complete entries into the show.
NOTE 2: You need to determine when you want to obtain missing entry information.  Some entry/show 
secretaries inform competitors of deficiencies and ask them to bring documents/money to the show.  Other 
entry/show secretaries try to have packets completed prior to the show; this is the author’s preference as it 
provides a smoother running of the show.  Use the FVD Entry Confirmations system and separate email to 
inform competitors of deficiencies and, as needed, remind them to submit the information/money/etc. prior to 
the show.  You may want to consider a surcharge for entries that are not complete prior to the beginning of the 
show; however, this MUST be written in the prize list.
NOTE 3: What is a late entry?  For most shows, an entry RECEIVED by the show secretary AFTER MIDNIGHT OF 
THE CLOSING DATE is LATE.  The definition of late for your show should be included in the prize list.

KEY ITEMS TO BE SCREENED, cont’d.:

https://www.usef.org/forms-pubs/FDs-pIVXI9U/usef-waiver-release-of-liability
https://www.usef.org/forms-pubs/7M4IexYMhK4/usef-entry-agreement-fillable
https://www.usdf.org/education/other-programs/musical-freestyle/index.asp
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SECTION II. BEFORE THE SHOW
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Details of FVD Entries > Introduction 

SECTION II. BEFORE THE SHOW

INTRODUCTION:

• EE and Handwritten Entries: 
o Even if you only accept EE entries, in FVD there are some data points that still must be hand entered 

or checked.
o Therefore, you must review each section of all entries.

• Unique Entry #: For each show, each entry (horse and rider combination) must have a unique entry #.  
For example, once you use entry #101, that number cannot be used again.  This unique entry # is used 
for:
o Entry # entered when importing EE entries.  It is imported into FVD.
o Entry # hand typed in FVD when recording handwritten entries. 
o Bridle # worn during the competition.

• People and Horses: 
o In FVD, each person is listed once in the Horse & Rider file (HR.hdf).  If a person is in another role in 

the same entry, or is in another entry, the person’s information and membership verifications do not 
have to be entered again.  

o In FVD, each horse is listed once in the Horse & Rider file (HR.hdf).  If a horse is in another entry, the 
horse’s information and recordation/registration verifications do not have to be entered again.  

• Duplicate People and Horse Names:
o FVD allows duplicate people and horse names.  
o For example, you are allowed to enter the name Susan Smith more than once because there may be 

more than one person with this name.  You can also enter the horse name Black Beauty more than 
once because there may be more than one horse with this name.

o However, this also allows you to accidentally enter a person or horse multiple times or select the 
wrong person or horse for an entry.  

o You need to be judicious when you add and/or edit new people and horses – you need to ensure you 
have selected the correct person or horse.  The best way to check this is to look at the USEF and USDF 
numbers.

• Overwriting the HR.hdf File: For an EE entry, for a person or horse already in your HR.hdf file, you have 
the option to overwrite the person’s or horse’s data in your HR.hdf, or not to overwrite it.  If you know 
the HR.hdf file is accurate, do not overwrite it.  See EE Online Entries > Import Entry into FVD > Online 
Entry Processing for details.

• Saving Data: The FVD Entry form has seven tabs.  As you enter FVD entry data, it will not be saved until 
you click a different tab.

❶ ❷ ❸ ❹ ❺ ❻ ❼

Some show secretaries screen and assemble an entry before working on the entry in FVD, others do this at the same 
time.  The following provides some background information on the FVD program then goes into detail of the FVD 
entry form tabs.
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• Select ❶Main Menu > ❷ Show Office >  ❸
Entries. 

• The ❹ Entry form > ❺ Summary tab opens.  
• There are ❻ seven tabs to move you from form to 

form as you enter/review/update Entry
information:
a. Summary
b. Horse / Owner
c. Rider / Trainer
d. Coach / Team
e. Class Entries
f. Stabling Fees
g. Other Fees / Payments

• You will proceed in this order as you 
enter/review/update entry information.

• At the bottom of the Entry form there is a series of 
tools:
o ❼ Previous Entry: Go to the previous entry
o ❽ Entry (Lookup): Enter text to search for a 

horse, rider, owner, or entry number
o ❾ Switch to … button: Click the button to 

switch the look up field for the Entry (Lookup) 
box between Horse, Rider, Owner, or Entry 
number.  See below for details.

o ❿ Next Entry: Go to the next entry
o ⓫ Add Entry:  Add a new entry
o ⓬ Delete Entry: Delete current entry
o ⓭ Upload Confirmations: Upload entry 

confirmation to the entrant.
o ⓮ Close:  Close the form.

1

2

3
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Details of FVD Entries > What is an Entry?, FVD Entry Tabs

SECTION II. BEFORE THE SHOW

• Dressage shows have Entries – horse and rider 
combinations – that ride dressage tests.  

• Each horse/rider combination in the show is a 
separate entry.  If Rider 1 rides both Horse 1 and 
Horse 2, Rider 1 / Horse 1 is one entry and Rider 1 
/ Horse 2 is a second separate entry.

• Each Entry must be entered separately into the 
FVD program.  Entry information includes details 
about the horse, the people [rider, owner(s),  
trainer, coach (optional)], team (if your show has 
teams), classes, stabling and associated fees, other 
fees, and payments.

• The Entries function of the FVD program is where 
you enter this information.

WHAT IS AN ENTRY?:

FVD ENTRY TABS:

RIDER 1 HORSE 1 RIDER 1 HORSE 2

ENTRY 1 ENTRY 2

Go to Previous Entry

4

5

6

Look up Horse, Rider or Owner Name or Entry Number

Switch to Horse, Rider, Owner, or Number Look-up

Go to Next Entry
Add a New Entry

Delete Current Entry

7 8 9 10 11 12 13 14
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Details of FVD Entries > Search for Entry #, Rider, Horse, or Owner

SECTION II. BEFORE THE SHOW

• For example, if you want to look up an entry for 
which you know the Rider name but not the 
Entry #, using the ❷ Switch to … button, select 
❹ Rider (Lookup) then, using the drop-down 
arrow, select the Rider from the list or type the 
name in the box and press Return.

• The Entry forms are also used to search for 
already entered entries.  When you open the 
Entry window, the default Lookup is ❶ Entry 
(Lookup).  This lets you use the entry # to find 
the entry.

• Using the         ❷ Switch to … button, you can
search your entries by selecting the following and 
using their drop-down arrow:
o ❸ Entry # (Lookup)
o ❹ Rider (Lookup)
o ❺ Horse (Lookup)
o ❻ Owner (Lookup)

2
1

3

4

5

6

SEARCH FOR ENTRY #, RIDER, HORSE, OR OWNER:

4
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• The ❹ Entry form opens with the ❺
Summary tab displayed.

• The entry form opens with the first entry 
in the show.

EE entry:
• Use the ❻ Entry (Lookup) drop-down 

arrow and select the desired entry.  The 
most recently downloaded entry will be 
at the bottom of the list.

• Many of the boxes will be populated with 
data that you now need to review, verify, 
and update, as needed.  Other boxes 
need to be completed by you.

Handwritten entry:
• To add a new entry, click ❼ Add Entry.
• For the new entry, in the ❽ Entry #, 

enter the ❾ entry/bridle number that 
you wish to use (e.g. 1, 101, 1003, etc.).

165

Details of FVD Entries > Open Entries, Add Entry & Entry # 

SECTION II. BEFORE THE SHOW

• Select ❶Main Menu > ❷ Show Office >        
❸ Entries. 

8
• The❽ entry number is now in the box.

4

5

7

8

6

OPEN ENTRIES:

ENTRY & ENTRY #:

1

2

3

NOTE: In this section of the manual, information for EE entries will be in blue and information for hand-typed 
entries will be in green.  Information that applies to both types of entry will be in black. 
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Details of FVD Entries > Summary Tab > Horses > Name in HR.hdf > Select Horse

SECTION II. BEFORE THE SHOW

EE entry:  
• The horse’s name will already be entered.
• Check capitalization; sometimes MSJ Happy 

Horse is entered as Mjs Happy Horse.  Correct 
this capitalization.

Handwritten entry:
• A horse may or may not already be in the HR.hdf 

database.  You have two options to determine 
this.

1. Using the ❶ Horse (Lookup) drop-down arrow 
and the ❷ scroll bar, look for the ❸ name of 
the horse.   
o If the name is on the list, select it.
o If the name is NOT on the list, go to ❹ on the 

next page.  

4

1

2

3

2. Alternately, start typing the horse name in the 
❹ Horse (Lookup) box.
o If the horse’s name is in the HR.hdf file, as you 

type, the name of the horse will appear.  In 
this example, Ex was typed and the program 
provided x, for the name Exx.  

o When the complete correct horse name 
appears in the box, press Enter.  

o The ❺ Horse name and the ❻ Owner name 
are entered (FVD automatically enters the 
Owner).  

o This method can be hazardous if the HR.hdf 
has two (or more) horses with the same name.  
Because of this, using the drop-down arrow 
may be a safer method.

5

6

SUMMARY TAB > HORSES > NAME ALREADY IN HR.hdf > SELECT HORSE:
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Details of FVD Entries > Summary Tab > Horses > Name in NOT HR.hdf > Add Horse

EE entry:
• The EE import enters the horse information.
• Use the instructions for a handwritten entry to 

add/review/correct/update the horse 
information, including membership verification, 
which is NOT entered by EE.

Handwritten entry:
• If the horse’s name is not on the list (is not in the 

HR.hdf file), you will get a ❶ Fox Village 
Dressage message telling you so.  

• Click ❷ OK.  
• Press the Esc key to clear the typing in the ❸

Horse (Lookup) box.  
• Sometimes FVD will not let you go forward from 

here.  If that happens, close and reopen the 
program, then go to step ❹.

NOTE:  Do not perform Step ❹ unless you are positive that you want to enter a new horse into the program.  
Once you click the Add Horse button, you cannot cancel the action – you are required to enter a horse.  If needed, 
enter the name of a fictitious horse (use AAAA so it is easy to find) then delete it later as in Delete a Horse.

• Click on the ❹ Add Horse button. 

SECTION II. BEFORE THE SHOW

3

2

1

4

SUMMARY TAB > HORSES > NAME NOT IN HR.hdf > ADD HORSE:

NOTE:  You can also enter a horse by clicking 
Main Menu > Show Office > Horses.

Continued on next page…



Fox Village Dressage User Manual – 2021 Update 1.0.5. helpdesk@foxvillage.com                 www.foxvillage.com

Details of FVD Entries > Summary Tab > Horses > Name in NOT HR.hdf > Add Horse, cont’d.

SECTION II. BEFORE THE SHOW

• The ❺ Horse / Owner form opens.
• ❻ Name: Type in the horse’s name.
• ❼ Breed: (optional)  Enter the horse’s breed (up to 30 characters; however, abbreviations are better as 

they fit better on FVD reports):
o First use the ❼ Breed drop-down arrow and select from the list.  
o If the breed you typed in is NOT on the list: 
➢ You get a ❽ Fox Village Dressage information message.  
➢ Click ❾ OK.  
➢ Press Esc to delete your typing.   
➢ Click the ❿ Edit Breeds button.  
➢ The ⓫ Breed form opens.   
➢ Click the ⓬ plus icon.
➢ Enter the new breed in the ⓭ blank line.
➢ Click ⓮ Close.   
➢ You can now select the Breed using the ❼ Breed drop-down arrow.

• ⓯ Sex:  (optional)  Use the ⓯ Sex drop-down arrow to select the horse’s gender.  Ensure you have 
completed this step for each horse so you can identify stallions and mares and arrange your stabling to 
keep them separated.

• ⓰ Color: (optional) Enter the horse’s color (optional).  Proceed as for breed but enter horse colors.
• ⓱ Height: (optional)  Using the drop-down arrow, enter the horse’s height.  

6
7

5 8

9

10

11

13

14

15

16
17

12

15

17

Continued on next page…
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Details of FVD Entries > Summary Tab > Horses > Name in NOT HR.hdf > Add Horse, cont’d.

SECTION II. BEFORE THE SHOW

• ⓲ Sire: (optional) Type in the name of the sire.
• ⓳Dam: (optional) Type in the name of the dam.
• ⓴ Dam’s Sire: (optional) Type in the name of 

the dam’s sire.
• XX Country of Birth: (optional) Type in the 

country where the horse was born.
• XX Breeder: (optional) Type in the name of the 

breeder.
• XX Year of Birth: (optional)  Type in the horse’s 

year of birth.
• XX Passport #:  (required for CDI shows)  Type in 

the passport #.
• XX Coggins: 
o If your show requires it and you received a 

copy of the current Coggins with the correct 
horse name:
▪ Click the Coggins check box to place a check 

in the box ( = yes, you received a current 
Coggins).  

▪ (optional) Enter the date the Coggins 
expires as MM/DD/YYYY.

o If you did not receive a copy of the Coggins, 
leave the box empty so you will later be 
prompted by the FVD program to collect this 
required form ( = no, you did not receive a 
copy of the current Coggins).

• XX Vaccines:
o If your show requires it and you received a 

copy of the current proof of vaccination with 
the correct horse name:
▪ Click the Vaccines check box to place a 

check in the box ( = yes, you received a 
current proof of vaccination).  

▪ (optional) Enter the date the vaccination 
report expires as MM/DD/YYYY.

o If you did not receive a copy of the vaccination 
report and it is required by your show, leave 
the box empty so you will later be prompted 
by the FVD program to collect this required 
form ( = no, you did not receive a copy of 
the current vaccination report).

• XX Notes: (optional)  Type in notes about the 
HORSE, if desired.

NOTE 1: In states where a copy of the horse’s  
current Coggins test is required, the horse should 
NOT be allowed off the trailer until the current copy 
has been presented to and approved by the show 
secretary.

NOTE 2: The name of the horse on the Coggins and 
Proof of Vaccination must match the name of the 
horse on the competition entry form and the USEF & 
USDF memberships.

NOTE 3: 
• A Coggins report expires one year after the blood 

was drawn.  So if the blood was drawn on 
03/20/2022, the report expires after 03/19/2022.

• A Proof of Vaccination expires six months after the 
date of vaccination.  So if flu/rhino vaccinations 
were given 03/20/2022, the proof expires after 
09/19/2022.
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Details of FVD Entries > Summary Tab > Horses > USEF Horse Recording

SECTION II. BEFORE THE SHOW

EE Entry:
• The data was entered with the EE upload.
• Use the EE Memberships Page and/or an 

EqVerification.org page to verify:
o ❶ USEF #.
o ❷ USEF Expiration:  If needed, use the drop-

down arrow to make the correct selection, as 
in the chart. 

• When verified, click the ❸ Cards Verified box.

Handwritten Entry:
• The data is hand entered by you.
• Use the EE Memberships Page and/or an 

EqVerification.org page to verify and enter:
o ❶ USEF #.
o ❷ USEF Expiration:  Use the drop-down 

arrow to make the correct selection, as in the 
chart. 

• When verified, click the ❸ Cards Verified box.

USEF #
USEF 

Expiration
Explanation

Verifi-
cation

USEF # 11/30/2022 Current USEF Annual Recording. Expires November 30, 2022 or date on card. 

Blank or 
USEF #

APPL
APPLied before the show.  No USEF recording or no USDF registration (blank), or USEF recording has 
expired (enter USEF #).  APPLied for USEF Horse Recording or renewal, or USDF registration, before the 
show and verification provided.   Keep a copy of the verification.



USEF # or 
USDF #

HID
USEF and/or USDF Horse IDentification #. Enter the USEF # or the USDF #.  Does not expire.  Cannot 
qualify for championships or awards.



Blank or 
USEF #

JAS
Joined at the Show.  No USEF recording or no USDF registration (blank), or USEF recording has expired
(enter USEF #).  The USEF Horse Application or renewal (or USDF Horse Application) was completed, and 
the fee paid, at the show and you have them to submit to USEF or USDF.



USEF # Lifetime USEF Life Recording.  Does not expire. 

Blank or 
USEF #

Exempt*
No USEF recording or no USDF registration (blank), or USEF recording has expired (enter USEF #).  The 
horse is only being ridden in exempt classes. Type in Exempt. 



Blank Blank
You cannot verify the USEF # (or USDF #) and the USEF Expiration.  Leave ❶ and ❷ and ❸ blank. FVD 
will report a deficiency to be corrected before the show or the first ride.  Update FVD when the deficiency 
is corrected.



USEF # = USEF horse recording number, whether current or expired.
USDF # = USDF horse registration number.

• For USEF, a current USEF Life or Annual recording or a USDF Life or HID recording is required for all non-
exempt horses. 

• See USEF AND USDF PEOPLE & HORSE MEMBERSHIP REQUIREMENTS & EXEMPTIONS for an explanation 
of USEF Horse Recording requirements, exemptions, etc.

1 2
3

SUMMARY TAB > HORSES > USEF HORSE RECORDING:

* Not on the FVD drop-down list.  Type in the selection if it applies.

1 2 3
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Details of FVD Entries > Summary Tab > Horses > USDF Horse Registration

SECTION II. BEFORE THE SHOW

USDF # USDF 
Expiration

Explanation Verifi-
cation

USDF # HID
Horse has a USDF Horse IDentification #.  Does not expire.  Use for non-exempt and exempt classes, 
when applicable. Cannot qualify for championships or awards.



USDF # Lifetime USDF Life Registration.  Does not expire.  Use for non-exempt and exempt classes, when applicable. 

Blank APPL*
APPLied before the show.  No USDF registration # or no USDF HID # (blank).  APPLied for USDF horse 
registration or USDF HID before the show and verification provided.   Keep a copy of the verification.



Blank JAS*
Joined at the Show.  No USDF horse registration #.  The USDF Horse Application was completed, and 
the fee paid, at the show and you have them to submit to USDF.



Blank Exempt* The horse is not USDF registered and is only being ridden in exempt classes. Type in Exempt. 

Blank Blank
You cannot verify the USDF # and USDF Expiration.  Leave ❶.  USDF # and ❷ USDF Expiration blank.  
Also leave the Cards Verified box blank. FVD will report a deficiency to be corrected before the show or 
the first ride.  Update FVD when the deficiency is corrected.



* Not on the FVD drop-down list.  Type in the selection if it applies.USDF # = USDF horse registration or HID number.

• For USDF, a USDF Life or HID horse registration is required for all non-exempt horses. 
• See USEF AND USDF PEOPLE & HORSE MEMBERSHIP REQUIREMENTS & EXEMPTIONS for an explanation 

of USEF Horse Recording requirements, exemptions, etc.

SUMMARY TAB > HORSES > USDF HORSE REGISTRATION:

EE Entry:
• The data was entered with the EE upload.
• Use the EE Memberships Page and/or an 

EqVerification.org page to verify:
o ❶ USDF #.
o ❷ USDF Expiration:  If needed, use the drop-

down arrow to make the correct selection, as 
in the chart.  Do not use the date as USDF does 
not have an annual horse registration.

• When verified, click the ❸ Cards Verified box.
• Enter the horse’s ❹Microchip # if required for 

the show.

Handwritten Entry:
• The data is hand entered by you.
• Use the EE Memberships Page and/or an 

EqVerification.org page to verify and enter:
o ❶ USDF #.
o ❷ USDF Expiration:  Use the drop-down 

arrow to make the correct selection, as in the 
chart. 

• When verified, click the ❸ Cards Verified box.
• Enter the horse’s ❹Microchip # if required for 

the show.

NOTE: Do not use the date as USDF does not 
have annual horse registration.

1 2 3

1 2
3
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Details of FVD Entries > Summary Tab > Horses > Local Organization Horse Registration

SECTION II. BEFORE THE SHOW

Handwritten entry:
• If you will be reporting scores to local 

organization(s), and if you entered the 
organization(s) in Show Preferences > 
Membership (2), click the ❶ Page 2 tab.

• Enter the applicable information for the 
organization(s). 

• If verified, click the ❷ Cards Verified box.

SUMMARY TAB > HORSES > LOCAL ORGANIZATION HORSE REGISTRATION:

EE Entry:
• If you will be reporting scores to local 

organization(s), and if you entered the 
organization(s) in Show Preferences > 
Membership (2) and when you set up your show 
for EE, click the❶ Page 2 tab. 

• You will see the data for local organization(s) that 
was entered with the EE import.

• Review/correct/update the information.
• If verified, click the ❷ Cards Verified box.

1

2
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Details of FVD Entries > Summary Tab > Horses > Owner > Horse Owner

SECTION II. BEFORE THE SHOW

SUMMARY TAB > HORSES > HORSE OWNER:

Handwritten entry:
• The ❺ Owner data is hand entered by you.
• If the Owner is already in the HR.hdf file:
o Using the ❻ Owner (Lookup) drop-down 

arrow and select the owner.
o Using the entry documents, 

review/correct/update the Owner’s 
information.

• If the Owner is NOT already in the HR.hdf file:
o Click the ❼ Add Owner button.
o The ❽ Owner form opens.

EE Entry:
• The ❶ Owner data was entered with the EE 

upload.
• Using the EE Entry Page, EE Memberships Page, 

and EqVerification page (if needed), review/ 
correct/update the Owner’s information.

• If the ❷ USEF and/or ❸ USDF membership 
information is verified, check the ❹ Cards 
Verified boxes.

• If the ❷ USEF and/or ❸ USDF membership 
information is missing or cannot be verified, do 
NOT check the ❹ Cards Verified boxes.

1

2

3

4
1

5
6

7

8

Continued on next page…
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Details of FVD Entries > Summary Tab > Horses > Owner > Horse Owner Contact Data

• The information needed to complete the Owner data boxes should be in the competition entry packet. 
• ❶ First Name: Type in the person’s first name.  If the owner is a business, type in Business.
• ❷ Last Name: Type in the person’s last name.  If the owner is a business, type in the name of the 

business.
• ❸ Entity Type:  Use the drop-down arrow and select the appropriate owner type.

o Individual: The horse owner is an individual.
o Organization: The horse owner is a non-farm business organization.
o Farm: The horse owner is a farm business.

• ❹ Address: Type in the person’s street address.
• ❺ City/State/Zip: Type in the person’s City, State (2-letter abbreviation), and Zip Code (you can enter 

the Zip+4).
• ❻ Country: Type in the person’s country of residence, if needed for your show.
• ❼ Telephone: Type in the person’s telephone number.
• ❽ Email: Type in the person’s email address.
• ❾ Volunteer: If the person is also a volunteer at your show and you want to track this using FVD, click 

the check box to place a check in it.
• ❿ SafeSport: If you have proof of the Owner’s SafeSport training, check the box and enter the date.  If 

you do not have proof, leave the box unchecked.  The training must be renewed annually.  (If not in the 
entry, you can obtain proof on the Horse/Owner and Rider/Trainer tabs after the USEF # is entered).

• ⓫ TIN: If your show provides monetary or other prizes that must be declared for tax purposes, enter 
their Tax Identification Number.  

• ⓬ Notes: Type in any other information you want to record about the person.  This information is not 
sent to the entrant.

SECTION II. BEFORE THE SHOW

9

1 2

3
4

5

6
7

8

SUMMARY TAB > HORSES > HORSE OWNER > OWNER CONTACT DATA:

10

11

12
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USEF # USEF Exp Explanation Verif

USEF # 11/30/2022 Current USEF member.  You can edit the date, if needed. 

Blank EC
Equine Canada member; provided EC verification. Equine Canada member in a USEF show. USEF non-
member but USEF fee not required.  Keep a copy of the verification.



Blank or 
USEF #

EX
USEF EXempt.  USEF #: USEF never-member (blank) or USEF membership has expired (enter USEF #).  Only 
participating in exempt classes (Pas de Deux, Quadrille, Intro and Opportunity, etc.). USEF non-member fee 
not required.



Blank F
Foreign Rider License.  USEF non-member.  Person has a Foreign Rider License, provided verification, and is 
only riding in FEI Championships and in CDI classes.  USEF non-member fee not required.  Keep a copy of 
the verification.



Blank or 
USEF #

JAS
Joined at Show.  USEF never-member (blank) or USEF membership expired (enter USEF #).  Joined or 
renewed USEF at the Show.  You have the USEF Membership Application and fee (send to USEF after the 
show).  USEF non-member fee not required.



USEF # Lifetime USEF Life Member.  Does not expire.  

Blank or 
USEF #

PARENT

PARENT of a minor rider/owner; must be listed as the trainer.  USEF never-member (blank) or USEF 
membership has expired (enter USEF #). GR1308: When an entry is under a minor’s [under 18] ownership 
and training, the parent who must sign will be exempt from the Federation non-member fee.  USEF non-
member fee not required.



Blank or 
USEF #

SP

USEF Show Pass for a USEF non-member.  Person is participating in non-exempt classes so is not exempt.  
USEF never-member (blank) or USEF membership has expired (enter USEF #). USEF fee required. If in 
doubt, classify the person as a SP and collect the fee.    if fee is paid,  if fee is not paid (you must 
collect the fee!).  It is important to use SP as this is how the FVD program tracks non-members for the Non-
Member Information & Fees report, which helps you determine the money you owe USEF.

 if fee 
paid

 if fee 
not paid

Blank or 
USEF #

APPL*
APPLied for USEF membership or renewal before the show and verification provided; USEF non-member 
fee not required. USEF never-member (blank) or USEF membership has expired (enter USEF #).  Keep a 
copy of the verification.
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Details of FVD Entries > Summary Tab > Horses > Owner > Owner USEF

SECTION II. BEFORE THE SHOW

SUMMARY TAB > HORSES > OWNER > OWNER USEF:
EE Entry:
• The data was entered with the EE upload.
• Use the EE Memberships Page and/or an 

EqVerification.org page to verify:
o ❶ USEF #.
o ❷ USEF Expiration:  If needed, use the drop-

down arrow to make the correct selection, as in 
the chart. 

• When verified, click the ❸ Cards Verified box.

Handwritten Entry:
• The data is hand entered by you.
• Use the EE Memberships Page and/or an 

EqVerification.org page to verify and enter:
o ❶ USEF #.
o ❷ USEF Expiration:  Use the drop-down arrow 

to make the correct selection, as in the chart. 
• When verified, click the ❸ Cards Verified box.

1 2

3

* = not in the drop-down menu.

USEF NON-MEMBER - IF IN DOUBT, COLLECT THE FEE: If a person cannot prove to you that s/he is a current USEF member, 
assume the person is a non-member and collect the non-member fee.  If s/he can later prove s/he was a member before the 
first ride, you can issue a refund, depending upon your prize list refunds policy.  It is much more difficult to collect a non-
member fee after the show!  If USEF determines the person was a non-member, they will expect the show to pay the fee.

1 2 3

Continued on next page…
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Details of FVD Entries > Summary Tab > Horses > Owner > Owner USDF

SECTION II. BEFORE THE SHOW

* Not on the FVD drop-down list.  Type in the selection if it applies.

EE Entry:
• The data was entered with the EE import.
• Use the EE Memberships Page and/or an 

EqVerification.org page to verify:
o ❶ USDF #.
o ❷ USDF Expiration:  If needed, use the drop-

down arrow to make the correct selection, as 
in the chart. 

• When verified, click the ❸ Cards Verified box.

SUMMARY TAB > HORSES > OWNER > OWNER USDF:

USDF # USDF Exp Explanation Verif

USDF # 11/30/2022 Current USDF member.  You can edit the date, if desired, for 5-year members. 

USDF # Lifetime USDF Life Member.  Does not expire.  

Blank or 
USDF #

Non-Member

USDF Non-Member; USDF fee is required. If in doubt, classify the person as a Non-Member and collect 
the fee.  Person is participating in non-exempt classes so is not exempt.  USDF never-member (blank) or 
USDF membership has expired (enter USDF #).   if fee is paid,  if fee is not paid (you must collect the 
fee!). It is important to use Non-Member as this is how the FVD program tracks USDF non-members for the 
USDF Non-members Report, which helps you determine the money you owe USDF. 

 if fee 
paid

 if fee 
not paid

Blank or 
USDF #

EX*
EXempt from USDF membership; USDF fee not required.  USDF never-member (blank) or USDF membership 
has expired (enter USDF #).  Only participating in Pas de Deux, Quadrille, Intro and Opportunity, etc.).



Blank or 
USDF #

JAS*
Joined at Show; USDF non-member fee not required.  USDF #: USDF never-member (blank) or USDF 
membership expired (enter USDF #). You have the USDF Membership Application and fee (send to USDF 
after the show.



Blank or 
USDF #

APPL*
APPLied for USDF membership or renewal before the show and verification provided; USDF non-member 
fee not required.  USDF #: USDF never-member (blank) or USDF membership has expired (enter USDF #). 
Keep a copy of the verification.



NOTE: Do not accept GMO 
membership card and date as 
proof of USDF membership.

1 2
3

USDF NON-MEMBER - IF IN DOUBT, COLLECT THE FEE: If a person cannot prove to you that s/he is a current USDF 
member, assume the person is a non-member and collect the non-member fee.  If s/he can later prove s/he was a 
member before the first ride, you can issue a refund, depending upon your prize list refunds policy.  It is much 
more difficult to collect a non-member fee after the show!  If USDF determines the person was a non-member, 
they will expect the show to pay the fee.

USDF GM MEMBERSHIP - DO NOT USE GM NUMBER AND GM EXPIRATION: People that are USDF Group 
Member (GM) members may participate in USEF/USDF shows and do not pay USDF non-member fee; however, 
they cannot qualify for GAIG or national awards.  USDF GM members receive a USDF membership number and 
card with a USDF expiration date; this USDF information must be used to verify membership.  The GM number and 
GM expiration date cannot be used as a proof of USDF membership.

Handwritten Entry:
• The data is hand entered by you.
• Use the entry documents to correct/update/verify:
o ❶ USDF #.
o ❷ USDF Expiration:  Use the drop-down arrow to make the correct selection, as in the chart. 

• When verified, click the ❸ Cards Verified box.

1 2 3
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Details of FVD Entries > Summary Tab > Rider

SECTION II. BEFORE THE SHOW

Handwritten Entry:
• As with horses and owners, a rider could be a 

person already in the HR.hdf file or not already in 
the hr.hdf file.

• If the rider is already in the HR.hdf file, select the 
name using the ❶ drop-down arrow or by 
typing the name in the ❷ Rider (Lookup) box, 
as for the horse and owner.

• If the rider is NOT on the list (not already in the 
HR.hdf file), click the ❸ Add Rider button.

• The ❹ Rider form opens.
o Enter the rider information as for the Owner.
o If not already entered, use the ❺ Rider 

Status drop-down arrow and select the correct 
status.

o If not already entered, enter the ❻ DOB.
o Click ❼ OK.

1
2 3

• You are returned to the ❽ Summary tab.
• The rider name is below the ❾ Entry #.
• The rider name is in the ❿ Rider (Lookup) box.
• If you checked the Auto Fill Trainer box in Main 

Menu > Show Office > Show Preferences > 
General tab, the ⓫ Trainer is automatically 
entered as the same person as the rider.  If this is 
incorrect, change to the correct person, as in the 
next section.

• Enter the ⓬ Coach, as for the Rider.
• If the horse is for sale, check the ⓭ For Sale box.
• If a signature is missing, check the applicable ⓮

Need XXX box(es).
• When you are done with this entry, click the ⓯

Close icon.

SUMMARY TAB > RIDER:

EE Entries:
• The EE import enters the rider information.
• Use the information for a handwritten entry to 

review/correct/update the rider information, 
including membership verification, which is NOT 
entered by EE.

NOTE: If the Rider was previously entered as an 
Owner, ensure you have recorded the Rider Status 
and DOB.

7

4

5
6

5
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Details of FVD Entries > Summary Tab > Trainer and Coach > USEF Rules, Entry Information

Interpretation:  For show purposes, the trainer is not necessarily the person that is normally paid to train the 
horse or the rider.  For show purposes, the trainer is the adult person responsible for the horse while the 
horse is on the show grounds.  The trainer may be the same person as the rider and/or owner. The trainer 
must sign the competition entry form and has USEF membership requirements.

SECTION II. BEFORE THE SHOW

• Enter/review/correct/update the Trainer and the (optional) Coach as for the Owner and Rider.  See 
Owner and previous page.

Interpretation:  The coach is the person who is coaching the rider/handler during the competition.  This may 
or may not be the rider’s coach at home. The coach may be the owner, trainer, or someone else.  A coach is 
not required for the competition and a coach signature is optional.  If the coach may ride the horse while it is 
on the show grounds, the coach must be included in the entry.

USEF Rule GR108 Coach.
For purposes of these rules, a coach is defined as any adult or adults who receives remuneration for having or 
sharing the responsibility for instructing, teaching, schooling, or advising a rider, driver, handler or vaulter in 
equestrian skills. See also GR906.4 and GR908.

USEF Rule GR148. Trainer
1. Any adult, or adults, who has the responsibility for the care, training, custody or performance of a horse.
2. Said person must sign the entry blank of any Licensed Competition whether said person be an owner, rider, 

agent and/or coach, as well as trainer.
3. Where a minor exhibitor has no trainer, a parent or guardian must sign and assume responsibility of 

trainer.
4. The name of the trainer must be designated as such on the entry blank.  See also GR404.

SUMMARY TAB > TRAINER AND COACH > USEF RULES:

TRAINER AND COACH > ENTRY INFORMATION:

NOTES: 
• If the rider/owner is a minor, the PARENT must sign as the TRAINER.  In this capacity, the PARENT is not 

required to be a USEF member and is not required to pay USEF non-member (show pass) fee.
• The trainer must be on the show grounds while the horse is on the show grounds.

TRAINER = Adult person responsible 
for the horse while on the show 
grounds.  Trainer must be on the show 
grounds.  Must be a USEF member or 
pay USEF Show Pass (non-member) fee.

COACH = Person who coaches the rider, for 
money, while on the show grounds.  Coach 
is optional unless the coach will ride the 
horse.  If a coach is declared, must be a 
USEF member or pay USEF Show Pass (non-
member) fee.

NOTE:  Now that you have entered the Horse, Owner, 
Rider, Trainer and Coach (if applicable), you can 
view/edit their information using the Entry tabs ❶
Horse/Owner, ❷ Rider/Trainer, and ❸
Coach/Team.  1 2 3

NOTE 2:  See MANAGING TEAMS for information on Teams.
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Details of FVD Entries > Summary Tab > Check Boxes

SECTION II. BEFORE THE SHOW

SUMMARY CHECK BOXES:
Click to check the appropriate boxes:
• ❶ For Sale: If the horse is for sale, check the box ( = yes the horse is for sale).  This will be annotated 

in the show program.  (optional)
• Signatures:  FVD helps you track missing signatures.
o ❷ Owner, Rider, Parent (if applicable), Trainer, and Coach (if applicable) Signatures are required on 

the USEF Waiver and the USEF Entry Agreement forms.   They can be copies, a FAX, a printed email 
attachment, or as part of the online entry.  If the box is checked, it will appear as a deficiency on FVD 
reports.

o Check the appropriate box:
▪  = you NEED the signature.
▪  = you have the signature.

• ❸ Confirmation Mailed:  
o When you click the ❹ Upload Confirmations button and send a FVD Confirmation to the entrants, 

this box is automatically checked (), letting you know an electronic confirmation was sent.
o If you have an update to the entry so you want to send another entry confirmation:
▪ Uncheck the ❸ Confirmation Mailed box.
▪ Click another tab to save the uncheck.
▪ Click the ❺ Summary tab.  The check will remain gone.
▪ You can now use ❹ Upload Confirmations again.

NOTE: See Some Notes About Database 
Programs for an explanation of check boxes.

4

1

2

3

5

CONGRATULATIONS!  YOU HAVE COMPLETED AN ENTRY.
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POST MARKED: (optional)
• If you want to track the date you received an EE  

entry or the postmark date of a snail mailed 
entry, enter the date in the ❶ Post Marked box 
(MM/DD/YYYY format).  (optional)

180

Details of FVD Entries > Summary Tab > Post Marked, Balance, Entry Memo, Hold

SECTION II. BEFORE THE SHOW

BALANCE: (auto-calculation)
• The ❷ Balance will be automatically completed 

by the FVD program after the classes and fees are 
entered (see Class Entries, Stabling > Fees and 
Other Fees, Payments) are entered.

ENTRY MEMO: (optional)
• Enter any ❸ Entry Memo necessary for this 

entry.  For example, you  may want to enter 
“Complete” if the entry is complete.  If it is 
missing something, you may want to type the 
information here, as a reminder for you and the 
entrant.  This text is included on the Entry 
Confirmation Report that is sent to the rider.  
(optional)

HOLD: (optional)
• When you click the ❹ Hold check box, it is 

checked.  An annotation is on the Reports > 
During-Show > Show Ring Steward’s report and 
the Reports > During-Show > Day Sheets Scoring 
report.  Its use indicates something must be 
settled in the show office before the ride or 
before the test and ribbon are provided.

1

2

3 4
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• After you have entered/reviewed/corrected/ 
verified the entry information, go back to the 
❶ Summary tab.

• Click the ❷ Edit Emergency Contact button.

181

Details of FVD Entries > Summary Tab > Emergency Information

SECTION II. BEFORE THE SHOW

EMERGENCY INFORMATION: (optional)

• The ❷ Emergency Contact form opens.
• Complete the information, which is provided on 

the EE and handwritten entry form.
• Click ❸ Close.

2

3

1

2

NOTE:  For EE entries, emergency information is collected in EE; however, the data does not upload into FVD.  If 
you want this information in FVD, you need to enter it by hand.
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Details of FVD Entries > Summary Tab > Need List 

SECTION II. BEFORE THE SHOW

1

• Open Main Menu > Entries > Summary tab.
• Click the ❶ Edit Need List button.

NEED LIST: (optional)

2

3

4

3

5

6

7

8

• If the appropriate items is not on the list, click 
the ❹ Edit Need List Category button.
o Click the ❺ Add Need List Category button.
o Type in the ❻ item you want to add to the 

list.
o Click ❼ Close.

• The ❷ Need List form opens.
• Use the ❸ drop-down arrow to see the list of 

built-in items.  Select the  appropriate item if it is 
on the list.

o Use the ❽ drop-down arrow to select the 
item for this entry.

NOTE: The Need List appears on the Reports > Pre-Show > 
Packet Sheets report (not on Packet Labels) and the Online 
Entry Confirmations.  It is another way to let entrants know of 
items missing in their show application.
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Details of FVD Entries > Horse/Owner, Rider/Trainer, and Coach/Team Tabs; Teams

SECTION II. BEFORE THE SHOW

1 2

3

Now that you have entered the Horse, Owner, Rider, Trainer and Coach (if applicable), you can view/edit 
their information using the Entry tabs ❶ Horse/Owner, ❷ Rider/Trainer, and ❸ Coach/Team.  

HORSE/OWNER, RIDER/TRAINER, COACH/TEAM TABS:

TEAMS:

See MANAGING TEAMS for information on Teams.
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Details of FVD Entries > Horse/Owner, Rider/Trainer, and Coach/Team Tabs > 
USEF Information Button > Introduction, Horse 

SECTION II. BEFORE THE SHOW

• Now that you have entered the Horse, Owner, 
Rider, Trainer and Coach (if applicable), you can 
verify their USEF information by clicking the ❶
USEF Information report for each.

• The information is directly from the USEF 
database and can be used to verify/update entry 
data.

USEF INFORMATION BUTTON > INFORMATION:

• Click the ❷ USEF Information button for the 
horse.

• The ❸ USEF Horse Information report opens.  It 
is prepopulated with data from USEF.

1

1

2

• On the ❹ General tab, you see specific information for the horse.

USEF INFORMATION BUTTON > HORSE:

3

MM/DD/YYYY

#######

HORSE NAME

MM/DD/YYYY

BREEDER NAME

DAM NAME

DAM SIRE NAME

SIRE NAME

#######

MM/DD/YYYY

Continued on next page…
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Details of FVD Entries > Horse/Owner, Rider/Trainer, and Coach/Team Tabs > 
USEF Information Button > Horse, Cont’d. 

SECTION II. BEFORE THE SHOW

• Next click the ❹Memberships/Owners tab.  Horse membership(s) and owner info will be shown here.

#######

#######

OWNER LAST, FIRST NAME

• Next click the ❺Measurement Card tab.  Pony measurement will be shown here.

4

5

6 7

• If desired, click ❻ Print to print the report.
• Click ❼ Close to close the report.



Fox Village Dressage User Manual – 2021 Update 1.0.5. helpdesk@foxvillage.com                 www.foxvillage.com186

Details of FVD Entries > Horse/Owner, Rider/Trainer, and Coach/Team Tabs > 
USEF Information Button > Owner

SECTION II. BEFORE THE SHOW

• Click the ❶ USEF Information button for the 
owner.

1

USEF INFORMATION BUTTON > OWNER:

Continued on next page…

• The ❷ USEF Individual/Organization Information report opens.  It is prepopulated with data from 
USEF.

• On the ❸ General tab, you see specific information for the owner.

2

3

MM/DD/YYYY

MM/DD/YYYY

OWNER USEF #

I, B or F

XXXX

OWNER FNAME

OWNER MN

OWNER LNAME

OWNER FNAME LNAME

MM/DD/YYYY

##

OWNER EMAIL ADDRESS

OWNER ADDRESS 1

OWNER ADDRESS 1

OWNER CITY

ST

OWNER ZIP CODE
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Details of FVD Entries > Horse/Owner, Rider/Trainer, and Coach/Team Tabs > 
USEF Information Button > Owner, Cont’d. 

SECTION II. BEFORE THE SHOW

• Next click the ❹Memberships/Phones tab.  The owner membership(s) and phone # will be shown.

• Using the Rider/Trainer and Coach/Team tabs, repeat for the rider, trainer and coach (if applicable).

• You can use these reports to verify/update the people data.

• If desired, click ❻ Print to print the report.
• Click ❼ Close to close the report.

(###) ###-####

#######

#######

4

(###) ###-####

5 7



Fox Village Dressage User Manual – 2021 Update 1.0.5. helpdesk@foxvillage.com                 www.foxvillage.com

1

The next step is to enter the class(es) requested by 
the entrant.

EE Entry:
• The EE import enters the classes requested.
• Review the handwritten entry instructions for 

class details.
• Using the entry form, verify that the correct 

classes are listed.
• GAIG Q: If the entry requested GAIG Q, ensure it 

is a GAIG Q class and ensure the people and horse 
in the entry have the correct USEF and USDF 
memberships.

• TOC: If the entrant requested a Test of Choice 
(TOC) class, the test will be listed as Place Holder.  
Select the correct test.

• MFS: If the entrant requested a MFS class, ensure 
the entrant is qualified to ride the MFS test.  Also, 
MFS classes are often TOC; therefore, you need to 
follow the TOC instructions above.

188

Details of FVD Entries > Class Entries Tab > Enter Classes

SECTION II. BEFORE THE SHOW

• Open the Entries form and the Entry # on which 
you are working.

• Select the ❶ Class Entries tab.
• The ❷ Class Entries tab opens.

Handwritten Entry:
• Click the ❸ Class drop-down arrow and click on the ❹ Class Text / Class Name corresponding to the 

first class in which the entry is to be entered.  You can also type in the class number and press return.  In 
this example, class 102.0 is selected.  The ❺ class is now in the box.

• If a second class was requested, select that class. Etc.  

CLASS ENTRIES > ENTER CLASSES:

3

4

2

5

NOTE:  USEF rule DR 119.2. states: 
“Horses ... are limited to a maximum of 
three Dressage rides per day at Fourth 
Level and below or two Dressage rides 
per day above Fourth Level. Horses 
competing at both Fourth Level and 
Prix St. Georges, or their equivalents, 
are limited to two Dressage rides per 
day. ...”  
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CLASS ENTRIES > CLASS WITH ONE TEST: 

• If the class has a single test (it is not a Test of Choice class), the ❶ Test name will automatically be 
entered in the test box (you set this up in Select Classes) and the ❷ Fee will automatically be entered in 
the fee box.

189

Details of FVD Entries > Class Entries Tab > Class with One Test

SECTION II. BEFORE THE SHOW

1
2
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CLASS ENTRIES > TEST OF CHOICE CLASS: 
• If this is a ❶ Test-of-Choice (TOC) class, the automatic test is ❷ Online Test Place Holder (you set this 

up in Select Classes).  Use the ❸ Test drop-down arrow to select the ❹ test requested on the entry 
form.  Ensure the requested/selected test is appropriate for the TOC class.  For example, if it is a FEI TOC 
class, a USEF test may not be selected.

CLASS ENTRIES > TEST OF CHOICE CLASS: 
• If this is a MFS class and the required copy of the appropriate qualifying test was received, check the ❺

FS Verify box.   If the test was not received, do not check the box (FVD will report it as a deficiency on the 
confirmation report).

190

Details of FVD Entries > Class Entries Tab > Test of Choice Class, MFS Class

SECTION II. BEFORE THE SHOW

1

2

3

4

5
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Details of FVD Entries > Class Entries Tab >
Qualifying Status for GAIG Regional Championships

• The GAIG Q rider status is now in the ❺ Qual/Div box.
• The qualifying ❻ Fee will automatically be added to the fee amount (in this example $60 class fee  + 

$15 qualifying fee = $75 total fee).

SECTION II. BEFORE THE SHOW

• If a rider wants an opportunity to qualify for the GAIG Regional Championships, the test must be a 
qualifying test and the rider must pay $15 extra BEFORE the ride.  The Yes/No for Qual/Div must be 
entered.  If it is not a qualifying ride, the default No does not need to be changed.

• By default, the ❶ Qual/Div (Qualification / Division = Rider Status) box has a ❷ No in the box (not a 
GAIG qualifying ride). 

• If the entry has requested a GAIG qualifying ride in a GAIG qualifying class, use the ❸ Qual/Div drop-
down arrow to select❹ Yes.  (Ignore Adult Amateur, JR/YR and Open on the list – they are legacy 
selections)

CLASS ENTRIES > QUALIFYING STATUS FOR GAIG REGIONAL CHAMPIONSHIPS:

NOTE : Ensure you have set up the qualification fee before you perform this step.  See Show Fees > System Fees.

NOTE: Click 
here for GAIG 
information 
on the USDF 
web site.

65

NOTE: You 
may use other 
options on the 
list; however, 
when another 
option is 
selected, the 
ride cannot be 
listed as a 
GAIG Q ride.

2

4

1

3

https://www.usdf.org/competitions/competitions-championships/regionals/competitors.asp
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Handwritten Entry:
• Click the ❶ Stabling Fees tab.
• If, in Show Fees > Custom Fees you selected stabling fees to be automatically entered for all entries, click the 
❷ Add Auto Fees button.  The fees are automatically entered.

• If you did not use automatic stabling fees or there are additional fees, use the ❸ Description drop-down 
arrow to see the list of available fees. The list includes the stabling ❹ System Fees that are built into FVD 
(they cannot be deleted) and any ❺ Custom Fees you may have entered in Show Fees > Custom Fees. Each 
item is a separate line.   Select the stabling requested in the entry. 

• Enter the ❻ Qty (number of items, the default is 1).  
• The ❼ Rate (= cost) is entered automatically.  The❽ Extension (Qty x Rate) will automatically be entered 

by FVD.
• For ❾ Stabling items, enter the horse stall and tack stall as separate lines, if both were requested.  
o If you used Day Stabling: Under Qty, enter the number of days for the horse stall and the number of days 

for the tack stall.
o If you used Show Stabling: Under Qty, enter 1 for a horse stall and 1 for a tack stall (if requested).

192

Details of FVD Entries > Stabling Tab > Fees, Stall #

NOTE: Ensure you have set up the stabling types and fees first.  See Show Fees for the procedure.

• Using the ⓭ Stall # drop-down, select the 
stall number for this horse (see Stalls for 
instructions to enter stalls).

SECTION II. BEFORE THE SHOW

• If the entrant did not request stabling, 
include the ❿ Haul In Fee (daily 
grounds fee), if applicable (this is a 
System Fee).  Enter the Qty (number of 
days the person will be hauling in).

• If the person has requested ⓫
Shavings, include this on the list and 
the Qty (number of bales requested).

• The⓬ Total Stable Fees box is 
automatically calculated and entered 
by the FVD program.

STABLING > FEES:

STABLING > STALL #:

EE Entry:
• The EE import provides stabling data.
• Using the Handwritten information as a guide, review/correct/update the stabling information.

3

1

9

2

System Fees

Custom Fees

4

5

6
11

10

7 8

12

13
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STABLING > STABLING DAYS:
• Check the ❶ Days that the horse will be in the 

stall.  This check mark is important as it 
determines  the correct stall counts on the stabling 
reports.

193

Details of FVD Entries > Stabling Tab > Stabling Days, Stall Groups, Stable Comments

SECTION II. BEFORE THE SHOW

9

8

10

NOTE: If possible, in the Prize List or on the show web 
site, encourage competitors to standardize the name 
of their stall groups.   For example, ⓬ Suzy Smith 
and ⓭ Smith Dressage are the same group; you will 
need to figure this out and put all in the group under 
the same stall group name.  If they all input Smith 
Dressage, it would make the job easier for you.

13
12

1

2 37

11

NOTE: For a show stall, the horse will use the stall on 
the days checked, and the intervening nights.  For 
example, if Friday and Saturday are checked, the horse 
will arrive Friday, stay in the stall Friday night, and 
depart on Saturday.  If Friday, Saturday, and Sunday 
are checked, the horse will arrive on Friday, stay in the 
stall Friday and Saturday nights, and depart on Sunday.  
For a day stall, the horse may only be in the stall during 
the checked days, not overnight.

4

5 6

STABLING > STALL GROUPS:
• Explanation: If a rider requests to be stabled with a 

particular person/farm/group, this is recorded via 
the ❷ Stall Group box.  You will need to create 
Stall Group names that represent groups of people 
who want to stable together.  This may be difficult 
to track because Susie may ask to be stabled with 
Ann, but Ann may ask to be stabled with XYZ Farm.  
It is up to you to figure out what they want.  It is 
best to use the name of the most prominent 
trainer or farm in the group.

• Create a Stall Group: For each new Stall Group, the 
first entry received requesting a particular 
person/barn/ group will require you to enter a Stall 
Group name in the Stall Group list:
o Click on the ❸ Edit Stall Groups button. 
o The ❹ Stall Group form opens. 
o To enter a new stall group, click the ❺ Add 

Stall Group button.
o Enter the group name on the blank line.
o Use one unique term for each stall group.
o Click ❻ Close.

• Use a Stall Group: 
o Click on the ❼ Stall Group drop-down arrow.
o The ❽ Stall Group list opens.
o Select the requested ❾ Stall Group name by 

clicking it.
o The ❿ Stall Group name is entered in the Stall 

Group box.
NOTE:  Comments 
made by entrants 
when using EE also 
appear in this box. 

STABLING > STABLE COMMENTS:
• If there are any special stabling 

comments, enter them in the 
⓫ Stable Comments box.
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• Select the ❶ Other Fees / Payments tab. 

Handwritten Entry:
❷ OTHER FEES:
• If you want the auto fees to apply to this entry, 

click the ❸ Add Auto Fees button.
• Using the❹ Description drop-down arrow, add 

any other fees that are applicable to this entry. 
❺ PAYMENTS / CREDITS:
• Using the ❻ Payment Type drop-down arrow, 

select the payment type (Check, Credit Card, 
Cash, etc.) used by this entry.

• Credit Card Payment (leave blank if CC not used):
o Using the ❼ Credit Card drop-down arrow, 

select the type of credit card (MasterCard, 
etc.).

o Using the❽ CC#/CK# box, enter the credit 
card number (or the check # if applicable).

o Using the ❾ Exp box, enter the expiration 
date of the credit card (MM/YY).

• Check Payment:
o Using the ❽ CC#/CK# box, enter the check 

number.
• Amount:
o Using the❿ Amount box, enter the  amount 

of the payment. 
• Total Payments:
o The amount paid will automatically be entered 

in the ⓫ Total Payments box.
• Balance:
o Any balance due will automatically be 

calculated and entered in the ⓬ Balance box.
o Any overpayment will automatically be 

calculated and entered (with a -) in the ⓬
Balance box.

o The ⓭ Balance is also automatically entered 
in the ⓮ Summary tab.

• If you want to print an invoice, click the ⓯ Print 
Invoice button.

• Click ⓰ Close to close the form.

194

Details of FVD Entries > Other Fees / Payments Tab

NOTE: Ensure you have set up Show Fees, 
Payment Types, and Credit Card Types before 
you perform this step.  

SECTION II. BEFORE THE SHOW

EE Entry:
• The EE upload provides the Other Fees and 

Payments data.
• Use the information for a Handwritten Entry to 

review/correct/update/verify the data.

13

14

4

3

2 1

6 7 8 9

5

6 7

10

11

12

15

16
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Details of FVD Entries > Delete a Horse

• A ❾ Fox Village Dressage warning message 
opens.

• Click ❿ Yes.
• The horse will no longer be in the HR.hdf file.
• The Owner is NOT deleted.

SECTION II. BEFORE THE SHOW

• The ❹ Horse/Owner form opens.
• Select the horse by using the ❺ Horse (Lookup)

drop-down arrow or by typing the horse’s name 
in the ❻ Horse (Lookup).

• The horse’s name will appear in the ❼ Name
box.

• Click the ❽ Delete Horse button.

• Select ❶Main Menu > ❷ Show Office 
> ❸ Horses.

NOTE: If a Horse is part of an entry in 
this show, s/he cannot be deleted.

DELETE A HORSE:

1

2

3

4

5
6

7

8

NOTE: You can also use this form to add or edit a 
Horse.

9

10
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Details of FVD Entries > Delete a Person (Owner, Rider, Trainer, Coach)

• A ❾ Fox Village Dressage warning message 
opens.

• Click ❿ Yes.
• The person will no longer be in the HR.hdf file.

SECTION II. BEFORE THE SHOW

• The ❹ People form opens.
• Select the person by using the ❺ People 

(Lookup) drop-down arrow or by typing the 
person’s name in the ❻ People (Lookup) box 
(people can be the Owner, Rider/Handler, Trainer, 
or Coach).

• The person’s name will appear in the ❼ Name
boxes.

• Click the ❽ Delete Person button.

• Select ❶Main Menu > ❷ Show Office 
> ❸ People.

NOTE: If a Person (Owner, Rider, Trainer or 
Coach) is part of an entry in this show, s/he 
cannot be deleted.

DELETE A PERSON (OWNER, RIDER, TRAINER, COACH):

1

2

3

4

5
6

7

8

9

10

NOTE: You can also use this form to add or edit a 
Person.



Fox Village Dressage User Manual – 2021 Update 1.0.5. helpdesk@foxvillage.com                 www.foxvillage.com197

SECTION II. BEFORE THE SHOW
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NOTE: Upload Confirmations only uploads/updates 
entries for which the Confirmation Mailed check 
box is NOT checked.  
 = Upload confirmations will not upload/update 
an entry.
 = Upload confirmations will upload/update an 
entry.

You need to inform the entrant that the entry has been received in a timely manner (or not) and also inform 
the entrant of any entry deficiencies that must be corrected before participation in the show.  The entrant 
may be notified via any one or more of the following:

You can Upload Confirmations via one of two 
methods:
1. From the ❶ Main Menu, click ❷ Upload 

Confirmations.
OR

2. Select  ❶Main Menu > ❸ Show Office >     
❹ Entries.  The ❺ Entry form opens.  Click ❻
Upload Confirmations.

198

FVD Confirmations > FVD Upload Confirmations > Open FVD Upload Confirmations

SECTION II. BEFORE THE SHOW

6

5

OPEN FVD UPLOAD CONFIRMATIONS

1

3

4

2

A. FVD Upload Confirmations web service
B. [Snail] Mail
C. Email from you.

The FVD Upload Confirmations service sends an 
email to the rider, owner, trainer, and coach.  The 
email contains a link that opens a web page with all 
the entry information, including annotation of any 
deficiencies (missing Coggins, missing signature, 
etc.).  The people respond to the show secretary, via 
the web page, that the entry is correct (Accept) or 
that the entry needs correction(s) (Reject) and use a 
notes section to communicate with the show 
secretary.  The show secretary tracks the 
confirmation responses on the web site, updates 
the entry, and sends updated information.

NOTE: After an entry is uploaded, the Confirmation 
Mailed check box is automatically checked.  You will 
need to uncheck it if you want to resend a 
confirmation after updating an entry.
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• The FVD ❶ Upload Confirmations to Web form 
opens.

• Click ❷ Upload Now.

199

FVD Confirmations > FVD Upload Confirmations > Send FVD Confirmations [e]Mail

SECTION II. BEFORE THE SHOW

• A ❸ Fox Village Dressage form verifies the 
confirmations were uploaded.

• Click ❹ OK to close the form.

• The people (rider/handler, owner, trainer, and coach) receive a ❺ FVD Confirmations [E]Mail.
• They click on the ❻ link.

FVD UPLOAD CONFIRMATIONS > SEND FVD CONFIRMATIONS [e]MAIL:

3

4

Rider@email.com;Owner@email.com;Trainer@email.com;Coach@email.com

5

6

1

2

mailto:Rider@email.com
mailto:Owner@email.com
mailto:Trainer@email.com
mailto:Coach@email.com
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FVD Confirmations > FVD Upload Confirmations > Entrant Views Entry Information

SECTION II. BEFORE THE SHOW

• After clicking the link, 
the entrants see a web 
page similar to the 
figure.

• The entrants review the 
information, then click: 
o ❶ Accept: Yes, 

everything is correct 
and complete.
or 

o ❷ Reject: No, I want 
to change something, 
something is not 
correct, or another 
problem.

• The entrants can then:
o Enter ❸ Your Name 

(the entrant’s name)
and

o Write ❹ Notes to 
the Secretary …

• They then click ❺
Submit to send an email 
to the show secretary.

FVD UPLOAD CONFIRMATIONS > ENTRANT VIEWS ENTRY INFORMATION:

1

2

4

5

3

NOTE: Unfortunately, not 
all entrants view the 
Confirmations Email.  
Hopefully, over time, 
entrants will become 
accustomed to opening, 
reading, and responding 
to the email.  If an entry 
has deficiencies, I also 
send a separate email 
from me with a clear 
Subject that the email is 
for the show.
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• The show secretary receives an email with a link to view the entrant’s response.

• The show secretary can also view a list of all show confirmations and their status.  Open the ❶ Upload 
Confirmations (see Upload FVD Confirmations > Open the Service) then click ❷ Click here to view the 
confirmations website.

201

FVD Confirmations > FVD Upload Confirmations > Secretary Views Confirmations Status

SECTION II. BEFORE THE SHOW

• The ❸ Fox Village Dressage Confirmation Manager Service web site opens with a list of entry 
confirmations that have uploaded.

• Click on the ❹ Entry # to view/respond to the entrant.

FVD UPLOAD CONFIRMATIONS > SECRETARY VIEWS CONFIRMATION STATUS:

1

2

3

4



Fox Village Dressage User Manual – 2021 Update 1.0.5. helpdesk@foxvillage.com                 www.foxvillage.com

• If the entrant accepted the confirmation, under ❶ Confirmation, the secretary sees ❷ The entry has 
been accepted and is now closed to changes.

• The secretary can send another ❸ Notes to Entrant, if desired.
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FVD Confirmations > FVD Upload Confirmations > Secretary Views Confirmations Status >
Accepted Entry

SECTION II. BEFORE THE SHOW

1
2

3

FVD UPLOAD CONFIRMATIONS > SECRETARY VIEWS CONFIRMATION STATUS > ACCEPTED ENTRY:
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FVD Confirmations > FVD Upload Confirmations > Secretary Views Confirmations Status >
Rejected Entry

SECTION II. BEFORE THE SHOW

• If an entrant rejected the confirmation [clicked ❶ Reject (No, I want to change something or 
something is not correct)] and requested a change to the entry in the ❷ Notes to Secretary (if you are 
rejecting the entry, please describe briefly and explicitly as possible the reason why) box, the show 
secretary should update the entry in FVD then send a new confirmation to the entrant, which will show 
the change and verify that it was done.

• If an entrant requested a change that cannot be done, or if there is another needed communication, the 
show secretary should send a reply to the confirmation response sent by the person, indicating in the ❸
Notes to Entrant box that the request cannot be done, and why.

1

2

3

FVD UPLOAD CONFIRMATIONS > SECRETARY VIEWS CONFIRMATION STATUS > REJECTED ENTRY:
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SECTION II. BEFORE THE SHOW
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1

• To print confirmation mailers for a group 
of entries, perhaps from a day’s work, 
select  ❷Main Menu > ❸ Reports > 
❹ Pre-Show > ❺ Entry Confirmation 
Mailers.

205

Snail Mail Confirmations > Snail Mail Confirmation Notification

SECTION II. BEFORE THE SHOW

If you do not want to use the web service, or the entrant does not have an email address, you can print and 
snail mail entry confirmations to entrants.

SNAIL MAIL CONFIRMATION NOTIFICATION:

• To print a confirmation mailer for one entry that 
you just completed, click the ❶ Print 
Confirmation button.

2

3

4

5

OR
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• The ❻ Entry Confirmation Mailer form opens.
• For ❼Mailer Style, select the type of mailer 

you want to use:
o If you wish to use a ❽ Self-Mailer (a printed 

piece of paper that you fold into thirds, secure 
with tape, and mail), click this radial button.   
This is the easiest method for mailing.

o If you wish to use a ❾Window Envelope (a 
printed piece of paper that you fold and put 
into a window envelope), click this radial 
button.

o If you wish to use a ❿ Standard Envelope 
(requires you to also print mailing labels), click 
this radial button.
▪ Click ⓫Mailing Labels if you want to print 

mailing labels to be used with the Standard 
Envelope style.

• Click ⓬ Expanded if you want to print the 
report in an expanded version on legal sized 
paper.

• Click ⓭ OK.  

206

Snail Mail Confirmations > Snail Mail Confirmation Notification, cont’d.

SECTION II. BEFORE THE SHOW

NOTE:  This report should not be posted on a public web site as it contains 
personal information (addresses, phone numbers, and email addresses).

6
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• The ❶ Entry Confirmation Mailer (Standard) report opens. 
• Click the ❷ Last Page button to display the total number of entries that have been entered.
• Alternately, click the ❸ Previous Page or ❹ Next Page icons until you see the report you want to print.
• This is a good time to review your work for errors.  For example, you might have forgotten to check the 
❺ Coggins box indicting you received a copy of the Coggins.  Review the information for each and every 
entry.  If you find an error, correct it on the Entries form.

• If a ❻ check box is checked (), the information is missing and needs to be submitted by the entrant.  

207

Snail Mail Confirmations > Snail Mail Confirmation Notification > Self-Mailer

SECTION II. BEFORE THE SHOW

SNAIL MAIL CONFIRMATION NOTIFICATION > SELF-MAILER:

RECOMMENDATION: 
Print (or screen capture) 
this report and include it 
in the entry packet as the 
first page of the packet.  
This report covers most 
items of the entry; it 
serves as an excellent 
entry summary and as an 
excellent document as it 
is automatically updated 
as deficiencies are 
corrected.

1

2

3 4
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• In Mail Confirmation Notifications > Mailer Style, if you checked the ❶ Expanded box, the ❷ Entry 
Confirmation Mailer (Expanded) report opens.   It is the same information as the Standard report but 
prints on legal-sized paper.

• Review the information for each and every entry.
• If a check box is checked (), the information is missing and needs to be submitted by the rider.  You 

may want to emphasize the missing information with a colored highlighter. 

208

Snail Mail Confirmations > Snail Mail Confirmation Notification > Expanded Mailer

SECTION II. BEFORE THE SHOW

SNAIL MAIL CONFIRMATION NOTIFICATION > EXPANDED [LEGAL-SIZED] SELF-MAILER:

1

2
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• To print the report, click the ❶ Print icon.  Also 
see PRINT PREVIEW.

• To close the report window, click ❷ Close Print 
Preview.

• The Self-Mailer / Entry Confirmation Report (Standard) has been designed as a tri-fold to be mailed 
without an envelope.  Fold the paper in thirds, ensuring the address is on the outside.  Tape the bottom 
edge to keep it closed.  Place a stamp and mail it. 

209

Snail Mail Confirmations > Snail Mail Confirmation Notification >
Print Report, Check Confirmation Mailed

SECTION II. BEFORE THE SHOW

• Select Main Menu > Entries.  
• Check the ❸ Confirmation Mailed check box.  
• The next time you print the Confirmation Mailer 

Report, only the newest entries will print.

NOTE:  To help you track the status/updates of your entries and to make your TD VERY happy, print the Entry 
Confirmation Report and attach it to the entry packet.  You can annotate changes on the paper document, 
which helps you track updates/changes (the computer does not track changes/updates), and the TD can 
review the paper document during the show – this helps the TD get oriented while reviewing each entry 
packet.

MAILED CONFIRMATION NOTIFICATION > PRINT REPORT:

3

MAILED CONFIRMATION NOTIFICATION > CHECK THE CONFIRMATION MAILED CHECK BOX :

2

1
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SECTION II. BEFORE THE SHOW
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Secretary Email Confirmations

SECTION II. BEFORE THE SHOW

SECRETARY EMAIL CONFIRMATIONS

• Unfortunately, I have found that less than half of 
show entrants respond to the FVD Confirmations 
(E)Mail.   Therefore, at this point, it may not be 
the most effective method to inform entrants of 
incomplete entries.

• Using the FVD Entry Confirmation Report to 
confirm an entry:
o Open the Entry Confirmation Report as on 

previous pages.
o Save the report as a ❶ PDF file (see Print 

Preview > Export > PDF or XPS).
o Email the entrants with the PDF file as an 

attachment (see Email One Person).

1

• Using a method with digital entry packets:
o For complete entries, I use FVD Confirmations (E)Mail.  
o For incomplete entries, I send a personal email to notify the entrants of the missing items.  The email 

has an embedded graphic that indicates the missing items.
o See DIGITAL ENTRIES PACKETS for this method of checking, assembling, and notification for digital 

entries.

• Regardless of your method, 
ensure the email SUBJECT is very 
specific to the show so entrants 
are more likely to open it.

• If you do not use FVD 
Confirmations, in FVD, check the 
Confirmation Mailed check box, 
as above.
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SECTION II. BEFORE THE SHOW
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Scratches Received BEFORE Scheduling > Introduction

Horses and riders can get injured or ill, which prevents them from participating in the show; therefore, their 
entry may be scratched before scheduling of the show or after scheduling of the show.   This chapter covers 
scratches that occur BEFORE scheduling.  See SCRATCHES AFTER SCHEDULING AND FILL SCRATCHED RIDES
for procedures for AFTER-scheduling scratches.

INTERPRETATION:
• In the Prize List, show management must publish its policies regarding scratches and the refund (or not) of 

fees. 
• If an entry is scratched from the competition prior to competing, show management must either refund the 

collected USEF and Drug Fee to the entrant, or they must submit the fee to the USEF.

SECTION II. BEFORE THE SHOW

The FVD program has procedures for full and partial fee refunds BEFORE scheduling:

1. Full Refund before Entry in the FVD Program 

2. Full Refund after Entry in the FVD Program but before Scheduling 

3. Partial Refund after Entry in the FVD Program but before Scheduling

USEF GR912. Cancellation and Withdrawal of Entries.  
1. A Licensed Competition may adopt its own policy covering the refunding of fees to an exhibitor who cancels 

his entries after the official closing date and prior to the competition’s beginning.  If a Licensed Competition 
does not specify its refund policy in the prize list, refunds are required to be made for entries cancelled 
before the competition begins, upon written request by the exhibitor within 30 days of the competition.

2. A Licensed Competition can set the penalty governing an exhibitor who is permitted to cancel his entries or 
withdraw from the competition.  Such penalty applies only at the competition in question.  See GR1305.

3. Competition management must refund any entry fees, (stabling and processing fees exempted) paid in 
advance by an exhibitor for any horse(s) which is subsequently named to an official US team, participation 
on which will prevent him/her from competing in that competition.

4. After the competition starts, if a rider is unable to compete due to illness or injury, class fees will be 
refunded upon presentation of a doctor’s certificate unless otherwise stated in prize list. Stall fees and 
office fees need not be refunded.

CHAPTER 4 DRUGS AND MEDICATIONS
USEF GR407. Management Procedures.
1.h.  …Within 10 days after a competition, competition management must forward to the Federation a sum 

representing the above fee times the number of horses and/or ponies entered in the nonexempt classes of 
the competition plus the number of horses and/or ponies scratched where the fee is not refunded, …

3.  It is a violation for a Licensee to withhold from the Federation any or all of the drug fees collected in 
accordance with GR407.1, for any purpose, including to defray the expenses incurred providing stalls, 
passes, and other items to the Federation drug testing personnel, as required by GR407.4 and .5.

NOTE: Each show should have a refund policy that is stated in the prize list.  For most shows, a scratch 
BEFORE the closing date is refunded, less the office fee; some shows give a full refund.  Many shows do not 
provide any refunds AFTER the closing date; other shows will provide refunds AFTER the closing.  Whatever 
your policy, ensure it is clearly stated in the prize list.
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Scratches Received BEFORE Scheduling > FULL Refund BEFORE Entry in the FVD Program

FULL REFUND BEFORE ENTRY IN THE FVD PROGRAM:

• If the entry has not been entered into the FVD program and the Prize List provides for a full refund:
o EE Online Entries: Process a full refund through EE.  Destroy or file the entry, if it was printed.
o Mailed Entries: Return the entry, including the check, to the submitter.  Alternately, advise the 

competitor that you will shred the check and recycle the entry packet.

• Since there is no data in the FVD program, you do not need to edit the program.

SECTION II. BEFORE THE SHOW
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Scratches Received BEFORE Scheduling > FULL Refund AFTER Entry in the FVD Program

• Select ❶Main Menu > ❷ Show Office 
> ❸ Entries.

1

2

3

IMPORTANT NOTE: Do not perform this procedure after SCHEDULING YOUR SHOW as it will delete rides on your 
schedule.  For most shows, ride fees are not refunded after closing/scheduling of the show.  See SCRATCHES 
AFTER SCHEDULING AND FILL SCRATCHED RIDES for the procedure to scratch rides after the show is scheduled.

• If the entry has been entered into the FVD program and the Prize List provides for a FULL refund before 
scheduling:
o EE Entries:  Request a full refund via EE.
o Snail Mailed Entries: Return the entry, including the check, to the submitter.  Alternately, advise the 

competitor that you will shred the check and recycle the entry packet.
o All Entries: Since there is data in the FVD program, you must edit the program as follows.

SECTION II. BEFORE THE SHOW

• The ❹ Entry form opens.
• If needed, use the ❺ Switch To… button to 

switch to ❻ Entry (Lookup).
• To open the entry you want to delete, in the ❼

Entry (Lookup) box, type in the entry number 
and press the Enter key.

• Click on the ❽ Delete Entry button.  
• This removes the entry and all associated data, 

including classes and fees paid under all 
categories.

• Click ❾ Close to return to the Main Menu.

4

56
7

98

FULL REFUND AFTER ENTRY IN THE FVD PROGRAM:
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SECTION II. BEFORE THE SHOW

216

Scratches Received BEFORE Scheduling > PARTIAL Refund AFTER Entry in the FVD Program >
Delete Rides

• A ⓫ Fox Village Dressage form opens to verify 
that you wish to delete the entry [ride].  

• Click ⓬ Yes. 

• Repeat steps ❾-⓬ for each of the entry’s 
class/rides that must be removed.

IMPORTANT NOTE: Do not perform this procedure after SCHEDULING YOUR SHOW as it will delete rides on your 
schedule.  For most shows, ride fees are not refunded after closing/scheduling of the show.  See SCRATCHES 
AFTER SCHEDULING AND FILL SCRATCHED RIDES for the procedure to scratch rides after the show is scheduled.

• Select ❶Main Menu > ❷ Show Office >        
❸ Entries.

• The ❹ Entry form opens.
• If needed, use the ❺ Switch To… button to 

switch to ❻ Entry (Lookup).
• In the ❼ Entry (Lookup) box, type in the entry 

number. 
• Select the ❽ Class Entries tab.
• To select a class/ride to be deleted, click the ❾

box/arrow to the left of the class #.  The box 
turns black. 

• Click the ❿ Delete Class Entry button to delete 
the ride from that class.

PARTIAL REFUND AFTER ENTRY IN THE FVD PROGRAM > DELETE RIDES:

• If the entry has been entered into the 
FVD program and the Prize List provides 
for a PARTIAL refund before scheduling:
o EE Entries:  Request a partial refund via 

EE.
o Snail Mailed Entries: Return or recycle 

the entry.  Do a partial refund to the 
submitter.  Shred or return the original 
check.

o All Entries: Since there is data in the 
FVD program, you must edit the 
program as follows.
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Scratches Received BEFORE Scheduling > PARTIAL Refund AFTER Entry in the FVD Program >
Delete Stabling

• The ❹ Entry form opens.
• If needed, use the ❺ Switch To… button to 

switch to ❻ Entry (Lookup).
• In the ❼ Entry (Lookup) box, type in the entry 

number. 
• Select the ❽ Stabling Fees tab. 
• For each stabling item that will be refunded, click 

on the ❾ white box/arrow to the left of the 
Description.  The white box will turn black.

• Click the ❿ Delete Fee button.

• A ⓫ Fox Village Dressage form opens to verify 
that you wish to delete the fee.  

• Click ⓬ Yes. 

• Repeat steps ❾-⓬ for any other stabling fees 
you want to refund.

SECTION II. BEFORE THE SHOW

• If your Prize List states that stabling fees 
will be refunded, perform this step.

• Select ❶Main Menu > ❷ Show Office 
> ❸ Entries.

PARTIAL REFUND AFTER ENTRY IN THE FVD PROGRAM > DELETE STABLING:
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SECTION II. BEFORE THE SHOW
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Scratches Received BEFORE Scheduling > PARTIAL Refund AFTER Entry in the FVD Program >
Delete Other Fees

• A ⓫ Fox Village Dressage warning form opens 
to verify that you wish to delete the fee.  

• Click ⓬ Yes. 

• Repeat steps ❾-⓬ for any other fees you want 
to refund.

• The ❹ Entry form opens.
• If needed, use the ❺ Switch To… button to 

switch to ❻ Entry (Lookup).
• In the ❼ Entry (Lookup) box, type in the entry 

number. 
• Next select the ❽ Other Fees / Payments tab. 
• Select the white box to the left of the ❾

Description.  A black arrow appears.
• Click on the ❿ Delete Fee button.

• If your Prize List states that other fees will 
be refunded, perform this step, deleting 
only those fees that are to be refunded.

• For example, the USEF Drug/Horse fee 
may need to be refunded.  (If this fee is 
not refunded for cancellations/scratches, 
it must be paid to USEF.)

• Select ❶Main Menu > ❷ Show Office 
>        ❸ Entries.

PARTIAL REFUND AFTER ENTRY IN THE FVD PROGRAM > DELETE OTHER FEES:
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Scratches Received BEFORE Scheduling > PARTIAL Refund AFTER Entry in the FVD Program >
Determine Refund Amount

• To check this amount due:

• Send the refund to the entrant via EE (EE entries 
only), check credit card refund, PayPal refund, 
etc.

• To ensure accurate accounting in FVD, under ❷
Payments/Credits, enter the ❸ (Refund).  Enter 
the refund value as a negative number (-188.00 in 
this example).

• The ❹ Balance on this entry is now ❺ 0.

• If you wish to print an invoice for the entrant, 
click the ❻ Print Invoice button.

• If you send a FVD Entry Confirmation to the 
entrant, the refund amount and the balance 
amount will be provided.

SECTION II. BEFORE THE SHOW

In this Example

Original Payment(s) $218

Non-refunded Fee (Office Fee) = $30 $30

Balance = Deleted Fees = Refund Due -$188

The following example is for a show that refunded all fees except the $30 office fee, as in the previous steps.

PARTIAL REFUND AFTER ENTRY IN THE FVD PROGRAM > DETERMINE REFUND AMOUNT:

• In this example, after deleting the rides, stabling 
fees, and other fees, FVD shows a ❶ Balance of 
$188.  This is the amount due to the entrant.

1

2

3

5
4 6
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SECTION II. BEFORE THE SHOW
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Close Show in EE
Close Show is used to close your show so 
no more entries will be accepted online 
through EE.  Also, after you close your show, 
you can no longer process refunds through 
EE unless you contact them for special 
arrangements.  

• You used PUBLISH A SHOW WITH EE for 
the initial show set up, including the 
initial show close dates and times.

• If you want your show to close on the 
initial date and time, you do not need to 
do anything as the show will 
automatically close.

• Use Close Show in EE if your show fills 
and needs to be closed early, or if it does 
not fill and you need to extend the 
closing date.

• Click ❶ Equestrian Entries Integrated 
Online Tools > ❷Close Show button.  

SECTION II. BEFORE THE SHOW

• The ❸ Publish Show form opens.
• Edit the ❹ Entries Close Date, Time and 

Time Zone to reflect the new show close 
date and time.

• If needed, edit the ❺ Late Entries Close 
Date, Time and Time Zone.

1
2

4

5

MM/DD/YYYY

MM/DD/YYYY

MM/DD/YYYY

MM/DD/YYYY
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SECTION II. BEFORE THE SHOW
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[The show may operate 16 hours in a day, including breaks, but additional judges are required.] 

223

Scheduling > Scheduling Considerations > Introduction, Judge Hours

SECTION II. BEFORE THE SHOW

INTERPRETATION:
• A judge may officiate (judge) 8 hours in a day, exclusive of breaks and lunch.  You may ask a judge if s/he 

will continue beyond their 8 hours of officiating.  Some will agree, some will agree but will charge punitive 
overtime fees, and some will not agree.  Get this in writing (an email is fine).  Check with the judges early 
enough so you can hire a part-time judge, if necessary.

• Judges must have a break or lunch every 2 hours.
• Breaks should be 10 to 15 minutes.  [15 minutes is expected unless additional breaks are provided to 

optimize the schedule]
• Lunch should be 45 to 60 minutes. [60 minutes is expected]

BLOCK YOUR RINGS TO ACCOMMODATE THESE RULES.

NOTE: Perform scheduling AFTER the closing date and AFTER
all your entries have been entered in the FVD program. 

• Scheduling is the process by which you determine the sequence of classes in each ring (blocking the 
rings) and the sequence of rides within each class.  Specific USEF rules must be followed.  The person 
scheduling the show often needs to be creative to fit all riders’ rides in a manner that will follow the 
rules and create an organized and pleasant show.  

• Some of the scheduling steps cannot be accomplished by a computer – they require human input.  
Scheduling is therefore more of an art than a science.

• For USEF/USDF shows, the tests in each class musts be run as a contiguous block.  For example, all the 
Class 101 rides must be scheduled together, all the Class 113 rides must be scheduled together, etc.  FVD 
helps you schedule in this manner.

• The only exception to contiguous rides in a class is for a rider that has multiple rides on different horses 
or a rider in two classes that conflict with each other (avoid this if you can).  For example, a class may 
have four rides and two of the rides involve one rider on two horses.  To provide adequate time between 
the rides (USEF rule is 50 minutes between one rider’s start time for two rides on different horses), one 
ride will have to be scheduled out of sequence.  This will be explained in Conflict Resolution and 
Temporary Rider Conflict (RC) Class.

USEF Rule DR126.2.d.
d. Judges and Technical Delegates. 

(1) No judge shall be required to officiate longer than 8 hours in one day, unless the judge has agreed in 
writing, and cannot be required to be on the competition grounds longer than 10 hours.
(2) Judges must be given at least a 45-minute lunch break and at least a 10 minute break every 2 hours.

SCHEDULING CONSIDERATIONS > INTRODUCTION:

SCHEDULING CONSIDERATIONS > JUDGE HOURS:
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Scheduling > Scheduling Considerations > Which Judges Can Judge Which Classes?

INTERPRETATION – Which Judges Can Judge Which Classes:
• Senior (S) Judges: Can judge all dressage tests at USEF/USDF shows.
• Registered (R) Judges: Can judge Intro, Training, Second, Third and Fourth Levels.  Cannot judge FEI Dressage 

Tests for 5- and 6-year-old horses.  May judge FEI Junior Tests, FEI Pony Tests, FEI Children’s Tests, FEI Para-
Equestrian Dressage Tests, FEI and USEF Dressage Tests for 4 year old  horses, and USEF and FEI Eventing 
Dressage Tests at all levels.  

• Recorded (r) Judges:  Can judge Intro, Training, First, and Second level classes; cannot judge Third Level and 
above.  Cannot judge FEI or USEF Dressage Tests for 4 and 5year old horses or in FEI Pony Tests. May judge FEI 
Para-Equestrian Dressage Tests equivalent to Second Level or below.  May officiate in Eventing Competitions at 
the Intermediate Level or below. 

• Learner (L) “Judges":  Cannot judge in USEF licensed / USDF recognized shows but may accompany a judge if 
formally requested and approved.

SECTION II. BEFORE THE SHOW

BLOCK YOUR RINGS TO ACCOMMODATE THESE RULES

USEF General Rules, Chapter 10 – Licensed Officials, Sub-Chapter 10-C – Classification – Judges
GR1007 General.
Licensed judges are classified as Senior, Registered, Recorded, Special, Guest and Apprentice.  A judge will not be 
licensed in more than 12 divisions.
GR1008 Senior Judge. [S]
Senior judge classification (S) applies to Dressage … .  Senior Dressage judges may officiate in all Federation and FEI 
Level Dressage classes at Federation Licensed Competitions. …
GR1009 Registered Judge. [R]
1. A Registered judge (‘R’) may officiate alone at any competition in the divisions in which s/he is Registered.
2. Registered Dressage judges may officiate in classes at Fourth Level and below except for FEI Dressage Tests for 

5 and 6-year-old horses. Registered Dressage judges may officiate in FEI Junior Tests, FEI Pony Tests, FEI 
Childrens Tests, FEI Para-Equestrian Dressage Tests, FEI and USEF Dressage Tests for 4-yearold horses, and USEF 
and FEI Eventing Dressage Tests at all levels. …

GR1010 Recorded Judge. [r]
A Recorded Dressage judge may officiate at Second Level and below and may not officiate at the Third Level and 
above. Recorded Dressage judges may not officiate in FEI or USEF Dressage Tests for 4 and 5-year-old horses, FEI 
Childrens Tests, or in FEI Pony Tests, or FEI Para-Equestrian tests.  Recorded Dressage judges may officiate in 
Eventing equivalent to Second Level or below. Recorded Dressage judges may officiate in Eventing Competitions at 
the Intermediate Level or below. 
GR1006 Apprentice [Learner Judge. [L]]
An Apprentice shall be a Federation Competing Member who is at least 21 years of age. Information on 
apprenticing procedure for each license is located on the Federation website. An Apprentice shall request approval 
prior to apprenticing from the Licensed Competition first followed by approval by the licensed official(s) with whom 
s/he will be apprenticing. [See the rule for more information.]

S
All Levels

R
Tr, 1st, 2nd, 

3rd, 4th

r
Tr, 1st, 2nd

L
Accompany 
Other Judge
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• Judge Locations: A judge may be moved to another ring if necessary, but it is smarter to keep them in a 
ring for 2-3 classes.  If you need to move a judge, allocate time in the schedule.

• Class Variety:  If possible, give each judge a variety of class levels – this makes their day more interesting.

• Judge Variety: If possible, schedule classes of the same level with different judges so riders can have a 
variety of judges (and more easily qualify for regional championships).  For example, if you have a two-
day show, schedule Test 3 with judge 1 on day 1 and with judge 2 on day 2.

• Class Day: The show prize list specifies which classes will be held on which days.  If at all possible, do not 
change the day on which a class is held.  If management changes the day a class is held and a rider is 
consequently unable to ride in the class, management is required to refund the entrant’s fees.  If the day 
on which a class is held is changed, in the FVD program you must go back to class setup and enter the 
change.  If the show was already scheduled, you need to revise your secheduling.

• Upper Level Classes:  If needed, schedule the upper level classes in the morning, which will usually have 
better weather conditions for these strenuous tests.

• Musical Freestyles: Schedule all musical freestyles together, preferably in an indoor arena.  This makes it 
easier to manage the sound system and makes it less likely the music will bother other rides.  Ensure the 
music does not hinder any other rings (this may require closing one arena while the MFS are run).  Also 
ensure the schedule allows time for equipment set-up and testing.

• Timing/Sequence of Tests of the Same Level: Riders often ride two sequential tests of the same level.  
Therefore, if possible, sequence the tests to allow these rides without a long span of time between rides.  
For example, don’t schedule First Level Test 1 early in the morning and First Level Test 2 late in the 
afternoon.  If possible, schedule First Level 1 before First Level 2 so riders can ride a progression of tests.

• Warm-Up: Consider the levels that will be in the warm-up at the same time.  Lower level horses/riders 
can be intimidated by upper level horses/riders and upper level riders may be annoyed by lower level 
riders.

• Small Arena: Para-equestrian Grade I and II tests must be in a small arena.  Introductory Level A, B and C 
tests should be in a small arena.  All Training Level tests can be in a small arena but avoid a small arena 
for Training Level Test 3.  Schedule small arena classes together and time them for minimal disruption to 
other arenas during rearrangement of the arena.  Provide time in the schedule for ring work.

• Harrow Break: If you have one or more adjacent show rings, do not schedule a harrow break in one 
arena while the other arena has rides – schedule the rings so harrowing can be done in both rings during 
a similarly scheduled lunch.

225

Scheduling > Scheduling Considerations > Other Considerations

SECTION II. BEFORE THE SHOW

SCHEDULING CONSIDERATIONS > OTHER CONSIDERATIONS:
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1

2

3

4

• Scheduling your show is less difficult IF.... you have been very accurate in your entries and IF you have set 
the class times properly. 

• If something does not look right, it is probably a data entry error:
o This is usually an entrant or secretary error such as using an incorrect class number, etc. 
o Show entry errors are usually mis-entries in the class entry section, such as selecting the wrong test in 

the test column.  In these cases, the “test” doesn’t match the class specifications or the rider’s 
intention in Test-Of-Choice classes. 

• You must fix these problems, or you will have a very bad show day.

STEP 1. REVIEW PRE-SCHEDULE (BY CLASS) 
> OPEN THE REPORT:

• Select ❶Main Menu > ❷ Reports > 
❸ Pre-Show > ❹ Pre-Schedule Report 
(by Class).
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Scheduling > Introduction, Step 1. Pre-Schedule (by Class) > Open the Report

• Scheduling involves the following steps, in sequence:
1. Pre-schedule (by Class)
2. Split Classes (if Needed)
3. Block the Classes in the Show
4. Enter Rings and Assign Rings to Each Class
5. Enter Judges and Assign Judge(s) to Each Class
6. Assign Ride Times
7. Add Breaks/Lunch
8. Conflict Resolution
9. Check Judge Hours
10. Review Day Sheets Report

SECTION II. BEFORE THE SHOW

NOTE: Show days must have been assigned 
to each class, as described in Classes, before 
you can use this report.

INTRODUCTION:
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• The ❶ Pre-Schedule (by Class) report opens. 
o This report shows the ❷ day, ❸ classes, ❹ total [number of] rides in a class, and ❺ class 

duration.   
o The last page has the ❻ Total Rides and the ❼ Total hours and minutes for the day.
o Look at the number of rides in each class.  If a non-championship class has more than 25 rides, the 

class must be split.  This must be done before you block the show.  See Reports > Pre-Show > Class 
Ride Limit Report for a report of classes with more than 25 rides.  See Split Classes for the procedure 
to split classes.
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Scheduling > Step 1. Pre-Schedule (by Class) > View the Report

SECTION II. BEFORE THE SHOW

STEP 1. REVIEW PRINT PRE-SCHEDULE (BY CLASS) > VIEW THE REPORT:

6
7

Last Page

3

4 5

1
2
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• If desired, print this report so you have it for 
continuous reference as you prepare to block 
the show.  

• To print the report, click ❶ Print.

• Click ❺ Close Print Preview to close the form 
and return to the Main Menu.
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Scheduling > Step 1. Pre-Schedule (by Class) > Print the Report

SECTION II. BEFORE THE SHOW

• The ❷ Print report form opens.
• Click the ❸ All radial button.
• Click ❹ OK.
• All the pages of the report will print.

STEP 1. PRE-SCHEDULE (BY CLASS) > PRINT THE REPORT:

2

3

4

1 5

NOTE:  The appearance of this form is 
dependent on your printer type. 
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STEP 2. SPLIT CLASSES (IF NEEDED) > HELPFUL HINTS
• Except for the 25 rides rule, you can split a class before or after the class is held.  If you split after the class is 

run, you have more scheduling flexibility in the case of scratches, etc.
• You can combine or split by Rider Status; for example, you can have an Open class and a separate AA/JR/YR 

class at the same level.  If you have enough riders, you can have separate Open (= Professional & USEF NM), 
AA, and JR/YR classes at the same level.  Etc.

• If you plan to split by Rider Status (Open, AA, JR/YR), you must have previously entered the Rider Status 
when entering rider information.  See Rider.

• Example:  
o Class 103.0 is too big – there are 15 Open, 10 AA, and 10 JR/YR riders, for a total of 35 riders. 
o You decide to have a class for Open riders (15 riders) and a separate class for AA/JR/YR riders (20 riders).
o Your Class 103.0 will remain as the Open class; the new Class 103.3 will be the AA/JR/YR class.

• To help you track classes, you may want to keep your Open classes as the original number (102.0,  etc.) and 
number your AA/JR/YR, AA, JR/YR, etc. classes as your derivative number classes (102.1, 102.2, etc.).  See 
RECOMMENDED DRESSAGE CLASS NUMBERS for recommendations on numbering classes.

• Some shows prefer smaller classes so more riders can have the pleasure of taking a ribbon home.  For 
example, Class 103.0 Open has 20 riders – 7 Open, 6 AA, and 7 JR/YR.   You are not required by USEF to split 
this class.  But you can split the class to Class 103.0 Open (7 riders), Class 103.1 AA (6 riders), and Class 103.2 
JYR (7 riders).  With this split, most of the riders will take home a ribbon as a reward for their hard work.  
They will also be very happy with show management!

INTERPRETATION:
• Except for championship classes, classes with more than 25 horse/rider pairs must be split (divided into two or 

more classes).  
• Championship classes are not split, even if they are very large.
• Competitions are encouraged to split classes into Open (open to all riders; Professionals and USEF non-members 

must ride in open classes), Adult Amateur, and Junior/Young Rider classes.  
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Scheduling > Step 2. Split Classes (if Needed) > USEF Rules, Helpful Hints

SECTION II. BEFORE THE SHOW

USEF DR126 Requirements for Dressage Competition Management.
2. The following requirements apply to all Levels 1-5 of Dressage Competitions, except where noted. Specific 

requirements for specific levels of competitions are listed under .2, below. 
a. Competition Levels, Divisions and Classes.

1) The competition Level and all classes must be listed in the prize list.
2) When permitted by the rules or special criteria, classes may be divided into separate divisions or 

sections based on qualifications, age or other eligibility of horses or riders.
3) Divisions or sections of a class are considered to be a separate “class” only if listed as such in the prize 

list. Divisions or sections of a class may be held in different rings and judged by different judges. When 
divisions or sections are held under different conditions (i.e, different ring or judges), separate awards 
must be given.

4) Where more than 25 entries are accepted for a particular class the class must be divided into separate 
divisions for awards purposes. USEF/USDF championship classes and USEF High Performance 
Championships, qualifying and selection trials, and observation classes cannot be split.

5) When entries warrant competitions are encouraged to split classes into separate divisions, and to 
provide separate awards, for Open riders, Adult Amateurs and Junior/ Young Riders. Horses may be 
ridden only once in any class, including separate divisions or sections of the same class. See DR119.1.

• Splitting Classes is the process of splitting (dividing) a large class into two or more smaller classes.  

NOTE: See Reports > Pre-Show > Class Ride Limit Report for a report of classes with > 25 rides. 

STEP 2. SPLIT CLASSES (IF NEEDED) > USEF RULES
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• Click the ❻ View 
Class Copy button.

• The ❼ Class Copy 
form opens.

• Your original class 
number, 103.0 in this 
example, is 
automatically entered 
in the ❽ Original 
Class Number box.

• Type your new class 
number, 103.3 in this 
example, in the ❾
New Class Number 
box.

• Click on ❿ OK.
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Scheduling > Step 2. Split Classes (if Needed) > Open the Class, Copy the Class

SECTION II. BEFORE THE SHOW

• The ❹ Class form opens.
• Using the ❺ Class (Lookup) drop-down arrow or type-in box, select the class you want to split (in this 

example, Class 103.0). 

• Select ❶Main Menu > ❷ Show Office
> ❸ Classes.  

1

2

3

NOTE 1:  Class Numbers may not contain letters but may contain a decimal to one place (for example, 103.3 but 
not 103 AJY and not 103.31).  Class Text may contain letters (for example 103 AJY).
NOTE 2:  It will be easier for you if you use a standard numbering method.  Although NOT required, the following is 
suggested:
• Open Class: 103.0 (0 = Open = all rider statuses may ride in the class; PROs and USEF non-members must be in 

open classes)
• AA Class: 103.1 (1 = one status of rider = AA)
• JR/YR Class: 103.2 (2 = 2 statuses of rider = JR and YR)
• AA/JR/YR Class: 103.3 (3 = 3 statuses of rider = AA, JR, and YR)

STEP 2. SPLIT CLASSES > OPEN THE CLASS:

STEP 2. SPLIT CLASSES > COPY THE CLASS:

4

5 6

7

8

9

10
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• Edit ❹ Class Name to reflect 
the difference between the 
classes.   In this example, for 
this class, the class name 
remains the same.

• Edit ❺ USEF Code.  
Unchanged for this class.

• Edit ❻ Qualify. Unchanged 
for this class.

• Edit ❼ Division. Unchanged 
for this class.

• Edit any other data that may 
be needed.
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Scheduling > Step 2. Split Classes (if Needed) > Edit Original Class, Edit New Class

SECTION II. BEFORE THE SHOW

STEP 2. SPLIT CLASSES > EDIT ORIGINAL CLASS:

1

2 3

4

5 6

7

Step 2. SPLIT CLASSES > EDIT NEW CLASS:

• Edit ⓫ Class Name to reflect 
the difference between the 
classes.   In this case, the 
class name was changed from 
Open to AJY.

• Edit ⓬ USEF Code.  In this 
case, it is unchanged.

• Edit ⓭ Qualify. In this case, 
it is unchanged.

• Edit ⓮ Division. It is 
changed from Open to AA & 
JR/YR for this class.

• Edit any other data that may 
be needed.

• Click ⓯ Close to save the 
changes.

• Using the ❶ Class (Lookup) box or drop-down arrow, open the ❷ (Original) Class Number (in this 
example, 103.0).

• Edit ❸ Text to reflect the difference between the classes.  In this case for this class, the text remains 
the same.

• Using the ❽ Class (Lookup) box or drop-down arrow, open the ❾ (New) Class Number (in this example, 
103.3).

• Edit ❿ Text to reflect the difference between the classes.  In this case, the text is now 103.3 as this class will 
have Adult Amateur (AA) and Junior/Young Rider (JYR) riders = AJY. It could also be 103 AJY.

8

9 10

11

12 13

14

15
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• If needed, select ❶ Main Menu > ❷
Show Office > ❸ Classes 
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Scheduling > Step 2. Split Classes (if Needed) > Open Class Splitter

SECTION II. BEFORE THE SHOW

• The ❹ Class
form opens.

• Using the ❺
Class (Lookup) 
drop-down 
arrow, select 
the original 
class that you 
are splitting.  In 
this example, it 
is ❻ 103.0.

• Click the ❼
Class Splitter 
button.

1

2

3

4

5

6

7

STEP 2. SPLIT CLASSES > OPEN CLASS SPLITTER:
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• The ❶ Class Splitter form opens.
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Scheduling > Step 2. Split Classes (if Needed) > Open Both Classes in Class Splitter

• If the original class was not previously selected, 
using the left ❷ Class (Lookup) drop-down 
arrow or type-in box, select the ❸ original class 
text (in this example, 103.0 Open).

• Using the right ❹ Class (Lookup) drop-
down arrow or type-in box, select the ❺
new class (in this example, 103.3 AJY).

• You can now view entries in both classes in the 
❻ Class Splitter form.  [You will see entries in 
class 103.3 when you move entries to it.  See 
below.]

SECTION II. BEFORE THE SHOW

STEP 2. SPLIT CLASSES > OPEN BOTH CLASSES IN 
CLASS SPLITTER:

1

3

2

5

4

6
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• This ❸ moves the selected horse/rider to the 
new class.

• If you accidentally move the incorrect rider to the 
new class, use the ❹ left arrow to move them 
back to the Open class.
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Scheduling > Step 2. Split Classes (if Needed) > Move Riders to New Class

• To move an AA rider from 103.0 Open to 103.3 
AJY, click on the ❶ empty white box to the left 
of the first AA rider’s name (the white box turns 
black with a white arrow) and click the ❷ right 
arrow.

• Repeat for all other horse/rider pairs to be 
moved to the new class.

• You have now split the classes with only ❺
Open riders in Class 103.0 and ❻ AJY riders in 
Class 103.3.

• Click ❼ Close to return to the Class form.

• Close the Class form.

SECTION II. BEFORE THE SHOW

• Congratulations!  You have split one class into two classes.  Repeat for any other class(es) you want to 
split.

STEP 2. SPLIT CLASSES > MOVE RIDERS TO NEW CLASS:

1

2

3

4

5

6

7
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• Draw ❶ vertical lines every 2 inches to make 
one column per ring per day. 

• Draw ❷ horizontal lines every 2 inches to make 
rows for each hour of the show day, plus 1 hour 
before and 1 hour after.   This provides ½ inch for 
each 15 minutes.

• Add10-15-minute ❸ breaks every two show 
hours and a minimum of 45 minutes for ❹
lunch. This will remind you to include breaks and 
lunch.

STEP 3. BLOCK CLASSES IN THE SHOW > BROWN PAPER METHOD > MATERIALS > PREPARE PAPER
Now that your entries are finished, with all the riders/horses entered in their classes, you need to “block” 
the show.  Blocking the show refers to arranging each class (each block of rides) into a show ring and time 
frame that abides by USEF rules and distributes the classes in a manner best suited for the judges, the 
riders/horses, and the show in general.  After you block the show, you schedule the ride times, which 
determines your show schedule.

The computer program can only do so much to help you block your show.  Unfortunately, a little bit of 
human brain power is necessary for this task.  Three blocking methods are described – the Brown Paper 
Method, the Scheduling Sheets Method, and the PowerPoint Method (or other graphics program method). 

Ring 
1

Ring 
2

Ring 
3

Ring 
4

Ring 
5

7:00

8:00

9:00

10:00

11:00

12:00

1:00

2:00

3:00

4:00

5:00

6:00

• Large piece of brown wrapping paper or a 
similar product.  Alternately, a magnetic 
bulletin board and some magnetic strips 
that can be cut and taped to the back of 
paper (to hold them in place).

• Construction paper in various colors, 
colored dots. 
o Chose a paper color for each type of 

class (for example, yellow for JR classes, 
green for YR classes, blue for AA classes, 
and pink for Open classes), 
or

o Choose a paper color for each level, 
or

o Choose a paper color for each level with 
dots of different colors for JR/YR, AA, 
and Open classes, 
or

o Chose a paper color for each judge type, 
or

o Any other method you may choose.

2”

LUNCH

BREAK

BREAK

2”

1 1 1 1 1

2

2

2

2

2

2

2

2

2

2
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Scheduling > Step 3. Block Classes in the Show > Brown Paper Method >
Materials, Prepare Paper 

Day 1

3

3

4

STEP 3. BLOCK CLASSES IN THE SHOW > BROWN PAPER METHOD > MATERIALS:

SECTION II. BEFORE THE SHOW

2
START

END

STEP 3. BLOCK CLASSES IN THE SHOW > BROWN 
PAPER METHOD > PREPARE PAPER:
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Scheduling > Step 3. Block Classes in the Show > Brown Paper Method > Block the Classes 

• Select the construction paper colored for the first class and cut it into two-inch strips. 
• Using the printed Pre-Schedule Report (by Test) as a guide, check how long the first class is and cut the 

strip to match. For example:
o A 2-hour, 15-minute class would be a 2 1/4" long strip.
o A 42-minute class would be about 3/4 inch.

• Label the strip and set it into place on the brown paper.  To balance days, classes, and judges, you always 
have to shift paper strips, which makes something else shift, etc.   Therefore, using a “movable” method 
of adhering the paper strips on the brown paper is advisable:
o Scotch tape is not the best choice.
o Thumbtacks on cork. 
o Magnetic strips (the most mobile). 

• Ensuring you follow the rules and considerations in Scheduling Considerations, repeat for each class.
• When the classes do not fit, you must shift around until you get an appropriate schedule. 
• Continue until you have each class “blocked.”
• Now that you have it arranged, FASTEN IT DOWN SO IT WILL NOT SHIFT!

Ring 
1

Ring 
2

Ring 
3

Ring 
4

Ring 
5

7:00

8:00

9:00

10:00

11:00

12:00

1:00

2:00

3:00

4:00

5:00

6:00

NOTE: Judges are not assigned until the classes are 
set; however, since some classes will require an S 
judge; some classes can have an S or an R judge; and 
some class can have an S, R or r judge; you may want 
to designate an S ring(s) and put FEI classes in that 
ring(s); designate an R ring(s) and put TR, 1st, 2nd, 3rd, 
and 4th classes in that ring(s); and designate an r 
ring(s) and put TR, 1st, and 2nd level classes in that 
ring(s).  This ensures you will not have to move your 
judges around too much, if at all.  This will need to be 
balanced as you block the classes, so judges get 
variety in levels and riders get variety in judges.

SECTION II. BEFORE THE SHOW

STEP 3. BLOCK CLASSES IN THE SHOW > BROWN PAPER METHOD > BLOCK THE CLASSES:
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Scheduling > Step 3. Block Classes in the Show > Brown Paper Method > 
Show Scheduling Sheet

• Print a copy of the Show Scheduling Sheet.  
• As you block the show, you will write in the class numbers and judge(s), breaks, and lunch for each ring, 

in sequence.  You will use this sheet as a guide to assign the ride times and schedule the rings.

SECTION II. BEFORE THE SHOW

Total time for each column should be no more than 8 hours of judging (exclusive of breaks and lunch), and 
no more than 10 hours on the show grounds (including breaks and lunch).  There should be a 10-15-minute 
break or 45-60-minute lunch at least every 2 hours.

STEP 3. BLOCK CLASSES IN THE SHOW > BROWN PAPER METHOD > SHOW SCHEDULING SHEET:

Show Scheduling Sheet
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Scheduling > Step 3. Block Classes in the Show > Scheduling Sheets Method >
Prepare Class Strips and Scheduling Sheets

• The Scheduling Sheets are located in the Appendices. There are six sheets as follows:
o Class Scheduling Sheet > 2-152 Minutes.
o Class Scheduling Sheet > 154-304 Minutes.
o Class Scheduling Sheet > 306-456 Minutes.
o Lunch Scheduling Sheet > 45- and 60-Minutes.
o Break Scheduling Sheet > 15- and 10-Minute.
o Show Scheduling Sheet.

• Determine the ❷ Total minutes for Class for the first class.  In the above example, the class has 105
minutes.
o If the class has ≤ 152 minutes, print Class Scheduling Sheet > 2-152 Minutes.
o If the class has > 152 minutes but ≤ 304 minutes, also print Class Scheduling Sheet > 154-304 Minutes.
o Etc.

• Cut the Scheduling Sheets to correspond to the number of minutes for the class.  If more than one sheet 
is needed, tape the sheets together.

• Tape the Pre-Schedule (by Test) Report Class Strip to the corresponding prepared Scheduling Sheet(s), 
to create a Strip/Sheet combination (see diagram on next page).

• Repeat for all classes for the day so each class has a Strip/Sheet combination.

• Print two copies of the Pre-Schedule (by Class) report – one will be used as a reference and the other will 
be used for scheduling blocks.

• Cut the classes on one Pre-Schedule (by Class) report into horizontal strips corresponding to each class.  
Include the ❶ Total Rides and the ❷ Total Minutes for Class in the strip.  A cut strip will look similar to 
the figure.

• If desired, using different colored ❸ highlighters, highlight each level with a different color, and/or 
highlight each division (Open, AA, JR/YR) with a different color.

• If desired, write the ❹ judge type(s) (S, R, r) allowed for the class.

STEP 3. BLOCK CLASSES IN THE SHOW > SCHEDULING SHEETS METHOD > PREPARE CLASS STRIPS:

SECTION II. BEFORE THE SHOW

STEP 3. BLOCK THE SHOW > SCHEDULING SHEETS METHOD > SCHEDULING SHEETS:

3

S, R, r Traditional level colors are:
Intro: White
Training: Pink
First: Blue
Second: Yellow
Third: Lilac
Fourth: Green
FEI: Off-white

1 2

Pre-
Schedule 
(by Class) 
Report 
Class Strip 

4
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Scheduling > Step 3. Block Classes in the Show > Scheduling Sheets Method > 
Diagram, Blocking Classes 

• Using a large table or floor, arrange the prepared Strips/Sheets
by ring.  If you have two rings, you will have two columns.  If 
you have three rings, you will have three columns.  Etc.

• Print Lunch Scheduling Sheet > 45- and 60-Minutes and Break 
Scheduling Sheet > 15- and 10-Minute.

• Cut out the time blocks for lunch and breaks and include in 
your blocking process to ensure you have appropriate lunch 
and break time blocks.

• To balance time allowed, classes, breaks, lunch, and 
appropriate judges, you always have to shift Strips/Sheets, 
which makes something else shift, etc. 

• When the classes do not fit, you have to move the 
Strips/Sheets around until you get an acceptable mix of classes, 
breaks, and lunches in the rings. 

• Continue until you have each class into the “block.”
• Now that you have it arranged, TAPE IT DOWN SO IT WILL NOT 

SHIFT!

SECTION II. BEFORE THE SHOW

STEP 3. BLOCK CLASSES IN THE SHOW > SCHEDULING SHEETS METHOD > DIAGRAM:

STEP 3. BLOCK THE SHOW > SCHEDULING SHEETS METHOD > BLOCKING CLASSES:

SCHEDULING SHEETS FOR A 2-RING SHOW

Strip/Sheet for First Class

1
0

5
 m

in

Class Scheduling Sheet > 2-152 Minutes 
Cut to 105 Minutes

Pre-Schedule Report (by 
Class) Class Strip taped to 
the Show Scheduling Sheet
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Scheduling > Step 3. Block Classes in the Show > Scheduling Sheets Method > 
Show Scheduling Sheet

• Print a copy of the Show Scheduling Sheet.  
• Using the Strips/Sheets, write in the judge(s), class numbers, breaks and lunch for each ring, in sequence.  

You will use this sheet as a guide to assign the ride times and schedule the rings.

SECTION II. BEFORE THE SHOW

Total time for each column should be no more than 8 hours of judging (exclusive of breaks and lunch), and 
no more than 10 hours on the show grounds (including breaks and lunch).  There should be a 10-15-minute 
break or 45-60-minute lunch at least every 2 hours.

STEP 3. BLOCK CLASSES IN THE SHOW > SCHEDULING SHEETS METHOD > SHOW SCHEDULING SHEET:

Show Scheduling Sheet
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• Select ❶Main Menu > ❷ Show Office 
> ❸ Classes. 
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Scheduling > Step 4. Rings > Enter Rings in FVD

SECTION II. BEFORE THE SHOW

NOTE:  If your rings have formal names or sponsors that you want to use, it is recommended that you also use ring 
numbers.  This will make it much easier for the competitors to determine/locate their rings on the show grounds. 

Now that you have blocked your show, you know the rings for each class.  You need to add this information 
to the classes.

3

1

2

• The ❹ Class form opens.
• Click the ❺ Edit Rings button.
• The ❻ Ring form opens.
• Enter the ❼ names for each ring (example: 1, Indoor, 1 Indoor, etc.).   Do not enter Ring 1, etc. as the 

word Ring is already on the reports.
• Click ❽ Close.

STEP 4. RINGS > ENTER RINGS IN FVD

5

4

6

7

8
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Scheduling > Step 4. Rings > Assign Rings to Each Class

• You are returned to the ❶ Class form.
• Use the ❷ Class (Lookup) drop-down arrow or type-in box, select the class for which you want to 

assign a ring.
• Using the ❸ Ring box drop-down arrow, select the ❹ ring number and/or name for the class, as 

determined during the Blocking the Show procedures.

• The Ring # is now entered in the ❺ Ring box.
• To schedule the ring for the next class, use the ❷ Class (Lookup) drop-down arrow, or click the ❻ Next 

Class button, or type the class number in the ❼ Class (Lookup) box, then assign the ring.
• Continue assigning the rings until all classes are assigned a ring.
• Click ❽ Close to return to the Main Menu.

SECTION II. BEFORE THE SHOW

STEP 4. RINGS > ASSIGN RINGS TO EACH CLASS:

5

6

7

8

1

2

3

4
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Scheduling > Step 5. Judges > Enter Judges’ Names

SECTION II. BEFORE THE SHOW

• The ❹ Class form opens.
• Click on the ❺ Edit Judges button.
• The ❻ Judge form opens.
• Enter the judge, including: 
o ❼ First Name, for example Suzy.
o ❽ Last Name (Rating, State), for example Smith (S,VA).

• To add a judge, click on the ❾ Add Judge button.
• To delete a judge:
o To select the judge, use the ❿ Previous Judge or ⓫ Next Judge, or the ⓬ Judge (Lookup) drop-

down arrow, or type the last name of the judge in the ⓭ Judge (Lookup) box. 
o Then click the ⓮ Delete Judge button. 

• When all judges are added or deleted, click ⓯ Close.

Now that you have blocked your show, you know the judge(s) for each class.  You need to add this 
information to the classes in FVD.

• If needed, select ❶Main Menu > ❷
Show Office > ❸ Classes. 

3

1

2

STEP 5. JUDGES > ENTER JUDGES’ NAMES:

NOTE: It is important to enter a 
judge’s last name as Lname (X,ST) (X = 
S, R, or r; ST = state) as USEF requires 
this information on show reports.

5

4

6

8

9

7

10 11

12
13

14 15
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Scheduling > Step 5. Judges > Assign Judge(s) to Each Class

• You are returned to the ❶ Class form.

• If you need to select the class for which you want to assign a judge, click the ❷ Class (Lookup) down-
arrow  and select the Class # or type in the Class # in the ❸ Class (Lookup) box.

• To select the Judge at C, click the ❹ Judge at C drop-down arrow and click the judge’s name, as 
determined during the Blocking the Show procedures.

• The name is now in the ❺ Judge at C box.
• If applicable, repeat for judges at E, H, M, and B.

• To move to the next class, click the ❻ Next Class button or type in the Class # in the ❸ Class (Lookup) 
box

• Enter the judge(s) for that class, as above.

• Continue until all classes have been assigned a judge in all positions.

• Click ❼ Close to return to the Main Menu.

SECTION II. BEFORE THE SHOW

STEP 5. JUDGES > ASSIGN JUDGE(S) TO EACH CLASS:

1
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• Select ❶Main Menu > ❷ Show Office
>❸ Scheduling. 

NOTE 1: Show days must have been assigned 
to each class, as described in Classes, before 
you can assign ride times.

245

Scheduling > Step 6. Assign Ride Times > Open Scheduling, Select Classes to Schedule 

• The ❹ Scheduling form opens, on which you choose the class numbers for the classes you want to 
schedule.  

• You can schedule up to eight classes at a time.  A separate form opens for each class; therefore, the 
number of classes you can schedule at one time depends upon the size and resolution of your computer 
monitor: 
o Smaller monitor / lower resolution = fewer classes
o Larger monitor / higher resolution  =  more classes.

• Using the sequence entered on your Show Scheduling Sheet, and the ❺ Class # drop-down arrows or 
type-in boxes, enter the first group of class numbers, in order, on which you wish to work.   These should 
be the first classes in the first ring.

• Click ❻ OK.  

SECTION II. BEFORE THE SHOW

2

3

1

4

5 5 5

6

5

STEP 6. ASSIGN RIDE TIMES > OPEN SCHEDULING

STEP 6. ASSIGN RIDE TIMES > SELECT CLASSES TO SCHEDULE:

NOTE 2: See OPEN TWO COPIES OF ONE 
SHOW FOR SCHEDULING for a method to 
schedule more than eight classes at a time.
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NOTE: For large classes, these windows can be enlarged, allowing you to see the entire class list.  Place your cursor over the 
bottom band – a double arrow appears.  Left click and drag down until you can see all the riders in the class.  The form will now 
be longer.  You can also move the Schedule windows around in case you want to change a class sequence

• The FVD program lists the ❷ Entry numbers, ❸ Rider names, and 
❹ Test abbreviation.

• Enter the ❺ Start Time of the first class using hour, minute, seconds, 
and AM or PM.  
o For hours less than two digits, enter a 0 then the correct number; 

for example, 08:00:00 AM is 8 o’clock in the morning.  
o You must enter AM or PM or some riders may be riding after dark!

• ❶ Schedule windows open for all selected classes, in the sequence in which you entered them in the 
Scheduling form. 
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Scheduling > Step 6. Assign Ride Times > Schedule Windows, Enter Start Time, Schedule the 
Class

SECTION II. BEFORE THE SHOW

NOTE: When the Schedule button is red, it must be clicked before you leave the form.  
Clicking Schedule causes a recalculation of the ride times in the class after you have 
made some changes.  If you do not click the red  Schedule, your changes will not take 
effect.  This is also important when you add or delete breaks.

STEP 6. ASSIGN RIDE TIMES > SCHEDULE WINDOWS:

STEP 6. ASSIGN RIDE TIMES > ENTER START TIME:

• When you change data in a Schedule form, the ❻ Schedule button 
text turns red.  Click the red ❻ Schedule button (the text will turn 
from red to black).   

• The FVD program will fill in the ❼ Time that each ride will start, 
based on the test durations in the FVD program (see Show Office > 
Test Durations and USEF/USDF/FEI TEST DURATIONS AND FVD TEST 
DURATIONS).

• The ❽ # of Rides and❾ End Time for the class is automatically 
entered.

• If needed/desired, enter a break or lunch, as explained later in 
Break/Lunch > Add a Break/Lunch. It is recommended you do this 
now as, if you wait until you schedule an entire ring, you will have to 
go back and adjust all the times.

STEP 6. ASSIGN RIDE TIMES > SCHEDULE THE CLASS:

1 1 1 1 1

42 3
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Time Format:
HH:MM:SS AM/PM
08:00:00 AM
12:00:00 PM

7

8 9

1



Fox Village Dressage User Manual – 2021 Update 1.0.5. helpdesk@foxvillage.com                 www.foxvillage.com

• Now go to the next ❶ Schedule form for 
the next class in your sequence.

• Type in the End Time from the previous class 
in the ❷ Start Time box. 

• Click the ❸ Schedule box (the text will turn 
from red to black). This will fill in the ❹
[ride] times that each rider is to ride.  

• The ❺ # of Rides and❻ End Time for the 
class is automatically entered.

• Repeat the sequence ❶ -❻ until the ride times for all selected classes have been assigned.

• Repeat, using the next group of classes you want to schedule in a ring.
• When the classes in Ring 1 have been scheduled, schedule Ring 2.
• Etc.
• Repeat until all classes in all rings are preliminarily scheduled.
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Scheduling > Step 6. Assign Ride Times > Next Start Times and Schedule, Close

NOTE: 
• To close one ❶ Schedule form, click its ❾ Close button.  
• To close all the open ❶ Schedule windows and the ❽ Scheduling form, on the ❽ Scheduling form, click 
❼ Close.

• If needed/desired, enter a break or lunch, as 
explained later in Break/Lunch.  It is recommended 
you do this now as, if you wait until you schedule an 
entire ring, you will have to go back and adjust all 
the times.

SECTION II. BEFORE THE SHOW

• When you are finished scheduling, click ❼ Close on the ❽ Scheduling form. This closes all the 
windows and returns you to the Main Menu.

STEP 6. ASSIGN RIDE TIMES > NEXT START TIMES AND SCHEDULE:

7
8

STEP 6. ASSIGN RIDE TIMES > CLOSE:

5 69

2

43

1 2
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• First schedule the class. 
• Decide before which ride in the class you wish to add a break and 

note that time.  For example, if the judge started judging at 8:00 
AM, you need a break that starts no later than 10:00 AM.  In this 
example we will schedule a break within a class at most 1.5 hrs from 
the start, or by 9:30 AM.  Looking at the schedule, the closest time 
before 9:30 AM is 9:30 AM.  This is the time the break will start.

• Click the ❶ Add Break button.
• The ❷ Add Break form opens. 
• Enter the ❸ Time the break should start.  In this example, it is 

9:30:00 AM.
• In the ❹ Duration box, enter the duration of the break in minutes 

(at least 10 minutes for a break and at least 45 minutes for lunch).  
In this example, it is 10 min.

• In the ❺ Description box, type a short description of the break, 
such as 10 MIN BREAK, 15 MIN BREAK, 45 MIN LUNCH, etc.  I use 
capital letters and the minutes so the break and time are obvious on 
reports.

• Click ❻ OK.
• The Add Break form will close and the break has been added.

248

Scheduling > Step 7. Break/Lunch > Add a Break/Lunch >
USEF Rules, Break/Lunch WITHIN a Class

INTERPRETATION: Judges must be given at least a 45-minute lunch break and at least a 10-minute break 
every 2 hours.  This means they judge for 2 hrs (or less), have a 10-15 min break, judge for 2 hrs (or less), have 
a 45-60 min lunch, judge for 2 hrs (or less), have a 10-15 min break, judge for 2 hrs (or less), then the day is 
done.  This gives them no more than 8 hrs of judging and 65 to 90 min of break/lunch, for a 9 hr 5 min to 9 hr 
30 min day.

• Breaks and lunch must be scheduled “by hand.”  They can be 
scheduled within a class or between classes, depending upon the 
schedule that you are developing.  

SECTION II. BEFORE THE SHOW

DR126.2.d. Requirements for Dressage Competition Management.
d. Judges and Technical Delegates. 

1. No judge shall be required to officiate longer than 8 hours in one day, unless the judge has agreed in 
writing, and cannot be required to be on the competition grounds longer than 10 hours.
2. Judges must be given at least a 45-minute lunch break and at least a 10-minute break every 2 hours.

NOTE 1:  Whenever possible, schedule a break after a class so a class in not interrupted by a break.  However, this is 
usually not possible.
NOTE 2:  In a perfect world, a lunch would not occur within a class because it introduces a long wait for riders to get 
final class results.  To avoid this, if the show duration allows, you may want to schedule two 10-minute breaks in the 
AM, instead of one 15-minute break.  This will often let you schedule lunch between classes.  

STEP 7. BREAK/LUNCH > ADD A BREAK/LUNCH > USEF RULES:

STEP 7. BREAK/LUNCH > ADD A BREAK/LUNCH > BREAK/LUNCH WITHIN A CLASS:

Continued on next page…
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Scheduling > Step 7. Break/Lunch > Add a Break/Lunch >
Break/Lunch WITHIN a Class, Cont’d.

• The ❼ Break has been 
added at 9:30 AM.

• Click on ❽ Schedule. 

VERY VERY VERY IMPORTANT:  The times of the subsequent classes/rides (in the subsequent Schedule 
forms) do not automatically adjust; therefore, if you have already scheduled subsequent classes/rides, 
you must sequentially enter the new Start Time(s) for the next class(es), thereby rescheduling each ride 
in each class following the class that you just rescheduled.

• This will ❾ reschedule the 
rides after the new BREAK 
and calculate a new class ❿
End Time.

NOTE:  During the Blocking the Show procedure you predetermined when you want your breaks and lunch; 
therefore, as you schedule each class, you can also add the breaks/lunch, thereby avoiding the need to 
reschedule each previously scheduled class as you add breaks/lunch.

SECTION II. BEFORE THE SHOW

• For the next class, edit the 
⓫ OLD START TIME to the 
⓬ NEW CLASS TIME.

• Click ⓭ Schedule.
• A new class ⓮ End Time is 

calculated.

• Repeat for the subsequent 
classes if they were 
previously scheduled, adding 
the lunch and afternoon 
breaks.

7

8

9

10

OLD START TIME NEW START TIME

11 12

13

14
OLD END TIME NEW END TIME
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Scheduling > Step 7. Break/Lunch > Add a Break/Lunch > Break/Lunch BETWEEN Classes

• The ❸ Add Break form opens. 
• Enter the ❹ Time the break should start.  In this 

example, it is 9:57:00 AM (enter all the digits and 
AM).

• Click in ❺ Duration box and enter the duration 
of the break in minutes (at least 10 minutes for a 
break and at least 45 minutes for lunch).  The 
example has a 60-minute lunch break.

• Click in the ❻ Description box and type in the 
type of break.  In this example, it is LUNCH.

• Click ❼ OK.

• First schedule the class after which you want to 
schedule a break or lunch. 

• Note the ❶ End Time of the class.  In this 
example, it is 9:57:00 AM.  This is a good time for 
a break between classes as the ring’s start time 
was 8:00:00 AM.

• Click the ❷ Add Break button.

• The Add Break form will close, ❽ BREAK 10 
MIN is added at the end of the class at 9:57:00 
AM, and ❾ Schedule turns red. However, the 
❿ End Time has not yet been updated.

• Click ❾ Schedule.

• The ❽ Break has now been scheduled and a new 
⓫ End Time is automatically entered.  Use this new 
end time to start your next class.  

• If later classes have already been scheduled, 
reschedule them to reflect this new End Time.

SECTION II. BEFORE THE SHOW

NOTE:  You can also schedule breaks/lunch between classes by starting the next class 10-15 min (break) or 45-
60 minutes (lunch) later than the end of the previous class.  However, with this technique, ***Break*** does 
not appear on the Day Sheets and the break/lunch times are not included on the Judge Schedule Report or 
the Harrow Report.  Therefore, this technique is not recommended. 

STEP 7. BREAK/LUNCH > ADD A BREAK/LUNCH > BREAK/LUNCH BETWEEN CLASSES:
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• Click on the ❶ white box w black arrow to the 
left of the break that you want to delete.  The 
box will turn black and the arrow will turn white.

• Click on the ❷ Delete Break button. 

• A ❸ Fox Village Dressage warning form opens.
• Click on ❹ Yes. 

• When you are finished click the Close button at 
the right of the scheduling form; this returns you 
to the Main Menu.

251

Scheduling > Step 7. Break/Lunch > Delete a Break/Lunch

• The ❺ BREAK is now gone and the ❻ Schedule
button is now red; however, the ❼ End Time 
has not yet updated.

• Click on ❻ Schedule (the text will change from 
red to black). 

3

4

You may need to delete a break if you must change 
your schedule due to excess judging time, rider 
conflicts, etc.

• The ❽ End Time has now changed.  Use this as 
the new start time for the next class.

• If later classes have already been scheduled, 
reschedule them to reflect this break deletion.

SECTION II. BEFORE THE SHOW

NOTE:  A frustrating aspect of scheduling occurs when lunch must be scheduled when there are only a few 
rides remaining in a class.  Riders, who are usually not aware of USEF judge scheduling rules, usually complain.  
If your show schedule allows, you may want to schedule two 10-minute breaks in the morning, which lets you 
schedule lunch after the class ends.  This will give you happy judges and happy riders.  As an alternative, you 
can contact the judge and ask permission to schedule the lunch a bit late; however, this should only be done 
as a last resort.

STEP 7. BREAK/LUNCH > DELETE A BREAK/LUNCH:
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NOTES: 
• The procedure to set the conflict resolution time is in Show Preferences.  Ensure this time is set to 50 

minutes before you perform the following procedures.
• Conflict resolution cannot be performed until ALL rides in ALL classes for the show DAY have been scheduled.
• An email from the rider is sufficient as a written agreement to a conflict.  Add the email to the entry packet.

4

5

• Select ❶Main Menu > ❷ Show Office 
> ❸ Scheduling.

252

Scheduling > Step 8. Conflict Resolution > USEF Rule, View Rider Conflicts

• The ❹ Scheduling form opens.
• To view Rider conflicts, using the ❺

View Conflicts drop-down arrow, select 
Rider. 

SECTION II. BEFORE THE SHOW

Interpretation: If a rider has less than 50 minutes between the start of two rides on different horses, there is a 
conflict.  FVD conflict resolution works to resolve these conflicts.

USEF Rules DR126.2.b. Requirements for Dressage Competition Management.
b. Competition Schedule. 

5. At least 50 minutes must be scheduled between start times for a rider’s tests on different horses unless 
he/she has agreed, in writing, to a shorter interval between tests. …

• Using the ❻ Date drop-down arrow, select a date to review.  Start with the first day of the show.  If the 
show has only one day, skip this step.

• Click ❼ OK.

1

3

2

STEP 8. CONFLICT RESOLUTION > USEF RULE:

STEP 8. CONFLICT RESOLUTION > VIEW RIDER CONFLICTS:

Saturday, June 20, YYYY

6

7
Saturday, June 20, YYYY
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NOTE 1: Rider Conflict Resolution indicates a conflict for the rider; it does not indicate whether the conflict is on 
one horse or two horses. 
NOTE 2: Rider conflict with two horses: For USEF, you need to resolve conflicts of less than 50 minutes with one 
rider on two horses.  
NOTE 2: Rider conflict on one horse:  There is no USEF rule for conflicts with two rides by one rider on one horse.  
I attempt to have no less than about 30  minutes for two rides on the same horse.
NOTE 3: Both types of conflict are managed the same way. 

• The ❽ Rider Conflicts form opens, which lists the ❾ Rider name, ❿ Entry #, ⓫ Class #, ⓬ Class 
Name, ⓭ Ring, ⓮ Day, ⓯ Time, ⓰ Conflict ( = conflict), and ⓱ Elapsed Minutes.  Riders with 
conflicts (less than 50 minutes between two rides) will have a check mark in the ⓰ Conflict column.

• To only view the riders with conflicts, click ⓲ Filter Conflicts.

253

Scheduling > Step 8. Conflict Resolution > View Rider Conflicts, Cont’d.

SECTION II. BEFORE THE SHOW

• Look at the first ⓳ Entry # and the two ⓴ Class numbers that share the conflict.  In this example, Entry 
# 103 has a conflict between Class 123 O and Class 122 O with an elapsed time of only XX 18 minutes.  
This is usually not enough time for two rides on the same horse.

8
9 10 11 12 13 14 15 16 17

18

Class 123 O      
Class 122 O

19 20

21
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• Select the conflicted class numbers in the ❶ Scheduling > Class # boxes.
• Click ❷ OK.

• View the ❸ rider’s position in each class.  
• In this example, the rider is the ❸ 2nd rider for Class #123 O and is the ❹ 1st rider for Class #122 O.

254

Scheduling > Step 8. Conflict Resolution > Fix Rider Conflicts

SECTION II. BEFORE THE SHOW

STEP 8. CONFLICT RESOLUTION > FIX RIDER CONFLICTS:

1 21

3
4

Continued on next page…
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• If possible, select an earlier ride time in the earlier class and/or a later ride time in the later class.  

255

Scheduling > Step 8. Conflict Resolution > Fix Rider Conflicts, Cont’d.

SECTION II. BEFORE THE SHOW

• In the earlier class (in this example, Class #123 
O), place the earlier class position number 
(earlier ride time) in the conflicted rider’s ❺ FO
(Forced Order) box (in this example, enter a 1 in 
the FO box).  

• Click the ❻ Schedule button (the text will 
change from red to black).

• The rider with a conflict is now in ❼ position 1.

• If needed, repeat with the second class to move 
the rider ❽ later in that class.

• Click ❾ Close to close both Schedule windows.

5

6

7

8

9



Fox Village Dressage User Manual – 2021 Update 1.0.5. helpdesk@foxvillage.com                 www.foxvillage.com256

Scheduling > Step 8. Conflict Resolution > Check for Resolution of the Conflict

• Proceed down the list to the next rider with a checked conflict box.
• Open classes in conflict for the new rider.
• Repeat these steps for each rider with check marks in the conflict boxes.

NOTES: 
• Some riders may simply be too close or classes too small to permit conflict resolution. Under unusual 

circumstances, to accommodate riders with a conflict, a ride may be scheduled out-of-sequence with the 
balance of the class.  See Temporary Rider Conflict (RC) Class for the procedure.

• For small shows, the show secretary may want to communicate with riders when there are not enough rides to 
accommodate the 50-minute rule.  Many riders will be happy to ride lower level tests with less than 50 minutes 
between tests.  Many professional riders do not need more than 30 minutes for a warm-up and are happy to 
accommodate a tighter schedule.  However, you must get written permission (an email or text will work).

• Championship classes must be run in their entirety before another class may start; however, you can add extra 
breaks or longer breaks to give more time, if necessary.

• You can also use the Rider Conflicts form to view riders with a long time between rides (they are not marked 
with a check).  Although not required, you may want to adjust ride times to lessen the time between rides.

SECTION II. BEFORE THE SHOW

• If the rider conflicts form was still 
open, on the ❸ Rider Conflicts form, 
click ❹ Refresh.

• The form “refreshes” to include the 
change you just made.

• Scroll down to the rider in question (or 
click ❺ Filter Conflicts to only view 
riders with conflicts) and see if the 
conflict has been resolved (unchecked).  
In this example, the conflict for entry 
❻ # 103 has changed from 18 
minutes to ❼ 34.5 minutes.  This is 
sufficient for one rider on one horse 
but is not sufficient for one rider on 
two horses, which is why the ❽
Conflict boxes are still checked (FVD 
automatically checks boxes if the 
Elapsed Time is < 50 minutes).

• If needed, open the view rider conflicts: open the ❶ Scheduling form and click ❷ OK.
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• If not resolved, repeat the conflict resolution process to widen the spread between ride times.
• If it cannot be resolved by changing ride times, you have two options:
o Reschedule your show.
o Create a Rider Conflict class (see Temporary Rider Conflict (RC) Class).
o Contact the rider to see if the conflict time is ok.  This can be done via email, text, or phone call.  Email 

or text is preferable as the rider’s return message is your written confirmation.

STEP 8. CONFLICT RESOLUTION > CHECK FOR RESOLUTION OF THE CONFLICT:
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• Re-select scheduling, proceed with conflict resolution for the next day(s) and repeat all steps above.

• If you had to move any classes during Conflict Resolution, if desired, go back to your blocking sheet and 
make the changes made during the conflict resolution process. 
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Scheduling > Step 8. Conflict Resolution > Other Conflicts

SECTION II. BEFORE THE SHOW

• Conflict Resolution is also used to determine conflicts for:
o ❶ Trainer: Displays conflicts for a trainer who may need to be with two or more horses.
o ❷ Coach: Displays conflicts for a trainer who may need to be with two or more riders.
o ❸ Horse: Displays conflicts for a horse that may have more than one rider.
o ❹ Class: Displays conflicts (scheduling errors) whereby two classes overlap in one ring or there is a 

lapse of time between two classes in one ring.

• When finished with the first day, in the ❺ Scheduling form, click ❻ Close.

1
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STEP 8. CONFLICT RESOLUTION > OTHER CONFLICTS:
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Scheduling > Step 8. Conflict Resolution > Temporary Rider Conflict (RC) Class

SECTION II. BEFORE THE SHOW

• There will be times when you cannot resolve a rider’s conflict with the previous techniques.  An example 
is a class with only three or four rides, and one rider has two rides on two horses in the class.  To fix this 
type of conflict, you create a Temporary Rider Conflict Class (RC Class) that lets you schedule one ride 
out of sequence with the balance of the class.

• In this example, we have a Training 2 class with four rides.  One rider has two horses in the class.  Since 
training 2 provides 7.5 minutes per ride, if the rider is the first and last rides in the class, the second ride 
will start 22.5 minutes after the start of the first ride.  This is not enough time to change horses, much 
less warm-up the second horse.

• Procedure:
o Using the ❶ View Class Copy button, create a new class that is a copy of the USEF Training Level Test 

2 class.  It might be named Training Test 2 RC, where the RC indicates it is a Temporary Rider Conflict 
Class.

o Using the ❷ View Class Splitter button, move the conflicted rider into the RC class.
o Schedule your show as usual.  Ideally, schedule the RC class BEFORE the balance of the class.  For 

example, the RC ride might be at 8:00:00 AM and the balance of the class might start at 10:00:00 AM.  
In this manner, the other riders do not have to wait for the conflicted ride to be completed.

o The morning of the show, AFTER Day Sheets have been printed and BEFORE the original class is scored 
and placed, using the ❶ View Class Splitter button, move the conflicted ride back into the original 
class.

o Score and place the original class in the usual manner.
o Finally, if desired, delete the RC class; however, this is not required as it is now an empty class so is not 

seen on most reports.

1 2

STEP 8. CONFLICT RESOLUTION > TEMPORARY RIDER CONFLICT (RC) CLASS:

NOTE:  Notify the scoring section of an RC class.  Otherwise, 
they may view the RC class as a separate class with one rider.
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INTERPRETATION
• A judge may not be on the show grounds in an official capacity longer than 10 hours.
• A judge may officiate 8 hours in a day, exclusive of breaks and lunch.  You may ask a judge if s/he will 

continue beyond their 8 hours of officiating.  Some will agree, some will agree but will charge punitive 
overtime fees, and some will refuse.  Check with the judges early enough so you can hire a part-time judge, 
if necessary.

• Judges must have a break or lunch every  2 hours.
• Breaks must be at least 10 minutes; 15-minute breaks are appreciated.
• Lunch must be at least 45 minutes; 60-minute lunches are appreciated.

259

Scheduling > Step 9. Check Judge Hours > USEF Rules, Avoid Fines

USEF Rule DR126.2.d. Requirements for Dressage Competition Management.
d. Judges and Technical Delegates. 

(1) No judge shall be required to officiate longer than 8 hours in one day, unless the judge has agreed in 
writing, and cannot be required to be on the competition grounds longer than 10 hours.
(2) Judges must be given at least a 45-minute lunch break and at least a 10-minute break every 2 hours.

• Show management is responsible for complying with USEF rules and may be fined if the rules are not 
followed.

SECTION II. BEFORE THE SHOW

STEP 9. CHECK JUDGE HOURS > USEF RULES:

SYEP 9. CHECK JUDGE HOURS > AVOID FINES:
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Scheduling > Step 9. Check Judge Hours > Judge Schedule Report

• The ❺ Judge Schedule 
report opens.

• This report counts ❻ Total 
Time for Day, including 
breaks/lunch that are listed 
on the Day Sheets but not
breaks/lunch that are not
listed on the Day Sheets as 
(see Break/Lunch between 
Classes). Therefore, if you 
used this latter technique, 
you would need to add time 
for these breaks/lunch.

• Click ❼ Print to print the 
report.

• Click ❽ Close Print 
Preview to close the report.

SECTION II. BEFORE THE SHOW

• You need to look at how many hours you 
have scheduled for each judge (if you 
have too many hours you will need to 
reschedule, get permission from the 
judge, or hire a second judge for the ring).  

• Select ❶Main Menu > ❷ Reports >                
❸ During-Show > ❹ Judge Schedule.
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STEP 9. CHECK JUDGE HOURS > JUDGE SCHEDULE REPORT:

Includes judging time and
breaks/lunch included in 
the schedule.  This cannot 
have more than 8 hrs of 
judging and cannot be 
more than 10 hours.
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Scheduling > Step 9. Check Judge Hours > Day Sheets Standard Report

SECTION II. BEFORE THE SHOW

• The ❺ Day Sheets report opens.
• If you want a report for all show days, 

click ❻ OK.
• If you want a report for one day, click the 
❼ Date drop-down arrow, select the ❽
Date you want to examine first.  We will 
look at Saturday.

• Click ❻ OK. 

• Next, click ❶Main Menu > ❷ Reports
> ❸ During-Show > ❹ Day Sheets 
Standard report.

5

6

7

8

5

6

• The ❾ Day Sheets (Standard) report opens.  
• We will look at judge ❿ Bxxxxxxx Exxxxxx on ⓫ Saturday and compare it to the Judge Schedule

Report.

9 11

10

1

2

3 4

STEP 9. CHECK JUDGE HOURS > DAY SHEETS STANDARD REPORT:

Saturday, June 20, YYYY
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Scheduling > Step 9. Check Judge Hours > Compare Judge Schedule Report & 
Day Sheets Standard Report

SECTION II. BEFORE THE SHOW

• The ❶ Judge Schedule Report shows the ❷ Total Time for Day is 7 hr., 44 min.  This complies with the 
USEF maximum of 10 hours on the show grounds.

• The ❸ Day Sheets (Standard) report shows ❹ BREAK 10 MIN, ❺ LUNCH 45 MIN and ❻ BREAK 10 
MIN, for a total breaks/lunch of 1 hr, 5 min. This complies with the USEF requirements for breaks (at 
least 10 min) & lunch (at least 45 min) every 2 hours.

• The total judging time is (7 hr, 44 min) – (1 hr, 5 min) = 6 hr, 39 min.  This complies with the USEF 
maximum judging time of 8 hours.

• Repeat this comparison for all judges in all rings for each day to ensure you have complied by the USEF 
rules.  If not, you will need to adjust your schedule; otherwise, you could be fined by USEF.

1

2

STEP 9. CHECK JUDGE HOURS > COMPARE JUDGE SCHEDULE REPORT & DAY SHEETS STANDARD REPORT:

3
4

5
6
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Scheduling > Step 10. Review Day Sheets Report

SECTION II. BEFORE THE SHOW

STEP 10. REVIEW DAY SHEETS REPORT:

• The last step of scheduling is to review 
the Day Sheets Report (CDI or Standard).

• Click ❶ Main Menu > ❷ Reports > ❸
During-Show > ❹ Day Sheets Standard 
(or Day Sheets CDI).

5

• The ❺ Day Sheets report opens.

• Methodically go through each class, in 
succession, to ensure no scheduling errors 
have been made.

• Take a lot of time with this to ensure you find 
any possible errors.

1

2

3 4
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SECTION II. BEFORE THE SHOW
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SECTION II. BEFORE THE SHOW

There are always horses or riders that come up with something just before or during a show, requiring them 
to scratch (cancel) a ride in a class, or an entire show.

• The ❹ Entry form opens.
• Using the ❺ Entry (Lookup) box, type in the 

Entry # and press the Enter key,  
OR

• Use the ❻ Entry (Lookup) drop-down arrow to 
select the Entry #.

265

Scratches Received AFTER Scheduling > Scratch Ride(s)

NOTE: This procedure is performed AFTER scheduling your show.  For scratches received 
BEFORE scheduling your show, see REFUNDS FOR SCRATCHES RECEIVED BEFORE SCHEDULING.

• Select ❶Main Menu > ❷ Show Office 
> ❸ Entries.

1

2

3

4

6
5

SCRATCH RIDE(S):
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SECTION II. BEFORE THE SHOW

• Ensure you have the correct ❼ Entry #.
• Click the ❽ Class Entries tab.

• Click on the ❾ Expand button to expand the class selection (for all classes, this shows three lines of 
information instead of the standard two lines).

266

Scratches Received AFTER Scheduling > Scratch Ride(s), Cont’d.

9

7

8
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SECTION II. BEFORE THE SHOW

• Click on the ❿ Term Reason drop-down arrow in 
the third row of the class/ride to be scratched.

• Select ⓫ Scratch.

267

Scratches Received AFTER Scheduling > Scratch Ride(s), Cont’d.

• Verify that ⓬ Scratch is in the box. 
• Repeat for each class in the entry to be 

scratched.
• The scratched rides will be annotated on the new 

Day Sheets, score sheets, and other FVD reports.
• Click ⓭ Close to close the form and return to 

the Main Menu.

• As scratches often occur after the test packets 
are distributed to the rings, you may want to use 
a ⓮ Schedule Changes form (this is not a FVD 
report).  It is a quadricate (4 sheets) carbonless 
form that can be ordered from a printing 
company.  The form is completed by the show 
participant, the data is entered in the computer, 
and runners take copies to the scorers (white), 
judge (yellow), steward (pink), and announcer 
(goldenrod).

• If the ring dressage test packets have not already 
been distributed, write “scratch” on the test 
label.  Keep the test in the packet as it will be 
used by the judge if you fill the scratch.

10

11

12

13

14

14

12
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SECTION II. BEFORE THE SHOW
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Fill Scratched Rides > Scratches Not Subbed Report

• Before and during a show, riders may 
want to fill a scratched ride.

• Use the Scratches Not Subbed Report to 
keep track of scratched rides that are 
available to other riders.  (Scratches that 
have not been substituted with another 
rider.)

• Select ❶Main Menu > ❷ Reports >                
❸ During-Show > ❹ Scratches Not 
Subbed report.

• The ❺ Scratches Not Subbed report
opens.  

• This report lists rides that have been 
scratched and are therefore available to 
other riders.  It is sorted by day and then 
by ride time.

• When a scratched ride is filled in the FVD 
program, the ride is automatically 
removed from the Scratches Not Subbed 
Report.

SECTION II. BEFORE THE SHOW

NOTE: If you have a long Scratches Not 
Subbed Report (many scratches), it may be 
easier to open the day sheet and look up the 
particular class for which a rider is looking 
for a ride.   Available rides will have the word 
“scratch”  in the term column corresponding 
to available ride times.

• To print a paper copy of the Scratches 
Not Subbed Report, click ❻ Print.  As 
time passes, be careful with the printed 
report as the computer may have more 
up-to-date information.

• Click ❼ Close Print Preview to close the 
report and return to the Main Menu.

5

6

7

SCRATCHES NOT SUBBED REPORT:

1

2

3

4

• IMPORTANT: After you enter a scratch, use Upload Ride Times to list the scratch(es) on the FVD web site 
so other riders may request the scratch(es).  See UPLOAD RIDE TIMES TO FVD WEB SITE.  
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270

Fill Scratched Rides > Open the Entry that Will Fill the Ride

• The ❹ Entry form opens.
• Use the ❺ Entry (Lookup) drop-down arrow or 
❻ type-in box to select the Entry # of the 
horse/rider pair that will fill the scratch.

• Select ❶Main Menu > ❷ Show Office 
> ❸ Entries.

1

2

3

5
6

4

OPEN THE ENTRY THAT WILL FILL THE RIDE:
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Fill Scratched Rides > Expand Class, View Scratches to Sub

• If the entrant is already in other classes/rides, 
you will now see the ❹ Day and Time for each 
class/ride.  In this example, this is a new entrant 
without any classes/rides.

• Click the ❺ View Scratches to Sub button.

• Look at the ❶ Entry # to verify that the correct 
entry has been selected.

• Click the ❷ Class Entries tab.
• The entry’s current class/rides are displayed.  
• Click the ❸ Expand button to display the 

class/ride details.

Continued on next page…

EXPAND CLASS:

1

2

3

VIEW SCRATCHES TO SUB:

4

5
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Fill Scratched Rides > Select Scratch, Correct Qual

• The ❻ Scratch - Sub form opens.
• Using the ❼ scroll bar, find the class you want to 

fill.  In this example, it is a ride in Class 113.

• A ❿ Fox Village Dressage warning form opens.
• Click ⓫ Yes to fill the scratch with this 

horse/rider pair (“sub this class entry” in FVD 
terminology).          

• The ⓬ added class is now listed for this entry. 

• Select the scratch to be filled by clicking the 
❽white box (it will turn black).

• Click ❾ Sub.

• VERY VERY VERY VERY IMPORTANT:
o If this is a GAIG Q class for which the 

qualifying fee was paid by both riders, you do 
not need to do anything.

o If the previous rider did not request a GAIG Q 
ride (as in this example) but the new rider 
wants a GAIG Q ride (and has paid the fee), 
click the ⓭ Qual/Div drop-down arrow (or 
use the type-in box) and select ⓮ Yes.

o If the previous rider had a GAIG Q ride but 
the new rider does not want a GAIG Q ride, 
click the ⓯ Qual/Div drop-down arrow (or 
use the type-in box) and select ⓰ No.

o If you do not edit Qual/Div, the Qual/Div 
status of the PREVIOUS rider carries over to 
the NEW rider, which could result in 
confusing errors!

SELECT SCRATCH:

CORRECT QUAL:

10

11

6

7

8
9

12
13

14
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Fill Scratched Rides > Test Sheet Label for a Filled Scratch

• If you want to print a label for the test, click the 
❶ white box adjacent to the new class entry 
(the box turns black).

• Click the ❷ Single Test Labels button.

• The ❸ Test Labels form opens.
• Select the ❹ letter corresponding to the arena 

position/judge for which you desire a label (this is 
usually letter C).

• Click ❺ OK.

• The ❻ Test Labels (Standard) report opens.
• See PRINT LABELS AND INDEX CARDS for the 

procedure to print labels and index.

3

5

4

• Pull the correct test, label the test, and put 
it/them into the appropriate scribe packet or 
send it to the judge’s stand if the tests have 
already been distributed.

TEST SHEET LABEL FOR A FILLED SCRATCH:

• As scratches often occur after the test packets 
are distributed to the rings, you may want to use 
a ❼ Schedule Changes form (this is not a FVD 
report).  It is a quadricate (4 sheets) carbonless 
form that can be ordered from a printing 
company.  The form is completed by the show 
participant, the data is entered in the computer, 
and runners take copies to the scorers (white), 
judge (yellow), steward (pink), and announcer 
(goldenrod).

1

2

NOTE: A hand-written label will suffice 
and is more cost effective as printing 
one label will use an entire label sheet.

14

7

6
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• Ensure you have the correct ❺ Entry #.
• If the sub rider is NOT already in your FVD 

database, click the ❻ Add Rider button and 
follow the instructions in Rider.  

• Using the ❼ Rider (Lookup) drop-down arrow or 
type-in box, select the name of the sub rider.

• Select the ❽ Rider / Trainer tab and ensure the 
sub rider’s information is complete and current.

275

Entry Changes > Rider Substitution for an Already Entered Rider > Change Rider

After the scheduling and during the show, the following entry changes may be needed:
1. Rider substitution for an already entered horse/rider combination.
2. Horse substitution for an already entered horse/rider combination.
3. Late entry for a new horse/rider combination.

NOTE: A rider substitution occurs when rider2 is taking ALL the rides of rider1 on horse1.  The Entry # for 
rider1/horse1 can be used for rider2/horse1.  If rider2 is only taking one/some of the rides of rider1 on horse1, 
then the rider2/horse1 combination is considered a new entry that requires a new Entry #, new fees, etc.  If 
the new entry is made after the show closing date, it may be considered a late entry.

• Select ❶Main Menu > ❷ Show Office 
> ❸ Entries.  

• Using the ❹ Entry (Lookup) drop-down 
arrow or type-in box, select the Entry #.

NOTE: Some show secretaries treat #1 and #2 as new entries with new 
entry fees, etc.  Your show can determine its own policy.  #3 is a new entry.

RIDER SUBSTITUTION FOR AN ALREADY ENTERED RIDER > CHANGE RIDER:

1

2

3

4

6

7

5

8
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• Select the ❶ Class Entries tab.
• Review the class entries and make any necessary 

changes for the new rider:
o For example, for GAIG Q rides, rider1 may have 

NOT requested a GAIG Q ride (No) but rider2 
may request a GAIG Q ride (Yes).

o In this example, Rider1 did not request a GAIG 
Q ride but Rider2 has requested a GAIG Q ride.  
Using the ❷ Div drop-down arrow, No must 
be changed to ❸ Yes.

o The ❹ $15 Q fee is automatically added.

276

Entry Changes > Rider Substitution for an Already Entered Rider > Update Classes & Fees

• Use the tests prepared for Rider1/Horse1 but change the rider name to reflect the new rider.  If the tests 
have already been distributed, the scribe enters the new rider name.

• See Test Sheet Label for a Filled Scratch, for the procedure to print a new label.  A hand-written label may 
be used, or you can cross out the name of the original rider and hand-write in the name of the new rider.

RIDER SUBSTITUTION FOR AN ALREADY ENTERED RIDER > UPDATE CLASSES:

RIDER SUBSTITUTION FOR AN ALREADY ENTERED RIDER > UPDATE FEES/PAYMENTS:

• To update fees, select the ❺ Other Fees > 
Payments tab.

• Make necessary changes.  Examples of new fees 
may be USEF and/or USDF non-member fees, 
entry Change Fee (not all shows charge this fee), 
etc.

• Check the new balance in the ❻ Balance box.  In 
this example, Rider2 owes the $15 Q fee.

• Collect and enter any new ❼ Payments / 
Credits, after which the balance should be $0.00 
again.

5

6

7

7

6

1

2

3
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Entry Changes > Horse Substitution for an Already Entered Horse > Change Horse, Data

HORSE SUBSTITUTION FOR AN ALREADY ENTERED HORSE > CHANGE HORSE:

NOTE:  A horse substitution occurs when horse2 is substituted for ALL the rides of rider1 on horse1.  The Entry 
# for rider1/horse1 may be used for rider1/horse2.  If horse2 is only being substituted for one/some of the 
rides of rider1 on horse1, then the rider1/horse2 pair are considered a new entry that requires a new Entry #, 
new fees, etc.  If the new entry is made after the show closing date, it may be considered a late entry.

1

• Select the ❶ Horse / Owner tab and ensure the 
new horse and owner information is complete, 
current and in the entry packet.

• Proceed as for Rider Substitution for an Already 
Entered Rider, except for the horse.

HORSE SUBSTITUTION FOR AN ALREADY ENTERED HORSE > CHANGE HORSE DATA:
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• Select the ❺ Class Entries tab.
• Review the ❻ class entries and make any 

necessary changes for the new horse (an example 
is adding or deleting qualification status).  

278

Entry Changes > Horse Substitution for an Already Entered Horse and Rider > 
Update Classes & Fees/Payments

• Use the tests prepared for Rider1/Horse1 but change the horse name to reflect the new horse.  If the 
test has already been distributed, the scribe enters the new horse name.

• See Test Sheet Label for a Filled Scratch for the procedure to print a new label.  A hand-written label may 
be used or you can cross out the name of the original rider and hand-write in the name of the new 
horse.

• To update fees, select the ❼ Other Fees / 
Payments tab.

• Make any necessary changes.  Examples of new 
fees may be USEF and/or USDF non-member 
fees, entry Change Fee (not all shows charge this 
fee), etc.

• Check the new balance in the ❽ Balance box.
• Collect and enter any new ❾ Payments / 

Credits, after which the balance should be $0.00 
again.

UPDATE FEES / PAYMENTS:

UPDATE CLASSES:

5

6

7

8

9
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• Late entries are entered the same as regular entries, except you are usually filling scratched rides.

• Print a new label.  A hand-written label may be used, or you can cross out the name of the original horse 
& rider and hand-write in the name of the new horse & rider.

• Use the tests prepared for the original (scratched) entry but change the entry #, horse name, rider name, 
rider status, and Q status to reflect the new entry.  If the test has already been distributed, the scribe 
enters the new information.

279

Entry Changes > Late Entries

LATE ENTRIES:

NOTE 2: After you have scheduled your show, it would be very difficult to add new ride times for a new entry; 
therefore, it is best if the new entry is only allowed to fill scratches.  An exception could be an RC ride schedule 
before the original first ride or after the original last ride.

NOTE 1:  A late entry occurs when a new horse/rider pair are entered in the show after the closing date (and 
presumably after scheduling).  This could be a completely new entry (new horse and new rider) that show 
management has allowed into the show.  It could also be a rider or horse substitution where the new 
rider/horse pair does not take all the rides of the original rider/horse pair.  For example, rider1/horse1 are 
scheduled for Training 2 and Training 3.  After the show closes, a change is requested so rider1/horse1 are 
riding in the Training 2 class and rider2/horse1 are riding in the Training 3 class.  Since rider2/horse1 are not 
taking all the rides of rider1/horse1, rider2/horse1 are a new (late) entry.  They are entered as a completely 
new entry with a new Entry #.  They are NOT charged the USEF horse/drug fee, stabling/grounds fee, etc. as 
that was already paid with the original entry.

NOTE 3: Many shows charge a late fee for late entries.  The fee is typically $50.  This is a show management 
decision that must be stated in the prize list.
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Wait List > Introduction, Place an Entry on the Wait List

• Before and/or during a show, you may receive late entries, riders may want to change classes and/or ride 
in additional classes for which you have no openings, etc.; therefore, you may want to put them on a 
Wait List for each requested class to more easily fill scratches.

• The FVD Wait List is for specified entry/class combinations.

• Select ❶Main Menu > ❷ Show Office 
> ❸ Classes.

SECTION VIII. TIPS & TRICKS

• The following covers method #3.

• If not already entered in FVD, enter the entry as in EE ONLINE ENTRIES, SNAIL MAILED SHOW ENTRIES 
CREATED WITH EE, SNAIL MAILED SHOW ENTRIES, and DETAILS OF A FVD ENTRY.

1

2

3

Continued on next page…

INTRODUCTION:

• A Wait List may be handled a number of different ways, including the following:
1. For entries not yet in the show, keep a file of the entries and put them in the show if you get an 

appropriate scratch.  This method is not recommended as it is difficult to remember who is waiting 
for what. 

2. For entries not yet in the show, you can use Check List feature to create a list in FVD; file the entries 
and pull the entries if you get an appropriate scratch.  Refer to this list whenever you get a scratch. 
Notify entrants they are on a waiting list.  This method is a little bit better than #1 as you have a 
master list of waiting entries.  See NOTE.

3. For entries already in the show, use the FVD View Wait List form and Wait List report, as discussed 
below.  

NOTE 1:  Check List is designed as a check list for show 
preparation steps, such as ordering ribbons and emailing 
the prize list.  Using it as a Wait List is an alternate purpose.

NOTE 2:  Notify entrants if they are on a waiting list.

PLACE AN ENTRY ON THE WAIT LIST:
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Wait List > Place an Entry on the Wait List, Cont’d.

• The ❹ Class form opens.

• Using the ❺ Class (Lookup) drop-down or type-in box, select the ❻ class for which you want to put an 
entrant on a waiting list.  In this example it is Training 3.

SECTION VIII. TIPS & TRICKS

5

4

Continued on next page…

5

6
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Wait List > Place an Entry on the Wait List, Cont’d.

• Verify that the correct ❼ Class # is displayed.

• Click the ❽ View Wait List button.

• The ❾Wait List form opens.

• Use the ❿ Entry # drop-down or type-in box to 
select the entry you want to put on the wait list 
for the class.  In this example, it is Entry # 106.

• Click ⓫ Close.

SECTION VIII. TIPS & TRICKS

7

8

9

10

11

10
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Wait List > View the Wait List Report

• Select  ❶Main Menu > ❷ Reports > 
❸ During-Show > ❹Wait List Report.

• The ❺Wait List report opens.
• The report contains:
o ❻ Day
o ❼ Class # and Class name
o ❽ Entry #
o ❾ Horse name
o ❿ Rider name

• The report is sorted by Day,  
Class #, then by Entry #.

• If you have a scratch in a class 
that has riders on the Wait List, 
you can refer to the list to fill the 
scratch (see Fill Scratched Rides).

The Wait List Report gives you a report of all 
classes for which entries are on the Wait 
List.

NOTE: The Wait List does 
not show the day/time the 
wait status was entered in 
the program.  If you want to 
give priority based on the 
day/time it was entered in 
the program, make a hand-
written annotation.  
Alternately, if you are 
assigning entry numbers in 
order of sequence, the entry 
with the lower entry # 
would get priority over an 
entry with a higher number.

SECTION VIII. TIPS & TRICKS

VIEW WAIT LIST REPORT:

5

1096 7 8
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Wait List > Delete Entry from the Wait List

• The ❹ Class form opens.

SECTION VIII. TIPS & TRICKS

After an entry is entered in the requested class, or if the entry withdraws the request, the entry must be 
manually removed from the wait list.

1

2

3

• Select  ❶Main Menu > ❷ Show Office 
> ❸ Classes.

4

Continued on next page…

DELETE ENTRY FROM THE WAIT LIST:
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Wait List > Delete Entry from the Wait List, Cont’d.
• Using the ❺ Class (Lookup) drop-down or type-in box, select the ❻ Class from which you want to 

delete an entry from the Wait List.  The example is Training 3.

• Verify that the correct ❼ Class # is displayed.
• Click the ❽ View Wait List button.

SECTION VIII. TIPS & TRICKS

7

8

5

6

Continued on next page…
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Wait List > Delete Entry from the Wait List, Cont’d.

• The ❾Wait List form opens and the ❿ wait 
listed entries (in this example, #106) is/are listed.

• To select the entry you want to delete, click the 
⓫ white box adjacent to the entry number.  The 
box is now black and the arrow is gray.

• Click the ⓬ Delete Entry button.

• A ⓭ Fox Village Dressage warning message 
opens.

• Click ⓮ Yes.

• The ⓯ entry is no longer on the Wait List for this 
class.

• Click ⓰ Close.

SECTION VIII. TIPS & TRICKS

9
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12

13

14
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16
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Ride Time Notification > USEF Rules, Methods, Upload Ride Times to the FVD Web Site

SECTION II. BEFORE THE SHOW

• Once you have established your show’s ride times, you can provide them to the competitors in four 
methods:
1. FVD Web Site: Post ride times using the FVD Upload Ride Times and & Results to Web service (see 

below). 
2. Your Web Site: Save ride times as PDF files and post on your web site.
3. Email: Save ride times as PDF files and email to competitors.
4. Snail Mail: Print ride times and snail mail to competitors.

1

2
3

NOTE: By convention (but not USEF rule), riders should know their ride times about a week before the first 
class.

USEF Rule DR126.2. Requirements for Dressage Competition Management.
b. Competition Schedule. 

2. Organizers must prepare a time schedule including all rides. If possible, competitors should be notified 
of their riding times prior to arrival at the competition.

• You must first register your show with 
FVD.  See REGISTER A SHOW WITH FVD.

• Click ❶Main Menu > ❷ Fox Village 
Dressage Online Tools > ❸ Upload Ride 
Times.

RIDE TIME NOTIFICATION > USEF RULES:

RIDE TIME NOTIFICATION > METHODS:

RIDE TIME NOTIFICATION > UPLOAD RIDE TIMES TO FVD WEB SITE:

Continued on next page…
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Ride Time Notification > Upload Ride Times to the FVD Web Site, Cont’d.

SECTION II. BEFORE THE SHOW

• A ❻ Fox Village Dressage information form 
opens to let you know your ride times have been 
uploaded.

• Click ❼ OK.

• Click ❺ Upload Now to upload your ride times.

• To generate URLs to post links to the information 
on your web site, click ❽ Generate URLs.  

• The URLs for your results ❾ By Class, ❿ By 
Rider and ⓫ Scratches are inserted into the 
boxes.

• Click each ⓬ Click here to view to see the 
information linked by the URL.

• Copy and paste each URL to your web site to 
provide links to the information on the FVD web 
site.

• Alternatively, email the links to all the riders.

• Click⓭ Close to return to the main menu.

See UPLOAD SHOW RESULTS TO THE WEB for information on streaming live results during the show.

• The ❹ Upload Ride Times & Results to Web 
form opens.

4

5

6

7

8

9

10

11

12

13
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Ride Time Notification > FVD Rider’s Schedule Report

• Select ❶Main Menu > ❷ Reports > 
❸ During-Show > ❹ Rider’s Schedule.

• The ❺ Rider’s Schedule report
opens.

• The report is an alphabetical 
listing (by rider last name) of all 
riders that provides:
o ❻ FirstName LastName (rider)
o ❼ Day
o ❽ Ride Time
o ❾ Ring
o ❿ Entry #
o ⓫ Horse (name)
o ⓬ Class (#)
o ⓭ Test Name
o ⓮ Qual/Div (Yes, No)
o ⓯ Judge names/locations

SECTION II. BEFORE THE SHOW

• There are two FVD reports commonly used to 
provide ride times to competitors:
o Rider’s Schedule Report
o Day Sheets Standard Report

1

2

3

4

RIDE TIME NOTIFICATION > FVD RIDER’S 
SCHEDULE REPORT:

6

7
8

9

5

10

11

12

13

14

15
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Ride Time Notification > FVD Day Sheets Standard Report

• Select ❶Main Menu > ❷ Reports > 
❸ During-Show > ❹ Day Sheets 
Standard Report (or Day Sheets CDI 
Report).

• Select the ❺ Date.
• Click ❻ OK.

• The ❼ Day Sheets (Standard)
report opens.

• This report lets competitors see 
the overall schedule of the show, 
how many riders are in each class, 
etc.

• The report is chronological listing 
(by ride time) of all rides that 
provides:
o ❽ Ring
o ❾ Day
o ❿ Class (# and name)
o ⓫ Judge 
o ⓬ Time
o ⓭ Entry (#)
o ⓮ Rider Name (First, Last)
o ⓯ Horse Name
o ⓰ Test (abbreviation)
o ⓱ Status/Div
o ⓲ Q (if GAIG Qual ride)
o ⓳ Term (terminated, usually 

scratch)

SECTION II. BEFORE THE SHOW

RIDE TIME NOTIFICATION > FVD DAY 
SHEETS STANDARD REPORT:

• There are two FVD reports commonly used to 
provide ride times to competitors:
o Rider’s Schedule Report
o Day Sheets Standard Report (or CDI Report)

1

2

3 4

5

6

Saturday, Jun 20, YYYY

78 9

10

11
12

13

14 15 16 17 18

19
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Ride Time Notification > Save a FVD Report, Post the FVD PDF Reports

• This example will save the Rider’s 
Schedule report.

• If not already open, open the 
report as on the previous page.

• Click ❶ Export > PDF or XPS.

SECTION II. BEFORE THE SHOW

NOTE: In the past, in order to create PDF files, you needed a PDF-Maker program installed on your computer.   
Fortunately, newer versions of Microsoft Office programs contain this utility.  Now it is very easy to create PDF 
files from FVD.  

1

• The ❷ Publish as PDF or XPS form opens.
• Navigate to ❸ Your FVD Folder (or the folder of your choice).
• The default file name is ❹ rptRiderSchedule.pdf.  If desired, change the file name to more closely 

reflect the nature of the file, such as YYYY-BHD-rptRiderSchedule.pdf.
• Click ❺ Publish.
• The file is saved.

RIDE TIME NOTIFICATION > SAVE A FVD REPORT:

2 3

4

5

• Using these 
procedures, save the 
Day Sheets Standard 
Report as a PDF file.

RIDE TIME NOTIFICATION > POST THE FVD PDF REPORTS:

• In your usual manner, post the saved Rider’s Schedule report and the Day Sheets Standard report to 
your organization’s web site or your show’s website.
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Ride Time Notification > Email Ride Times Reports > Email Addresses

• To place the email addresses of all riders 
in your clipboard, select ❶Main Menu 
> ❷ Show Office > ❸ E-mails to 
Clipboard

• A ❼ Fox Village Dressage message opens, 
informing you that the rider e-mails for the 
current show have been copied to your clipboard.

• Click ❽ OK.

7

8

Now that you have posted your ride times on a web site, you need to inform your riders that they are 
available.  You can do this via email message.  Alternatively, you can email the ride times as attachments.  
FVD has a utility for pasting rider, owner, trainer, and coach emails into the clipboard so you can easily 
email all of them in one message.

SECTION II. BEFORE THE SHOW

• The ❹ E-mails to Clipboard form opens.
• Click the ❺ Riders in Show radial button – it fills 

with a black dot.
• If you want to email to owners, trainers, etc., click 

the corresponding radial button(s).
• Click ❻ OK.

4

5

6

1

2

3

RIDE TIME NOTIFICATION > EMAIL RIDE TIMES REPORTS > EMAIL ADDRESSES:

NOTE: Scroll to the bottom of the Show 
Office list to find Emails to Clipboard.
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Ride Time Notification > Email Ride Times Reports > Send Email

• Open your default email program in the usual manner.
• Place your curser in the ❶ To: box and type your email address.
• Place your cursor in the ❷ BCC: (Blind Carbon Copy) and keyboard Ctrl V (keyboard shortcut for Paste).  

Using BCC prevents the disclosure of rider emails to other riders.
• The ❸ rider email addresses are pasted into the BCC: box.
• Type in a ❹ Subject that will let the recipients know it is a legitimate email regarding the show.
• Type a ❺ message to the riders.
• If you want/need to send attachments, attach the ❻ Day Sheet Report and the ❼ Rider’s Schedule 

Report.
• Click ❽ Send.
• The ride times have been sent to the riders!

SECTION II. BEFORE THE SHOW

RIDE TIME NOTIFICATION > EMAIL RIDE TIMES REPORTS > SEND EMAIL:

2
3

4

8

1

5

First1Last1@email.com

5

6

1
2

3

4

7

8

YYYY

YYYY

YYYY-BHD-rptDaySheetsStd.pdf (78K)

YYYY-BHD-rptRiderSchedule.pdf (70K)
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Ride Time Notification > Snail Mail Ride Times > Ride Schedule Mailers

1

2

3

4

• Select ❶Main Menu > ❷ Reports > 
❸ Pre-Show > ❹ Ride Schedule 
Mailers. 

• The ❺ Ride Schedule Mailers form opens.
• Decide what ❻Mailer Style you want to use 

(Self Mailer, Window Envelope, or Standard 
Envelope) by clicking the corresponding radial 
button.  (Self Mailer is the easiest and cheapest 
method as labels and envelopes are not 
required.)

• Click ❼ OK. 

5

6

7

SECTION II. BEFORE THE SHOW

RIDE TIME NOTIFICATION > SNAIL MAIL RIDE TIMES > RIDE SCHEDULE MAILERS:

NOTE: Scroll to the bottom of the Reports 
> Pre-Show list to find Emails to Clipboard.

Continued on next page…
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Ride Time Notification > Snail Mail Ride Times > Ride Schedule Mailers, Cont’d.

• The ❽ Ride Schedule Mailer report 
opens, showing information for each 
entry on a separate page.  The ❾
Global Memo is on each rider’s page.

• Review each entry’s page to ensure it is 
correct. 

• Click the ❿ Print button
o The ⓫ Print form opens.

o To print all the pages, click the ⓬
Print Range > All radial button.

o Click ⓭ OK.
o All the pages will print.

o To print one or a range of pages, click 
⓮ Print Range > Pages.

o In the ⓯ From:  To:  boxes, fill in 
the page number or page number 
range that you want to print.

o Click ⓭ OK. 
o The selected page(s) will print.

• For ⓮ Self Mailer, fold each sheet in thirds, tape, stamp, and mail.
• For ⓯ Window Envelope, fold the sheet in thirds and place in a window 

envelope, stamp, and mail.
• For ⓰ Standard Envelope, fold the sheet in thirds and place in a 

standard envelope.  Create rider mailing labels using ⓱ Mailing Labels.  
Print then affix the labels to the envelopes, stamp, and mail.

SECTION II. BEFORE THE SHOW

8

9

10

11

12

13

NOTE:  This form is printer dependent; 
therefore, your form will look different. 

14

15

16

17
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SECTION II. BEFORE THE SHOW
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Prepare Dressage Tests Sheets > Test Count Report

• Select ❶Main Menu > ❷ Reports > 
❸ Pre-Show > ❹ Test Count Report.  

• The ❺ Test Count report opens.
• Click ❻ Print to print the report, 

as in Day Sheets Report > Use, 
Print.

• If desired, click ❼ Close Print 
Preview to close the report.

• Using the Test Count Report, 
determine how many copies of 
each test you need.  

• Increase the count by at least 10% 
to have extra tests on hand for last 
minute changes, reference copies 
for the judges, etc.

The Test Count Report lets you know how 
many of each dressage test you need for 
your show.

SECTION II. BEFORE THE SHOW

TEST COUNT REPORT:

5

6

7

5

NOTE:  If you are using FVD 
Paperless Scoring, you do not need 
to print the test sheets.  Click here for 
information on the FVD web site.

https://www.foxvillage.com/post?id=22
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Prepare Dressage Tests Sheets > Online Dressage Test Computer Files

• Computer files for the dressage tests are available from the USDF, USEF, and FEI (including Para-
Equestrian Dressage Tests) web sites.  [Eventing tests must be purchased via the USEA web site.]

• Show Management prints the tests for show purposes.
• The tests are rewritten every few years and updated/corrected frequently, so it is best to use the files 

posted on the web sites every time you print dressage tests.
• USEF/USDF Dressage Tests (see Dressage Tests > USEF/USDF):

o Click here to obtain the 2019 USEF/USDF tests via the USDF web site.
o Fees (as of November 2021):
▪ USEF charges a Dressage Ride Fee of $0.45 per Training through Fourth Level ride and a Competition Fee of 

$1.50 per horse in the show (click here for links to the current USEF Post Competition Report online).
▪ USDF charges a Dressage Ride Fee of $15.00 per Training through GP ride and $.45 for each Introductory 

and Freestyle ride (click here links to the USDF Report of Fees online).  
▪ For schooling shows, the tests may be used free of charge.

• FEI Dressage Tests (see Dressage Tests > FEI):
o Click here to obtain the FEI tests via the FEI web site.
o There is no cost per ride.

• FEI Para Equestrian Dressage Tests (see Dressage Tests > FEI Para-Equestrian):
o Click here to obtain the FEI PE tests via the FEI web site.
o There is no cost per ride.

SECTION II. BEFORE THE SHOW

ONLINE DRESSAGE TEST COMPUTER FILES:

https://www.usdf.org/downloads/forms/index.asp?TypePass=Tests
https://www.usef.org/compete/resources-forms/competition-management
https://www.usdf.org/docs/showflash/web/index.asp
https://inside.fei.org/fei/your-role/organisers/dressage/tests
https://inside.fei.org/fei/your-role/organisers/p-e-dressage/tests
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Prepare Dressage Tests Sheets > Paper Size and Colors

• In the USA, dressage tests are printed on 8 ½ x 14 paper.

• Although no longer required, printing different test levels/types on 
different colored paper makes finding tests easier, particularly while 
in the scoring section.  The following are the standard colors with 
links to Amazon.com:
o Introductory - white (can be purchased anywhere!)
o Training – pink (click here)
o First – blue (click here)
o Second – yellow (click here)
o Third – lavender (click here)
o Fourth – green (click here)
o FEI – ivory (click here)
o Eventing – gray (click here)

SECTION II. BEFORE THE SHOW

INTRODUCTORY
TRAINING

FIRST
SECOND

THIRD
FOURTH

FEI
EVENTING

PAPER SIZE AND COLORS:

As of November 2021

http://www.amazon.com/Boise-Fireworx-Colored-Multi-Use-Powder/dp/B001AFM7ZK/ref=sr_1_5?s=office-products&ie=UTF8&qid=1418124374&sr=1-5&keywords=8-1+2+x+14+paper+blue
http://www.amazon.com/Hammermill-Colors-Legal-Sheets-103317R/dp/B000CD0C9Y/ref=sr_1_8?ie=UTF8&qid=1459268991&sr=8-8&keywords=8.5+x+14+paper+blue
http://www.amazon.com/Boise-MP2204-CY-FIREWORX-20-Pound-Crackling/dp/B001AFK92I/ref=pd_sbs_op_3?ie=UTF8&refRID=1WFNSG1QE0JTB2869GJN
https://www.amazon.com/Hammermill-Colored-Printer-Colorful-103788R/dp/B008JFXRIU/ref=sr_1_2?keywords=%228.5+x+14%22+paper+orchid+lavender+lilac&qid=1638034355&sr=8-2
http://www.amazon.com/Boise-MP2204-GN-FIREWORX-20-Pound-Popper-mint/dp/B001AFF9NW/ref=pd_sim_op_1?ie=UTF8&refRID=06YMPFB674A8ERN90S43
http://www.amazon.com/Boise-MP2204IY-Fireworx-Flashing-Ream-CASMP2204IY/dp/B0057V6UVU/ref=sr_1_7?s=office-products&ie=UTF8&qid=1418124696&sr=1-7&keywords=8-1+2+x+14+paper+ivory
http://www.amazon.com/Domtar-Colors-Earthchoice-Opaque-Paper/dp/B008UWVS5G/ref=sr_1_1?s=office-products&ie=UTF8&qid=1418124798&sr=1-1&keywords=8-1+2+x+14+paper+gray
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Prepare Dressage Tests Sheets > Print Dressage Tests

SECTION II. BEFORE THE SHOW

• The ❺ Preferences form specific to your printer 
opens.  The appearance is different for each printer 
type.

• IMPORTANT: Using the ❻ Paper Size drop-down 
arrow, select Legal.  If you do not do this, the image 
will print as 8 ½ x 11 instead of 8 ½ x 14.  Also 
ensure the ❼ Orientation is Portrait.

• If your printer has a duplex feature (prints on both 
sides of the paper; a printer with this feature is 
HIGHLY recommended as it will save you lots of 
time and hassle), using the ❽ Duplex / Booklet
drop-down arrow, select Duplex.

• Click ❾ OK.
• You are returned to the ❸ Print form.
• Using the Test Count Report, select the number of 

❿ Copies you want to print.
• Click ⓫ OK.
• The dressage tests sheets will print.

• Open the test you want to print (see 
Online Test Computer Files or USEF/USDF 
AND FEI DRESSAGE TESTS).  The ❶ PDF 
file will look similar to the diagramClick
the ❷ Print button.

• The ❸ Print form opens.
• Click ❹ Preferences (or Properties).

1
2

5

6

8

9

7

PRINT DRESSAGE TESTS:

NOTE: Each PDF program and printer 
will have different appearances. 

3

4

10

11
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Prepare Dressage Tests Sheets > Open Dressage Test Sheet Labels Report

FVD has a utility to print labels for the dressage tests.

SECTION II. BEFORE THE SHOW

• Select ❶Main Menu > ❷ Reports > 
❸ Pre-Show > ❹ Test Labels.

• The ❺ Test Labels form opens.
• Using the drop-down, select the ❻ Date for 

which you want to print the labels.
• The form gives you the choice of judge location 

to be printed.  First select the ❼ Judge at C.  
(After printing out this set of labels, repeat for 
judges at other locations, if applicable.)

Continued on next page…

OPEN DRESSAGE TEST SHEET LABELS:

1

2

3

4

5

6

7

Saturday, June 20, YYYY
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Prepare Dressage Tests Sheets > Open Dressage Test Sheet Labels Report, Cont’d.

SECTION II. BEFORE THE SHOW

• You have four options for dressage test labels:
o Standard Label / Standard Size (4” x 2”) – sorted by Date / Ring / Ride Time. 
o Standard Label / Small Label (4” x 1-1/3”) – sorted by Date / Ring / Ride Time. 
o CDI Label / Standard Size (4” x 2”) – sorted by Date / Class / Entry # as ride times are assigned later.
o CDI Label /Small Size (4” x 1-1/3”) – sorted by Date / Class / Entry # as ride times are assigned later. 

Standard Label / Standard Size (4” x 2 “)

Do not check 
❽ CDI or     
❾ Small

8
9

Standard Label / Small Size (4” x 1-1/3 “)

Check 
❾ Small

9

CDI Label / Standard Size (4” x 2 “)

8

Check 
❽ CDI

00:00:00

CDI Label / Small Size (4” x 1-1/3 “)

8
9

Check both
❽ CDI and     
❾ Small

00:00:00

NOTE:  This is 
the most used 
size.
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Prepare Dressage Tests Sheets > Print Dressage Test Sheet Labels

• In this example, we will use 
Standard Labels / Standard 
Size.  

• Do not check ❶ CDI or ❷
Small.

• Click ❸ OK.

SECTION II. BEFORE THE SHOW

• The labels print in order of go for each ring; therefore, it is important to keep the original order when 
you put the labels on the tests.

• Place each label in the appropriate position on the appropriate test.  Be very careful to place the correct 
label on the correct test.  Do not cover the judge’s signature space or the scoring lines.  

• For shows with classes that have two or more judges, print the additional labels needed with the second, 
third, etc. judge’s position by selecting the ❺ Judge position and repeat.

• The ❹ Test Labels (Standard) 
report opens for standard labels.

• Check the labels to ensure 
everything is correct.

• See PRINT LABELS AND INDEX 
CARDS for the procedure to print 
labels and index cards.

PRINT DRESSAGE TEST SHEET LABELS:

4

1
2

3

5
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SECTION II. BEFORE THE SHOW
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Stabling > Total Stable Report

• Select ❶Main Menu > ❷ Reports >                 
❸ During-Show > ❹ Total Stable 
report.

• The ❺ Total Stable report opens.  It is 
sorted by Stall Group (entries with no Stall 
Group are first) then by Rider Last Name. 
For each horse/rider combination, it 
provides:
o ❻ Horse Name
o ❼ Rider Name
o ❽ Stall Group (if entered)
o ❾ Horse Sex (needed for stall 

assignments – separate stallions and 
mares)

o ❿ Entry #
o ⓫ Space where the Stall # will be 

located after entry into the FVD 
program

o ⓬ Stable Comments (if entered)
o ⓭ Horse (Stable) or Tack Stall and on 

which days (a check indicates the horse 
will stay that day and night for show 
stalls).

o ⓮ Bedding requested (# of bales)
• The last page of the report provides     
⓯ total # of stalls for each day and    
⓰ total # of bales of bedding (assume 
more bedding will be requested during 
the show)

SECTION II. BEFORE THE SHOW

• Using a Stall Layout Plan for the facility 
(you will need to get the specific stall 
numbers and location from the facility 
owner/operator or from past shows), 
make a tentative stall assignment sheet 
by hand.  

• Ensure you:
o Keep requested Stall Groups together. 
o Place stallions in stallion proof stalls. 
o Mares and stallions should not be in 

adjacent stalls.
o Do not use stalls that need repair, etc.

TOTAL STABLE REPORT:

6
7

8

5

9

10

11

12 13

14

15 16

14
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Stabling > Enter Stall Numbers in FVD

• You need to enter the stall number for 
each of the stalls you may use at the 
show facility.  This can be done during 
Edit a Show Template > Stalls, during Set 
Up a New Show > Stalls, or after the stalls 
have been assigned by hand.

• Select ❶Main Menu > ❷ Show Office 
> ❸ Stalls.

7

8

• The ❹ Stalls form opens.
• Using the ❺ Add Stall button, enter the 

numbers of all the stalls.
• To ensure the stall numbers sort numerically, for 

stall 1-9, enter them as 01-09 (if you have over 
99 stalls, use 001-099).

• To delete a stall, click the white box next to the 
stall number (the box turns black) then click the 
❻ Delete Stall button.  

• A ❼ Fox Village Dressage warning message 
opens.

• To delete the selected stall number, click ❽ Yes.

• Click ❾ Close when you have entered all the stalls.

1

2

3

NOTES: 
• If you are using a Show Template, the stall numbers may already be entered.
• For stall numbers 1-9, enter them as 01-09 as this facilitates sequential sorting in the FVD program.  If the 

facility has more than 99 numbered stalls, number the stalls 001, 002, 003, …, 010, 011, …, 099, 100, etc.  
[For computer nerds: this is required as stall number is a text field, not a number field.]

• You may want to enter both the barn name/number and the stall number.  In the example we will use, 
Barn 1 is the barn number and 01, 10, 11, etc. are the stall numbers.   You are allowed a maximum of 10 
letters and numbers so you may need to use abbreviations for barn names.

• Some stalls at some facilities may be in disrepair, in use by another event, etc.  Therefore, before you assign 
stalls, go to the facility and inspect the stalls.

SECTION II. BEFORE THE SHOW

9

ENTER STALL NUMBERS IN FVD:

5 6

4
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Stabling > Assign Stall Numbers

• Next you need to enter the assigned stall 
number for each horse (stable) and tack 
stall.

• Select ❶Main Menu > ❷ Show Office 
> ❸ Entries.

• The ❹ Entry form opens 
with the first Entry #
displayed.

• If not already displayed, use 
the ❺ Switch to … button 
to switch to ❻ Entry 
(Lookup).

• To select the Entry # for 
which you want to enter 
stall numbers, use the ❼
Entry (Lookup) drop-down 
arrow or type the Entry # in 
the ❽ Entry (Lookup) box.

• Click on the ❾ Stabling 
Fees tab.

• Using the ❿ Stall # drop-
down arrow, select the 
assigned horse Stall # (and 
the tack stall #, if 
requested).

• Use the ⓫ Next Entry 
button to move to the next 
entry.

• Repeat steps 10 - 11 until all 
entries that have requested 
stalls (horse stalls and tack 
stalls) have them assigned in 
the FVD program.

• Click ⓬ Close to return to 
the Main Menu.

• Open the Total Stable Report 
to check your assignments.

NOTE: See MAKE A STALL LIST FROM DATA EXPORTED TO EXCEL for information on using MS Excel to make a 
stall list that you can sort by stall number, rider name, and horse name, and distribute to competitors, post on 
your web site, etc.

SECTION II. BEFORE THE SHOW

NOTE: FVD does not prevent inadvertent assignment of a stall more than once.  Ensure you do not do this!

ASSIGN STALL NUMBERS:

4

8

9

5
6

7

10

11 12
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Stabling > Print Stable Cards and Tack Stall Cards

• Select ❶Main Menu > ❷ Reports > 
❸ During Show > ❹ Stable Cards.

SECTION II. BEFORE THE SHOW

1

2

3

4

After you have assigned the stall and tack stall numbers in the FVD program, you can print the 3” x 5” Stable 
/ Stabling Cards or 2” x 4” Stable / Stabling Labels.  They are fastened to the stalls so riders know they are 
using the correct stall.

• The ❺ Stable Cards form opens.
• First select ❻ Stabling Cards to create cards for 

horse stalls.
• If you want small cards, click ❼ Small.
• Click ❽ OK.

5

6

7

8

PRINT STABLE CARDS AND TACK STALL CARDS:
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Stabling > Print Stable Cards and Tack Stall Cards, Cont’d.

SECTION II. BEFORE THE SHOW

• The ❾ Stabling Cards report opens.  
• Examine the report for errors, etc.
• The standard size is printed onto 3” x 5” laser index cards. See PRINT LABELS AND INDEX CARDS for the 

procedure to print labels and index cards.
• The small size is printed onto 2” x 4” shipping labels. See PRINT LABELS AND INDEX CARDS for the 

procedure to print labels and index cards.

STANDARD SIZE – 3” x 5” LASER INDEX CARDS SMALL SIZE – 2” x 4” SHIPPING LABELS

9 9

• To print the Tack Stall Cards, repeat Steps 1-9 above, selecting Tack Stall Cards in Step 6.

• The cards/labels are sorted by Stall Group.  Resort the horse and tack stall cards according to your stall 
list.

• Prior to arrival of horses at the show, apply stall cards to stalls.  Depending upon the facility, they can be 
affixed with tape, stapler gun, or using a facility-supplied clip or holder.

• Print several of your stall lists and post them in convenient places.  It is helpful to get them laminated or 
put them in document protectors. 

• If desired, send the stall assignments out with the ride times or post on your web page.  (Some shows do 
not provide stall assignments until horses arrive at the show.  This helps prevent the unloading of horses 
prior to submission of the Coggins and vaccinations reports.)

NOTE: The FVD program also provides Stable Labels that can be used in lieu of the Stable Cards and can also 
be placed on show packets.  See During Show > Stable Labels for further information.
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Rider Packet Labels/Sheets > Types of FVD Rider Packet Labels/Sheets

• When they check-in with the show office, riders may receive a packet containing their bridle number, 
show program, and other inserts determined by show management.  The FVD program creates labels or 
sheets for the rider packets.

• You have a choice of three types of Rider Packet Labels:
A. Packet Labels (Detail): Label that details entry deficiencies that must be corrected.
B. Packet Labels (Standard): Label that has just the Entry #, rider name, and horse name. 
C. Packet Sheets: Half sheet of paper with entry deficiency information; the paper is either inserted in 

the envelope or stapled to the front of the envelope.

• Obtain a sufficient number of envelopes for the number of riders.  Most shows use a 9” x 12” envelope.  
Many colors are available.  A smaller sized envelope may be used if you do not have any large handouts.

C. Packet Sheet
8 ½” x 5 ½” Paper

(Prints 2 per 8 ½” x 11” 
Sheet of Paper) 

B. Packet Label (Standard)
4” X 2” Label
(Avery 5163)

A. Packet Label (Detail)
3½” X 5” Label
(Avery 5168)

TYPES OF FVD RIDER PACKET LABELS/SHEETS:

NOTE: The Packet Label (Detail) and the 
Packet Sheet list ❶ deficiencies noted 
within the entry and on the Need List.

1

1
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Rider Packet Labels/Sheets > Rider Packet Labels (Standard) – 4” x 2” Label

• Select ❶Main Menu > ❷ Reports >                
❸ Pre-Show >  ❹ Packet Labels 
(Standard).

1

2

3

4

• The ❺ Packet Labels (Standard) report 
opens.

• See PRINT LABELS AND INDEX CARDS for 
the procedure to print labels and index 
cards.

• Apply labels to rider packet envelopes and load with bridle number, show program, and other items for 
the riders. 

• Store in alphabetical order, by rider last name, at the show office check-in desk.

NOTE: Some shows do not use envelopes.  
They affix the Packet Labels to the bridle 
numbers.

This label has just the Entry #, rider name, 
and horse name.  It does not list entry 
deficiencies.

NOTE: The Rider Packet Labels (Standard) do not include the stall number.  To include the stall number on the 
rider packet, also use Stable Labels that can be attached to the Rider Packets.

RIDER PACKET LABELS (STANDARD):

RECOMMENDATION: Use this label for Rider 
Packets and use the Create Custom Entry 
Packet Labels for Entry Packets.

5
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Rider Packet Labels/Sheets > Rider Packet Labels (Detail) – 3½” x 5” Labels

• Select ❶Main Menu > ❷ Reports >                 
❸ Pre-Show > ❹ Packet Labels 
(Detail).

1

2

3

4

• The ❺ Packet Labels (Detail) report 
opens.

• See PRINT LABELS AND INDEX CARDS for 
the procedure to print labels and index 
cards.

• Apply labels to rider packet envelopes & load with bridle number, program, & other items for the riders. 
• Store the rider packets in alphabetical order, by rider last name, at the show office check-in desk.

NOTE: The Rider Packet Labels (Detail) do not include the stall number.  To include the stall number on the rider 
packet, use Stable Labels (Small) that can also be attached to the Rider Packets.

RIDER PACKET LABELS (DETAIL):

5

This label details entry deficiencies that 
must be corrected.

RECOMMENDATION: Use this label for Rider 
Packets and use the Create Custom Entry 
Packet Labels for Entry Packets.



Fox Village Dressage User Manual – 2021 Update 1.0.5. helpdesk@foxvillage.com                 www.foxvillage.com316

Rider Packet Labels/Sheets > Rider Packet Sheets – 8½” x 5½” Sheets

• Select ❶Main Menu > ❷ Reports >                
❸ Pre-Show > ❹ Packet Sheets.

SECTION II. BEFORE THE SHOW

• The ❺ Packet Labels report opens.
• Use 8½” x 11” paper.
• Prints two to an 8 ½ x 11 page.
• To print the sheets, click the ❻ Print

button.
• Cut each sheet in half and affix to the 

rider packets via staple, tape or paper 
clip.

• Cut the sheets in half and tape or staple to rider packet envelopes.
• Load the envelopes with bridle number, show program, and other items for the riders. 
• Store in alphabetical order, by rider last name, at the show office check-in desk.

Half sheet of paper with entry deficiency 
information; the paper is either inserted in 
the envelope or stapled to the front of the 
envelope.

NOTE: The Rider Packet Sheets do not include the stall number.  To include the stall number on the rider packet, 
also use Stable Labels that can be attached to the Rider Packets.

1

2

3

4

5

6

RIDER PACKET SHEETS:

RECOMMENDATION: Use this label for Rider 
Packets and use the Create Custom Entry 
Packet Labels for Entry Packets.
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Day Sheets Reports > Overview

❶ Day Sheets CDI Report:  Used for CDIs; may be used for non-CDIs.  Provides more detail than the other 
reports. 
❷ Day Sheets Standard Report: Used for non-CDI shows.
❸ Day Sheets Scoring Report:  Similar to Day Sheets Standard Report but has a ❹ Finished column to 
indicate the scoring is completed (put a check or the final score in the column) and has a ❺ Hold column 
so the scoring department and/or awards department knows to not release a test or ribbon until cleared by 
the show office.  See Hold for information about hold.

FVD provides three Day Sheets Reports that are key reports for running your show. 

SECTION III. DURING THE SHOW

OVERVIEW:

1

2

3

4
5

• Who needs copies of a Day Sheet Report?
o Show Secretary.  Will need a copy for pre-

show work.
o Show Program Committee.  The report is 

usually in the Show Program).
o At the beginning of each show day (or late the 

evening before), new updated copies that 
reflect any changes will be needed for:  
➢ Show Office. Posted at the show office.
➢ Show Secretary.
➢ Scribe(s). As a minimum, provide Day 

Sheets for the classes appearing before 
their judge; however, since judges often 
want to see Day Sheets for the entire show, 
provide a full set. The scribe Day Sheets 
should be provided with the packet of tests 
for the day.

➢ Technical Delegate(s).
➢ Announcer. Or use Announcer’s Report.
➢ Warm-up Ring Steward(s).  Or use Ring 

Stewards’ Report)
➢ Show Ring Steward(s).  Or use Ring 

Stewards’ Report.
➢ Scoring Office.   Or use Day Sheets Scoring 

Report.
➢ Awards Manager.   Or use Day Sheets 

Scoring Report.
➢ Photographer.
➢ Videographer.
➢ Media.
➢ Others.
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Day Sheets Reports > Day Sheets CDI Report

• Select ❶Main Menu > ❷ Reports > 
❸ During-Show > ❹ Day Sheets CDI.

• The ❺ Day Sheets form opens.
• If you want to open all days of the show, 

click ❻ OK.
• If you want to print one day, using the ❼

Date drop-down arrow, select the date 
for which you want to print Day Sheets.

• Click ❻ OK.

• The ❽ CDI Day Sheets report opens, which shows the sequence of rides by ❾ Ring number, ❿ Class , 
and ⓫ Times, which are listed by the order of go.

SECTION III. DURING THE SHOW

DAY SHEETS CDI REPORT:

5

6

7

1

2

3 4

8
9

10

11
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Day Sheets Reports > Day Sheets Standard Report

• Select ❶Main Menu > ❷ Reports > 
❸ During-Show > ❹ Day Sheets 
Standard report.

• The ❺ Day Sheets form opens.
• If you want to open all days of the show, click ❻ OK.
• If you want to print one day, using the ❼ Date drop-

down arrow, select the date for which you want to 
print Day Sheets.

• Click ❻ OK.

• The ❽ Day Sheets report opens, 
which shows the sequence of rides 
by ❾ Ring number, ❿ Class , and 
⓫ Times, which are listed by the 
order of go.

SECTION III. DURING THE SHOW

5

6

7

DAY SHEETS STANDARD REPORT:
1

2

3 4

8
9

10

11
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Day Sheets Reports > Day Sheets Scoring Report

• Select ❶Main Menu > ❷ Reports > 
❸ During-Show > ❹ Day Sheets 
Scoring report.

• The ❺ Day Sheets form opens.
• If you want to open all days of the show, click ❻ OK.
• If you want to print one day, using the ❼ Date drop-

down arrow, select the date for which you want to print 
Day Sheets.

• Click ❻ OK.

• The ❽ Day Sheets (Scoring) report 
opens, which shows the sequence of 
rides by ❾ Ring number, ❿ Class , 
and ⓫ Times, which are listed by the 
order of go.

• This report is provided to the scoring 
department and the awards 
department.  
o They use the ⓬ Finished column 

to indicate the ride has been 
scored or the test sheet has been 
received (awards).

o They refer to the ⓭ Hold column 
to determine if tests and ribbons 
need to be withheld until cleared 
by the show secretary.  See Hold
for information on hold.

SECTION III. DURING THE SHOW

5

6

7

DAY SHEETS SCORING REPORT:
1

2

3
4

8
9

10

11 12
13
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Day Sheets Reports > Print a Day Sheets Report

PRINT A DAY SHEETS REPORT:

SECTION III. DURING THE SHOW

1

• Open the Day Sheet report you want to print.
• Click the ❶ Print button

• The ❷ Print form opens.

• To print all the pages, click the ❸ Print Range / All radial button.
• Click ❹ OK.
• All the pages will print.

• To print one or a range of pages, click ❺ Print Range / Pages.
• In the ❻ From:  To:  boxes, fill in the page number or page number range that you want to print.
• Click ❹ OK. 
• The selected page(s) will print.

2

3

4

5
6
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Scribing > Introduction

• Scribing is the process by which movement POINTS, collective POINTS, and ERRORS are recorded on a 
dressage score sheet.  Traditionally, one scribe sitting with a judge in a judge booth records the judge 
POINTS, ERRORS and remarks by hand on a paper score sheet.  Today, there are also digital methods of 
scribing.

• FVD provides the following scribing methods:
1. Traditional Paper Score Sheets: One scribe in the judge booth writes POINTS and ERRORS on 

traditional paper score sheets.  Runners take the paper score sheets to the scoring section personnel, 
who calculate FINAL POINTS and FINAL PERCENTS.

2. FVD eScribe Mode:  Two scribes are in the judge booth.  One scribe records judge POINTS, ERRORS
and remarks on a traditional paper scoresheet that is taken to the scoring section, which calculates 
FINAL POINTS and FINAL PERCENT.  A second scribe in the judge booth records POINTS and ERRORS
on a wired network computer/laptop using the eScribe Mode of FVD.  The eScore POINTS may be 
displayed on a large ring-side monitor (and elsewhere) for instant results.  The traditional paper score 
sheet POINTS and ERRORS are usually the official results.  The scoring section compares digital 
POINTS and ERRORS and paper score sheet POINTS and ERRORS then determines FINAL POINTS and 
FINAL PERCENTS.  The class is then placed.

3. FVD Cloud Server:  An easy method to wirelessly network a variety of show devices (PC and MAC 
computers, laptops, tablets, smart phones, etc.) and digitally scribe in the judge booth.  A paper score 
sheet is no longer used as a digital score sheet is created.  The scoring section has access to the 
POINTS and ERRORS and places each class.  Entrants receive a digital score sheet.  

SCRIBING > INTRODUCTION: NOTE:  See TERMINOLOGY IN THIS MANUAL for 
scribing/scoring nomenclature used in this manual. 

1. Traditional Paper Score Sheet

2. FVD eScribe Mode

3. FVD Cloud Server

NOTE: Click here for Paperless Show Setup (on 
the FVD web site).  This entails an additional fee.

https://www.foxvillage.com/post?id=22
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eSCRIBE MODE:

326

Scribing > eScribe Mode

• Ensure you are using Standard Scoring.
• Click ❶ Main Menu > ❷ Scoring.
• Click the ❸ padlock button.

• An ❹ eScribe Mode form opens.  
• Follow the instructions on the box.
• Click ❺ OK.

5

4

Continued on next page…

NOTE:  eScribe mode only works with Standard Scoring; it does not work with Manual Scoring.
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Scribing > eScribe Mode, Cont’d.

• ❻ The screen now has this appearance.
• The computer user only has access to the 

scoring features of FVD.

• Before a class starts, select the class using 
❼ Class (Lookup) then click ❽ Score.

• The ❾ Scoring - C (or other judge 
position letter) screen opens.

• Before a ride starts, select the entry using 
❿ Entry (Lookup).

• Enter the movement ⓫ POINTS for each 
movement as they are called out by the 
judge.

• Enter the collective ⓬ POINTS as they 
are called out by the judge.

• Enter ⓭ Errors, if needed.
• Enter ⓮ Term Reason, if needed.

• Before the following ride starts, repeat 
starting at ❿ Entry (Lookup).

• When a class is completed, click ⓯
Close.

• For the following class, repeat starting at 
❼ Class (Lookup).

• When eScribing is finished:
o Click the ⓰ padlock icon.
o The ⓱ eScribe Mode form opens.
o Enter the ⓲ 4-digit code.
o Click ⓳ OK to close eScribe Mode.

9

10

11

12

13

14

15

7

8

6
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Scribing > FVD Cloud Server

• Easy Method to Connect Show Devices:
o FVD Cloud Server is an easy method now available to FVD users to connect show devices for file 

sharing.
o It uses the FVD Cloud Server; all FVD files are on the server.
o Users may use a desktop or laptop (Windows or MacOS) or tablet (Windows, Android or iOS).
o Show devices no longer require a wired connection between them; however, each requires its own 

wired, Wi-Fi or cellular internet connection.
o Scribes may enter POINTS, ERRORS and judge comments near the judge or at a remote location (a 

talking communication method between judge and scribe is necessary). POINTS, ERRORS and judge 
comments input by the scribe are on the FVD Cloud Server.

o The show office uses the scores on the FVD Cloud Server to place classes and post results.
• Paperless Scoring:
o FVD Cloud Server also offers a paperless method of scoring that directly uses the FVD Cloud Server for 

recording POINTS, ERRORS and judge comments in the cloud.  
o The paperless method is a safer method of scoring in this day of infectious diseases as a dressage test 

sheet does not have to pass from secretary > scribe > judge > runner > scoring > awards.  Instead, the 
competitor obtains their test sheet online.

• See FVD CLOUD SERVER for details.

FVD CLOUD SERVER > WHAT IS FVD CLOUD SERVER?:

Windows 
Desktop Windows 

Laptop

Windows 
Tablet

MacOS 
Desktop

MacOS 
Laptop

iOS 
TabletAndroid 

Tablet

FVD CLOUD SERVER SHOW DEVICES

NOTE: When you 
use a tablet, it is 
easier if you also 
use a compatible 
keyboard and 
mouse.
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Scoring > Introduction

• Prior to 2016 scoring was reasonably simple.  It was the process of (1) multiplying movement and 
collective POINTS by coefficients to give the TOTAL POINTS, (2) adding the TOTAL POINTS to determine 
SUBTOTAL POINTS, (3) deducting for ERRORS to determine the (4) FINAL POINTS, and ultimately 
calculating the (5) FINAL PERCENT that determines the class placing.

• Since then, scoring has become more complex:  
o The calculations for USEF/USDF tests have not changed.  
o FEI now has (1) OTHER ERRORS (points subtracted from the subtotal points) AND (2) ERRORS OF 

COURSE (percent subtracted from calculated percent).  This is much more complicated and requires a 
lot of extra math.  

• The following pages will hopefully explain the rules and the math.  

• Before discussing FVD scoring methods, this manual will cover USEF/USDF and FEI error rules; scoring 
terminology on USEF/USDF and FEI test sheets and FVD, error management, terminology used in this 
manual, and examples of calculations.

• FVD performs many of the calculations for you; however, you still need to know what you are doing!

• This chapter covers basic scoring procedures.  For additional procedures, see SCORING.

INTRODUCTION:
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Scoring > Errors > USEF Rule

USEF DR122.5. Errors.
a. When a competitor makes an “error of the course” (takes the wrong turn, omits a movement, etc.) the President of the Jury warns him 

by sounding the bell. The President shows him if necessary the point at which he must take up the test again and the next movement 
to be executed then leaves him to continue by himself. However, in some cases when, although the competitor makes an “error of the 
course”, the sounding of the bell would unnecessarily impede the fluency of the performance for instance if the competitor makes a 
transition from medium trot to collected walk at V instead of at K or cantering up the center line from A makes a pirouette at D instead 
of at L it is up to the President to decide whether to sound the bell or not. However, if the bell is not sounded at an error of course, or 
error of test in which the movement, or a requirement of the movement, is repeated and the error occurs again, only one error is
recorded. If a rider performs in a rising trot when a sitting trot is required, or vice versa, the bell must be sounded and the rider warned 
that this is an error that accumulates if repeated, leading to elimination at the third occurrence.

b. In National [USDF/USEF] tests, every “error of the course” whether the bell is sounded or not, must be penalized, except as noted 
above: 
1. The first time by 2 points.
2. The second time by 4 points; [6 points total].
3. The third time the competitor is eliminated. However, at the discretion of the judge, the rider may continue to finish the test. If the 

competitor’s continued presence in the ring is about to interfere with the start of the next scheduled ride, then the judge must
excuse him/her from the ring. 

c. In FEI tests [FEI YR thru GP] (except those listed under “c.3” and “d” below), every “error of the course” whether the bell is sounded or 
not, must be penalized, except as noted above: 
1. The first time by 2 percentage points from the total score received; 
2. The second time by elimination; However, at the discretion of the judge, 

the rider may continue to finish the test. If the competitor’s continued presence 
in the ring is about to interfere with the start of the next scheduled ride, then the 
judge must excuse him/her from the ring.

3. For FEI Para-Equestrian tests, refer to the test sheets for the calculation of errors. 
d. For USEF and FEI Young Horse tests, and FEI Children, Pony Riders and Junior tests, 

the deduction for an error shall be: 
1. First error: -0.5% (1/2 percentage point) from total score received.
2. Second error: -1.0% (one percentage point) from total score received.
3. Third error: Elimination.

e. For FEI Level and USDF Freestyle tests, two points will be deducted for each error, however they are not cumulative and will not 
result in elimination.

f. When the competitor makes an “error of the test” (trots rising instead of sitting; at the salute does not take the reins in one hand, etc.) 
he must be penalized as for an “error of the course”. In principle, a competitor is not allowed to repeat a movement of the test unless 
the President of the Jury decided on an error of course (rings the bell). If, however, the rider has started the execution of a movement 
and attempts to do the same movement again, the judge(s) must consider the first movement shown only and, at the same time 
penalize for an error of course.

g. If the Jury has not noted an error the competitor has the benefit of the doubt.
h. The decision as to whether or not an error of course has been made will be that of the judge at C. The other judges’ scores will be 

adapted accordingly upon approval of the judge at C.
i. The penalty points are deducted on each judge’s sheet from the total points obtained by the competitor.
j. Other Errors. For USEF High Performance qualifying and selection trials, all of the following are considered errors (faults), and two (2) 

points will be deducted per error (fault) by each judge, but they are not cumulative and will not result in elimination (including for 
Freestyle tests): 
1. Entering the space around the arena with whip or with boots on the horse’s legs or with discrepancy in dress (e.g. lack of gloves);
2. Entering the dressage arena with whip or with boots on the horse’s legs or with discrepancy in dress (e.g. lack of gloves). Exception: 

Carrying the whip for more than three movements will entail elimination;
3. Not entering the arena within 45 seconds but before 90 seconds after the bell;
4. Entering the arena before the sound of the bell;
5. In Freestyle classes, entering the arena after more than 20 seconds of music but within 90 seconds.
6. If the Freestyle test is longer or shorter than stipulated on the test sheet, zero point five percentage points (0.5%) will be deducted 

from the total artistic score;
7. Using voice or clicking the tongue repeatedly;
8. Athletes not taking the reins in one (1) hand at the salute. 

k. Judges may not mark or deduct points for an error for any reason other than as described in DR122.5; i.e. dress code violations (DR120) 
cannot be penalized by an error. 

l. For USEF High Performance qualifying and selection trials, if the Freestyle test is longer or shorter than the stipulated time on the test 
sheet, zero point five percent (0.5%) will be deducted from the total artistic score. 

As of November 2021 – check USEF web site for any changes.

[6 points total]

[-2 for each other error, no elimination]

[1.5% total]
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Scoring > Errors > FEI Rules

FEI ARTICLE 430  EXECUTION OF THE TESTS
3. Error of course. When an Athlete makes an “error of course” (takes the wrong turn, omits a movement, etc.) the Judge at C 

warns him [or her], by sounding the bell. The Judge at C shows him [or her], if necessary, the point at which he [she] must take
up the test again and the next movement to be executed, then leaves him to continue by himself. However, in some cases when, 
although the Athlete makes an “error of course”, the sounding of the bell would unnecessarily impede the fluency of the 
performance - for instance if the Athlete makes a transition from medium trot to collected walk at V instead of at K, or, cantering 
up the centre line from A, makes a pirouette at D instead of at L - it is up to the Judge at C to decide whether to sound the bell or 
not. However, if the bell is not sounded at an error of course and the test requires the same movement to be repeated and the
Athlete again makes the same error, the Athlete is only penalised once. 

The decision as to whether or not an error of course has been made will be at the sole discretion of the Judge at C. The other 
Judges’ scores will be adapted accordingly.

4. Error of test/execution. When an Athlete makes an “error of the execution of the test” (trots rising instead of sitting, etc.) he 
must be penalised as for an “error of course”. In principle an Athlete is not allowed to repeat a movement of the test unless the 
Judge at C decides on an error of course (sounds the bell). If, however, the Athlete has started the execution of a movement and
attempts to do the same movement again, the Judges must consider the first movement shown only and at the same time, 
penalise for an error of course.

5. Unnoticed error. If the Ground Jury has not noted an error, the Athlete has the benefit of the doubt and will therefore not be 
penalised for the error.

6. Penalties

6.1. Error of Course. 
[For YR through GP] Every “error of course”, whether the bell is sounded or not, must be penalised, except as noted above. 

First error: Two (2) percentage points from the total score (per Judge).
Second error: Elimination.

For Young Horses tests, Children, Pony Riders and Junior tests:
First error: Zero point five percentage points (0.5%) from the total score [percent].
Second error: One percentage point (1%) [total of 1.5%]
Third error: Elimination

6.2. Other Penalties. 
It is the responsibility of the Judge at C to decide whether a penalty should be applied and the other judges sheets should be 
marked accordingly to ensure consistency.
All of the following are considered faults, and two (2) points will be deducted per fault by each Judge, but they are not 
cumulative [????} and will not result in Elimination (including for Freestyle tests):
− Entering the space around the arena with whip or with boots on the Horse’s legs or with discrepancy in dress (e.g. lack of 

gloves)
− Entering the Dressage arena with whip or with boots on the Horse’s legs or with discrepancy in dress (e.g. lack of gloves). If 

the test has already started before the discrepancy has been noticed, the Judge at C stops the Athlete and if needed and 
possible, an assistant may enter the arena to remove the item(s). The Athlete then continues the test, either starting from the 
beginning (from the inside of the fence) or from the movement where he was stopped. The marks given before he was 
stopped are not changed

− Entering the arena before the sound of the bell
− Not entering the arena within forty five (45) seconds after the bell, but within ninety (90) seconds
− For Freestyle tests, entering the arena after more than thirty (30) seconds of music
− If the Freestyle test is longer or shorter than stipulated on the test sheet, zero point five percentage points (0.5%) will be 

deducted from the total artistic score
− Using voice or clicking the tongue repeatedly
− Athletes not taking the reins in one (1) hand at the salute.

6.3 Penalty Points. The penalty points are deducted on each Judge’s sheet from the total points obtained by the Athlete.

As of 31 March 2020 – check FEI web site for any changes

[1.5% total]
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Scoring > Test Sheet and FVD Terminology > Most USEF/USDF Tests

USDF/USEF TEST SHEET FVD STANDARD SCORING

❶ POINTS:  Score given to each dressage movement or 
collective.

FVD does not have a term for POINTS  The points for each 
movement is entered in the ❶ left (red text) box.

❷ COEFFICIENT: Important dressage movements have a 
coefficient of 2 or 3.  For such movements, the points/mark 
earned are multiplied by the coefficient.

Coefficients are not listed on the FVD form.  

❸ TOTAL: Points x Coefficient ❸ Standard Marks and Collective Marks. Points/Marks x 
Coefficient.  Automatically calculated by FVD and entered in 
the right (black bold text) box.

❹ SUBTOTAL: Sum of TOTAL before errors are subtracted. The subtotal is not on the FVD form.

❺ ERRORS: Points lost due to errors (-2 or -6 points). ❺ Errors: Calc is used for USEF/USDF tests.  See below for 
instructions on how to calculate USEF/USDF errors in FVD.

❻ TOTAL POINTS = Final Score > Points: SUBTOTAL minus 
any ERRORS

❻ Score Results > Final Score:  Automatically calculated by 
FVD.  Total of all Standard Marks minus any Errors (-2 or -6).  

❼ Final Score > Percent: (TOTAL POINTS / Max Points) * 100 ❼ Score Results > Percentage Automatically calculated by 
FVD.  (Final Score / max marks) x 100.  

1 3

FVD STANDARD SCORING FORM

6 7

5

1 3

EXTRACTS FROM USEF DRESSAGE TEST SHEET

1 32

4
5

6

6 7
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Scoring > Test Sheet and FVD Terminology > FEI YH, Children, Pony & Junior Tests

FEI JUNIOR INDIVIDUAL TEST FVD STANDARD SCORING

❶ Mark and Collective Mark   Each movement/collective 
earns a mark from 0 - 10 with 0.5 decimal increments. 

FVD does not have a term for Mark.  The marks (points) for 
each movement is entered in the ❶ left (red text) box.

❷ Coefficient: Important dressage movements have a 
coefficient of 2 or 3.  For such movements, the points/mark 
earned are multiplied by the coefficient.

Coefficients are not listed on the FVD form.  

❸ FINAL MARK: Mark or Collective Mark x Coefficient ❸ Standard Marks / Collective Marks. Points/Marks x 
Coefficient.  Automatically calculated by FVD and entered in 
the right (black bold text) box.

❹ Total: Sum of FINAL MARKS before errors are subtracted. The Total is not on the FVD form.

❺ To be deducted / penalty points: Percent and points
(marks) lost due to errors

❺ Errors: Use 2% for percent deducted.  Use Calc for points 
deducted.  See below for instructions on how this is 
calculated.

❻ TOTAL: Total minus penalty points (-2 points/marks per 
other error)

❻ Score Results > Final Score:  Automatically calculated by 
FVD.  Total of all Standard Marks minus any Errors (-2 or -6).  

❼ TOTAL SCORE in %: (Total / Max Points) x 100 ❼ Score Results > Percentage Automatically calculated by 
FVD.  (Final Score / max marks) x 100.  

1 3

FVD STANDARD SCORING FORM

5

6 7

4

1

EXTRACTS FROM FEI JUNIOR INDIVIDUAL TEST

6

5

2 3

1 2 3

7

1 3

1 3

NOTE:  The actual error deductions are more complicated than demonstrated on these forms.  
See EXAMPLE CALCULATIONS > FEI YH, CHILDREN, PONY & JUNIOR TESTS for details.
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Scoring > Test Sheet and FVD Terminology > FEI Young Rider Through Grand Prix Tests

1 3

FVD STANDARD SCORING FORM

6 7

51 34

1 32

EXTRACTS FROM FEI GRAND PRIX TEST SHEET

5

6 7

1 32

FEI GRAND PRIX TEST FVD STANDARD SCORING

❶ Mark and Collective Mark   Each movement/collective 
earns a mark from 0 - 10 with 0.5 decimal increments. 

FVD does not have a term for Mark.  The marks (points) for 
each movement is entered in the ❶ left (black text) box.

❷ Coefficient: Important dressage movements have a 
coefficient of 2 or 3.  For such movements, the points/mark 
earned are multiplied by the coefficient.

Coefficients are not listed on the FVD form.  

❸ FINAL MARK: Mark or Collective Mark x Coefficient ❸ Standard Marks. Points x Coefficient.  Automatically 
calculated by FVD and entered in the right (black bold text) 
box.

❹ Total: Sum of Final Marks before errors are subtracted. The Total is not on the FVD form.

❺ To be deducted / penalty points: Percent and points
(marks) lost due to errors

❺ Errors: Use 2% for percent deducted.  Use Calc for points 
deducted.  See below for instructions on how this is 
calculated.

❻ TOTAL: Total minus penalty points (-2 points/marks per 
other error)

❻ Score Results > Final Score:  Automatically calculated by 
FVD.  Total of all Standard Marks minus any Errors (-2 or -6).  

❼ TOTAL SCORE in %: (Total / Max Points) x 100 ❼ Score Results > Percentage Automatically calculated by 
FVD.  (Final Score / max marks) x 100.  

NOTE:  The actual error deductions are more complicated than demonstrated on these forms.  
See EXAMPLE CALCULATIONS > YOUNG RIDERS THROUGH GRAND PRIX for details.
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Scoring > Terminology Used in this Manual

NOTE: Test sheets and FVD do not use the above nomenclature.  It is being used by this 
author for this manual in an attempt to clearly describe scoring for the MANY test types.

TERMINOLOGY USED IN THIS MANUAL:

USEF/USDF TESTS FEI TESTS DESCRIPTION

POINTS POINTS Each number awarded by the judge for each 
movement and collective

TOTAL POINTS TOTAL POINTS POINTS x Collective (if applicable)

SUBTOTAL POINTS SUBTOTAL POINTS Sum of all TOTAL POINTS

ERROR POINTS ERROR POINTS Number subtracted due to errors (USEF/USDF) or 
other errors (FEI)

FINAL POINTS PRELIMINARY POINTS SUBTOTAL POINTS minus ERROR POINTS.  

FINAL PERCENT PRELIMINARY PERCENT (PRELIMINARY POINTS / Max Points) x 100.  

NA ERROR PERCENT Error percent subtracted from PRELIMINARY 
PERCENT, as defined by FEI for the particular 
test.

NA FINAL PERCENT PRELIMINARY PERCENT minus ERROR PERCENT

NA FINAL POINTS (FINAL PERCENT * Max Points ) / 100

For multiple judges (multiple test sheets):  
• Mean of USEF/USDF FINAL PERCENT or FEI FINAL PERCENT = MEAN FINAL PERCENT.
• Mean of USEF/USDF FINAL POINTS or FEI FINAL POINTS = MEAN FINAL POINTS.  
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Scoring > Example Calculations > USEF/USDF Tests

EXAMPLE CALCULATIONS > USEF/USDF:

POINTS COEFFICIENT
TOTAL 
POINTS

6 6

7 2 14

etc etc etc

Sum = 
SUBTOTAL 

POINTS

SUBTOTAL POINTS

- ERROR POINTS

FINAL POINTS

/ Max Points

* 100

FINAL PERCENT

SUBTOTAL POINTS 200

- ERROR POINTS 0

FINAL POINTS 200

/ Max Points: 0.68966

x 100 68.966

FINAL PERCENT 68.966%

TR3 TEST / MAX POINTS = 290 / No Error

SUBTOTAL POINTS 200

- ERROR POINTS -2

FINAL POINTS 198

/ Max Points: 0.68276

x 100 68.276

FINAL PERCENT 68.276%

TR3 TEST / MAX POINTS = 290 / One Error

EXAMPLE CALCULATIONS > USEF/USDF:

For multiple judges (multiple test sheets):  
• Mean of FINAL POINTS = MEAN FINAL POINTS
• Mean of FINAL PERCENT = MEAN FINAL PERCENT

1st Error: -2 points
2nd Error: -4 points (-6 points total)
3rd Error: Elimination

NOTE:  This is also the calculation for an FEI 
test that has no Errors of Course. 

NOTE:  Fortunately, errors during a test are 
infrequent; therefore, this is usually all you need to 
do to enter the scores for a ride. Error handling for 
FEI tests with ERRORS OF COURSE looks rather 
complicated.  However, you and FVD will not need 
to do the math very often.
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Scoring > Example Calculations > FEI YH, Children, Pony & Junior Tests
EXAMPLE CALCULATIONS > FEI YH, CHILDREN, PONY & JUNIOR TESTS:

SUBTOTAL POINTS 220

- ERROR POINTS -2

PRELIMINARY POINTS 218

/ Max Points: 0.66061

x 100 66.061

PRELIMINARY PERCENT 66.061%

- ERROR PERCENT -0.5%

FINAL PERCENT 65.561%

x Max Points 21,635.00

/100 216.350

FINAL POINTS 216.350

JR TEAM TEST / Max Points = 330 / Both Types of Error

SUBTOTAL POINTS 220

- ERROR POINTS NA

PRELIMINARY POINTS 220

/ Max Points: 0.66667

x 100 66.667

PRELIMINARY PERCENT 66.667%

- ERROR PERCENT NA

FINAL PERCENT 66.667%

x Max Points NA

/100 NA

FINAL POINTS 220

JR TEAM TEST / Max Points = 330 / No Error

SUBTOTAL POINTS 220

- ERROR POINTS -2

PRELIMINARY POINTS 218

/ Max Points: 0.66061

x 100 66.061

PRELIMINARY PERCENT 66.061%

- ERROR PERCENT NA

FINAL PERCENT 66.061%

x Max Points NA

/100 NA

FINAL POINTS 218

JR TEAM TEST / Max Points  = 330 / Other Error(s) Only

SUBTOTAL POINTS 220

- ERROR POINTS NA

PRELIMINARY POINTS 220

/ Max Points: 0.66667

x 100 66.667

PRELIMINARY PERCENT 66.667%

- ERROR PERCENT -0.5%

FINAL PERCENT 66.167%

x Max Points 21,835.00

/100 218.35

FINAL POINTS 218.35

JR TEAM TEST / Max Points = 330 / Error of Course Only

For multiple judges (multiple test sheets:  
• Mean of FINAL PERCENT = MEAN FINAL PERCENT.
• Mean of FINAL POINTS = MEAN FINAL POINTS.  

To be deducted / penalty points:
1. OTHER ERRORS:  Two (2) points deducted for each other error.
2. ERRORS OF COURSE: 

• 1st Error: 0.5% deducted
• 2nd Error: 1% deducted (1.5% total deducted)
• 3rd Error: Elimination

NOTE:  Fortunately, errors during a test are infrequent.  Error handling for FEI tests with ERRORS OF 
COURSE looks rather complicated.  However, you and FVD will not need to do the math very often.
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Scoring > Example Calculations > FEI Young Rider Through Grand Prix Tests

SUBTOTAL POINTS 300

- ERROR POINTS -2

PRELIMINARY POINTS 298

/ Max Points: 0.64783

x 100 64.783%

PRELIMINARY PERCENT 64.783%

- ERROR PERCENT -2%

FINAL PERCENT 62.783%

x Max Points 28,880.00

/100 194.55

FINAL POINTS 288.80

GP TEST / Max Points = 460 / Both Error Types

SUBTOTAL POINTS 300

- ERROR POINTS NA

PRELIMINARY POINTS 300

/ Max Points: 0.65217

x 100 65.217

PRELIMINARY PERCENT 65.217%

- ERROR PERCENT NA

FINAL PERCENT 65.217%

x Max Points NA

/100 NA

FINAL POINTS 300

SUBTOTAL POINTS 300

- ERROR POINTS -2

PRELIMINARY POINTS 298

/ Max Points: 0.64783

x 100 64.783

PRELIMINARY PERCENT 64.783%

- ERROR PERCENT NA

FINAL PERCENT 64.783%

x Max Points NA

/100 NA

FINAL POINTS 298

GP TEST / Max Points = 460 / Other Error(s) Only

EXAMPLE CALCULATIONS > FEI YR THRU GP:

GP TEST / Max Points = 460 / No Error(s)

SUBTOTAL POINTS 300

- ERROR POINTS NA

PRELIMINARY POINTS 300

/ Max Points: 0.65217

x 100 65.217

PRELIMINARY PERCENT 65.217%

- ERROR PERCENT -2%

FINAL PERCENT 63.217%

x Max Points 29,080

/100 194.55

FINAL POINTS 290.80

GP TEST / Max Points = 460 / Error of Course Only

For multiple judges (multiple test sheets):  
• Mean of FINAL PERCENT = MEAN FINAL PERCENT.
• Mean of FINAL POINTS = MEAN FINAL POINTS.  

To be deducted / penalty points:
1. OTHER ERRORS:  Two (2) points deducted for each other error.
2. ERRORS OF COURSE: 

• 1st Error: 2% deducted
• 2nd Error: Elimination

NOTE:  Fortunately, errors during a test are 
infrequent.  Error handling for FEI tests with ERRORS 
OF COURSE looks rather complicated.  However, you 
and FVD will not need to do the math very often.
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Scoring > FVD Scoring Reports > Day Sheets Scoring Report

• The Day Sheets Scoring report may be used by the scoring section as it is a guide to classes with 
information that is useful to scorers.

• Select ❶Main Menu > ❷ Reports > ❸ During Show > ❹ Day Sheets Scoring.  

• The ❺ Day Sheets Scoring report 
opens.  For each ring, the report 
contains the class information and an 
area on which scorers write in the 
scores, percentages, and placings by 
hand.

• Click the ❻ Print button to print all the 
sheets.

• Click ❼ Close Print Preview to close 
the report.

NOTE:  Print the Day Sheets Scoring at the 
last possible moment before they are used.  
This ensures the scorers have the most 
current show information.

FVD SCORING REPORTS > DAY SHEETS SCORING REPORT:

1

2

3
4

NOTE:  This is a good report for the scoring 
department as:
• The ❽ Finished column is used to 

indicate the test has been scored and 
posted.

• The ❾ E H C M B columns can be used 
to record the scores from each judge.  If 
there is a single judge at C, you can use 
this area to record the final points and 
final percent.

• The ❿ Hold column has a check if the 
test and ribbon must be held until the 
entry is cleared by the Show Secretary.

• Computers crash!  Therefore, it is a good 
idea to have a paper back-up for scores.  
FVD provides two reports that may be 
used for this purpose:
1. Day Sheets Scoring report
2. Handwritten Scoring report

5

6

8

9

5

7

10
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Scoring > FVD Scoring Reports > Handwritten Score Sheets Report

• Select ❶ Main Menu > ❷ Reports > ❸ During-Show > ❹ Handwritten Score Sheets.
• The ❺ Handwritten Score Sheets report opens.
• Print the report as for Day Sheets Scoring.

FVD SCORING REPORTS > HANDWRITTEN SCORE SHEETS REPORT:

1

2

3

4

NOTE:  Disadvantages of 
this report:
• There is no Finished

column to indicate the 
test has been scored and 
posted.

• There is no Hold column 
to check if the test and 
ribbon must be held until 
the entry is cleared by the 
Show Secretary.

• Computers crash!  Therefore, it is a good 
idea to have a paper back-up for scores.  
FVD provides two reports that may be 
used for this purpose:
1. Day Sheets Scoring report
2. Handwritten Scoring Sheets report

• The ❻ E H C M B columns 
are used to record the FINAL 
POINTS from each judge.  
Alternately, with one judge, 
they can be used to record 
FINAL POINTS, FINAL 
PERCENT, and PLACE.

• The ❼ Total column is used 
for the FINAL POINTS (one 
judge) or the MEAN FINAL 
POINTS (multiple judges).

• The ❽ % column is used 
for the FINAL PERCENT (one 
judge) or the MEAN FINAL 
PERCENT (multiple judges). 

• The ❾ Open, ❿ AA and 
⓫ JR/YR columns can be 
used for division scores.

5

6 7 8 9

5

10 11
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• Manual Scoring: The scorers hand calculate the scores and percentages and use their calculations to 
annotate the tests, place the class, and make awards.  The FINAL POINTS (but not the movement-by-
movement scores from the judges’ test sheets) are entered in the computer during or after the show.  
FVD calculates the FINAL PERCENTS.

• Standard Scoring: CDI shows must use this method. 
o The scorers hand calculate the FINAL POINTS and FINAL PERCENT and use their calculations to 

annotate the tests.  A computer operator enters movement-by-movement POINTS and ERRORS from 
the judges’ test sheets.  FVD automatically calculates the FINAL POINTS and FINAL PERCENT.  The FVD  
result is compared to the hand calculation performed by scoring.  The computer is used to place the 
classes.  

o Alternately, with FVD Cloud Server (see FVD CLOUD SERVER), at the judge’s stand the scribe enters 
the POINTS, ERROR POINTS, and ERROR PERCENT into a FVD device.  FVD calculates the FINAL POINTS 
and the FINAL PERCENT.  There is no separate scoring section!

• Show management decides which approach to use.  The decision is usually based on available 
equipment and staff/volunteers.  The decision must be made before the show starts.

342

Scoring > FVD Manual Scoring and Standard Scoring

• FVD provides three approaches to scoring: 

FVD MANUAL AND STANDARD SCORING:

NOTE:  The FVD authors prefer that you use Standard Scoring as it gives you more data and lets you use other 
services such as Competitor Tent (iOS app).  However, Standard Scoring requires numerous scorers and computers, 
and it entails more work and time.  Smaller shows with less staff and minimal equipment may therefore find it 
easier to use Manual Scoring.  Standard Scoring is required for CDIs and is used for FVD Cloud Server.

1. No Computer Use During the Show FVD Manual Scoring Enter SUBTOTAL POINTS only after show

2. Computer Use During the Show FVD Manual Scoring Enter SUBTOTAL POINTS only during show

3. Computer Use During the Show FVD Standard Scoring Enter MOVEMENT-BY-MOVEMENT POINTS during show 

NOTE:  A paper printout of the calculation is no longer required; 
however, it can be useful when looking for the source of an error.

MANUAL SCORING FORM STANDARD SCORING FORM



Fox Village Dressage User Manual – 2021 Update 1.0.5. helpdesk@foxvillage.com                 www.foxvillage.com343

Scoring > FVD Manual Scoring & No Computer Use During the Show

SECTION III. DURING THE SHOW

NOTE:  Most USEF/USDF shows use computers during the show.  However, very small 
USEF/USDF shows, and most schooling shows, may not have the staff and equipment 
to use computers during the show.  Therefore, this section is included for these shows.
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Scoring > FVD Manual Scoring & No Computer Use During the Show > 
Flowchart

• When the ❶ dressage test sheets come in from the rings, the scoring section computes the FINAL 
POINTS and FINAL PERCENT using a hand calculator and records them on the test sheet.  If a calculator 
printer tape is used, the tape is attached to the test sheet.  A 2nd scorer verifies the 1st.

• The scored test sheets are provided to the Head Scorer.
• The Head Scorer writes the FINAL POINTS and FINAL PERCENT on the:
o ❷ Day Sheets Scoring report (or Handwritten Score Sheets report), and
o ❸ Handwritten score posters (this can be a FVD Handwritten Scoresheet report or a locally-

produced poster).  
• When a class is finished, the Head Scorer places the class and writes the placings on the Day Sheets 

Scoring (or Handwritten Score Sheets report) and ❸ handwritten score posters.
• The tests then go to the ❹ awards section unless there is a hold on the entry.
• AFTER THE SHOW, using the Day Sheets Scoring report (or Handwritten Score Sheets report), the 

computer operator enters the FINAL POINTS into ❺ FVD and ❻ sends results reports to USEF and 
USDF.

3

HANDWRITTEN SCORE POSTERS
(not a FVD report)

1
DRESSAGE TEST SHEETS

DAY SHEETS SCORING

2
5

AFTER THE SHOW

AWARDS

DURING THE SHOW

RESULTS 
REPORTS

6

4

FVD MANUAL SCORING & NO COMPUTER USE DURING THE SHOW  > FLOWCHART:
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Scoring > FVD Manual Scoring & No Computer Use During the Show > 
Set Up Manual Scoring

• The ❹ Show Preferences form opens.
• On the ❺ General tab > ❻ Scoring, select ❼Manual Scoring by clicking the radial button so it is filled 

with a black dot.
• Click ❽ Close to return to the Main Menu.

• To set up Manual Scoring, select ❶
Main Menu > ❷ Show Office > ❸
Show Preferences.

7

5
6

4

8

FVD MANUAL SCORING & NO COMPUTER USE DURING THE SHOW > SET UP MANUAL SCORING:

1

2

3
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Scoring > FVD Manual Scoring & No Computer Use During the Show > 
Most Test Types > No Errors

• If you are not using a computer during your show, all scoring procedures are done by hand.
• One Judge:

o First Scorer:
▪ Calculate the ❶ MOVEMENT TOTAL POINTS and❷ COLLECTIVE TOTAL POINTS
▪ ❸ SUBTOTAL POINTS = ❶ MOVEMENT TOTAL POINTS plus ❷ COLLECTIVE TOTAL POINTS.
▪ Since this example has no errors, enter 0 (zero) in the ❹ ERROR POINTS box. 
▪ ❺ FINAL POINTS =❸ SUBTOTAL POINTS minus❹ ERROR POINTS.
▪ ❼ FINAL PERCENT = (❺ FINAL POINTS divided by ❻MAX POINTS) x 100.  Write ❼ FINAL PERCENT near the 
❺ FINAL POINTS.

o Second Scorer:
▪ Proceed as for the First Scorer except, if the calculations match, write the ❺ FINAL POINTS on the ❽ Final 

Score > Points line and write the ❼ FINAL PERCENT on the ❾ Final Score > Percent line.
o If the calculations do not match, repeat calculations until they match.

• Multiple Judges:
o For each judge/sheet, repeat as for one judge.
o Calculate the mean of all ❺ FINAL POINTS to determine the MEAN FINAL POINTS.
o Calculate the mean of all ❼ FINAL PERCENT to determine the MEAN FINAL PERCENT.
o Ensure the MEAN FINAL POINTS and the MEAN FINAL PERCENT are entered on a separate sheet as the final scores.

• AFTER THE SHOW:  Enter the ❺ FINAL POINTS or MEAN FINAL POINTS in FVD.  FVD calculates the ❼ FINAL PERCENT 
or MEAN FINAL PERCENT.

FVD MANUAL SCORING & NO COMPUTER USE DURING THE SHOW > MOST TEST TYPES > NO ERRORS:

1

SUBTOTAL POINTS 178.5

-ERROR POINTS 0

PRELIMINARY POINTS 178.5

/ Max Points: 0.61552

x 100 61.552

PRELIMINARY PERCENT 61.552%

- ERROR PERCENT NA

FINAL PERCENT 61.552%

x Max Points NA

/100 NA

FINAL POINTS 178.5

TR3 TEST / MAX POINTS = 290 / No Errors

3

5

5

7

7

4

6
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Scoring > FVD Manual Scoring & No Computer Use During the Show >
Most USEF/USDF Tests > Errors

USEF DR122.5.b. Errors
b. In National [USDF/USEF] tests, every error of the course whether the bell is sounded or not, must be 

penalized, …: 
1. The first time by 2 points;
2. The second time by 4 points [total of 6 points];
3. The third time the competitor is eliminated. However, at the discretion of the judge, the rider may 

continue to finish the test. If the competitor’s continued presence in the ring is about to interfere with 
the start of the next scheduled ride, then the judge must excuse him/her from the ring. 

FVD MANUAL SCORING & NO COMPUTER USE DURING THE SHOW > MOST USEF/USDF TESTS > ERRORS:

USEF DR117.6. The Position and Aids of the Rider
6. The use of the voice in any way whatsoever or clicking the tongue once or repeatedly is a fault involving the 

deduction of 2 marks from those that would otherwise have been awarded for the movement where this 
occurred.

• One Judge:
o ❺ FINAL POINTS = ❸ SUBTOTAL POINTS minus ❹ ERROR POINTS.
o ❼ FINAL PERCENT = (❺ FINAL POINTS divided by ❻MAX POINTS) x 100.

• Multiple Judges:
o For each judge/sheet, repeat as for one judge.
o Calculate the mean of all ❺ FINAL POINTS to determine the MEAN FINAL POINTS.
o Calculate the mean of all ❼ FINAL PERCENT to determine the MEAN FINAL PERCENT.
o Ensure the MEAN FINAL POINTS and the MEAN FINAL PERCENT are entered on a separate sheet as the final scores.

• AFTER THE SHOW:  Enter the ❺ FINAL POINTS or MEAN FINAL POINTS in FVD.  FVD calculates the ❼ FINAL PERCENT 
or the MEAN FINAL PERCENT.

• What does this mean?
o Errors for most USEF/USDF tests are error of course and use of voice.
o First Error: -2 points deducted from the SUBTOTAL POINTS.
o Second Error: -4 additional points (for a total of -6 points) are deducted from the SUBTOTAL POINTS.
o Third Error:  Elimination.

SUBTOTAL POINTS 178.5

- ERROR POINTS -2

FINAL POINTS 176.5

/ Max Points 0.60862

x 100 60.862

FINAL PERCENT 60.862%

TR3 TEST / MAX POINTS = 290 / One Error

3

4

5

7

61st Error: -2 points
2nd Error: -4 points (-6 points total)
3rd Error: Elimination

4
4

178.5

2

176.5

178.5

6

172.5

ONE ERROR TWO ERRORS THREE ERRORS

3

4

5

3

4

5
6 6 6

FINAL PERCENT = 
(176.5/290)x100 = 59.483%

FINAL PERCENT = 
(172.5/290)x100 = 60.862%

NO SCORE7 7 7
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Scoring > FVD Manual Scoring & No Computer Use During the Show > USEF 
& FEI YH, FEI Children, FEI Pony, FEI Junior Rider Tests > Other Errors Only 

• One Judge:

o ❸ FINAL POINTS = ❶ SUBTOTAL POINTS minus ❷ ERROR POINTS.  

o ❺ FINAL PERCENT = (❸ FINAL POINTS / ❹MAX POINTS) x 100.

• Multiple Judges (multiple test sheets):

o For each judge/sheet, repeat as for one judge.

o Calculate the mean of all ❸ FINAL POINTS to determine the MEAN FINAL POINTS.

o Calculate the mean of all ❺ FINAL PERCENT to determine the MEAN FINAL PERCENT.

o Ensure the MEAN FINAL POINTS and the MEAN FINAL PERCENT are entered on a separate sheet as 

the final scores.

• After the Show: Enter ❸ FINAL POINTS or MEAN FINAL POINTS into FVD.  FVD calculates the ❺ FINAL 

PERCENT or the MEAN FINAL PERCENT.

• Since you are not using FVD at the show, because of the FEI scoring rules, you will need to do some 
math.  Use the table below for formulas.  If you have a non-FVD laptop or iPad, you may want to create 
an Excel spreadsheet to assist you. 

• (If you use FVD at the show, FVD performs the calculations for you!)

FVD MANUAL SCORING & NO COMPUTER USE DURING THE SHOW > USEF & FEI YH, FEI CHILDREN, FEI 
PONY, FEI JUNIOR RIDER TESTS > OTHER ERRORS ONLY:

SUBTOTAL POINTS 214

- ERROR POINTS -2

PRELIMINARY POINTS 212

/ Max Points 0.64242

x 100 64.242

PRELIMINARY PERCENT 62.242%

- ERROR PERCENT 0

FINAL PERCENT 62.242%

x Max Points NA

/100 NA

FINAL POINTS 212

JR TEAM TEST / MAX POINTS = 330 / Other Errors Only

1

3

3

5

5

2

4

(1.5% total)

1

2

3

4

5

214

ERROR POINTS 

M
A

X
 P

O
IN

TS

-2

212 64.242%

SUBTOTAL POINTS 

FINAL POINTS 

FINAL PERCENT 

To be deducted / penalty points:
1. OTHER ERRORS:  Two (2) points deducted for each other error.
2. ERRORS OF COURSE: 

• 1st Error: 0.5% deducted
• 2nd Error: 1% deducted (1.5% total deducted)
• 3rd Error: Elimination

FINAL PERCENT = (212/330)x100 = 64.242%
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Scoring > FVD Manual Scoring & No Computer Use During the Show > USEF 
& FEI YH, FEI Children, FEI Pony, FEI Junior Rider Tests > Errors of Course Only 

• One Judge:

o ❸ PRELIMINARY POINTS = ❶ SUBTOTAL POINTS –❷ ERROR POINTS

o ❺ PRELIMINARY PERCENT = (❸ PRELIMINARY POINTS / ❹MAX POINTS) * 100.

o ❼ FINAL PERCENT = ❺ PRELIMINARY PERCENT minus❻ ERROR PERCENT.  

o ❽ FINAL POINTS = (❼ FINAL PERCENT * ❹MAX POINTS) / 100.

• Multiple Judges:

o For each judge/sheet, repeat as for one judge.

o Calculate the mean of all ❽ FINAL POINTS to get the MEAN FINAL POINTS. 

o Calculate the mean of all ❼ FINAL PERCENT to get the MEAN FINAL PERCENT. 

o Ensure the MEAN FINAL POINTS and the MEAN FINAL PERCENT are entered on a separate 
sheet as the final scores.

• After the Show: 

o Enter the ❽ FINAL POINTS or the MEAN FINAL POINTS in FVD.  

o FVD will calculate the ❼ FINAL PERCENT or the MEAN FINAL PERCENT.

FVD MANUAL SCORING & NO COMPUTER USE DURING THE SHOW > USEF & FEI YH, FEI CHILDREN, FEI 
PONY, FEI JUNIOR RIDER TESTS > ERRORS OF COURSE ONLY:

SUBTOTAL POINTS 214

- ERROR POINTS 0

PRELIMINARY POINTS 214

/ Max Points 0.64848

x 100 64.848

PRELIMINARY PERCENT 64.848%

- ERROR PERCENT -0.5%

FINAL PERCENT 64.348%

x Max Points 21,235.00

/100 212.350

FINAL POINTS 212.350

JR TEAM TEST / MAX POINTS = 330 / One Error of Course Only

SUBTOTAL POINTS 214

- ERROR POINTS 0

PRELIMINARY POINTS 214

/ Max Points 0.64848

x 100 64.848

PRELIMINARY PERCENT 64.848%

- ERROR PERCENT -1.5%

FINAL PERCENT 63.348%

x Max Points 20,904.84

/100 209.048

FINAL POINTS 209.048

JR TEAM TEST / MAX POINTS = 330 / Two Errors of Course Only

1

2

3

4

5

6

7

4

8

1

2

3

4

5

6

7

4

8

1

2

3

4 214

ERROR POINTS 

M
A

X
 P

O
IN

TS

0

214

212.350FINAL POINTS 8 64.348%

7 FINAL PERCENT

SUBTOTAL POINTS 

PRELIM 
POINTS 

(214 / 330) * 100 = 64.848%5 PRELIMINARY PERCENT 

To be deducted / penalty points:
1. OTHER ERRORS:  Two (2) points deducted for each other error.
2. ERRORS OF COURSE: 

• 1st Error: 0.5% deducted
• 2nd Error: 1% deducted (1.5% total deducted)
• 3rd Error: Elimination

6

6 ERROR PERCENT 
-0.5% 
or –

1.5%

NOTE:  
Fortunately, 
errors during a 
test are 
infrequent.  Error 
handling for FEI 
tests with 
ERRORS OF 
COURSE looks 
rather 
complicated.  
However, you 
and FVD will not 
need to do the 
math very often.
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Scoring > FVD Manual Scoring & No Computer Use During the Show > USEF 
& FEI YH, FEI Children, FEI Pony, FEI Junior Rider Tests > Both Error Types

• One Judge:
o Other Errors:
▪ ❸ PRELIMINARY POINTS = ❶ SUBTOTAL POINTS minus ❷ ERROR POINTS.
▪ ❺ PRELIMINARY PERCENT = (❸ PRELIMINARY POINTS divided by❹Max Points) * 100.

o Errors of Course:
▪ ❼ FINAL PERCENT = ❺ PRELIMINARY FINAL PERCENT minus❻ ERROR PERCENT.
▪ ❽ FINAL POINTS = (❼ FINAL PERCENT divided by ❹Max Points) x 100).

• Multiple Judges:
o For each judge/sheet, repeat as for one judge.  
o Calculate the mean of all ❼ FINAL PERCENT to get the MEAN FINAL PERCENT.
o Calculate the mean of all ❽ FINAL POINTS to get the MEAN FINAL POINTS. 
o Ensure the MEAN FINAL POINTS and the MEAN FINAL PERCENT are entered on a separate sheet as 

the final scores.
• After the Show: Enter the ❽ FINAL POINTS or the MEAN FINAL POINTS in FVD.  FVD will calculate the 
❼ FINAL PERCENT or the MEAN FINAL PERCENT.

FVD MANUAL SCORING & NO COMPUTER USE DURING THE SHOW > USEF & FEI YH, FEI CHILDREN, FEI 
PONY, FEI JUNIOR RIDER TESTS > BOTH ERROR TYPES:

SUBTOTAL POINTS 214

- ERROR POINTS -2

PRELIMINARY POINTS 212

/ Max Points 0.64242

x 100 64.242

PRELIMINARY PERCENT 64.242%

- ERROR PERCENT -0.5%

FINAL PERCENT 63.742%

x Max Points 21,034.998

/100 210.350

FINAL POINTS 210.350

JR TEAM TEST / MAX POINTS = 330 / Both Types of Error

1

2

3

5

4

7

4

8

6

1

2

4 214

ERROR POINTS

M
A

X
 P

O
IN

TS

212

212.350FINAL POINTS 7 64.348%

6 FINAL PERCENT

-2

3 PRELIMINARY POINTS

SUBTOTAL POINTS

5 PRELIMINARY PERCENT

(212 / 330) * 100 = 64.242%

6 ERROR PERCENT
0.5% 
or -

1.5%

To be deducted / penalty points:
1. OTHER ERRORS:  Two (2) points deducted for each other error.
2. ERRORS OF COURSE: 

• 1st Error: 0.5% deducted
• 2nd Error: 1% deducted (1.5% total deducted)
• 3rd Error: Elimination

2

6

NOTE:  
Fortunately, 
errors during a 
test are 
infrequent.  Error 
handling for FEI 
tests with 
ERRORS OF 
COURSE looks 
rather 
complicated.  
However, you 
and FVD will not 
need to do the 
math very often.
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Scoring > FVD Manual Scoring & No Computer Use During the Show > 
FEI YR through GP Tests > Other Errors Only 

FVD MANUAL SCORING & NO COMPUTER USE DURING THE SHOW > FEI YR THROUGH GP TESTS > OTHER 
ERRORS ONLY:

• One Judge:

o ❸ PRELIMINARY POINTS =❻ FINAL POINTS = ❶ SUBTOTAL POINTS minus ❷ ERROR POINTS.  

o ❺ PRELIMINARY PERCENT =❺ FINAL PERCENT = (❻ FINAL POINTS divided by ❹MAX POINTS) x 
100.

• Multiple Judges:

o For each judge/sheet, repeat as for one judge.

o Calculate the mean of all ❻ FINAL POINTS to determine the MEAN FINAL POINTS.

o Calculate the mean of all ❺ FINAL PERCENT to determine the MEAN FINAL PERCENT.

o Ensure the MEAN FINAL POINTS and the MEAN FINAL PERCENT are entered on a separate sheet as 
the final scores.

• After the Show:  

o Enter ❻ FINAL POINTS or MEAN TOTAL POINTS into FVD.  

o FVD calculates the ❺ FINAL PERCENT or the MEAN FINAL PERCENT.

SUBTOTAL POINTS 314

- ERROR POINTS -2

PRELIMINARY POINTS 312

/ Max Points 0.67826

x 100 67.826

PRELIMINARY PERCENT 67.826%

- ERROR PERCENT NA

FINAL PERCENT 67..826%

x Max Points NA

/100 NA

FINAL POINTS 312

GP TEST / MAX POINTS = 460 / Other Error(s) Only

1

2

3

6

4

5

5

314

-2

312

1

2 ERROR POINTS 

3

4

67.826%

FINAL PERCENT = (312 / 460) * 100 = 67.826%

SUBTOTAL POINTS 

M
A

X
 P

O
IN

TS

FINAL POINTS 

5 FINAL PERCENT 
[-2 for each other error]

To be deducted / penalty points:
1. OTHER ERRORS:  Two (2) points deducted for each other error.
2. ERRORS OF COURSE: 

• 1st Error: 2% deducted
• 2nd Error: Elimination

2

NOTE:  
Fortunately, 
errors during a 
test are 
infrequent.  Error 
handling for FEI 
tests with 
ERRORS OF 
COURSE looks 
rather 
complicated.  
However, you 
and FVD will not 
need to do the 
math very often.
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Scoring > FVD Manual Scoring & No Computer Use During the Show > 
FEI YR through GP Tests > Errors of Course Only 

FVD MANUAL SCORING & NO COMPUTER USE DURING THE SHOW > FEI YR THROUGH GP TESTS > ERROR 
OF COURSE ONLY:

• One Judge:

o ❸ PRELIMINARY POINTS = (❶ SUBTOTAL POINTS minus❷ ERROR POINTS) 

o ❺ PRELIMINARY PERCENT = (❸ PRELIMINARY POINTS divided by ❹MAX POINTS) * 100.

o ❼ FINAL PERCENT = ❺ PRELIMINARY PERCENT minus❻ ERROR PERCENT.  

o ❽ FINAL POINTS = (❼ FINAL PERCENT times ❹MAX POINTS) divided by 100.

• Multiple Judges:

o For each judge/sheet, repeat as for one judge.

o Calculate the mean of all ❽ FINAL POINTS to determine the MEAN FINAL POINTS.

o Calculate the mean of all ❼ FINAL PERCENT to determine the MEAN FINAL PERCENT.

o Ensure the MEAN FINAL POINTS and the MEAN FINAL PERCENT are entered on a separate sheet as 
the final scores.

• After the Show: 

o Enter ❽ FINAL POINTS or MEAN TOTAL POINTS into FVD.  

o FVD calculates the ❼ FINAL PERCENT or the MEAN FINAL PERCENT.

SUBTOTAL POINTS 314

- ERROR POINTS 0

PRELIMINARY POINTS 314

/ Max Points 0.68261

x 100 68.261

PRELIMINARY PERCENT 68.261%

- ERROR PERCENT 2%

FINAL PERCENT 66.261%

x Max Points 30,480.00

/100 304.800

FINAL POINTS 304.800

GP TEST / MAX POINTS = 460 / Error of Course

1

2

3

4

5

6

7

4

8

314

0

314

1

2 ERROR POINTS

3

4

M
A

X
 P

O
IN

TS

SUBTOTAL POINTS

PRELIMINARY POINTS

FINAL POINTS 8

(314 / 460) * 100 = 68.261%

5 PRELIMINARY PERCENT 

304.800 66.261%

7 FINAL PERCENT

To be deducted / penalty points:
1. OTHER ERRORS:  Two (2) points deducted for each other error.
2. ERRORS OF COURSE: 

• 1st Error: 2% deducted
• 2nd Error: Elimination

2 -2% 6 ERROR PERCENT

NOTE:  
Fortunately, 
errors during a 
test are 
infrequent.  Error 
handling for FEI 
tests with 
ERRORS OF 
COURSE looks 
rather 
complicated.  
However, you 
and FVD will not 
need to do the 
math very often.
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Scoring > FVD Manual Scoring & No Computer Use During the Show > 
FEI YR through GP Tests > Both Error Types 

FVD MANUAL SCORING & NO COMPUTER USE DURING THE SHOW > FEI YR THROUGH GP TESTS > BOTH 
ERROR TYPES:

• One Judge:
o Other Errors: 
▪ ❸ PRELIMINARY POINTS = ❶ SUBTOTAL POINTS minus ❷ ERROR POINTS.
▪ ❺ PRELIMINARY PERCENT = (❸ PRELIMINARY POINTS divided by❹MAX POINTS) x 100.

o Errors of Course:
▪ ❼ FINAL PERCENT = ❺ PRELIMINARY PERCENT minus❻ ERROR PERCENT.
▪ ❽ FINAL POINTS = (❼ FINAL PERCENT times❹Max Points) divided by 100.

• Multiple Judges:

o For each judge/sheet, repeat as for one judge.

o Calculate the mean of all ❽ FINAL POINTS to determine the MEAN FINAL POINTS.

o Calculate the mean of all ❼ FINAL PERCENT to determine the MEAN FINAL PERCENT.

o Ensure the MEAN FINAL POINTS and the MEAN FINAL PERCENT are entered on a separate sheet as 
the final scores.

• After the Show:
o Enter the ❽ FINAL POINTS or the MEAN FINAL POINTS in FVD.  
o FVD will calculate the ❼ FINAL PERCENT or the MEAN FINAL PERCENT.

SUBTOTAL POINTS 314

- ERROR POINTS -2

PRELIMINARY POINTS 312

/ Max Points 0.67826

x 100 67.826

PRELIMINARY PERCENT 67.836%

- ERROR PERCENT -2%

FINAL PERCENT 65.826%

x Max Points 30,280.00

/100 302.800

FINAL POINTS 302.800

GP TEST / MAX POINTS = 460 / Both Error Types

1

2

3

4

5

6

7

4

8

314

-2

312

2 ERROR POINTS 

3

4MAX POINTS

7

1 SUBTOTAL POINTS

PRELIMINARY POINTS 

5 PRELIMINARY PERCENT
(312 / 460) * 100 = 67.826%

65.826%302.8008FINAL POINTS 

FINAL PERCENT 

[-2 for each other error]
2

6 -2% 2 ERROR PERCENT 

NOTE:  
Fortunately, 
errors during a 
test are 
infrequent.  Error 
handling for FEI 
tests with 
ERRORS OF 
COURSE looks 
rather 
complicated.  
However, you 
and FVD will not 
need to do the 
math very often.
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Scoring > FVD Manual Scoring & No Computer Use During the Show > 
After the Show

FVD MANUAL SCORING > NO COMPUTER USE DURING THE SHOW > AFTER THE SHOW:

• After the show, collect the Days Sheets Scoring report (or Handwritten Score Sheets report) or the Score 
Posters.

• Using the instructions in the next part of this chapter (Scoring > FVD Manual Scoring > Computer Use 
During the Show), enter the FINAL POINTS into FVD.  FVD then calculates the FINAL PERCENT.

• Place each class (see PLACE A CLASS).
• Create the FVD USEF/USDF *.dat file (see DATA FILE FOR USEF AND USDF) and email to USEF and USDF.
• Create the USEF Post Competition Report (see USEF POST COMPETITION REPORT FORM) and snail-mail 

with any accompanying documents and payments.
• Create the USDF Report of Fees (see USDF REPORT OF FEES) and snail-mail or email them with any 

accompanying documents and payments.
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Scoring > FVD Manual Scoring & Computer Use During the Show > Flowchart

• When the ❶ dressage test sheets come in from the rings, the scoring department computes the points and 
percentages using a hand calculator and records them on the test sheet.  If a calculator printer tape is used, the tape 
is attached to the test sheet. 

• The scored test sheets are provided to the Head Scorer.
• Head Scorer:

o (Optional) Writes the points and percentages on the ❷ Day Sheets Scoring (or Handwritten Score Sheets) report 
as a back-up.  

o Uses the report as a method to track scored tests and to determine if the test and ribbon must be held until 
cleared by the show office.

o When a class is finished (or before), the Head Scorer provides the test sheets to the computer operator.
• Computer Operator: 

o Using the test sheets, the computer operator enters the final points into ❸ FVD, verifies that the FVD percent
calculation matches the hand calculation, and places the class in FVD and on the test sheets by writing the place 
on each sheet.

o Prints three copies of the ❹ FVD Score Report (for posting, announcer, and awards)
o Provides the test sheets to the ❺ awards section.

• After the Show, the computer operator ❻ sends results to USEF and USDF.

DAY SHEETS SCORING

1 DRESSAGE TEST SHEETS

2

FVD SCORE REPORT

3

SHOW OFFICE COMPUTER

4

AFTER THE SHOW

AWARDS

DURING THE SHOW

RESULTS 
REPORTS

5
6

FVD MANUAL SCORING & COMPUTER USE DURING THE SHOW > FLOWCHART:

NOTE: The Head Scorer and the Computer Operator 
might be the same person or different people.
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Scoring > FVD Manual Scoring & Computer Use During the Show > 
Set Up Manual Scoring

• The ❹ Show Preferences form opens.
• In the ❺ General tab > ❻ Scoring, select ❼Manual Scoring by clicking the radial button so it is filled 

with a black dot.
• Click ❽ Close to return to the Main Menu.

• To select Manual Scoring, select ❶Main 
Menu > ❷ Show Office > ❸ Show 
Preferences

7

5
6

4

8

FVD MANUAL SCORING & COMPUTER USE DURING THE SHOW > SET UP MANUAL SCORING:

1

2

3
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Scoring > FVD Manual Scoring & Computer Use During the Show > 
Open Manual Score Sheet

• Select ❶Main Menu > ❷ Scoring.

• Using the ❸ Class (Lookup) drop-down 
arrow or type-in box, select the ❹ Class
to be scored.

1

2

3

4

FVD MANUAL SCORING > COMPUTER USE DURING THE SHOW > OPEN MANUAL SCORE SHEET:

• Click the ❺ Score box.
5

Continued on next page…
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Scoring > FVD Manual Scoring & Computer Use During the Show > 
Most Test Types > No Errors

6
7 8

• The Manual Score Sheet form opens.
• If you have monitor space, you can increase the height of this form to show more 

rides.

• Enter the ❶ SUBTOTAL POINTS in the FVD ❻ Judge Scores box under the letter 
for the judge’s position and press Enter. 

• FVD automatically enters the ❸ FINAL POINTS in the ❼ Final Score box and the 
❹ FINAL PERCENT in the ❽ Percent box.

• If there is more than one judge, repeat for other judge position(s).
• FVD automatically calculates the MEAN FINAL POINTS and the MEAN FINAL 

PERCENT.

FVD MANUAL SCORING & COMPUTER USE DURING THE SHOW > NO ERRORS:

169.0

0

169.0

58.276% 

3

4

TEST SHEET SCORING AREA

SUBTOTAL POINTS

ERROR POINTS

FINAL POINTS

FINAL PERCENT

1

2

NOTE:  
• Fortunately, errors during 

a test are infrequent.  
Therefore, for most tests, 
this is all you will need to 
do.  

• Error handling for FEI tests 
with ERRORS OF COURSE 
looks rather complicated.  
However, you and FVD will 
not need to do the math 
very often.
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Scoring > FVD Manual Scoring & Computer Use During the Show > 
USDF/USEF Tests > Errors

• OPTION 2:
o Enter the ❶ SUBTOTAL POINTS in the ❺ Judge Scores box.
o FVD calculates the ❻ PRELIMINARY POINTS and the ❼ PRELIMINARY PERCENT .
o Click the ❽ Calc button.
o The ❾ Error Calculator form opens.
o Enter the ❷ ERROR POINTS  (-2 or -6).
o Click ❿ OK.
o FVD automatically enters the ❸ FINAL POINTS in the Final Score box and the ❹ FINAL PERCENT in the Percent

box.
o If there is more than one judge, repeat for other judge position(s).
o FVD automatically calculates the MEAN FINAL POINTS and the MEAN FINAL PERCENT.

FVD MANUAL SCORING & COMPUTER USE DURING THE SHOW > USDF/USEF TESTS > ERRORS:

• With FVD, you have two entry options if there were errors (point deduction) in these tests:
1. Use the final points hand calculated by the scoring section.
2. Use FVD to calculate the final points and final percent.

• OPTION 1:  Enter the ❸ FINAL POINTS or MEAN FINAL POINTS calculated 
by the scoring section in the ❺ Judge Scores box.  FVD will calculate the 
❹ FINAL PERCENT or the MEAN FINAL PERCENT.  

[6 points total]2ERROR 
POINTS

169.0

2

167.0

57.586% 

TEST SHEET SCORING AREA

1

2

5

8

9

SUBTOTAL POINTS

ERROR POINTS

FINAL POINTS

FINAL PERCENT

3

2

3

4

6 7

9

4
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Scoring > FVD Manual Scoring & Computer Use During the Show > USEF 
& FEI YH, FEI Children, FEI Pony, FEI Junior Tests > Other Errors Only

• OPTION 2:
o Enter the ❶ SUBTOTAL POINTS in the ❺ Judge Scores (Points) box.
o FVD automatically enters ❻ PRELIMINARY POINTS in the Final Score box and ❼ PRELIMINARY PERCENT in 

the Percent box.
o Click the ❽ Calc button.
o The ❾ Error Calculator form opens.
o Enter the ❷ ERROR POINTS in the Points box.
o Click ❿ OK.
o FVD automatically enters the ❸ FINAL POINTS and the ❹ FINAL PERCENT.
o If there is more than one judge, repeat for other judge position(s).
o FVD automatically calculates the MEAN FINAL POINTS and the MEAN FINAL PERCENT.

FVD MANUAL SCORING & COMPUTER USE DURING THE SHOW > USEF & FEI YH, FEI CHILDREN, FEI PONY, 
FEI JUNIOR TESTS > OTHER ERRORS ONLY:

• With FVD, you have two entry options if there were other errors (points deduction) only in these tests:
1. Use the FINAL POINTS hand calculated by the scoring section.
2. Use FVD to calculate the FINAL POINTS and FINAL PERCENT.

• OPTION 1:  Enter the ❸ FINAL POINTS or MEAN FINAL POINTS calculated by the scoring section in the ❺ Judge 
Scores (Points) box.  FVD will calculate the ❹ Percent (FINAL PERCENT) or the MEAN FINAL PERCENT.  

9

5
6

3 4

7

8

9

10

2

223.0

-2

221.0 66.970%3

1

2

SUBTOTAL POINTS

ERROR POINTS

FINAL POINTS

4 FINAL PERCENT

[1.5% total]

[-2 for each other error] 2
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Scoring > FVD Manual Scoring & Computer Use During the Show > USEF 
& FEI YH, FEI Children, FEI Pony, FEI Junior Tests > Errors of Course Only

• OPTION 2: 
o Enter the ❶ SUBTOTAL POINTS in the ❻ Judge Scores box.
o FVD automatically enters the ❼ PRELIMINARY POINTS in the Final Score box and the ❽ PRELIMINARY 

PERCENT in the Percent box.
o Click the ❾ Calc button.
o The ❿ Error Calculator form opens.
o Enter the ⓫ ERROR PERCENT in the Percentage box:
▪ For a 0.5% error, enter 0.005.
▪ For a 1.5% error, enter 0.015.

o Click ⓬ OK.  FVD updates ⓫ 0.005 (or 0.015) to ⓭ 0.50% (or 1.5%).  Click ⓮ OK.
o FVD automatically enters the ❹ FINAL POINTS) box and the ❺ FINAL PERCENT.
o If there is more than one judge, repeat for other judge position(s).
o FVD automatically calculates the MEAN FINAL POINTS and the MEAN FINAL PERCENT.

FVD MANUAL SCORING & COMPUTER USE DURING THE SHOW > USEF & FEI YH, FEI CHILDREN, FEI PONY, 
FEI JUNIOR TESTS > ERRORS OF COURSE ONLY:

IMPORTANT!!!

• With FVD, you have two entry options if there were errors of course (% deduction) only in these tests:
1. Use the FINAL POINTS hand calculated by the scoring section.
2. Use FVD to calculate the FINAL POINTS and FINAL PERCENT.

• OPTION 1: Enter the ❹ FINAL POINTS or MEAN FINAL POINTS calculated by the scoring section in the ❻ Judge 
Scores box.  FVD will calculate the ❺ FINAL PERCENT or the MEAN FINAL PERCENT. 

6

9

or 0.015 or 1.5%

7 8

4 5

223.0

0

223.03

1

2

67.076%221.351

SUBTOTAL POINTS

ERROR POINTS

FINAL POINTS

FINAL PERCENTPRELIMINARY POINTS

4

5

(1.5% total)

[1.5% total]

[-2 for each other error]

10

11

12

13

14

11

10 10

0.5% ERROR PERCENT11

NOTE:  
• Fortunately, errors 

during a test are 
infrequent. 

• Error handling for 
FEI tests with 
ERRORS OF 
COURSE looks 
rather complicated.  
However, you and 
FVD will not need to 
do the math very 
often.
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Scoring > FVD Manual Scoring & Computer Use During the Show > USEF & 
FEI YH, FEI Children, FEI Pony, FEI Junior Tests > Both Error Types

• OPTION 2: 
o Enter the ❶ SUBTOTAL POINTS in the ❻ Judge Scores box.
o Click the ❼ Calc button.
o The ❽ Error Calculator form opens.
▪ Enter the ❾ ERROR PERCENT in the Percentage box:
➢ For a 0.5% error, enter 0.005.
➢ For a 1.5% error, enter 0.015.

▪ Enter the ❷ ERROR POINTS in the Points box.
o Click ❿ OK.
o FVD automatically enters the ❹ FINAL POINTS box and the ❺ FINAL PERCENT.
o If there is more than one judge, repeat for other judge position(s).
o FVD automatically calculates the MEAN FINAL POINTS and the MEAN FINAL PERCENT.

FVD MANUAL SCORING & COMPUTER USE DURING THE SHOW > USEF & FEI YH, FEI CHILDREN, FEI PONY, 
FEI JUNIOR TESTS > BOTH ERROR TYPES:

IMPORTANT!!!

• With FVD, you have two entry options if there were both types of errors (points & percent deducted):
1. Use the final points hand calculated by the scoring section.
2. Use FVD to calculate the final points and final percent.

• OPTION 1: Enter the ❹ FINAL POINTS or the MEAN FINAL POINTS calculated by the scoring section in the ❻
Judge Scores box.  FVD will calculate the ❺ FINAL PERCENT or the MEAN FINAL PERCENT. 
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9

88

9

or 0.015 or 1.5%

10

3 4

4 5

22

223.0
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221.03

1

2

66.470%219.3514

5

SUBTOTAL POINTS

ERROR POINTS

FINAL POINTS

FINAL PERCENTPRELIMINARY FINAL POINTS

[1.5% total]

[-2 for each other error]

9

2
-0.5% 9 ERROR PERCENT

NOTE:  
• Fortunately, errors during a test are 

infrequent.  
• Error handling for FEI tests with 

ERRORS OF COURSE looks rather 
complicated.  However, you and FVD 
will not need to do the math very often.
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Scoring > FVD Manual Scoring & Computer Use During the Show > 
FEI YR through GP Tests > Other Errors Only

• OPTION 2:
o Enter the ❶ SUBTOTAL POINTS in the ❺ Judge Scores box.
o FVD automatically enters ❻ PRELIMINARY POINTS in the Final Score box and ❼ PRELIMINARY PERCENT 

in the Percent box.
o Click the ❽ Calc button.
o The ❾ Error Calculator form opens.
o Enter the ❷ ERROR POINTS in the Points box.
o Click ❿ OK.
o FVD automatically enters the ❸ FINAL POINTS and the ❹ FINAL PERCENT.
o If there is more than one judge, repeat for other judge position(s).
o FVD automatically calculates the MEAN FINAL POINTS and the MEAN FINAL PERCENT.

FVD MANUAL SCORING & COMPUTER USE DURING THE SHOW > FEI YR THROUGH GP TESTS > OTHER 
ERRORS ONLY:

• With FVD, you have two entry options if there were other errors (points deducted) only in these tests:
1. Use the FINAL POINTS hand calculated by the scoring section.
2. Use FVD to calculate the FINAL POINTS and FINAL PERCENT.

• OPTION 1: Enter the ❹ FINAL POINTS or the MEAN FINAL POINTS calculated by the scoring section in the 
❻ Judge Scores box.  FVD will calculate the ❺ FINAL PERCENT or the MEAN FINAL PERCENT. 

9 9

2

5
6 7

8

3 4

314

-2

312

1

2 ERROR POINTS 

3 67.826%

SUBTOTAL POINTS 

FINAL POINTS 

4 FINAL PERCENT [-2 for each other error]
2
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Scoring > FVD Manual Scoring & Computer Use During the Show > 
FEI YR through GP Tests > Errors of Course Only

• OPTION 2:
o Enter the ❶ SUBTOTAL POINTS in the ❻ Judge Scores box.
o FVD automatically enters the ❼ PRELIMINARY POINTS in the Final Score box 

and the ❽ PRELIMINARY PERCENT in the Percent box.
o Click the ❾ 2% button.
o FVD subtracts 2% from the ❽ PRELIMINARY PERCENT) and enters the ❺

FINAL PERCENT and the ❹ FINAL POINTS.
o If there is more than one judge, repeat for other judge position(s).
o FVD automatically calculates the MEAN FINAL POINTS and the MEAN FINAL 

PERCENT.

FVD MANUAL SCORING & COMPUTER USE DURING THE SHOW > FEI YR THROUGH GP TESTS > ERRORS OF 
COURSE ONLY:

• With FVD, you have two entry options if there were errors of course (% deduction) only in these tests:
1. Use the final points hand calculated by the scoring section.
2. Use FVD to calculate the final points and final percent.

• OPTION 1: Enter the ❹ FINAL POINTS or MEAN FINAL POINTS calculated by the scoring section in the 
❻ Judge Scores box.  FVD will calculate the ❺ FINAL PERCENT or the MEAN FINAL PERCENT.

NOTE:  
• Fortunately, errors 

during a test are 
infrequent. 

• Error handling for FEI 
tests with ERRORS 
OF COURSE looks 
rather complicated.  
However, you and 
FVD will not need to 
do the math very 
often.
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SUBTOTAL POINTS 

FINAL POINTS 4 304.801 66.261%

5 FINAL PERCENT

[-2 for each other error]

PRELIMINARY POINTS 

9

2% 2 ERROR PERCENT 
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Scoring > FVD Manual Scoring & Computer Use During the Show > 
FEI YR through GP Tests > Both Error Types 

• OPTION 2: 
o Enter the ❶ SUBTOTAL POINTS in the ❻ Judge Scores box.
o FVD automatically enters the ❼ PRELIMINARY POINTS in the Final Score box and the ❽

PRELIMINARY PERCENT in the Percent box .
o Click the ❼ Calc button.
o The ❽ Error Calculator form opens.
o Enter the ❾ ERROR PERCENT (-2%).
o Enter the ❷ ERROR POINTS (-2).
o Click ⓫ OK.
o FVD automatically enters the ❹ Final Score (FINAL POINTS) box and the ❺ Percent (FINAL 

PERCENT) .
o If there is more than one judge, repeat for other judge position(s).
o FVD automatically calculates the MEAN FINAL POINTS and the MEAN FINAL PERCENT.

FVD MANUAL SCORING & COMPUTER USE DURING THE SHOW FEI YR THROUGH GP TESTS> BOTH ERROR 
TYPES:

• With FVD, you have two entry options if there were both types of errors (points & percent deducted):
1. Use the final points hand calculated by the scoring section.
2. Use FVD to calculate the final points and final percent.

• OPTION 1: Enter the ❹ FINAL POINTS or the MEAN FINAL POINTS calculated by the scoring section in the ❻
Judge Scores box.  FVD will calculate the ❺ FINAL PERCENT or the MEAN FINAL PERCENT.
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1 SUBTOTAL POINTS
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65.826%302.8004FINAL POINTS FINAL PERCENT 

[-2 for each other error]
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9
-2% 9 ERROR PERCENT 
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NOTE:  
• Fortunately, 

errors 
during a 
test are 
infrequent. 

• Error 
handling for 
FEI tests 
with 
ERRORS OF 
COURSE 
looks rather 
complicated
.  However, 
you and 
FVD will not 
need to do 
the math 
very often.
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• If there is no score for a ride, using the ❶ Term drop-down, ❷ select the reason for the termination of 
the ride:
o Eliminated: The judge eliminated the rider. The horse/rider may compete in other classes.
o HC: Hors de Concours – The rider rode w/o a recorded score.  Show management must agree to an HC 

ride prior to the start of the class.
o No Show: The competitor failed to notify the competition secretary of his/her intention to scratch.
o Retired: The test was stopped and the rider/horse pair may no longer participate in the competition 

w/o permission from the competition management.  [NOTE: This appears to be an eventing term.]
o Scratch: The rider voluntarily withdrew prior to the beginning of the class.
o Withdrew: The rider voluntarily stopped the ride and, with the permission of the judge, left the arena 

w/o completing the test.  The horse/rider may compete in other classes in the show.
o Vet Out:  The rider withdrew at the recommendation of a veterinarian.

• When all scores for this recording session for this class are entered, click ❸ Close.

367

Scoring > FVD Manual Scoring & Computer Use During the Show > 
Term(ination)

NOTE:  For results reports sent to USEF and USDF, if a ride has no score, a S (scratch), E (eliminated), R (retired), or 
VW (voluntarily withdrew) are required in the Place box.  With FVD, you enter this information in the Term box.  
The FVD Program enters this information in the final report sent to USEF and USDF.  How nice!

FVD MANUAL SCORING & COMPUTER USE DURING THE SHOW > TERM(INATION):

1

2

3

2
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• When the ❶ dressage test sheets come in from the rings, the scoring department computes the FINAL 
POINTS and FINAL PERCENT using a hand calculator and records them on the test sheet.  If a calculator 
printer tape is used, the tape is attached to the test sheet. 

• The FINAL POINTS and FINAL PERCENT are verified by a second scorer.
• The scored test sheets are provided to the ❷ Head Scorer / Computer Operator.
• Using the test sheets, the Head Scorer / Computer Operator:
o Enters the scores, movement-by-movement, into ❸ FVD.
o Verifies that the FVD calculation matches the hand calculation.
o (Optional) Uses the ❹ Day Sheets Scoring report (or Handwritten Score Sheet report) as a method to:
▪ Track scored tests.
▪ Determine if the test and ribbon must be held until cleared by the show office.
▪ (Optional) Writes the points and percentages on the Day Sheets Scoring report (or Handwritten Score 

Sheet report) as a back-up.  
• When a class is finished, the Head Scorer / Computer Operator:
o Using FVD, places the class.
o Prints and posts three copies of the ❺ FVD score report (for awards, announcer, and for posting).
o Provides the test sheets to the ❻ awards section.

• After the show, the computer operator ❼ sends results to USEF and USDF.
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REPORTS6
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FVD STANDARD SCORING & COMPUTER USE DURING THE SHOW > FLOWCHART:

Scoring > FVD Standard Scoring & Computer Use During the Show > Flowchart 
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Scoring > FVD Standard Scoring & Computer Use During the Show > 
Set Up Standard Scoring 

• The ❹ Show Preferences form opens.
• In the ❺ General tab > ❻ Scoring, select ❼ Standard Scoring. 
• Click ❽ Close to return to the Main Menu.

7

5

6

4

8

• Select ❶Main Menu > ❷ Show Office
> ❸ Show Preferences.  

1

2

3

FVD STANDARD SCORING & COMPUTER USE DURING THE SHOW > SET UP STANDARD SCORING:

NOTE: Standard Scoring requires use of the FVD computer during the show.

NOTE: In previous versions of FVD, Standard Scoring was called Instant Scoring.
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• Select ❶Main Menu > ❷ Scoring.  
• Using the ❸ Class (Lookup) drop-down 

arrow, select the ❹ number of the class 
to be scored.  Alternately, type the class 
number in the box and press return.

371

Scoring > FVD Standard Scoring & Computer Use During the Show > 
Open the Scoring Form

• By default, the form opens with judge 
position ❺ C.  This is what you need for 
a class with one judge.

• Click ❻ Score.

NOTE FOR CLASSES WITH MORE THAN 
ONE JUDGE: 
• If the class has more than one judge, 

after you enter the marks and errors for 
judge position C, return to Step ❺ and 
select the radial button corresponding 
to the next judge position.  Enter the 
marks and errors from that judge.  Etc.

• When all judge scores are entered, you 
can view and print all scores on one 
report.  See Multi-Judge Sheets.

1

2

3

4

FVD STANDARD SCORING & COMPUTER USE DURING THE SHOW > OPEN THE SCORING FORM:

6

57

NOTE: When you are using Standard 
Scoring, FVD provides the option of using 
❼ barcodes to find the correct test to 
score.  See Barcodes for procedure.
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• The ❶ Scoring - C (or another selected judge position) form opens.
• Ensure you have the correct Class and Judge Position; select Entry Number:

o Ensure you have selected the correct ❷ Class and❸ Judge Position.  In this example, it is Class 103, Judge at C.
o Using the ❹ Entry (Lookup) dropdown arrow, the text box, or using the ❺ Previous Entry and ❻ Next Entry 

icons, select the correct ❼ Entry #.  In this example, it is Entry #116.
• Standard Marks:

o Place the curser in the movement ❽ POINTS box (left column with red text) and enter the POINTS for the first 
movement.  Press Enter. The movement ❾ TOTAL POINTS is automatically calculated by the computer, using the 
coefficients if applicable, and entered in the right column box.

o The cursor is automatically moved to the next POINTS box.
o Continue entering movement POINTS, ensuring you have the correct movement points in the correct box.  

• Collective Marks:
o When you have finished entering the movement POINTS, the curser automatically moves to the ❿ collectives

POINTS (left column).
o Enter the POINTS for each collective mark.  The collective ⓫ TOTAL POINTS is automatically calculated by the 

computer, using the coefficients if applicable, and entered in the right column box.
• Score Results:  FVD automatically calculates the ⓬ FINAL POINTS (Score Results > Final Score) and the ⓭ FINAL 

PERCENT (Score Results > Percentage).
• If there are multiple judges, repeat for the other judge position(s).  See Multi-Judge Sheets for reporting scores from 

multiple judges.

372

Scoring > FVD Standard Scoring & Computer Use During the Show > 
Most Tests > No Errors

FVD STANDARD SCORING & COMPUTER USE DURING THE SHOW > 
MOST TESTS > NO ERRORS:

NOTE: You can also use barcodes.  
See Barcodes for procedure.
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NOTE:  Errors during a 
test are infrequent; 
therefore, this is 
usually all you need to 
do to enter the scores 
for a ride.  Error 
handling looks rather 
complicated, mainly 
for FEI tests.  
However, you will not 
need to do the 
following pages very 
often.
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Scoring > FVD Standard Scoring & Computer Use During the Show > 
USEF/USDF Intro through Fourth Levels > Errors

• After entering the movement and collective POINTS, FVD enters ❶ PRELIMINARY POINTS in the Score 
Results > Final Score box and ❷ PRELIMINARY PERCENT in the Score Results > Percentage box.

• Click ❸ Calc.  
• The ❹ Error Calculator box opens.  
• Enter the ERROR POINTS in the ❺ Points box.  In this example, there were 2 ERROR POINTS.
• Click ❻ OK. 
• FVD subtracts the ERROR POINTS from the ❶ PRELIMINARY POINTS to determine the ❼ FINAL 

POINTS and calculates the ❽ FINAL PERCENT.
• If there are multiple judges, repeat for the other judge position(s).  See Multi-Judge Sheets for reporting 

scores from multiple judges.

FVD STANDARD SCORING & COMPUTER USE DURING THE SHOW > 
USEF/USDF INTRO THROUGH FOURTH LEVELS > ERRORS:
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7 8

FROM TEST SHEET

[6 points total]5
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Scoring > FVD Standard Scoring & Computer Use During the Show > USEF 
& FEI YH, FEI Children, FEI Pony, FEI Junior Tests > Other Errors Only

FVD STANDARD SCORING & COMPUTER USE DURING THE SHOW > USEF & FEI YH, FEI CHILDREN, FEI 
PONY, FEI JUNIOR TESTS > OTHER ERRORS ONLY:

• For FEI Other Errors, points are deducted from the PRELIMINARY POINTS.
• After entering the movement and collective POINTS, FVD enters ❶ PRELIMINARY POINTS (Score 

Results > Final Score) and ❷ PRELIMINARY PERCENT (Score Results > Percentage).
• Click ❸ Calc.  
• The ❹ Error Calculator box opens.  
• Enter the ERROR POINTS in the ❺ Points box (in this example -2 ERROR POINTS).  
• Click ❻ OK. 
• FVD subtracts the ERROR POINTS from the ❶ PRELIMINARY POINTS) to determine the ❼ FINAL 

POINTS and calculates the ❽ FINAL PERCENT.
• If there are multiple judges, repeat for the other judge position(s).  See Multi-Judge Sheets for reporting 

scores from multiple judges.
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[1.5% total]

[-2 for each other error]5
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Scoring > FVD Standard Scoring & Computer Use During the Show > USEF 
& FEI YH, FEI Children, FEI Pony, FEI Junior Tests > Errors of Course Only

FVD STANDARD SCORING & COMPUTER USE DURING THE SHOW > USEF & FEI YH, FEI CHILDREN, FEI 
PONY, FEI JUNIOR TESTS > ERRORS OF COURSE ONLY:

• For FEI Errors of Course, a percent is deducted from the PRELIMINARY PERCENT.
• After entering the Standard Marks and Collective Marks, FVD enters ❶ PRELIMINARY POINTS in the 

Score Results > Final Score box and ❷ PRELIMINARY PERCENT in the Score Results > Percentage box.
• Click ❸ Calc.  
• The ❹ Error Calculator box opens.  
• Enter ERROR PERCENT in the ❺ Points  box.  
• Click ❻ OK. 
• FVD subtracts 0.5% (or 1.5%) from the ❶ PRELIMINARY PERCENT to determine the ❽ FINAL PERCENT 

and calculates the ❼ FINAL POINTS.
• If there are multiple judges, repeat for the other judge position(s).  See Multi-Judge Sheets for reporting 

scores from multiple judges.
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[1.5% total]

[-2 for each other error]
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Scoring > FVD Standard Scoring & Computer Use During the Show > USEF & 
FEI YH, FEI Children, FEI Pony, FEI Junior Tests > Both Error Types

FVD STANDARD SCORING & COMPUTER USE DURING THE SHOW > USEF & FEI YH, FEI CHILDREN, FEI 
PONY, FEI JUNIOR TESTS > BOTH ERROR TYPES:

• For both types of FEI errors, a both points and a percent are deducted.
• After entering the movement and collective POINTS, FVD enters ❶ PRELIMINARY POINTS in the Score 

Results > Final Score box and ❷ PRELIMINARY PERCENT in the Score Results > Percent box.
• Click ❸ Calc.  
• The ❹ Error Calculator box opens.  
• Enter the ERROR PERCENT in the ❺ Percentage box.  
• Enter the ERROR POINTS in the ❻ Points box.
• Click ❼ OK. 
• FVD performs the calculations to determine the ❽ FINAL PERCENT and the❼ FINAL POINTS.
• If there are multiple judges, repeat for the other judge position(s).  See Multi-Judge Sheets for reporting 

scores from multiple judges.

3

4

5

6

7

7 8

1 2

[1.5% total]

[-2 for each other error]

5

6
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Scoring > FVD Standard Scoring & Computer Use During the Show > FEI 
Young Rider through Grand Prix Tests > Other Errors Only

FVD STANDARD SCORING & COMPUTER USE DURING THE SHOW > FEI YR THROUGH GP TESTS > OTHER 
ERRORS ONLY:

• For FEI Other Errors, points are deducted from the PRELIMINARY POINTS.
• After entering the movement and collective POINTS, FVD enters ❶ PRELIMINARY POINTS in the Score 

Results > Final Score box and ❷ PRELIMINARY PERCENT in the Score Results > Percentage box.
• Click ❸ Calc.  
• The ❹ Error Calculator box opens.  
• Enter the ERROR POINTS in the ❺ Points box.  
• Click ❻ OK. 
• FVD subtracts the ❺ ERROR POINTS from the ❶ PRELIMINARY POINTS to determine the ❼ FINAL 

POINTS) and calculates the ❽ FINAL PERCENT.
• If there are multiple judges, repeat for the other judge position(s).  See Multi-Judge Sheets for reporting 

scores from multiple judges.

1

7 8

4

5

6

2

3

[-2 for each other error]
5
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Scoring > FVD Standard Scoring & Computer Use During the Show > FEI 
Young Rider through Grand Prix Tests > Errors of Course Only

FVD STANDARD SCORING & COMPUTER USE DURING THE SHOW > FEI YR THROUGH GP TESTS > ERRORS 
OF COURSE ONLY:

• For FEI Errors of Course, a percent is deducted from the PRELIMINARY PERCENT.
• After entering the movement and collective POINTS, FVD enters ❶ PRELIMINARY POINTS in the Score 

Results > Final Score box and ❷ PRELIMINARY PERCENT in the Score Results > Percentage box.
• To deduct the ERROR PERCENT, click ❸ 2%.  
• FVD subtracts 2% from the ❷ PRELIMINARY PERCENT to determine the ❽ FINAL PERCENT  and 

calculates the ❼ FINAL POINTS.
• If there are multiple judges, repeat for the other judge position(s).  See Multi-Judge Sheets for reporting 

scores from multiple judges.

3

7 8

1 2

[-2 for each other error]

3
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Scoring > FVD Standard Scoring & Computer Use During the Show > FEI 
Young Rider through Grand Prix Tests > Both Error Types 

FVD STANDARD SCORING & COMPUTER USE DURING THE SHOW > FEI YR THROUGH GP TESTS > BOTH 
ERROR TYPES:
• For both types of FEI errors, a both points and a percent are deducted.
• After entering the movement and collective POINTS, FVD enters ❶ PRELIMINARY POINTS in the Score 

Results > Final Score box and ❷ PRELIMINARY PERCENT in the Score Results > Percentage box.
• Click ❸ Calc.  
• The ❹ Error Calculator box opens.  
• Enter the ERROR PERCENT in the ❺ Percentage box.  
• Enter the ERROR POINTS in the ❻ Points box.
• Click ❼ OK. 
• FVD performs the calculations to determine the ❽ FINAL PERCENT) and the❼ FINAL POINTS.
• If there are multiple judges, repeat for the other judge position(s).  See Multi-Judge Sheets for reporting 

scores from multiple judges.

3

4

5

7

7 8

6

1 2

[-2 for each other error]

5

6
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Scoring > FVD Standard Scoring & Computer Use During the Show > 
Term(ination) Reason 

• If the ride was terminated, use the ❶ Term Reason drop-down box and select the reason.

• Compare the computer input and results to the test sheet and scorer results.  If any entries or 
calculations do not match, reenter/recalculate until they match.

• To print the score sheet (some shows include this printout with the test sheets), click the ❷ Print
button.

• If desired, staple the test sheet, the printed score sheet, and the calculator tape together so they can be 
given to the rider.

• When finished with this task, click ❸ Close.  You can reopen the class for additional entries as the test 
sheets arrive.

• Repeat for all the rides of the class as the test sheets arereceived.
• If multiple classes are coming to the scoring desk, they are scored then sorted into a class folder to hold 

until the class is finished and ready to be awarded. 

1

2 3

FVD STANDARD SCORING & COMPUTER USE DURING THE SHOW > TERM(INATION) REASON:
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Scoring > FVD Standard Scoring & Computer Use During the Show > 
Barcodes > Introduction, Procedure

• When you are using Standard Scoring (but NOT Manual Scoring),  you have the option to use FVD’s 
barcodes feature.

• This feature includes barcodes on the test sheet labels.  When scoring, the barcode is swiped and FVD 
automatically opens the correct test to be tested.

FVD STANDARD SCORING & COMPUTER USE DURING THE SHOW > BARCODES > INTRODUCTION:

1

2

• Use Standard Scoring (see Set Up Standard Scoring).
• Download and install the Barcode Font (click here for instructions on the FVD web site).  Ensure you 

install both the Fre3of9x.ttf and free3of9.ttf files.
• When printing the ❶ Test Labels (see Print Dressage Test Sheet Labels), check the ❷ Barcode check 

box. 

FVD STANDARD SCORING & COMPUTER USE DURING THE SHOW > BARCODES > PROCEDURE:

• The dressage test sheet labels will have barcodes on them.

• During the show, when scoring receives a test to be scored, the barcode is scanned (click here for 
suggested devices on the FVD web site) and FVD automatically opens the correct ride to be scored.

http://www.foxvillage.com/barcode.asp
http://www.foxvillage.com/barcode.asp
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Place a Class > Introduction, Open Place/Rank Class Form

• Classes can be placed in one of three 
methods:
o Standard: (Default setting – no divisions)  

All riders are considered equally and are 
placed 1-n, based on their scores.

o Rider Status:  Riders are first grouped as 
Open, Adult Amateur or Junior/Young 
Rider divisions, then each of these three 
divisions is sorted and placed separately 
1-n.

o Ride Status: For GAIG qualifying rides 
(the entry paid the Q fee for a Q class), 
the rides are grouped by Q-Yes and Q-No 
divisions, then each of these divisions is  
sorted and is placed separately 1-n.

• These methods let you have ONE class with 
a mixture of riders or rides, but separate 
placings.  ONE class rather than several 
classes split by division, all riding the same 
tests, can be easier to schedule and work 
with conflict resolution.

• Select ❶Main Menu > ❷ Scoring.
• Using the ❸ Class (Lookup) drop-down arrow or text box, select the class you want to place.
• To use the default (Standard), click ❹ Place.
• To select a different placing method, use the ❺ Place drop-down arrow and select ❻ Rider Status or Ride 

Status.
• Click ❹ Place.
• The ❼ Place/Rank Class form opens.
• Hand type the ❽ placings (see next page for examples).

6

INTRODUCTION:

3

OPEN PLACE/RANK CLASS FORM:

7

8

• See Data File for USEF & USDF > Classes Awarded by Rider Status or Ride Status for further information on 
reporting these divisions to USEF and USDF.

NOTE:  This procedure is the same for 
Standard Scoring and Manual Scoring.
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Place a Class > Placing Methods
PLACING METHODS:

• To print this form, click the ❾ Print button.

• STANDARD:  
o All rides are sorted by ❶ Final Percent, highest percent to lowest percent, without divisions.
o To place the class, hand type ❷ 1 – n.  

• RIDER STATUS:  
o All rides are sorted by ❸ Rider Status (AA, then JYR, then Open), then by ❹ Final Percent, highest percent to 

lowest percent.
o To place the class, hand type ❺ 1 – n for each rider status.  

• RIDE STATUS:  
o All rides are sorted by ❻ Ride Status, then by ❼ Final Percent, highest percent to lowest percent, without 

divisions.
o To place the class, hand type 1 – n for each ride status.   

NOTE 2: FVD does not 
provide an option for 
awarding classes by O 
and AJY divisions.  If 
this is how you award a 
class, use Place by 
Rider Status, then 
hand-place the AJY 
division.

1 2

3 4 5

6 7 8

9

NOTE 3: See Data File 
for USEF & USDF > 
Classes Awarded by 
Rider Status or Ride 
Status for information 
on reporting these 
divisions to USEF and 
USDF.

NOTE 1: This is the 
default FVD selection.



Fox Village Dressage User Manual – 2021 Update 1.0.5. helpdesk@foxvillage.com                 www.foxvillage.com

SECTION III. DURING THE SHOW

385

Place a Class > Ties, Ride with FINAL POINTS and FINAL PERCENT but no Place, 
Ride with No FINAL POINTS and No FINAL PERCENT

TIES:

USEF DR 123.3. Individual Classification: In case of equality of points [ties] the competitor with the highest 
marks received under General Impressions [Collective Marks] shall be declared the winner. When the 
scores for General Impressions [Collective Marks] are equal after coefficients have been applied, the horses 
must remain tied. 

INTERPRETATION: If two horse/rider pairs in a class/division have the same FINAL PERCENT (a tie), the 
sum (collective marks x coefficients) determine the placings:
• If horse/rider pair 1 has a higher sum (collective marks x coefficients), that pair receives the higher 

placing and horse/rider pair 2 receive the next placing.
• If horse/rider pair 1 and horse/rider pair 2 have the same sum (collective marks x coefficients), they 

receive the same placing.  The next placing is skipped, and horse/rider pair 3 receive the following 
placing.

HORSE/RIDER PAIR FINAL PERCENT
SUM 

(COLLECTIVE MARKS x 
COEFFICIENTS)

PLACE EXAMPLE

Horse/Rider Pair 1 65.000% 46 n 2

Horse/Rider Pair 2 65.000% 43 n+1 3

Horse/Rider Pair 3 64.000% NA n+2 4

HORSE/RIDER PAIR FINAL PERCENT
SUM 

(COLLECTIVE MARKS x 
COEFFICIENTS)

PLACE EXAMPLE

Horse/Rider Pair 1 65.000% 46 n 2

Horse/Rider Pair 2 65.000% 46 n 2

Horse/Rider Pair 3 64.000% NA n+2 4

• Horse/rider pair 1 has higher sum (collective marks x coefficients) than horse/rider pair 2:

• Horse/rider pair 1 has the same sum (collective marks x coefficients) as horse/rider pair 2:

• FVD does not automatically sort for ties.  The computer user must hand place the places.

RIDE WITH FINAL POINTS AND FINAL PERCENT BUT NO PLACE:
• If a ride has FINAL POINTS and FINAL PERCENT but did not place in the class, for the *.dat file FVD will 

automatically enter 0 in the place box.

RIDE WITH NO FINAL POINTS AND NO FINAL PERCENT :

• If a ride has no score, ensure the Term is entered (see Term(ination).  FVD will automatically enter S
(scratch), E (eliminated), R (retired), or VW (voluntarily withdrew) in the place box for the *.dat file.
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• If you are using Manual Scoring and will not
award the class by divisions, you can use Score > 
Quick Place.

• When every score and term reason for the class 
have been entered, select ❶ Main Menu > ❷
Scoring > ❸ Score.

386

Place a Class > Manual Scoring > Place a Class without Divisions Using Quick Place

• The ❹Manual Score Sheet opens.

• Click ❺ Quick Place.

• Type the place (1, 2, 3, 4, etc.) sequentially in the 
❼ Place boxes.   

• Take care in placing ties as the FVD program does 
not sort ties by Collective Marks; therefore, you 
may need to place 1, 2, 4, 3, … or 1, 2, 3, 3, 5, …, 
etc. depending upon the Collective Marks results.

• If the entry has a score but did not place, in the 
USEF/USDF *.dat file, FVD will automatically 
enter 0 in the place box, which is required.

MANUAL SCORING > PLACE A CLASS WITHOUT DIVISIONS USING QUICK PLACE:

1

2

3

4

5

• This ❻ sorts all the rides in the class, with 
the highest percentage score first, etc., but 
does NOT enter the placing in the ❼ Place
box.  
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Print a Results Report > Preliminary Report

• If you have a large class, you may want to 
print preliminary report(s) during the day, 
which have scores for rides that have 
been completed.  This makes some riders 
happy; however, others may be confused, 
thinking the results are complete.

• To print a preliminary score report for a 
completed class report, select ❶Main 
Menu > ❷ Scoring >❸ Standard >❹
Place.

1

2

3

4

5

6

PRELIMINARY REPORT:

• The ❺ Place / Rank Class form opens.
• Note that the initial riders have ❻ percents, but the latter riders do not because they have not yet 

ridden their tests or their tests have not yet been scored. 
• Click the ❼ Print icon to print the form.
• Write PRELIMINARY on the printout and post it in the score reports area.

7

NOTE 3: Many shows use this printout to post class results as it is a small report.  Before you do this, ask your 
TD as some of them require a Final Report (see Print Score Report) as it provides the points, time printed and 
the term reason.

NOTE 1:  Although printing a preliminary report is a good idea, some rides may be confused, thinking the class 
and complete and the final results posted.  To avoid this confusion, you may want to hand write (in large bold 
perhaps red text) PRELIMINARY on the print-out.

PRELIMINARY

NOTE 2: Since results are now available “live” online, this preliminary report may no longer be necessary.
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• The ❺ Final Score 
Report opens.

• Check the report to 
ensure you are looking at 
the correct class, the 
results are correct.

• To print the report, click 
the ❻ Print icon.

• If the report is generated 
during the show and 
paper results are 
required:
o Post the results at the 

designated area.
o Supply a copy to:
▪ Announcer.
▪ Awards.

o If you do not have a 
Day Sheet Scoring
report, keep a copy for 
archiving.

• Click ❼ Close Print 
Preview to close the 
report.

389

Print a Results Report > Final Report

• To print a final score report for a 
completed class report, select ❶Main 
Menu > ❷ Scoring.

• Ensure that the ❸ Final box is checked 
(the default).

• Click ❹ Report. 

1

2

3

4

FINAL REPORT:

NOTE: Some TDs require this Final Report as it provides the time printed, 
the score, percent, and the place.  Ask your TD which report s/he requires.

5

6

7
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NOTE: DO NOT DO THE FOLLOWING UNTIL YOU ARE ABSOLUTELY SURE 
YOU WILL NOT NEED TO MAKE ANY CHANGES AS YOU WILL NOT BE ABLE 
TO DO SO!!!  IN MOST CASES, DO NOT USE THIS FEATURE.

391

Close a Class

• This procedure was created for large 
shows with multiple computer users.  In 
this circumstance, after a class is placed 
and printed, it can be a good idea to close 
the class to avoid any accidental changes.  
Smaller shows with smaller staff may 
choose to not use this feature. 

• Select ❶Main Menu > ❷ Scoring.
• Using the ❸ Class (Lookup) drop-down 

arrow, select the number of the class you 
want to close.

• Click on ❹ Close Class.

5

6

• A ❺ Fox Village Dressage warning form opens.
• Click on ❻ Yes to prevent inadvertent changes.  
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Upload Show Results to the Web > FVD Online Entries, Ride Times & Results Web Site

• During and after the show you have options to 
upload your results to the FVD web site.

• Select ❶Main Menu > ❷ Fox Village Dressage 
Online Tools  > ❸ Upload Results.

4

5

• The ❹ Upload Ride Times & Results to Web 
form opens.

• Click ❺ Click here to view Ride Times & 
Results website.

• The ❻ Fox Village Dressage Online Entries, 
Ride Times and Results web page opens.  

• Results can be displayed ❼ By Class, ❽ By 
Rider, ❾ By Horse and ❿ Scratch.  Navigate 
through this page to familiarize yourself with its 
features and functions.

Show Name  Show Name  Show Name

Show Name  Show Name  Show Name

Show Name  Show Name  Show Name

ShowContactEmail@email.com

ShowContactEmail@email.com

ShowContactEmail@email.com

Show Name  Show Name  Show Name

Show Name  Show Name  Show Name

Show Name  Show Name  Show Name

Show Name  Show Name  Show Name

ShowContactEmail@email.com

ShowContactEmail@email.com

ShowContactEmail@email.com

ShowContactEmail@email.com

6

7 8 9 10

1

2
3

FVD ONLINE ENTRIES, RIDE TIMES & RESULTS WEB SITE:
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Upload Show Results to the Web > FVD Online Entries, Ride Times & Results Web Site > 
Upload

• To upload your show’s results, click ❶ Upload 
Now. 

• A ❷ Fox Village Dressage form opens advising 
you that the results have been uploaded.

• Click ❸ OK.

3

2

1

FVD ONLINE ENTRIES, RIDE TIMES & RESULTS WEB SITE > UPLOAD:
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395

Upload Show Results to the Web > FVD Online Entries, Ride Times & Results Web Site > 
Stream Results Live to the FVD Web Site

• If you are at the show, your computer has an 
internet connection, and you are entering scores 
in the computer, you can stream your results live 
to the FVD website.

• To activate this feature, click ❶ Start. 

• The form now has a message ❷ Your results 
are currently streaming, informing you that your 
results are automatically loaded onto the FVD 
website every five minutes.

• The streamed results automatically upload class results as they are entered into your show computer or 
the FVD server.  The screen displays results by class, by rider, by horse and scratch, with results sorted by 
percentages, showing the highest percentage first.  

• This feature is very convenient for competitors and anyone interested in “real-time” show results.  For 
example, after a rider completes a ride, s/he can use an internet-connected cell phone, tablet, etc. to log 
on to http://www.foxvillage.com/fvdshowresults to find their scores and how they placed in the class, in 
real time.

• To stop the streaming, click the ❸ Stop button.

• The form now has a message ❹ Your results 
have stopped streaming.

2

3

4

FVD ONLINE ENTRIES, RIDE TIMES & RESULTS WEB SITE > STREAM RESULTS LIVE TO THE FVD WEB SITE:

http://www.foxvillage.com/fvdshowresults
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Upload Show Results to the Web > Generate URLs 

• You can also generate URLs to your show’s web 
pages on the FVD website.

• To activate this feature, click ❶ Generate URLs.

• The URLs for your results ❷ By Class, ❸ By 
Rider, and ❹ Scratches are inserted into the 
boxes.

• Click each ❺ Click here to view to see the 
information linked by the URL.

• Copy and paste each URL to your web site to 
provide links to the information on the FVD web 
site.

• Click ❻ Close to return to the Main Menu.

5

6

2

3

4

1

GENERATE URLs:
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High Score Report > Introduction

• Many dressage shows provide awards to the horse/rider combination with the highest score of the show 
(Overall High Score) and the second highest score of the show (Reserve High Score).  There may also be 
awards for the highest score at each level (Training, First, Second, Third, Fourth, FEI, MFS), as well as 
awards for the highest score for each rider status (Open, Adult Amateur, Junior/Young Rider).  This 
report helps you determine the high score winners for your show.  You must first enter all the scores for 
the show/level/status.  

• Whenever possible, these reports are generated during the show so riders can receive their ribbons and 
accolades before they depart the show grounds.

• Select  ❶Main Menu > ❷ Reports > 
❸ Post-Show > ❹ High Score Report.

• The ❺ High Score Report form opens

• Click the ❻ Date drop-down arrow to select the 
date.  If you want results for the entire show, do 
not select a date.

• Using individual or successive ❼ Order By drop-
down arrows, you can select the order by which 
the report data is sorted.  You can choose up to 
five sort criteria:
1. Breed
2. Class
3. Level
4. Status [AA, JYR, Open]
5. Test

• If you click ❽ OK without making an Order By 
selection, the report lists every ride in the show, 
sorted from highest to lowest percentage score.  
Use this list to determine your show’s overall high 
score and reserve high score winners.

1

2

3

4

• We will look at a sort by Level and then a separate sort by [Rider] Status.  You can use different sorts, 
and combinations of sorts, depending upon the awards offered by your show.

NOTE : Overall, level, and rider status high score awards are usually only awarded to rides in Training, 1st, 2nd, 3rd, 
4th, and FEI (PSG, Intermediate, and GP).  Awards for freestyles, quadrilles, and Pas de Deux rides would be 
separate awards.  However, this is a decision to be made by show management.

6

8

7

5

Saturday, June DD, YYYY
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High Score Report > Sorted by Level > Select the Order By > Level

• ❽ Level now appears in the first Order By box.
• If you want to include another Order By, use the 

second drop-down arrow to select your next 
criterion.  In this example we will only sort by 
level.

• Click ❾ OK.

7

5

6

9

8

• Sorting the report by Level gives you the highest score for each level (Training, 1st, 2nd, 3rd, 4th, and FEI).  

• The ❺ High Score form opens.
• Using the first ❻ Order By drop down arrow, 

select ❼ Level.

• Select  ❶Main Menu > ❷ Reports > 
❸ Post-Show > ❹ High Score Report.

1

2

3

4
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High Score Report > Sorted by Level > Determine High Scores by Level

• The ❶ [High] Score report opens, sorted by Level, which contains:
o ❷ Entry #
o ❸ Rider name
o ❹ Horse name
o ❺ Test
o ❻ Breed
o ❼ Class #
o ❽ Class [Name]
o ❾ [Rider] Status
o ❿ [Final] Score
o ⓫ [Final] Percent
o ⓬ Place

• If desired, click ⓭ Print to print the report.  
• When you are ready to close the report, click ⓮ Close Print Preview.

Go to the next page for information on using the report.

SORTED BY LEVEL > VIEW BY LEVEL REPORT:

Highest Training Level

2 3 4 5 6 7 8 9 10 11 12

XXXX Blue Horse Dressage

13

14

1
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High Score Report > Sorted  by Level > Determine High Score Winner by Level

• The report sorted by Level has the following sequence:
o Training Level, starting with the highest Training Level score and ending with the lowest Training Level 

score.
o First Level, starting with the highest First Level score and ending with the lowest First Level score. 
o Second Level, starting with the highest Second Level score and ending with the lowest Second Level 

score.
o Third Level, starting with the highest Third Level score and ending with the lowest Third Level score.
o Fourth Level, starting with the highest Fourth Level score and ending with the lowest Fourth Level 

score.
o FEI Levels, starting with the highest FEI Level score and ending with the lowest FEI Level score.
o Other tests not usually awarded high score awards, such as freestyles, etc.
o Introductory Level, starting with the highest Introductory Level score and ending with the lowest 

Introductory Level score.

• The first horse/rider on the list is the Training Level High Score, as seen on the previous page.  If desired, 
highlight this ride.

• With a pen, draw a line between the last (lowest) Training Level score and the first (highest) First Level 
score.  Repeat for First/Second, Second/Third, Third/Fourth, and Fourth/FEI.

SORTED BY LEVEL > VIEW BY LEVEL REPORT > DETERMINE HIGH SCORE WINNER BY LEVEL:

• The first horse/rider at each level is the high score winner for that level.   You may want to highlight this 
horse/rider.

• The second horse/rider at each level is the reserve high score winner for that level.   You may want to 
highlight this horse/rider.

• Record all of these winners.  This is usually written on a separate piece of paper and/or hand-annotated 
on the High Score Report printout.

Lowest Training Level
Highest First Level

XXXX Blue Horse Dressage
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High Score Report > Sorted by Status > Select the Order By > [Rider] Status

• ❽ Status now appears in the Order By box.
• If you want to include another Order By, use the 

second drop-down arrow to select your next 
criterion.  For example, you could first select 
Status and then select Level.  

• In this example we will only sort by ❽ Status.
• Click ❾ OK.

• Sorting the report by [Rider] Status gives you the highest score for each rider status (Adult Amateur, 
JR/YR, Open).  

• The ❺ High Score form opens.
• Using the first ❻ Order By drop down arrow, 

select ❼ Status.

7

5

6

9

8

SORTED BY STATUS > SELECT THE ORDER BY > [RIDER] STATUS:

• Select  ❶Main Menu > ❷ Reports > 
❸ Post-Show > ❹ High Score Report.

1

2

3

4
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High Score Report > Sorted by Status > View Report by Status
• The ❶ High Score report opens, sorted by Level, which contains:

o ❷ Entry #
o ❸ Rider name
o ❹ Horse name
o ❺ Test
o ❻ Breed
o ❼ Class #
o ❽ Class [Name]
o ❾ Status
o ❿ Score
o ⓫ Percent
o ⓬ Place

• If desired, click ⓭ Print to print the report.  
• When you are ready to close the report, click ⓮ Close Print Preview.

Go to the next page for information on using the report.

Highest Adult Amateur

2 3 4 5 6 7 8 9 10 11 12

13

14

XXXX Blue Horse Dressage
1
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High Score Report > Sorted by Status > Determine High Scores by [Rider] Status

• The report sorted by [Rider] Status has the following sequence:
o Adult Amateur, starting with the highest Adult Amateur score and ending with the lowest Adult 

Amateur score.
o JR/YR, starting with the highest JR/YR score and ending with the lowest JR/YR score. 
o Open (Professional or USEF non-member), starting with the highest Open score and ending with the 

lowest Open score.

• The first horse/rider on the list is the Adult Amateur High Score (see previous page).
• With a pen, draw a line between the last (lowest) Adult Amateur score and the first (highest) JR/YR level 

score.  
• Repeat for JR/YR / Open.  
• Repeat for Open.

• Different shows have different rules on which classes are included in High Score Awards. 

• Record all of these winners.  This is usually written on a separate piece of paper and/or annotated on the 
High Score report printout.

SORTED BY STATUS > DETERMINE HIGH SCORES BY [RIDER] STATUS:

Lowest Adult Amateur

Highest JR/YR

Lowest JR/YR

Highest Open

XXXX Blue Horse Dressage
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*.dat File for USEF & USDF > Introduction, Classes Awarded by Rider Status

INTRODUCTION:

• Within 10 days of the show, your results must be emailed to 
USEF and USDF using a file (*.dat file) easily created by FVD.

• Before you create and email the *.dat file, you must ensure 
your results are in a format required by USEF and USDF:
o SITUATION 1:  If NONE of your classes were awarded by O, 

AA & JYR and/or O & AJY divisions, you are ready to create 
the *.dat file. 

o SITUATION 2:  If your show had SEPARATE CLASSES for O, AA 
& JYR and/or O & AJY divisions, you are ready to create the 
*.dat file.

o SITUATION 3: If, during the show, you had any classes that 
were awarded by O, AA & JYR and/or O & AJY divisions AND 
you later SPLIT THE CLASSES by rider status within the FVD 
software, you are ready to create the *.dat file. In this 
situation, you have one class that was split to multiple 
classes based on rider status.  See SPLIT CLASSES for 
information on splitting classes.

o SITUATION 4: If you had any classes that WERE awarded by 
O, AA & JYR or O & AJY divisions but NOT SPLIT by these 
divisions, you need to prepare your results before you 
create the *.dat file. In this situation, you have one class that 
was awarded by rider status.

• Open ❶ Main Menu > ❷ Show Office 
> ❸ Classes.

NOTE:
O = Open:  Class may be entered by all 
riders.  Professionals and USEF non-
members must ride in Open classes.
AA = A = Adult Amateur: Class may 

be entered by riders that fall within 
the USEF definition of Adult Amateur.  
See USEF GR1306 and GR 1307.
JYR = JY = Junior/Young Rider: Class 
may be entered by riders that fall 
within the USEF definition of Junior 
Rider and/or Young Rider.  See USEF 
GR128 Junior and  GR150 Young Rider.
AJY = Adult Amateur, Junior Rider 
and Young Rider: Class may be 
entered by riders that fall within the 
USEF definition of Adult Amateur, 
Junior Rider, or Young Rider.
O/AA/JY:  Class awarded by O, AA and 
JY divisions.
O/AJY: Class awarded by O and AJY 
divisions.

1

2

3

CLASSES AWARDED BY RIDER STATUS:

Continued on next page…
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*.dat File for USEF & USDF > Classes Awarded by Rider Status, Cont’d.

• The ❹ Class 
form opens.

• Use ❺ Class 
(Lookup) to 
select the class.

• Use the ❻
Split for 
Awards drop-
down arrow 
and select ❼
O/AJY or ❽
O/AA/JR, 
depending on 
how you 
awarded the 
class.

4

5

6

7
8

9

10

11

12

13

• After all classes awarded by rider status 
have been annotated as above, open ❿
Main Menu > ⓫ > Reports > ⓬ Post-
Show > ⓭ USEF eScores.

• Repeat ❺ -❽ for every class that was 
awarded by rider status.

• Click ❾ Close to close the form.

• The ⓮ USEF eScores form opens.
• Check the ⓯ Split for Awards (USEF 

only) box.
• Proceed to Create the FVD eScores 

(*.dat) File to create the *.dat file.

14

15

NOTE 1:  This procedure does not actually SPLIT 
the class.  It simply informs USEF and USDF that 
you awarded the class by rider status divisions.
NOTE 2:  Even though the nomenclature is 
USEF eScores, the report is also for USDF.
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*.dat File for USEF & USDF > Create the FVD eScores (*.dat) File

• Select  ❶Main Menu > ❷ Reports > 
❸ Post-Show > ❹ USEF eScores.   

2

1

3

4

USEF has some rather complicated instructions and Excel templates for the required electronic submission 
of results (click here).  Fortunately for the FVD user, FVD provides the information required by USEF (and 
USDF) when you submit the USEF eScores (*.dat) file generated by FVD.  

CREATE THE FVD eSCORES (*.DAT) FILE:

NOTE 1:  You must submit your results to USEF and USDF within 10 days of the show.  This includes the *.dat file, 
the USEF Post Competition Report, and the USDF Report of Fees.

NOTE 2:  When you create the USEF [/USDF] eScores (*.dat) file, the data is automatically (1) uploaded to the FVD 
site for updating and (2) synchronized with the Competitor Tent iOS app (click here).  If any of your competitors 
have registered with Competitor Tent, they will be contacted by Competitor Tent.  Therefore, DO NOT DO A 
PRACTICE RUN as your online show information will be changed.

NOTE 3:  USEF and USDF accept the same eScores file (*.dat file).  You can email the file to them with the same 
email by sending the file as an attachment to results@USEF.org and to results@USDF.org. 

NOTE 4:  USEF & USDF must be notified of classes that did not fill (classes for which there were no entries).  FVD 
automatically creates this information and includes it in the USEF eScores file.  How nice!

https://www.usef.org/forms-pubs/f_1TxwTvliY/universal-results-template---2020
https://competitortent.com/
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*.dat File for USEF & USDF > Create the FVD eScores (*.dat) File, Cont’d.

• The ❺ USEF eScores form opens.  
• If you awarded by rider status in any class, check 

the ❻ Split for Awards (USEF only) box.  See 
Classes Awarded by Rider Status for information.

• If you also want a *.dat file for other (local) 
organizations, check the ❼ Other eScores box.

• If you want to automatically open your email 
program to email the *.date file, check the ❽
Open e-mail program to send attachment check 
box.  This box is checked by default.  
o This will automatically save the *.dat file to 

Your FVD Folder and open an email with the 
*.dat as an attachment.  

o If you uncheck the box, the *.dat file is saved 
to Your FVD Folder but an email is not 
opened.

• Click ❾ Ok.

5

6
7

9

• A ❿ Fox Village Dressage information form 
opens to inform you that the file has been saved 
to Your FVD Folder.

• Click ⓫ OK to return to the Main Menu.

10

11
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*.dat File for USEF & USDF > Verify the eScores (*.dat) File Was Saved

• Navigate to ❶ Your FVD Folder.  
• The file name of the file that you just saved will be your show’s USEF/USDF number followed by the dat

extension.  In this example, the show’s number is 123456, so file name is ❷ 123456.dat.  Do not change 
this file name as it is the file name required by USEF.   

• Double check to ensure it is the correct show number – you entered this with Main Menu > Show Office 
> Show Information and a previous typo could cause you a big headache!

1

2

VERIFY THE USEF eSCORES (*.dat) FILE WAS SAVED:
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*.dat File for USEF & USDF > Email *.dat File to USEF & USDF

• In the usual manner, open your default email program and start a new email message.
• To: – In the To… box, enter ❶ results@usef.org and results@usdf.org as these are the email addresses 

to which results are emailed to USEF and USDF.
• Subject – In the Subject: box, enter the ❷ Show Name – Show Number (in this example, it is #123456).
• Message – A ❸message is not required.
• Attach the File – Using the method for your email program, attach the *.dat file (in this example, it is 

123456.dat).  The file name is automatically entered in the ❹ Attachment area (you do not type it in).
• Send – Click the ❺ Send button.
• Your attachment is now on its way to USEF and USDF!
• If you do not receive a return email acknowledgement, the email was not delivered – resend it.

SECTION IV. AFTER THE SHOW

EMAIL *.DAT FILE TO USEF & USDF:

3

4

5

1

2

Suzy Secretary

XXXX  Blue Horse Dressage - #123456

XXXX  Blue Horse Dressage - #123456

mailto:results@usef.org
mailto:results@usdf.org
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USEF Post Competition Report Form > Introduction

• You have VERY LITTLE TIME to submit your results to USEF.  Reports must be received by USEF within 10 
working days.  They may be electronically transmitted; this is easy to do with FVD.  Consult the USEF 
guidelines (see links below) for details.

• Ensure all classes have been placed – even single ride classes must have been placed.
• If a ride had no score, ensure you used the Term box (see Term(ination).  ) so FVD will enter S (scratch), E

(Eliminated), R (Retired), or VW (Withdrew) in the place box, which is required for the USEF and USDF 
*.dat file.  

• Two Reports must be sent to USEF:
o Snail Mail Report: USEF Post Competition Report Form and your payment(s).
o Email Report: USEF Electronic Submission of Show Results (created with FVD).

• USEF web forms and guidelines:
o USEF Post Competition Report Form: Click here.
o 2021 USEF Post Competition Report FAQ: Click here.  
o USEF Results Criteria: Click here. 
o USEF Universal Results Template (*.xls): Click here.
o 2022 Section Codes (*.xls) (Dressage is lines 146-201): Click here.

• This chapter covers the steps to prepare and send this report to USEF.  The following chapter covers the  
report for USDF.

INTRODUCTION:

https://www.usef.org/forms-pubs/RN8ynf3CCuI/2021-post-competition-report
https://www.usef.org/forms-pubs/1smZa7KdiYI/post-competition-report-faq
https://www.usef.org/forms-pubs/bwWVV5IWQ5U/results-criteria
https://www.usef.org/forms-pubs/f_1TxwTvliY/universal-results-template---2021
https://www.usef.org/forms-pubs/Xj-0MTRXLKw/2022-section-codes-in-excel-format
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USEF Post Competition Report Form > USEF Results Rules

USEF Rule GR1214. Results.
1. All competition results and other data as specified by USEF in the license agreement must be 

electronically transmitted to USEF within 10 days following a Licensed competition including all 
corrections, changes and additions to the prize list.  All results must meet the criteria and format of the 
Federation result template with all required fields as published by USEF and must be submitted as 
outlined in the license agreement.  A fee will be assessed for any required data not received electronically. 
Full results include but are not limited to the names and Federation numbers of all horses, riders and 
owners in all classes, the number of entries, all placings, and money paid out.  In the event of an entry 
under multiple ownership, only one owner need be a Member or pay a Show Pass fee.  The competition is 
responsible for listing either the active member or the person that paid the Show Pass fee in the results. 
(Exception GR901.9). 
b. Dressage

1. Results for Dressage Competitions and Regular or Local competitions holding open Dressage or 
Dressage Sport Horse Breeding classes must include the Federation and USDF membership and 
identification/recording numbers for all owners, riders, handlers and horses for whom this 
information is required for the competition. This material is needed in order to include the winnings 
of exhibitors in the Federation’s permanent records. 

2. The secretary of each Federation Licensed Competition must, within 10 calendar days of the competition, 
send to the Federation, either electronically or by mail with proof of delivery, a list of judges, stewards, 
technical delegates and competition officials, as well as the full results with all required fields.

3. If the competition fails to file a full set of results postmarked within 10 calendar days of the closing of the 
competition, the Federation will levy a fine of $250. If the fine is not paid, future competition dates might 
be retracted or not awarded. The competition has the right to request a waiver of this fine, provided they 
can show good cause.

4. If management disputes that the results were not timely filed or that the above fine is not properly owing, 
it may request a procedural review of these issues before the Co-Chairs of the Hearing Committee or their 
designees, provided that the request is made within 30 days of management’s receipt of the Federation’s 
notice of fine, specifying the grounds for the appeal. The Co-Chairs of the Hearing Committee or their 
designees may waive a part or all of the fine upon a finding of good cause why the application was not 
timely filed and/or a finding that extreme hardship results from the automatic penalty.

5. Within 30 days of the deadline for filing any report or paperwork required under the Rules, the Federation 
must notify the Official Competition Contact responsible for filing such report or paperwork in the event 
that it has not been received.

6. The Federation must be notified of any retirement ceremony held at any Licensed Competition. See 
GR812. BOD

USEF RESULTS RULES:
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USEF Post Competition Report Form > The USEF Form

• Open the 2021 USEF Post Competition Report Form:
o Print and fill-in version: Click here.

• This 3-page form is updated annually and sometimes within a year; therefore, each time you prepare the 
results of a show, download the document from the USEF website to ensure you have the most current 
version.

• You will complete this form by hand or on the computer, then print and mail it to USEF with your 
payment(s).

• The STEP annotations below refer to the procedures on the following pages and where to find the data in 
FVD.

STEP A

STEP B

STEP C

STEP D
STEP E

STEP F

STEP G

STEP H STEP I

STEP K

STEP J

STEP L

THE FORM:

https://www.usef.org/forms-pubs/uBXqaF7bWvM/2020-post-competition-report-form
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USEF Post Competition Report Form > The USEF Form, Cont’d.

STEP G

STEP F

STEP B
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USEF Post Competition Report Form > 
FVD USEF/USDF Post Competition Report

The FVD USEF/USDF Post Competition 
report is the source of most of the 
information required for the USEF Post 
Competition Report Form.

• Select ❶Main Menu > ❷ Reports > 
❸ Post-Show > ❹ USEF/USDF Post 
Competition report.

1

2

3

4

• The ❺ USEF/USDF Post Competition 
report opens.  Information you will need 
to complete the USEF Post Competition 
Report Form is annotated below.

• Click the ❻ Print icon to print the 
report.

• Click ❼ Close to close the report.

FVD USEF/USDF POST COMPETITION REPORT:

6

7

FVD USEF Post Competition Report

5

STEPS C, E, H

STEP G
STEP D

STEP A

STEP B

STEP B

STEP B
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USEF Post Competition Report Form > Step A: Competition Information

• Write or type in:
o ❶ COMP # (Competition #)
o ❷ COMPETITION NAME (official name of your show)
o ❸ DATE [of the show]
o ❹ LOCATION [of the show]

USEF Post Competition Report Form, page 1

1 2
3 4

COMPLETING THE FORM > STEP A: COMPETITION INFORMATION:
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USEF Post Competition Report Form > Step B: Non-Member Information & Fees

• For USEF, Show Pass Fee (SP) = Non-Member Fee (NM).
• From the FVD USEF/USDF Post Competition Report, determine the total number of USEF Non-Members 

that paid the USEF Show Pass fee.  
• In this example, the total is ❶ 2.  Write/type in this number on the ❷ USEF Post Competition Report 

Form.  
• The form multiplies this number by $45, the USEF Non-Member (Show Pass) fee, and enters the ❸

value on the USEF Post Competition Report Form.

COMPLETING THE FORM > STEP B: NON-MEMBER INFORMATION & FEES:

FVD USEF/USDF Post Competition Report

2 3

USEF Post Competition Report Form, page 1

NOTE: The ❸ value is included in the TOTAL AMOUNT ENCLOSED boxes on page 1.

3

1

1
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USEF Post Competition Report Form > Step B: Non-Member Information & Fees, 
Cont’d.

• Next you need the names of the non-members for page 3 of the USEF form, which are on the FVD 
USEF/USDF Post Competition Report.

• On page 2 of the USEF Post Competition Report Form:
o LIST NAMES: Enter the ❹ names.
o AMOUNT PAID: Enter the ❺ amount paid (2021 = $45).
o SEPARATE PAYMENT ENCLOSED: Check ❻ YES if a separate payment is enclosed; check ❼ NO if a 

separate payment is not enclosed (the payment is part of the show’s payment).
o USEF - $45: Check ❽ USEF - $45.

USEF Post Competition Report Form, page 2

4 5 6 87

NOTE: The sum of the ❺ values is included in the TOTAL AMOUNT ENCLOSED boxes on page 1.  

FVD USEF/USDF Post Competition Report

4
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USEF Post Competition Report Form > Step C: Drug Fees, Step D: Ride Fees, 
Step E: Competition Fee

COMPLETING THE FORM > STEP C: DRUG/HORSE USEF FEES:  
• From the FVD USEF/USDF Post Competition Report, determine the USEF Drug Fees (per horse) 

collected.  In this example, the fee was paid for ❶ 90 horses.  On the Post Competition Report Form ❷
USEF FEES line, enter the ❶ number.  The form multiplies this number by $23, the USEF Fee, and enters 
the ❸ value on the USEF Post Competition Report Form.  In this example, 90 x $23 = $2070.   

COMPLETING THE FORM > STEP D: DRESSAGE RIDE FEES: 
• From the FVD USEF/USDF Post Competition Report, determine the number of Dressage Ride Fees (the 

number of Training through Fourth level rides = USEF tests) collected.  In this example, there were ❹ 79
Training through Fourth Level rides. On the Post Competition Report Form ❺ DRESSAGE RIDE FEES line, 
enter the ❹ number.  The form multiplies this number by $0.45, the USEF Dressage Rides Fee, and 
enters the ❻ value on the Post Competition Report Form.  In this example, 79 x $0.45 = $35.55. 

COMPLETING THE FORM > STEP E: COMPETITION FEE: 
• From the FVD USEF/USDF Post Competition Report, determine the number of USEF Drug Fees (per 

horse) collected = # of horses.  In this example, the fee was paid for ❼ 90 horses.  
• On the USEF Post Competition Report Form, type in this number to the right of ❽ USEF Fees (per 

horse).  This form multiplies this number by $1.50, the USEF Competition Fee, to determine the ❾ total 
amount due to USEF.   In this example, 90 x $1.50 = $135.00.   

USEF Post Competition Report Form, page 1

2
31

FVD USEF Post Competition Report

NOTE: The ❸ value is included in the TOTAL AMOUNT ENCLOSED boxes on page 1.

1 3

USEF Post Competition Report Form, page 1

5

6

FVD USEF Post Competition Report

4

NOTE: The ❻ value is included in the TOTAL AMOUNT ENCLOSED boxes on page 1.

4

FVD USEF Post Competition Report

USEF Post Competition Report Form, page 1

8

9

7

7

NOTE: The ❾ value is included in the TOTAL AMOUNT ENCLOSED boxes on page 1.
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USEF Post Competition Report Form > Step F: USEF Membership Application Fees

COMPLETING THE FORM > STEP F: USEF MEMBERSHIP APPLICATION FEES:

• Select ❶Main Menu > ❷ Reports > 
❸ Post Show >❹ Show Fee Summary.

1

2

3

4

• The ❺ Show Fee Summary form opens.

5

Continued on next page…

NOTE: 
• If you included USEF membership application fees in your show funds, follow these instructions.
• It may be easier to accept separate payments that you could submit with your payment, if you use snail-mail.
• To make life easier for you, you might want to encourage riders/owners/trainers to record their horse(s) and 

send you verification before or during the show.
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USEF Post Competition Report Form > Step F: USEF Membership Application Fees, 
Cont’d.

• Using the ❻ drop down arrow, select the ❼
membership category you are seeking.  

• The list content depends upon the show fees you 
established in Show Fees and the fees you 
collected for the show.  This could include the 
System Fee Membership Recording Application 
or multiple Custom Fees you set up for the 
multiple categories of USEF membership.  This 
example shows three ❽ USEF Memberships 
Fees that were added in Custom Fees.

6

7
8

• In this example, we have one ❾ USEF Active 
Membership.  The rider paid the USEF Active 
Membership fee of ❿ $80, for a total of ⓫ $80 
collected by the show office during the show.  

• Repeat for USEF Active Membership 3-Year 
and/or USEF Life Membership, if applicable.

• Make a separate record of these names and fees
as show management must record them on the 
USEF Post Competition Report.  The easiest 
method is to click the ⓬ Print icon.

9 10

11

12Continued on next page…
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USEF Post Competition Report Form > Step F: USEF Membership Application Fees, 
Cont’d.

• From the FVD Show Fee Summary, you have determined the total number of USEF Active Membership 
fees paid (1 in this example), the names of the person/people who paid, and the total fee owed to USEF 
for Active Membership ($80 in this example).

• On page 1 of the USEF Post Competition Report Form, on the appropriate ⓭Membership line, enter 
the total number of each type of USEF membership fees you collected at the show as part of your show’s 
fees.  In this example, there is ⓮ 1 Active Membership.  The form multiplies this number by the 
applicable membership fee and enters the ⓯ total.   In this example, it is 1 x $80 = $80.

• On page 2 of the USEF Post Competition Report Form, under ⓰MEMBERSHIP APPLICATION FEES, for 
ALL membership fees collected, enter the ⓱ LIST NAMES (riders, owners and trainers), the ⓲
AMOUNT PAID, ⓳ SEPARATE PAYMENT ENCLOSED (YES / NO), and check the ⓴ USEF box.

USEF Post Competition Report Form, page 1

NOTE: The ⓯ value is included in the TOTAL AMOUNT ENCLOSED boxes on page 1.

NOTE: List ALL people who paid a USEF membership fee, whether or not the fee is included in 
your show’s fees or you will be submitting a separate payment, such as a check from the person.

13 14 15

USEF Post Competition Report Form, page 2

16

17 18 19 20
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USEF Post Competition Report Form > Step G: USEF Horse Recording Fees

COMPLETING THE FORM > STEP G: USEF HORSE RECORDING FEES:  

NOTE: 
• If you included USEF horse recording fees in your show funds, follow these instructions.
• It may be easier to accept separate payments that you could submit with your show check, if you use snail-mail.
• To make life easier for you, you might want to encourage riders/owners/trainers to record their horse(s) and 

send you verification before or during the show.

• Select ❶Main Menu > ❷ Reports > 
❸ Post Show >❹ Show Fee Summary.

1

2

3

4

• The  ❺ Show Fee Summary form opens. 

5

Continued on next page…
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USEF Post Competition Report Form > Step G: USEF Horse Recording Fees, Cont’d.

• Using the ❻ drop down arrow, select the 
recording fee you are seeking.  

• The list content depends upon the show fees you 
established in Show Fees and the fees you 
collected for the show.  

• This could include the System Fee Horse 
Recording Application or Custom Fees such as  
USEF Annual Horse Recording and/or USEF
Lifetime Horse Recording; these custom fees are 
on the USEF Post Competition Report so 
including them in your show fees is 
recommended.   

• In this example, we select ❼ USEF Annual Horse 
Recording.  

9

8
• For this show, we see that one rider paid the 

USEF Annual Horse Recording fee of ❽ $95, for 
a total of ❾ $95 collected by the show office 
during the show as part of the show’s fees.  Show 
management must record the $95 on the USEF 
Post Competition Report and include the $95 in 
its payment to USEF.

• Repeat for USEF Life Horse Recording, if 
applicable.

• Make a separate record of these names and fees
as show management must record them on the 
USEF Post Competition Report.

6

7

Continued on next page…
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USEF Post Competition Report Form > Step G: USEF Horse Recording Fees, Cont’d.

• On page 1 of the USEF Post Competition Report Form, on the ❿ Annual Recording or Life Recording 
line, enter the total number of each type of USEF Horse Recording fees collected that are part of your 
show’s fees.  In this example, enter ⓫ 1 for Annual Recording.  The form multiplies the number by the 
applicable fee and enters the ⓬ value.  In this example, it is 1 x $95 = $95.

• On page 3 of the USEF Post Competition Report Form, under ⓭ HORSE APPLICATION FEES, enter the 
⓮ NAMES (riders, owners and trainers), the ⓯ AMOUNT PAID, ⓰ SEPARATE PAYMENT ENCLOSED 
(YES/NO), and check the ⓱ ANNUAL or⓲ LIFE box.

NOTE: The ⓬ value is included in the TOTAL AMOUNT ENCLOSED boxes on page 1.

NOTE: List ALL people who paid a USEF horse recording fee, whether or not the fee is included in 
your show’s fees or you will be submitting a separate payment, such as a check from the person.

• If you also accepted FARM/BUSINESS RECORDINGS, complete the information as for a Horse Recording.

USEF Post Competition Report Form, page 1

10 11 12

USEF Post Competition Report Form, page 2

13

14 15 16 17 18
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COMPLETING THE FORM > STEP H: TOTAL NUMBER OF HORSES:
• From the FVD USEF Post Competition Report, determine the total number of horses entered by using 

the number of USEF Drug fees paid.  In this example, there were ❶ 90 USEF Drug Fees paid and 
therefore 90 horses entered in the show.  On the USEF Post Competition Report Form, type in this 
number in the ❷ TOTAL NUMBER OF HORSES ENTERED line.

429

USEF Post Competition Report Form > Step H: # of Horses, 
Step I: Number of Spectators, Step J: Signature

COMPLETING THE FORM > STEP I: SPECTATOR ATTENDANCE: 
• If you do not have a method to determine the number of spectators, this may be estimated as 2 times 

the number of rides (total class entries).  Using the FVD USEF Post Competition Report, determine the 
❸ Total Class Entries = number of rides.  In this example there were ❹ 113 rides in the show; 
therefore, an estimate of the spectators is 226.  On the USEF Post Competition Report Form, type in this 
number in the ❹ ESTIMATED SPECTATOR ATTENDANCE line.

COMPLETING THE FORM > STEP J: SIGNATURE: 
• The Contact/Secretary signs the printed USEF Post Competition Report Form in ❺ SIGNATURE line or 

uses a digital signature.

USEF Post Competition Report Form, page 1

Suzy Secretary 5

USEF Post Competition Report Form, page 1

2

FVD USEF Post Competition Report

1

FVD USEF Post Competition Report

USEF Post Competition Report Form, page 1

4

3 4
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USEF Post Competition Report Form > Step K: Total Due, Step L: Payment, 
Snail Mail to USEF 

COMPLETING THE FORM > STEP L: PAYMENT INFORMATION:  
• If you pay by check, complete the ❼ check information.
• If you pay by credit card, complete the ❽ credit card information.

• Snail Mail the following to USEF using the USEF address on the form:
o USEF Post Competition Report Form
o Your check (if not using a credit card)
o Competitor checks made out to USEF
o Membership Application forms collected during the show
o Horse Recording Application forms collected during the show

• Do not send USEF Medication Report Forms with this packet; they are given to the TD.

NOTE:  Some of the fees, such as USEF Membership and USEF Horse Recording, may have 
been paid in competitor checks made out to USEF.  Do not include these amounts in your 
payment; the competitor checks are instead mailed to USEF with the Post Competition Form.

COMPLETING THE FORM > STEP K: TOTAL AMOUNT ENCLOSED:
• The USEF Post Competition Report Form automatically calculates the ❺ total amount due and enters 

the value on the ❻ TOTAL AMOUNT ENCLOSED line.  

USEF Post Competition Report Form, page 1

6 5

USEF Post Competition Report Form, page 1

7

8

Mary Manager

COMPLETING THE FORM > SNAIL MAIL TO USEF:



Fox Village Dressage User Manual – 2021 Update 1.0.5. helpdesk@foxvillage.com                 www.foxvillage.com

SECTION IV. AFTER THE SHOW

431

USEF Post Competition Report Form > Completed Form > Page 1

Mary Manager
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USEF Post Competition Report Form > Completed Form > Pages 2 and 3
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USDF Report of Fees > Introduction

• You have VERY LITTLE TIME to submit your results to USDF.  Reports must be received by USDF within 10 
working days.  They may be electronically transmitted; this is easy to do with FVD.  Consult the USDF 
guidelines (see links below) for details.

• Ensure all classes have been placed – even single ride classes must have been placed.
• If a ride had no score, ensure you used the Term box (see Term(ination)) so FVD will enter S (scratch), E

(Eliminated), R (Retired), or VW (Withdrew) in the place box, which is required for the USEF and USDF 
*.dat file.  

• Two Reports must be sent to USDF:
o USDF Report of Fees and your payment(s) – can be done online
o USEF/USDF Electronic Submission of Show Results (the FVD *.dat file – sent via email).

• USDF web forms and guidelines:
o 2022 USDF Report of Fees: Click here.
o USDF Results, Fees, and Paperwork Submission Guidelines: Click here.

• This chapter covers the steps to prepare and send these reports to USDF.  The previous chapter covered 
reports for USEF.

INTRODUCTION:

https://www.usdf.org/docs/showflash/web/GeneralInfo/After/ReportofFees2022.pdf?t=12/4/2021%2010:48:05%20AM
https://www.usdf.org/docs/showflash/web/GeneralInfo/After/ResultsSubmission.pdf?t=12/4/2021%2010:48:05%20AM
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USDF Report of Fees Page 1 > The USDF Form, Step A: Show Information

• The USDF Report of Fees (fill-in) PDF form is downloaded and saved, filled-in and saved again:
o You may then print it and snail mail it with check(s) covering the fees or credit card information due to 

USDF. 
o You may also email the report to USDF and pay online.

• These documents change at least annually; therefore, each time you send the results of a show, 
download the documents from the website to ensure you have the most current version.

• The form looks very daunting; however, don’t despair – the FVD program takes the pain out of the 
reporting process!

• The STEP annotations below refer to the procedures on the following pages.

STEP E

STEP F

STEP G

STEP H

STEP A

STEP B

STEP C

STEP D

NOTE: Blue boxes indicate areas where data can 
be typed in on the fill-in form.

STEP A: SHOW INFORMATION:  Write/type in the ❶Competition Name, the ❷ Competition Date, and 
the ❸ USDF/USEF Competition #.

1

USDF Report of Fees, page 1

2 3

THE FORM:

STEP J

STEP I
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USDF Report of Fees Page 1 > Step B: Qualifying Ride Fees > FVD USDF Qualifying 
Rides Report

• Select ❶Main Menu > ❷ Reports > ❸ Post-
Show > ❹ USDF Qualifying Ride Fees report.

The FVD USDF Qualifying Ride Fees Report is used to 
complete page 1 of the USDF Report of Fees, which 
reports the number of GAIG Q fees for each Q test.

• The ❺ USDF Qualifying Rides 
Report opens.  

• The report contains:
o ❻ Test
o ❼ # of Rides
o ❽ Q Fee
o ❾ Total Q Fee for each Q test
o ❿ Total of Qualifying Ride Fees

• If desired, click ⓫ Print to print the 
report.

• Click ⓬ Close Print Preview to 
close the report.

FVD USDF Qualifying Ride Fees Report

STEP B: QUALIFYING RIDE FEES > FVD USDF QUALIFYING RIDES REPORT:

96 7 8

5

5

NOTE: FVD has two reports for GAIG Q.  Total 
Qualifying Rides Down Centerline reports the 
actual GAIG Q rides that were completed.  USDF 
Qualifying Ride Fees reports the GAIG Q fees paid 
for each test type.  In the past, rides were reported; 
USDF did not receive fees paid for scratched or 
incomplete rides.  Now fees are reported; USDF 
receives all GAIG Q fees paid, even if a ride was 
scratched or not completed.

10

11

12
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USDF Report of Fees Page 1 > Step B: Qualifying Ride Fees > Enter the Data

• Look at the first qualifying test on the FVD USDF Qualifying Ride Fees Report (❶ Training Level, Test 3 
2019).   In this example, the # of Rides (# of ride fees paid) is ❷ 4.  

• On the 2020 USDF Report of Fees, in the ❸ # of Rides (# of ride fees paid) box corresponding to Training 
Level, Test 3 2019, type❹ 4.  The form multiplies the number by $15.00, the Qualifying Ride fee, and enters 
the ❺ value in the Total Q Fee box.  In the example 4 x $15.00 = $60.00.

• Repeat for the next Q test, … . 
• The form calculates the ❻ SUBTOTAL OF QUALIFYING RIDE FEES [PAID].  In this example, it is ❼ $705.00.

STEP B: QUALIFYING RIDE FEES > COMPLETE THE FORM:

FVD USDF Qualifying Ride Fees Report

1 2

USDF Report of Fees, page 1

3

4 5

6 7
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USDF Report of Fees Page 2 > Step C: Subtotal of Q Fees, Step D: (Show) Number

• On the top of page 2 of the 2020 USDF Report of Fees, the form automatically enters the ❶ SUBTOTAL 
OF FEES FROM FRONT OF FORM, which is determined at the bottom of page 1 .  In this example, it is ❷
$705.

USDF Report of Fees, page 2

1 2

3 4

STEP C: SUBTOTAL OF Q FEES:

STEP D: (SHOW) NUMBER:

• In the ❸ NUMBER box, type in the show’s USEF/USDF number.  In this example it is ❹ 123456.

USDF Report of Fees, page 2
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USDF Report of Fees Page 2 > Step E: New USDF Ride Fee > 
FVD Total Rides Down Centerline Report

STEP E: NEW USDF RIDE FEE > FVD TOTAL RIDES DOWN CENTERLINE REPORT:

• Select ❶Main Menu > ❷ Reports > ❸ Post-
Show > ❹ Total Rides Down Centerline.

The FVD Total Rides Down Centerline Report is 
used to complete the top pf page 2 of the USDF 
Report of Fees. 

1

3

4

2

• The ❺ Total Rides Down 
Centerline Report opens.  

• The report contains:
o ❻ Class (Number)
o ❼ Class Name
o ❽ Test
o ❾ # of Rides

• For the USDF Report of Fees, you 
need:
o Total number of ❿ Introductory 

Level Tests A, B & C.  In this 
example it is 1 + 1 + 1 = 3.

o Total number of ⓫ Freestyles 
(Training – Fourth Level).  In this 
example it is 4 + 1 + 1 + 5 = 11.

• Enter these numbers in the applicable boxes on the USDF report.
• The form calculates the ⓬ amounts due to USDF.

FVD Total Rides Down Centerline Report

10

11

5

6 7 8 9

12
10

11

USDF Report of Fees, page 2



Fox Village Dressage User Manual – 2021 Update 1.0.5. helpdesk@foxvillage.com                 www.foxvillage.com

1

2

3

4

SECTION IV. AFTER THE SHOW

440

USDF Report of Fees Page 2 > Step F: Additional Fees > 
FVD Profit(Loss) Statement Report

• Select ❶Main Menu > ❷ Reports > ❸ Post-
Show > ❹ Profit(Loss) Statement.

• The ❺ Profit / (Loss) 
Statement report opens.   This 
report lists the income (and 
expenses) for your show, 
including the System Fees and 
the Custom Fees you set up.

The paid USDF fees are found in the FVD Profit(Loss) 
Statement Report.

STEP F 

5

STEP F: ADDITIONAL FEES > FVD PROFIT(LOSS) STATEMENT REPORT:

FVD Profit(Loss) Statement Report

Continued on next page…



Fox Village Dressage User Manual – 2021 Update 1.0.5. helpdesk@foxvillage.com                 www.foxvillage.com

SECTION IV. AFTER THE SHOW

441

USDF Report of Fees Page 2 > Step F: Additional Fees > 
FVD Profit(Loss) Statement Report, Cont’d.

• Using the ❻ Other Fees figures on the FVD Profit(Loss) Statement report, complete the ❼ USDF 
Report of Fees / Additional Fees section.  In this example, USDF non-member fees were the only 
reportable fees.  

• The FVD Profit(Loss) Statement report does not provide the ❽ Number; therefore, you need to do 
some reverse math to determine the Number.  

• Enter the ❾ TOTAL $ RECEIVED from the FVD Profit(Loss) Statement report.  In this example the only 
USDF other fee is Non-Member Fees 6 x $35 = ❾ $210.

USDF Report of Fees, page 27

8 9

NOTE: For the USDF Non-Member Fees, include all fees collected, including fees 
that will be part of your show payment and fees that were paid by a separate 
check to USDF.  You will subtract this latter category further down on the form.

FVD Profit(Loss) Statement Report

6

210 / $35 = 6 USDF Non-members

8
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USDF Report of Fees Page 2 > Step G: USDF Non-Member Names & Fees > 
FVD Non-Members Report 

• For USDF non-member fees, you must also provide the names of the people (rider, owner) that participated 
in the show.  This might take multiple steps.

• Select ❶Main Menu > ❷ Reports > ❸
Post-Show > ❹ Non-members.

• The ❽ USDF Non-members report opens.
• The report lists all people in the show (Rider and/or Owner) that had ❾ Non-Member in the ❿ USDF 

Expiration box.
• In this example, there are six USDF Non-members listed, which matches the number already entered on the 

USDF Report of Fees form.

STEP G: USDF NON-MEMBER NAMES & FEES > FVD NON-MEMBERS REPORT: 

1

2

3
4

• The ❺ Non-member form opens.
• Click the ❻ USDF radial button. 
• Click ❼ OK.

5

6

7

9

10

8

FVD USDF Non-members Report
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USDF Report of Fees Page 2 > Step G: USDF Non-Member Names & Fees > 
FVD Show Fee Summary Report 

• Next you need to verify that you collected these USDF Non-member fees.  If a person did not pay the fee, 
USDF will expect the show to send the fee to USDF.

• Use the FVD Show Fee Summary Report to verify you received the appropriate number of USDF Non-
member fees.

1

2

3

4

5

6

7

• Select ❶Main Menu > ❷ Reports > 
❸ Post-Show > ❹ Show Fee Summary.

• The ❺ Show Fee Summary form opens.
• Using the ❻ Show Fee drop-down arrow, select 
❼ USDF Non-member (a System Fee).

Continued on next page…

STEP G: USDF NON-MEMBER NAMES & FEES > FVD SHOW FEE SUMMARY REPORT: 
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USDF Report of Fees Page 2 > Step G: USDF Non-Member Names & Fees > 
FVD Show Fee Summary Report, Cont’d., Non-Member Names on USDF Form 

• The ❽ USDF Non-member form opens.
• In this example there are:
o The❾ Quantity Totals = 6 (the show had six 

USDF Non-member fees paid).  This matches 
the FVD Other Fees.

o The ❿ total amount received was $210. This 
matches the FVD Other Fees.

• The report lists the RIDER in the ENTRY for which 
a USDF non-member fee was paid; it does NOT 
necessarily list the person in the entry who is the 
USDF non-member.  If you want to verify the 
person, you must look at each ⓫ Entry #.

• Click ⓬ Close to close the form.

STEP G: USDF NON-MEMBER NAMES & FEES > NON-MEMBER NAMES ON USDF FORM:

• Now that you have verified that the required number of USDF Non-member fees have been paid, return 
to the list of non-members on the FVD USDF Non-members Report.

8

9 10

11

12

FVD USDF Non-members Report

12

• Now that the names of USDF Non-members are known and the number of USDF Non-member fees 
paid matches the number of non-members, the ⓭ names are listed on the USDF Report of Fees.

13

USDF Report of Fees, page 2
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USDF Report of Fees Page 2 > Step H: Totals, Step I: Online Payment Information, 
Step J: Credit Card Payment Information

• If you are paying USDF using the USDF Report of Fees via credit card, complete this section.
• Sign the form electronically (it can then be emailed to USDF) or sign the printed form (it can then be snail 

mailed to USDF) or a scanned copy can be emailed to USDF.

• Using your previous entries, the USDF Report of Fees automatically calculates the ❶ GRAND TOTAL OF 
FEES ENCLOSED, which includes fees that will be part of your show’s payment and fees paid directly to 
USDF.

• Add the total amount of any checks or credit card payments for USDF fees that were made out to USDF 
and write it in the ❷ SUBTRACT TOTAL $ PAID BY COMPETITORS (Personal Checks / Credit Cards) TO 
USDF box.  (Mail the checks made out to USDF to USDF.) Type the value in the box. In this example, there 
are $0.  I recommend you also type in a 0 to prove you considered this data.

• The USDF Report of Fees automatically calculates the ❸ TOTAL AMOUNT OWED BY SHOW TO USDF 
and enters it in the box.

1

2

3

USDF Report of Fees, page 2

STEP H: TOTALS:

STEP I: ONLINE PAYMENT INFORMATION:

• You may pay ❸ TOTAL AMOUNT OWED BY SHOW TO USDF online (click here).
• After you pay online, you will receive a USDF ❹ Online Transaction Identification Number.  Enter this in 

the ❺ Online Transaction Identification Number box.
• If you pay online, the USDF Report of Fees and related paperwork must be submitted under separate 

cover via email (results@usdf.org), fax, or snail mail.

4 5
USDF Report of Fees, page 2

STEP J: CREDIT CARD INFORMATION:

USDF Report of Fees, page 2

Mary Manager

https://www.usdf.org/online-services/fee-reports/compfees.asp
mailto:results@usdf.org
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USDF Report of Fees > Completed USDF Report of Fees, What to Send to USDF

• USDF Report of Fees form (email, snail mail, or fax)
• Your check (if you did not pay online)
• Other checks made out to USDF (for people and horse memberships, USDF Affidavit, etc.) (snail mail)
• USDF Membership forms (snail mail)
• USDF Lifetime Horse Registration applications and fees (snail mail)
• USDF Upgrade to Lifetime Horse Registration forms and fees (snail mail)
• USDF Horse Identification Number applications (snail mail)
• USDF Affidavit forms (snail mail)

COMPLETED USDF REPORT OF FEES:

WHAT TO SEND TO USDF:

Mary Manager
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Media Reports > Options

• Select ❶Main Menu > ❷ Reports > 
❸ Post-Show > ❹ Score - Media.

1

2

3

4

• The ❺Media Scoring reports form opens.
• Make the choices desired:
o ❻ Entire Show: Check the box if you want the results for the 

entire show.
o ❼ Day: Use the drop-down arrow to select one day of the show.  
o ❽ Place Limit: 

▪ Enter a number corresponding to the number of places in 
each class (this is usually 6; for championship classes it is 
often 10).  

▪ Alternately, if your targeted media only wants the top 3 
places, enter 3.  

▪ Leave the box blank to get all results.
o ❾ Group by Rider’s Status: Check the box if you want the results 

sorted by rider status (AA / JYR / Open).  Not an available  selection 
with Simple Media Report.

o ❿ Simple Media Report: Check the box if you want a report that 
includes only the:
▪ Class Name
▪ Judge(s) Name(s) and Location
▪ Class Placing
▪ Rider Name
▪ Horse Name
▪ Percentage.  
(If you do not check this box, you get a report with more 
information.)

• In this example, we have selected Entire Show, Place Limit 6, and 
Simple Media.

• Click ⓫ OK.

SECTION IV. AFTER THE SHOW

When your show is finished and after all recording, scoring, placing, etc. have been completed on the 
computer, you can create reports for the media, which you can include your web site, your organization’s 
newsletter, local horse/dressage newsletters, The Chronicle of the Horse, etc.

OPTIONS:

5
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Media Reports > Media Scoring - Simple > The Report

• The ❶ Media Scoring - Simple report, with the selected criteria, opens.
• If desired, click ❷ Print to print the report.

Go to the next page for information on using the report…

1

2

MEDIA SCORING - SIMPLE > THE REPORT:
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Media Reports > Media Scoring - Simple > Save the Report as a *.pdf File, Email

SECTION IV. AFTER THE SHOW

• This report is often emailed, as a *.pdf file, to the press so they may report the results of your show.
• You may also want to post it on the show’s web site, etc.
• To save this report as a *.pdf file, see Print Preview > Export > PDF or XPS.
• Click ❶ Close Print Preview to close the report and return to the Main Menu.

MEDIA SCORING - SIMPLE > SAVE THE REPORT AS A *.PDF FILE:

SIMPLE SCORE REPORT FOR THE MEDIA > EMAIL:

• To email the report to the media, use your default email program and attach the report PDF.

1



Fox Village Dressage User Manual – 2021 Update 1.0.5. helpdesk@foxvillage.com                 www.foxvillage.com

SECTION IV. AFTER THE SHOW

451

Media Reports > Media Scoring - Simple > Place Limit, File Names

• For an all-riders report, the file name could be similar to 
YYYYBlueHorseDressage_ALL_ ScoreReportMediaSimple.pdf, which indicates the report has ALL places. 

• For a Places 1-3 report, the file name could be similar to: 
YYYYBlueHorseDressage_Places1-3_ScoreReportMediaSimple.pdf, which indicates the report has
places 1-3.  

• Etc.

• Some media centers require a report with all 
places, only 3 places, or another variation.  

• To create these reports, repeat the previous 
steps, except in ❶ Place Limit, enter:
o ❷ Nothing for a report with all riders,
o ❸ 3 for a report listing only the first 3 places,
o or another number, as needed.

MEDIA SCORING - SIMPLE > PLACE LIMIT:

All Places1 2

Places 1-331

MEDIA SCORING - SIMPLE > FILE NAMES:
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Media Reports > [Non] Simple Score Report for the Media
• If your media customers desire more show information, you can provide a [Non] Simple Media Report.

• The ❺Media Scoring Reports form opens.
• Select the criteria you need but do not check the 
❻ Simple Media Report check box.

• Click ❼ OK.

• The ❽Media 
Scoring report opens.

• This report includes:
o ❾ Class Name
o ❿ Judge Name(s) 

and location
o ⓫ Entry #
o ⓬ Rider Name
o ⓭ Horse Name
o ⓮ Dressage Test
o ⓯ Rider Status
o ⓰ Final Points
o ⓱ Final Percent
o ⓲ Class Placing

SECTION IV. AFTER THE SHOW

5

6

7

• Select ❶Main Menu > ❷ Reports > 
❸ Post-Show > ❹ Score - Media.

1

2

3
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SECTION V. EVERY DAY
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Backup Your Files > Introduction, Files to Backup

• It is very important that you back up your FVD files FREQUENTLY.  This is not automatically done for you 
in FVD.  Any time you have made changes to your show, HR, test and template files, do back-ups.

• You use the Windows copy and paste functions to copy a file from one drive > folder to Drive > folder. 
• It is recommended that you copy the files to an external storage device such as the cloud, an external 

hard drive, jump/thumb drive, memory card, etc.  By doing this, if your computer crashes, your backup 
will be retrievable.  

• Also, you can store the backup in a different room/building/city in case your computer’s location suffers 
a natural or other disaster.

• Navigate to the folder where your FVD files are saved.  This is ❶ Your FVD Folder.
• You will see the subfolders and files in the FVD folder.
• In this example, we will first backup the ❷ YYYY-BHD-Show.sdf, ❸ HR.hdf, ❹ License.dll (if you 

recently updated FVD or have not yet saved it) and ❺ Test.tdf files.  
• Then we will backup the template files (*.kdf), which are located at ❻ Your FVD Folder > Support.

• As a minimum, you need to frequently back-up the following files:
o *.sdf (your Show File)
o HR.hdf (your Horse & Rider File)
o Test.tdf (your test file)

• Also backup:
• License.dll (your license file – back it up whenever you update FVD.
• *.kdf (template files) – back them up when you edit them.

NOTE: Previous versions of FVD had Backup and Restore functions.  They are no longer provided as it is easier to 
use the Windows copy and paste functions.  If you have previous versions of back-up copies, in FVD, see Utilities 
> Instructions Backup / Restore.

Continued on next page…

INTRODUCTION:

FILES TO BACKUP:

1

4
3

2

5

6
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Backup Your Files > Select & Copy Files to the Clipboard >
Select the Files, Copy the Files to the Clipboard

• Point the cursor at the ❼ 2020-BHD-Show.sdf 
file and left click.  The background will turn blue.

• Depress the Ctrl key (do not release it until told 
to do so below).

• Then point the cursor at the ❽ HR.hdf file and 
left click. The background will turn blue.

• Without releasing the Ctrl key, point the cursor at 
the ❾ License.dll file (if you need to back it up 
now) and left click. The background will turn 
blue.  

• Without releasing the Ctrl key, point the cursor at 
the ❿ Test.tdf file. The background will turn 
blue.  

• Now all three (or four) files have been selected 
(they all have a blue background). 

• Release the Ctrl key.

• With the cursor over the highlighted file names, 
right click and select ⓫ Copy.

• The files are now in the windows clipboard.

Continued on next page…

SELECT & COPY FILES TO THE CLIPBOARD > SELECT THE FILES:

YYYY-BHD-Show.sdf

YYYY-BHD-Show.sdf7

9

8

10

11

SELECT & COPY FILES TO THE CLIPBOARD > COPY THE FILES TO THE 
CLIPBOARD:
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Backup Your Files > Paste Files to an External Storage Device

PASTE FILES TO AN EXTERNAL STORAGE DEVICE:
• First connect/insert the external storage device.
• Navigate to the external storage device.  In this example, it is an external drive named ❶

THUMBDRIVE(I:).
• With your cursor in the information area, right click and select ❷ Paste.

• The ❸ FVD files have been copied to the local disk.

1

2

3
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Backup Your Files > Backup Show Template File(s), Create a Folder or Subfolders for the 
Backup Files (Recommended)

CREATE A SUBFOLDER OR SUBFOLDERS FOR THE BACKUP FILES (RECOMMENDED):
• If desired, create a subfolder on the external device that will contain your backup files.  Or create 

multiple subfolders that will hold a series of backup files.  In this example, we will create the YYYY-MM-
DD_FVD-Backup folder.  
o Right click the external drive onto which you want to create a subfolder.  In this example, right click 
❶ THUMBDRIVE (I).

o In the form that opens, click ❷ New. 
o Click ❸ Folder.
o A ❹ New folder is created.

BACKUP SHOW TEMPLATE FILE(S):
Using the above procedures, navigate to Your FVD Folder > Support folder and copy then paste your 
template file(s) to the backup device.

Continued on next page…

4

1

2 3
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Backup Your Files > Create Subfolders for the Backup Files (Optional), Cont’d.

• Next, rename New folder to describe the files in the folder.  
o Right click ❺ New folder.
o In the form that opens, click ❻ Rename.
o ❺ New folder now has a ❼ dark blue background.
o Type the folder name you desire. In this example, it will be YYYY-MM-DD_FVD-BU to indicate the date 

of the backup (YYYY-MM-DD) and the contents of the folder (FVD-BU).

• You now have a ❽ YYYY-MM-DD_FVD-BU folder on the external drive.
• Using the previous procedure, on this date copy your ❾ FVD files onto this folder.
• If you backup files later the same day, create a folder similar to YYYY-MM-DDb_FVD-BU, where “b” lets 

you know it is the second backup of that day.
• If you backup files the next day, create a folder for the next date.
• Etc.

• This gives you a series of backups to which you can return in case your computer fails, your files gets 
corrupted, etc.

NOTE:  Windows and many of the external hard drives now on the market include software that can be set 
up to automatically create backups.  Consult the Windows and/or hard drive manuals for the procedure.

5
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YYYY-BHD-Show.sdf

YYYY-MM-DD_FVD-BU
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Restore Your Files > Copy and Paste Your Backup Files to Your FVD Folder

• If the old/corrupted files are still on Your FVD Folder, for each file you are restoring, the ❶ Replace or 
Skip Files form will open.

• Since you want to replace the old/corrupted file, click ❷ Replace the file in the destination.
• The backed-up file(s) will replace the old/corrupted files and you can get back to work.

UPDATED 2020-02-07

• Perform Repair All Links, as in REPAIR ALL LINKS.

1

2

COPY AND PASTE YOUR BACKUP FILES TO YOUR FVD FOLDER:

• If you have a hard drive failure or other type of mishap, simply copy and paste your most recent backup 
to Your FVD Folder.  

• This is performed exactly as in the previous steps, except the files are copied from the external device 
and are pasted into your computer’s FVD folder (*.sdf, hr.hdf, test.tdf, License.dll (if needed), and *.kdf).

COPY
PASTE
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Restore Your Files > Copy and Paste Your Backup Files To Another Computer, 
Email Your Files to Another Person

COPY AND PASTE YOUR FILES TO ANOTHER COMPUTER:

• Make a backup of your most recent files to the external device, as previously described.
• If not already done, install FVD on the second computer.
• Insert/connect your external storage device to the second computer.
• Copy and paste your most recent backup to the FVD folder of the second computer.  This is performed 

exactly as above, except the files are copied from the external device and are pasted into the FVD folder 
(*.sdf, hr.hdf, test.tdf and license.dll) or FVD\Support folder (*.kdf).

• This can also be accomplished by networking the two computers.
• After copying and pasting the files, REPAIR ALL LINKS.

EMAIL YOUR FILES TO ANOTHER PERSON:

• Open your default email program and complete the To: box, Subject: box, and write a message.
• Attach the *.sdf, HR.hdf, Test.tdf, license.dll and *.kdf in the usual manner.
• Send the email.
• The recipient then saves the files to the appropriate folders on his/her FVD computer.
• After copying and pasting the files, REPAIR ALL LINKS.
• In a pinch, you can email the files to yourself - this is another method of backing up the files!

UPDATED 2020-02-07
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SECTION VI. APPENDICES

NOTE: This appendix provides guidance regarding USEF and USDF membership requirements.  Rules change 
frequently; therefore, consult the USEF and USDF web sites for the most up-to-date and complete information.
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PEOPLE - USEF: 
• Types of USEF People Memberships:

o USEF People Competing Membership: 
▪ USEF 1-Year (effective 12 months from start date)
▪ USEF 3-Year (effective 36 months from start date)
▪ USEF Life Member (no expiration date)

o USEF People Non-member:  May participate if USEF Show Pass Fee (= non-member fee) is paid (one 
fee/person/show).  Cannot qualify for GAIG or many other national awards. 

o USEF Other Memberships:
▪ USEF 1-Year Fan (effective 12 months from start date).  Must pay USEF NM fee to participate in USEF shows.
▪ USEF 1-year Subscriber (effective 12 months from start date). Must pay USEF NM fee to participate in USEF 

shows.
• USEF Membership Applications – Paper and Online:

o USEF People Membership Application before the show:  Paper click here, online click here.
o USEF People Membership Application during the show: click here.

HORSES - USEF:
• USEF Horse Recording Types:
o USEF Annual Recording (effective 12 months from the start date).  Becomes a USEF Horse Identification 

Number (USEF HID) after one year unless renewed.
o USEF Lifetime Recording (recording does not expire)

• USEF Non-Recorded Horse: USEF accepts USDF HID or Life Registration, but the ride cannot qualify for GAIG or 
many national awards.

• USEF Horse Recording Applications:
o USEF Horse Application used before the show:  Paper click here
o USEF Competition Horse Application used during the show: click here.

465

Memberships > USEF People and Horse Membership Types

USEF NON-MEMBER - IF IN DOUBT, COLLECT THE FEE:  If a person cannot prove to you that s/he is a current USEF 
member, assume the person is a non-member and collect the Show Pass (non-member) fee(s).  If s/he can later 
prove s/he was a USEF member before the ride(s), you can issue a refund.  It is much more difficult to collect a non-
member fee after the show!  If USEF determines the person was a non-member, they will expect the show to pay 
the fee.

NOTE:  USEF has a different people 
membership application and horse recording 
application forms to be used before the show 
vs. during the show.  Ensure you use the 
correct form!

USEF HORSE OWNERSHIP:  A horse’s owner is the person on record with USEF as the owner on the day the horse is 
competed.  If a horse has been sold and a USEF Horse Ownership Transfer Form (click here) has not yet been sent to 
USEF, the membership status of the original owner must be observed; if the original owner is not a USEF member, a 
USEF non-member fee must be paid for the USEF non-member owner.  Alternately, the show secretary may obtain 
proof that a USEF change of owner has been submitted to USEF; in this case, the new owner is on the entry.

• In order to participate in USEF licensed shows, USEF has specific membership requirements for people (riders, 
owners, trainers, coaches, business owners) and horses (USEF Recording).

• The EE entry memberships page has USEF and USDF membership status for all the people and horse in the entry.  
The data comes directly from the USEF and USDF databases.  If there is a question or a change, the best way to 
verify memberships in a show entry is to use www.EqVerification.org, which provides a printable report with the 
data in the USEF and USDF databases at that moment.

LEASED HORSE: If a horse has been leased by a person, for show purposes that person is considered the horse 
owner, must be listed as the owner on the entry, and must fulfill all the USEF membership requirements of an 
owner.  A USEF Lease Registration Form (click here) is used to verify the lease.  If this is not done, the actual owner 
of the horse is considered the owner and must fulfill all the USEF membership requirements of an owner.

USEF PEOPLE AND HORSE MEMBERSHIP TYPES:

NOTE:  The links on this page are as of December 
2021.  The links may change year-to-year.

https://www.usef.org/forms-pubs/d_jqOXjpYpc/2/us-equestrian-membership-application
https://www.usef.org/join-usef/join-renew
https://www.usef.org/forms-pubs/UfJbZ2KD_cQ/2022-us-equestrian-membership
https://www.usef.org/forms-pubs/CMIdre6sIQk/2020-us-equestrian-horse-application
https://www.usef.org/forms-pubs/QnWIuMWuxJA/us-equestrian-horse-application
https://www.usef.org/forms-pubs/7JPall0D4BU/transfer-form
http://www.eqverification.org/
https://www.usef.org/forms-pubs/g_0LY1-fRQ8/lease-form
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• USEF competition membership requirements are covered in USEF GR1308 (click here for GR13) and USEF 
GR901.9 (click here for GR9).  The following is text related to dressage. 

466

Memberships > USEF Membership Requirements and Exceptions

USEF GR1308 Membership and Document Requirements
1. To be eligible to participate as a rider, …, owner, …, lessee, …, coach or trainer at …Dressage …, persons must be Members of 
the Federation as provided in GR202 or if not a member, must pay a Show Pass fee as provided in GR206 (for exceptions
see GR901.9 [see next page]). Exception: Applications for Federation Individual Membership and Horse Recordings submitted at
Licensed Competitions:

a. For Dressage Competitions, reference Bylaw 223, Section 1:
1. Applications are considered effective on the date the application and dues are received by the Competition

Secretary provided the application is signed and dated by the Competition Secretary on that same day.
2. Applications completed online at the competition are effective the date the application is submitted.\

b. …     
c. Lessees are considered owners in connection with this membership requirement. 
d. When an entry is under multiple ownership, only one owner need be a Member or pay a Show Pass fee. 
e. When an entry is under a minor’s ownership and training, the parent who must sign will be exempt from the Federation 

Show Pass fee. Only a parent will be exempt from the Federation Show Pass fee if signing as coach for his/her minor child.
2. Memberships completed at the competition must be forwarded to the Federation office within ten (10) days of the
close of the competition as part of the full competition results, which are defined in GR1214. The member’s copy of
the application is valid for 45 days or until the membership card is received from The Federation.

a. The following credentials must be available to Competition Management and the Federation steward/technical
delegate. Competitions may, at their discretion, confirm any of the below electronically with the Federation office:

1. Amateur Status.
2. Copies of … pony measurement cards.
3. Federation membership cards or a copy thereof.  Exception: Applications completed at the competition. The member will 

retain the pink copy of the membership application form which, when properly signed by the Competition Secretary, is valid for 45 
days from the date signed.

4. Federation horse recordings for USEF/USDF qualifying classes for dressage championships (see DR127.2), and USEF/USDF 
Dressage Championships (see DR127.2).

5. …
6. …
7. Non-U.S. citizens (as defined by GR901.9) and Foreign Competitors (as defined by GR828.4) must provide proof, in English, 

of current membership in good standing in their respective National Federation or hold current membership in good standing with 
USEF.

8. For all horses competing in Young Jumper classes a copy of the registration papers issued by a Breed Registry (or other 
means of identification issued by the Federation providing proof of age and identity) must be checked by the horse show office.

9. Originals or copies of United States Hunter Jumper Association, Inc., membership card, if applicable.
b. If an exhibitor does not submit the proper membership documentation to the competition and the competition

cannot verify such information, (with the exception of Federation measurement cards) the exhibitor will be responsible to pay a 
$45 Show Pass fee which is non-refundable.
3. Participation of non-US citizens in non-breed-restricted national competitions in the US.

a. Non-US citizens who are not current members of USEF as provided in GR202 must either provide proof, in English, of current 
membership in good standing in their own National Federation or must pay a registration fee as provided for in GR206 (for 
exceptions see GR901.9 [see next page]).

b. In any discipline, owners and trainers who are non-US citizens and who have a current letter of permission/good standing
from their own federation, are exempt from Federation membership requirements per Art. III, Sect. 3.  Under this rule, non-US 
citizens must provide proof to competition management of current permission/good standing from their own federation in order to 
be exempted from Federation membership requirements.

c. Foreign Competitors (non-U.S. citizens) who participate in Federation amateur classes, in any discipline, must be in possession 
of a Federation Amateur Card and must be a Junior, Senior, or Life Competing Member of the Federation. (Exception: Equestrian 
Canada members in possession of current EC membership may sign for USEF Amateur status on a show by show basis at no cost). 
However, non-U.S. citizens who are not competing in Federation amateur classes are not required to become Federation Members 
if they provide proof, in English, of membership in good standing in their own National Federation.
4. U.S. Competitors competing in their own country in a FEI-sanctioned event, not requiring an FEI Passport, must present a valid 
USA National Passport or a valid FEI Passport. …

USEF MEMBERSHIP REQUIREMENTS AND EXCEPTIONS:

https://www.usef.org/forms-pubs/nT3TlM3v0NA/gr13-competition-participants-and
https://www.usef.org/forms-pubs/Qbn3Og5AY8Y/gr9-competition-prize-lists-entries
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Memberships > USEF Membership Requirements and Exceptions, Cont’d.

USDF GR901.9 Requirements
The following statement must be published in BOLD TYPE for all …, Dressage Competitions, …:
Life, senior active and junior active members shall be eligible to participate in all classes at …, Dressage, … . A non-member 
may participate as a handler, rider, …, owner, lessee, …, coach or trainer at …, Dressage Competitions, … upon payment of a 
$45 Show Pass fee. Participants in the following classes are exempted from the Requirements of this rule: 
1) leadline; 
2) exhibitions; 
3) games and races; 
4) classes for 4-H members; 
5) walk trot (exception: Friesian performance FR218) and academy classes (academy classes are classes limited to horses 

used regularly in a lesson program); 
6) USDF introductory level tests, pas de deux and quadrille classes; 
7) …NRHA Endorsed Reining Competitions. 
8) Opportunity classes, 
9) citizens of other nations who have proof, in English, of current membership in good standing of their own National 

Federation, 
10) …
11) assistant handlers in Dressage Sport Horse Breeding classes 

GR821 Opportunity Classes
1. Opportunity Classes:

e. Dressage classes may be offered as Opportunity classes at Dressage Competitions … as described below:
6. Horses, riders, owners, trainers, and coaches participating only in Opportunity classes are exempt from Federation 

and affiliate organization membership and Horse Identification (HID) requirements and non-member/Show Pass fees, but 
are required to list the Federation membership number if the participant is a member.

NOTE: If a person and/or a horse is/are participating in an exempt class and a non-exempt class, the people must 
have USEF and USDF memberships or pay the non-member fees and the horse must have at least a USDF HID #.

NOTE: Horses ONLY in non-opportunity introductory level classes are NOT exempt from the USEF & Drug fee.

Summary for Horses and People Participating in ONLY Introductory or Opportunity Classes
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• In order to participate in USDF recognized shows, USDF has specific membership requirements for people (riders, 
owners, business owners; not for trainers and coaches) and horses (USDF Registration).

468

Memberships > USDF People and Horse Membership Types

NOTE 1:  USDF has a different people membership application and horse registration application forms to be used before the 
show vs. during the show.  Ensure you use the correct form.
NOTE 2:  The links on this page are as of December 2021.  The links may change year-to-year.
NOTE 3:  Click here for USDF People and horse memberships information document.
NOTE 4:  USDF people memberships and horse registrations can be completed and paid online.  Acknowledgement can be 
counted as proof of membership or registration.
NOTE 5 - USDF GM MEMBERSHIP - DO NOT USE GM NUMBER AND EXPIRATION: People that are USDF Group Member (GM) 
members may participate in USEF/USDF shows.  They cannot qualify for GAIG or many other national awards.  USDF GM 
members receive a USDF membership number and expiration; this USDF information must be used to verify membership.  The GM 
number and expiration cannot be used as a proof of USDF membership.
NOTE 6 - NON-MEMBER - IF IN DOUBT, COLLECT THE FEE:  If a person cannot prove to you that s/he is a current USDF member, 
assume the person is a non-member and collect the USDF non-member fee.  If s/he can later prove s/he was a member before the 
rides, you can issue a refund, pursuant to your show’s refund rules.  It is much more difficult to collect a non-member fee after the 
show!  If USDF determines the person was a non-member, they will expect the show to pay the fee.
NOTE 7 - USDF HORSE OWNERSHIP:  A horse’s owner is the person on record with USDF as the owner on the day the horse is 
competed.  If a horse has been sold and a USDF Transfer of Ownership Form (click here) has not yet been sent to USDF, the 
membership status of the original owner must be observed; if the person is not a USDF member, a USDF non-member fee must be 
paid for the USDF non-member owner.  If a USDF Transfer of Ownership Form has been sent to USDF, get proof from new owner.
NOTE 8 - LEASED HORSE: If a horse has been leased by a person, for show purposes that person is considered the horse owner 
and must fulfill all the USDF membership requirements of an owner.  A USDF Lease Recording Form (click here) is used to verify 
the lease.  If this is not done, the actual owner of the horse is considered the owner and must fulfill all the USDF membership 
requirements of an owner.  If a USDF Transfer of Ownership Form has been sent to USDF, get verification from lessee.

PEOPLE - USDF:
• USDF People Membership Types:

o USDF 1-Year Participating (expires November 30 of the membership year).
o USDF 1-Year Youth Participating (expires November 30 of the membership year).
o USDF 5-Year Participating (expires November 30 at the end of the fifth membership year).
o USDF Lifetime Participating (membership does not expire).
o USDF Business (expires November 30 of the membership year) (business = farms and organizations).
o USDF Group Member (GM) Membership (expires November 30 of the membership year) (see GM NOTE).
o USDF Education Membership (expires November 30 of the membership year) (not for competitions).

• USDF People Non-member:  May participate if USDF Non-member Fee is paid (one fee/person/show).  Cannot qualify 
for GAIG or many national awards.

• USDF People Membership Applications:
o USDF Membership Application form (to print and snail mail) used before the show: click here
o USDF Membership Online Application form used before the show: click here
o USDF Participating Membership ● Business Membership Application during the show: click here

HORSES - USDF:
• USDF Horse Registration (2015 - click here):

o USDF Horse Identification Number (HID) (does not expire) (cannot qualify for GAIG or national awards)
o USDF Lifetime Horse Registration (does not expire)
o NOTE: There is no USDF Annual Horse Registration

• USDF Non-registered Horse:  May not participate.  Must have at least a USDF HID. Cannot qualify for GAIG or national 
awards.

• USDF Horse Registration Forms:
o USDF Horse paper Registration before the show: click here
o USDF Horse Online Registration before the show: click here
o USDF Horse Registration during the show: click here

USDF PEOPLE AND HORSE MEMBERSHIP TYPES:

https://www.usdf.org/docs/membership/MemHorseReq.pdf?t=12/8/2021%205:03:41%20PM
https://www.usdf.org/docs/ShowFlash/web/GeneralInfo/Before/TransferForm.pdf?t=1/24/2020%207:29:04%20PM
https://www.usdf.org/docs/membership/LeaseAgrmntForm.pdf?t=1/26/2020%201:42:20%20PM
https://www.usdf.org/docs/membership/MembershipApplication2022.pdf?t=12/8/2021%205:03:41%20PM
https://www.usdf.org/join/horse.asp
https://www.usdf.org/docs/showflash/web/GeneralInfo/Before/2022PMBMCompApplication.pdf?t=12/8/2021%205:05:26%20PM
http://www.usdf.org/join/HRFees.pdf
https://www.usdf.org/docs/membership/HorseRegForm.pdf?t=12/8/2021%205:03:41%20PM
https://www.usdf.org/join/horse.asp
https://www.usdf.org/docs/showflash/web/GeneralInfo/Before/HorseRegistration.pdf?t=12/8/2021%205:05:26%20PM
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Memberships > USDF Membership Requirements Chart

Least restrictive – Riders 
and owners can be USDF 
non-members (but must 
pay the USDF non-
member fee) and horses 
can have only a USDF 
HID).

Most restrictive – Riders 
and owners must be USDF 
Participating Members 
and horses must be USDF 
Lifetime Registered.

*

*

* Most common for USEF/USDF shows.

Owner can be a GM or 
NM but rider must be a 
PM.

This chart is from the USDF Membership and Horse Registration Requirements document (click here).  It lists the 
USDF membership requirements to participate in USDF recognized shows.  The people memberships are for riders 
and owners; trainers and coaches are not required to have USDF membership (but they must be USEF members!) The 
chart has been reorganized to run from the least restrictive types of membership/registration to the most restrictive 
types of membership/registration.

USDF MEMBERSHIP REQUIREMENTS CHART:

https://www.usdf.org/docs/membership/MemHorseReq.pdf?t=1/26/2020%2011:26:25%20AM
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Memberships > USDF Exceptions

NOTE: Previously para-equestrian riders, owners and horses were exempt from USDF memberships.  
Memberships are now required.

The USDF Exception List (click here) lists exemptions to USDF people membership and USDF horse 
registration requirements.

• Minimum USDF competition requirements:
o The minimum requirement for owners and riders is payment of the USDF non-member fee (this is a 

per-competition fee). [Trainers and coaches are not required to be USDF members.]
o The minimum requirement for the horse is the USDF Horse Identification Number (HID). This is a 

one-time fee that allows scores to be entered but not counted towards many national awards.

• Individuals and horses competing only in the following are exempt from the USDF membership/non-
member fee and horse registration requirements:
o Handlers of horses competing in DSHB in-hand or group classes
o Horses competing only in Individual Breed Classes (IBC) at DSHB competitions
o Sires and dams of horses in DSHB group classes, where those sires or dams are not actually 

competing in the same competition.
o Horses competing only in breed restricted dressage or DSHB classes at regular competitions (i.e. all

Arabian, all Friesian, all Morgan classes, etc.)
o USDF Introductory Level tests
o Pas de deux
o Quadrille
o Opportunity classes
o Horses ridden in leadline, exhibitions, games and races, classes for 4-H members, walk-trot, and

academy classes.
• Riders, owners and horses in exempt classes and regular classes must meet the minimum USDF 

membership / horse registration requirements.
• Foreign competitors do not have to have a USDF membership, pay the non-member fee, or register their 

horse if participating in FEI Championships and in CDI classes.
• Non-US citizens participating in USDF recognized competitions are not exempt from USDF membership 

requirements.

USDF EXCEPTIONS:

https://www.usdf.org/docs/ShowFlash/web/GeneralInfo/Before/MembershipExceptionList.pdf
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Memberships > USEF and USDF Exceptions Summary

NOTE: If a person and/or a horse is/are participating in an exempt class and a non-exempt class, the 
people must have USEF and USDF memberships or pay the non-member fees and the horse must have 
at least a USDF HID #.

For Horse and People Only
in This Type of Class

USEF People* 
Membership

USEF Horse 
Registration

USEF & Drug 
Fee

Can be USEF 
Drug Tested?

USDF People** 
Membership

USDF Horse 
Recording

Opportunity Exempt Exempt Exempt YES Exempt Exempt

USDF Introductory Exempt Exempt Not Exempt YES Exempt Exempt

USDF Pas de Deux Exempt Exempt Not Exempt YES Exempt Exempt

USDF Quadrille Exempt Exempt Not Exempt YES Exempt Exempt

• Summary for USEF/USDF and Opportunity, Introductory, Pas de Deux, and Quadrille:

*   USEF People = Rider, Owner, Trainer and Coach
** USDF People = Rider and Owner

NOTE: Previously para-equestrian riders, owners and horses were exempt from USDF memberships.  
Memberships are now required.
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• The following are membership requirements to participate in a USEF/USDF dressage competition (a show that is 
not breed restricted) in a non-GAIG-qualifying status as an open, adult amateur, junior rider/young rider or non-
member.  Items in red are the minimum requirements.  (See the next page for GAIG qualification requirements.)

• The requirements for local championships and other special categories of classes/awards may be more stringent.  
Consult the rules for the particular class(es)/award(s) for further information.  

• The two easiest ways to provide/receive copies of membership cards with the show entry is through (1) use of EE 
for online show entries, and (2) the USEF and Affiliates Membership Verification System at 
www.eqverification.org.  If you receive an entry with confusing/missing documentation, your simplest solution is 
to check the memberships on this system.

472

Memberships > USEF and USDF Membership Requirements for GAIG Non-Qualifying Rides

• NOTE 1: The above does not apply to exempt classes, for which the rider, owner, trainer, coach and horse are exempt 
from membership requirements and non-member fees.

• NOTE 2: The USEF non-member fee is also called a Show Pass. 
• NOTE 3: Non-member fees change every few years.  Ensure the current fee is in the show entry.
• NOTE 4: All adult (>18yo) USEF competing members (riders, owners, trainers, and coaches) must have current SafeSport 

Training.  USEF non-members are not required to take the training.

PARTICIPANT USEF USDF 

Horse Must have:
1) USEF Lifetime Recording, 
or
2) Current USEF Annual Recording, 
or
3) USDF HID or LHR

Must have:
1) USDF Lifetime Horse Registration (LHR) 
or
2) USDF Horse Identification Number (HID)

Rider
(mandatory)

Must be:
1) Current active USEF Competing Member, or
2) Pay USEF show pass (non-member) fee.  One 

fee/person/show.
and

3) For Adult Amateur classes – USEF Senior 
Amateur Member on USEF Membership Card 
or Non-Member Amateur Card, or on the 
verification print-out.  If there is no proof of 
USEF amateur status, the rider must be in 
open classes.

Must be:
1) Current USDF Participating Member (PM),  

or
2) Current USDF Group Member Organization 

(GM) member,
or

2) Pay USDF non-member fee. One 
fee/person/show.

Owner,

(mandatory) 
At least one owner must be:
1) Current active USEF Competing Member, or
2) Pay USEF show pass (non-member) fee.  One 

fee/person/show.

At least one owner must be:
1) Current USDF Participating Member (PM),  or
2) Current USDF Group Member Organization 

(GMO) member, or
3) Pay USDF non-member fee. One 

fee/person/show

Trainer
(USEF 
mandatory)

Must be:
1) Current active USEF Competing Member, or
2) Pay USEF show pass (non-member) fee.  One 

fee/person/show.

No USDF membership required.

Coach
(optional; if 
listed, USEF 
mandatory)

Must be:
1) Current active USEF Competing Member, or
2) Pay USEF show pass (non-member) fee.  One 

fee/person/show.

No USDF membership required.

http://www.eqverification.org/
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PARTICIPANT USEF USDF 

Horse Must have:
1) USEF Lifetime Recording,                                               

or
2) Current USEF Annual Recording

Must have:
USDF Lifetime Horse Registration (LHR)

Rider
(mandatory)

Must be:
1) Current active USEF Competing Member 
2) For Adult Amateur classes – USEF Senior 

Amateur Member

Must be:
Current USDF Participating Member (PM)

Owner*
(mandatory)

At least one owner* must be:
Current active USEF Competing Member

At least one owner* must be:
Current USDF Participating Member (PM)            

Trainer
(mandatory)

Must be:
1) Current active USEF Competing Member, 

or
2) Pay USEF show pass (non-member) fee.  

One fee/person/show.

No USDF membership required.

Coach
(optional)

Must be:
1) Current active USEF Competing Member, 

or
2) Pay USEF show pass (non-member) fee.  

One fee/person/show.

No USDF membership required.

473

Memberships > USEF and USDF Membership Requirements for 
GAIG Qualifying and Championship Rides

SECTION VI. APPENDICES

• The following are membership requirements to qualify in a Great American Insurance Group (GAIG)/ 
USDF Regional Dressage Championship qualifying or championship class (Open, Adult Amateur, or JYR 
division).

• The requirements for local championships and other special categories of classes/awards may be more 
or less stringent.  Consult the rules for the particular class(es)/awards for further information.  

• The two easiest ways to provide/receive copies of membership cards with the show entry is through (1) 
use of EE for online show entries, and (2) the USEF and Affiliates Membership Verification System at 
www.eqverification.org.  If you receive an entry with confusing/missing documentation, your simplest 
solution is to check the memberships on this system.

NOTE: Non-members may ride in GAIG qualification classes, but they may not qualify for the GAIG championships.

*NOTE: For a horse with more than one owner, at least one owner must be both
an active USEF competing member and an active USDF participating member.  

http://www.eqverification.org/
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Dressage Tests > USEF/USDF
Click here for 2019 USEF/USDF guidelines and tests.

INTRODUCTORY THROUGH FOURTH LEVEL TESTS
Introductory (white paper)

Introductory Test A
Introductory Test B
Introductory Test C

Training Level Tests (optional pink paper)
Training Level Test 1 
Training Level Test 2 
Training Level Test 3 

First Level Tests (optional blue paper)
First Level Test 1 
First Level Test 2 
First Level Test 3 

Second Level Tests (optional yellow paper)
Second Level Test 1 
Second Level Test 2 
Second Level Test 3 

Third Level Tests (optional lavender paper)
Third Level Test 1 
Third Level Test 2 
Third Level Test 3 

Fourth Level Tests (optional green paper)
Fourth Level Test 1 
Fourth Level Test 2 
Fourth Level Test 3 

FREESTYLE / PAS DE DEUX / QUADRILLE TESTS
Freestyle

Freestyle - Training Level (white or pink paper)
Freestyle - First Level (white or blue paper)
Freestyle - Second Level (white or yellow paper)
Freestyle - Third Level (white or lavender paper)
Freestyle - Fourth Level (white or green paper)

Pas de Deux Tests
Pas de Deux (white paper)

Quadrille Tests
Quadrille - Introductory Level (white paper)
Quadrille - Training Level (white paper)
Quadrille - First Level (white paper)
Quadrille - Second Level (white paper)
Quadrille - Third Level (white paper)
Quadrille - Freestyle (white paper)

https://www.usdf.org/downloads/forms/index.asp?TypePass=Tests
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Dressage Tests > USEF/USDF, Cont’d.

DEVELOPING HORSE / YOUNG HORSE TESTS
USEF Developing Horse Prix St. Georges Test 
USEF Developing Horse Grand Prix Test
Four-Year Old Dressage Test

SPORT HORSE TESTS
Individual Class Scoresheets

Sport Horse Prospects (white or yellow paper)
Sport Horse Breeding Stock (white or pink paper)
Sport Horse Group Class (white or blue paper) 
Sport Horse Prospects Under Saddle (white or green paper)

Master Class Scoresheets
Sport Horse Prospect (In-Hand) (white or yellow paper)
Sport Horse Breeding Stock (white or pink paper)
Sport Horse Group Class (white or blue paper)
Sport Horse Prospect (Under Saddle) (white or green paper)

Championship
Sport Horse Championship Class (white or tan paper)

Materiale
Sport Horse Materiale Class (white or ivory paper)

Amateur / Junior / Young Rider Handler
Amateur / Junior / Young Rider Handler (white paper)

DRESSAGE SEAT EQUITATION
Dressage Seat Equitation

Click here for 2019 USEF/USDF guidelines and tests.

https://www.usdf.org/downloads/forms/index.asp?TypePass=Tests
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FEI TESTS FOR SENIORS
Prix St-Georges 
Intermediate I
Intermediate A
Intermediate B
Intermediate II
Short Grand Prix
Grand Prix
Grand Prix Special

FEI FREESTYLE TESTS
Pony Riders
Juniors 
Young Riders 
Intermediate I 
Intermediate A/B
Grand Prix

FEI U-25 TESTS
Grand Prix 16-25

FEI YOUNG RIDERS TESTS
Preliminary Competition 
Team Competition
Individual Competition 

FEI JUNIORS TESTS
Preliminary Competition 
Team Competition 
Individual Competition

FEI PONY RIDERS TESTS
Preliminary Competition 
Team Competition 
Individual Competition

FEI CHILDREN TESTS
Preliminary Competition A
Preliminary Competition B
Team Competition 
Individual Competition

FEI  YOUNG HORSES 
Competition for 4-year-old horses (national competition only)
Preliminary Competition for 5-year-old horses 
Final Competition for 5-year-old horses
Preliminary Competition for 6-year-old horses 
Final Competition for 6-year-old horses - Final
Preliminary Competition for 7-year-old horses
Final Competition for 7-year-old horses
Grand Prix – Young Horses (national competition only)

FEI REGIONAL GAMES
Preliminary Competition 
Team Competition 
Individual Competition 

SECTION VI. APPENDICES

477

Dressage Tests > FEI

Click here for the FEI dressage tests

https://inside.fei.org/fei/your-role/organisers/dressage/tests


Fox Village Dressage User Manual – 2021 Update 1.0.5. helpdesk@foxvillage.com                 www.foxvillage.com

SECTION VI. APPENDICES

478

Dressage Tests > FEI Para-Equestrian

Dressage Tests Grade I
Novice Test A
Novice Test B
Team Test 
Individual Test 
Freestyle Test
Grade I Introductory Test A (national classes only)
Grade I Introductory Test B (national classes only)

Dressage Tests Grade II
Novice Test A
Novice Test B
Team Test 
Individual Test 
Freestyle Test
Grade II Introductory Test A (national classes only)
Grade II Introductory Test B (national classes only)

Dressage Tests Grade III 
Novice Test A
Novice Test B
Team Test 
Individual Test 
Freestyle Test
Grade III Introductory Test A (national classes only)
Grade III Introductory Test B (national classes only)

Dressage Tests Grade IV
Novice Test A
Novice Test B
Team Test 
Individual Test 
Freestyle Test
Grade IV Introductory Test A (national classes only)
Grade IV Introductory Test B (national classes only)

Dressage Tests Grade IV
Novice Test A
Novice Test B
Team Test 
Individual Test 
Freestyle Test
Grade IV Introductory Test A (national classes only)
Grade IV Introductory Test B (national classes only)

Click here for the FEI Para-Equestrian tests

https://inside.fei.org/fei/your-role/organisers/p-e-dressage/tests
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For TOC classes

480

Dressage and Other Tests Built Into FVD (as of December 8, 2021)
SECTION VI. APPENDICES

•As of Dec 8, 2021, FVD has these tests, in the order presented, built into the program.
•The more commonly used dressage tests are highlighted here.
•The tests can be edited or deleted, and new tests can be added.  See Show Office  > Test Editor for the procedure to edit, delete and add tests.

NOTE:  List will be updated soon.
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Test Durations > USDF Approximation of Test Times

Click here for Resource on USDF Web Site

https://www.usdf.org/docs/ShowFlash/web/GeneralInfo/Before/TestTimes.pdf?v=09.03.2019


Fox Village Dressage User Manual – 2021 Update 1.0.5. helpdesk@foxvillage.com                 www.foxvillage.com

SECTION VI. APPENDICES

483

Test Durations > FVD Test Durations NOTE:  List will be updated soon.
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USEF Section Codes > Listed by Category

• Dressage USEF Section Codes are required for all recognized classes.  
• In FVD, they are entered in the Classes USEF Code box (see Classes). 
• Click here for the 2022 USEF source document.

NOTE: For USEF purposes, a class limited to AA, JYR, AA, or AJY 
riders (no Professional riders) is considered an Open class. 

NOTE: If there is no code for a class, use 1598 MISC DRESSAGE.  
Ex.: FEI Int A & B, etc.  

Not on FVD list; number can be hand entered

YOUNG HORSE

1551 FEI/USEF DRESSAGE TEST FOR 4-YEAR-OLD HORSES

1581 FEI PRELIMINARY DRESSAGE TEST FOR 5-YEAR-OLD HORSES

1542 FEI DRESSAGE TEST FOR 5-YEAR-OLD HORSES FINAL

1582 FEI PRELIMINARY DRESSAGE TEST FOR 6-YEAR-OLD HORSES

1543 FEI DRESSAGE TEST FOR 6-YEAR-OLD HORSES FINAL

1583 FEI PRELIMINARY DRESSAGE TEST FOR  7-YEAR-OLD HORSES

1562 FEI DRESSAGE TEST FOR 7-YEAR-OLD HORSES FINAL

1584 USEF DEVELOPING HORSE PRIX ST. GEORGES TEST

1585 USEF DEVELOPING HORSE GRAND PRIX TEST

PONY/CHILDREN/JUNIOR/YOUNG/16-25 RIDERS

1573 FEI PONY TEAM TEST

1574 FEI PONY INDIVIDUAL TEST

1586 FEI PONY FREESTYLE

1579 FEI CHILDREN TEAM TEST

1580 FEI CHILDREN INDIVIDUAL TEST

1572 FEI JR. TEAM TEST

1576 FEI JR. INDIVIDUAL TEST

1587 FEI JUNIOR FREESTYLE

1577 FEI YR. TEAM TEST

1578 FEI YR. INDIVIDUAL TEST

1588 FEI YOUNG RIDER FREESYTLE

1554 USEF YOUNG ADULT "BRENTINA CUP"

1555 FEI GRAND PRIX RIDERS AGES 16 - 25

SPORT HORSE BREEDING

5901 YRLG DRES. BRDG.

5902 2 YR OLD DRES. BRDG.

5903 3 YR OLD DRES. BRDG.

5906 DSHB 4-YEAR-OLD

5905 DSHB YOUNG HORSE

5904 DSHB MATURE HORSE

5900 DRESSAGE SPRT HRS BREEDING

1596 DRESSAGE BREEDING-MATERIALE

OTHER

1500 DRESSAGE - TOC

1593 PARA- EQUESTRIAN

1598 MISC DRESSAGE

6900 DRESSAGE SEAT MEDAL

USEF/USDF TESTS

1502 TRAINING LEVEL DRESSAGE

1504 FIRST LEVEL DRESSAGE

1507 SECOND LEVEL DRESSAGE

1510 THIRD LEVEL DRESSAGE

1513 FOURTH LEVEL DRESSAGE

FEI TESTS

1531 PRIX ST. GEORGE LEVEL

1533 INTERMEDIATE I

9943 INTERMEDIATE - A 

9946 INTERMEDIATE - B 

1535 INTERMEDIATE II

1537 GRAND PRIX LEVEL 

1556 GRAND PRIX SPECIAL

1557 CDI - GRAND PRIX OPEN

1558 CDI - GRAND PRIX SPECIAL

US & FEI FREESTYLES

1538 SECOND LEVEL FREESTYLE

1539 THIRD LEVEL FREESTYLE

1540 FOURTH LEVEL FREESTYLE

1541 FIRST LEVEL FREESTYLE

1534 INTERMEDIATE I FREESTYLE

1589 INTERMEDIATE A/B FREESTYLE

1526 GRAND PRIX FREESTYLE

1559 CDI - GRAND PRIX FREESTYLE

(as of December 9, 2021)

?????

?????
?????

https://www.usef.org/forms-pubs/Xj-0MTRXLKw/2022-section-codes-in-excel-format
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USEF Section Codes > Listed by Number

• Dressage USEF Section Codes are required for all 
recognized classes.  

• In FVD, they are entered in the Classes USEF 
Code box (see Classes). 

• Click here for the 2022 USEF source document.

Not on FVD list; number and title can 
be hand entered

1500 DRESSAGE - TOC
1502 TRAINING LEVEL DRESSAGE
1504 FIRST LEVEL DRESSAGE
1507 SECOND LEVEL DRESSAGE
1510 THIRD LEVEL DRESSAGE
1513 FOURTH LEVEL DRESSAGE
1526 GRAND PRIX FREESTYLE
1531 PRIX ST. GEORGE LEVEL
1533 INTERMEDIATE I
1534 INTERMEDIATE I FREESTYLE
1535 INTERMEDIATE II
1537 GRAND PRIX LEVEL 
1538 SECOND LEVEL FREESTYLE
1539 THIRD LEVEL FREESTYLE
1540 FOURTH LEVEL FREESTYLE
1541 FIRST LEVEL FREESTYLE
1542 FEI DRESSAGE TEST FOR 5-YEAR-OLD HORSES FINAL
1543 FEI DRESSAGE TEST FOR 6-YEAR-OLD HORSES FINAL
1551 FEI/USEF DRESSAGE TEST FOR 4-YEAR-OLD HORSES
1554 USEF YOUNG ADULT "BRENTINA CUP"
1555 FEI GRAND PRIX RIDERS AGES 16 - 25
1556 GRAND PRIX SPECIAL
1557 CDI - GRAND PRIX OPEN
1558 CDI - GRAND PRIX SPECIAL
1559 CDI - GRAND PRIX FREESTYLE
1562 FEI DRESSAGE TEST FOR 7-YEAR-OLD HORSES FINAL
1572 FEI JR. TEAM TEST
1573 FEI PONY TEAM TEST
1574 FEI PONY INDIVIDUAL TEST
1576 FEI JR. INDIVIDUAL TEST
1577 FEI YR. TEAM TEST
1578 FEI YR. INDIVIDUAL TEST
1579 FEI CHILDREN TEAM TEST
1580 FEI CHILDREN INDIVIDUAL TEST
1581 FEI PRELIMINARY DRESSAGE TEST FOR 5-YEAR-OLD HORSES
1582 FEI PRELIMINARY DRESSAGE TEST FOR 6-YEAR-OLD HORSES
1583 FEI PRELIMINARY DRESSAGE TEST FOR  7-YEAR-OLD HORSES
1584 USEF DEVELOPING HORSE PRIX ST. GEORGES TEST
1585 USEF DEVELOPING HORSE GRAND PRIX TEST
1586 FEI PONY FREESTYLE
1587 FEI JUNIOR FREESTYLE
1588 FEI YOUNG RIDER FREESYTLE
1589 INTERMEDIATE A/B FREESTYLE
1593 PARA- EQUESTRIAN
1596 DRESSAGE BREEDING-MATERIALE
1598 MISC DRESSAGE
5900 DRESSAGE SPRT HRS BREEDING
5901 YRLG DRES. BRDG.
5902 2 YR OLD DRES. BRDG.
5903 3 YR OLD DRES. BRDG.
5904 DSHB MATURE HORSE
5905 DSHB YOUNG HORSE
5906 DSHB 4-YEAR-OLD
6900 DRESSAGE SEAT MEDAL
9943 INTERMEDIATE - A 
9946 INTERMEDIATE - B 

(as of December 9, 2021)

https://www.usef.org/forms-pubs/Xj-0MTRXLKw/2022-section-codes-in-excel-format
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USEF Section Codes > Listed by FVD

On USEF list

(as of December 9, 2021)

Not on USEF list; do not use

NOTE:  List will be updated soon.
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EC Section Codes > Listed by FVD

• See SHOW PREFERENCES > MEMBERSHIP (1) TAB to use 
EC codes in the show.

• On the ❶ Class form, the ❷ EC (Section) Codes come 
directly from EC’s database. Canadian users click on the 
❸ Import EC Codes button to import the more current 
list.   Then use the ❹ EC Code drop-down arrow to 
select the correct code.

1

2

3

4

(as of December 9, 2021)
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• Although not required by USEF or USDF, the 
following standard nomenclature for class 
numbers is recommended:

Second # = Class “level” or “category” #

Training 0

First Level 1

Second Level 2

Third Level 3

Fourth Level 4

FEI PSG, Int I, Int A, Int B, Int II, GP, GPS 5

USDF MFS, FEI MFS 6

Other Tests 7+

First # = Show Day #

First show day 1

Second show day 2

Third show day 3

Etc. n

Third # = “test #” or “other” #

PSG 0

Test 1, Int 1, 1st MFS, Int 1 MFS, Quad 1st, 
Preliminary Test, USEF YH 4YO, DH PSG, DSE, PE 
Novice,  Fillies, Etc.

1

Test 2, Int 2 , 2nd MFS, GP MFS, Quad 2nd , Team, 
Brentina, FEI YH 4YO, DH GP, Colts, Etc.

2

Test 3, GP, Individual, 3rd MFS, Quad 3rd, 
Individual, YH 5YO Prelim, Geldings, Etc.

3

Test 4, GPS, 4th MFS, Quad 4th, Pony/JR/YR/PE 
MFS, YH 5YO Final, Etc.

4

FEI TOC (Int, GP), USDF MFS TOC, FEI MFS TOC, 
Quad TOC, YH 5YO Prelim, PE TOC, Etc.

5

FEI TOC (PSG, Int, GP),  Pas de Deux, YH 6YO 
Final, PE TOC

6

YH TOC, Etc. 7

Other Tests 8+

None 9

491

Dressage Class Numbers > Recommendations

• Use a three-digit number such as:
o First # = Show Day
o Second # = Class level or category
o Third # = test# or other

• If one class is split into two or more classes, the 
derivative classes are assigned decimals.  For 
example, if class #213 is split into two classes, 
the original Open class is #213.0 (0 for Open) and 
the new class is #213.1, etc.  A recommended 
nomenclature is as follows:
o 213.0 = Open Class (0 for Open)
o 213.1 = AA Class (1 type of rider status)
o 213.2 = JYR Class (2 types of rider status)
o 213.3 = AA/JYR Class (3 types of rider status)

213

• For example, a Day 2 - First Level - Test 3 class 
would be 213.  Any time class 213 is mentioned, 
the day, level, and test would be obvious.
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NOTE: See Scheduling Sheets Method for the use of these optional sheets. 
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02
04
06
08
10
12
14
16
18
20
22
24
26
28
30
32
34
36
38
40
42
44
46
48
50
52
54
56
58
60
62
64
66
68
70
72
74
76
78
80
82
84
86
88
90
92
94
96
98
100
102
104
106
108
110
112
114
116
118
120
122
124
126
128
130
132
134
136
138
140
142
144
146
148
150
152
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Scheduling Sheets > Class 2-152 MinutesSECTION VI. APPENDICES
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154
156
158
160
162
164
166
168
170
172
174
176
178
180
182
184
186
188
190
192
194
196
198
200
202
204
206
208
210
212
214
216
218
220
222
224
226
228
230
232
234
236
238
240
242
244
246
248
250
252
254
256
258
260
262
264
266
268
270
272
274
276
278
280
282
284
286
288
290
292
294
296
298
300
302
304
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Scheduling Sheets > Class 154-304 MinutesSECTION VI. APPENDICES
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306
308
310
312
314
316
318
320
322
324
326
328
330
332
334
336
338
340
342
344
346
348
350
352
354
356
358
360
362
364
366
368
370
372
374
376
378
380
382
384
386
388
390
392
394
396
398
400
402
404
406
408
410
412
414
416
418
420
422
424
426
428
430
432
434
436
438
440
442
444
446
448
450
452
454
456
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Scheduling Sheets > Class 306-456 MinutesSECTION VI. APPENDICES
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02
04
06
08
10
12
14
16
18
20
22
24
26
28
30
32
34
36
38
40
42
44
46
48
50
52
54
56
58
60
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Scheduling Sheets > Lunch 45- and 60-Minute

60 MINUTE LUNCH

02
04
06
08
10
12
14
16
18
20
22
24
26
28
30
32
34
36
38
40
42
44
45

45 MINUTE LUNCH

SECTION VI. APPENDICES
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Scheduling Sheets > Break 15- and 10-Minute

02
04
06
08
10

10 MINUTE BREAK

SECTION VI. APPENDICES

02
04
06
08
10
12
14
15

15 MINUTE BREAK

02
04
06
08
10

10 MINUTE BREAK

02
04
06
08
10

10 MINUTE BREAK

02
04
06
08
10

10 MINUTE BREAK

02
04
06
08
10

10 MINUTE BREAK

02
04
06
08
10
12
14
15

15 MINUTE BREAK

02
04
06
08
10
12
14
15

15 MINUTE BREAK

02
04
06
08
10
12
14

15

15 MINUTE BREAK

02
04
06
08
10
12
14
15

15 MINUTE BREAK
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Scheduling Sheets > Show Scheduling Sheet

Ring 1 Ring 2 Ring 3 Ring 4 Ring 5 Ring 6 Ring 7

Class #: Write in class numbers for each ring, in order of go.
X: Judge: Write in the letter position(s) and the judge name(s).
Include breaks and lunch.
Use the completed sheet for scheduling.

SECTION VI. APPENDICES
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Local Network vs. FVD Cloud Server

• Small shows - One Computer Possible
o If you have a small show, you may only need one FVD computer (Win 10 PC - desktop or laptop). This 

may work well if the secretary and the computer scorer are the same person (if entries do not need 
many changes during the show).  Having an internet connection is ideal as you can post real-time 
results.

• Most Shows - Two or More Computer Devices
o Most shows, even two-ring shows, need at least two computers – one for the secretary and one for 

the computer scorer/results person.
o When you have two or more computers, they need to be connected to each other so the FVD files can 

be simultaneously shared and updated from the two or more computers.
o FVD offers two methods of computer connections:
▪ Local Network – Two or more computers that are connected with one another for the purpose of 

communicating data electronically.  For FVD, the internet connection may be wireless, but the show 
computers must be connected via cables.  All the devices must be Win 10 PCs (desktops and/or 
laptops).  The FVD software is on the computers.

▪ FVD Cloud Server – Two or more computer devices, each with internet access (wired, Wi-Fi, or 
cellular), that are connected via the FVD Cloud Server for the purpose of communicating data 
electronically.  The devices may be desktops and/or laptops (Win or iOS PC or laptop) and tablets 
(Win, iOS, or Android).  The FVD software is on the FVD Cloud Server.

SECTION VII. NETWORKING COMPUTERS

LOCAL NETWORK FVD CLOUD SERVER

FVD

SHOW DEVICES

FVD SOFTWARE ON FVD CLOUD SERVER

• Computer use during a show:
o At the show, the computer(s) is/are used for:
▪ Secretary Duties:  Update entries, add GAIG Q fees, change rider or horse, etc., etc., etc.
▪ Scoring Duties:  Enter scores in FVD, place classes, print results, etc.
▪ Scribing Duties: Enter scores in FVD ring-side (optional but very handy).

o Show computers may also be used for other duties such as TD review of digital entry packets..

INTERNET

MODEM

ROUTER

SHOW COMPUTERS

WIRED CONNECTION

WIRED CONNECTION

HOTSPOTOR

WIRELESS CONNECTIONOR

BRIDGE

SWITCH

OR

WIRELESS CONNECTION

WIRED CONNECTION

ALL WIRED CONNECTIONS

FVD FVD

FVD SOFTWARE ON EACH COMPUTER
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Local Network vs. FVD Cloud Server > Comparison Chart

SECTION VII. NETWORKING COMPUTERS

TOPIC ONE COMPUTER
NO NETWORK

TWO + COMPUTERS
ALL WIRED 
CONNECTIONS

TWO + COMPUTERS
WIFI AND WIRED 
CONNECTIONS

TWO + COMPUTERS
FVD IN THE CLOUD
WIRED, WIFI, OR 
CELLULAR

Cloud Server NA NA FVD Cloud Server

Internet Connection Wired Wired (Ethernet) Wireless Wired, Wi-Fi or Cellular

Secretary Computer 
Device*

Win 10 PC** Win PC** Win PC**

Scoring/Results 
Computer Device*

NA Win PC** Win PC**

Scribe Computer 
Device(s)

NA Win PC** •Win PC**
•MAC
• iOS Tablet
•Android Tablet

Connection Equipment NA • Cable Modem
• Router
• Cables

•Hotspot
• Repeater/ Bridge 

Adapter
• Switch
• Cables

• Varies – equipment to 
connect each device to 
internet

• Can be wired, Wi-Fi, or 
cellular

Computer-to-Computer 
Connection

NA Wired (Ethernet) NA – connection is via 
the FVD Cloud Server

FVD Files on Secretary 
Computer

All FVD files All FVD files None

FVD File on Other Local 
Computers

NA FVD.accde None

Files on FVD Cloud 
Server

NA NA ALL FVD files

Plus • Very simple
• All files are local
• No computer 

connections

•All files are local
• Paperless test sheets
• Printers can be connected via the network

• Cloud connection easy 
to set up

• Computers do not have 
to be wired together

• Paperless test sheets
•Many types of devices
• Files on server 

automatically backed 
up

Minus • One computer shared 
by secretary and 
scoring

•Only Win 10 PC
•No paperless test 

sheets
• Files not automatically 

backed up

•Network can be difficult to set up
•All computers must have wired connections
•Only Win 10 PC
• Files not automatically backed up

• Scribe devices must 
also have internet 
access

•Use of iPad may 
require external 
keyboard and mouse

• Printers must be 
connected via network, 
Wi-Fi, r cables

* Secretary computer and scoring/results computer may be the same computer, depending upon desired work process.
* Win 10 PC is a desktop or laptop running Win 10 Home or Win 10 Pro.

• This chart compares and contrasts a Local Network and FVD in the Cloud.
• The details of each method are in the following pages.
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Local Network > Introduction

INTRODUCTION:
• Most show offices have a secretary section and a separate scoring section dedicated to scoring test 

sheets.  For shows that enter scores on the computer during the show, a computer (or computers) 
dedicated to scoring activities is preferable.  This scenario requires, as a minimum, at least two 
computers – one for the show secretary (secretary/master computer) and one for the scoring section 
(scoring/slave computer).  
o The secretary/master computer has the FVD program and data files (*.sdf, HR.hdf and Test.tdf).  
o The scoring/slave computer has the FVD program and uses the data files on the secretary/master 

computer via the network.
• The two (or more) computers must be networked – connected so they can exchange files and perhaps 

printers and other devices. 
• Large shows may have multiple computers for the show office and multiple computers for scoring, 

including computers in the judge stands used for eScoring.  For theses shows, it is it is recommended that 
a network administrator be hired. 

• This manual will cover the use of one secretary/master computer and one scoring/slave computer.  

• Computers can be networked with wires (wired with Ethernet cables) or without wires (wireless or WiFi).  
For FVD, to ensure data is not lost, the internet connection can be wired or wireless; however, the 
computers should be connected with wires (Ethernet cables).  

• Basic equipment required for networking two FVD computers:

SECTION VII. NETWORKING COMPUTERS

• Schematic diagrams for the wired and wireless internet connection setups are on the next two pages.

Wired Internet Connection Wireless Internet Connection

Internet Access 
(requires a data plan)

Cable Modem Hotspot

Computer Network Connector Router
• Repeater/Bridge Adapter for 

Wireless/ Wired Hookup
• Ethernet Unmanaged Switch 

Computers with Ethernet Port*
1. Secretary/master computer with FVD and data files
2. Scoring/slave computer with FVD; uses secretary/master computer

data files via the network

* Most desktop and laptop computers have internal Ethernet ports for connecting to a wired network.
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COMMON WIRED AND WIRELESS LOCAL NETWORK CONNECTIONS FOR FVD

FVD SOFTWARE ON EACH SHOW COMPUTER

NOTE 1:  This chapter is intended to assist you in setting up a local network.  It does not cover specific use of 
FVD.  If you need help with a network, please contact a network specialist. 
NOTE 2:  The following instructions are based on Windows 10.  Features may have changed for Windows 11.

Local Network > Diagram

DIAGRAM:

WIRED 
CONNECTIONS

WIRED 
CONNECTION

MODEM

ROUTER

HOTSPOT 
(WIRELESS)

BRIDGE

WIRED 
CONNECTION

WIRELESS 
CONNECTION

WIRELESS 
CONNECTION

SWITCH

FVD FVD

WIRED 
CONNECTION

PC 
ETHERNET 

PORT

PC 
ETHERNET 
PORT

PRINTER 
ETHERNET 

PORT

WIRED 
CONNECTIONS
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Local Network > 1. Wired Internet Access and Wired Computer Connections

SECTION VII. NETWORKING COMPUTERS

Internet

Cable Modem

Wired Internet Access

Wired (Ethernet) Cable

Secretary/Master Computer

Router

Requires a data plan.  This 
may be provided by the 
show facility.

Scoring/Slave Computer

• MS Access 2013 
or later

• FVD
• License.dll
• Show Data Files

• MS Access 2013 
or later

• FVD
• License.dll

Wired Internet Access

Wired (Ethernet) Cables

FRONT

BACK

Wired Computer Connections

IMPORTANT 
• For FVD Data Integrity:
o Internet access may be wired or wireless.  
o Show computers must have a wired connection.

• FVD files may be shared via the cloud but they 
cannot be used simultaneously; therefore, cloud 
sharing does not work during a show.

NOTE:  The products mentioned here are 
suggestions only.  Similar products also work.

1. WIRED INTERNET ACCESS AND WIRED COMPUTER CONNECTIONS:
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Local Network > 2. Wireless Internet Access and Wired Computer Connections

SECTION VII. NETWORKING COMPUTERS

Internet

Wireless Internet Access

Wireless (WiFi) Signal

Secretary/Master Computer

Hotspot - Requires a data plan from 
a provider. This may be provided by 
the facility.

Scoring/Slave Computer

• MS Access 2013 
or later

• FVD
• License.dll
• Show Data Files

• MS Access 2013 
or later

• FVD
• License.dll

Wireless Internet Access

Wired (Ethernet) Cables

Click here for source
$37.58 via Amazon

NETGEAR 5-Port Gigabit 
Ethernet Unmanaged Switch 
(GS105NA)

Click here for source
$38.00 via Amazon

VONETS 2-in-1 WiFi 
Repeater/Bridge Adapter for 
Wireless/ Wired Hookup

Wired Computer Connections

IMPORTANT 
• For FVD Data Integrity:
o Internet access may be wired or wireless.  
o Show computers must have a wired connection.

• FVD files may be shared via the cloud but they 
cannot be used simultaneously; therefore, cloud 
sharing does not work during a show.

NOTE:  The products mentioned here are 
suggestions only.  Similar products also work.

2. WIRELESS INTERNET ACCESS AND WIRED COMPUTER CONNECTIONS:

https://www.amazon.com/gp/product/B0000BVYT3/ref=ppx_yo_dt_b_search_asin_title?ie=UTF8&psc=1
https://www.amazon.com/gp/product/B01GF6GST4/ref=ppx_yo_dt_b_search_asin_title?ie=UTF8&psc=1
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Local Network > Resources, Network Setup Overview 

NETWORK SETUP OVERVIEW:
• Setup the Computers to Run FVD:
o All computers must have: 
▪ MS Access 2013 or later or the runtime version.
▪ Fox Village Dressage software installed on the C: > Users > [UserName] > Documents > FVD folder.
▪ The License.dll file obtained when you paid for FVD (copy the file from the Secretary/Master 

computer to the Scoring/slave computer) on the C: > Users > [UserName] > Documents > FVD 
folder.

o The Secretary/Master computer also has the show data files (*.sdf, HR.hdf, and test.tdf).
o The Scoring/Slave computer has FVD (FVD.accde) but not the FVD data files.

• Plan Your Network:  Determine if you will have wired or wireless internet connection.  
• Get Internet Access:  If needed, sign up with an internet service provider (ISP) and an appropriate data 

plan.  The cable modem or hotspot is often leased or purchased with the plan.
• Get the Necessary Network Hardware: 
o Wired internet and wired computer connections: Purchase modem, router, and Ethernet cables.
o Wireless internet and wired computer connections:  Purchase hotspot, repeater/bridge adapter for 

wireless/wired hookup, Ethernet unmanaged switch, and Ethernet cables.
• Connect the Network Hardware and Computers:  Use instructions that came with the equipment and 

the previous diagrams.
• Setup the Computers for Networking:
o Setup the network type network (Private or Guest/Public).
o Setup the network profiles (network discovery, file and printer sharing, public folder sharing, media 

streaming (if needed), file sharing connections (encryption), password protected sharing).
o Set up file sharing and/or folder sharing, if needed.

• Use Files on Another Computer

SECTION VII. NETWORKING COMPUTERS

RESOURCES:  
• Click here – Windows Home Networking Made Easy: Home and Small Office Connectivity (book, April 

2019 or later, Bernstein)
• Click here – How to change the Windows 10 network location to private (or public) (web, Digital Citizen)
• Click here – How to customize advanced network sharing settings in Windows (web, Digital Citizen)
• Click here – How to share files and printers without HomeGroup on Windows 10 (web, Windows Central)
• Click here – File sharing over a network in Windows 10 (web, Microsoft)
• Click here – Windows 10 Shared Folder Not Showing (web, Microsoft)
• Click here – Homegroup removed!  How to get Network Sharing to Work with Windows 10 v1803 (web, 

Microsoft)

NOTE: Prior to April 2018, Windows 10 had Homegroup that made it easy for non-IT professionals to set up a 
small network.  Unfortunately, Homegroup no longer exists so a regular network set-up is required.  Now you 
must set-up network types, network profiles, file sharing and folder sharing, etc.  

NOTE: I find that networking computers can be VERY confusing, probably because there are SOOOOO many 
options that appear to overlap.  Microsoft and the internet have many tutorials, but I have not found one that 
covers Windows 10 networking form A to Z.  It is sort of like learning to bake a cake online: one link tells you 
how to break an egg, another how to measure flour, another how much vanilla, etc.; however, there is no link 
to tell you how to put it all together and actually bake the cake.  An exception is the Bernstein book reference.  
This local network chapter is my understanding of how to get computers networked.  You may have a different 
and perhaps better way.  If you do, please share it with me at LeslieRaulin@gmail.com.

https://www.amazon.com/gp/product/1096109913/ref=ppx_yo_dt_b_asin_title_o01_s00?ie=UTF8&psc=1
https://www.digitalcitizen.life/how-set-your-networks-location-private-or-public-windows-10
https://www.digitalcitizen.life/how-customize-your-advanced-network-sharing-settings-windows-81
https://www.windowscentral.com/how-share-files-and-printers-without-homegroup-windows-10
https://support.microsoft.com/en-us/help/4092694/windows-10-file-sharing-over-a-network
https://answers.microsoft.com/en-us/windows/forum/windows_10-networking/windows-10-shared-folder-not-showing/f80e3e1e-0703-4fdf-bfdb-737800ff726e?auth=1
https://answers.microsoft.com/en-us/windows/forum/windows_10-files/homegroup-removed-how-to-get-network-sharing-work/01277332-2916-4a68-853a-116696b20743
mailto:LeslieRaulin@gmail.com
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Local Network > Network Types and Network Profiles

NETWORK TYPES:
• There two types of commonly used networks in Windows 10:
o ❶ Private:  Used for networks you trust, such as a home or show network.

▪ Has less protection from other devices on the same network because it treats that network as trusted.
▪ The PC is discoverable on the network, and you can share folders and printers with that network.
▪ This profile should be used for your home network or to the network from your workplace. When this 

type is assigned to a network connection, network discovery is turned on, file and printer sharing are 
turned on.

▪ Settings can be changed to provide less or more protection.
o ❷ Guest/Public:  Used for networks you do NOT trust, such as coffee shops, hotels, and airports.

▪ Has the maximum protection possible from other devices on the same network because it treats that 
network as untrusted.

▪ The PC is not discoverable on the network, and you cannot share folders and printers with that 
network.

▪ This profile should be used when connecting to public networks you don't trust, like those found in 
airports, coffee shops, bars, hotels, etc.

▪ Settings can be changed to provide less or more protection.
• When you connect to a new and unknown network, the operating system sets it as Guest/Public. 
• If needed, you can change it to Private.

NETWORK PROFILES:
• Each network type has a network profile.
• A network profile includes network and sharing settings that are applied to the type of network you are 

using. 
• Based on the network type assigned to your active network connection (Private or Guest/Public), features 

such as file and printer sharing, network discovery, and others may be enabled or disabled. 
• These network profiles are useful to people who are very mobile and connect their computers and devices to 

many networks.  For example, you could use your home laptop to connect to your home network, take it to a 
show and connect to the facility’s network or the show sponsor’s network and, when traveling to a show, 
connect to free WiFi networks in hotels and airports.

• Each time you connect to a new network, Windows asks you to assign a network profile whether you want to 
make your computer discoverable on the network.  With this choice, you set the network and sharing 
settings that are appropriate for that network connection.  This helps you maintain the security of your 
system and turn on network and sharing features only when they are useful to you.

SECTION VII. NETWORKING COMPUTERS

1

2

NETWORK TYPE

NETWORK TYPE
NETWORK PROFILE

NETWORK PROFILE
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Local Network > Change Network Type > Wireless Internet Connection

• Left click on the ❶ WiFi button in the 
notification area of the taskbar (usually found on 
the bottom-right corner of the screen). 

SECTION VII. NETWORKING COMPUTERS

1

2

3

4

5

6

CHANGE NETWORK TYPE > WIRELESS INTERNET CONNECTION:
• The following shows you how to change the wireless network to Private.
• You must be logged in with a user account that has administrator privileges. 

• Click ❷ Properties link beneath the name of the 
WiFi network to which you are connected.

• A ❸ Settings window opens, with settings for 
the wireless network that you are connected to. 

• In the ❹ Network profile section, If the ❺
Public radial button is active, click the ❻ Private 
radial button. The network profile is changed to 
Private.

• Alternately, if the ❻ Private radial button is 
active, click the ❺ Public radial button. The 
network profile is changed to Public.

• For FVD, you may choose Public or Private, 
depending on your level of trust of the 
connection.  If in doubt, choose Public.
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Local Network > Change Network Type > Wired Internet Connection

• Click on the ❶ Network button in the notification 
area of the taskbar (usually found on the bottom-
right corner of the screen). 

SECTION VII. NETWORKING COMPUTERS

1

2

CHANGE NETWORK TYPE > WIRED INTERNET CONNECTION:
• The following shows you how to change the wired network to Private.
• You must be logged in with a user account that has administrator privileges. 

• Click the ❷ name of the wired network you are 
connected to.

• A ❺ Network profile window opens, with 
settings for the wired network that you are 
connected to. 

• If the ❼ Private radial button is active, click the 
❻ Public radial button. The network profile is 
changed to Public.

• Alternately, if the ❻ Public radial button is 
active, click the ❼ Private radial button. The 
network profile is changed to Private.

• For FVD, you may choose Public or Private, 
depending on your level of trust of the 
connection.  If in doubt, choose Public.

3

4

7

5

6

• The ❸ Settings window opens.
• Click the ❹ name of the wired network you are 

connected to.
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Local Network > Setup Network Profiles > 1. Open Network and Sharing Center

SETUP NETWORK PROFILES > 1. OPEN NETWORK AND SHARING CENTER:

SECTION VII. NETWORKING COMPUTERS

1

2

2

3

Continued on next page…

• Click ❸ Network and Internet.

• Using ❶ Cortana or other method, open ❷
Control Panel.
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Local Network > Setup Network Profiles > 2. Open Advanced Sharing Settings

• The ❶ Control Panel\Network and Internet window opens.
• Click ❷ View network status and tasks.

SECTION VII. NETWORKING COMPUTERS

3

4

2

1

• The  ❸ Control Panel\Network and Internet\Network and Sharing Center window opens.
• Click ❹ Change advanced sharing settings.

SETUP NETWORK PROFILES > 2. OPEN ADVANCED SHARING SETTINGS:
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Local Network > Setup Network Profiles > 3. Look at the Profiles

• The  Control Panel\Network and Internet\Network and Sharing Center\Advanced sharing settings
window opens.

• There are two network types whose profiles can be setup can be set up.  Additionally, there is All 
Networks whose profiles are applies to both network types.
o ❶ Private
o ❷ Guest or Public
o ❸ All Networks

• Private and Guest/Public have different settings that are applied when connecting to a network of that 
type. 

• All Networks has settings that apply to both Private and Guest/Public networks.
• The network profile assigned to your existing network connection is indicated by the statement ❹

current profile placed next to the name of one of the available profiles.
• You can collapse or expand the display of any network profile by clicking or tapping the ❺ arrow placed 

to its right.  This displays the settings available for each network profile, as on the next page.

SECTION VII. NETWORKING COMPUTERS

1

2

3

4

5

5

5

Two network types, each with a separate profile.

All Networks profiles apply to both network types.

SETUP NETWORK PROFILES > 3. LOOK AT THE PROFILES:

PRIVATE NETWORK TYPE

NETWORK PROFILE

GUEST/PUBLIC NETWORK TYPE

NETWORK PROFILE

ALL NETWORK TYPES
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Local Network > Setup Network Profiles > 3. Look at the Profiles, cont’d.

SECTION VII. NETWORKING COMPUTERS

Continued on next page…

• ❶ Private Profiles:

o Xx Network discovery

o Xx File and printer sharing

• ❷ Guest/Public Profiles:

o Xx Network discovery

o Xx  File and printer sharing

• ❸ All Networks Profiles:

o Xx Public folder sharing

o Xx Media streaming

o Xx File sharing connections

o Xx Password protected sharing

o These settings and their defaults 
apply to all network 
connections.

1a

1b

2b

3a

3b

3d

2a

3c

1

2

3

PRIVATE NETWORK TYPE

GUEST/PUBLIC NETWORK TYPE

NETWORK PROFILE

NETWORK PROFILE

ALL NETWORK TYPES

NETWORK PROFILE

NETWORK PROFILE

NETWORK PROFILE

NETWORK PROFILE

NETWORK PROFILE

NETWORK PROFILE

1a

1b

3d

3c

3b

3a

2b

2a
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Local Network > Setup Network Profiles > 4. Network Discovery 
(Private Network & Guest/Public Network)

• When ❶ Network Discovery is turned on, Windows searches for other devices on the network and it 
allows other computers and devices on the same network to find your computer or device. 

• When ❶ Network Discovery is turned off, Windows does not search for other devices.
• RECOMMENDATIONS: 
o Private Networks: 
▪ Turn Network Discovery on. 
▪ For ❷ Turn on automatic setup of network connected devices (default is checked = on):
➢ This feature affects the way Windows 10 works with network devices like external hard drives 

that are connected to the router or to another computer in the network. 
➢ Such devices can be used by features like File History. 
➢ This tool can detect hard disks that are attached to other network PCs or devices and use them 

for backing up your personal files and folders.
o Guest or Public Networks:
▪ Turn Network Discovery off so your device will not be visible to other computers and others will 

not be able to access what you are sharing on the networks that are trusted.
o FVD: 
▪ Turn Network Discovery on so the show computers and other devices can be “discovered.”

SECTION VII. NETWORKING COMPUTERS

1

1

2

SETUP NETWORK PROFILES > 4. NETWORK DISCOVERY:

https://www.digitalcitizen.life/file-history
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Local Network > Setup Network Profiles > 5. File and Printer Sharing 
(Private Networks & Guest/Public Networks)

• When ❶ File and Printer Sharing is on, you can share files and printers with other computers and 
devices on your network. 

• When ❶ File and Printer Sharing is off,, you will not be able to share anything. Even if your computer is 
visible to other devices on the network, no one will be able to view any shared folders and printers.

• RECOMMENDATIONS:
o Private Networks: Turn File and Printer Sharing on.
o Public and Guest Networks: Turn File and Printer Sharing on.
o FVD: Turn File and Printer Sharing on so the show computers can share files and printer(s).

SECTION VII. NETWORKING COMPUTERS

1

1

SETUP NETWORK PROFILES > 5. FILE AND PRINTER SHARING:
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Local Network > Setup Network Profiles > 6. Public Folder Sharing (All Networks) 

• When ❶ Public File Sharing is turned on, people on the network can access the files from your Public 
folder, which can be found at C: > Users > Public. 

• When ❶ Public File Sharing is turned off, people on the network cannot access the files from your 
Public folder. 

• RECOMMENDATIONS:
o Private Networks: Turn Public Folder Sharing on if there is more than one user.
o Public and Guest Networks: Turn Public Folder Sharing off.
o FVD: If your FVD files are at C: > Users > Public > Documents > FVD, turn Public Folder Sharing on so 

the show computers can share files and printer(s).

SECTION VII. NETWORKING COMPUTERS

1

SETUP NETWORK PROFILES > 6. PUBLIC FOLDER SHARING:
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Local Network > Setup Network Profiles > 7. Media Streaming (All Networks)

• When ❶Media Streaming is on, people and devices on the network can access pictures, music, and 
videos on this computer. 

• When ❶Media Streaming is off, people and devices on the network cannot access pictures, music, and 
videos on this computer. 

• To change the settings, click ❷ Choose media streaming options… .  Follow the instructions on the 
screen.

• RECOMMENDATIONS:
o Private Network: Turn this feature on if you need to use it.
o Guest or Public Network: Turn this feature off if unless you need to use it.
o FVD: Most uses of FVD do not involve media streaming; therefore, the status of this setting does not 

usually affect networking for FVD.

SECTION VII. NETWORKING COMPUTERS

1

2

SETUP NETWORK PROFILES > 7. MEDIA STREAMING:
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Local Network > Setup Network Profiles > 8. File Sharing Connections (All Networks)

• ❶ File Sharing Connections is about the type of encryption used for file sharing connections, when 
computers connect to each other and copy files and folders from one another. 
o ❷ 128-bit encryption is the default.   Data transfer is more secure and harder to intercept.  
o ❸ 40- or 56- bit encryption is less secure but may be needed for older equipment.

• RECOMMENDATIONS:  
o Private or Guest/Public Networks: 
▪ If you have more current equipment and operating systems, use 128-bit encryption. 
▪ If you have older devices or computers that cannot properly access your shared files and folders, 

use 40- or 56-bit encryption and keep in mind that this is a less secure option.
o FVD: Follow the above recommendation.

SECTION VII. NETWORKING COMPUTERS

1

2

SETUP NETWORK PROFILES > 8. FILE SHARING CONNECTIONS:

3
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Local Network > Setup Network Profiles > 9. Password Protected Sharing (All Networks) 

• When ❶ Password Protected Sharing is turned on, people need a password to access your shared 
folders and files. 

• When ❶ Password Protected Sharing is turned off, people do not need a password to access your 
shared folders and files. 

• RECOMMENDATIONS:
o Private and Guest/Public Networks: Keep this feature turned on at all times to prevent unwanted 

people from accessing your shared resources.
o FVD: 
▪ Keep this feature on (password required) so only people with the password may used the folders 

and files.
▪ In a show setting, you may want the setting off (no password required) since you may have many 

computer users with whom the password will need to be provided.

SECTION VII. NETWORKING COMPUTERS

1

SETUP NETWORK PROFILES > 9. PASSWORD PROTECTED SHARING:
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Local Network > Setup Network Profiles > 10. Save Changes 

• After you have made changes to network profiles, click ❶ Save changes to save your changes.

SECTION VII. NETWORKING COMPUTERS

1

SETUP NETWORK PROFILES > 10. SAVE CHANGES:
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Local Network > Sharing Specific Folders

SHARING SPECIFIC FOLDERS:
• Depending upon your network type and profile settings, you may need to share specific folders.
• If you only want to share multiple folders in the local network, using the File Explorer sharing options is 

the best approach.
• Open File Explorer.  
o On most Windows 10 computers, it is the ❶ file folder button on the bottom left the of Taskbar.
o It can also be opened by clicking ❷My Computer.

SECTION VII. NETWORKING COMPUTERS

1 2

3

4

• The ❸ File Explorer window opens.

• Navigate to the folder you want to share.  For FVD, it is ❹ C: > Users > [UserName] > Documents > FVD.

Continued on next page…
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Local Network > Sharing Specific Folders, cont’d.
• Right click the folder.
• Put your cursor over ❺ Give access to.
• Click ❻ Specific people... .

SECTION VII. NETWORKING COMPUTERS

5

6

7

• The ❼ Network access window opens.

Continued on next page…
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Local Network > Sharing Specific Folders, cont’d.

• Using the ❽ drop-down arrow, select the 
users with whom you want to share the 
folder.
o ❾ Guest: Shares the contents with a 

designated guest (non-registered user of 
the network) without the need to enter a 
password to access the files.

o ❿ Email address for a specific user.
o ⓫ Everyone: Shares the contents with 

anyone in the network without the need 
to enter a password to access the files.

o ⓬ Create a new user… : Legacy feature 
that does not work!

SECTION VII. NETWORKING COMPUTERS

Continued on next page…

• ⓭Everyone is now in the box.

• Select ❾ Everyone.

9

8

SpecificUserName (SpecificUserEmailAddress)
9

10
11
12

SpecificUserName (SpecificUserEmailAddress)
13
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Local Network > Sharing Specific Folders, cont’d.

• Using the ⓮ drop-down arrow, select read, 
read/write, or remove. 
o ⓯ Read: Gives network users the ability 

to list and open files, but they won't be 
able to modify or delete existing files and 
folders. Also, they won't be able to 
upload or create new folders or files.

o ⓰ Read/Write: Allows users to list, 
open, modify, delete, upload, and create 
new files and folders.

o ⓱ Remove: Blocks the specified user or 
group from accessing the folder and its 
contents.

• For FVD, select Read/Write.
• Click ⓲ Share.

SECTION VII. NETWORKING COMPUTERS

OPTIONAL:
• Right click the ⓴ shared folder path; the 

background turns blue.
• Click ⓴ Copy Link.
• Share the link with other users on the 

network.

• Click XX Done.

• The ⓳ Your folder is shared window 
opens.

22

14

15

16
17

18

19

20
21

22

21
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Local Network > Sharing Specific Files

SHARING SPECIFIC FILES:
• Depending upon your network type and profile settings, you may need to share specific files.
• When you only need to share one or multiple files to another computer you can use the Share feature.
• Open File Explorer.  
o On most Windows 10 computers, it is the ❶ file folder button on the bottom left the of Taskbar.
o It can also be opened by clicking ❷My Computer.

SECTION VII. NETWORKING COMPUTERS

Continued on next page…

1 2

3

4

• The ❸ File Explorer window opens.

• Navigate to the folder with the files you want to share.  For FVD, it is ❹ C: > Users > [UserName] > 
Documents > FVD.
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Local Network > Sharing Specific Files, cont’d.

• Select the files you want to share.  For FVD, this is ❺ *.sdf (Show file), ❻ HR.hdf (Horse & Rider file), 
and ❼ Test.tdf (Test file).

SECTION VII. NETWORKING COMPUTERS

Continued on next page…

5

6

7

8

• Click on the ❽ Share menu button.  
• The ❾ Share ribbon opens.
• Click the ❿ Share button.

9
10
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Local Network > Sharing Specific Files, cont’d.

• The ⓫ Share window opens.
• Windows searches for devices to share and displays them in the third section.  In this example, it found 
⓬MSI-Laptop, which is the computer with which I want to share the files.

• Click the ⓬ button of the device.

SECTION VII. NETWORKING COMPUTERS

• On the OTHER computer, the ⓭ Nearby sharing window opens.
• Click ⓮ Save.
• The designated files can now be shared (seen and used on) the laptop computer.

11

12

13

14
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Local Network > Use Folders and Files on Another Computer

USE FOLDERS AND FILES ON ANOTHER COMPUTER:
• Now that you have made all your network settings, it is finally time to use files on another computer!

SECTION VII. NETWORKING COMPUTERS

1 2

• ❸ File Explorer (or My Computer) opens.
• Scroll down the left-hand pane until you see ❹

Network.
• Click on ❹ Network.

3

4

• You see ❺MSI-LAPTOP, the second 
computer on the network.

• Double click on ❺MSI-LAPTOP.

• Open ❶ File Explorer or ❷My Computer.

5

Continued on next page…
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Local Network > Use Folders and Files on Another Computer, cont’d.

SECTION VII. NETWORKING COMPUTERS

• The ❾ Users folder opens.  
Its ❿ subfolders can be 
seen.

• You can use these folders as 
if they were on master 
computer.

• The ❻ \\MSI-LAPTOP folder on the 
networked computer opens.

• You can see its ❼ C:\ drive, ❽ D:\ drive, 
and ❾ Users folders.

• Double click any of the folders.  In this 
example, we will click the ❾ Users folder.

6

7

8

6

9

6

• For example, on the laptop 
the FVD folder is on the 
Users/Public folder.  Click ⓫
Public and you will see the 
⓬ FVD folder.

• Time to get to work on your 
show!

10
11

9

12

11
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Local Network > Troubleshooting > Windows 10 Shared Folder Not Showing

SECTION VII. NETWORKING COMPUTERS

• With all the above, which in my opinion is way too complicated, you still may not be able to Files 
between two computers!

• Many thanks to IT specialist Jason Bryant, who is a dressage show volunteer (he does parking!!!).  He 
used this and the next trouble shooting hints when we had trouble getting computers to talk to each 
other.  Click here. to see the hint online. 

Continued on next page…

• Using Cortana, search for ❶ Services.
• Click ❷ Services App.

1

2

3

4

• The ❸ Services 
window opens.

• You need to change the 
following services to 
have ❹ Startup Type >
Automatic:
o Function Discovery 

Provider Host
o Function Discovery 

Resource Publication
o SSDP Discovery
o UPnP Device Host

TROUBLESHOOTING > WINDOWS 10 SHARED FOLDER NOT SHOWING:

NOTE: Change these services 
settings on all your computers.

https://answers.microsoft.com/en-us/windows/forum/windows_10-networking/windows-10-shared-folder-not-showing/f80e3e1e-0703-4fdf-bfdb-737800ff726e?auth=1


Fox Village Dressage User Manual – 2021 Update 1.0.5. helpdesk@foxvillage.com                 www.foxvillage.com533

Local Network > Troubleshooting > Windows 10 Shared Folder Not Showing, cont’d.

SECTION VII. NETWORKING COMPUTERS

• We will first do Function Discovery Provider Host.
• Using the ❺ scrollbar, find ❻ Function Discovery Provider Host.
• Under ❼ Startup Type, double click ❽Manual (or the setting you see).

• ❻ Function Discovery Provider Host now has 
the Startup type setting of ⓭ Automatic.

5

6

7

8

• The ❾ Function Discovery Provider Host 
Properties (Local Computer) window opens.

• Using the ❿ Startup type drop-down arrow, 
select ⓫ Automatic.

• Click ⓬ OK.

• Repeat for:
o Function Discovery Resource Publication
o SSDP Discovery
o UPnP Device Host

9

6
7

10

11

12

13
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Local Network > Troubleshooting > Homegroup Removed!  How to Get Network Sharing to 
Work with Windows 10 v1803

SECTION VII. NETWORKING COMPUTERS

• Prior to April 2018, Windows 10 had Homegroup that made it easy for non-IT professionals to set up a 
small local network.  Unfortunately, starting with Windows 10 v1803 (April 2018), Homegroup no longer 
exists so a regular network set-up is required.  

• If your computers are running Windows 10 v1803 or older (not recommended as there is a reason they 
do updates!!), you may need to do some tweaking.

• The procedure is long, so I have not included the details in this manual.  Click here for the procedure.  
You will need to sign up with the Microsoft community (providing a username) to open the link.

• How to determine your Windows 10 version:
o Using Cortana, type ❶ About.
o Click ❷ About your PC.

1

2

3

4

5
6
7
8

9

o The ❸ Settings window 
opens.

o Using the scrollbar, scroll 
down until you see ❹
Windows specifications.  

o You will see:
▪ ❺ Edition
▪ ❻ Version
▪ ❼ Installed on
▪ ❽ OS build

▪ In this example, you can 
see ❾ Version 1909.

NOTE: It is recommended that all your computers be 
setup so you automatically receive Windows 10 
updates.  By doing this, you will always have the 
most recent version of the operating system, which 
will give you better security, current features, and 
perhaps better networking.  And, it is free!

TROUBLESHOOTING > HOMEGROUP REMOVED!  HOW TO GET NETWORK SHARING TO WORK WITH 
WINDOWS 10 V1803 :

NOTE: Change these settings on all your computers.

https://answers.microsoft.com/en-us/windows/forum/windows_10-files/homegroup-removed-how-to-get-network-sharing-work/01277332-2916-4a68-853a-116696b20743
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Local Network > Summary for FVD

SECTION VII. NETWORKING COMPUTERS

• NETWORK TYPE: For FVD, you may choose Public or Private, depending on your level of trust of the 
connection.  If in doubt, choose Public as it provides the most protections.

• NETWORK PROFILES:
o Network Discovery: Turn on so the show computers and other devices can be “discovered.”
o File and Printer: Turn on so the show computers can share files and printer(s).
o Public Folder Sharing:  If your FVD files are at C: > Users > Public > Documents > FVD, turn Public 

Folder Sharing on so the show computers can share files and printer(s).
o Media Streaming: Most uses of FVD do not involve media streaming; therefore, the status of this 

setting does not usually affect networking for FVD.
o File Sharing Connections (encryption):  Use 128-bit unless you have older equipment.
o Password Protected Sharing:  
▪ Turn off (no password required) if you are in a show setting with many computer users with whom 

the password will need to be provided.
▪ Turn on (password required) so only people with the password may used the folders and files.

• SHARING SPECIFIC FOLDERS:  Use this feature if you only want to share specific folders.

• SHARING SPECIFIC FILES: Use this feature if you only want to share specific files.

Show Scorer Using FVD & 
FVD Files on Show Secretary Computer 

to Score the Show

Show Secretary Using FVD & 
FVD Files on Show Secretary Computer

To Manage Show

SCORER

FVD.accde
License.dll

*.sdf
HR.hdf
Test.tdf

FVD.accde
License.dll

SECRETARY
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SECTION VII. NETWORKING COMPUTERS
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537

FVD Cloud Server > What is FVD Cloud Server?, What is Remote Desktop?

• Easy Method to Connect Show Devices:
o FVD Cloud Server is an easy method now available to FVD users to connect show devices for file 

sharing.
o It uses the FVD Cloud Server; all FVD files are on the server.
o Users may use a desktop or laptop (Windows or MacOS) or tablet (Windows, Android or iOS).
o Show devices no longer require a wired connection between them; however, each requires its own 

wired, Wi-Fi or cellular internet connection.
o Scribes may enter POINTS, ERRORS and judge comments near the judge or at a remote location (a 

talking communication method between judge and scribe is necessary). POINTS, ERRORS and judge 
comments input by the scribe are on the FVD Cloud Server.

o The show office uses the scores on the FVD Cloud Server to place classes and post results.
• Paperless Scoring:
o FVD in the Cloud also offers a paperless method of scoring that directly uses the FVD Cloud Server for 

recording POINTS, ERRORS and judge comments in the cloud.  
o The paperless method is a safer method of scoring in this day of infectious diseases as a dressage test 

sheet does not have to pass from secretary > scribe > judge > runner > scoring > awards.  Instead, the 
competitor obtains their test sheet online.

o This is an advanced FVD feature with a cost of $150 per show.

WHAT IS FVD CLOUD SERVER?:

• Remote Desktop is a technology that allows users to connect to a specific remote computer (FVD Cloud 
Server) from a location (secretary’s home, show office, judge huts) as if they were sitting in front of the 
remote computer.  Users can perform a wide range of tasks as if they are actually using the remote 
computer (FVD Cloud Server) in person.

WHAT IS REMOTE DESKTOP?:

NOTE: For this manual:
• A show device is a desktop or laptop computer (Win or MAC) or tablet (Win, Android or iOS).  
• A show device is not a printer or other computer accessory you may use.

Windows 
Desktop Windows 

Laptop

Windows 
Tablet

MacOS 
Desktop

MacOS 
Laptop

iOS 
TabletAndroid 

Tablet

FVD CLOUD SERVER SHOW DEVICES

NOTE: When you 
use a tablet, it is 
easier if you also 
use a compatible 
keyboard and a 
mouse.

NOTE: Remote desktop software must be installed/setup on each show device.  Multiple 
companies offer remote desktop software for Windows, MacOS, and tablets (Win, iOS and 
Android) devices.  This manual uses a specific version of Remote Desktop for Windows and a 
specific version of Remote Desktop for the iPad.  Versions for other devices will function similarly.
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FVD Cloud Server > Schematic of FVD Cloud Server

FVD Cloud Server = Remote Desktop

Secretary Scoring 

Scribe at Ring 1

Show devices log on to the FVD Cloud Server via Remote Desktop software 

Wired, Wi-Fi, or Cellular Internet Access

Show Devices 
Run FVD from 
the FVD 
Cloud Server

All FVD Files 
are on the FVD 
Cloud Server

FVD Files

Etc.

Show Devices 
can be PC, MAC, 

or Tablet (Win, 
iOS, or Android)

FVD

Show Devices

NOTE: Printers and other 
accessories are not connected 
via FVD in the Cloud.  They 
must be connected via Wi-Fi, 
cables or a network.
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FVD Cloud Server > Steps for Use

STEP 1: IMPORTANT INFORMATION BEFORE YOU START:
• FVD will provide you with:

1) USERNAMES (multiple)– you need a separate username for each show device.
2) PASSWORD (one) – all your show devices will use the same password.
3) DOMAIN NAME (one) of the FVD Cloud Server (fvdts.foxvillage.com:3489) – everyone uses the same 

domain name.
4) SERVER E:FVD* FOLDER – all your files will be stored on this folder and all your devices will have 

access to this folder.
• Store this information in a safe place so it is available when you need it.

STEP 7: CREATE A COPY OF FVD.accde FOR EACH SHOW DEVICE:
• Using one of your show devices, log onto your Server E: FVD Folder.
• Make copies of  5) FVD.accde, one for each device.

STEP 8: USE THE CORRECT FVD.ACCDE FILE FOR EACH DEVICE:
• Logon to your Server E: FVD Folder.
• To open FVD, double-click on the appropriate FVD.accde file.

## = number provided by FVD; for example, FVD13

DEVICE 1) USERNAMES 2) PASSWORD 3) DOMAIN NAME 4) E: FOLDER 5) FVD.accde FILE

Secretary FVD##user1@foxvillage.com PASSWORD
provided by FVD

All your show 
devices use the 
same PW

fvdts.foxvillage.com:3489

All your show devices use 
the same domain name

E:FVD##

All your show 
devices use the 
same Server E: 
Folder

FVD-Sec.accde

Scoring FVD##user2@foxvillage.com FVD-Score.accde

Ring 1 FVD##user3@foxvillage.com FVD-Ring1.accde

Ring 2 FVD##user4@foxvillage.com FVD-Ring2.accde

Etc. Etc. Etc.

STEP 2: FVD CLOUD SERVER > SETUP REMOTE DESKTOP FOR EACH SHOW DEVICE:
• After you receive the above information, setup Remote Desktop Connection software for each device.

STEP 4: A LOOK AT THE FVD CLOUD SERVER SCREEN:
• This step familiarizes you with the FVD Cloud Server screen.

STEP 6: COPY YOUR FVD FILES TO THE SERVER:
• This step shows you how to copy your FVD files from you Local C: FVD Folder to your Server E: FVD 

Folder.

STEP 5: ACCESS TO YOUR LOCAL C: DRIVE VIA THE FVD CLOUD SERVER:
• This is an optional step.
• Perform the step if you might need access to your Local C: FVD drive via the FVD Cloud Server. 

STEP 3. LOGON TO THE FVD CLOUD SERVER:
• After you install and setup Remote Desktop software, you can logon to the FVD Cloud Server.
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FVD Cloud Server > Step 2a. Setup Remote Desktop for Win 10 PC > 
Win 10 Pro Vs. Win 10 Home

• If your computer has Windows 10 Pro, you can use Windows 10 Remote Desktop directly from 
Windows.  Select ❼ Start > ❽ Settings > ❾ System > ❿ Remote Desktop and turn on ⓫ Enable 
Remote Desktop.

• If you are using Windows 10 Home, you need to install a third-party remote desktop program. 
• This manual uses Thinstuff TSX Client (see next pages, it is free), which is recommended by FVD.

• To determine if your computer has Windows 10 Pro or Windows 10 Home, select ❶ Start > ❷
Settings > ❸ System > ❹ About and look for ❺ Edition.  It will say ❻Windows 10 Pro or Windows 
10 Home.

STEP 2a. SETUP REMOTE DESKTOP FOR WIN PC > 10 PRO VS. WINDOWS 10 HOME:

> >

1

2

3

4
5 6

> > ❿ Remote Desktop

7

8

9

⓫ Enable Remote Desktop>
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FVD Cloud Server > Step 2a. Remote Desktop for Win 10 Home PC > 
Install Thinstuff TSX Client

• These instructions are for Windows 10 Home users only.
• You install Thinstuff TSX Client on your local Win 10 PCs.
• Click here to open the Thinstuff TSX Client page, which has the following:

STEP 2a. REMOTE DESKTOP FOR WIN 10 HOME PC > INSTALL THINSTUFF TSX CLIENT:

• Read everything on the page (the FAQ are definitely for computer experts!).
• Click ❶ Download.
• A ❷ Opening ThinstuffTsxClient-2.0.24.exe window opens.
• Click ❸ Save File.

Continued on next page…

1

2

3

NOTE: Remote desktop 
software must be 
installed/setup on each 
show device.  Multiple 
companies offer remote 
desktop software for 
Windows, MacOS, and 
tablets (Win, iOS and 
Android) devices.  This 
manual uses a specific 
version of Remote Desktop 
for Windows and a specific 
version of Remote Desktop 
for the iPad.  Versions for 
other devices are similar.

https://www.thinstuff.com/products/tsx-client/
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FVD Cloud Server > Step 2a. Remote Desktop for Win 10 Home PC > 
Install Thinstuff TSX Client, Cont’d.

• For most computers, the ❹ ThinstuffTsxClient-2.0.24.exe file is saved in your ❺ C > Users > 
[Username] > Downloads folder. 

• (Optional)  If desired, cut and paste the file to another folder of your choice.  For downloaded software, I 
have a ❻ C: DownloadedSoftware folder, under which I create subfolders titled with the software 
name.  In this example, I named the subfolder ❼ Thinware-TSX-Client.  I cut and pasted the 
downloaded ❹ ThinstuffTsxClient-2.0.24.exe file into this subfolder.

• Double-click the ❹ ThinstuffTsxClient-2.0.24.exe file.
• Windows opens a warning window.  Click YES.
• A ❽ TSX Client 2.0.24 Setup form opens.
• Click ❾ Next >.

Continued on next page…

4

5

8

9

6 7

4
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FVD Cloud Server > Step 2a. Remote Desktop for Win 10 Home PC > 
Install Thinstuff TSX Client, Cont’d.

Continued on next page…

• A new ❿ TSX Client 2.0.24 Setup form opens. 
for the bootstrapper action.

• If needed, click ⓫ Install.
• Click ⓬ Next >.

• A new ⓭ TSX Client 2.0.24 Setup form opens for 
the License Agreement.

• Read the license agreement.
• Click ⓮ I Agree.

• A new ⓯ TSX Client 2.0.24 Setup form opens for 
the Install.

• Since you are installing TSX Client, Client is in the 
box.

• Click ⓰ Next >.

10

11

12

15

16

14

13
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FVD Cloud Server > Step 2a. Remote Desktop for Win 10 Home PC > 
Install Thinstuff TSX Client, Cont’d.

• A new ⓱ TSX Client 2.0.24 Setup window opens 
for Choose Install Location.

• If you want the default folder ⓲ C:\Program 
Files\ThinStuff\TSX Client, click ⓳ Install.

• If you want a different folder, click ⓴ Browse…, 
select the folder, then click ⓳ Install.

• The program is installed.
• A new XX TSX Client 2.0.24 Setup window opens 

for Completing the TSX Client 2.0.24 Setup 
Wizard.

• Click XX Finish.

17

18

19

20

21

22

23

24

21

22

• The installation added XX TSX Client Connection 
Manager and XX TSX Client Connection to Start.

• It also installs shortcuts on the Desktop.

• The files are found at XX C: > Program Files > 
Thinstuff > TSX Client.

23

24

25

25

TSX Client Connection Manager

TSX Client Connection
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FVD Cloud Server > Step 2a. Remote Desktop for Win 10 Home PC > 
Setup Thinstuff TSX Client

Continued on next page…

• Now that you have installed Thinstuff TSX Client, you use it to setup and use Remote Desktop.
• If not already received, email FVD at helpdesk@foxvillage.com to obtain a User Name, Password, and 

Folder on the FVD Cloud Server.
• Open TSX Client Connection:
o Click Start > ❶ TSX Client Connection, or
o Click ❷ C: > Program Files > Thinstuff > TSX Client > ❸ tstsc.exe, or
o Click the ❹ TSX Client Connection icon place on your desktop during installation.

• The ❺ Thinstuff TSX Client Remote Desktop 
Connection window opens.

• Click ❻ Options to view more setup options 
(the graphic is after options are opened).

• In the ❼ Name box, enter ❽ Fox Village TS.
• In the ❾ Connection type box, ensure ❿

Desktop is selected.
• In the ⓫ Computer box, enter ⓬

fvdts.foxvillage.com:3489.
• In the ⓭ User name box, type the ⓮ user 

name provided to you by FVD (you must use a 
different username for each show device; see 
Setup Parameters for Show Devices for 
recommendations on the use of usernames).

• Click ⓯ Connect.

4

1

2

3

5

6

7 8

9 10

11 12

13 14

15

STEP 2a. REMOTE DESKTOP FOR WIN 10 HOME PC > SETUP THINSTUFF TSX CLIENT :

mailto:helpdesk@foxvillage.com
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FVD Cloud Server > Step 2a. Remote Desktop for Win 10 Home PC > 
Setup Thinstuff TSX Client, Cont’d.

• A ⓰ Remote Desktop Connection window 
opens.

• Click ⓱ Connect.

16

17

18

19

20

• A connection occurs.
• A ⓲Windows Security window opens.
• Enter the ⓳ Password provided by FVD.
• Click ⓴ OK.

• A connection occurs.
• A xx Remote Desktop Connection window 

opens.
• Click XX Yes.

21

22

21

22

• The FVD Cloud Server screen opens.
• The screen will be introduced after iPad remote 

connection instructions.  See FVD Cloud Server 
Screen.
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FVD Cloud Server > Step 2b. Remote Desktop for iPad > 
Install Microsoft Remote Desktop Client for iOS

• From your iPad > App Store, download/install ❶ Remote Desktop Mobile (free)(requires iOS 13.0 or 
later) by clicking x GET. 

• An ❷ App Store window opens asking you to verify the install (the method depends on your iPad 
version and setup).

1

2

STEP 2b. REMOTE DESKTOP FOR iPAD > INSTALL MS REMOTE DESKTOP CLIENT FOR iOS:

NOTE: For an Android 
tablet, use Chrome Remote 
Desktop or a third-party 
program of your choice.

NOTE: The blue
background indicates 
the window is on the 
iPad.

This section covers iPads.  The procedure for other tablets is similar.

• The program is installed.

NOTE: Remote desktop software must be installed/setup on each show device.  Multiple 
companies offer remote desktop software for Windows, MacOS, and tablets (Win, iOS and 
Android) devices.  This manual uses a specific version of Remote Desktop for Windows and a 
specific version of Remote Desktop for the iPad.  Versions for other devices are similar.
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FVD Cloud Server > Step 2b. Remote Desktop for iPad > 
Open Microsoft Remote Desktop Client for iOS

STEP 2b. REMOTE DESKTOP FOR iPAD > INSTALL MS REMOTE DESKTOP CLIENT FOR iOS:

• Click ❶ OPEN now or at all other times click the ❷ RD Client icon placed on the screen during the 
installation.

1

2

OR

FIRST USE

ALL SUBSEQUENT USES
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FVD Cloud Server > Step 2b. Remote Desktop for iPad > 
Setup Microsoft Remote Desktop Client for iOS

• After you click OPEN or the RD Client icon for the first time, you are asked for access to your Bluetooth, 
Camera, and Microphone.  Click OK to each request.

• The ❶ RD Client screen opens.
• Ensure ❷ PCs is highlighted (dark orange). 
• Click the ❸ + (plus).

Continued on next page…

2

31

STEP 2b. REMOTE DESKTOP FOR iPAD > INSTALL MS REMOTE DESKTOP CLIENT FOR iOS:
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FVD Cloud Server > Step 2b. Remote Desktop for iPad > 
Setup Microsoft Remote Desktop Client for iOS, Cont’d.

• A ❹menu opens.
• Click ❺ Add PC.

Continued on next page…

• An ❻ Add PC menu opens.
• Click ❼ PC Name - Hostname or IP Address >.  

This is asking for the FVD Cloud Server Hostname 
(fvdts.foxvillage.com:3489)’

• A ❽ PC Name menu opens.  
• In the box, type ❾ fvdts.foxvillage.com:3489.
• Click the ❿ < (left arrow).

• You are returned to the ⓫ Add PC menu.
• Note that the ⓬ fvdts.foxvillage.com:3489 is 

now in the PC Name box.
• Click ⓭ User Account – Ask When Required >.

4

5

6

7

8

9

10

11

12

13
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FVD Cloud Server > Step 2b. Remote Desktop for iPad > 
Setup Microsoft Remote Desktop Client for iOS, Cont’d.

• The ⓮ User Account menu opens.
• Click ⓯ Add User Account >.

Continued on next page…

• The ⓰ Add User Account menu opens.
• In the ⓱ User@Domain or Domain\User box, 

type the username provided by FVD.  (See Setup 
Parameters for Show Devices for 
recommendations on the use of usernames.)

• In the ⓲ Password box, type the password 
provided by FVD.

• Click ⓳ Friendly Name >.

• The ⓴ Friendly Name menu opens.  
• In the XX Optional box, type a name that will 

help you remember the user.  In this example, 
User Ring 1 was used as this iPad will be used 
by the scribe in Ring 1.

• Click the XX < (left arrow).
• You now see XX User Ring 1 in the Friendly 

name box.
• Click the XX < (left arrow).

14

15

16

17

18

19

Type in username from FVD

Type in password from FVD

• You are returned to the XX Add User Account 
menu.

• You see:
o XX Username from FVD
o XX Password from FVD
o XX Friendly Name – User Ring 1

• Click XX Save.  This saves the User Account.

25

26

29

28

27

25

26

27•••••••••••

******************

28

29

User Ring 1

20

21

22

23

24

User Ring 1  

21

22

23

24
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FVD Cloud Server > Step 2b. Remote Desktop for iPad > 
Setup Microsoft Remote Desktop Client for iOS, Cont’d..

Continued on next page…

• You are returned to the XX User Account menu.
• Note that XX User Ring 1 is checked so is active.
• Click the XX < (left arrow).

30

31

32

• You are returned to the XX Add PC menu.
• You see:
o XX PC Name – fvdts.foxvillage.com:3489.
o XX User Account – User Secretary.

• Click XX Friendly Name.

33

34

35

36

• The XX Friendly Name menu opens.  
• In the XX Optional box, type a name that will 

help you remember the PC. In this example, 
FVD Cloud Server is recommended as this PC is 
the FVD Cloud Server.

• Click the XX < (left arrow).
• You now see XX  FVD Cloud Server in the 

Friendly name box.
• Click the XX < (left arrow).

37

38

39

40

41

37

38

39

40

41

• You are returned to the XX Add PC menu.
• You see:
o XX PC Name – fvdts.foxvillage.com:3489
o XX User Account – User Secretary
o XX Friendly Name – FVD Cloud Server

• Click XX Save.  This saves the PC (FVD Cloud 
Server) settings that were just established.

42

43

44

45

46

33

34

35

36

User Ring 1

42

43

44

45

46

User Ring 1

30

31

32

User Ring 1       
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FVD Cloud Server > Step 2b. Remote Desktop for iPad > 
Setup Microsoft Remote Desktop Client for iOS, Cont’d..

• You are returned to the XX RD Client main menu.
• You now have the XX FVD Cloud Server icon on the main menu.
• You have successfully set up Microsoft Remote Desktop Client for iOS so you can now logon to the FVD 

Cloud Server with your iPad tablet.

47

48

47

48

• To log onto the FVD Cloud Server from the iPad, 
click the XX RD Client icon.

49

• The XX Microsoft Remote Desktop Client for 
iOS opens.

• Click the XX FVD Cloud Server icon.
• The FVD Cloud Server screen opens and you can 

run FVD on your iPad as though it is a PC.  Yay!

50

51

49

50

51
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FVD Cloud Server > Step 3. Logon to the FVD Cloud Server

• Double click the Remote Desktop icon on your device.
• For a Windows 10 Home device, click the ❶ TSX Client Connection icon.

1 2

3

4

5

6

7

8

• The ❸ Thinstuff TSX Client Remote Desktop 
Connection form opens.

• Click ❹ Connect.

• A ❺ Remote Desktop Connection form opens.
• Click ❻ Connect.

• A ❼ Remote Desktop Connection form opens.
• Click ❽ Yes.

• The connection to the FVD Cloud Server is done.

STEP 3. LOGON TO THE FVD CLOUD SERVER:

• For an iPad, click the ❷ RD Client icon.
• This example uses Thinstuff TSX Client Remote 

Desktop Connection.
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FVD Cloud Server > Step 4: A Look at the FVD Cloud Server Screen > Top Center Icons

Continued on next page…

• The FVD Cloud Server (Remote Desktop) window opens:

• Features of the FVD Remote Desktop window:
o Top Center Icons (click the top center if you do not see this):
▪ ❶ Down arrow:  Opens a menu for App commands, Charms, Switch apps, and Start.  You do not 

need to use this.
▪ ❷ Pin the connection bar.  You do not need to use this.
▪ ❸ Connection info: Click the icon to open a window that states the quality of the connection from 

your computer to the FVD Server (cloud).  This is handy information.
▪ ❹ Name of the FVD server (fvdts.foxvillage.com).
▪ ❺Minimize:  Minimizes the window to an icon on the taskbar.  Click the icon on the taskbar        

to un-minimize.  
▪ ❻Maximize: Click to maximize the window so it encompasses the entire monitor.  Click maximize 

again to unmaximize the window.
▪ ❼ Close: Click to close the FVD Remote Desktop connection but does not log off properly.  

Instead, use FVD IN THE CLOUD > IMPORTANT INFORMATION > WHEN YOU FINISH.

Top Center Icons
Top Left Icons

Bottom Left Icons Bottom Right Icons

STEP 4. A LOOK AT THE FVD CLOUD SERVER SCREEN > TOP CENTER ICONS:

1 2 3 5 6 74
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FVD in the Cloud > Step 4: A Look at the FVD Cloud Server Screen > Top Left Icons

Continued on next page…

o Top Left Icons:
▪ ❶ Recycle Bin:  Location of deleted files.  Click in the Recycle Bin files that you want 

to undelete. 
▪ ❷Mac Files:  Location of files created with a Mac computer. 
▪ ❸ FVD2020 103.accde - Shortcut:  
➢ Double click to open the FVD program on the FVD cloud server.
➢ A ❹Microsoft Security Notice opens.
➢ It shows the ❺ File Path on the FVD Cloud Server (in this example is it 

E:\FVD13\FVD2020 103.accde; yours will be different).
➢ Click ❻ Open.
➢ The usual ❼ FVD window opens.

1

2

3

4

5

6

7

STEP 4: A LOOK AT THE FVD CLOUD SERVER SCREEN > TOP LEFT ICONS:

Top Center Icons

Top Left Icons

Bottom Left Icons Bottom Right Icons

Use this icon 
to open FVD 
on the FVD 
Cloud Server
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FVD in the Cloud > Step 4: A Look at the FVD Cloud Server Screen >
Bottom Left Icons, Bottom Right Icons

o Bottom Left Icons:
▪ ❶ Start: Functions as in Windows 10, except features are on the FVD Cloud Server.
▪ ❷ Server Manager: Used to change User Account Control.  You cannot use this feature. 
▪ ❸Windows PowerShell: Opens a DOS window.  You do not need to use this.
▪ ❹ File Explorer: Functions as on Windows 10.  Shows files structure on the FVD Cloud Server.  You 

can only edit the E: drive folder assigned to you by FVD.
▪ ❺ [Microsoft] Store: Functions as on Windows 10.  You do not need to use this.

Top Center Icons
Top Left Icons

Bottom Left Icons Bottom Right Icons

o Bottom Right Icons:
▪ ❻ Solve PC Issues: Functions as in Windows 10.  You do not need to use this function.
▪ ❼ Network Connection: Functions as in Windows 10.  You do not need to use this function. 
▪ ❽ Audio Service: Functions as in Windows 10.  You do not need to use this function. 
▪ ❾ Time and Date: Functions as on Windows 10.  Shows the time and date of the FVD Cloud 

Server.

STEP 4: A LOOK AT THE FVD CLOUD SERVER SCREEN > BOTTOM LEFT ICONS, BOTTOM RIGHT ICONS:

1 2 3 4 5

6 7 8 9
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FVD Cloud Server > Step 5: Access Your Local C: Drive via the FVD Cloud Server > Setup

1

2

3

• To set up access to your desktop’s C: drive so you 
can use it from the FVD Cloud Server:
o Open ❶ TSX Client Connection, as previously 

described.
o Click ❷ Resources.
o Click ❸More.

Continued on next page…

STEP 5: ACCESS YOUR LOCAL C: DRIVE VIA THE FVD CLOUD SERVER > SETUP:

• This is an optional step.  Perform this step if you think you will need access to your local C: drive via the 
FVD Cloud Server. For example, it is another method to copy your files to the server E: drive.  

• The TSX Client Remote Desktop Connection provides a method to access your local C: drive.
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FVD Cloud Server > Step 5: Access to Your Local C: Drive via the FVD Cloud Server >
Setup, Cont’d.

4

56

7

8

9

o The ❹ Local devices and resources window 
opens.

o Ensure the ❺ Drives box is checked.
o Click the ❻ > (right arrow).

o Another ❼ Local devices and resources 
window opens.

o Unclick all drive letters except ❽ C.
o Click ❾ OK.

o On the ❶ TSX Client Connection window, 
click ❿ Connect.

10

1

Continued on next page…
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FVD Cloud Server > Step 5: Access Your Local C: Drive via the FVD Cloud Server >
Access Your Local C: Drive

• The ❶ FVD Cloud Server window opens.
• Double click the ❷ File Explorer icon.

C
o

ntin
u

ed
 o

n
 n

ext p
a

g
e…

1

2

• ❸ This PC opens on the FVD Cloud Server.
• Your local C: drive is at ❹ C on XPS8930 [C = drive, XPS8930 = local drive name (yours will be different)].
• Double click ❹ C on XPS8930.

3

4

3

4

4

STEP 5: ACCESS YOUR LOCAL C: DRIVE VIA THE FVD CLOUD SERVER > ACCESS YOUR LOCAL C: DRIVE:
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FVD Cloud Server > Step 5: Access Your Local C: Drive via the FVD Cloud Server >
Access Your Local C: Drive, Cont’d.

• The❺ C on XPS8930 folder opens.
• Double click on ❻ Users.

Continued on next page…

• The ❼ Users folder opens.
• Double click on ❽ [Username] (Lesli in this 

example).

• The ❾ Lesli folder opens.
• Double click on ❿ Documents.

5

6

7

8

7

10

9

9
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FVD Cloud Server > Step 5: Access Your Local C: Drive via the FVD Cloud Server >
Access Your Local C: Drive, Cont’d.

• The⓫ Documents folder opens.
• Double click on ⓬ FVD.

Continued on next page…

• The ⓭ FVD folder opens.
• Double click on ⓮ FVD (it is FVD.accde but the 

file extension does not show on the FVD Cloud 
Server).

11

12

11

13

14

13
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FVD Cloud Server > Step 6: Copy Your FVD Files to the Server

• Connect to the FVD Cloud Server, as previously 
described.

• On the server, double click ❶ File Manager on 
the bottom left of the screen.

1

• The ❹ Data (E:) folder opens.
• Each folder is assigned to a FVD user group.
• Double click on ❺ FVD## (this is the folder on 

the FVD Cloud Server that FVD assigned to your 
FVD user group).

• The ❷ This PC folder opens.
• Double click on ❸ Data (E:) (this is the drive on 

the FVD Cloud Server where FVD user group files 
are located).

4

5

4

Continued on next page…

STEP 6: COPY YOUR FVD FILES TO THE SERVER:

2

3

2

NOTE: The black
background indicates 
the window is on the 
FVD Cloud Server.

NOTES: 
• When you first start a subscription to FVD, the FVD staff will install the FVD files onto a Server E: FVD Folder 

assigned to your user group.  
• If you are an existing FVD user, you will need to copy/paste your FVD files onto your Server E: FVD Folder.
• When a FVD update is issued, you copy the new *.exe file onto your Server E: FVD Folder then double click to 

install the updates.
• This chapter covers how to copy your FVD files from your Local C: FVD Folder to your Server E: FVD Folder.
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FVD Cloud Server > Step 6: Copy Your FVD Files to the Server, Cont’d.

• Your ❻ FVD## folder opens.  IN this example, it 
is FVD13.

• Your ❼ FVD files are now in your E: folder on 
the FVD Cloud Server.

• You can now use FVD as in the usual manner 
using the files on the FVD Cloud Server.

• On your Local C: FVD folder (C: > Users > 
[UserName] > Documents > FVD), copy the FVD 
files to the clipboard.

• Paste your FVD files to your Server E: FVD Folder
(depending upon your internet connection, this 
may take a few minutes).

6

6

6

6

7
7
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FVD in the Cloud > Step 7: Create a Copy of FVD.accde for Each Show Device

• You need a separate copy of FVD.accde for each 
device you will use at your show.

• The following filenames may assist you:
o FVD-Sec.accde for show secretary computer
o FVD-Score.accde for scoring/results computer
o FVD-Ring1.accde for Ring 1 computer/device
o FVD-Ring2.accde for Ring 2 computer/device
o Etc.

• Create the copies of FVD.accde:
o Connect to your Server E: FVD Folder, as 

previously described.
o Single click on the ❶ file to be copied, FVD1 

in this example.  Its background turns light 
blue.

o Click ❷ Copy.
o Click ❸ Paste.

1

2 3

4

5

• Change filenames:
o The ❹ copy is now seen (Access uses the 

original filename followed by - Copy).
o To change the copy filename, click on the 

filename until it has a dark blue background 
with a box around it:

o Type in the new filename.  In this example, it 
will be FVD-Score.accde.

o Repeat so that FVD1 - Copy becomes FVD-
Sec.accde.

o The filenames are now:

o Repeat for the rings.

• The ❺ four files in this example are now seen.

Go to the next page for instructions on signing on 
each device.

STEP 7. CREATE A COPY OF FVD.accde FOR EACH SHOW DEVICE:
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FVD Cloud Server > Step 8: Use the Correct FVD.accde File for Each Device

1

• With any show device, logon to the FVD Cloud 
Server by clicking the appropriate icon for the 
device.

• Single click the ❶ File Explorer icon at the lower 
left of the screen.

• The ❷ This PC window opens.
• Double click the ❸ Data (E:) icon.

2

3

• The ❹ Data (E:) window opens.
• Double click the ❺ Folder that was assigned to 

your user group.  In this example, it is FVD13.

5

4

Continued on next page…

STEP 8:  USE THE CORRECT FVD.accde FILE FOR 
EACH DEVICE:



Fox Village Dressage User Manual – 2021 Update 1.0.5. helpdesk@foxvillage.com                 www.foxvillage.com

SECTION VII. NETWORKING COMPUTERS

567

FVD Cloud Server > Step 8: Use the Correct FVD.accde File for Each Device, Cont’d.

• The folder screen opens.  In this example, the 
folder is ❻ FVD13.

• Double click on the appropriate ❼ FVD* file for 
the device you are using.  For example:
o Secretary device – use ❽ FVD-Sec.accde.
o Scoring device – use ❾ FVD-Score.accde.
o Ring 1 device – use ❿ FVD-Ring1.accde.
o Ring 2 device – use ⓫ FVD-Ring2.accde.

Continued on next page…

6

7

8

9

10

11

12

13

14

15

• A ⓬Microsoft Access Security Notice form 
opens.

• Click ⓭ Open.

• You may get a message asking you if you want to 
create a new template.  Click Yes or NO, 
depending upon your next task.

• ⓮ FVD opens.
• Click ⓯ Repair All Links and select the show’s 

*.sdf, HR.hdf, and Test.tdf files.

• Repeat for other show devices.

• You are ready to run your show!
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FVD Cloud Server > Use FVD Cloud Server at a Show

• Your devices are now ready for your show.  You use FVD in the usual manner.
• All FVD files are on the FVD Cloud Server.  
• Each local device is using a different FVD*.accde file but all devices are using the same *.sdf, HR.hdf, and 

Test.tdf files so the data is shared; for example:
o If a Scribe enters scores, the Scorer/Results person sees the scores.
o If the Secretary scratches a ride, the Scribe and Scorer/Results person see the scratch.
o Etc.

*.sdf
HR.hdf
Test.tdf

Secretary 
Device

Scoring 
Device

Ring 1 
Device

Ring 2 
Device

FVD-Sec.accde     FVD-Score.accde     FVD-Ring1.accde     FVD-Ring2.accde

FVD Cloud Server

USE FVD CLOUD SERVER AT A SHOW:
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FVD Cloud Server > Sign Out When you Finish

SIGN OUT WHEN YOU FINISH:

• When you finish your session on the FVD Cloud Server (long break, lunch, dinner, 
end of the show, etc.), you must sign out (log off) the server.  

• Procedure:
o At the bottom left of the FVD Cloud Server screen, click the ❶ Start icon.
o The ❷ Start screen opens.
o Click the ❸ username at the top right of the screen.
o A ❹menu opens.
o Click ❺ Sign out.
o You are logged off the FVD Cloud Server and the screen closes.

• When work resumes, you will need to log on again (details to follow).

1

4

5

username

1

3

3
2
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SECTION VIII. PROGRAM FUNCTIONS

• The ❶ FILE tab does not open a ribbon; instead, it takes the user to a screen with:
o ❷ Arrow:  Returns the user to the ❸ FVD Main Menu.
o ❹ Feedback: Opens the ❺ Feedback section that sends messages to Microsoft (not FVD).
o ❻ Exit closes the FVD program.

3

1

4

2 5

6
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SECTION VIII. PROGRAM FUNCTIONS

❶ Fox Village Dressage opens a ribbon with the following functions:
❷ Show Template
❺ Create Show Template
❻ Open Show Template

❸ Show File 
❼ Create Show File
❽ Open Show File

❹ File Linking
❾ Repair All Links
❿ Show File
⓫ Horse & Rider File
⓬ Test File
⓭ Linked Files

1

2

5

6

3 4

7

8
9 10

11

12

13

NOTE:   See FVD Interface for complete use of these functions.
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Fox Village Dressage > Show Template > Create Show Template

SECTION VIII. PROGRAM FUNCTIONS

SHOW TEMPLATE > CREATE SHOW TEMPLATE:
• Create Show Template is used to create a Show Template file that contains all the recurring information 

for a recurring show or show series.  
• A Show Template is used to create a new show whose file.  The template is already populated with 

recurring show information such as location, show manager, show secretary, classes, stalls, etc.
• A Show Template is particularly helpful if you sponsor the same show every year with the same classes, 

the same stalls, etc.  
• A Show Template can be updated with new recurring information, if needed.
• A Show Template avoids the re-entering of the recurring show information and show preferences for 

every show.
• By default, Show Template files are saved in the FVD/Support folder and have the extension *.kdf.
• It is recommended that you name show template files to identify the show type and the fact that it is a 

template file.  For example, YYYY-BHD-Template.kdf, where YYYY is the year, BHD is the show name 
(Blue Horse Dressage), and Template indicates it is a template file.  Of course, the *.kdf extension 
identifies the file as a template file; however, adding the word Template makes it even more obvious.

• See START THE FVD PROGRAM & CREATE FIRST TEMPLATE and CREATE A SHOW TEMPLATE AND OPEN A 
SHOW TEMPLATE for details on creating a show template.  

• For previous versions of FVD, a Show Template was optional.  It is now required.

1

2

5
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Fox Village Dressage > Show Template > Open Show Template

SHOW TEMPLATE > OPEN SHOW TEMPLATE: 
• Open Show Template is used to open and edit a Show Template that you previously created.  For 

example, the facility may have built a new barn so you need to add more stalls, you may have a new 
show secretary email address, etc.

• When you open FVD, it automatically opens the template (or show) on which you were previously 
working.  If you want to continue to work on the same template (or show), you do not need to do 
anything.

• See CREATE A SHOW TEMPLATE AND OPEN A SHOW TEMPLATE and EDIT A SHOW TEMPLATE for details.

SECTION VIII. PROGRAM FUNCTIONS

1

2

6



Fox Village Dressage User Manual – 2021 Update 1.0.5. helpdesk@foxvillage.com                 www.foxvillage.com575

Fox Village Dressage > Show File > Create Show File

SHOW FILE > CREATE SHOW FILE: 
• Create a Show File is used to create a new show from an existing Show Template file that has recurring 

show information already entered.
• Show files have the *.sdf extension.
• It is recommended that you name the show file so it is evident which show it represents.  For example, 

YYYY-BHD-Show.sdf where YYYY is the show year, BHD is the show, and Show indicates it is a show file. 
Of course, the *.sdf extension identifies the file as a show file; however, adding the word Show makes it 
even more obvious.

• See CREATE A SHOW TEMPLATE & OPEN A SHOW TEMPLATE and EDIT A SHOW TEMPLATE for procedures 
to create and edit a show template.

• See CREATE A SHOW FILE FROM A SHOW TEMPLATE FILE for procedures to create a new show from a 
show template.

SECTION VIII. PROGRAM FUNCTIONS

1

3

7
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Fox Village Dressage > Show File > Open Show File

SHOW FILE > OPEN SHOW FILE: 
• Open Show File is used to open a previously created show file.
• When you open FVD, it automatically opens the show (or template) on which you were previously 

working.  If you want to continue to work on the same show (or template), you do not need to do 
anything.

• If you want to work on a different show, you need to open the second show.  The Show File > Open 
function does this for you.

• Opening a show is a process whereby you open a previously created show.
• See OPEN A SHOW FILE for procedures.
• After you open the file, link the show file (*.sdf) to the HR.hdf and Test.tdf files (see REPAIR ALL LINKS for 

procedures.

SECTION VIII. PROGRAM FUNCTIONS

1

3

8



Fox Village Dressage User Manual – 2021 Update 1.0.5. helpdesk@foxvillage.com                 www.foxvillage.com577

Fox Village Dressage > File Linking > Repair All Links

FILE LINKING > REPAIR ALL LINKS:
• Repair All Links is used to link the FVD files, so they share data.
• As described in INTRODUCTION TO FVD, the FVD program has a number of different files.  Key files 

include:
o Show Data File (*.sdf ) (* = the name of your show file)
o Horse & Rider File (HR.hdf)
o Test File (Test.tdf)

• Before you can use a show file (*.sdf), it must be linked to the HR.hdf and the Test.tdf.  The Repair All 
Links File function provides the linkage.  

• Perform the function every time you create a new template or show file and every time you move files to 
a new computer or new folders on the same computer.

• See REPAIR ALL LINKS for procedures to link the files.

SECTION VIII. PROGRAM FUNCTIONS

1

4

9
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Fox Village Dressage > File Linking > Show File

FILE LINKING > SHOW FILE:
• File Linking > Show File performs a similar function to Repair All Links, but only for the Show File.
• It is mainly used for networking computers together so they can share the same files on a mapped drive.
• To link your FVD files, see REPAIR ALL LINKS. 

SECTION VIII. PROGRAM FUNCTIONS

1
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Fox Village Dressage > File Linking > Horse & Rider File

SECTION VIII. PROGRAM FUNCTIONS

FILE LINKING > HORSE & RIDER FILE:
• File Linking > Horse & Rider File performs a similar function to Repair All Links, but only for the Horse & 

Rider File.
• It is mainly used for networking computers together so they can share the same files on a mapped drive.
• To link your FVD files, see REPAIR ALL LINKS. 

1

4
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Fox Village Dressage > File Linking > Test File

SECTION VIII. PROGRAM FUNCTIONS

FILE LINKING > TEST FILE:
• File Linking > Test File performs a similar function to Repair All Links, but only for the Test File.
• It is mainly used for networking computers together so they can share the same files on a mapped drive.
• To link your FVD files, see REPAIR ALL LINKS. 

1

4
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Fox Village Dressage > File Linking > Linked Files

SECTION VIII. PROGRAM FUNCTIONS

FILE LINKING > LINKED FILES:
• File Linking > Linked Files is used to determine which files are currently linked.
• See Check the Links for the procedure.

1

4

13
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SECTION VIII. PROGRAM FUNCTIONS

❶ Utilities opens a ribbon with the following functions:
❷ Program File

❽ Compact
❸ Show Template File 

❾ Compact
❹ Show File 

❿ Compact
❺ Horse & Rider File

⓫ Compact
❻ Test File
⓬ Compact

❼ Backup / Restore
⓭ Instructions

1

2 3 4 5 6 7

8 9 10 11 12 13

NOTE:  See Utilities Ribbon for additional information. 
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Utilities > Program File, Show Template, Show File, Horse & Rider File, Test File > Compact

SECTION VIII. PROGRAM FUNCTIONS

PROGRAM FILE, SHOW TEMPLATE, SHOW FILE, HORSE & RIDER FILE, TEST FILE > COMPACT:
• As you delete old database information and add new information, the space within each of your FVD files 

can become fragmented.  The result is that, over time, your files can grow larger than needed to store 
your data and it takes the computer longer to use the file.

• Compact is used to compact (decrease the size of) each FVD file:
o ❷ Program File (FVD.accde).
o ❸ Show Template File (*.kdf).
o ❹ Show File (*.sdf).
o ❺ Horse & Rider File (HR.hdf)
o ❻ Test File (Test.tdf)

• To remove unused space, you should compact your FVD files periodically.
• We will use Program File > Compact as an example:
o Click ❷ Program File > ❽ Compact.
o FVD compacts the file.  While it is doing this, the Main Menu will disappear for a short time.  When 

compaction is completed, the Main Menu reappears.
• Repeat for your other FVD files.

1

2 3 4 5 6

8 9 10 11 12
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Utilities > Backup / Restore > Instructions

BACKUP / RESTORE > INSTRUCTIONS:
• It is always a good idea to backup important computer files, preferably on a different storage device than 

your computer hard drive.  This is also true for your FVD files.  You should FREQUENTLY backup your FVD 
files, particularly when entering entries, during the show, and after the show.  Also, backup your files at 
the end of each day of use.

• Previous versions of FVD had the utilities Backup and Restore.  These utilities have been retired.  
• You now use Windows Copy and Paste to backup and restore your FVD files.  When you do this, the file 

extensions do not change.
• See BACKUP FILES and RESTORE FILES for procedures.

• For users with previous Backup and Restore files, select ❼ Backup/Restore >⓭ Instructions on how 
to convert your files.

SECTION VIII. PROGRAM FUNCTIONS

BACK UP YOUR FILES 
DURING AND AFTER 

EVERY USE!

1
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13
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SECTION VIII. PROGRAM FUNCTIONS

❶ Help opens a ribbon with the following functions:
❷ Online Manuals

❻ Quick Start
❼ User Manual
❽ User Manual (DSHB)

❸ Support
❾ GoToAssist
❿ GoToMeeting

❹ License
⓫ Activate

❺ About
⓬ About Fox Village Dressage
⓭ Check for Updates

1

2 3 4 5

6

7

8 9 10 11

12

13

NOTE:  See Help Ribbon for additional information. 



Fox Village Dressage User Manual – 2021 Update 1.0.5. helpdesk@foxvillage.com                 www.foxvillage.com586

Help > Online Manuals > Quick Start 

ONLINE MANUALS > QUICK START: 
• Quick Start opens the Fox Village Dressage Quick Start Manual (*.pdf file). 
• The FVD Quick Start Manual will quickly get you up and running as a FVD user.

• Select ❶ Help > ❷ Online Manuals > ❻ Quick Start.
• The ❹ Fox Village Dressage Quick Start *.pdf file opens online. 
• The manual is designed to be used as an electronic file but may also be printed.
• Using your usual procedures for PDF files, Save and/or Print the file. 

SECTION VIII. PROGRAM FUNCTIONS
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Help > Online Manuals > User Manual

SECTION VIII. PROGRAM FUNCTIONS

ONLINE MANUALS > USER MANUAL: 
• User Manual opens the Fox Village Dressage User Manual (*.pdf file). 
• The user manual is a comprehensive guide to the FVD program. 

• Select ❶ Help > ❷ Online Manuals > ❼ User Manual.
• The ❹ Fox Village Dressage User Manual *.pdf file opens online. 
• The manual is designed to be used as an electronic file but may also be printed (almost 800 pages!).
• Using your usual procedures for PDF files, Save and/or Print the file. 

1
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Help > Online Manuals > User Manual (DSHB)

SECTION VIII. PROGRAM FUNCTIONS

ONLINE MANUALS > USER MANUAL (DSHB): 
• User Manual (DSHB) opens the FVD DSHB User Manual (*.pdf file). 
• This manual is a companion manual to the FVD User Manual that covers use of FVD for Dressage Sport 

Horse Breeding shows. 

• Select ❶ Help > ❷ Online Manuals > ❸ User Manual (DSHB).
• The ❹ Fox Village Dressage User Manual (DSHB) *.pdf file opens. 
• The manual is designed to be used as an electronic file but may also be printed (over 600 pages!).
• Using your usual procedures for PDF files, Save and/or Print the file. 
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Help > Support > GoToAssist

SECTION VIII. PROGRAM FUNCTIONS

• Select ❶ Help > ❸ Support > 
❾ GoToAssist.

• The ❹ GoToAssist web site 
opens with a logon screen.

• This is a future support system 
for FVD.

SUPPORT > GOTOASSIST: 
• GoToAssist opens a web page that asks for Your Name and Support Key that are supplied to you by the 

FVD software developers.  
• GoToAssist allows remote access to your computer so the FVD software developers can help resolve FVD 

problems you may be having.
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Help > Support > GoToMeeting

SECTION VIII. PROGRAM FUNCTIONS

• Select ❶ Help > ❸ Support > ❿
GoToMeeting.

• The ❹ GoToMeeting web site opens 
with a logon screen.

• Use the logon ID provided to you by FVD.

SUPPORT > GOTOMEETING: 
• GoToMeeting opens the GoToMeeting web site.  
• This is an online customer support method that FVD may use.

4

NOTE: GoToMeeting is an online meeting 
service that enables individuals and 
organizations to easily, securely and cost-
effectively collaborate, present information 
and demonstrate products online. This 
managed service is unique because of its 
innovative flat-fee All You Can Meet® pricing 
model that enables businesses to benefit more 
frequently from the value of online meetings. 
With GoToMeeting, organizations will 
increase productivity, decrease costs, expand 
reach and generate revenue opportunities.

1
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Help > License > Activate

SECTION VIII. PROGRAM FUNCTIONS

• Select ❶ Help > ❹ License > ⓫ Activate.

LICENSE > ACTIVATE: 
• Activate opens FVD Activation.  
• After you purchase FVD, via email, you will receive an Activation Key and a license file (license.dll).
• You use this function to:
o Purchase FVD
o Renew FVD
o Receive a new license
o Enter your Activation Key.  

• The ❹ Fox Village Dressage Activation 
form opens.

• With this form, you can:
o ❺ Purchase FVD.
o ❻ Renew FVD.
o ❼ Request a new license.
o Enter your ❽ Activation Key.  After you 

enter your Activation Key, click ❾
Activate to activate the program.
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Help > About > About Fox Village Dressage

SECTION VIII. PROGRAM FUNCTIONS

• The ❸ About Fox Village Dressage form 
opens.

• With this form, you can:
o View the FVD ❹ Copyright.
o View the ❺ FVD Contact Information.
o View your ❻ Your Contact Information.
o Open the ❼ End User License Agreement 

page on the FVD web site.
o Your ❽ FVD Version (you receive a prompt 

to upgrade when a new version is released).
• Click ❾ Close when you have finished viewing 

the information.

ABOUT > ABOUT FOX VILLAGE DRESSAGE: 
• About Fox Village Dressage opens the ❸ About Fox Village Dressage form.  
• Use this function to learn about FVD and about your FVD license.

1

5

13

12

Your Name

Your Address
Your Phone Number
Your Email Address
Your FVD Expiration Date

4
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5

7

3

8

9

• Select ❶ Help > ❺ About > ⓬ About Fox Village Dressage.
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SECTION VIII. PROGRAM FUNCTIONS
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Show Office > Show Information

• Select ❶Main Menu > ❷ Show Office 
> ❸ Show Information.

1

2

3

4

5

• The ❹ Show Information form opens.

• See Show Information for procedures to enter your show’s information.

• Click ❺ Close to close the form and return to the Main Menu.

SHOW INFORMATION: 
Show Information is used to enter information about your show.

SECTION VIII. PROGRAM FUNCTIONS
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Show Office > Show Preferences

SHOW PREFERENCES: 
Show Preferences is used to enter your preferences for managing your show.

• Select ❶Main Menu > ❷ Show Office 
> ❸ Show Preferences.

1

2

3

4

5

• The ❹ Show Preferences form opens.

• See Show Preferences for procedures.

• Click ❺ Close to close the form.

SECTION VIII. PROGRAM FUNCTIONS
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Show Office > Show Fees

SHOW FEES: 
Show Fees is used to enter the fees for your show.

• Select ❶Main Menu > ❷ Show Office 
> ❸ Show Fees.

1

2

3

4

5

• The ❹ Show Fees form opens.

• See Show Fees for procedures to enter your 
show’s fees.

• Click ❺ Close to close the form.

SECTION VIII. PROGRAM FUNCTIONS
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Show Office > Payment Types

PAYMENT TYPES: 
Payment Types is used to enter the types of payments you accept for your show (cash, credit card, checks, 
etc.).

• Select ❶Main Menu > ❷ Show Office 
> ❸ Payment Types.

1

2

3

4

5

• The ❹ Payment Type form opens.

• See Payment Types for procedures to enter your 
show’s payment types.

• Click ❺ Close to close the form.

SECTION VIII. PROGRAM FUNCTIONS
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Show Office > Credit Card Types

CREDIT CARD TYPES: 
Credit Card Types is used to enter the types of credit cards you accept for your show .

1

2

3

4

5

• Select ❶Main Menu > ❷ Show Office 
> ❸ Credit Card Types.

• The ❹ Credit Card Type form opens.

• See Credit Card Types for procedures to enter 
your show’s credit card types.

• Click ❺ Close to close the form.

SECTION VIII. PROGRAM FUNCTIONS
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Show Office > Stalls

STALLS:
Stalls is used to enter (barn and) stall numbers prior to assigning stalls to entries.

1

2

3

4

5

• Select ❶Main Menu > ❷ Show Office 
> ❸ Stalls.

• The ❹ Stalls form opens.

• See Stalls for procedures on entering your show’s 
stall information.

• Click ❺ Close to close the form.

SECTION VIII. PROGRAM FUNCTIONS
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Show Office > Stall Groups
STALL GROUPS: 
• Stall Groups is used to enter the names of Stall Groups in the program.  
• Stall Groups are used to identify multiple entries who want to be stabled together.  
• A Stall Group name is entered in the FVD program, then the name is selected for each entry in the group.   

• Select ❶Main Menu > ❷ Show Office 
> ❸ Stall Groups.

1

2

3

• The ❹ Stall Groups form opens.
• Enter the names of Stall Groups.  

• See Stall Groups for procedures.

• Click ❺ Close to close the form.

NOTE: Using information on the entry forms, you may need to develop Stall Group names.  For example, Mary 
may ask to be stabled with Nancy, and Nancy may ask to be stabled with John.  You need to make the 
association between Mary, Nancy, and John and develop one Stall Group name for their group.  The easiest 
way to do this is to use the name of the most prominent barn, the last name of the most prominent 
rider/trainer in the group, or put all the last names in the group.

SECTION VIII. PROGRAM FUNCTIONS

4

5
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Show Office > Classes

CLASSES: 
Classes is used to enter information about the dressage classes being offered at your show.

• Select ❶Main Menu > ❷ Show Office 
> ❸ Classes.

1

2

3

4

5

• The ❹ Class form opens.

• See Classes for procedures to enter your show’s class information.

• Click ❺ Close to close the form.

SECTION VIII. PROGRAM FUNCTIONS
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Show Office > Teams

TEAMS: 
Teams is used to (1) add team names and (2) place teams.

• Select ❶Main Menu > ❷ Show Office 
> ❸ Teams.

1

2

3

4

5

• The ❹ Team form opens.

• See Teams and MANAGING TEAMS for 
procedures.

• Click ❺ Close to close the form.

SECTION VIII. PROGRAM FUNCTIONS
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Show Office > Entries

ENTRIES: 
Entries is used to enter and edit your show’s entries.

• Select ❶Main Menu > ❷ Show Office 
> ❸ Entries.

• The ❹ Entry form opens.

• See DETAILS OF A FVD ENTRY for procedures to 
enter your show’s entries.

• Click ❺ Close to close the form.

SECTION VIII. PROGRAM FUNCTIONS

4

5

1

2

3
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Show Office > Horses
HORSES: 
• Horses is used to enter and edit information about horses (and their owners) in your show.
• You can enter horses information while creating an entry or you can first enter the horse (and people) 

information, then create the entry.

• Select ❶Main Menu > ❷ Show Office 
> ❸ Horses.

1

2

3

4

5

• The ❹ Horse / Owner form opens.

• See Horses for procedures to enter the 
information.

• Click ❺ Close to close the form.

SECTION VIII. PROGRAM FUNCTIONS
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Show Office > People
PEOPLE: 
People is used to enter and edit information about people (owners, riders, trainers, and coaches) in your 
show.

• Select ❶Main Menu > ❷ Show Office 
> ❸ People.

1

2

3

4

5

NOTE: When working on handwritten entries, you enter information on horses, owners, riders, trainers, and 
coaches.  A person can be a rider, owner, trainer and/or coach; for example, an owner can also be a rider and/or 
a trainer.  Therefore, the FVD program puts all people (and horse) information in one data file, the HR.hdf.  Each 
person is only entered ONE TIME;  their data is then applied to each applicable role on the entry form.  The 
People form is another way to enter information about all people, regardless of their status.

• The ❹ People (Rider / Owner /Trainer / Coach) form opens.

• See Horses > Owner, Rider, and Trainer and Coach for procedures.

• Click ❺ Close to close the form.

SECTION VIII. PROGRAM FUNCTIONS
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Show Office > Test Durations
TEST DURATIONS: 
• Test Durations is used to edit (change) the test durations built into the FVD program.
• Dressage tests have standard ride time durations, in minutes, from initial halt/salute to final halt/salute.  
• For show scheduling, additional administrative time is needed before and after each test for the rider to 

enter the ring and for the judge to complete the test sheet.  
• The FVD program has default FVD Test Durations (= ride time + administrative time) for each test that are 

optimized for USEF/USDF shows (see USEF/USDF/FEI TEST DURATIONS AND FVD TEST DURATIONS), that are 
used during scheduling.  

• During Scheduling, FVD uses the Test Durations to determine the ride times.
• The FVD program user can edit the FVD Test Durations if more or less time is desired.

1

2

3

• Select ❶Main Menu > ❷ Show Office 
> ❸ Test Durations.

• The ❹ Test Durations form opens.
• Using the ❺ slider, scroll through the list of tests 

until the test for which you want to edit the 
duration is visible.

• Highlight the ❻Minutes duration for the test.
• Edit the time by typing in a new number.

• Repeat for any other test you want to edit.

• Click ❼ Close.

SECTION VIII. PROGRAM FUNCTIONS

NOTE 1: In FVD, the test duration includes the time for the dressage test (ride time) and for judge admin time.  For 
example, the 2019 Training Level Test 3 should be ridden in 4min 30sec (small arena) or 5min 30sec (large arena).  
FVD uses 7min in scheduling so the rider has time to enter the ring and the judge has time to write remarks and sign 
the test sheet.
NOTE 2: If you are running a schooling show, you may want to provide plenty of time for the judge to talk to the 
riders.  For example, you may want to give 10 minutes for the test.  

4

5

6

7
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Show Office > Test Editor

• Select ❶Main Menu > ❷ Show Office 
> ❸ Test Editor.

SECTION VIII. PROGRAM FUNCTIONS

TEST EDITOR: 
• Test Editor is used to edit the dressage tests in the FVD program and to add new tests into FVD.  
• Test information is in the Test.tdf file.
• See DRESSAGE AND OTHER TESTS BUILT INTO FVD to see a list of the included tests.

1

2

3

NOTE: Edit tests with great care.  If you edit a standard test, it could inaccurately change the show results.

• The ❹ Test Editor form opens.
• See Test Editor for procedure.

4
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Show Office > Scheduling

• Select ❶Main Menu > ❷ Show Office 
> ❸ Scheduling.

1

2

3

• The ❹ Scheduling form opens.

SECTION VIII. PROGRAM FUNCTIONS

SCHEDULING: 
Scheduling is used to schedule the rides in your show.

4
5

• See SCHEDULING for information on using the Scheduling form and scheduling the show.
• Click ❺ Close to close the Scheduling form.
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Show Office > Income [and Invoice] > Purpose, Open, 1. Top Information

INCOME [AND INVOICE] > PURPOSE: 
• Income is used to enter income and create an invoice for a customer who is providing money (income) 

to the show that is not part of a show entry.
• The data entered in this invoice is how you enter a payment and create an invoice for a non-entry 

customer.  
• It does not link to an Entry #; therefore, it is not a method to enter/edit fees/payments for an entry.  For 

example, during the show a rider buys more bedding.  If you create the invoice using the function 
described on this page, the purchase is not reflected on the fees paid by the rider.  If you want the 
purchase to be reflected on the fees paid by the rider, the purchase must be entered under the Entry #
(see Stabling and Other Fees / Payments).  

• If instead a non-entry person rents a vendor booth, purchases a show program, makes a donation to the 
show, etc., you enter the payment (income) and create an invoice using the function described in this 
section.

• Select ❶Main Menu > ❷ Show Office 
> ❸ Income.

1. TOP INFORMATION:
• ❺ The FVD Program automatically enters the 

name of the show and the show address.
• ❻ Customer: Enter the name and address of the 

person/company to whom the invoice will be 
sent.  Type them as for an envelope.

• ❼ Invoice #: Enter an invoice number.  You can 
use up to ten letters and numbers.

• ❽ Date: The FVD program automatically enters 
today’s date.

• ❾Memo: If desired, enter a memo about the 
invoice.  You can use up to 50 letters and 
numbers.

SECTION VIII. PROGRAM FUNCTIONS

• The ❹ Income form opens, which has three 
sections to be completed:
1. Top information
2. Charges
3. Payments

3

2

1

Print Invoice/Statement
Delete Invoice

Add Invoice
Next Invoice

Look up an invoice
Previous Invoice

4

5

6

9

7
8

INCOME > 1. TOP INFORMATION:

INCOME [AND INVOICE] > OPEN:
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Show Office > Income [and Invoice] > 2. Charges

INCOME [AND INVOICE] > 2. CHARGES:

• ❶ Category: 
o To add a new category:
▪ Click the ❷ Edit Income Categories 

button.
▪ The ❸ Income Category form opens.
▪ To add a ❹ new category, type the name 

of the category in the box.  In this example, 
it is Vendor.

o To delete a category:
▪ Click on the ❺► to the left of the 

category name and click the ❻ Delete 
Income Category button.

o Click ❼ Close to save your changes and 
return to the Income form.

o Use the ❽ dropdown arrow to select the 
category of charges. 

• ❾ Amount: Enter the dollar amount of the 
charge.

• Repeat steps  10 – 16 for additional charges.

• ❿ Total Charges: FVD automatically calculates 
and enters the total of the charges.

SECTION VIII. PROGRAM FUNCTIONS

3

45

6 7

Print Invoice/Statement
Delete Invoice

Add Invoice
Next Invoice

Look up an invoice
Previous Invoice

1 2
8 9

10
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Show Office > Income [and Invoice) > 3. Payments, 4. Print

INCOME [AND INVOICE] > 3. PAYMENTS:

• ❶ Payment Type: Use the drop-down arrow to 
enter the type of payment (refund, cash, check, 
credit card, paid to USDF).

• ❷ Credit Card: If a credit card was used, use the 
drop-down arrow to enter the type of credit 
card.

• ❸ CC# / CK#: Enter the credit card number or 
the check number.

• ❹ Exp: If a credit card was used, enter the 
expiration date of the credit card.

• ❺ Amount: Enter the amount paid.

• Repeat for additional income.

• ❻ Total Payments: FVD will automatically enter 
the total of the payments.

• ❼ Balance Due: FVD will automatically enter 
the balance due.  If there is a credit, the amount 
will be in (parens).

INCOME [AND INVOICE] > 4. PRINT:

• Click ❽ Print Invoice/Statement to print the 
invoice.

• Click ❾ Close to return to the Main Menu.

SECTION VIII. PROGRAM FUNCTIONS

Print Invoice/Statement
Delete Invoice

Add Invoice
Next Invoice

Look up an invoice
Previous Invoice

1 2 3 4 5

6
7

8 9
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Show Office > Expenses [and Checks] > Purpose, Open, Top Information

• Select ❶Main Menu > ❷ Show Office 
> ❸ Expenses.

• The ❹ Expenses form opens.

1

2

3

SECTION VIII. PROGRAM FUNCTIONS

EXPENSES [AND CHECKS] > PURPOSE: Used to enter expenses and create checks.

NOTE:  Dressage shows cost money!  This function is how you track your show expenses and create checks.  
Even if you do not want to print a check, you should still enter the expenses if you use FVD to track your 
expenses.  For example, this is where you enter the cost of ribbons, trophies, bedding, use of the facility, 
insurance, monetary prizes, etc.

EXPENSES [AND CHECKS] > TOP INFORMATION:

• ❺ Check #: Enter the check number.
• ❻ Date: FVD automatically enters today’s date.
• ❼ Pay to the Order of: Enter the name of the 

person/company to whom/which the check is 
written.

• ❽ The amount is automatically entered by the 
FVD program after the amount is entered in the 
lower part of the form (see next page).

• ❾ Address, etc.: Enter the address, etc. of the 
person/company to whom/which the check is 
written.

• ❿Memo: Enter a short memo regarding the 
expense.

• ⓫ The FVD program automatically enters the 
name of the show secretary.

EXPENSES [AND CHECKS] > OPEN:

4

5

6

7 8

9

10 11
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Show Office > Expenses [and Checks] > Bottom Information

• The ❹ Expense Category form opens.
• To add a new category, type the ❺ name of the 

category in the box adjacent to the * (the * 
changes to a ►).

• To delete a category, click on the ► to the left of 
the category name and click the ❻ Delete 
Income Category button.

• Click ❼ Close to save your changes and return 
to the Expense form.

• Use the ❷ Category drop-down arrow to select 
the category.

• ❽ Amount: Enter the amount of the expense.

• Repeat to enter any additional expenses for this 
person/vendor/etc.

SECTION VIII. PROGRAM FUNCTIONS

• ❶ Category: 
o Use the ❷ dropdown arrow to select the 

category of expense. 
o If the category you want to use is not on the 

drop-down list, go to step ❸.
• Click the ❸ Edit Expense Categories button to 

add a new category to the list.

EXPENSES [AND CHECKS] > BOTTOM INFORMATION:

4

5

6 7

Print Current Check
Delete Expense

Add Expense
Next Expense

Look up an expense
Previous Expense

1
2

3
8



Fox Village Dressage User Manual – 2021 Update 1.0.5. helpdesk@foxvillage.com                 www.foxvillage.com614

Show Office > Expenses [and Checks] > Print Check

• The ❷ Check report opens.
• Using custom ordered checks (available from 

your bank or the internet), use ❸ Print to 
print the check.

• Click ❹ Close Preview to close the check.

SECTION VIII. PROGRAM FUNCTIONS

• Click ❺ Close.

2

3

4

1

5

EXPENSES [AND CHECKS] > PRINT CHECK:

• To print a check, click ❶ Print Current Check.
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Show Office > Expenses [and Checks] > Prize Batch > Purpose, Enter the Cash Prize Values

SECTION VIII. PROGRAM FUNCTIONS

• The Prize Batch feature lets you enter a batch of checks to print for prizes.  
• It is performed AFTER a class is finished.

1

2

3

4
5

6

7 8

9

• The ❻ Place / Rank Class form opens.
• ❼ Place the class.
• Type in the cash ❽ Prize for each ride receiving 

a cash prize.
• Click ❾ Close.

EXPENSES [AND CHECKS] > PRIZE BATCH > PURPOSE:

• Select ❶ Main Menu > ❷ Scoring.
• Using the ❸ Class (Lookup) drop-down 

arrow (or type-in box), select the class 
whose prize checks you want to enter.

• Click ❹ Place.
• Select the ❺ type of class.

EXPENSES [AND CHECKS] > PRIZE BATCH > ENTER THE CASH PRIZE VALUES:
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Show Office > Expenses [and Checks] > Prize Batch > Enter the Batch Information

SECTION VIII. PROGRAM FUNCTIONS

• The ❹ Expenses form opens.
• Click the ❺ Create Prize Batch button.

EXPENSES [AND CHECKS] > PRIZE BATCH > ENTER THE BATCH INFORMATION

4

5

6

7 9

• The ❻ Prize Money Check Batch form opens.
• Enter the ❼ Starting Check # for the batch of 

checks to be printed.  The feature assumes you 
will be using a consecutive sequence of check 
numbers, such as 1, 2, 3, 4, 5, etc.  The example 
will start with ❽ 1234.

• Click the ❾ Create Batch button.

Continued on next page…

8

• Select ❶Main Menu > ❷ Show Office 
> ❸ Expenses.

• The ❹ Expenses form opens.

1

2

3
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Show Office > Expenses [and Checks] > Prize Batch > Enter the Batch Information, Cont’d.

SECTION VIII. PROGRAM FUNCTIONS

• Using the ⓬ Expense (Lookup) drop-down 
arrow, you can see the ⓭ batch of expenses was 
added.

• Click one of the new expenses.  In this example, 
it is check number ⓮ 1234.

• The ⓯ Pay to the Order of box has been filled in 
with the owner’s name.

• The ⓰ owner’s contact information has been 
filled-in.

• The ⓱Memo box has been filled in with the 
class name and place.

• The ⓲ Prize Batch check box has been checked.

• A ❿ Fox Village Dressage form opens informing 
you the prize money check batch was created 
successfully.

• Click ⓫ OK.

Continued on next page…

10

11

Address

City ST ZipCode

12

15

16

17

13 14 Bedding Company

18 ✓



Fox Village Dressage User Manual – 2021 Update 1.0.5. helpdesk@foxvillage.com                 www.foxvillage.com618

Show Office > Expenses [and Checks] > Prize Batch > Print Prize Batch [Checks]

SECTION VIII. PROGRAM FUNCTIONS

• ❷ The user can now print the four checks.

• To print the batch of prize checks, click the ❶
Print Prize Batch button.

2

EXPENSES [AND CHECKS] > PRIZE BATCH > PRINT PRIZE BATCH [CHECKS]:

NOTES: 
• To print only the check being viewed, click the ❸ Print Current Check button.
• If you have many cash prizes from multiple classes, first enter all the cash prizes in the Place / Rank form (see 

Prize Batch > Enter the Cash Prize Values) for each applicable class, then print the batched checks.

1

Address

City ST ZipCode

3
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Show Office > Check List [= To Do List]

• Select ❶Main Menu > ❷ Show Office 
> ❸ Check List.

1

2

3

CHECK LIST [= TO DO LIST]: 
Check List is used to create a To Do List.

• The ❹ Check List form opens.

• ❺ Due Date: Enter the date the task must be 
completed (MM/DD/YYYY).

• ❻ Description: Enter a description of the task.  
It can be a simple title or a long message. 

• ❼ Finished:  When the task has been 
completed, click (check) the box.

• ❽ Add Item button: Click to add another task to 
the list.

• ❾ Delete Item button: Click to delete a task 
from the list.

• Click ❿ Close to save your changes and return 
to the Main Menu.

• With your cursor in the Description box, ⓫
Press shift + F2 to zoom on description.

• The ⓬ Zoom form opens in which you can view 
and edit your Description.

• Click ⓭ Font to change the font, font style, and 
size.

• Click ⓮ OK to save your changes and return to 
the ❹ Check List form.

• Click ❿ Close to save your changes and return 
to the Main Menu.

SECTION VIII. PROGRAM FUNCTIONS

NOTE:  Instead of the above, the check list can be used to track entries that are on a wait list but are not
entered in the FVD program.  In the ❺ Due Date column, enter the date the entry was received/requested.  
In the ❻ Description column, enter the class #, rider name, and email address.  If you have a pre-show 
scratch, refer to the list to fill the scratch.

6

8 9

5 7

4

10

11

12

13 14
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Show Office > Horses and Rider DB Management

• Select ❶Main Menu > ❷ Show Office 
> ❸ Horses and Rider DB Management.

• See HORSE & RIDER (HR.hdf) DATABASE 
MANAGEMENT for procedures.

1

2

3

HORSES AND RIDER DB MANAGEMENT: 
Horses & Rider DB Management is used to clean up your database.

SECTION VIII. PROGRAM FUNCTIONS
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Show Office > USDF Membership Verification > Purpose, USDF Information Tab

USDF MEMBERSHIP VERIFICATION > PURPOSE: 
• USDF Membership Verification is used to verify USDF people memberships and USDF horse registrations 

for all people and horses in the show current at the time you use this function.  
• Based on membership numbers entered into FVD, it uses the online membership data of USDF.

• In order to charge the correct fees and determine if an entry qualifies for a GAIG Q ride, championship 
rides, etc., you need USDF membership numbers and status for all people and horses in your show 
(except for entries only in exempt classes – see USDF Exceptions and USEF and USDF Exceptions 
Summary).  

• There are many methods to obtain this information, all of which can have a lag time from membership 
application/payment:
o Equestrian Entries: Information provided in EE show entry downloads.  Since this is downloaded a long 

time before the show, it may not be current by show date.
o USEF Affiliates Membership Verification Service (click here): You search by number, horse name, 

owner last name, organization name, and/or rider name to obtain USEF and USDF membership 
information.  This is the BEST method!

o Mailed Entry Packet: Paperwork sent to you with a mailed entry packet. Since this is mailed a long 
time before the show, it may not be current by show date.

o FVD USDF Membership Verification (this topic): This feature does not change or reset your 
membership confirmations.

USDF MEMBERSHIP VERIFICATION > USDF INFORMATION:
• If the USEF Affiliates Membership Verification Service does not have the information you need, USDF has 

other resources on their web site:
o Person > USDF Print Membership Card: Click here.
o Horse > USDF Print Horse Card (Certificate): Click here.

• If a person joined USDF or a horse was registered with USDF just before the show or during the show, 
USDF has specific guidelines on what can and cannot be accepted as proof of membership for people 
and horses.  See USDF Acceptable Proof of Membership for Shows (click here).  USDF does not accept a 
GMO membership card as proof of USDF GMO membership.

SECTION VIII. PROGRAM FUNCTIONS

http://www.eqverification.org/default.aspx
https://www.usdf.org/card/
https://www.usdf.org/card/horse.asp
https://www.usdf.org/docs/showflash/web/GeneralInfo/Before/AcceptableProofofMembership.pdf?t=4/7/2020%2012:21:33%20PM
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Show Office > USDF Membership Verification > Open, About Tab

• Select ❶Main Menu > ❷ Show Office 
> ❸ USDF Membership Verification.

1

2

3

SECTION VIII. PROGRAM FUNCTIONS

• The ❹ USDF Verification form opens.
• Click the ❺ About tab.
• Read the information.

5

4

USDF MEMBERSHIP VERIFICATION > OPEN:

USDF MEMBERSHIP VERIFICATION > ABOUT:

NOTE:  You can also use FVD USEF Information to pull 
USEF data for a specific person or horse if the entry has 
sufficient information to pull data from the USEF 
database.
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Show Office > USDF Membership Verification > USDF Verification Tab > 
Person Membership Verification

SECTION VIII. PROGRAM FUNCTIONS

• Click the ❶ USDF Verification tab.
• Click the ❷ Person Membership Verification button.

USDF MEMBERSHIP VERIFICATION > USDF VERIFICATION TAB > PERSON MEMBERSHIP VERIFICATION:

1

2• FVD obtains the data online.
• A ❸ FVD message lets you know the verification was 

completed successfully.
• Click the ❹ OK button.

3

4

• The ❺ USDF Person 
Membership Verification 
report for the show opens.

• The report includes:
o ❻ Date and time the 

report was created.
o ❼ Person name 

(alphabetical by last name).
o ❽ USDF #
o ❾ Exp. Date
o ❿ Verified
o ⓫Membership Type

• The list has two parts:
o People with ⓬ Verified 

Memberships.
o People with ⓭ Non-

verified Memberships –
people whose membership 
was not verified so they 
may not be current USDF 
members.  Ensure you 
collect their USDF non-
member fee.

NOTE: If you check  Update USDF Cards Verified, 
all the USDF people memberships will be updated in 
your HR.hdf file, thereby overwriting any updates 
you have added.  Do this with caution!
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Show Office > USDF Membership Verification > USDF Verification Tab > 
Horse Membership Verification

SECTION VIII. PROGRAM FUNCTIONS

• Click the ❶ USDF Verification tab.
• Click the ❷ Horse Membership Verification button.
• A ❸ FVD message opens informing you that the 

verification process was successfully completed.
• Click ❹ OK.

USDF MEMBERSHIP VERIFICATION > USDF VERIFICATION TAB > HORSE MEMBERSHIP VERIFICATION:
1

2

• FVD obtains the data online 
then opens the ❺ USDF Horse 
Membership Verification 
report.

• The report includes:
o ❻ Date and time the report 

was created.
o ❼ Horse / Owner names
o ❽ USDF # for horse and 

owner
o ❾ Exp. Date for horse and 

owner
o ❿ Verified
o ⓫Membership Type

• The list has two parts:
o People with ⓬ Verified 

Memberships.
o People with ⓭ Non-verified 

Memberships.  These horses 
must get at least a USDF HID 
to participate in the show.

3

4

NOTE: If you check  Update USDF Cards 
Verified, all the USDF people memberships 
will be updated in your HR.hdf file, thereby 
overwriting any updates you have added.  
Do this with caution!
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Show Office > USDF Membership Verification > USDF Verification Tab > 
Qualifiers w/o Documentation

SECTION VIII. PROGRAM FUNCTIONS

• This report provides a list of entries for which a GAIG Q ride 
was requested but are missing one or more requirements 
to do a GAIG Q ride.

• Click the ❶ USDF Verification tab.
• Click the ❷ Qualifiers w/o Documentation button.

USDF MEMBERSHIP VERIFICATION > USDF VERIFICATION TAB > QUALIFIERS W/O DOCUMENTATION:

1

2

• FVD obtains the data online 
then opens the ❸ USDF 
Qualifiers w/o 
Documentation report.

• The report includes:
o ❹ Entry #
o ❺ Horse info
o ❻ Owner info
o ❼ Rider info
o ❽ Telephone

• If a box is checked (), you 
have the information.

• If a box is not checked (), 
you do NOT have the 
information.

• You can use this report to 
notify entry participants that 
are missing information.

NOTE: If you check  Update USDF Cards Verified, 
all the USDF people memberships will be updated in 
your HR.hdf file, thereby overwriting any updates 
you have added.  Do this with caution!
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Show Office > USEF Membership & SafeSport Verification > 
Purpose, USEF Information

USEF MEMBERSHIP & SAFESPORT VERIFICATION > PURPOSE: 
• USEF Membership & SafeSport Verification is used to verify USEF people memberships and horse 

recordings.  
• Based on membership numbers entered into FVD, it uses the online membership data of USEF to check 

the current membership status of all the horses and people in the show.

• In order to charge the correct fees and determine if an entry qualifies for a GAIG Q ride, championship 
rides, etc., you need USEF and USDF membership numbers and status for all people and horses in your 
show (except for entries only in exempt classes – see USEF and USDF Exceptions Summary).  

• There are many methods to obtain the membership information, all of which can have a lag time from 
membership application/payment:
o Equestrian Entries: Information provided in EE show entry downloads.  Since this is downloadeda long 

time before the show, it may not be current by show date.
o USEF Affiliates Membership Verification Service (click here): You search by number, horse name, 

owner last name, organization name, and/or rider name to obtain USEF and USDF membership 
information.  This is the BEST method!

o USEF Information (click here).  A form opens showing you the person’s personal, USEF and USDF 
information.

o Mailed Entry Packet: Paperwork sent to you with a mailed entry packet. Since this is mailed a long 
time before the show, it may not be current by show date.

o FVD Membership Verification (this topic): Using data in the current show, search by individual or farm 
numbers or by horse numbers.  This feature does not change or reset your membership confirmations.

USEF MEMBERSHIP & SAFESPORT VERIFICATION > USEF INFORMATION:
• If the USEF Affiliates Membership Verification Service does not have the information you need, USDF has 

other resources on their web site:
o People Search: Click here.
o Horse Search: Click here.

• If a person joined USEF or a horse was recorded with USEF just before the show or during the show, the 
person will have received an email from USEF verifying the payment.  This can be used as proof of 
verification.

SECTION VIII. PROGRAM FUNCTIONS

http://www.eqverification.org/default.aspx
https://www.usef.org/search/people
https://www.usef.org/search/horses
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Show Office > USEF Membership & SafeSport Verification > 
Open, About

1

2

3

SECTION VIII. PROGRAM FUNCTIONS

• The ❹ USEF Verification form opens.
• Click the ❺ About tab.
• Read the information.

5

4

• Select ❶Main Menu > ❷ Show Office 
> ❸ USDF Membership & SafeSport 
Verification.

USEF MEMBERSHIP & SAFESPORT VERIFICATION > OPEN:

USEF MEMBERSHIP & SAFESPORT VERIFICATION > ABOUT:

5
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Show Office > USEF Membership & SafeSport Verification > USEF 
Verification Tab > Individual/Organization Membership Verification

SECTION VIII. PROGRAM FUNCTIONS

• Click the ❶ USEF Verification tab.
• Click the ❷ Individual/Organization Membership Verification 

button.

USDF MEMBERSHIP VERIFICATION > INDIVIDUAL/ORGANIZATION MEMBERSHIP VERIFICATION:

1 2

• FVD obtains the data online 
then opens the ❸ USEF 
Membership Verification –
Individual & Organization 
report.

• The report includes:
o ❹ Date report was 

created.
o ❺ USEF #.
o ❻ Name
o ❼ Org Name (USEF)
o ❽Membership Type
o ❾ DOB
o ❿ USEF Age
o ⓫ Amateur/Pro (Rider 

Status)
o ⓬ (Membership) Start 

Date
o ⓭ US Citizen ( = USA 

citizen)
o ⓮ (Membership) End 

Date
o ⓯ Suspension Status 

(YES/NO)
o ⓰ (USEF Membership) 

Status

• The list has three parts:
o ⓱ Farm.
o ⓲ Individual.
o ⓳ Organization
o ⓴Membership Number 

Not In USEF’s Database

NOTE: An organization is any entity that is 
part of an entry but is not an individual person 
nor a farm.  This report lists Farms, 
Individuals, and Organizations.

PERSON’S NAME#######

3
4

#######

#######

#######

#######

#######

#######

#######

#######

#######

#######

#######

#######

#######

#######

#######

LAST NAME, FIRST NAME

RIDER LAST, RIDER FIRST

LAST NAME, FIRST NAME

LAST NAME, FIRST NAME

LAST NAME, FIRST NAME

LAST NAME, FIRST NAME

LAST NAME, FIRST NAME

LAST NAME, FIRST NAME

LAST NAME, FIRST NAME

LAST NAME, FIRST NAME

LAST NAME, FIRST NAME

LAST NAME, FIRST NAME

LAST NAME, FIRST NAME

LAST NAME, FIRST NAME

LAST NAME, FIRST NAME

LAST NAME, FIRST NAME

LAST NAME, FIRST NAME

5 6 7 8 9 10 11 12 13 14 15 16

17

18

19

20
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Show Office > USEF Membership & SafeSport Verification > 
USEF Verification Tab > Horse Membership Verification

SECTION VIII. PROGRAM FUNCTIONS

• Click the ❶ USEF Verification tab.
• Click the ❷ Horse Membership Verification button.

USDF MEMBERSHIP VERIFICATION > HORSE MEMBERSHIP VERIFICATION:

1

2

• FVD obtains the data online 
then opens the ❸ USEF 
Membership Verification –
Horse report.

• The report includes:
o ❹ Date and time report 

was generated.
o ❺ (Horse) USEF #
o ❻ (Horse) Name
o ❼ Org Name (USEF)
o ❽ Foal Date
o ❾ Age Verified ( = 

verified)
o ❿ Country of Origin
o ⓫ (Recording) Start Date
o ⓬ (Recording) End Date 

(Annual)
o ⓭ (Recording) Status

XXXX Blue Horse Dressage
USEF Membership Verification - Horse3

4

5 6 7 8 9 10 11 12 13
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Show Office > USEF Membership & SafeSport Verification > 
USEF Verification > SafeSport Training

SECTION VIII. PROGRAM FUNCTIONS

• Used to verify the status of SafeSport training.

• Click the ❶ USEF Verification tab.
• Click the ❷ SafeSport Training button.

USDF MEMBERSHIP VERIFICATION > SAFESPORT TRAINING: 1

2

• FVD obtains the data online 
then opens the ❸ USEF 
SafeSport Training –
Individual & Organization 
report.

• The report includes:
o ❹ Date and time report 

was generated.
o ❺ USEF #
o ❻ (Person) Name
o ❼ Expires (Date)
o ❽ Suspension Status 

(YES = suspended)
o ❾ Details

• The list has three parts:
o ❿ Individuals
o ⓫ Farm
o ⓬ Organization
o ⓭Membership 

Numbers Not In USEF’s 
Database
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3
4

5 6 7 8 9
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Show Office > Export Utility [to MS Excel] > Purpose, Open, Select Table to Export

EXPORT UTILITY [TO MS EXCEL] > OPEN: 
• Select ❶Main Menu > ❷ Show Office 

>              ❸ Export Utility.

1

2

3

• In this example will use ❻ Class.
• Click❼ OK.

SECTION VIII. PROGRAM FUNCTIONS

EXPORT UTILITY [TO MS EXCEL] > PURPOSE: 
• Export Utility [to MS Excel] is used to export FVD data to a MS Excel spreadsheet file.  
• Once the data is in a MS Excel file, you can use it to create form letters, custom labels, stall lists, etc.

6

7

• The ❹ Export Utility form opens.
• Use the ❺ Table drop-down arrow to 

select a table to export:
o Class
o Entry
o Entry Fees
o Horse
o Ride
o People
o USDF Champ Verify by Entry
o USDF Champ Verify by Class

Continued on next page…

4

5

5

EXPORT UTILITY [TO MS EXCEL] > SELECT TABLE TO EXPORT: 
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Show Office > Export Utility [to MS Excel] > Name and Save the File, Open the File

• The ❶ New MS Excel File window opens.
• By default, the ❷ FVD folder opens.   
• Create/Navigate to a new folder if you want to save the file to a different folder. 
• In the ❸ File Name box, type a name for your file.  It is recommended that you use a file name that 

includes the year, the name of the show, and the type of table.  In this example, the file name is YYYY-
BHD-Class.xls.

• Click ❹ Save.

• A ❺ Fox Village Dressage information form 
opens letting you know the table was exported 
successfully.

• Click ❻ OK.

• Navigate to the ❼ FVD folder that contains the 
❽ Excel file you just created (YYYY-BHD-Class).

• Double click the file name to open the file.

SECTION VIII. PROGRAM FUNCTIONS

EXPORT UTILITY [TO MS EXCEL] > NAME AND SAVE THE FILE:

5

6

EXPORT UTILITY [TO MS EXCEL] > OPEN THE FILE:

1

2

3

43

7

8
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Show Office > Export Utility [to MS Excel] > View the File

• The MS Excel File opens.

SECTION VIII. PROGRAM FUNCTIONS

• Follow the same procedure to create MS Excel files containing information about:
o Class
o Entry
o Entry Fees
o Horse
o Ride
o People
o USDF Champ Verify by Entry
o USDF Champ Verify by Class

• The following page lists the fields exported for each of the possible selections.
• You can use the information in these files to create custom labels, make a stall list, provide information 

for the show program, etc.

EXPORT UTILITY [TO MS EXCEL] > VIEW THE FILE:
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Show Office > Export Utility [to MS Excel] > Fields in Each Export Table

SECTION VIII. PROGRAM FUNCTIONS

Entry.xls
• Entry 
• Horse 
• Horse For Sale 
• Owner First Name 
• Owner Last Name 
• Need Owner Signature 
• Rider First Name 
• Rider Last Name 
• Need Rider Signature 
• Trainer First Name 
• Trainer Last Name 
• Need Trainer Signature 
• Coach First Name 
• Coach Last Name 
• Need Coach Signature 
• Need Parent Signature 
• Confirmation Mailed 
• Post Marked 
• Stall Group 
• Stall Previous Sunday 
• Stall Previous Monday 
• Stall Tuesday 
• Stall Wednesday 
• Stall Thursday 
• Stall Friday 
• Stall Saturday 
• Stall Sunday 
• Stall Monday 
• Stable Comments 
• Entry Memo 

Class.xls
• Class 
• Name 
• Display Form 
• Date 
• Ring 
• Fee 
• Qualifying Fee 
• Prize 
• Sponsor 
• Start Time 
• End Time 
• Breaks 
• Rides 
• Closed 
• Test 
• Judge E 
• Judge H 
• Judge C 
• Judge M 
• Judge B 

EntryFees.xls
• Entry 
• Horse 
• Rider First Name 
• Rider Last Name 
• Description 
• Rate 
• Quantity 
• Total 
• Stall 

Horse.xls
• Name 
• Breed 
• Height 
• Color 
• Sex 
• Sire 
• Dam 
• Dams Sire 
• Birth Country 
• Birth Year 
• Breeder 
• Coggins 
• Coggins Expiration Date 
• Vaccines 
• Vaccines Expiration Date 
• Passport 
• USEF 
• USEF Expiration 
• USEF Verified 
• USDF 
• USDF Expiration 
• USDF Verified 
• Other 
• Other Expiration 
• Other Verified 
• Last Show 
• Notes 
• Owner First Name 
• Owner Last Name 

The following information (columns) is included in the named exported Excel files:
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Show Office > Export Utility [to MS Excel] > Fields in Each Export Table, Cont’d.

The following information (columns) is included in the named exported Excel files:

SECTION VIII. PROGRAM FUNCTIONS

Ride.xls
• Entry 
• Rider First Name 
• Rider Last Name 
• Horse Name 
• Force Order 
• Class 
• Test 
• Time 
• Qual/Div
• Term Reason 
• Subbed Out 
• Rank E 
• Rank H 
• Rank C 
• Rank M 
• Rank B 
• Place 
• Prize 
• Conflict 
• Elapse 
• Free Style 
• Verify 

People.xls
• First Name 
• Last Name 
• Address 
• City 
• State 
• Zip Code 
• Country 
• Telephone 
• E-mail 
• Citizenship 
• TIN 
• [Rider] Status 
• DOB 
• USEF 
• USEF Expiration 
• USEF Verified 
• USDF 
• USDF Expiration 
• USDF Verified 
• Other 
• Other Expiration 
• Other Verified 
• Volunteer 
• Last Show 
• Notes 

USDF_ChampVerifyByEntry.xls
• lngEntryID
• Horse 
• Horse USEF 
• Horse USDF 
• Owner Last Name 
• Owner First Name 
• Owner USEF 
• Owner USDF 
• Rider Last Name 
• Rider First Name 
• Rider USEF 
• Rider USDF 
• Rider Status 
• Q1 
• Q2 
• Level 
• Verified 

USEF_ChampVerifyByEntry.xls
• Class Number 
• Class Name 
• lngEntryID
• Horse 
• Horse USEF 
• Horse USDF 
• Owner Last Name 
• Owner First Name 
• Owner USEF 
• Owner USDF 
• Rider Last Name 
• Rider First Name 
• Rider USEF 
• Rider USDF 
• Rider Status 
• Q1 
• Q2 
• Level 
• Verified 
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Show Office > Emails to Clipboard > Purpose, Open, Select 

SECTION VIII. PROGRAM FUNCTIONS

• Select ❶Main Menu > ❷ Show Office 
> ❸ Rider Emails to Clipboard.

• The ❹ E-mails to Clipboard form opens.
• You have the following options (❺ E-mail Filter) 

(you may only click one radial button at a time):
o ❻ Riders in Show:  Copies the email 

addresses of all the riders in your show to the 
clipboard.

o ❼ Owners in Show: Copies the email 
addresses of all the owners in your show to 
the clipboard.

o ❽ Trainers in Show: Copies the email 
addresses of all the trainers in your show to 
the clipboard.

o ❾ Coaches in Show: Copies the email 
addresses of all the coaches in your show to 
the clipboard.

o ❿ All People in Show: Copies the email 
addresses of all the riders, owners, trainers, 
and coaches in your show to the clipboard.

o ⓫ All People in HR Database: Copies the 
email addresses of all the people in your HR 
database to the clipboard.  Lets you enter a 
⓬ Last Show Date, which limits the people to 
those who showed since the date you enter.

• Make your selection then click ⓭ OK.

EMAILS TO CLIPBOARD > PURPOSE: 
• Emails to Clipboard is used to copy the email addresses of people to your Windows clipboard.  
• Using your default email program, you can then paste the clipboard contents into the To… box (or BCC:

box) and thereby send an email to people in your show.  
• You can select which group(s) of people to include.

1

2

3

EMAILS TO CLIPBOARD > OPEN: 

EMAILS TO CLIPBOARD > SELECT: 

4

5

6
7
8

9
10

11

12

13
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Show Office > Emails to Clipboard > Verification, Send Email

SECTION VIII. PROGRAM FUNCTIONS

• To send an email the selected people, ❸ open your default email program in the usual manner.
• Put your email address in the ❹ To: box.
• Paste the contents of your clipboard (the people email addresses) into the ❺ BCC… box.  This is 

important as it hides the email addresses from all the recipients, thereby keeping email addresses 
private.

• Enter a ❻ subject that will clearly indicate the email is related to the show.  
• ❼ Compose your email in the usual manner, add any attachment(s) you may want to email, and ❽

send.
• This is a handy method to send a message to all the selected people, with attachments such as the 

Rider’s Schedule Report, etc.
• See USE EMAIL ADDRESSES for more information on emails.

• A ❶ Fox Village Dressage information form 
opens, indicating the email addresses have been 
copied to the clipboard.

• Click ❷ OK.

1

2

EMAILS TO CLIPBOARD > VERIFICATION: 

EMAILS TO CLIPBOARD > SEND EMAIL: 

RiderEmail@email.com4 5

7

3

Suzy Secretary
2020 Blue Horse Dressage
SuzySecretary@email.com

YYYY Blue Horse Dressage – Message from the Show Secretary6

NOTE:  Remember to paste show 
participant emails to Bcc, not To.  
In this way you avoid broadcasting 
all the emails to everyone.
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NOTE: Scoring is explained in SCORING.  This chapter explains additional FVD scoring tools.

SECTION VIII. PROGRAM FUNCTIONS



Fox Village Dressage User Manual – 2021 Update 1.0.5. helpdesk@foxvillage.com                 www.foxvillage.com639

Scoring > Multi-Judge Sheets > Purpose, Enter All Judge Points and Errors

SECTION VIII. PROGRAM FUNCTIONS

MULTI-JUDGE SHEETS > PURPOSE: 
• Multi-Judge Sheets is used with Standard Scoring when a class has more than one judge.
• After the movement and collective POINTS are entered for all judges for the class, the Multi-Judge Sheet 

displays all the POINTS on one sheet of paper.

MULTI-JUDGE SHEETS > ENTER ALL JUDGE POINTS AND ERRORS: 
• Ensure you are using ❶ (Standard) Scoring.  See Set Up Standard Scoring for procedure.
• Select ❷Main Menu > ❸ Scoring.
• Using the ❹ Class (Lookup) drop-down arrow, select the class you want to score.
• Click the ❺ C radial button to enter POINTS and ERRORS from the judge at C.
• Click the ❻ B (or other judge position) radial button to enter POINTS and ERRORS from the judge at B 

(or other judge position) .
• After the POINTS and ERRORS have been entered for all judges for the class, click the ❼Multi-Judge 

Sheet button.

1

2

3

54
7

6
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SECTION VIII. PROGRAM FUNCTIONS

640

Scoring > Multi-Judge Sheets > View Multi-Judge Sheet Report

• The ❶ Scoring Multi-Judge 
Sheet report opens.

• The sheet displays:
o ❷ TOTAL POINTS from 

each judge.
o ❸ ERRORS for each judge.
o ❹ SUBTOTAL POINTS for 

each judge.
o ❺ FINAL PERCENT for 

each judge.
o ❻MEAN FINAL POINTS 

for the ride.
o ❼MEAN FINAL PERCENT 

for the ride.
• Click ❽ Refresh if the scores 

were changed in the scoring 
form.

• Click ❾ Print to print the 
report.

• If all the POINTS AND ERRORS
have been entered for other 
rides:
o Click ❿ Previous Rider or 
⓫ Next Rider to view the 
sheet of the next rider.

o Alternately, click the ⓬
Entry (Lookup) drop-down 
arrow to select a different 
entry #.

• Click ⓭ Close when you are 
finished.

VIEW MULTI-JUDGE SHEET REPORT: 

1

2

3

4

5

7

89

2

3

4

5

6

10 1112 13
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Scoring > Special Score Reports > Purpose, Open

SECTION VIII. PROGRAM FUNCTIONS

SPECIAL SCORE REPORTS > PURPOSE:  Special Score Reports is used to provide results reports for special 
situations.

SPECIAL SCORE REPORTS > OPEN:  
• Select ❶ Main Menu > ❷ Scoring. 
• Using the ❸ Class (Lookup) drop-down 

or type-in box, select the class for which 
you desire a report.

• Click the ❹ Special Score Reports 
button.

5

6 7 8 9
• The ❺ Special Score Reports form opens.
• There are special reports for:
o ❻ Awards
o ❼ Breed
o ❽ Combined
o ❾ Team

• Each of these will be discussed in the next pages.

1

2

3 4
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Scoring > Special Score Reports > Awards Tab > Purpose, Open

SECTION VIII. PROGRAM FUNCTIONS

SPECIAL SCORE REPORTS > AWARDS TAB > OPEN:

• The ❺ Special Score Reports form opens.
• Select the ❻ Awards tab.
• Using the ❼ Class (Lookup) drop-down arrow or 

type-in box, select the class for which a Special 
Awards Report is desired.

• Click the ❽ Awards Report button.

• The ❾ Awards report 
opens.

• It includes:
o ❿ Place
o ⓫ Entry #
o ⓬ Rider Name
o ⓭ Horse Name

• Click ⓮ Print to print 
the report.

• Click ⓯ Close Print 
Preview to close the 
report.

SPECIAL SCORE REPORTS > AWARDS TAB > PURPOSE: 
• The Awards tab provides Special Score Reports to display awards (placing) for each selected class in the 

show.

5

6

7 8

1

2

3

• Select ❶ Main Menu > ❷ Scoring. 
• Using the ❸ Class (Lookup) drop-down or type-

in box, select the class for which you desire a 
report.

• Click the ❹ Special Score Reports button.

4

NOTE: This report does not
include Rider Status (AA, 
JYR, Open) and does not sort 
by Rider Status.  It simply 
sorts by place.

9

14

15

10 11 12 13
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Scoring > Special Score Reports > Breed Tab > Purpose, Open

SECTION VIII. PROGRAM FUNCTIONS

SPECIAL SCORE REPORTS > BREED TAB > OPEN: 

• The ❺ Special Score Reports form opens.
• Click the ❻ Breed tab.
• See the separate FVD Dressage Sport Horse 

Breeding User Manual (click here).

5

6

SPECIAL SCORE REPORTS > BREED TAB > PURPOSE: 
• The Breed tab provides Special Score Reports for breed shows.

1

2

3

• Select ❶ Main Menu > ❷ Scoring. 
• Using the ❸ Class (Lookup) drop-down or type-

in box, select the class for which you desire a 
report.

• Click the ❹ Special Score Reports button.
4

http://www.foxvillage.com/FVDUserManualDSHB.asp
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Scoring > Special Score Reports > Combined Tab > Purpose, Open & Select Classes

SPECIAL SCORE REPORTS > COMBINED TAB > PURPOSE: 
• The Combined tab provides a Special Score Report for shows that combine the results of two (or three) 

classes for each rider/horse pair to determine the final scores and final placings.
• The same Horse/Rider pairs must be in the two (or three) classes.

SECTION VIII. PROGRAM FUNCTIONS

SPECIAL SCORE REPORTS > COMBINED TAB > OPEN & SELECT CLASSES:

• The ❺ Special Score Reports form opens.
• Select the ❻ Combined tab.
• Using the drop-down arrows or type-in boxes, 

enter the two or three classes for which you want 
the scores combined.

6

5

1

2

3

• Select ❶ Main Menu > ❷ Scoring. 
• Using the ❸ Class (Lookup) drop-down or type-

in box, select the first class of the combination for 
which you desire a report.

• Click the ❹ Special Score Reports button.

Continued on next page…
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Scoring > Special Score Reports > Combined Tab > Calculation Methods

• The results can be calculated two ways:
1. Total Final Points: 
▪ For this method, DO NOT check the ❶ Average Percent Scores checkbox ().
▪ The calculation is the sum of the FINAL POINTS for the 2 (or 3) classes divided by the sum of the  MAXIMUM 

POINTS for the 2 (or 3) classes.  
▪ For example, a rider had FINAL POINTS of 173.5 and 248.0 (sum = 421.5) in classes with maximum scores of 

300 and 360 (sum = 660).  The Combined Final Percent for this rider is (421.5/660) x 100 = 65.859%.  
2. Average Percent Scores (Average Final Percent):  
▪ For this method, CHECK the ❷ Average Percent Scores checkbox ().
▪ The calculation is the average of the 2 (or 3) FINAL PERCENTS for each rider.  
▪ For example, a rider had 59.828% and 70.857%.  The Combined Final Percent for this rider is the average of 

the FINAL PERCENTS: (59.828% + 70.857%) / 2 = 65.342%.

SECTION VIII. PROGRAM FUNCTIONS

SPECIAL SCORE REPORTS > COMBINED TAB > CALCULATION METHODS:

1 2

2

1

NOTE: The final placings 
are entered by hand.



Fox Village Dressage User Manual – 2021 Update 1.0.5. helpdesk@foxvillage.com                 www.foxvillage.com646

Scoring > Special Score Reports > Team Tab > Purpose, Open

SECTION VIII. PROGRAM FUNCTIONS

SPECIAL SCORE REPORTS > TEAM TAB > PURPOSE: 
• Team Tab is used to determine team FINAL POINTS and FINAL PERCENTS and to place teams.
• Some dressage shows have teams, which are usually 3-4 rider/horse pairs whose scores are tallied to 

determine team placings.  
• Teams are entered into the FVD program during the Entry phase.  See Teams for procedures.
• The scores for each individual in a team are entered in the usual manner (see SCORING).
• Placing of the teams is then performed.

SPECIAL SCORE REPORTS > TEAM TAB > OPEN:

NOTE: For details on managing teams, see MANAGING TEAMS.

1

2

3

• Select ❶ Main Menu > ❷ Scoring. 
• Using the ❸ Class (Lookup) drop-down or type-

in box, select the first class of the combination for 
which you desire a report.

• Click the ❹ Special Score Reports button.
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Scoring > Special Score Reports > Team Tab > Team Report

• The ❶ Team Score report opens.
• In the report, the rides are grouped by ❷ Team, then by ❸ FINAL PERCENT (high to low for each ride) 

within each team.
• Each team’s ❹ FINAL POINTS and ❺ FINAL PERCENT are listed.  
• On this report the teams are NOT ordered by place – that is done with Special Score Reports > Team > 

Place Team (see next page).  Look at the team FINAL PERCENTS to determine the highest team 
percentage (1st place), next highest percentage (2nd place), etc.  In this example, Team B is 1st and Team A 
is 2nd.  Make a note of the placings or write them on your report print-out.

• If desired, click ❻ Print to print the report.
• Click ❼ Close Print Preview to close the report.

SECTION VIII. PROGRAM FUNCTIONS

1

2

3

4 5

6

7

2

3

• The ❹ Special Score Reports form opens.
• Select the ❺ Team tab.
• Select the ❻ Team Report button.

4

5

6

SPECIAL SCORE REPORTS > TEAM TAB > TEAM REPORT:

NOTE: For details on managing teams, see MANAGING TEAMS.
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Scoring > Special Score Reports > Team Tab > Place Team

• The ❹ Team form opens.
• Using the ❺ Team (Lookup) drop-down arrow 

or type-in box, select the ❻ first team to be 
placed.

• Using the team placings determined on the 
previous page, enter the ❼ Place for each team.

• When you are finished, click ❽ Close to save 
your changes, which returns you to the ❶
Special Score Reports form.

• On the ❶ Special Score Reports form, click ❾
Close to close the report and return to the Main 
Menu > Scoring.

SECTION VIII. PROGRAM FUNCTIONS

SPECIAL SCORE REPORTS > TEAM TAB > PLACE TEAM:

4

5

6
7

8

NOTE: There is no final report with team placings.  Use the 
Team Score Report with handwritten placings.

• You are returned to the ❶ Special Score 
Reports form.

• Select the ❷ Team tab.
• Select the ❸ Place Team button.

1

2

3

9

NOTE: For details on managing teams, see MANAGING TEAMS.
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Scoring > Score Prep, Live Display

SECTION VIII. PROGRAM FUNCTIONS

LIVE DISPLAY:

1

2

3

4

• Live Display is a dashboard for connecting and 
sending scores to an electronic scoreboard.

• It is a FVD license-activated feature.
• If you wish to use this FVD feature, contact FVD 

via email at helpdesk@foxvillage.com.
• Select ❶ Main Menu > ❷ Scoring. 
• Using the ❸ Class (Lookup) drop-down or type-

in box, select the first class of the combination 
for which you desire a report.

• Click the ❺ Live Display button.
• The ❻ Live Display form opens.

5

SCORE PREP:

• Score Prep is used with Paperless Dressage Scoring.  Click here for information on the FVD web site.
• Select ❶ Main Menu > ❷ Scoring 
• Using the ❸ Class (Lookup) drop-down or type-in box, select the first class of the combination for 

which you desire a report.
• See the ❹ Score Prep button.  Do not click the button unless you are using Paperless Dressage Scoring.

6

mailto:helpdesk@foxvillage.com
https://www.foxvillage.com/post?id=22
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SECTION VIII. PROGRAM FUNCTIONS
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Reports - Pre-Show > Class List

• Select  ❶Main Menu > ❷ Reports > 
❸ Pre-Show > ❹ Class List Report.

• The ❺ Class List report
opens.

• The list contains: 
o ❻ Class #
o ❼ Class Name
o ❽ Day of the class

SECTION VIII. PROGRAM FUNCTIONS

CLASS LIST: 
The Class List report is used to create a list of all the classes in the show.

6 7 8

5
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Reports - Pre-Show > Class Key Report 

• Select  ❶Main Menu > ❷ Reports > 
❸ Pre-Show > ❹ Class Key Report.

• The ❺ Class Key Report 
opens.

• The list contains: 
o ❻ Class #
o ❼ Class Text
o ❽ Class Name
o ❾ Day 
o ❿ USEF Codes
o ⓫ AHA Codes (on the 

report if AHA codes were 
entered (see Enter 
Classes). 

o ⓬ Default EC Code (on 
the report if EC was 
selected as the National 
Level (see Show 
Preferences > 
Membership (1) Tab).

SECTION VIII. PROGRAM FUNCTIONS

CLASS KEY REPORT: 
The Class Key Report is used to create a list of all the classes in the show, including the USEF Section Codes,
and AHA Codes & Default EC Codes if they are used.

6 7 8 9 10 11 12

5
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Reports - Pre-Show > Class Ride Limit

• Select  ❶Main Menu > ❷ Reports > 
❸ Pre-Show > ❹ Class Ride Limit.

SECTION VIII. PROGRAM FUNCTIONS

CLASS RIDE LIMIT: 
• Except for championship classes, USEF DR126.4. limits class size to 25 rides.
• The Class Ride Limit report is used to report a class that has more than the maximum of 25 rides.

• If there is no class with more than the 
maximum of 25 rides, a ❺ Fox 
Village Dressage information form 
opens advising you this is the case.

• Click ❻ OK to close the form.

• If there are any classes with more 
than the maximum of 25 rides, the 
❼ Classes with More Than 25 Rides
report opens.  

• The report includes:
o ❽ Class #
o ❾ [Class] Name
o ❿ Number of Rides [in the class]

• If any listed class is NOT a 
championship class, by USEF DR126.4 
rule, you must split the class (see Split 
Classes).

1

2

3
4

USEF DR126 Requirements for Dressage Competition Management
4. Where more than 25 entries are accepted for a particular class the class must be divided into separate divisions 
for awards purposes. USEF/USDF and other regional or local championship classes and USEF High Performance 
Championships, qualifying and selection trials cannot be split.

5

6

7

8 9 10
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Reports - Pre-Show > Entries without Documentation

• Select  ❶Main Menu > ❷ Reports > 
❸ Pre-Show > ❹ Entries without 
Documentation Report.

• The ❺ Entries without 
Documentation report
opens.  

• The report contains:
o ❻ Entry # (the report is 

sorted by Entry #, with the 
lowest number first).

o ❼ Horse Name, USEF and 
USDF #s

o ❽ Owner Name, USEF 
and USDF #s

o ❾ Rider Name USEF and 
USDF #s

o ❿ Trainer Name, USEF 
and USDF numbers

o ⓫ Coach Name, USEF and 
USDF #s

o ⓬ Telephone
• Key:
o  ######: Number 

verified and membership is 
current.  

o  ######: Number not
verified and/or 
membership not current.

o  : No number 
provided.  Status 
unknown.

o  nmr or  pend: Non-
member or pending 
membership status 
verified.

o  nmr or  pend: Non-
member or pending 
membership status not 
verified.

SECTION VIII. PROGRAM FUNCTIONS

ENTRIES WITHOUT DOCUMENTATION: 
The Entries without Documentation is used to create a list of entries that are missing required USEF and/or 
USDF membership documentation for the horse, owner, rider, trainer, and/or coach.  If an entry is on the 
list, information is missing and the entrant needs to be contacted.
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6 7 8 9
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10 11 12
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Reports - Pre-Show > Entry Confirmation Mailers

• Select  ❶Main Menu > ❷
Reports > ❸ Pre-Show > 
❹ Entry Confirmation 
Mailers.

• The ❽ Entry Confirmation 
Mailers report opens (this 
example is a Self-Mailer).

• The Window Envelope and 
Standard Envelope reports 
provide the same 
information in different 
formats.

1

2

3

4

SECTION VIII. PROGRAM FUNCTIONS

ENTRY CONFIRMATION MAILERS: 
• Entry Confirmation Mailers are used to mail 

and/or email a confirmation that the show 
entry packet has been received and processed 
(see Snail Mail Confirmation Notification). 

• The document contains all the entry’s key 
information that is entered in FVD and 
includes entry deficiencies.

• It may also be used as part of the entry packet 
(see ENTRY REVIEW AND MANAGEMENT 
SUGGESTIONS).

• The ❺ Entry Confirmation 
Mailer form opens.

• Click your ❻Mailer Style 
preference.

• Click ❼ OK.

5

7

6

 = Bad  = Good

NOTE:  It is a good idea 
to include this report 
with the paper entry 
packet or the digital 
entry packet as it verifies 
the information in FVD.
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Reports - Pre-Show > Horse Passport Labels

• Select  ❶Main Menu > ❷ Reports > 
❸ Pre-Show > ❹ Horses Passport 
Labels  report.

• The ❺ Horses Passport 
Labels report opens.

• The report contains:
o ❻ Show Name
o ❼ Entry #
o ❽ Horse name
o ❾ Rider FirstName 

LastName
• The labels are printed with 

Avery 5962 or generic 1-
1/3” x 4” labels.  

SECTION VIII. PROGRAM FUNCTIONS

HORSE PASSPORT LABELS: 
The Horse Passport Labels report is used to by CDI secretaries for their horse passport packets.

6

7
8

5

9
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Reports - Pre-Show > Horses without Coggins

• Select  ❶Main Menu > ❷ Reports > 
❸ Pre-Show > ❹ Horses without 
Coggins Report.

• The ❺ Horses without 
Coggins Report opens.

• The report contains:
o ❻ Entry # (the report is 

sorted by entry # with the 
lowest number first)  

o ❼ Horse name 
o ❽ Rider name
o ❾ Rider Telephone
o ❿ Rider Email

• The rider/owner needs to be 
contacted for submission of 
the Coggins (horses may not 
be taken off the trailer 
before the show secretary 
receives a copy of a current 
Coggins).

SECTION VIII. PROGRAM FUNCTIONS

HORSES WITHOUT COGGINS: 
The Horses without Coggins report is used to create a list of all entries that are missing the Coggins Report.

555    Horse Name                       Rider Name                            ###-###-####        EmailAddress

6 7 98

5

10
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Reports - Pre-Show > Horses without Vaccines

• Select  ❶Main Menu > ❷ Reports > 
❸ Pre-Show > ❹ Horses without 
Vaccines report.

• The ❺ Horses without 
Vaccines report opens.

• The report contains:
o ❻ Entry # # (the report 

is sorted by entry # with 
the lowest number first)  

o ❼ Horse name 
o ❽ Rider name
o ❾ Rider Telephone
o ❿ Rider Email

• The rider/owner needs to 
be contacted for submission 
of the proof of vaccination.

SECTION VIII. PROGRAM FUNCTIONS

HORSES WITHOUT VACCINES: 
• The Horses without Vaccines report is 

used to create a list of all entries that are 
missing proof of vaccination IAW USEF 
GR845 (click here).

NOTE: USEF GR845 
requires the proof of 
vaccination be brought to 
the show but does not 
require that it be part of 
the show entry.  Shows may 
require the proof of 
vaccination as part of the 
show entry.

EmailAddress@email.com

EmailAddress@email.com

EmailAddress@email.com

6 7 98 10

5

https://www.usef.org/forms-pubs/ANcxoLX1gNs/equine-vaccination-rule-gr845
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Reports - Pre-Show > Packet Labels (Standard)

• Select  ❶Main Menu > ❷ Reports > 
❸ Pre-Show > ❹ Packet Labels 
(Standard) report.

• The ❺ Packet Labels 
(Standard) report opens.

• The report contains:
o ❻ Show Name
o ❼ Show Date
o ❽ Rider Name (the report 

is sorted by the rider’s  last 
name)

o ❾ Entry #
o ❿ Horse Name

• See RIDER PACKET 
LABELS/SHEETS for more 
information on using and 
printing these labels.

1

2

3

4

PACKET LABELS (STANDARD): 
Packet Labels (Standard) is used to create labels that are placed on the show packets that are given to the 
competitors (also  called rider packets).  

SECTION VIII. PROGRAM FUNCTIONS

5

6
7

9
8

10
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Reports - Pre-Show > Packet Labels (Detail) 

• Select  ❶Main Menu > ❷ Reports > 
❸ Pre-Show > ❹ Packet Labels (Detail)
report.

• The ❺ Packet Labels 
(Detail) report opens.

• The report contains:
o ❻ Show Name
o ❼ Show Date
o ❽ Rider Name (the 

report is sorted by the 
last name)

o ❾ Entry #
o ❿ Horse Name
o ⓫ Payment/refund 

due
o ⓬ Items missing from 

entry

• See RIDER PACKET 
LABELS/SHEETS for more 
information on using and 
printing these labels.

PACKET LABELS (DETAIL): 
Packet Labels (Detail) is used to create 
labels that are placed on the rider packets 
that are given to the competitors.  The label 
alerts show management to missing 
information that must be collected when 
the competitor registers at the show office.

SECTION VIII. PROGRAM FUNCTIONS

5

6
7

8
9

10
1112

12

12
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Reports - Pre-Show > Packet Sheets

• Select  ❶Main Menu > ❷ Reports > 
❸ Pre-Show > ❹ Packet Sheets.

• The ❺ Packet Sheet report
opens.

• The report contains:
o ❻ Show Name
o ❼ Entry #
o ❽ Rider Name (the 

report is sorted by the 
rider’s last name)

o ❾ Horse Name
o ❿ Amount Due (or 

Refund Due)
o ⓫ Items missing from 

entry

• See RIDER PACKET 
LABELS/SHEETS for more 
information on using and 
printing these sheets.

PACKET SHEETS: 
Packet Sheets is used to print sheets that 
are cut in half and attached to the show 
packets that are given to the competitors.  
The sheets alert show management to 
missing information that must be collected 
when a competitor registers at the show 
office.

SECTION VIII. PROGRAM FUNCTIONS

5
6

7 8 9 10

11

11

11

11
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Reports - Pre-Show > Pre-Schedule (by Class)

• Select  ❶Main Menu > ❷ Reports > 
❸ Pre-Show > ❹ Pre-Schedule Report.

• The ❺ Pre-Schedule (by 
Class)  report opens.

• The report contains:
o ❻ Show Date
o ❼ Class # and Name
o ❽ Entry #
o ❾ Rider [Name]
o ❿ Horse [Name]
o ⓫ Total Rides [for each 

class]
o ⓬ Total Minutes [for each 

class]
• The last page of the report 

has:
o ⓭ Total Rides [for the day]
o ⓮ Total Rides [for the 

show]
o ⓯ Total Minutes for the 

day (hours and minutes). 

PRE-SCHEDULE (BY CLASS):
The Pre-Schedule (by Class) is a report of 
the classes and rides, sorted by Show Day, 
then Class #, then by Entry #. The report 
provides helpful information to use before 
scheduling to help you plan your show.

SECTION VIII. PROGRAM FUNCTIONS

NOTE: ⓯ Total Minutes for the 
show helps you plan when you 
are accepting entries as it will let 
you know the length of the 
show.  In this example, if the 
show had two arenas, for which 
each judge can only judge 8 
hours, there are too many 
hours/minutes in this show.

9

6
7

8

5

10

11 12

13
14
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Reports - Pre-Show > Pre-Schedule (by Class Summary) 

• Select  ❶Main Menu > ❷ Reports > 
❸ Pre-Show > ❹ Pre-Schedule Report 
(Summary).

PRE-SCHEDULE (BY CLASS SUMMARY):
The Pre-Schedule (by Class Summary) is a 
report of the days, classes, ring #, # of Rides, 
and Total Minutes, sorted by Day then Class 
#. The report provides helpful information to 
use before scheduling to help you plan your 
show.

• The ❺ Pre-Schedule 
Report (Summary) report
opens.

• The report contains:
o ❻ Show Date
o ❼ Class # and Name
o ❽ Ring # (if assigned)
o ❾ Total Rides for 

each class
o ❿ Total Minutes for 

each class
o ⓫ Total Rides for the 

day
o ⓬ Total Rides for the 

show
o ⓭ Total Minutes for 

the day

SECTION VIII. PROGRAM FUNCTIONS

5

6

7 8 9 10
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Reports - Pre-Show > Pre-Schedule (by Ring)

• Select  ❶Main Menu > ❷ Reports > ❸
Pre-Show > ❹ Pre-Schedule Report (by 
Ring).

PRE-SCHEDULE (BY RING):
The Pre-Schedule (by Ring) is a report of the 
classes and rides, sorted by Day, Ring #, then by 
Class #, then by Entry #. The report provides 
helpful information to use during scheduling to 
help you plan the rings your show.

• The ❺ Pre-Schedule (by 
Ring) report opens.

• The report contains:
o ❻ Show Date
o ❼ Ring
o ❽ Class # and Name
o ❾ Entry #
o ❿ Rider [Name]
o ⓫ Horse [Name]
o ⓬ Time allocated for 

each ride.
o ⓭ Total Rides (for 

each class)
o ⓮ Total Minutes (for 

each class) 
(hours/minutes)

• Totals:
o ⓯ Total Rides for 

each ring.
o ⓰ Total Minutes for 

each ring.
o ⓱ Total Rides for the 

day.
o ⓲ Total Rides for the 

show.
o ⓳ Total minutes 

(Hrs/Mins) for the day.

SECTION VIII. PROGRAM FUNCTIONS

NOTE: ⓰ Total Minutes 
for each ring helps you 
plan when you are 
scheduling the show as it 
lets you know if you have 
more than 8 hrs (480 min) 
for a ring.  Since each 
judge can only judge 8 
hours, if there are more 
than 480 min for a ring, 
you need to reschedule.
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Reports - Pre-Show > Pre-Schedule Report (by Ring Summary)

• Select  ❶Main Menu > ❷ Reports > 
❸ Pre-Show > ❹ Pre-Schedule Report 
(by Ring Summary).

• The ❺ Pre-Schedule 
Report (by Ring 
Summary) opens.

• The report contains:
o ❻ Show Date
o ❼ Ring #
o ❽ Class # and Name
o ❾ Total Rides for each 

class
o ❿ Total Minutes for 

each class
o ⓫ Total Minutes for 

each ring
o ⓬ Total Rides for each 

day
o ⓭ Total Minutes for 

each day
o ⓮ Total Rides for the 

show (on last page)

PRE-SCHEDULE (BY RING SUMMARY):
The Pre-Schedule Report (by Ring 
Summary) is a report of the days, classes, 
ring #, # of Rides, and Total Minutes, sorted 
by Day, then Ring #, then Class #. The report 
provides helpful information to use before 
and during scheduling to help you plan your 
show.

SECTION VIII. PROGRAM FUNCTIONS
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Reports - Pre-Show > Pre-Schedule (by Rider’s Status)

• Select  ❶Main Menu > ❷ Reports > 
❸ Pre-Show > ❹ Pre-Schedule Report 
(by Rider’s Status).

PRE-SCHEDULE (BY RIDER’S STATUS):
The Pre-Schedule (by Rider’s Status) is a report 
of the classes and rides, sorted by Day, Class #, 
then by Rider Status (Blank, Adult Amateur, 
JR/YR, Open),  then by Entry #. The report 
provides helpful information to use before and 
during scheduling to help you plan your show.  In 
particular, it can guide you to splitting classes by 
rider status, if you choose to do so.

• The ❺ Pre-Schedule 
(by Rider’s Status) 
report opens.

• The report contains:
o ❻ Show Date
o ❼ Class # and Name
o ❽ Rider Status
o ❾ Entry #
o ❿ Rider (name)
o ⓫ Horse (name)
o ⓬ Total Rides for 

each status
o ⓭ Total Minutes for 

each status
o ⓮ Total Rides for the 

class
o ⓯ Total Minutes for 

the class

SECTION VIII. PROGRAM FUNCTIONS
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Reports - Pre-Show > Pre-Schedule (by Test) [Class/Test]

• Select ❶Main Menu > ❷ Reports > 
❸ Pre-Show > ❹ Pre-Schedule (by 
Test).

PRE-SCHEDULE (BY TEST) [CLASS/TEST]:
The Pre-Schedule (by Test) [Class/Test] is a 
report of the classes and rides, sorted by Day, 
Class #, then by Test, then by Entry #.  The 
report provides helpful information to use 
before and during scheduling to help you plan 
your show.

• The ❺ Pre-Schedule (by 
Test) report opens.

• The report contains:
o ❻ Show Date
o ❼ Class # and Name
o ❽ Test
o ❾ Entry #
o ❿ Rider name
o ⓫ Horse name
o ⓬ Total Rides for each 

class
o ⓭Minutes for each 

ride.
o ⓮ Total Minutes for 

each test.
o ⓯ Total Minutes for 

each class

• See Print Pre-Schedule (by 
Test) for an example of 
how this report may be 
used to help schedule the 
show.

SECTION VIII. PROGRAM FUNCTIONS
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Reports - Pre-Show > Prize List Labels

• Select  ❶Main Menu > ❷ Reports > 
❸ Pre-Show > ❹ Prize List Labels.

• The ❺ Prize List Labels form opens.  
• Enter the ❻ Last Show Date that you 

would like included (MM/DD/YYYY).  
For example, if you want to go back 
five years, use a date that is five years 
prior to your current show’s date(s).

• Check either ❼ Last Name, First 
Name or ❽ Zip Code, Last Name, 
First Name to specify the order in 
which the labels are sorted.

• Click ❾ OK. 

5

6

7
8

9

• The ❿ Prize List Labels report opens.
• The report contains the names and 

addresses of previous show 
participants listed in your Horse & 
Rider (HR.hdf) file.

• See PRINT LABELS AND INDEX CARDS
to print these labels.  

SECTION VIII. PROGRAM FUNCTIONS

PRIZE LIST LABELS:
Prize List Labels is used to create mailing labels of people involved in your previous shows.  You can use the 
mailing labels to snail mail copies of your new show’s Prize List. (This assumes you have used your HR.hdf 
file for previous shows.)[Of course, nowadays, online posting and/or emailed attachments are must better 
and cheaper!]

10
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Reports - Pre-Show > Ribbon (Basic)

• Select  ❶Main Menu > ❷ Reports > 
❸ Pre-Show > ❹ Ribbon Report 
(Basic).

• The ❺ Ribbon (Basic) report
opens.

• The report contains:
o ❻ Show Name
o ❼ Class # and Name
o ❽Max number of places 

for each class
o ❾ Number of Rides for 

each class
o ❿ Number of 1st thru 14th

place for each class
o ⓫ Total Ribbons for each 

class
• The report’s last page 

contains:
o ⓬ Total number of Rides 

for the show
o ⓭ Total number of 

Ribbons for each place for 
the show

o ⓮ Total number of ribbons 
for the show

RIBBON (BASIC):
The Ribbon (Basic) report counts the 
number of ribbons you will need for the 
show if you do not separate the awards by 
rider status (Adult Amateur, JR/YR, Open).

SECTION VIII. PROGRAM FUNCTIONS

5
6

7 8 9 10 11

12 13 14

NOTE: The report does not account for 
ties, Pas de Deux (2 riders per test ), or 
Quadrille (4 riders per test).  Always 
order about 5-10% extra ribbons!
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Reports - Pre-Show > Ribbon (by Rider Status)

• Select  ❶Main Menu > ❷ Reports > 
❸ Pre-Show > ❹ Ribbon (by Rider’s 
Status).

• The ❺ Ribbon (by Rider’s 
Status) report opens.

• The report contains:
o ❻ Show Name
o ❼ Class # and Name
o ❽ [Rider] Status (AA, JYR, 

Open)
o ❾Max number of places 

for each status/class
o ❿ Number of Rides for 

each status/class
o ⓫ Number of 1st thru 

14th place for each status 
/class

o ⓬ Total Ribbons for each 
status/class

• The last page contains:
o ⓭ Total number of Rides 
o ⓮ Total number of 

Ribbons (1st thru 14th) for 
each status/class

o ⓯ Total number of 
ribbons

RIBBON (BY RIDER STATUS):
The Ribbon (by Rider Status) counts the 
number of ribbons you will need for the 
show if you each class by rider status (Adult 
Amateur, JR/YR, Open).

SECTION VIII. PROGRAM FUNCTIONS

NOTE: The report does not
account for ties, Pas de 
Deux (2 riders per test ), or 
Quadrille (4 riders per test).  
Always order about 5-10% 
extra ribbons!

1
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Reports - Pre-Show > Ride Schedule Mailers

• Select  ❶Main Menu > ❷ Reports > 
❸ Pre-Show > ❹ Ride Schedule 
Mailers.

• For procedures to print the 
report, see PRINT.

• Snail mail the report, if 
desired.

• For procedures to save the 
report as a PDF file, see 
Export > PDF or XPS.

• For procedures to email the 
report PDF to the rider, see 
Email One Person.

• The ❺ Ride Schedule Mailers form opens.
• Select the ❻Mailer Style to be used.
• Click ❼ OK.

5

6

7

RIDE SCHEDULE MAILERS:
This report is used to create a ride times 
sheet that can be snail mailed and/or 
emailed to each rider.  It can also be placed 
in rider packets, if desired.

SECTION VIII. PROGRAM FUNCTIONS

• The ❽ Ride Schedule 
Mailer report opens.

• The report contains:
o ❾ Show Name, Date, 

Show Contact, Rider 
Name

o ❿ Information regarding 
the rider’s rides.

o ⓫ Show Name and 
Address

o ⓬ Rider Name and 
Address

8

9

10

11

12

NOTE: Better ways to send out ride times:
• Use the FVD Rider’s Schedule Report.  This report 

can be emailed to all show participants and/or 
posted on the show’s web site.  

• Use Upload Ride Times to the FVD Web Site.
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Reports - Pre-Show > Rider Email List

RIDER EMAIL LIST:
The Rider Email List provides a list of all 
show riders and their emails.

• Select  ❶Main Menu > ❷ Reports > 
❸ Pre-Show > ❹ Rider Email List 
report.

• The ❺ Rider Email List 
report opens.

• The report contains:
o ❻ Rider Name
o ❼ (Rider) Email

SECTION VIII. PROGRAM FUNCTIONS

EmailAddress@Email.com

EmailAddress@Email.com

EmailAddress@Email.com

EmailAddress@Email.com

EmailAddress@Email.com

EmailAddress@Email.com

EmailAddress@Email.com

EmailAddress@Email.com

EmailAddress@Email.com

EmailAddress@Email.com

EmailAddress@Email.com

EmailAddress@Email.com

EmailAddress@Email.com

EmailAddress@Email.com

EmailAddress@Email.com

EmailAddress@Email.com

EmailAddress@Email.com

EmailAddress@Email.com

EmailAddress@Email.com

EmailAddress@Email.com

EmailAddress@Email.com

EmailAddress@Email.com

EmailAddress@Email.com

EmailAddress@Email.com

EmailAddress@Email.com

EmailAddress@Email.com

EmailAddress@Email.com

EmailAddress@Email.com

EmailAddress@Email.com

EmailAddress@Email.com

EmailAddress@Email.com

EmailAddress@Email.com

EmailAddress@Email.com

EmailAddress@Email.com

EmailAddress@Email.com

EmailAddress@Email.com

EmailAddress@Email.com

EmailAddress@Email.com

EmailAddress@Email.com

EmailAddress@Email.com

EmailAddress@Email.com

EmailAddress@Email.com

EmailAddress@Email.com

EmailAddress@Email.com

EmailAddress@Email.com
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EmailAddress@Email.com
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Reports - Pre-Show > Test Count

TEST COUNT:
The Test Count report is used to determine 
how many test sheets of each test are 
needed for the show.

1

2

3

4

• Select ❶Main Menu > ❷ Reports > 
❸ Pre-Show > ❹ Test Count report.

• The ❺ Test Count report
opens.

• The report contains:
o ❻ Test Name
o ❼ # of Tests Needed

• See Test Count Report for 
further information on the 
use of this report.

SECTION VIII. PROGRAM FUNCTIONS

NOTE: Always print a few 
extra of each test.  The judges 
expect a blank test sheet for 
reference, and the show office 
might need blank test sheet 
when filling scratches, etc.

5

6 7
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Reports - Pre-Show > Test Labels
TEST LABELS: The Test Labels report is used 
to create test labels that are applied to the 
dressage test sheets prior to the show.

• Select  ❶Main Menu > ❷ Reports > ❸
Pre-Show > ❹ Test Labels.

• The ❺ Test Labels form opens.
• Using the ❻ drop down arrow, select the 
❼ Date of the show for which you want 
to print labels.

• Select the ❽ Judge position for which you 
desire to make labels.  C is the default.

• Click ❾ OK.

• The ❿ Test Labels 
(Standard) report opens.

• The report contains:
o ⓫ Show Name
o ⓬ Date
o ⓭ Class # and Test
o ⓮ Qualifier (Q) or not 

(no Q)
o ⓯ Entry #
o ⓰ Rider status (Adult 

Amateur, JR/YR, Open).
o ⓱ Horse and Rider

names.
o ⓲ Time, Ring, and 

Judge.

• See Prepare Dressage Test 
Sheets for further 
information on the printing 
and use of this report.

SECTION VIII. PROGRAM FUNCTIONS

5
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Reports - Pre-Show > USDF Qualifiers without Documentation

• Select  ❶Main Menu > ❷ Reports > ❸ Pre-
Show > ❹ USDF Qualifiers without 
Documentation Report.

• The ❺ USDF Qualifiers without 
Documentation Report opens.

• The report contains:
o ❻ Entry #.
o ❼ Horse:
➢ Name
➢ USEF Number
➢ USEF Number

o ❽ Owner:
➢ Name
➢ USEF Number
➢ USEF Number

o ❾ Rider:
➢ Name
➢ USEF Number
➢ USEF Number

o ❿ Rider Telephone number.
• What the information means:

o  Number: Membership 
number & card submitted and 
verified.

o  Number: Membership 
number submitted but not 
verified with a card.

o  No Number: Membership 
number & card have not been 
submitted.

• Entries on this report with  have 
deficiencies that must be resolved 
before the ride.  For the ride to be a 
Q ride, all numbers must be 
submitted and current expiration 
verified.  The numbers and 
verification may be obtained via the 
various online searches available 
(see USEF AND USDF PEOPLE & 
HORSE MEMBERSHIP 
REQUIREMENTS & EXEMPTIONS).

USDF QUALIFIERS WITHOUT DOCUMENTATION:
Entries in USDF qualifying classes who requested 
(and paid the Q fee) that the ride be a qualifying 
ride, must meet USDF and USEF membership 
requirements.  The USDF Qualifiers without 
Documentation Report lists Q entries with 
missing horse, owner, and/or rider membership 
information.

SECTION VIII. PROGRAM FUNCTIONS

2

3

4

1

5

6 7 8 9

 = Good     = Bad
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Reports - Pre-Show > Volunteer

• The ❺ Volunteer report opens.
• Riders, Owners, Trainers, and 

Coaches❻ checked as 
volunteers in the Entry form are 
listed.

• Select  ❶Main Menu > ❷ Reports > 
❸ Pre-Show > ❹ Volunteer.

SECTION VIII. PROGRAM FUNCTIONS

VOLUNTEER:
The Volunteer report is used to create a list 
of show participants that are also show 
volunteers.  See Details of a FVD Entry for 
the procedure to designate a person as a 
volunteer.

5

6
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Reports - During-Show > Announcer’s [“Order of Go” (Detail)]

ANNOUNCER’S [“ORDER OF GO” (DETAIL)]:
The Announcer’s “Order of Go” (Detail) report provides detailed information for the announcer (or others 
with a need for detailed information), organized in order of go for the entire show (by time, not by ring).  
Some announcers prefer this report; other announcers prefer the Day Sheets report.

• Select  ❶Main Menu > ❷ Reports > 
❸ During-Show > ❹ Announcer’s.

SECTION VIII. PROGRAM FUNCTIONS

1

2

3 4

• The ❺ Announcer’s report form opens.
• Using the ❻ Date drop-down, select the 

date.
• Click ❼ OK.

5

6

7

Rider’s Address
Age        Breed
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Rider’s Address
Age        Breed
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Rider’s Address
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Rider’s Address
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Dam

Rider’s Address
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Rider’s Address
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Dam
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Sire
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Sire
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Sire
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Sire
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Horse
Sire
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Breeder

Owner
Breeder

Owner
Breeder

Owner
Breeder

Owner
Breeder

Owner
Breeder

Owner
Breeder

Owner
Breeder

Owner
Breeder

Owner
Breeder

8

• The ❽ Announcer’s “Order of Go” (Detail) Report opens.
• The report contains:

o ❾ [Ride] Time
o ❿ Entry #
o ⓫ Ring
o ⓬ Rider, Horse, Sire [Names]
o ⓭ Rider’s Address, Horse Age, Breed, Dam [Name]
o ⓮ Horse’s Height
o ⓯ Stat/Div, Color, DamSire [Name]
o ⓰ Class, Class Name, Sex
o ⓱ Owner, Breeder [Names]
o ⓲ Term
o ⓳ Test
o ⓴ Q

###:## AM

###:## AM

9 10 11 12 13 14 15 16 17 18 1920
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Reports - During-Show > Announcer’s [“Order of Go”] (Summary)

ANNOUNCER’S [“ORDER OF GO”] (SUMMARY): 
The Announcer’s “Order of Go” (Summary) provides summary information for the announcer (or others 
with a need for summary information), organized in order of go for the show (by time, not by ring).

SECTION VIII. PROGRAM FUNCTIONS

5

6

7

8

• Select  ❶Main Menu > ❷ Reports > 
❸ During-Show > ❹ Announcer’s.

1

2

3
4

• The ❺ Announcer’s report form opens.
• Using the ❻ Date drop-down, select the 

date.
• Check the ❼ Summary check box ().
• Click ❽ OK.

###:## AM
###:## AM

9

• The ❾ Announcer’s “Order of Go” (Summary) report opens.
• The report contains:

o ❿ [Ride] Time
o ⓫ Entry #
o ⓬ Ring
o ⓭ Rider [Name]
o ⓮ Horse (Name)
o ⓯ [Rider] Stat/Div
o ⓰ Class #
o ⓱ Class Name
o ⓲ Term
o ⓳ Test
o ⓴ Q

##:## XX

##:## XX10 11 12 13 14 15 16 17 18 19 20
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Reports - During-Show > Class Schedule - Judge Assignment

CLASS SCHEDULE - JUDGE ASSIGNMENT: 
The Class Schedule - Judge Assignment report provides the schedule of classes, including start/stop times 
and class duration, & the class judges.  

• Select  ❶Main Menu > ❷ Reports > 
❸ During-Show > ❹ Class Schedule -
Judge Assignment.

1

2

3
4

SECTION VIII. PROGRAM FUNCTIONS

5

6

7

• The ❺ Class Schedule – Judge Assignment form 
opens.

• Select the ❻ Date you desire.
• Click ❼ OK.

• The ❽ Class Schedule - Judge Assignment report opens.
• The report contains:

o ❾ Date
o ❿ Ring
o ⓫ Start Time  End Time (including breaks)
o ⓬ [Class] Duration (including breaks)
o ⓭ Class [#]
o ⓮ Class Name
o ⓯ Judge Name(s)

• See Check Judges’ Hours for the use of this report.

8

9

10 11 12 13 14 15
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Reports - During-Show > Day Sheets CDI

DAY SHEETS CDI:
The Day Sheets CDI report provides daily show information in a CDI format. 

• Select  ❶Main Menu > ❷ Reports > 
❸ During-Show > ❹ Class Schedule > 
Day Sheets CDI.

SECTION VIII. PROGRAM FUNCTIONS

• The ❺ Days Sheets form opens.
• Using the ❻ drop-down arrow, select 

the day (or leave it blank to get a report 
for all days).

• Click ❼ OK.
5

6

7

1

2

3 4

• The ❽ CDI Day Sheets report opens.
• The report contains:

o ❾ Ring #
o ❿ Class # and Name
o ⓫ Judge [Name]
o ⓬ [Ride] Time
o ⓭ Entry [#]
o ⓮ Rider [Name]
o ⓯ [Rider] Citizenship
o ⓰ Horse [Name]

11
12 13 14 15 16 17 18 19 20 21 22 23 24

8
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9
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Reports - During-Show > Day Sheets Standard

DAY SHEETS STANDARD:
The Day Sheets Standard report provides 
daily show information in a standard (non-
CDI) format. 

• Select  ❶Main Menu > ❷ Reports > 
❸ During-Show > ❹ Class Schedule > 
Day Sheets Standard.

SECTION VIII. PROGRAM FUNCTIONS

• The ❺ Days Sheets form opens.
• Using the ❻ drop-down arrow, select the 

day for which a report is desired (or leave 
blank to get a report for all show days).

• Click ❼ OK.

5

6

7

1

2

3
4

• The ❽ Day Sheets 
Standard report opens.

• The report contains:
o ❾ Ring #
o ❿ Class # & Name
o ⓫ Judge(s)
o ⓬ [Ride] Time
o ⓭ Entry [#], Rider 

[Name]
o ⓮ Horse [Name]
o ⓯ Test
o ⓰ Stat/Div
o ⓱ Q
o ⓲ Term
o ⓳ Lines for Scores

• See Day Sheets Standard 
Report and REPORTS IN 
THE SHOW PROGRAM for 
use of this report.

8

9
10
11

12 13 14 15 16 17 18 19
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Reports - During-Show > Day Sheets Scoring
DAY SHEETS SCORING:
The Day Sheets (Scoring) report provides daily show information to help the scoring department track completion of 
score sheets and if they are on hold. 

• Select  ❶Main Menu > ❷ Reports > ❸
During-Show > ❹ Class Schedule > Day 
Sheets Scoring.

SECTION VIII. PROGRAM FUNCTIONS

• The ❺ Days Sheets form 
opens.

• Using the ❻ drop-down 
arrow, select the day for 
which a report is desired (or 
leave blank to get a report 
for all show days).

• Click ❼ OK.

5

6

7

1

2

3
4

8

9

10
11

12 13 14 15 16 17 18 19 20 21

• The ❽ Day Sheets 
(Scoring) report opens.

• The report contains:
o ❾ Ring #
o ❿ Class [#] & Name
o ⓫ Judge(s)
o ⓬ [Ride] Time
o ⓭ Finished
o ⓮ Entry [#]
o ⓯ Rider [Name]
o ⓰ Horse [Name]
o ⓱ Test
o ⓲ Stat/Div
o ⓳ Q
o ⓴ Term
o 21 Lines for Scores
o 22  Hold boxes

• See Day Sheets Scoring 
Report for use of this 
report.

21

22
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Reports - During-Show > Entry By
ENTRY BY:
The Entry By reports provide show reports sorted by rider, entry #, horse name, owner name, trainer name, 
or coach name.

• Select  ❶Main Menu > ❷ Reports > 
❸ During-Show > ❹ Entry By.

• The ❽ Entry By Rider 
report opens.

• The report contains:
o ❾ Rider (Name)
o ❿ Entry #
o ⓫ Horse (Name)
o ⓬ Owner (Name)
o ⓭ Trainer (Name)
o ⓮ Coach (Name)

• On the ❺ Entry By form, 
click any of the other 
options (By Horse, By 
Owner, By Trainer, By 
Coach) to open a similar 
report sorted by the 
option selected.

SECTION VIII. PROGRAM FUNCTIONS

• The ❺ Entry By form opens.
• For this example, click ❻ By 

Rider.
• Click ❼ OK.

5

6

7

8

9 10 11 12 13 14
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Reports - During-Show > Handwritten Score Sheets

HANDWRITTEN SCORE SHEETS:
Handwritten Score Sheets are used for recording scores during the show.  Traditionally it was used by the 
scoring section.  The new Day Sheets (Scoring) may now be used instead.

• Select  ❶Main Menu > ❷ Reports > 
❸ During-Show > ❹ Handwritten 
Score Sheets.

SECTION VIII. PROGRAM FUNCTIONS

1

2

3

4

• The ❺ Handwritten 
Score Sheets report
opens.

• The report contains:
o ❻ Ring #
o ❼ Class # &

Name
o ❽ Judge [Name]
o ❾ (Ride) Time
o ❿ Entry #
o ⓫ Rider [Name]
o ⓬ Horse [Name]
o ⓭ Test
o ⓮ Stat/Div
o ⓯ Q
o ⓰ Term
o ⓱ Spaces/boxes 

for handwritten 
scores and 
placings

• See Handwritten 
Score Sheets and 
Make Large-Sized 
Results Posters for 
uses of this report.

7
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Reports - During-Show > Harrow Schedule

HARROW SCHEDULE:
To ensure good footing, arenas are usually 
“dragged” with a harrow before the show 
begins and in the middle of the show day, as 
a minimum.  This is often accomplished 
during a judge’s break or lunch.  The Harrow 
Schedule Report list times each arena has 
breaks so harrowing could be performed.

• Select  ❶Main Menu > ❷ Reports > 
❸ During-Show > ❹ Harrow Schedule.

• The ❺ Harrow Schedule 
report opens.

• The report contains:
o ❻ Date
o ❼ Ring #
o ❽ Time a break/lunch 

begins
o ❾ Duration (min) of 

the break/lunch
o ❿ Description

• Use this report to 
schedule the dragging of 
your rings.

NOTE: Breaks/Lunch are 
scheduled in Add a 
Break/Lunch.  The 
Harrow Schedule Report
is a listing of the breaks 
and lunches, by ring, 
with time and duration.  
Harrow time should be 
considered when breaks 
and lunches are 
scheduled.  Show 
management selects 
which rings will be 
harrowed at which time.  
Do not harrow a ring 
that is adjacent to a ring 
with rides in progress!

SECTION VIII. PROGRAM FUNCTIONS
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Reports - During-Show > Horse Inspection

HORSE INSPECTION:
CDI shows require an inspection of the horses to ensure they are physically fit for showing.  The Horse 
Inspection report is used to record the inspection results.  It is printed and provided to the veterinarian.  
The results are not entered into FVD.

• Select ❶Main Menu > ❷ Reports > 
❸ During-Show > ❹ Horse Inspection.

• The ❺ Horse 
Inspection report
opens.

• The report contains:
o ❻ Entry #
o ❼ Horse (name)
o ❽ Passport #
o ❾ Rider (name)
o ❿ Citizenship
o ⓫ Accepted box
o ⓬ Not Accepted 

box
o ⓭ Reinspect box
o ⓮ Passport Return 

Signature
• Use this report to 

mark, by hand, the 
inspection status of 
each horse.

SECTION VIII. PROGRAM FUNCTIONS
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Reports - During-Show > Judge Schedule

JUDGE SCHEDULE: 
The Judge Schedule report tells you how 
many hours a judge is scheduled to officiate 
and be on the show grounds.

• Select  ❶Main Menu > ❷ Reports > 
❸ During-Show > ❹ Judge Schedule.

• The ❺ Judge Schedule 
report opens.

• The report contains:
o ❻ Judge (name)
o ❼ Day
o ❽ Start Time
o ❾ End Time
o ❿ Duration of each 

class (includes breaks)
o ⓫ Class #
o ⓬ Class Name
o ⓭ Ring
o ⓮ Station (C, E, etc.)
o ⓯ Total Time for Day 

(hr/min).  
• See Check Judges’ Hours for 

information on using this 
report.

SECTION VIII. PROGRAM FUNCTIONS
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NOTE: The ⓯ Total Time 
for Day includes all breaks.  
Therefore, when 
determining if the judge has 
no more than 8 hours of 
judging, subtract the time 
for all breaks.

USEF Rule DR126.1. Requirements for Dressage 
Competition Management.

d. Judges and Technical Delegates. 
(1) No judge shall be required to officiate longer than 8 
hours in one day, unless the judge has agreed in 
writing, and cannot be required to be on the 
competition grounds longer than 10 hours.
(2) Judges must be given at least a 45-minute lunch 
break and at least a 10 minute break every 2 hours.



Fox Village Dressage User Manual – 2021 Update 1.0.5. helpdesk@foxvillage.com                 www.foxvillage.com

1

2

3

4

689

Reports - During-Show > Rider’s Schedule

RIDER’S SCHEDULE: 
The Rider’s Schedule report lists each rider 
(alphabetically by last name) and the classes 
each has entered with the ride time, ring 
number, and judge(s).

• Select  ❶Main Menu > ❷ Reports > 
❸ During-Show > ❹ Rider’s Schedule.

• The ❺ Rider’s Schedule 
report opens.

• The report contains:
o ❻ Rider name
o ❼ Day of the ride
o ❽ Ride Time
o ❾ Ring #
o ❿ Entry #
o ⓫ Horse [Name]
o ⓬ Judge at … [Name]
o ⓭ Class #
o ⓮ Test Name
o ⓯ Qual/Div

SECTION VIII. PROGRAM FUNCTIONS

• For procedures to save the 
report as a PDF file, see 
Export > PDF or XPS.

• Post the report PDF on the 
show’s web site and/or email 
the report to show 
participants.

• For procedures to email the 
report PDF to the rider, see 
Email One Person.

• Snail mail the report, if 
desired.
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Reports - During-Show > Ring Steward’s [“Order of Go”]

RING STEWARD’S [“ORDER OF GO”]: 
The Ring Steward’s {“Order of Go”] report
provides information needed by Ring 
Stewards to manage each ring.  All rides for 
the day are listed, by each ring, in order of go.

• Select  ❶Main Menu > ❷ Reports > ❸
During-Show > ❹ Ring Steward’s.

• The ❾ Ring Steward’s “Order of 
Go” report opens.

• The report contains:
o ❿ Date
o ⓫ Ring #
o ⓬ Time
o ⓭ Entry #
o ⓮ Rider [Name]
o ⓯ Horse [Name]
o ⓰ Class [# and Name]
o ⓱ Term
o ⓲ Hold

• Print a copy of this report for each 
ring steward.  Some ring stewards 
or shows prefer to use Day Sheets.

• If you check the ⓳ Horse Detail 
box, the report will contain details 
about the horse (Breed, Sex, 
Height, Color).

SECTION VIII. PROGRAM FUNCTIONS

• The ❺ Ring Steward’s 
Report  form opens.

• Use the ❻ drop down 
arrow to select the ❼
date (or leave this blank 
to get all dates).

• Click ❽ OK.
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Reports - During-Show > Scratches Not Subbed

SCRATCHES NOT SUBBED: 
The Scratches Not Subbed report lists 
scratched rides that have not been filled 
(substituted) by other riders.  When a 
scratched ride is filled (subbed), the ride is 
no longer listed on the report.

• Select  ❶Main Menu > ❷ Reports > 
❸ During-Show > ❹ Scratches Not 
Subbed.

• The ❺ Scratches Not Subbed 
report opens.  

• The report contains:
o ❻ Day
o ❼ Time
o ❽ Class #
o ❾ Class Name
o ❿ Test
o ⓫ Ring

• The report is sorted by:
o Day
o Time

• This report is only valuable if 
all scratches have been 
entered in the computer.

• During the show, you can refer 
to this report on the computer 
to determine available rides.

• You can also print the report 
(frequently) so you and others 
can refer to it, thereby 
assisting in filling available 
rides.

• Additionally, if you are using 
UPLOAD SHOW RESULTS TO 
THE WEB, available rides can 
be viewed online.

• See SCRATCHES AFTER 
SCHEDULING AND FILL 
SCRATCHED RIDES for 
procedures.

SECTION VIII. PROGRAM FUNCTIONS
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Reports - During-Show > Show Roster > By Entry #
SHOW ROSTER > BY ENTRY #: 
The Show Roster > by Entry # report lists 
competitors by Entry #.  It is often used in a 
show program.

• Select  ❶Main Menu > ❷ Reports > ❸
During-Show > ❹ Show Roster.

• The ❽ Show Roster Report 
(by Entry #) report opens.  The 
report contains:
o ❾ Entry #
o ❿ Horse [Name], Breeder 

[Name]
o ⓫ Age, Sire
o ⓬ Breed
o ⓭ Height, Dam
o ⓮ Color
o ⓯ Sex
o ⓰ Rider [Name], Owner 

[Name]
o ⓱ Rider’s Address,

Owner’s Address

• This report can be used in the 
Show Program. 

• See Print Preview > Export > 
Word to save it as an editable 
Word file.  

• See Print Preview > Export > 
PDF or XPS to save it as a *.pdf 
file.  

SECTION VIII. PROGRAM FUNCTIONS

• The ❺ Show Roster report form opens.
• Click ❻ Report Style / Entry #.  (See next 

page for a By Rider’s Name report.)
• Click ❼ OK.
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Reports - During-Show > Show Roster > By Rider

• The ❽ Show Roster (by 
Rider) report opens.  The 
report contains:
o ❾ Rider, Owner (or * if 

rider = owner).
o ❿ Rider’s Address,

Owner’s Address
o ⓫ Entry #
o ⓬ Horse, Breeder
o ⓭ Age, Sire
o ⓮ Breed
o ⓯ Height, Dam
o ⓰ Color
o ⓱ Sex

• This report can be used in the 
Show Program. See Print 
Preview > Export > Word to 
save it as an editable Word file.  

• See Print Preview > Export > 
PDF or XPS to save it as a *.pdf 
file.  

SECTION VIII. PROGRAM FUNCTIONS

SHOW ROSTER > BY RIDER: 
The Show Roster (by Rider) report lists 
competitors by Rider’s [Last] Name.  It is 
often used in a show program.

• The ❺ Show Roster Report 
form opens.

• Click ❻ Report Style / By 
Rider.  (See previous page for 
a By Entry # report.)

• Click ❼ OK.

• Select  ❶Main Menu > ❷ Reports > ❸
During-Show > ❹ Show Roster.
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Reports - During-Show > Stable Cards > Stable Cards & Tack Stall Cards

STABLE CARDS > STABLE CARDS & TACK 
STALL CARDS: 
Stable Cards and Tack Stall Cards are used 
to make Stall Cards and Tack Stall Cards. 
These are 3” x 5” index cards that are affixed 
to each horse’s stall. 

• Select  ❶Main Menu > ❷ Reports > 
❸ During-Show > ❹ Stable Cards.

SECTION VIII. PROGRAM FUNCTIONS

• The ❺ Stable Cards 
form opens.

• Under ❻ Stall Type, 
select ❼ Stable 
Cards.

• Click ❽ OK.
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• The ❾ [Horse] Stable Cards 
report opens.  

• Each page of the report has 
information for three stabling 
cards. 

• The report contains:
o ❿ Rider Name
o ⓫ Horse Name
o ⓬ Stall Group Name
o ⓭ Entry #
o ⓮ Sex
o ⓯ Breed
o ⓰ Color
o ⓱ Height
o ⓲ EMERGENCY 

INFORMATION (to be 
completed by the rider)

o ⓳ Extra Bedding
o ⓴ Stall #
o XX Days reserved ().

• The report is sorted by:
o Stall Group (entries w/o a 

stall group are listed first)
o Entry #

• Repeat, using XX Tack Stall 
Cards, for tack stall cards.

• See Print Stable Cards and Tack 
Stall Cards for details on the 
printing and use of this report.
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Reports - During-Show > Stable Cards > Stable Cards (Small) & Tack Stall Cards (Small)

STABLE CARDS > STABLE CARDS (SMALL) & 
TACK STALL CARDS (SMALL): 
Stable Cards (Small) and Tack Stall Cards 
(Small) are used to make Stall Cards and Tack 
Stall Cards. These are 2” x 4” labels or 
business cards that are affixed to each horse’s 
stall. They are sorted by Stall Group name.

• The ❾ Stable Cards (Small) 
report opens.  

• Each page of the report has 
information for three stabling 
cards. 

• The report contains:
o ❿ Rider Name
o ⓫ Horse Name
o ⓬ Stall Group Name
o ⓭ Entry #
o ⓮ Sex
o ⓯ Breed
o ⓰ Color
o ⓱ Height
o ⓲ EMERGENCY 

INFORMATION (to be 
completed by the rider)

o ⓳ Extra Bedding
o ⓴ Stall #
o XX Days reserved ().

• The report is sorted by:
o Stall Group (entries w/o a 

stall group are listed first)
o Entry #

• Repeat, using XX Tack Stall 
Cards, for tack stall cards.

• See Print Stable Cards and Tack 
Stall Cards for details on the 
printing and use of this report.

SECTION VIII. PROGRAM FUNCTIONS
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• Select  ❶Main Menu > ❷ Reports > 
❸ During-Show > ❹ Stable Cards.

• The ❺ Stable Cards 
form opens.

• Under ❻ Stall Type, 
select ❼ Stable 
Cards.

• Click ❽ OK.
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Reports - During-Show > Stable Labels > Stable Labels & Tack Stall Labels
STABLE LABELS > STABLE LABELS & TACK 
STALL LABELS: 
Instead of Stall Cards and Tack Stall Cards, 
you may desire Stall Labels and Tack Stall 
Labels to designate stall assignments. These 
are 1” x 2-5/8” labels that are affixed to each 
horse’s stall and/or the rider packets.

• Select  ❶Main Menu > ❷ Reports > 
❸ During-Show > ❹ Stable Labels.

• The ❾ Stable Labels report
opens.

• Each page of the report has 
information for 30 Stabling 
Labels. 

• The report contains:
o ❿ Horse Name
o ⓫ Rider Name
o ⓬ Stall Group Name
o ⓭ Bedding #
o ⓮ Sex
o ⓯ Entry #
o ⓰ Stall #

• The report is sorted by:
o Stall Group (entries w/o a 

stall group are listed first)
o Entry #

• Repeat, using ⓱ Tack Stall 
Labels, for tack stall labels.

• See PRINT LABELS AND INDEX 
CARDS for the procedure to 
print labels and Default & 
Recommended Settings > 1’ x 
2-5/8” Labels for specifics on 
this label.

SECTION VIII. PROGRAM FUNCTIONS

• The ❺ Stable Labels 
form opens.

• Under ❻ Stall Type, 
select ❼ Stabling 
Labels.

• Click ❽ OK.
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Horse Name                              Sex
Rider Name                         Entry #
Stall Group Name
Bedding:  #                          Stall: #
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Reports - During-Show > Stable > Stable Report and Tack Stall Report

• Select  ❶Main Menu > ❷ Reports > ❸
During-Show > ❹ Stable.

• The ❾ Stable Report opens.  
• The report contains:

o ❿ Horse, Rider, Stall Group
o ⓫ Sex, Entry #, Stall #
o ⓬ Day(s) reserved
o ⓭ Bedding ordered

• The report is sorted by:
o Stall Group (entries w/o a stall 

group are listed first)
o Entry #

• Print this report for your Stabling 
Manager.

• Repeat, using ⓮ Tack Stall for the 
Tack Stall report

STABLE > STABLE REPORT AND TACK STALL 
REPORT:
• The Stable report contains information on 

horse stalls only. 
• The Tack Stall Report contains information 

on tack stalls only.
• The Total Stable Report (see Reports > Post-

Show > Total Stable Report) contains 
information on horse stalls and tack stalls, all 
in one report.   

SECTION VIII. PROGRAM FUNCTIONS

• The ❺ Stable report form opens.
• Under ❻ Stall Type, select ❼

Stable Report.
• Click ❽ OK.
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Reports - During-Show > Team Roster

TEAM ROSTER: 
The Team Roster report lists the members 
(horse and rider) of teams.

• Select  ❶Main Menu > ❷ Reports > 
❸ During-Show > ❹ Team Roster.

• The ❺ Team Roster report
opens.

• The report contains:
o ❻ Team name
o ❼ Entry # for each Horse/ 

Rider combination
o ❽ Horse name
o ❾ Rider name

• For details on managing teams, 
see MANAGING TEAMS.

• See Select the Entry’s Team for 
procedures on entering teams in 
the FVD program.

• See Scoring > Special Score 
Reports > Team Tab for 
procedures on scoring teams.

SECTION VIII. PROGRAM FUNCTIONS
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Reports - During-Show > Total Stable

• Select  ❶Main Menu > ❷ Reports > ❸
During-Show > ❹ Total Stable.

• The ❺ Total Stable report opens.
• The report contains:

o ❻ Horse, Rider, Stall Group
o ❼ Sex, Entry #, Stall #
o ❽ Day(s) reserved
o ❾ Bedding ordered, Type of stall 

(Horse or Tack)
o ❿ Preferences declared in the 

entry packet (if any) or other 
notes

• The report is sorted by:
o Stall Group (entries w/o a stall 

group are listed first)
o Entry #

• Print this report for your Stabling 
Manger.

• Posting this report on the show’s web 
site is an easy method to inform 
riders of their stall assignments. 

SECTION VIII. PROGRAM FUNCTIONS

TOTAL STABLE:
• The Stable Report (see Reports > During-

Show > Stable Reports > [Horse] Stabling 
Report) contains information on horse stalls 
only. 

• The Tack Stall Report (see Reports > During-
Shows > Stable Reports > Tack Stall Report) 
contains information on tack stalls only.

• The Total Stable Report (this report) contains 
information on horse stalls and tack stalls, all 
in one report.   

NOTE:  Some shows do not release stall 
numbers prior to the show.  Instead, 
they provide stall numbers when the 
rider/owner registers at the Show 
Office.  This prevents the unloading of 
horses for which a current Coggins has 
not yet been submitted.
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Reports - During-Show > [Show’s Total] Wait List Report > Purpose, Open the Report

[SHOW’S TOTAL] WAIT LIST REPORT > 
PURPOSE: 
• The {Show’s Total] Wait List report shows 

all entrants who have been placed on a 
waiting list.  The report is listed by class, 
in order of class #.

• Select  ❶Main Menu > ❷ Reports > 
❸ During-Show > ❹Wait List.

• The ❺Wait List report opens.
• The report contains:
o ❻ Day
o ❼ Class #
o ❽ Class name
o ❾ Entry #
o ❿ Horse name
o ⓫ Rider name

• If you have a scratch in a class 
with riders on the wait list, you 
can refer to the list to fill the 
scratch.

• See WAIT LIST for information 
on wait lists and using this 
report.

SECTION VIII. PROGRAM FUNCTIONS

NOTE:  This Wait List Report 
requires the entry be entered in the 
FVD program.  If you have received 
entries after the show is closed and 
the rider would like to enter the 
show if there are appropriate 
scratches, you can use the Check 
List to list these entries that have 
not yet been entered in the 
program.  See Show Office > Check 
List for more information.
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[SHOW’S TOTAL] WAIT LIST REPORT > OPEN 
THE REPORT:
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Reports - Post-Show > AHA eScores [Arabian Horse Association]

AHA eSCORES [ARABIAN HORSE ASSOCIATION]: 
AHA eScores provides a *.dat file that is formatted to the Arabian Horse Association (AHA) specifications 
and is used to email show results to the AHA.

• Select  ❶Main Menu > ❷ Reports > 
❸ Post-Show > ❹ AHA eScores.

• The ❺ AHA eScores form opens.
• The text tells you how to use this form.
• Click ❻ OK to create the*.dat  file.
• If the ❼ Open e-mail program to send attachment box is checked, your email program will open with 

the file inserted as an attachment.

SECTION VIII. PROGRAM FUNCTIONS
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Reports - Post-Show > Breed Score Report - Individual 

BREED SCORE REPORT - INDIVIDUAL: 
The Breed Score Report - Individual is used to track scores by breed.

• Select  ❶Main Menu > ❷ Reports > 
❸ Post-Show > ❹ Breed Score -
Individual.

• The ❺ Breed Score Report form opens.
• Using the ❻ drop-down arrow or ❼ type-in 

box, select the breed for which you want a 
report.

• Click ❽ OK.

SECTION VIII. PROGRAM FUNCTIONS
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• The ❾ [Breed] Score 
Report opens.

• The report contains:
o ❿ Entry #
o ⓫ Rider name
o ⓬ Horse name
o ⓭ Test abbreviation
o ⓮ Breed
o ⓯ Class # & name
o ⓰ Status of rider
o ⓱ Score
o ⓲ Percent
o ⓳ Place

• The report is sorted by 
percentage.
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Reports - Post-Show > Equine Canada eScores

EQUINE CANADA eSCORES: 
Equine Canada eScores creates a *.dat file formatted to the Equine Canada (EC) specifications.  It is used to 
send results to the EC.

• Select  ❶Main Menu > ❷ Reports > 
❸ Post-Show > ❹ Equine Canada 
eScores.

• The ❺ Equine Canada eScores form opens.
• The form tells you how to use this report.
• Complete the required information by completing the boxes.
• If the ❻ Force Upload regardless of validation results box is checked (), unvalidated results will be 

uploaded.
• Click ❼ OK to create the*.dat  file.

SECTION VIII. PROGRAM FUNCTIONS
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Reports - Post-Show > Entry Balance

ENTRY BALANCE: 
The Entry Balance report is used to track the fees, payments and balance due, by rider name and entry #.

• Select  ❶Main Menu > ❷ Reports > 
❸ Post-Show > ❹ Entry Balance.

• The ❺ Entry Balance 
Report opens.

• The report contains:
o ❻ Rider name 

(alphabetical by last 
name)

o ❼ Entry #
o ❽ Entry Fees
o ❾ Stable Fees
o ❿ Other Fees
o ⓫ Total Fees
o ⓬ Payments
o ⓭ Balance Due

• The report is sorted by rider 
last name then by Entry #

SECTION VIII. PROGRAM FUNCTIONS
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Reports - Post-Show > Entry Invoices > By Entry # & By Rider
ENTRY INVOICES > BY ENTRY # & BY RIDER: 
The Entry Invoices report is used to create invoices for the entries.  It explains fees paid and explains a balance 
due or a credit due.  The applicable page(s) of the report can be mailed or emailed to the rider and/or provided 
in the rider packet(s).   Do not web-post the report as it has personal information.

• Select  ❶Main Menu > ❷ Reports > ❸
Post-Show > ❹ Entry Invoices.

• The ❺ Entry Invoice Report form opens.  
• Select ❻ By Entry # to have the reports 

sorted by Entry # (this example).
• Select ❼ By Rider to have the reports 

sorted by Rider last name.
• Click ❽ OK.

SECTION VIII. PROGRAM FUNCTIONS
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• The ❾ Entry Invoice report
(in this example, it is By Entry 
#) opens.

• The report contains:
o ❿ Show Name & Address
o ⓫ Entry #, Rider Name, 

Horse Name
o ⓬ Rider Address
o ⓭ Show Date(s)
o ⓮ Show Secretary Name,

Email, Phone
o ⓯ Class Entry Fees
o ⓰ Stable Fees
o ⓱ Other Fees
o ⓲ Payments / Credits
o ⓳ Balance Due or (Credit 

Due)
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Reports - Post-Show > Entry Payment
ENTRY PAYMENT: 
The Entry Payment report provides a lists of payments, by payment type (cash, check, credit card, etc.)

• Select  ❶Main Menu > ❷ Reports > 
❸ Post-Show > ❹ Entry Invoices.

• The ❺ Entry Payment 
report opens.

• The report contains:
o ❻ [Payment] Type 

(cash, check, CC, EE, 
etc.)

o ❼ Entry #
o ❽ Rider name
o ❾ Credit Card type
o ❿ CC# / CK #
o ⓫ Exp (CC expiration 

date)
o ⓬ Amount
o ⓭ Subtotal [for each 

Payment Type]
o ⓮ Total (bottom of 

last page)

SECTION VIII. PROGRAM FUNCTIONS

5

6 7 8 9 10 11 12

13

Last Page 14
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Reports - Post-Show > FEI eScores

FEI eSCORES: 
FEI eScores creates a *.dat file formatted to the FEI specifications.  It is used to send results to the FEI.  
Used for CDI shows and requires a FVD FEI/CDI license.

• Select  ❶Main Menu > ❷ Reports > 
❸ Post-Show > ❹ FEI eScores.

• If you do not have a FVD CDI/FEI license:
o A ❺ Fox Village Dressage form opens.
o The form advises you must have a FVD CDI/FEI license to use this function.
o Click ❻ OK.
o If you want a CDI/FEI license, contact FVD at helpdesk@foxvillage.com.

• If you have a FVD CDI/FEI license:
o A form opens similar to the other eScores forms.
o The form tells you how to use the FEI eScores form.

SECTION VIII. PROGRAM FUNCTIONS
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Reports - Post-Show > High Score

HIGH SCORE: 
The High Score report helps you determine the high score winners for your show.

• The ❺ High Score form 
opens.

• To view all show days 
ordered by score, click ❻
OK without using the Date or 
Order By drop-down arrows.

• The form lets you sort the 
report by highest score (no 
selections) Breed, Class, 
Level, [Rider] Status, and 
Test.

• Select  ❶Main Menu > ❷ Reports > ❸
Post-Show > ❹ High Score.

SECTION VIII. PROGRAM FUNCTIONS

1

2

3

45

• The ❾ High Score report
opens, sorted by the 
horse/rider scores with the 
highest score at the top (in 
this example).

• The report contains:
o ❿ Entry #
o ⓫ Rider name
o ⓬ Horse name
o ⓭ Test abbreviation
o ⓮ Breed
o ⓯ Class [# and Name]
o ⓰ Status of rider
o ⓱ Score [Points]
o ⓲ Score [Percent]
o ⓳ Place

• See HIGH SCORE REPORTS
for further information.

9
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Reports - Post-Show > Income Balance
INCOME BALANCE: 
The Income Balance report shows the sources of non-entry show income (vendor fees, program sales, 
donations, etc.) and balance due.  For an income source to be included in this report, it must have been 
entered using the Income feature of FVD (see Show Office > Income [and Invoice]).

• Select  ❶Main Menu > ❷ Reports > 
❸ Post-Show > ❹ Income Balance.

SECTION VIII. PROGRAM FUNCTIONS

• The ❺ Income Balance report
opens.

• The report includes:
o ❻ Payer
o ❼ Date
o ❽ Invoice #
o ❾ Balance Due
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Reports - Post-Show > Non-members

NON-MEMBERS: 
USEF, USDF, FEI and other organizations have strict membership requirements for riders, owners and trainers 
who participate in licensed / recognized shows in non-exempt classes/status.  This report helps you track non-
members.

• Select  ❶Main Menu > ❷ Reports > ❸
Post-Show > ❹ Non-members.

• The ❾ Non-members report
opens, USEF in this example.

• The report contains:
o ❿ Name
o ⓫ Total Number of USEF 

Non-members
• Repeat for USDF, FEI, and Local 

organizations (L1, L2, L3).

• The Show Secretary should 
contact these individuals prior 
to the show and/or ensure they 
have paid their non-member fee 
($30 for USEF, $25 for USDF).

• See USEF POST COMPETITION 
REPORT and USDF REPORT OF 
FEES for use of this report.

• The ❺ Non-member report form opens.
• Select the ❻ organization for which you 

want to track non-members.  In this 
example, we selected ❼ USEF.

• Click ❽ OK.

SECTION VIII. PROGRAM FUNCTIONS

5

6
7

8

9

NOTE: 
• A name is listed on this report if ⓬ SP (USEF) or ⓭ Non-

Member (USDF, FEI, L1, L2, L3) was selected when the 
person’s membership information was entered (see Owner > 
USEF, Owner > USDF, Rider and Trainer and Coach).  

• For people on these reports, ⓮ USEF Show Pass fee and/or 
the ⓯ USDF Non-Member fee must be collected and 
submitted to USEF or USDF.  Check the Entries > Other Fees 
for their entries to ensure you collected the fees!
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Reports - Post-Show > Owner Labels
OWNER LABELS: 
Owner Labels creates 1” x 2-5/8” mailing labels for horse owners.  The labels may be used to snail mail 
prizes, tax documents, and other post-show documents.

• Select  ❶Main Menu > ❷ Reports > 
❸ Post-Show > ❹ Owner Labels.

• The ❺ Owner Labels 
report opens.

• For each owner, the report 
contains:
o ❻ Owner Name
o ❼ Owner Street 

Address
o ❽ Owner City, ST, 

ZipCode and Country

• See PRINT LABELS AND 
INDEX CARDS for the 
procedure to print labels 
and index cards and Default 
& Recommended Settings > 
1” x 2-5/8” Labels for 
specifics on this label.

SECTION VIII. PROGRAM FUNCTIONS
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Reports - Post-Show > Owner’s Tax Information Report

OWNER’S TAX INFORMATION REPORT: 
The Owner’s Tax Information Report provides consolidated owner information needed for tax reporting for 
awards with monetary value.

• Select  ❶Main Menu > ❷ Reports > 
❸ Post-Show > ❹ Owner’s Tax 
Information Report.

• The ❺ Owner Tax 
Information Report opens.

• The report contains:
o ❻ Horse name
o ❼ Owner Name & 

Address
o ❽ TIN (Tax Identification 

Number) (see Owner for 
procedures on entering 
this number)

o ❾ Citizenship (see 
Owner for procedures on 
entering the citizenship)

• The report is alphabetical, 
using the horse name.  

SECTION VIII. PROGRAM FUNCTIONS

5
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Reports - Post-Show > Payment Type Summary

PAYMENT TYPE SUMMARY: 
The Payment Type Summary is used to determine the entry payment amounts, by type (Cash, Check, Credit 
Card, etc.).

• Select  ❶Main Menu > ❷ Reports > 
❸ Post-Show > ❹ Payment Type 
Summary.

• The ❺ Payment Type 
Summary form opens.

• Using the ❻ Payment 
Type drop-down arrow, 
select the payment type.  In 
this example, we Check was 
selected.

SECTION VIII. PROGRAM FUNCTIONS

• The ❼ Payment Type Summary form now contains the check 
data:
o ❽ Rider [Name]
o ❾ Entry #
o ❿ Amount
o ⓫ Totals

• Repeat to select another payment type.
• Click the ⓬ Print button to print.
• Click ⓭ Close to close the form and return to the Main Menu.
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Reports - Post-Show > Profit(Loss) Statement

PROFIT(LOSS) STATEMENT: 
The Profit(Loss) Statement tallies your revenue (income) and expenses and provides your net profit(loss).

• Select  ❶Main Menu > ❷ Reports > 
❸ Post-Show > ❹ Profit(Loss) 
Statement.

• The ❺ Profit(Loss) 
Statement report opens.

• The report has the following:
o ❻ Revenue [= Income]
▪ Itemized, based on 

income categories for 
the show

▪ Income is entered in 
Stabling > Fees, Other 
Fees, Payments, and 
Show Office > Income.

o ❼ Gross Income = Total 
income for the show

o ❽ Expenses
▪ Itemized, based on 

expense categories for 
the show) (in this 
example, show 
expenses were not 
entered as they were 
tracked by the 
organization’s 
treasurer)

▪ Expenses are entered 
in Show Office > 
Expenses.

o ❾ Total Expenses = Total 
expenses for the show

o ❿ Net Profit (Loss) = 
Income - Expenses

SECTION VIII. PROGRAM FUNCTIONS
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Reports - Post-Show > Ride Detail Summary

RIDE DETAIL SUMMARY: 
The Ride Detail Summary displays the status of each Level / Test #, organized by Test Group.

• Select  ❶Main Menu > ❷ Reports > 
❸ Post-Show > ❹ Ride Detail 
Summary.

SECTION VIII. PROGRAM FUNCTIONS

1

2

3

4

5

6 7 8 9

• The ❺ Ride Detail Summary 
report opens.

• The report has the following:
o ❻ Test Name 
o ❼ Total
o ❽ Completed
o ❾ Eliminated
o ❿ Retired
o ⓫Withdres
o ⓬ Vet Out
o ⓭ Scratch
o ⓮ Subbed Out
o ⓯ No Show
o ⓰ HC
o ⓱ Test Group

10 11 12 13 14 15 16
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Reports - Post-Show > Rider LabelsRIDER LABELS: 
The Rider Labels report creates 1” x 2-5/8” mailing labels for all riders in the show. Use this report to snail 
mail tests, ribbons, cash prizes, etc. to the riders.

• Select  ❶Main Menu > ❷ Reports > 
❸ Post-Show > ❹ Rider Labels.

SECTION VIII. PROGRAM FUNCTIONS

1

2

3

4

• The ❺ Rider Labels report 
opens.

• The report contains:
o ❻ Rider FirstName 

LastName
o ❼ Rider Street Address
o ❽ Rider City, State, Zip 

Code, Country

• See PRINT LABELS AND INDEX 
CARDS for the procedure to 
print labels and index cards 
and Default & Recommended 
Settings > 1” x 2-5/8” Labels
for specifics on this label.

Street Address
City, State, Zip Code
USA

Street Address
City, State, Zip Code
USA

Street Address
City, State, Zip Code
USA

Street Address
City, State, Zip Code
USA

Street Address
City, State, Zip Code
USA

Street Address
City, State, Zip Code
USA

Street Address
City, State, Zip Code
USA

Street Address
City, State, Zip Code
USA

Street Address
City, State, Zip Code
USA

Street Address
City, State, Zip Code
USA

Street Address
City, State, Zip Code
USA

Street Address
City, State, Zip Code
USA

Street Address
City, State, Zip Code
USA

Street Address
City, State, Zip Code
USA

Street Address
City, State, Zip Code
USA

Street Address
City, State, Zip Code
USA

Street Address
City, State, Zip Code
USA

Street Address
City, State, Zip Code
USA

Street Address
City, State, Zip Code
USA

Street Address
City, State, Zip Code
USA

Street Address
City, State, Zip Code
USA

Street Address
City, State, Zip Code
USA

Street Address
City, State, Zip Code
USA

Street Address
City, State, Zip Code
USA

Street Address
City, State, Zip Code
USA

Street Address
City, State, Zip Code
USA

Street Address
City, State, Zip Code
USA

Street Address
City, State, Zip Code
USA

Street Address
City, State, Zip Code
USA

Street Address
City, State, Zip Code
USA
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Reports - Post-Show > Rider Score - Individual

RIDER SCORE - INDIVIDUAL: 
The Rider Score - Individual report provides the scores, percentages, and placings for each rider.

• Select  ❶Main Menu > ❷ Reports > 
❸ Post-Show > ❹ Rider Score -
Individual.

1

2

3

4

SECTION VIII. PROGRAM FUNCTIONS

• The ❺ Rider Score form opens.
• Using the ❻ Rider drop-down arrow or 

type-in box, select the name of the rider 
whose scores you want to report.

• Click ❼ OK.

5

7

6

• The ❽ Rider Score report
opens.

• The report contains:
o ❾ Entry #
o ❿ Rider name
o ⓫ Horse name
o ⓬ Test abbreviation
o ⓭ Breed
o ⓮ Class [# and Name]
o ⓯ Status of rider
o ⓰ Score (Final Points)
o ⓱ Percent (Final Percent)
o ⓲ Place

8

9 10 11 12 13 14 15 16 17 18
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• The ❺ Score - Final form opens.
• Under ❻ Scoring Style, you can select one 

of three options.  Select ❼ Standard and 
Breed.

• If this is a CDI show, also select ❽ CDI 
Format.

• Click ❾ OK.

719

Reports - Post-Show > Score - Final > Standard and Breed

SCORE - FINAL > STANDARD AND BREED: 
The Score - Final > Standard and Breed report provides detailed results for each applicable class.  

• Select  ❶Main Menu > ❷ Reports > ❸
Post-Show > ❹ Score - Final.

SECTION VIII. PROGRAM FUNCTIONS

1
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45
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NOTE: Previously this report was emailed to 
USEF/USDF as a PDF file.  This requirement has 
been dropped as the *.dat file is now emailed.

• The ❿ Score - Final report opens.
• For each class, the report contains:
o ⓫ Show Name
o ⓬ Final Competition Class designation
o ⓭ Show Date(s)
o ⓮ Show Secretary name and phone
o ⓯ Class Prize
o ⓰ Class # and Name
o ⓱ Show USEF # and USDF #
o ⓲ Judge names(s) and positions
o ⓳ Detailed class results (Place, Total score, Percent, 

Qualifying?, Horse/ USEF#/USDF#/Other#, Rider#/USDF#/ 
Other#, Owner/U SEF#/USDF#/Other#)

o ⓴ Horse/Rider/Owner Names, USEF & USDF Numbers
• Repeat for ❻ other Scoring Styles.
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Reports - Post-Show > Score Reports - Media > Entire Show

SCORE REPORTS - MEDIA > ENTIRE SHOW: 
Score Reports - Media provides show results for the media. 

• Select  ❶Main Menu > ❷ Reports > 
❸ Post-Show > ❹ Score Reports -
Media.

SECTION VIII. PROGRAM FUNCTIONS

• The ❺Media Scoring 
form opens.

• The default report is 
❻ Entire Show

• Click ❼ OK.

1

2

3

4
5

6

7

• The ❽Media Scoring report opens.
• The report contains:
o ❾ Class Name
o ❿ Entry #
o ⓫ Rider Name
o ⓬ Horse Name
o ⓭ Test Name
o ⓮ Rider Status
o ⓯ Final Points
o ⓰ Final Percent
o ⓱ Place

• See MEDIA REPORTS for more 
options.

8
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Reports - Post-Show > Show Fee Summary

SHOW FEE SUMMARY: 
Show Fee Summary lets you look at the source of income for each income item (show fee).

• The ❺ Show Fee Summary form opens.

• Select  ❶Main Menu > ❷ Reports > 
❸ Post-Show > ❹ Show Fee Summary.

SECTION VIII. PROGRAM FUNCTIONS

Continued on next page…
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Reports - Post-Show > Show Fee Summary, Cont’d.

• The ❽ Show Fee Summary for the selected fee 
opens.

• The report contains:
o ❾ Show Fee category
o ❿ Rider name
o ⓫ Entry #
o ⓬ Qty (quantity)
o ⓭ Rate (cost per item)
o ⓮ Extension (Qty x Rate)
o ⓯ Total Qty (total number of items sold)
o ⓰ Total Extension (total  fees paid for this 

category)

• The report is sorted by rider last name.

• Click ⓱ Print to print the report.
• Click ⓲ Close Print Preview to close the report 

and return to the Main Menu.

SECTION VIII. PROGRAM FUNCTIONS

• Use the ❻ Show Fee drop-down arrow to select 
the Show Fee for which you desire information.  

• The show fees are entered in Show Fees; the 
Show Fee list contains the system fees and the 
custom fees you entered.  

• In this example, we selected ❼ Office Fee $30. 
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Reports - Post-Show > Total Qualifying Rides Down Centerline

TOTAL QUALIFYING RIDES DOWN 
CENTERLINE: 
The Total Qualifying Rides Down Centerline 
report gives you the number of GAIG Q rides 
completed for each Q class (for the riders 
who paid the GAIG Q fee, the report shows 
the number of rides that were actually 
completed).  See IMPORTANT NOTE below.

• Select  ❶Main Menu > ❷ Reports > 
❸ Post-Show > ❹ Total Qualifying 
Rides Down Centerline Report.

• The ❺ Total Qualifying Rides 
Down Centerline Report opens.

• The report contains:
o ❻ Class #
o ❼ Class Name
o ❽ Test
o ❾ # of Rides by type of 

qualify (rider status)
o ❿ Type of Qualify
o ⓫ Total Number of 

Qualifying Rides per show 
(on last page)

SECTION VIII. PROGRAM FUNCTIONS

IMPORTANT NOTE: 
• The report has the RIDES completed, not 

the actual GAIG Q fees PAID.
• In the past, for the GAIG Q fee collected, 

shows only paid USDF the fee for rides 
that were actually completed.  

• Now shows must pay the GAIG Q fee to 
USDF whether or not the ride was 
completed, unless the fee is refunded to 
the rider.  

• Therefore, DO NOT USE THIS REPORT to 
determine the amount of money owed to 
USDF.  Instead, use the USDF Qualifying 
Ride Fees Report.

5
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Reports - Post-Show > Total Rides Down Centerline

TOTAL RIDES DOWN CENTERLINE: 
The Total Rides Down Centerline report
gives you the number of all completed rides
by class, and the total number of rides of 
each test in the class.  

• Select  ❶Main Menu > ❷ Reports > 
❸ Post-Show > ❹ Total Rides Down 
Centerline.

• The ❺ Total Rides Down 
Centerline Report opens.

• The report contains:
o ❻ Class #
o ❼ Class Name
o ❽ Test
o ❾ # of Riders
o ❿ Total Time
o ⓫ Day
o ⓬ Total Number of Rides in 

the show

SECTION VIII. PROGRAM FUNCTIONS
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Reports - Post-Show > USEF [and USDF] eScores 

USEF [AND USDF] eSCORES: 
USEF [and USDF] eScores is used to create a *.dat file that you email to USEF and USDF to electronically 
submit show results.

• Select  ❶Main Menu > ❷ Reports > 
❸ Post-Show > ❹ USEF eScores.

• See DATA FILE FOR USEF AND USDF for detailed use of the *.dat file.

SECTION VIII. PROGRAM FUNCTIONS

• The ❺ USEF eScores form opens.
• By default, the ❻ Open e-mail program to send 

attachments check box is checked.
• If you want to first save the FVD  *.dat file, then 

email it to USEF and USDF, click the check in the 
to ❼ remove the check.

• Click ❽ OK.
• The show’s *.dat file is saved in your C:  Users 

[UserName]  Documents  FVD folder.
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VERY IMPORTANT NOTE:  When you create the USEF (and USDF) eScores (*.dat) file, the data is automatically 
(1) uploaded to the FVD site for updating and (2) synchronized with the Competitor Tent iOS app (click here).  
If any of your competitors have registered with Competitor Tent, they will be contacted by Competitor Tent.

https://competitortent.com/
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Reports - Post-Show > USDF Qualifying Ride Fees

SECTION VIII. PROGRAM FUNCTIONS

USDF QUALIFYING RIDE FEES: 
The USDF Qualifying Ride Fees Report 
shows, for each GAIG Q test, the number of 
GAIG Q fees paid and not refunded (for a 
scratched ride, etc.) and therefore must be 
paid to USDF.

• Select  ❶Main Menu > ❷ Reports > 
❸ Post-Show > ❹ USDF Qualifying 
Ride Fees.

• The ❺ USDF Qualifying Ride 
Fees report opens.  

• The report contains:
o ❻ Test
o ❼ # of Rides
o ❽ Q Fee
o ❾ Total Q Fee for each Q 

test
o ❿ Total of Qualifying Ride 

Fees

• See USDF REPORT OF FEES for 
information on the use of this 
report.
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Reports - Post-Show > USEF/USDF Post Competition

USEF/USDF POST COMPETITION:  
The FVD USEF/USDF Post Competition 
report is used after the show to obtain 
information needed for post-competition 
results submission, and payment of fees, to 
USEF. 

• Select  ❶Main Menu > ❷ Reports > 
❸ Post-Show > ❹ USEF Post 
Competition.

• The FVD ❺ USEF Post 
Competition Report opens.

• The report provides data 
required by USEF on the USEF 
Post Competition Report Form.

• See USEF POST COMPETITION 
REPORT FORM for detailed 
information.

SECTION VIII. PROGRAM FUNCTIONS

5
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SECTION VIII. PROGRAM FUNCTIONS

See the separate FVD DSHB User Manual
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SECTION VIII. PROGRAM FUNCTIONS
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FVD Online Tools > Register Show

REGISTER SHOW: 
Register Show registers your show with FVD, which allows you to upload confirmations, ride times, and 
results to the FVD online services.  It also allows you to use the Equestrian Entries Integrated Online Tools.

• See REGISTER A SHOW WITH FVD for procedures. 

SECTION VIII. PROGRAM FUNCTIONS



Fox Village Dressage User Manual – 2021 Update 1.0.5. helpdesk@foxvillage.com                 www.foxvillage.com731

FVD Online Tools > Upload Confirmations

UPLOAD CONFIRMATIONS: 
Upload Confirmations is the process by which you can upload your entry confirmations to the FVD online 
services.  The rider/handler, owner, trainer, and coach are then automatically emailed a link to their online 
entry information so they can check and confirm the entry data.

• See FVD Upload Confirmations for procedures. 

SECTION VIII. PROGRAM FUNCTIONS
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FVD Online Tools > Upload Ride Times

UPLOAD RIDE TIMES: 
Upload Ride Times is the process by which you can upload your ride times to the FVD online services.  
Anyone can log onto the FVD online services to view the ride times (click here).

• See Upload Ride Times to the FVD Web Site for procedures. 

SECTION VIII. PROGRAM FUNCTIONS

http://www.foxvillage.com/fvdshowresults/(0oefw345bx1c0i550ecu3h55)/Show.aspx
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FVD Online Tools > Upload Results

UPLOAD RESULTS: 
Upload Results is the process by which you can upload your show results to the FVD online services.  
Anyone can log onto the FVD online services to view the results (click here).  The results can be uploaded 
“real time” every five minutes.

• See UPLOAD SHOW RESULTS TO THE WEB for procedures. 

SECTION VIII. PROGRAM FUNCTIONS

http://www.foxvillage.com/fvdshowresults/(0oefw345bx1c0i550ecu3h55)/Show.aspx
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SECTION VIII. PROGRAM FUNCTIONS
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EE Integrated Online Tools > Publish Show

PUBLISH SHOW: 
Publish Show is the process by which you publish (upload) your show information to EE so riders can enter 
your show online.  If selected by the entrant, entries through EE can be imported and integrated into your 
FVD show data – eliminates lots of typing!

• In this manual, see PUBLISH A SHOW WITH EE for procedures.
• Click here to see separate EE instructions.

SECTION VIII. PROGRAM FUNCTIONS

https://www.equestrianentries.com/public/bluesteel/img/pdf/Part%20III%20Publishing.pdf
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EE Integrated Online Tools > Import Online Entries

IMPORT ONLINE ENTRIES: 
Import Online Entries is the process by which you import, into FVD, your show entries that have been 
entered through Equestrian Entries (EE).  

• In this manual, see EE ONLINE ENTRIES for procedures.
• Click here to see separate EE instructions.

SECTION VIII. PROGRAM FUNCTIONS

https://www.equestrianentries.com/public/bluesteel/img/pdf/Part%20IV%20Entry%20Import.pdf
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EE Integrated Online Tools > Close Show

CLOSE SHOW: 
Close Show is the process by which you close your show so no more entries will be accepted through EE.  

• See CLOSE YOUR SHOW IN EQUESTRIAN ENTRIES for procedures.

SECTION VIII. PROGRAM FUNCTIONS
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SECTION VIII. PROGRAM FUNCTIONS
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Print Preview > Introduction

739

SECTION VIII. PROGRAM FUNCTIONS

• Every time you open a report, the ❶ Print Preview ribbon opens with five groups of tools 
for manipulating the reports:
❷ Print 

❸ Print - Used to print a report.
❹ Page Setup

❺ Portrait – Creates a report in a portrait (vertical) page orientation.
❻ Landscape – Creates a report in a landscape (horizontal) page orientation.
❼ Size – Lets you change the size of paper on which the report is presented and printed.
❽ Page Setup – Lets you adjust the margins, page setting, and columns of the report.

❾ View
❿ One Page – Gives one page of the report on a piece of paper.
⓫ Two Pages – Gives two pages of the report on a piece of paper.
⓬ More Pages – Gives more than two pages of the report on a piece of paper.

⓭ Export
⓮ Word – Exports (saves) the FVD report as a Microsoft Word file.
⓯ Excel – Exports (saves) the FVD report as a Microsoft Excel file.
⓰ PDF or XPS – Exports (saves) the FVD report as a PDF or XPS file.

⓱ Close Preview
⓲ Close Print Preview – Used to close the report.

• We will look at each of these features, using the Day Sheets (Standard) Report.

1
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INTRODUCTION:
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Print Preview > Print > Print [a Report] > All or Pages From:___ To:___

• Select ❶ Print Preview > ❷ Print > ❸Print.

SECTION VIII. PROGRAM FUNCTIONS

• The ❹ Print form opens.

• To print all pages: 
o For ❺ Print Range, click the ❻ All radial 

button.
o Click ❼ OK.
o All the pages will print.

• To print one or a range of the pages in the report: 
o For ❽ Print Range / ❾ Pages, enter the first 

page you want to print in the ❿ From: box 
and the last page you want to print in the ⓫
To: box.  

o Click ⓬ OK.  
o The selected pages will print.

NOTE: The printer forms will vary depending on your brand and model 
of printer.  This example is for a Brother MFC-9970CDW printer.

7

4

5
6

4

8

9
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PRINT > PRINT [A REPORT] > ALL OR PAGES FROM:___ TO:___:
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Print Preview > Print > Print [a Report] > [Printer] Properties

• Select ❶ Print Preview > ❷ Print > ❸Print.

SECTION VIII. PROGRAM FUNCTIONS

• The ❹ Print form opens.

• To adjust printer settings, click ❺ Properties. 

• Your printer’s ❻ Properties form will open.  
Each printer has different properties.   The 
example is for a Brother printer.

• Adjust settings according to your printer’s 
manual.

• Click ❼ OK to return to the ❹ Print form.

NOTE: The printer forms will vary depending on 
your brand and model of printer.  This example is 
for a Brother MFC-9970CDW printer.
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PRINT > PRINT [A REPORT] > [PRINTER] PROPERTIES:
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Print Preview > Page Setup > Portrait, Landscape

• If you want to change a report from Landscape (horizontal) page orientation to Portrait (vertical) page 
orientation, select ❶ Print Preview > ❹ Page Setup > ❺Portrait or ❻ Landscape

SECTION VIII. PROGRAM FUNCTIONS

• The report changes from landscape to portrait page orientation.  When you print the report, it will print 
with the new orientation.

NOTE: Most FVD reports are designed for the default orientation.  If you change the orientation, you may 
lose some information, as seen in the above portrait orientation where the judge name has been lost.

1

4

5 6

Landscape Page OrientationPortrait Page Orientation

PAGE SETUP > PORTRAIT, LANDSCAPE:
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Print Preview > Page Setup > Size

• If you want to change the paper size, select ❶ Print Preview > ❹ Page Setup > the ❼ Size drop-down 
arrow.

SECTION VIII. PROGRAM FUNCTIONS

• The ❺ size drop-down list opens.  
• Click on another size of paper.  In this example, we will select ❻ Legal.

• The report is now displayed as on legal sized paper. When you print the report, it will 
print with the new paper size.6

5

1

4

7

Letter Size Legal Size

PAGE SETUP > SIZE:
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744

Print Preview > Page Setup > Page Setup

• To further change the page features, select ❶ Print 
Preview > ❹ Page Setup > ❽ Page Setup.

SECTION VIII. PROGRAM FUNCTIONS

• The ❹ Page Setup form opens.

• On the ❺ Print Options tab, you can change:
o ❻ Margins by editing the numbers in each box.
o To print data but not logos, etc., click the ❼ check 

box.

• On the ❽ Page tab, you can change:
o ❾ Orientation (Portrait / Landscape)
o ❿ Paper / Size
o ⓫ Paper / Source (which paper tray the 

printer will use)
o ⓬ Printer

• On the ⓭ Columns tab, you can change:
o ⓮ Grid Settings
o ⓯ Column Size
o ⓰ Column Layout 
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PAGE SETUP > PAGE SETUP:
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Print Preview > View > Two Pages

• To change from one page per screen to two pages per screen, select ❶ Print Preview > ❾ View > click 
⓫ Two Pages.

SECTION VIII. PROGRAM FUNCTIONS

NOTE: View does not change the number of pages printed on a sheet of paper.  
That is accomplished through the printer properties (see your printer’s manual).

1

9

11

View > Two PagesView > One Page

VIEW > TWO PAGES:
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Print Preview > View > More Pages

• To change from one page per screen to more pages per screen, select ❶ Print Preview > ❾ View > ⓬
More Pages drop-down arrow.

• Choose Four Pages, Eight Pages, or Twelve Pages.  The example is four pages.

SECTION VIII. PROGRAM FUNCTIONS

NOTE: View does not change the number of pages printed on a sheet of paper.  
That is accomplished through the printer properties (see your printer’s manual).

View > One Page View > Four Pages

1

9

12 14 15 16

VIEW > MORE PAGES:
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Print Preview > Export > Word > Save Options

• The ❹ Export - RTF File form opens.
• The default destination folder is your ❺ Documents folder with a file name indicative of the report 

being exported (in this example it is rptDaySheetsStd.rtf).  
• Click ❻ Browse… to change the destination folder and/or the file name.
• If you want to open the destination file after the export operation is complete, click the ❼ check box.
• Click ❽ OK.

SECTION VIII. PROGRAM FUNCTIONS

• To export (save) a report as a Microsoft Word file (actually, as a *.rtf file that can be used and saved in 
Word), select ❶ Print Preview > ⓭ Export > ⓮ Word.
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iew > More Pages

EXPORT > WORD > SAVE OPTIONS:
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Print Preview > Export > Word > Save File Opens

SECTION VIII. PROGRAM FUNCTIONS

• The file is saved and opens if the check box was checked.

1

13

14

EXPORT > WORD > SAVE FILE OPENS:
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Print Preview > Export > Excel > Save Options

• The ❹ Export – Excel Spreadsheet form opens.
• The default destination folder is your ❺ Documents folder with a file name indicative of the report 

being exported (in this example it is rptDaySheetsStd.xls).  
• Click ❻ Browse… to change the destination folder and/or the file name.
• Click the ❼ File format drop-down arrow to select the version of Excel.
• If you want to open the destination file after the export operation is complete, click the ❽ check box.
• Click ❾ OK.

SECTION VIII. PROGRAM FUNCTIONS

• To export (save) a report as a Microsoft Excel file, select ❶ Print Preview > ⓭ Export > ⓯ Excel.
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EXPORT > EXCEL > SAVE OPTIONS:
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Print Preview > Export > Excel > Saved File Opens

SECTION VIII. PROGRAM FUNCTIONS

• The file is saved and opens if the check box was checked.

1

13

15

EXPORT > EXCEL > SAVED FILE OPENS:
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Print Preview > Export > PDF or XPS > Save Options

• The ❹ Publish as PDF or XPS form opens.
• The default destination folder is your ❺ Documents folder with a file name indicative of the report 

being exported (in this example it is ❻ rptDaySheetsStd.pdf.  
o If a different folder destination is desired, navigate to that folder.  
o If a different file name is desired, change the file name in the ❼ File name box.

SECTION VIII. PROGRAM FUNCTIONS

• To export (publish, save) a report as a PSD or XLS (Microsoft version of PDF) file, select ❶ Print Preview 
> ⓭ Export > ⓰ PDF or XPS.

• If desired, select other options such as:
o ❽ Open file after publishing – check the box if you want to open the PDF file after it is exported 

(published/ saved).
o ❾ Optimize for – Standard creates a higher quality but larger file; Minimum creates a lesser quality 

but smaller file.  Click the radial button you desire.
o ❿ Options – lets you select a page range and other PDF options.
o ⓫ Tools – Used to map a network drive.

• Click ⓬ Publish.
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EXPORT > PDF OR XPS > SAVE OPTIONS:
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Print Preview > Export > PDF or XPS > Saved File Opens

SECTION VIII. PROGRAM FUNCTIONS

• The PDF file is saved and opens if the check box was checked.

1
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16

EXPORT > PDF OR XPS > SAVED FILE OPENS:
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Print Preview > Close Preview > Close Print Preview

• The report is closed and you are returned to the Main Menu.

SECTION VIII. PROGRAM FUNCTIONS

• To close a report, on the ❶ Print Preview tab, ⓱ Close Preview group, click ⓲ Close Print Preview.

1

17

18

CLOSE PREVIEW > CLOSE PRINT PREVIEW:
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SECTION IX. TIPS & TRICKS
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Entry Review and Management Suggestions – Paper Entry Packets > Materials

SECTION IX. TIPS & TRICKS

• Each show secretary develops their own method to review and manage their paper entries.
• The following demonstrates my paper entries method and is presented in hopes it may assist you.

• Materials:
o ❶ 9” x 12” manilla envelopes (for entry packets)
o ❷ 9” x 12” white envelopes (for rider packets)
o ❸ 4.25” x 5.5” white labels (for entry packets)
o ❹ Two hanging file boxes and two colors of hanging files (one for entry packets, one for rider 

packets)
o ❺ Two sets of 1/5 cut hanging file tabs labeled A-XYZ.  Put tabs on left side of files.
o ❻ Paper clips.
o ❼ 2” x 1.5” post-it note pads.
o ❽ Pencils with erasers.

MATERIALS:

1 2 3

4

5 6
7

8

5

NOTE:  This paper entry packets method is not 
an official FVD product.  It is a method 
developed and used by the FVD manual author.  
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• In Excel (or Word or another program of your 
choice), create a ❶ table that includes all the 
screening information needed for your show, 
similar to the table on this page.

• After designing the table, take a screen capture 
and paste it into a ❷ PowerPoint slide (set to 
8.5” x 11” size) (or another program of your 
choice).

• Make three copies of the table screen capture 
(you now have four copies) and arrange all four 
copies as in the ❷ diagram.

• Adjust the sizes and placing of the screen 
captures so they print on one sheet of 4.25” x 
5.5” labels (see Supplies to Have on Hand for 
sources). 

• Print the labels and affix to the ❸ top left of 
each entry packet before you start to screen it.

• As you screen an entry, using a pencil, record the 
status of each item on the label.

757

Entry Review and Management Suggestions – Paper Entry Packets > 
Create Custom Entry Packet Labels

SECTION IX. TIPS & TRICKS

CREATE CUSTOM ENTRY PACKET LABELS:

2

1

NOTE 1:  FVD has multiple reports that list 
entry deficiencies; however, in my hands it is 
easier to use this entry packet label, with 
pencil annotations, to quickly update and refer 
to the status of an entry.

NOTE 2:  Whenever you update a paper entry, 
ensure you annotate the change in FVD.

3
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• Use a PENCIL so it is easy to make changes as the entry is updated.
• ❶ RIDER LAST: Enter the rider’s last name.
• ❷ RIDER FIRST: Enter the rider’s first name.
• ❸ HORSE: Enter the horse’s name.
• ❹ BRIDLE #: Enter the entry’s bridle number.
• ❺ 1 2 B: For two shows in one weekend:

o 1: Entry is only for the first show (usually Saturday).
o 2: Entry is only for the second show day (usually Sunday)
o B: Entry is for both shows (usually Saturday and Sunday)

• ❻ AA  JYR  OPEN:
o AA: Circle this is the rider is an Adult Amateur (based on USEF card)
o JYR: Circle this if the rider is a Junior Rider or a Young Rider (based on USDF card)
o OPEN: Circle this if the rider is a Professional or a USEF non-member (based on USEF card or no card)

o ❼ OK column: For each item, put a check (✓) in this column if all requirements have been satisfied.
o ❽ FIX column: For each item, put an X in this column if all the requirements have NOT been satisfied.  

This will let you quickly ascertain an entry’s deficiencies.  When the item is correct, the X is erased and 
the OK column is checked (✓).

758

Entry Review and Management Suggestions – Paper Entry Packets > 
Use of Custom Entry Packet Labels

SECTION IX. TIPS & TRICKS

USE OF CUSTOM ENTRY PACKET LABELS:

Continued on next page…

1
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• ❾ Rider, Owner, or Trainer USEF Member:
o ACT: Circle if the person is a current USEF Active Member (Competing Member).
o NM$: Circle if the person is not a current USEF member but has paid the USEF Show Pass (Non-

Member) fee.
o EX: Circle if the person is EXempt from USEF membership.
o NO: Circle if the person is NOT a USEF member, is NOT exempt, and has NOT paid the NM fee.  Put an 

X in the FIX box.
• ❿ Rider, Owner, or Trainer USDF Member:

o PM: Circle if the person is a USDF Participating Member.
o GM: Circle if the person is a USDG Group Member.
o NM$: Circle if the person is NOT a USDF member but has paid the USDF Non-Member fee.
o EX: Circle if the person is EXempt from USDF membership.
o NO: Circle if the person is NOT a USDF member, is NOT exempt, and has not paid the NM fee.  Put an 

X in the FIX box.
o ⓫ Rider, Owner, Trainer, Coach SafeSport:

o YES: Circle if the person is an adult with current SafeSport training.
o NA: Circle if the person is not subject to SafeSport training (e: under age 18, USEF non-member).
o NO: Circle if the person is subject to SafeSport training but does not have (current) training.

759

Entry Review and Management Suggestions – Paper Entry Packets > 
Use of Custom Entry Packet Labels, cont’d.

SECTION IX. TIPS & TRICKS

Continued on next page…
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• ⓬ Horse USEF Recording:
o LIFE: Circle if the horse has USEF LIFE recording.
o ANN: Circle if the horse has current USEF ANNual recording.
o HID: Circle if the horse has USEF or USDF Horse IDentification number.
o EX: Circle if the horse is EXempt from USEF recording.
o NO: Circle if the horse is not USEF recorded or USDF registered. Put an X in the FIX box.

• ⓭ Horse USDF Registration:
o LIFE: Circle if the horse is USDF LIFE registered.
o HID: Circle if the horse has a USDF Horse IDentification number.
o EX: Circle if the horse is EXempt from USDF registration.
o NO: Circle if the horse is not USDF registered. Put an X in the FIX box.

• ⓮ GAIG Q:
o YES OK: Circle if the entrant requested GAIG Q for one or more rides and meets Q requirements.
o YES FIX: Circle if the entrant requested GAIG Q for one or more rides and does not meet Q 

requirements. Put an X in the FIX box.
o NO: Circle if the entrant is riding GAIG Q tests but did not request GAIG Q.
o NA: Circle if the entrant is not riding any GAIG Q tests.
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Entry Review and Management Suggestions – Paper Entry Packets > 
Use of Custom Entry Packet Labels, cont’d.

SECTION IX. TIPS & TRICKS

Continued on next page…

12
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• ⓳ Tack Stall?  (Your table will have 
nomenclature for your tack stall types.  
Examples are shown here.)
o T-FS: Circle if the entrant request a tack 

stall for Friday and Saturday.
o T-SS: Circle if the entrant requested a tack 

stall Saturday and Sunday.
o T-FSS: Circle if the entrant request a tack 

stall Friday, Saturday, and Sunday.
o NO: Circle if the entrant did not request a 

tack stall.

761

Entry Review and Management Suggestions – Paper Entry Packets > 
Use of Custom Entry Packet Labels, cont’d.

SECTION IX. TIPS & TRICKS

Continued on next page…

15

16
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18

19

• ⓯ Complete Payment:
o YES: Circle if the entry has been paid in full.
o NO: Circle if the entry has NOT been paid in full. Put an X in the FIX box.

• ⓰ Owe $__________: On the line, enter amount owed to the show by the entrant.
o OWE: Circle if the amount is owed.  Put an X in the FIX box.
o PD: Circle if the amount has been paid by the entrant.  When the payment is received, erase the OWE, 

erase the X in the FIX box and put a check in the OK box.
o NA:  Circle if a refund was not due to the entrant.

• ⓱ Refund:_____________: On the line, enter the refund due by the show to the entrant.
o REF: Circle if a refund is due. Put an X in the FIX box.
o PD: Circle if the refund has been paid by to show to the entrant. When the refund is provided, erase the 

REF, erase the X in the FIX box and put a check in the OK box.
o NA:  Circle if a refund was not due to the entrant.

• ⓲ Horse Stall?  (Your table will have nomenclature for your stall types.  Examples are shown here.)
o FrSa: Circle if the entrant request a stall for Friday and Saturday.
o SaSu: Circle if the entrant requested a stall Saturday and Sunday.
o FrSaSu: Circle if the entrant request a stall Friday, Saturday, and Sunday.
o NO: Circle if the entrant did not request a stall.
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Entry Review and Management Suggestions – Paper Entry Packets > 
Use of Custom Entry Packet Labels, cont’d.

SECTION IX. TIPS & TRICKS

• As an item is updated, using the pencil & eraser, and change the circled STATUS, erase the FIX box X, and 
check the OK box.  This gives you a current, at a glance, status of the entry.

• ⓴ USEF Entry Agreement:
o Rid: Circle if the Rider has signed the form.
o Own: Circle if the Owner has signed the form.
o Trai: Circle if the Trainer has signed the form.
o Coac: Circle if the Coach has signed the form.
o Par: Circle if the Parent has signed the form (if applicable).
o If a person has not signed the form, do not circle and put and X in the fix box.

• XX USEF Waiver Form:
o Rid: Circle if the Rider has signed the form.
o Own: Circle if the Owner has signed the form.
o Trai: Circle if the Trainer has signed the form.
o Coac: Circle if the Coach has signed the form.
o Par: Circle if the Parent has signed the form (if applicable).
o If a person has not signed the form, do not circle and put and X in the fix box.

• XX Coggins:
o YES: Circle if a complete current Coggins is in the entry.
o NO: Circle if a complete current Coggins is NOT in the entry. Put an X in the FIX box.

21

22

o OLD: Circle if the Coggins has expired. 
Put an X in the FIX box.

o HORSE NAME: Circle if the Coggins has 
the wrong horse name (example: barn 
name). Put an X in the FIX box.

• XX Proof of Vaccination:
o YES: Circle if a complete current Proof 

of Vaccination is in the entry.
o NO: Circle if a complete current Proof 

of Vaccination is NOT in the entry. Put 
an X in the FIX box.

o OLD: Circle if the proof of vaccination 
has expired. Put an X in the FIX box.

o HORSE NAME: Circle if the proof of 
vaccination has the wrong horse name 
(example: barn name). Put an X in the 
FIX box.

• XX MFS Q Test:
o YES: The entrant requested a MFS ride 

and the appropriate proof of 
qualification is in the entry.

o NO: The entrant requested a MFS ride 
and the appropriate proof of 
qualification is NOT in the entry. Put an 
X in the FIX box.

o NA: Circle if the entrant did not request 
a MFS ride.

24
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Entry Review and Management Suggestions – Paper Entry Packets >
Procedure > Use of Materials, Open Entry

SECTION IX. TIPS & TRICKS

• Print the emailed EE entry packet or have a mailed entry in front of you.
• Pull out a ❶ kraft envelope (entry packet envelope – contents will be reviewed by the TD), a ❷ white 

envelope (rider packet envelope – will be given to the rider at the show), an ❸ entry packet label, the 
❹ bridle number for this entry, and ❺ 1.5” x 2” sticky sheet to mark incomplete entries.

• Affix the entry packet label to the top left of the kraft envelope.

• All your writing will be done in ❻ pencil so changes can be made as the entry is updated.
• Write the ❼ rider name, horse name, bridle number on the entry packet label. 
• If you have two shows in one weekend, circle ❽ 1, 2, or B.
• Circle the appropriate ❾ rider status (AA JYR OPEN).
• Write the ❿ rider’s last name and bridle number on the top left of the white envelope.
• Put the bridle number into the white envelope.

PROCEDURE > USE OF MATERIALS:

• If not already open, click ⓫Main Menu 
> ⓬ Show Office > ⓭ Entries. 

PROCEDURE > OPEN ENTRY:

1 2

3

4

Entry Packet Envelope Rider Packet Envelope

Use Pencils

Entry # = Bridle #
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PROCEDURE > SUMMARY TAB:

764

Entry Review and Management Suggestions – Paper Entry Packets >
Procedure > Summary Tab, Entry Confirmation Mailer

SECTION IX. TIPS & TRICKS

• The ❶ Entry form opens to the ❷ Summary 
tab.  

• For EE entries (emailed or mailed): 
o Using ❸ Entry (Lookup), open the entry you 

are working on.  
o You will see entry information downloaded 

from EE.  You will update/expand the data.
• For hand-written entries:
o Click the ❹ Add Entry icon to open a new 

entry.
o There will be no data; you must hand-enter 

the entry data.
• If needed (ugh!), look up information via 

www.EqVerification.org and print that report.
• You can also use FVD USEF Information if the 

entry has enough information to search the 
USEF database.

• Sequence of review:
o I first annotate the entry packet label.
o Then I go over and edit the FVD entry tabs 

(see DETAILS OF A FVD ENTRY for 
instructions).

• After you have screened the entry, completed 
the entry packet label, and updated the FVD 
screens, in the ❺ Entry Memo box, write a 
short memo saying the entry is complete or 
saying what is missing in the entry (this memo 
will go to the entrant in FVD communications).  
Do not use <, <, &, ‘, or “ in the message.

• Click the ❻ Print Confirmation icon. 

• The ❼ Entry Confirmation Mailer (Standard) 
report opens.

• Click ❽ Print to print the report.
• Click ❾ Close Print Preview to close the report.  
• Use this as the first page of the entry packet to 

assist you and the TD during packet review.  You 
can make notes on this page as the entry is 
updated, which serves as a reminder of steps 
taken to update and complete the entry.

PROCEDURE > ENTRY CONFIRMATION MAILER:

1

2

3

4

5

6

7

8

9

Do not use  <, <, &, ‘, “

http://www.eqverification.org/
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Entry Review and Management Suggestions – Paper Entry Packets >
Procedure > Upload Confirmations, Organize Entry Packet

SECTION IX. TIPS & TRICKS

• Click ❶ Upload Confirmations to send a 
confirmation email to the entry participants.  
They will receive an email with all their FVD show 
data as an attachment (see FVD Upload 
Confirmations for details).

• After the confirmation is uploaded, the ❷
Confirmation Mailed box is automatically ❸
checked to let you know a confirmation has been 
emailed to the entrants.

• Although not required, if there are entry 
deficiencies, I also send a personal email to the 
entrants (rider, owner & trainer) letting them 
know of the entry deficiencies.  I do this because 
many people do not open the FVD Entry 
Confirmation email, but they do open a personal 
email.  To ensure they open your personal email, 
use a SUBJECT that clearly indicates it is 
information about their entry; for example: YYYY 
Blue Horse Dressage – Incomplete Entry.

• I do not send a personal email if the entry is 
complete.

• Next organize the paper entry packet in a standard order (makes review easier for you and the TD).  This 
is the order I use:
1. FVD Entry Confirmation Mailer
2. EE Summary Page 
3. EE Entry Form (or snail mailed hand-written entry form)
4. EE Stabling Form
5. EE or EqVerification.org USEF and USDF numbers and status
6. EE or mailed or emailed USEF Waiver Form
7. EE or mailed or emailed USEF Entry Application
8. EE or mailed or emailed Coggins
9. EE or mailed or emailed Proof of Vaccination (if required by the show to be in the entry packet)
10. EE or mailed or emailed proof of current SafeSport training for adult rider, owner, trainer and coach 

(if part of the entry)
11. EE or mailed or emailed proof of qualification to ride in a MFS class (if the entry has a MFS ride)
12. Any other documents pertinent to the entry that are required by the show.

PROCEDURE > UPLOAD CONFIRMATIONS:

PROCEDURE > ORGANIZE ENTRY PACKET:

1

2

3
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Entry Review and Management Suggestions – Paper Entry Packets >
Procedure > Filing of Packets

SECTION IX. TIPS & TRICKS

• Complete Entries:
o Staple the entry documents together and place them in the entry’s ❶ kraft envelope (entry packet).  
o Place a ❷ paper clip at the top of the envelope (prevents “lost” entries due to a flap covering an entry).
o Place the kraft envelope vertically in the ❸ entry packet hanging file box in the ❹ hanging file 

corresponding to the first letter of the rider’s last name.  This helps you organize the packets 
alphabetically so the TD can easily find each packet.

o Place the paperclipped ❺ white envelope (rider packet) in the ❻ rider packet hanging file box in the 
hanging file corresponding to the first letter of the rider’s last name. This helps you find the packets when 
entrants check in at the show office.

• Incomplete Entries:
o Paper clip the entry packet documents together and place them in the entry’s ❼ kraft envelope (entry 

packet).  
o Place the ❽ white envelope (rider packet) behind the kraft envelope and ❾ paper clip them together.   

By doing this, you will not accidentally give a rider packet with bridle number to an entrant whose entry is 
incomplete.

o Place a ❿ 1.5” x 2” post-it note on the top right of the kraft envelope.  This flags the entry packet as 
incomplete.

o Place the kraft envelope / white envelope vertically in the entry packet hanging file box in the hanging file 
corresponding to the first letter of the rider’s last name. This helps you organize the packets alphabetically 
so you and the TD can easily find each packet.

PROCEDURE > FILING OF PACKETS:

12

3
4

5

6

7

8

9

10

10
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Entry Review and Management Suggestions – Paper Entry Packets > Procedure >
Update Entries, [Rider] Packet Labels, Manage Packet at the Show

SECTION IX. TIPS & TRICKS

• Update the entry packet label.
• Update FVD to reflect the updates.
• Annotate updates on the first page of the entry packet.
• Add new documents to the entry packet.  Staple the documents together and place them in the entry’s 

kraft envelope (entry packet). 
• Place the paperclipped kraft envelope (entry packet) vertically in the entry packet hanging file box.
• If the entry is now complete, place the paperclipped white envelope (rider packet) vertically in the rider 

packet hanging box. 
• Send the entrants a new FVD Confirmation Email to provide the updated status of their entry.

• Complete entry packets:  Give the entrant the white envelope (rider packet) and wish them a fun show.
• Incomplete entry packets:
o Control your temper!
o Update the entry packet label.
o Update FVD to reflect the updates.
o Annotate updates on the first page of the entry packet.
o Add new documents to the entry packet.  Staple the documents together and place them in the 

entry’s kraft envelope (entry packet). 
o Send the entrants a new FVD Confirmation Email to provide the updated status of their entry.
o Place the paperclipped kraft envelope (entry packet) vertically in the entry packet hanging file box.
o Give the white envelope (rider packet) to the entrant. 

PROCEDURE > UPDATE ENTRIES: (when received before the show)

1

2

3

4

• Click ❶ Main Menu > ❷ Reports > ❸
Pre-Show > ❹Packet Labels (Standard).

• The Packet Labels (Standard) report 
opens.

• Print the labels on 2” x 4” shipping labels.
• Affix the ❺ appropriate packet label to 

the top left of each (white) rider packet, 
including those with incomplete entries. 

PROCEDURE > [RIDER] PACKET LABELS: (just 
before the show)

PROCEDURE > MANAGE PACKETS AT THE SHOW:

5
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SECTION IX. TIPS & TRICKS
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Entry Review and Management Suggestions – Digital Entry Packets >
Introduction, Set Up Show Computer, Screen Capture Software

SECTION IX. TIPS & TRICKS

• The preceding paper entry packet procedure uses a lot of paper and toner, requires a large hanging file box, and 
entries can be confusing to review.

• I have therefore adopted a digital entry packet method that I prefer.  This method may look a bit difficult, but I find 
it much easier than juggling around lots of paper.

• I use a cloud drive (MS OneDrive) for storage of the digital entry packets.

INTRODUCTION:

SET UP SHOW COMPUTER:

• On the cloud drive, create a folder for the show or 
show series.  In this example, a ❶ BHD (for Blue 
Horse Dressage) folder was created.

1

• In the BHD folder, create a subfolder similar to ❷
YYYY-BHD-Entries-PDF-XLS (use a file name 
appropriate for your show, but include Entries-PDF-
XLS). 2

3

4

5

6

7

• In the YYYY-BHD-Entries-PDF-XLS folder, create 
the following subfolders:
o ❸ YYYY-BHD-Complete.  This is where you 

will store your complete digital entry packets.
o ❹ YYYY-BHD-Incomplete. This is where you 

will store your incomplete digital entry 
packets.

o ❺ YYYY-BHD-Scratch. This is where you will 
store your scratched digital entry packets.

o ❻ YYYY-BHD-WaitList. This is where you will 
store your digital entry packets on your waiting 
list, if you have one.

o ❼ zTemplate.  This is where you will store an 
extra copy of your digital entry template (to be 
explained shortly).

SCREEN CAPTURE SOFTWARE:
• This digital entry packets method requires a means to do screen image captures.
• This can be done using the PrtScn (Print Screen) key on the keyboard (click here).  However, this requires a lot of 

image cropping.
• Windows 10 also has a built-in Snipping Tool for screen captures.
• I use SnagIt software (click here).  As of November 2021, the cost is $62.99 (they sometimes have sales). This cost 

is soon recovered by savings from paper, toner, labels and kraft envelope that are no longer used. 
• Other brands of free and for cost screen image capture software are also available. 

NOTE 1:  This digital entry packets method is not an official FVD product and has not been reviewed by USEF or 
USDF.  It is a method developed and used by the FVD manual author.  Check w your TD to ensure s/he will use it.
NOTE 2:  With this method, a networked computer must be available to the TD for entry packet review.

2

https://www.dell.com/support/kbdoc/en-us/000147539/how-to-use-the-print-screen-key-in-microsoft-windows-operating-systems
https://www.techsmith.com/screen-capture.html
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Entry Review and Management Suggestions – Digital Entry Packets >
Digital Entry Packets Template

SECTION IX. TIPS & TRICKS

• I use a MS Excel template to create a digital entry packets, as in the diagram.  Click here to download the file.
• The template has the following tabs:

o ❶ CHK SH = Check Sheet:  Location of a check sheet used to track the items required in an entry.
o ❷ FVD COV = FVD Cover Page:  Location of the FVD Entry Confirmation Mailer (Standard) report.
o ❸ EE COV = EE Cover Page:  Location of the first page of an EE entry.
o ❹ ENTRY = EE Entry Form: Location of the EE entry form or snail mailed entry form.
o ❺MEMB = Memberships:  Location of all people and horse USEF and USDF proof of memberships.
o ❻ USEF ENT AG = USEF Entry Agreement form:  Location of USEF Entry Agreement form signed by Rider, 

Owner, Trainer and Coach (if applicable).
o ❼ USEF WAIVER = USEF Waiver form:  Location of USEF Waiver forms - one for each person in the entry 

(Rider, Owner, Trainer and Coach (if applicable)).
o ❽ COG = Coggins:  Location of the Coggins report.
o ❾ VAC = Proof of Vaccination:  Location of proof of vaccination IAW USEF GR845.
o ❿ SAFE SPORT = Proof of SafeSport training:  Location of proof of current SafeSport for each adult USEF 

member in the entry (Rider, Owner, Trainer and Coach (if applicable)).
o ⓫ OTH = Other:  Location of other documents such as proof of Q for MFS, pony measurement, etc.
o ⓬ STALL = Stall:  Location of EE or snail mailed stall request.

CREATE DIGITAL ENTRY PACKETS TEMPLATE:

1 2 3 4 5 6 7 8 9 10 11 12

http://www.frederickdressage.org/uploads/3/7/3/8/37380471/lname-horse-xxx-2021-08-25.xlsx
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Entry Review and Management Suggestions – Digital Entry Packets >
Save the Digital Entry Packets Template, Create a Digital Entry Packet > 

Save PDF and XLSX Files

SECTION IX. TIPS & TRICKS

• EE Entry PDF File:  When you receive an EE email 
notification that an entry has been processed, 
save the entry’s PDF file to the YYYY-BHD-Entries-
PDF-XLS folder.  EE names this PDF file by the EE 
Tracking Number, such as 345678.pdf.  I rename 
this file Lname-Horse-XXX.  In this example it is 
❹Mxxxxxx-Axxxxx-349.pdf.

• Digital Entry XLSX File:  Copy Lname-Horse-
XXX.xlsx and name it Lname-Horse-XXX.xlsx.  In 
this example, it is ❺Mxxxxxx-Axxxxx.xlsx.

CREATE A DIGITAL ENTRY PACKET > SAVE PDF AND XLSX FILES:

SAVE THE DIGITAL ENTRY PACKETS TEMPLATE:

• Save the digital entry template in the YYYY-
BHD-Entries-PDF-XLS folder.  I name this copy 
of the file ❶ Lname-Horse-XXX as a file for 
an entry will be named this way; for example, 
Smith-Buddy-123, where Smith is the rider’s 
last name, Buddy is the name of the horse, 
and XXX is the bridle number.

• Save a back-up copy of the digital entry 
template in the ❷ zTemplate folder.  I name 
this copy ❸ DigitalEntryTemplate-YYYY-MM-
DD, where the date reflects the date the 
template was created/updated.  This way, if 
you edit your template to add a new feature, 
you can track your versions.

4

5

1

2

3

2
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Entry Review and Management Suggestions – Digital Entry Packets >
Create a Digital Entry Packet > Open the PDF and XLSX Files

SECTION IX. TIPS & TRICKS

• Open the PDF and XLSX files.  

CREATE A DIGITAL ENTRY PACKET > OPEN THE PDF AND XLSX FILES:

NOTE: Ideally, you will be using a large monitor or a double monitor 
system as it is easier to visualize both files at the same time.

Dxxxx Lxxxxx Mxxxxxx on “Axxxxx”

#######

#######

#######

#######

#######

#######

#######

Show Name

Show Location

MM/DD/YYYY

27” Computer Monitor
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Entry Review and Management Suggestions – Digital Entry Packets >
Create a Digital Entry Packet > Enter Top Data

SECTION IX. TIPS & TRICKS

CREATE A DIGITAL ENTRY PACKET > ENTER TOP DATA:

• On the *.xlsx file, CHK SH tab, enter:
o ❶ RIDER LAST NAME
o ❷ RIDER FIRST NAME
o ❸ HORSE NAME
o ❹ BRIDLE NUMBER
o ❺ R = O = T :  If the rider is also the owner and the coach, type the rider’s last name.
o ❻ R = :  If the rider, owner, trainer and coach are multiple people, type the rider’s last name.
o ❼ O = :  If the rider, owner, trainer and coach are multiple people, type the owner’s last name.
o ❽ T = :  If the rider, owner, trainer and coach are multiple people, type the trainer’s last name.
o ❾ C = :  If the rider, owner, trainer and coach are multiple people, type the coach’s last name, if 

applicable.

1
2

3
4

5
6
7
8
9

NOTE:  Items 5 – 9 will assist you as you review the entry as 
the people in the entry determines the documents required.

Dxxxx Lxxxxx Mxxxxxx on “Axxxxx”

#######

#######

#######

#######

#######

#######

#######

Show Name

Show Location

MM/DD/YYYY
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Entry Review and Management Suggestions – Digital Entry Packets >
Create a Digital Entry Packet > FVD Entry Confirmation

SECTION IX. TIPS & TRICKS

• After the entry is entered into FVD, using your 
screen capture software program, capture the 
❶ FVD Entry Confirmation report and paste it 
on the ❷ FVD COV tab of the *.xlsx file. 

• If/when the entry is updated, you can add a new 
captured document or annotate this page.  (Also 
update FVD!)

CREATE A DIGITAL ENTRY PACKET > FVD ENTRY 
CONFIRMATION:

1

2
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Entry Review and Management Suggestions – Digital Entry Packets >
Create a Digital Entry Packet > EE Cover Page

SECTION IX. TIPS & TRICKS

CREATE A DIGITAL ENTRY > EE COVER PAGE:

• Using your screen capture software program, capture the ❶ EE Cover Page in the *.PDF file and paste it 
on the ❷ EE COV tab of the *.xlsx file. 

• The EE Cover Page gives you a summary of the entry.  This data will be verified on subsequent EE pages.

• Annotation of entry “events” is easy.   On this tab, and any other tab, you can capture/copy/paste 
additional information such as ❸ emails.  You can also type ❹ notes to yourself (and/or the TD).  

1

2

Email from:  Show Secretary
Email to: entry participants

Message to the entry participants.

See you at the show!

Suzy Secretary

NOTE TO TD:
You can write a note to yourself and/or 
the TD

3

4
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Entry Review and Management Suggestions – Digital Entry Packets >
Create a Digital Entry Packet > EE Entry Form

SECTION IX. TIPS & TRICKS

• Using your screen capture software program, capture the ❶ EE Entry Page in the *.PDF file and paste it 
on the ❷ ENTRY tab of the *.xlsx file. 

• The EE Entry Page gives you a lot of information on the entry.  Use this page to verify the ❸ payment 
status.

• The membership numbers and status are verified on the EE Memberships page.

• If/when the entry is updated, you can add captured documents, annotate payment changes, etc.

Continued on next page…

CREATE A DIGITAL ENTRY PACKET > EE ENTRY FORM:

1

2

3
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Entry Review and Management Suggestions – Digital Entry Packets >
Create a Digital Entry Packet > EE Entry Form, Cont’d.

SECTION IX. TIPS & TRICKS

• For this entry, the payment is complete, no money is owed, and no money needs to be refunded.
• Check the ❸ relevant boxes on the CHK SH tab of the XLSX file.
• Nomenclature:
o ❹ Complete Payment /  OK /  YES:  The payment is complete.
o ❺ Complete Payment /  NO:  The payment is incomplete.  Check the FIX box.
o ❻ Owe $: _________:  Enter the amount owed. 
o ❼ Owe $: /  OK /  NO:  Money is not owed or has been paid.
o ❽ Owe $: /  BALANCE PAID:  Money was owed but has been paid.
o ❾ Owe $: /  OWE MONEY:  Money is owed. Check the FIX box.
o ❿ Refund $: _________:  Enter the amount of refund.
o ⓫ Refund $:  OK /  NO:  Money does not need to be refunded or has been refunded.
o ⓬ Refund $:  REFUND DONE:  A refund has been refunded.
o ⓭ Refund $:  REFUND DUE:  A refund is due to the entrant.  Check the FIX box.

3
4 5

6 7 8 9
10 11 12 13
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Entry Review and Management Suggestions – Digital Entry Packets >
Create a Digital Entry Packet > Memberships

SECTION IX. TIPS & TRICKS

• Using your screen capture software program, capture the ❶ EE Memberships Page in the *.PDF file and 
paste it on the ❷MEMB tab of the *.xlsx file. 

• The EE Entry Page verifies membership information.  Use this page to verify membership numbers, 
status, and expiration dates for people (rider, owner, trainer, coach (if applicable)) and the horse.

• If the information is confusing, use EqVerification.org to verify further.
• If needed/desired, the www.EqVerifications.org report may also be pasted to this tab.

• If/when the entry is updated, you can add captured documents, annotate membership changes, etc.

Continued on next page…

1

2

CREATE A DIGITAL ENTRY PACKET > MEMBERSHIPS:

USEF #: #######
Horse: Xxxxxxxxxx
Type: Xxxxxxxx
Effective Date: MM/DD/YYYY
Exp. Date: ----
Foal Date: MM/DD/YYYY
FEI Status: Xxxxxxxxx

USEF #: #######
Owner: Xxxxxxxxxx
Type: Xxxxxxxx
Effective Date: MM/DD/YYYY
Exp. Date: ----
Foal Date: MM/DD/YYYY
Safe Sport Training: MM/DD/YYYY - MM/DD/YYYY 

USEF #: #######
Owner: Xxxxxxxxxx
Type: Xxxxxxxx
Effective Date: MM/DD/YYYY
Exp. Date: ----
Foal Date: MM/DD/YYYY
Safe Sport Training: MM/DD/YYYY - MM/DD/YYYY 

USDF #: #######
Horse: Xxxxxxxxxx
Type: Xxxxxxxx
Effective Date: MM/DD/YYYY
Date: Printed MM/DD/YYYY

USEF #: #######
Owner: Xxxxxxxxxx
Membership: Xxxxxxxx
Eff Date: MM/DD/YYYY
Exp. Date: MM/DD/YYYY
Date Printed: MM/DD/YYYY

USEF #: #######
Owner: Xxxxxxxxxx
Membership: Xxxxxxxx
Eff Date: MM/DD/YYYY
Exp. Date: MM/DD/YYYY
Date Printed: MM/DD/YYYY

OPTIONAL BUT HELPFUL

EqVerification.org
http://www.eqverifications.org/
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Entry Review and Management Suggestions – Digital Entry Packets >
Create a Digital Entry Packet > Memberships, Cont’d.

SECTION IX. TIPS & TRICKS

• On the CHK SH tab, check the boxes according to the rider, owner, trainer, coach and horse USEF and USDF 
memberships.  If there are no deficiencies, check the corresponding OK boxes.  If there are deficiencies, check the 
corresponding FIX boxes.

• Nomenclature:
o ❸ USEF Member Rider/Owner/Trainer/Coach /  OK /  R USEF ACTIVE: The R/O/T/C is a USEF current active 

(competing) member.
o ❹ USEF Member Rider/Owner/Trainer/Coach /  OK /  R USEF NM PAID: The R/O/T/C is a USEF non-member 

and has paid the USEF Show Pass fee.
o ❺ USEF Member Rider/Owner/Trainer/Coach /  OK /  R USEF EXEMPT: The R/O/T/C is exempt from USEF 

membership.
o ❻ USEF Member Rider/Owner/Trainer/Coach /  R USEF NM NOT PAID /  FIX: The R/O/T/C is a USEF non-

member and has not paid the USEF Show Pass fee. 
o ❼ USDF Member Rider/Owner/Trainer /  OK /  R USDF PM: The R/O/T/C is a USDF participating member.
o ❽ USDF Member Rider/Owner/Trainer /  OK /  R USDF GM: The R/O/T/C is a USDF group member.
o ❾ USDF Member Rider/Owner/Trainer /  OK /  R USDF NM PAID: R/O/T/C is a USDF non-member and has 

paid the USEF non-member fee.
o ❿ USDF Member Rider/Owner/Trainer /  OK /  R USDF EXEMPT: R/O/T/C is exempt from USDF membership.
o ⓫ USDF Member Rider/Owner/Trainer /  R USDF NM NOT PAID /  FIX : The R/O/T/C is a USDF non-member 

and has not paid the USDF non-member fee. 
o ⓬ USEF Member Coach /  OK /  NO COACH:  The entry does not have a coach declared.

3 4 5 6

7 8 9 10 11

12
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Entry Review and Management Suggestions – Digital Entry Packets >
Create a Digital Entry Packet > USEF Entry Agreement

SECTION IX. TIPS & TRICKS

• Using your screen capture software program, capture the ❶ USEF Entry Agreement Page on the *.PDF 
file and paste it on the ❷ USEF ENT AG tab of the *.xlsx file. 

• The USEF Entry Agreement must be signed by each person in the entry (rider, owner, trainer, coach (if 
applicable)).

• If/when the entry is updated, you can add captured documents, annotate signature changes, etc.

Continued on next page…

CREATE A DIGITAL ENTRY PACKET > USEF ENTRY AGREEMENT:

1

2
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Entry Review and Management Suggestions – Digital Entry Packets >
Create a Digital Entry Packet > USEF Entry Agreement, Cont’d.

SECTION IX. TIPS & TRICKS

• On the CHK SH tab, check the boxes according to the rider, owner, trainer, and coach signature status.  
• If there are no deficiencies, check the corresponding ❸ OK boxes.  If there are deficiencies, check the 

corresponding ❹ FIX boxes.
• Nomenclature:
o ❺ USEF Entry Ag Rider/Owner/Trainer/Coach /  OK /  R/O/T/C ENTRY AG YES: The R/O/T/C 

have signed the USEF Entry Agreement.
o ❻ USEF Entry Ag Rider/Owner /  OK /  PARENT SIG: If the rider or owner is a minor, the parent 

has signed the form.
o ❼ USEF Entry Ag Rider/Owner /  OK / PARENT SIG  NA : The rider or owner is not a minor.
o ❽ USEF Entry Ag Rider/Owner/Trainer/Coach /  NEED R/O/T/C ENTRY AG /  FIX: The R/O/T/C 

USEF Entry Agreement has not bee provided.
o ❾ USEF Entry Ag Coach /  OK /  NO COACH:  A coach has not been declared. 

CREATE A DIGITAL ENTRY PACKET > USEF ENTRY AGREEMENT:

3 45
6 7

8

9
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Entry Review and Management Suggestions – Digital Entry Packets >
Create a Digital Entry Packet > USEF Waiver

SECTION IX. TIPS & TRICKS

• Using your screen capture software program, capture the ❶ USEF Waiver on the *.PDF file and paste it 
on the ❷ USEF WAIVER tab of the *.xlsx file. 

• A SEPARATE checked and signed form is required for each person (rider, owner, trainer, coach (if 
applicable)) in the entry.  Each of the forms are pasted to the tab.

• If/when the entry is updated, you can add new captured documents, annotate signature changes, etc.

Continued on next page…

CREATE A DIGITAL ENTRY > USEF WAIVER:

1

2



Fox Village Dressage User Manual – 2021 Update 1.0.5. helpdesk@foxvillage.com                 www.foxvillage.com783

Entry Review and Management Suggestions – Digital Entry Packets >
Create a Digital Entry Packet > USEF Waiver, Cont’d.

SECTION IX. TIPS & TRICKS

• On the CHK SH tab, check the boxes according to the rider, owner, trainer, and coach signature status.  
• If there are no deficiencies, check the corresponding ❸ OK boxes.  If there are deficiencies, check the 

corresponding ❹ FIX boxes.
• Nomenclature:
o ❺ USEF Waiver Rider/Owner/Trainer/ Coach /  OK /  R/O/T/C WAIVER YES: The R/O/T/C have 

signed a separate USEF Waiver form.
o ❻ USEF Waiver Rider/Owner /  OK /  PARENT SIG: The rider and/or owner is/are a minor and 

the parent has signed.
o ❼ USEF Waiver Rider/Owner /  OK / PARENT SIG  NA: The rider and/or owner is/are not a 

minor.
o ❽ USEF Waiver Rider/Owner/Trainer/ Coach /  NEED R/O/T/C WAIVER /  FIX: The R/O/T/C 

has/have not signed a separate USEF Waiver form.
o ❾ USEF Waiver Coach /  OK /  NO COACH:  The entry does not have a declared coach.

3 45
6 7

8

9
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Entry Review and Management Suggestions – Digital Entry Packets >
Create a Digital Entry Packet > Coggins

SECTION IX. TIPS & TRICKS

• Using your screen capture software program, capture the ❶ Coggins in the *.PDF file and paste it on 
the ❷ COG tab of the *.xlsx file. 

• The Coggins must have the same horse name as on the entry and USEF/USDF memberships.
• The Coggins expires 365 days after the blood was drawn.  If it was drawn on 03/18/YYYY, the last day it is 

good is 03/17/YYYY+1.

• If/when the entry is updated, you can add new captured documents, add a vet letter, annotate Coggins 
changes, etc.

• If an ❸ old Coggins (or another old document on another tab) was originally sent, you can make that 
image small so it is available, if needed.

Continued on next page…

CREATE A DIGITAL ENTRY PACKET > COGGINS:

1

2

3
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Entry Review and Management Suggestions – Digital Entry Packets >
Create a Digital Entry Packet > Coggins, Cont’d.

SECTION IX. TIPS & TRICKS

• On the CHK SH tab, check the boxes according to the status of the ❸ Coggins.
• If there are no deficiencies, check the corresponding ❹ OK boxes.  If there are deficiencies, check the 

corresponding ❺ FIX boxes.
• Nomenclature:
o ❻ Coggins /  OK /  COGGINS YES:  The entry has a current Coggins with the correct horse name.
o ❼ Coggins /  COG WRONG HORSE NAME /  FIX:  The horse name on the Coggins is not the same 

as on the entry and USEF/USDF memberships.  Need a vet letter declaring they are the same horse.
o ❽ Coggins /  NEED COGGINS W/IN 1 YR /  FIX:  Coggins has expired.   Need a new Coggins.

3 4 56 7 8



Fox Village Dressage User Manual – 2021 Update 1.0.5. helpdesk@foxvillage.com                 www.foxvillage.com786

Entry Review and Management Suggestions – Digital Entry Packets >
Create a Digital Entry Packet > Vaccinations

SECTION IX. TIPS & TRICKS

• Using your screen capture software program, capture the ❶ Proof of Vaccinations in the *.PDF file and 
paste it on the ❷ VAC tab of the *.xlsx file. 

• The proof of vaccinations must have the same horse name as on the entry and USEF/USDF memberships.
• The proof of vaccinations expires six months after they were administered.  If they were administered on 

03/18/YYYY, the last day they are good is 09/17/YYYY.

• If/when the entry is updated, you can add new captured documents, annotate vaccination changes, etc.

Continued on next page…

CREATE A DIGITAL ENTRY PACKET > VACCINATIONS:

1

2

NOTE:  The proof of vaccinations can 
be this USEF form, a letter from the 
veterinarian, an invoice from the 
veterinarian, a signed invoice from the 
person who has care and custody of 
the horse, etc.  Just ensure the horse 
name is correct, the vaccine(s) 
administered are correct, and the 
vaccine(s) were done withing 6 
months of the show date.
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Entry Review and Management Suggestions – Digital Entry Packets >
Create a Digital Entry Packet > Vaccinations, Cont’d.

SECTION IX. TIPS & TRICKS

3 4 56 7 8

• On the CHK SH tab, check the boxes according to the status of the ❸ Proof of Vaccinations.
• If there are no deficiencies, check the corresponding ❹ OK boxes.  If there are deficiencies, check the 

corresponding ❺ FIX boxes.
• Nomenclature:
o ❻ Proof of Vaccination /  OK /  VACS YES:  The entry has a current Coggins with the correct 

horse name.
o ❼ Proof of Vaccination /  VAC WRONG HORSE NAME /  FIX:  The horse name on the proof of 

vaccination is not the same as on the entry and USEF/USDF memberships.  Need a vet letter declaring 
they are the same horse.

o ❽ Proof of Vaccination /  NEED COGGINS W/IN 6 MOS /  FIX:  Proof of vaccination has expired.   
Need new vaccinations.
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Entry Review and Management Suggestions – Digital Entry Packets >
Create a Digital Entry Packet > SafeSport

SECTION IX. TIPS & TRICKS

• Using your screen capture software program, capture the proof of ❶ SafeSport training in the *.PDF file 
and paste it on the ❷ SAFE SPORT tab of the *.xlsx file. 

• The SafeSport training must be renewed each year.
• The entry must have proof of current SafeSport training for each adult USEF member in the entry (rider, 

owner, trainer, coach).

• If/when the entry is updated, you can add new captured documents, annotate SafeSport changes, etc.

Continued on next page…

CREATE A DIGITAL ENTRY PACKET > SAFESPORT:

1

2

NOTE:  The proof SafeSport training 
must have a start date within the year 
or have an expiration date.  The 
SafeSport training certificate may be 
used; however, it does not have an 
expiration date.  A screen capture of 
the person’s USEF dashboard also has 
the required information.
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Entry Review and Management Suggestions – Digital Entry Packets >
Create a Digital Entry Packet > SafeSport, Cont’d.

SECTION IX. TIPS & TRICKS

• On the CHK SH tab, check the boxes according to the status of the ❸ SafeSport training for each adult USEF 
member in the entry (rider, owner, trainer, coach).

• If there are no deficiencies, check the corresponding ❹ OK boxes.  If there are deficiencies, check the 
corresponding ❺ FIX boxes.

• Nomenclature:
o ❻ SafeSport Rider/Owner/Trainer/Coach /  OK /  R/O/T/C SS YES: The R/O/T/C have current SafeSport 

training.
o ❼ SafeSport Rider/Owner/Trainer/Coach /  OK /  SS EXEMPT USEF NM: The R/O/T/C are exempt from 

SafeSport training due to USEF NM.
o ❽ SafeSport Rider/Owner/Coach /  OK /  SS EXEMPT AGE: The R/O/C are exempt from SafeSport 

training due to age.
o ❾ SafeSport Rider/Trainer Parent/  OK /  SS EXEMPT PARENT: The trainer parent is exempt from 

SafeSport training due to parent status.
o ❿ USEF Waiver Rider/Owner/Trainer/Coach /  NEED R/O/T/C PROOF OF SS /  FIX: The R/O/T/C 

has/have not provided proof of current SS training.
o ⓫ USEF Waiver Coach /  OK /  NO COACH:  The entry does not have a declared coach.
o ⓬ SafeSport Owner /  OK /  O SS EX BUSINESS:  The business owner is SS exempt (businesses do not take 

SS training).

3 4 56 7 8
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Entry Review and Management Suggestions – Digital Entry Packets >
Create a Digital Entry Packet > Other

SECTION IX. TIPS & TRICKS

• Using your screen capture software program, capture any other documents on the *.PDF file and paste 
them on the ❷ OTH tab of the *.xlsx file. 

• Such documents may include proof of Q to ride a MFS test, pony measurement, horse passport, local 
membership card, etc.

• If/when the entry is updated, you can add new captured documents, annotate changes, etc.

Continued on next page…

CREATE A DIGITAL ENTRY PACKET > OTHER:

1

2

1 1
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Entry Review and Management Suggestions – Digital Entry Packets >
Create a Digital Entry Packet > Other, Cont’d.

SECTION IX. TIPS & TRICKS

• Example – Proof of Q for MFS Ride:
o On the CHK SH tab, check the boxes according to the status of other documents, such as ❸ proof of 

Q for a MFS test.  
o If there are no deficiencies, check the corresponding ❹ OK box.  If there are deficiencies, check the 

corresponding ❺ FIX box.
• Nomenclature:
o ❻MFS Q Test /  OK / MFS NA: The entrant is not riding a MFS test.
o ❼MFS Q Test /  OK / MFS YES: The entrant is riding a MFS test and has provided proof of Q to 

ride the test.
o ❽MFS Q Test /  NEED PROOF OF MFS Q /  FIX : The entrant is riding a MFS test but has note 

provided proof of Q to ride the test.

3 4 56 7 8
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Entry Review and Management Suggestions – Digital Entry Packets >
Create a Digital Entry Packet > Stalls

SECTION IX. TIPS & TRICKS

• Using your screen capture software program, if applicable, capture the EE stall request form in the *.PDF 
file and paste it on the ❷ STALL tab of the *.xlsx file. 

• If/when the entry is updated, you can add new captured documents, annotate stall changes, etc.

CREATE A DIGITAL ENTRY PACKET > STALLS:

1

2

Continued on next page…
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Entry Review and Management Suggestions – Digital Entry Packets >
Create a Digital Entry Packet > Stalls, Cont’d.

SECTION IX. TIPS & TRICKS

• On the CHK SH tab, check the boxes according to the ❸ stabling request.  
• If there are no deficiencies, check the corresponding ❹ OK boxes.  If there are deficiencies, check the 

corresponding ❺ FIX boxes.
• Nomenclature:
o ❻ Horse Stall /  OK /  NO HORSE STALL: The entrant has not reserved a horse stall.
o ❼ Horse Stall /  OK /  H-FrSa: The entrant has reserved a horse stall for Friday and Saturday.
o ❽ Horse Stall /  OK /  H-FrSaSu: The entrant has reserved a horse stall for Friday, Saturday and 

Sunday.
o ❾ Horse Stall /  OK /  H-SaSu: The entrant has reserved a horse stall for Saturday and Sunday.
o ❿ Tack Stall /  OK /  NO TACK STALL: The entrant has not reserved a tack stall.
o ⓫ Tack Stall /  OK /  T-FrSa: The entrant has reserved a tack stall for Friday and Saturday.
o ⓬ Tack Stall /  OK /  T-FrSaSu: The entrant has reserved a tack stall for Friday, Saturday and 

Sunday.
o ⓭ Tack Stall /  OK /  T-SaSu: The entrant has reserved a tack stall for Saturday and Sunday.

3 4 5
6 7 8 9

10 11 12 13



Fox Village Dressage User Manual – 2021 Update 1.0.5. helpdesk@foxvillage.com                 www.foxvillage.com794

Entry Review and Management Suggestions – Digital Entry Packets >
Create a Digital Entry Packet > Store the PDF and XLSX Files

SECTION IX. TIPS & TRICKS

• Now that you have created the digital entry packet, if you have not already done so, annotate the entry 
details in FVD.

• Next you store the entry’s PDF and XLSX files 
in a manner that will be easy for you and the 
TD to find the files for updates and review.

• Navigate to the folder where the ❶ PDF and 
❷ XLSX files on which you were just 
working are stored.  In this example, the files 
are in the ❸ OneDrive-Personal > BHD > 
YYYY-BHD-Entries-PDF-XLS folder.

1

2

3

• In this folder, create a ❹Mxxxxx-Axxxxx-
349 subfolder, typing the rider’s last name, 
the horse’s name, and the bridle number.  
This should match the PDF and XLSX file 
names.

4

• Move the ❶ PDF and ❷ XLSX files to the 
❹Mxxxxx-Axxxxx-349 subfolder.

4

1

2

4

Continued on next page…
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Entry Review and Management Suggestions – Digital Entry Packets > Create 
a Digital Entry Packet > Store the PDF and XLSX Files, Cont’d., Access DB

SECTION IX. TIPS & TRICKS

• If the entry is complete, move the ❺Mxxxxxx-Axxxxx-349 file to the ❻ YYYY-BHD-Complete folder.
• If the entry is incomplete, move the ❺Mxxxxxx-Axxxxx-349 file to the ❼ YYYY-BHD-Incomplete folder.
• If the entry scratches, move the ❺Mxxxxxx-Axxxxx-349 file to the ❽ YYYY-BHD-Scratch folder.
• If the entry is on your wait list, move the ❺Mxxxxxx-Axxxxx-349 file to the ❾ YYYY-BHD-WaitList folder.

5

6

7

8

9

• Continue with creation of digital entry packets for all your entries.
• You will have a ❿ long list of subfolders corresponding to your show’s entries, each with the EE 

entry PDF and your digital entry XLSX.
• The subfolders are automatically sorted alphabetically so they are easy to find when you need to 

update an entry or the TD needs to review the entries.  During the show, the TD will need a 
dedicated computer for entry review.

• As an optional feature, I created a ⓫ MS Access database program on which the user can upload 
links to each entry’s PDF and XLSX files.  It has a space for secretary and/or TD notes.  The notes 
can be printed as a report.  This may make TD review and documentation easier.  Click here to 
download the database file. 

• Alternately, the TD can use the ❿ long list of subfolders to review the digital entry packets.

10

11

http://www.frederickdressage.org/uploads/3/7/3/8/37380471/entriesdatabasetemplateforshows.accdb
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SECTION IX. TIPS & TRICKS



Fox Village Dressage User Manual – 2021 Update 1.0.5. helpdesk@foxvillage.com                 www.foxvillage.com797

Print Labels and Cards > Introduction

The FVD program uses the following labels and index cards for the following purposes:

SECTION IX. TIPS & TRICKS

Size Use Resources

1” x 2-5/8” shipping labels

• Prize List Mailing Labels
• Horse Stall Labels
• Tack Stall Labels
• Owner Mailing Labels

Avery 5260 (AM)
DigiOrange (AM)

1-1/3” x 4” address labels
• Dressage Test Sheets

(small labels)
Avery 5962 (AM)
DigiOrange (AM)

2” x 4” shipping labels
• Dressage Test Sheets
• Packet Labels (Standard)

Avery 5163 (AM)
DigiOrange (AM)

3-1/2” x 5” shipping labels • Packet Labels (Detail)
Avery 5168 (AM)
DigiOrange (AM)

3” x 5” laser index cards
• Horse Stall Cards
• Tack Stall Cards

Avery 5388 (AM)

4.25” x 5.5” Labels
(square edges)

• Packet Labels (not for a FVD 
report)

DigiOrange (AM)

INTRODUCTION:

https://www.amazon.com/Avery-Mailing-Printers-Permanent-Adhesive/dp/B00004Z5SN/ref=sr_1_4?crid=MAYW4YPYJAR5&keywords=avery+5260+labels&qid=1579881591&s=office-products&sprefix=Avery+5260+labels%2Coffice-products%2C301&sr=1-4
https://www.amazon.com/DigiOrange-Mailing-Labels-Inkjet-Printers/dp/B005FCWRKO/ref=sr_1_6_sspa?keywords=digiorange+5260+labels&qid=1579881523&s=office-products&sr=1-6-spons&psc=1&spLa=ZW5jcnlwdGVkUXVhbGlmaWVyPUFMWkJZWjM1NU0xQ0MmZW5jcnlwdGVkSWQ9QTA4NzQzMjAzNFZKRkQ2VUxFS085JmVuY3J5cHRlZEFkSWQ9QTAxMzY2NDgxVVdUQTFWUjA4QVFPJndpZGdldE5hbWU9c3BfYnRmJmFjdGlvbj1jbGlja1JlZGlyZWN0JmRvTm90TG9nQ2xpY2s9dHJ1ZQ==
https://www.amazon.com/Avery-Laser-Labels-Mailing-White/dp/B00BT33VCG/ref=sr_1_7?keywords=avery+5962+labels&qid=1579881753&s=office-products&sr=1-7
https://www.amazon.com/Digiorange%C2%AE-Inches-Labels-Inkjet-Printers/dp/B019BG6IS6/ref=sr_1_2?keywords=digiorange+5962+labels&qid=1579881880&s=office-products&sr=1-2
https://www.amazon.com/Avery-Shipping-Printers-Permanent-TrueBlock/dp/B00004Z6LV/ref=sr_1_7?keywords=avery+%225163%22+labels&qid=1579882044&s=office-products&sr=1-7
https://www.amazon.com/Digiorange-Shipping-Labels-Inkjet-Printers/dp/B07Y53X8HQ/ref=sr_1_3_sspa?keywords=digiorange+2%22+x+4%22+labels&qid=1579882225&s=office-products&sr=1-3-spons&psc=1&spLa=ZW5jcnlwdGVkUXVhbGlmaWVyPUEyVFlXSDg5WlYwRDk2JmVuY3J5cHRlZElkPUEwNTgyNzk1MTlFSUFEM1NCOElKQSZlbmNyeXB0ZWRBZElkPUExMDI0ODgyMko0UTZZTEhPSUNaWiZ3aWRnZXROYW1lPXNwX2F0ZiZhY3Rpb249Y2xpY2tSZWRpcmVjdCZkb05vdExvZ0NsaWNrPXRydWU=
https://www.amazon.com/Avery-Shipping-Printers-Permanent-TrueBlock/dp/B00004Z6LW/ref=sr_1_10?keywords=avery+%225168%22+labels&qid=1579882111&s=office-products&sr=1-10
https://www.amazon.com/Digiorange-Mailing-Shipping-Labels-Printers/dp/B07DMPH7LQ/ref=sr_1_1_sspa?keywords=digiorange+3.5%22+x+5%22+labels&qid=1579882297&s=office-products&sr=1-1-spons&psc=1&spLa=ZW5jcnlwdGVkUXVhbGlmaWVyPUExS1FXSlhPUlRKNTgxJmVuY3J5cHRlZElkPUEwNzkxNDk0M0dDTEkwWkQ2UDNVTyZlbmNyeXB0ZWRBZElkPUEwMDczOTMyMU1LNVZRRkROOEhXUSZ3aWRnZXROYW1lPXNwX2F0ZiZhY3Rpb249Y2xpY2tSZWRpcmVjdCZkb05vdExvZ0NsaWNrPXRydWU=
https://www.amazon.com/Avery-Printable-Cards-Inkjet-Printers/dp/B00006HPWA/ref=sr_1_8?keywords=avery+%225388%22+label&qid=1579882395&s=office-products&sr=1-8
https://www.amazon.com/Digiorange-Mailing-Shipping-Labels-Printers/dp/B07X9TSDYD/ref=sr_1_3_sspa?keywords=4.25+x+5.5+labels&qid=1579880813&s=office-products&sr=1-3-spons&psc=1&spLa=ZW5jcnlwdGVkUXVhbGlmaWVyPUEzSlczQ0JYRkJGWUpQJmVuY3J5cHRlZElkPUEwMzM1OTUyMk1RWDhKQzExQkE5VCZlbmNyeXB0ZWRBZElkPUExMDI5ODk4MkpOREMzUEhOS09ZQyZ3aWRnZXROYW1lPXNwX2F0ZiZhY3Rpb249Y2xpY2tSZWRpcmVjdCZkb05vdExvZ0NsaWNrPXRydWU=
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Print Labels and Cards > Print a Test Page Using a Plain Piece of Paper > Open a Report

For most printers, the FVD default or recommended settings will accurately print the text in the correct 
location on the labels/cards.  However, some printers may require adjustment of the settings.  To avoid 
wasting expensive labels, it is a good idea to first test the printout on plain paper, make adjustments if 
needed, then print the final labels.  We will use 1” x 2-5/8“ Prize List Mailing Labels (Avery 5260) as an 
example to check the printing accuracy and to make adjustments if needed.  These instructions can be used 
for any of the labels/index cards used by the program.

SECTION IX. TIPS & TRICKS

• The ❾ Prize List Labels report opens.
• Check the labels to ensure they are the ones you 

intend to print.

• Click ❶Main Menu >❷ Reports > ❸
Pre-Show >❹ Packet Labels (Standard).

• The ❺ Prize List Labels form opens.  
• Enter a ❻ Last Show Date and select the 
❼ Order By that you prefer.

• Click ❽ OK.

5

6

7

8

1

2

3

4

9

PRINT A TEST PAGE USING A PLAIN PIECE OF PAPER > OPEN A REPORT:
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Print Labels and Cards > Print a Test Page Using a Plain Piece of Paper > 
Print a Report, Overlay with Label Sheet

SECTION IX. TIPS & TRICKS

• Ensure plain paper is 
loaded in your printer.

• Click ❶ Print.

• The ❷ Print form opens.
• If needed, using the ❸ Printer / Name: drop 

down arrow, select your printer.
• To print just the first page of labels, click the ❹

Pages radial button then enter 1 in both the ❺
From: and ❻ To: boxes.

• Click ❼ OK.

• The ❽ first page prints out on plain paper.
• Place a ❾ label sheet on top of the printout and 

hold them up to a light so the printed sheet can 
be seen through the label sheet.  

• If the alignment is not correct, for example ❿
part of the top line of text would not be printed 
on the label, you will need to adjust the print 
settings.  Go to Adjust Print Settings for the 
procedure.

• If the alignment is correct, you can print your 
labels.  Go to Print the Labels for the procedure.

1

2

3

4
5 6

7

8

9

PRINT A TEST PAGE USING A PLAIN PIECE OF PAPER > PRINT A REPORT, OVERLAY WITH LABEL SHEET:

10
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Print Labels and Cards > Adjust Print Settings

• Different printers may need different settings in order to print labels and index cards correctly.  If the 
default or recommended FVD settings (see Default & Recommended Settings) do not work for your 
printer, do the following.

• The ❷ Print form opens.
• Click ❸ Setup… .

SECTION IX. TIPS & TRICKS

• After opening any label/index card report form, click ❶ Print.

2

3

Continued on next page…

1

ADJUST PRINT SETTINGS:
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Print Labels and Cards > Adjust Print Settings, Cont’d.

SECTION IX. TIPS & TRICKS

• Next, we will look at the ❻ Columns tab.
• Under ⓫ Grid Settings, you can adjust:
o ⓬ Number of Columns: (number of vertical 

columns on the text/label sheet) 
o ⓭ Row Spacing: (space between horizontal 

rows on the text/label sheet) 
o ⓮ Column Spacing: (space between vertical 

columns on the text/label sheet)
• Under ⓯ Column Size, you can adjust: 
o ⓰Width: (width of each text/label)
o ⓱ Height: (height of each text/label)

• Under ⓲ Column Layout, you can adjust the 
order in which the labels print.  This is usually not 
changed.

• After each adjustment, print one sheet of labels/index cards on a plain piece of paper, as in Print a Test 
Page Using a Plain Piece of Paper, to test the adjustment.

• Unfortunately, the adjustments are a matter of trial and error until you get it right.  Once you determine 
the correct settings for your printer, write them down so you can use them the next time you print the 
same labels.

• When you are finished making the print adjustments, click ⓳ OK.  

• Start with the ❺ Print Options tab.  The graphic 
shows the FVD margin default settings for the 
Prize List Labels (Avery 5260 1” x 2-5/8”).

• You can change the ❼ Top, ❽ Bottom, ❾ Left
and ❿ Right margins to correct the alignment of 
the printed text with the labels.  
o For example, if part of the top line of text is 

printed above the label, you need to increase 
the size of the top margin to move the text 
down.  

o As another example, if the left side of the text 
is printed left of the label, you need to 
increase the size of the left margin to move 
the text to the right.  

• The ❹ Page Setup form opens, which has two 
tabs:
o ❺ Print Options
o ❻ Columns

• The print settings are adjusted in these tabs.

6

11

12

13

14

15

16 17

18

19

7

8

4

5 6

10

9
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1

3

802

Print Labels and Cards > Print the Labels

SECTION IX. TIPS & TRICKS

• To determine how many label sheets you will 
need, click the ❶ Last Page arrow.

• The number that appears in the ❷ Page: box is 
the number of label sheets you will need.  In this 
example, 6 label sheets are needed.

• To set your printer’s paper type for labels (or card 
stock for index cards), click ❸ Print.

• The ❹ Print form opens.
• To adjust the printer properties, click ❺

Properties.

• Load the required number of label sheets in your 
printer.  Refer to your printer’s manual for 
instructions on loading the label sheets.  Some 
printers require the labels to be face up, others 
face down; some require the top to be facing into 
the printer, others require the top to be facing 
away from the printer. 

4

5

Continued on next page…

12

PRINT THE LABELS:
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Print Labels and Cards > Print the Labels, Cont’d.

SECTION IX. TIPS & TRICKS

• Your printer’s ❻ Properties form opens (in the example, we seen the properties for a Brother printer; 
different printers will have different windows).  

• For this printer, select the ❼Media type drop-down arrow and select ❽ Label for labels (or ❾
Thicker Paper for index cards).

• Click ❿ OK at the bottom of the Properties form.

• Click ⓫ OK on the Print form.  
• Your labels will print.

NOTE: My printer prints labels better on the Plain Paper media selection.  On the Label setting, the label 
sheets do not feed an instead bunch up.  So, if you have printing problems, try a different media setting.

7

8

9

6

10

11



Fox Village Dressage User Manual – 2021 Update 1.0.5. helpdesk@foxvillage.com                 www.foxvillage.com804

SECTION IX. TIPS & TRICKS
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Use Email Addresses > E-mail One Person

• Select ❶Main Menu > ❷ Show Office 
> ❸ People

• The ❹ People form opens.
• Using the ❺ Rider (Lookup) drop-down or type-

in box, select the person you want to email.

SECTION IX. TIPS & TRICKS

6

Continued on next page…

3

2

1

4

5

EMAIL ONE PERSON:
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Use Email Addresses > E-mail One Person, Cont’d.

SECTION IX. TIPS & TRICKS

7

• Open your email program.
• Place your cursor in the ❽ To: box and keyboard Ctrl + V (this pastes the contents of your clipboard into 

the To box – the person’s email address is pasted into the box).
• In the ❾ Subject box, type a subject that will clearly identify the email as being related to the show –

this will increase your chances the entrant will open the email.
• In the ❿ Message box, type your message.
• In the usual manner, attach any ⓫ attachments you may want to send.
• Click ⓬ Send.
• The email will be sent to the one person.

• With your cursor, highlight the ❼ E-mail 
address.

• With the email address highlighted, keyboard  
Crtl + C (this places the person’s email address in 
your clipboard).

8

9

Attachment.pdf

10

12

11

YYYY Blue Horse Dressage - Entry Issue
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Use Email Addresses > E-mail Groups of People

SECTION IX. TIPS & TRICKS

• Select ❶Main Menu > ❷ Show Office 
> ❸ Emails to Clipboard.

• The ❹ E-mails to Clipboard form opens.
• You have the following options (❺ E-mail Filter):
o Riders in Show – copies the email addresses of all the 

riders in your current show to the clipboard.
o Owners in Show – copies the email addresses of all the 

owners in your current show to the clipboard.
o Trainers in Show – copies the email addresses of all the 

trainers in your current show to the clipboard.
o Coaches in Show – copies the email addresses of all the 

coaches in your current show to the clipboard.
o All People in Show – copies the email addresses of all 

the riders, owners, trainers, and coaches in your current 
show to the clipboard.

o All People in HR Database – copies the email addresses 
of all the people in your HR Database to the clipboard.  
Lets you enter a ❻ Last Show Date, which limits the 
people to those who showed since the date you enter.

• Make your selection then click ❼ OK.

6

4

5

7

• A ❽ Fox Village Dressage information form opens, 
indicating the email addresses have been copied to 
your (Windows) clipboard.

• Click ❾ OK.

1

2

3

8

9

Continued on next page…

EMAIL GROUPS OF PEOPLE:
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Use Email Addresses > E-mail Groups of People, Cont’d.

• Open your email program.
• Place your cursor in the ❿ To box and type your email address.
• Place your cursor in the ⓫ BCC box and keyboard Ctrl + V (this pastes the contents of your clipboard 

into the Bcc box – the email addresses are pasted into the box).  Use Bcc (Blind carbon copy) so the 
recipients will not see the email addresses of other people.

• In the ⓬ Subject box, type a subject that will clearly identify the email as being related to the show –
this will increase your chances the entrant will open the email.

• In the ⓭Message box, type your message.
• In the usual manner, attach any ⓮ attachments you may want to send.
• Click ⓯ Send.
• The email will be sent to the group of people.
• This is a handy method to send a message to all the selected people, with attachments, such as the Prize 

List,  Rider’s Schedule Report, etc.

SECTION IX. TIPS & TRICKS

NOTE: It is very important to paste the recipient email addresses into the Bcc: box 
(blind carbon copy) instead of the To: box.  By using the Bcc: box, the recipient 
email addresses are hidden so they are not publicly broadcast to all recipients.

Attachment.pdf

YYYY Blue Horse Dressage – Ride Times

10 11

12

13

14

15

NOTE:  Ensure you paste the show participant emails 
into the Bcc box, not the To box, so you do not 
broadcast all the show participant emails to others.
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SECTION IX. TIPS & TRICKS
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• A Quadrille has four riders and a Pas de Deux has two riders.  This Tip & Trick will provide the steps to 
schedule a Quadrille or a Pas de Deux class with the correct duration and the riders scheduled together.

• Test Duration: The FVD program provides the entire duration of the test (ride time and administrative 
time) for the test; therefore, if you schedule the four riders for a Quadrille, the program allows 4 x 8 = 32 
minutes (Basic Quadrille Test) or 4 x 8.5 = 34 minutes (other Quadrille tests) for the test.  Also, if you 
schedule the two riders for a Pas de Deux, the program allows 2 x 10 = 20 minutes for the test.

• Scheduling:  The FVD program does not identify the riders composing a Quadrille or a Pas de Deux; 
therefore, during scheduling, the riders will not necessarily be scheduled together.  This must be done 
manually using the Forced Order (FO) procedure.

810

Scheduling Quadrille & Pas de Deux > Introduction, Step 1. Include the Test in Your Show

• The ❹ Class form opens.
• Click ❺ Add a Class.
• Enter the ❻ Class Number and ❼ Text.
• Using the ❽ Default Test drop-down arrow, 

select the ❾ test you want to include in this 
class.  The tests are:
o USDF Pas de Deux
o USDF Introductory Quadrille Test
o USDF Training Level Quadrille Test
o USDF First Level Quadrille Test
o USDF Second Level Quadrille Test
o USDF Third Level Quadrille Test
o USDF Quadrille Freestyle

• For this example, USDF Second Level Quadrille 
Test was entered.

• Enter the other information for the class, as in 
Classes.

• Click ❿ Close.

STEP 1. INCLUDE THE TEST IN YOUR SHOW:

• Select ❶Main Menu > ❷ Show Office 
> ❸ Classes.  

SECTION IX. TIPS & TRICKS

1

2

3

INTRODUCTION:

4

5

6 7

9

8

10
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Scheduling Quadrille & Pas de Deux > Step 2. Adjust the Test Durations

• Pas de Deux Test:
o Depending upon the level, USDF allocates 5-6 

minutes for riding the test.  
o FVD allocates ❺ 10 minutes; this includes 

time for pre-test and post-test judging 
activities.  However, the FVD program provides 
10 minutes to each of the two Pas de Deux 
riders, giving a total of 20 minutes for the test.  
If instead each rider is allocated half the time 
(5 minutes), they will be scheduled for a better 
test duration.  

o To adjust the test duration, edit the ❺ 10.00
to  ❻ 5.0 (or 4.5).

• Quadrille Tests:
o Depending upon the level, USDF allocates 

5:50-6 minutes for riding the test. 
o FVD allocates 8 minutes (Basic Quadrille Test) 

or 8.5 minutes (other Quadrille Tests); this 
includes time for pre-test and post-test 
activities.  However, the FVD program provides 
8.0 (or 8.5) minutes to each of the four 
Quadrille riders, giving a total of 32 (or 34) 
minutes for them to ride the test.  If instead 
each rider is allocated one quarter of the time 
(2 or 2.125 minutes), they will be scheduled 
for the appropriate test duration.  

o To adjust the test duration, edit the ❼ 8.0 to 
❽ 2.0 for  the Basic Quadrille Test and edit 
the ❾ 8.5 to ❿ 2.2 (the program will not 
accept 2.125) for the other Quadrille Tests.

• Click ⓫ Close when you are finished.

STEP 2. ADJUST THE TEST DURATIONS:

• Select ❶Main Menu > ❷ Show Office 
>        ❸ Test Durations.  

SECTION IX. TIPS & TRICKS

1

2

3

4

5

7

• The ❹ Test Durations form opens.
• Scroll through the list until you find the 

first test you want to adjust. 

6

8

9

10

11
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Scheduling Quadrille & Pas de Deux > Step 3. Scheduling the Rides 

STEP 3. SCHEDULING THE RIDES:

• Schedule your show as in SCHEDULING.
• For the Assign Ride Times step, the ❶ Schedule form will 

look similar to the figure.
• You will be familiar with your entries and will know which 

riders are riding together in the Pas de Deux (or Quadrille).  
In this example, we know that Rider A and Rider B (pink) 
are riding together and Rider C and Rider D (blue) are 
riding together; however, the FVD program does not 
automatically schedule them together (one following the 
other in the class order).  We need to perform a Forced 
Order (FO) to reorder the riders.

• To reorder the rides, in the ❷ FO column, type a 1 for 
Rider A, a 2 for Rider B, a 3 for Rider C, and a 4 for Rider 
D.

• Click ❸ Schedule.

• We can see that ❹ Rider A and Rider B (pink – both 
riders start together at 10:21:00 AM) are now scheduled 
together and ❺ Rider C and Rider D (blue – both riders 
start together at 10:31:00 AM) are scheduled together.

• Quadrille tests are scheduled in a similar manner except 
that riders riding together will be force ordered  to 
positions 1-4, 5-8, etc.

SECTION IX. TIPS & TRICKS

3

172

2

172

4

5

1
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SECTION IX. TIPS & TRICKS

NOTE: 
• FVD requires all competing teams and all members of a team be in the same

class.  You can have a separate team class that can be the same test for all or it 
can be a TOC class wherein team members may ride different tests.  

• For example:
o A team competition may be all Training 3 so the class would be a Training 3 

team class.
o If there are mixed teams – riders of a team may ride different tests – the 

team class would be a TOC mixed team class wherein the team members 
may ride any test, as defined by the show.  

• Either team class may be a regular class in the show, as long as the class fulfills 
the team class requirements.
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Managing Teams > Introduction, Step 1. Enter Team Names

SECTION IX. TIPS & TRICKS

• Select ❶Menu > ❷ Show Office > ❸
Teams

• A blank ❼ Team form opens.
• In the ❽ blank line, enter the team name.   

• Continue until all teams are entered.

• If a team has withdrawn from the show, use the 
❾ Team (Lookup) drop-down arrow (or type-in 
box) and select the team name.  Then click the 
❿ Delete Team button to delete the team.

• Click ⓫ Close.

• The ❹ Team form opens.
• To enter the first team, type the team name in 

the ❺ Team Name box.

• To enter the next team, click the ❻ Add Team 
button.

Some shows have teams in which 3-4 horse/rider pairs compete and their scores are combined to 
determine a team placing.  This Tip & Trick consolidates all team procedures.

STEP 1. ENTER TEAM NAMES:

• Enter each entry as in EE ONLINE ENTRIES, SNAIL MAILED SHOW ENTRIES CREATED WITH EE, SNAIL 
MAILED SHOW ENTRIES, and DETAILS OF A FVD ENTRY.

1

2

3

4

5

5

6

INTRODUCTION:

7

8
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Managing Teams > Step 2. Enter Entries in Teams

• The team name is now in the ❾ Team box.

• Select ❶Menu > ❷ Show Office > ❸
Entries

• The ❹ Entry form opens.
• Use the ❺ Entry (Lookup) drop-down arrow or 

type-in box to select the entry. 
• Verify that the correct Entry # is displayed in the 
❻ Entry # box.

• Click on the ❼ Coach/Team tab.
• Click on the ❽ Team drop-down arrow and 

select the team name from the list by clicking on 
the team name.  

SECTION IX. TIPS & TRICKS

STEP 2. ENTER ENTRIES IN TEAMS:

Each entry that is part of a team must be designated as a member of the team. 

9
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Managing Teams > Step 3. Team Roster Report

The FVD program provides a listing of teams 
and the members of each team.

• Select  ❶Main Menu > ❷ Reports > 
❸ During-Show > ❹ Team Roster 
Report.

• The ❺ Team Roster Report 
opens.

• The report contains:
o ❻ Team name
o ❼ Entry # for each Horse/ 

Rider combination
o ❽ Horse name
o ❾ Rider name

SECTION IX. TIPS & TRICKS

5

6 7 8 9

STEP 3. TEAM ROSTER REPORT:
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Managing Teams > Step 4. Scoring Teams, Step 5. Determine Team Place

SECTION IX. TIPS & TRICKS

STEP 5. DETERMINE TEAM PLACE: 1

2

3

• Select ❶ Main Menu > ❷ Scoring. 
• Using the ❸ Class (Lookup) drop-down or type-

in box, select the first class of the combination for 
which you desire a report.

• Click the ❹ Special Score Reports button.

• The ❹ Special Score Reports form opens.
• Select the ❺ Team tab.
• Select the ❻ Team Report button.

4

5

6

• Each individual in the class is scored in the regular manner (see SCORING).  

STEP 4. SCORING TEAMS:

Continued on next page…
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Managing Teams > Step 5. Determine Team Place, Cont’d.

SECTION IX. TIPS & TRICKS

• The ❼ Team Score report opens.
• In the report, the rides are grouped by ❽ Team, then by ❾ FINAL PERCENT (high to low for each ride) 

within each team.
• Each team’s ❿ FINAL POINTS and ⓫ FINAL PERCENT are listed.  
• On this report the teams are NOT ordered by place – that is done with Special Score Reports > Team > 

Place Team (see next page).  Look at the team ⓫ FINAL PERCENTS to determine the highest team 
percentage (1st place), next highest percentage (2nd place), etc.  In this example, Team B is 1st and Team A 
is 2nd.  Make a note of the placings or write them on your report print-out.

• If desired, click ⓬ Print to print the report.
• Click ⓭ Close Print Preview to close the report.

7

8

9

8

9

10 11

12

13

10 11

Continued on next page…
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Managing Teams > Step 6. Place Teams

• The ❹ Team form opens.
• Using the ❺ Team (Lookup) drop-down arrow 

or type-in box, select the ❻ first team to be 
placed.

• Using the team placings determined on the 
previous page, enter the ❼ Place for each team.

• When you are finished, click ❽ Close to save 
your changes, which returns you to the ❶
Special Score Reports form.

• On the ❶ Special Score Reports form, click ❾
Close to close the report and return to the Main 
Menu > Scoring.

SECTION IX. TIPS & TRICKS

4

5

6
7

8

NOTE: There is no final report with team placings.  Use 
the Team Score Report with handwritten placings.

• You are returned to the ❶ Special Score 
Reports form.

• Select the ❷ Team tab.
• Select the ❸ Place Team button.

9

1

2

3

STEP 6. PLACE TEAMS:
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SECTION IX. TIPS & TRICKS
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Reports in the Show Program > List, 1. Class Schedule - Judge Assignment Report

FVD reports may be used in your show program.  The following reports are often in show programs:
1. Class Schedule - Judge Assignment Report
2. Judge Schedule
3. Day Sheets (Standard or CDI)
4. Show Roster Report (by Entry #)
5. Show Roster Report (by Rider’s Name)

• Select ❶Main Menu > ❷ Reports > 
❸ During Show > ❹ Class Schedule -
Judge Assignment.  

• The report provides a listing, by ring, of 
each class, the time, the duration, the 
class number and name, and the judge(s).

• See Reports > During-Show > Class 
Schedule - Judge Assignment Report for 
more information.

SECTION IX. TIPS & TRICKS

NOTE:  To include a report in your Show Program, save the report as an editable Word file (see Print Preview > 
Export > Word) or as a *.pdf file (see Print Preview > Export > PDF or XPS).

1. CLASS SCHEDULE – JUDGE ASSIGNMENT REPORT:

LIST:
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Reports in the Show Program > 2. Judge Schedule Report

• Select ❶Main Menu > ❷ Reports > 
❸ During Show > ❹ Judge Schedule 
Report.  

• The report provides a listing, by ring, of 
each class, the time, the duration, the 
class number and name, and the judge(s).

• See Judge Schedule Report. for more 
information.

SECTION IX. TIPS & TRICKS

2. JUDGE SCHEDULE REPORT:

• Because of its vertical orientation, some 
shows prefer the Judge Schedule Report 
instead of the Class Schedule – Judge 
Assignment Report.

NOTE:  To include a report in 
your Show Program, save the 
report as an editable Word 
file (see Print Preview > 
Export > Word) or as a *.pdf 
file (see Print Preview > 
Export > PDF or XPS).
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Reports in the Show Program > 3. Day Sheets Standard Report

• Select ❶Main Menu > ❷ Reports > 
❸ During-Show > ❹ Day Sheets 
Standard.  

• The report provides the Show Schedule, 
sorted by Day then by Ring #, then by 
ride Time.

• See Day Sheets Standard Report for more 
information.

SECTION IX. TIPS & TRICKS

NOTE:  To include a report in your Show Program, save the report as an editable Word file (see Print Preview > 
Export > Word) or as a *.pdf file (see Print Preview > Export > PDF or XPS).

3. DAY SHEETS STANDARD REPORT: 1

2

3
4

NOTE: For a CDI, use the Day Sheets CDI Report.
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Reports in the Show Program > 4. Show Roster (by Entry #)

• Select ❶Main Menu > ❷ Reports > 
❸ During Show > ❹ Show Roster.  

• The ❺ Show Roster report opens.
• Select ❻ Report Style > ❼ By Entry #.
• Click ❽ OK.

SECTION IX. TIPS & TRICKS

4. SHOW ROSTER (BY ENTRY #):

NOTE:  To include a report in 
your Show Program, save the 
report as an editable Word file 
(see Print Preview > Export > 
Word) or as a *.pdf file (see 
Print Preview > Export > PDF 
or XPS).

1

2

3

4

5

6
7

8

• The report lists the entries, by 
Entry #.

• See Show Roster (by Entry #)
for more information.
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Reports in the Show Program > 5. Show Roster (by Rider)

SECTION IX. TIPS & TRICKS

5. SHOW ROSTER (BY RIDER):

NOTE:  To include a report in 
your Show Program, save the 
report as an editable Word file 
(see Print Preview > Export > 
Word) or as a *.pdf file (see 
Print Preview > Export > PDF 
or XPS).

• The report lists the entries 
alphabetically, by the rider’s 
last name.

• See Show Roster (by Rider) for 
more information.

5

6

7

8

• Select ❶Main Menu > ❷ Reports > 
❸ During Show > ❹ Show Roster.  

• The ❺ Show Roster report opens.
• Select ❻ Report Style > ❼ By Rider.
• Click ❽ OK.

1

2

3

4
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SECTION IX. TIPS & TRICKS
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FVD reports may be posted on your web site.  The following reports are often posted:
1. Rider’s Schedule Report
2. Total Stable Report
3. Day Sheets (Standard or CDI)

827

Reports for Web Site Posting > List, 1. Rider’s Schedule Report

• Select ❶ Main Menu > ❷ Reports > 
❸ During Show > ❹ Rider’s Schedule.  

SECTION IX. TIPS & TRICKS

NOTE:  To include a report 
on your web site, save the 
report as an editable Word 
file (see Print Preview > 
Export > Word) or as a 
*.pdf file (see Print Preview 
> Export > PDF or XPS).  For 
a web site, a *.pdf file is 
better.

1. RIDER’S SCHEDULE REPORT:

1

2

3

4

LIST:

• The report provides an 
alphabetical list of riders with 
their rides, in order by day 
then by time.

• See Rider’s Schedule for more 
information.
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Reports for Web Site Posting > 2. Total Stable Report

• Select ❶Main Menu > ❷ Reports > 
❸ During Show > ❹ Total Stable.  

SECTION IX. TIPS & TRICKS

NOTE 1:  Some shows do not 
release stall numbers prior to 
the show.  Instead, they 
provide stall numbers when the 
competitor registers at the 
Show Office.  This avoids the 
unloading of horses for which a 
current Coggins and/or Proof 
of Vaccination has not yet been 
submitted.
NOTE 2: It is recommended 
that the Show Program and/or 
the rider packets also include a 
map of the facility, including 
the barn names and stall 
numbers, so riders can locate 
their stalls.
NOTE 3:  See MAKE A STALL 
LIST FROM DATA EXPORTED 
TO EXCEL for information on 
how to create a stable report 
sorted by stall number, horse 
name, and rider last name.  
You may prefer this report for 
posting on a web site and 
sending to riders.
NOTE 4:  To include a report on 
your web site, save the report 
as an editable Word file (see 
Print Preview > Export > Word) 
or as a *.pdf file (see Print 
Preview > Export > PDF or XPS).  
For a web site, a *.pdf file is 
better.

2. TOTAL STABLE REPORT:

5

6
5

• The report provides a list sorted by ❺
Stall Group (first it lists horses w/o a stall 
group, then it lists horses alphabetically 
by stall group), then by ❻ Entry #.  

• See STABLING for more information on 
stabling.



Fox Village Dressage User Manual – 2021 Update 1.0.5. helpdesk@foxvillage.com                 www.foxvillage.com829

Reports for Web Site Posting > 3. Day Sheets Standard Report

SECTION IX. TIPS & TRICKS

• Select ❶Main Menu > ❷ Reports > 
❸ During-Show > ❹ Day Sheets 
Standard.  

• The ❺ Day Sheets form opens.
• To obtain a report for the entire show, do 

not enter a ❻ Date.
• Click ❼ OK.

NOTE: For a CDI, use the Day Sheets CDI.

3. DAY SHEETS STANDARD REPORT:

NOTE:  To include a report 
on your web site, save the 
report as an editable Word 
file (see Print Preview > 
Export > Word) or as a 
*.pdf file (see Print Preview 
> Export > PDF or XPS).  For 
a web site, a *.pdf file is 
better.

1

2

3 4

• The report provides the Show 
Schedule, sorted by ❺ Day
then by ❻ Ring #, then by ride 
❼ [Ride] Time.

• See Day Sheets Standard Report
for more information.

5

6

7

56
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##:## AM
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SECTION IX. TIPS & TRICKS
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Make a Stall List from Data Exported to Excel > Introduction, 
Step 1. Export Entry Fees to Excel

• Stabling is covered in STABLING.
• FVD provides the following [horse] stabling / tack stall reports:
o Stable Reports - [Horse] Stabling Report (see Reports > During-Show > Stable  > Stabling Report)
o Stable Reports - Tack Stall Report (see Reports > During-Show > Stable > Tack Stall Report).
o Total Stable Report (see Reports > During-Show > Total Stable).

• All of these reports are sorted first by Stall Group, then by Entry #.  If you have a person in the show 
office looking for a stall assignment, using these lists can be cumbersome, particularly since people will 
usually not know the Stall Group Name you used in FVD.  Therefore, another method to report stall 
numbers is useful.

• You may have a stall listing separate from FVD.  If that is the case, use your list to give riders their stall 
assignments, post the list, etc.

• If you do not have a stall listing separate from FVD and/or you want a stall listing from FVD data, you can 
generate a list using FVD data exported to MS Excel.  

• The following explanation assumes you have MS Excel and a working knowledge of the program.

SECTION IX. TIPS & TRICKS

• Select ❶Main Menu > ❷ Show Office 
> ❸ Export Utility.

• The ❹ Export Utility form opens.
• Using the ❺ drop-down arrow (or type-in box), 

select ❻ Entry Fees.

• Click ❼ OK.

1

2

3

4

5

6

7

6

Continued on next page…

INTRODUCTION:

STEP 1. EXPORT ENTRY FEES TO EXCEL:
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Make a Stall List from Data Exported to Excel > Step 1. Export Entry Fees to Excel, Cont’d.

SECTION IX. TIPS & TRICKS

• The ❽ New MS Excel File form opens in your ❾ FVD folder.
• In the ❿ File name: box, type in the name for your file.  Use a name that will readily identify the file 

source and contents.  In this example, 2020-BHF-StallList was used.  FVD automatically enters the .xls
extension.

• Click ⓫ Save.

• A ⓬ Fox Village Dressage form opens, letting 
you know the file was saved successfully.

• Click ⓭ OK.

8

9

10

11

12

13
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Make a Stall List from Data Exported to Excel > Step 2. Open the Excel File

STEP 2. OPEN THE EXCEL FILE:

• Navigate to your ❶ FVD folder.
• Open the ❷ Excel file by double-clicking on 

the file name.

SECTION IX. TIPS & TRICKS

• The ❸ Excel file opens.
• It contains the following fields:
o ❹ Entry #
o ❺ Horse [Name]
o ❻ Rider First [Name]
o ❼ Rider Last [Name]
o ❽ [Fee] Description 
o ❾ Rate
o ❿ Quantity
o ⓫ Total
o ⓬ Stall [#]

2

1

4 5 6 7 8 9

3

10 11 12
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Make a Stall List from Data Exported to Excel > Step 3. Delete Unneeded Columns

SECTION IX. TIPS & TRICKS

STEP 3. DELETE UNNEEDED COLUMNS:

• Place your cursor over the gray area and right click.
• In the menu that opens, click ❸ Delete.

• The unneeded columns (Rate, 
Quantity and Total) have been deleted 
and ❹ Stall is now column F.

• You only need:
o Entry #
o Horse
o Rider First Name
o Rider Last Name
o Description
o Stall

• To delete the unneeded columns 
(Rate, Quantity and Total):
o Click ❶ F.
o Depress and hold the left mouse 

button.
o Drag your cursor across ❷ G and 

H.  
o Release the left mouse button.
o Columns F, G and H are now gray in 

color.

3

21

4

NOTE: If you do not want your stall list to include 
the Description, delete this column also.
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Make a Stall List from Data Exported to Excel > Step 4. Sort the Data by Stall Number
STEP 4. SORT THE DATA BY STALL NUMBER:

SECTION IX. TIPS & TRICKS

• The ❹ Sort form opens.
• If not checked, check the ❺ My data has 

headers box.
• Click the ❻ Sort by down arrow and select 
❼ Stall. 

• If not already selected, use the ❽ Order
drop-down arrow and select ❾ A to Z.

• Click ❿ OK.

• The spreadsheet is now sorted in ascending 
order by ⓫ Stall number so entries with a 
stall are at the top of the spreadsheet.

• Entries ⓬ without a stall are at the bottom 
of the spreadsheet.

1

2

3

• To select all cells in 
the workbook, 
click the ❶
box at the top left 
of the 
spreadsheet.  The 
color of the 
spreadsheet will 
change to gray.

• Select ❷ Sort & 
Filter > ❸ Custom 
Sort.

4
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5

8
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Make a Stall List from Data Exported to Excel > Step 5. Delete Rows Without Stall Numbers

STEP 5. DELETE ROWS WITHOUT STALL NUMBERS:

SECTION IX. TIPS & TRICKS

• Scroll down the spreadsheet 
until there are ❶ rows with no 
stall numbers listed.  

• Click on the first row without a 
stall # (row 28 in this example), 
press the left mouse button, 
scroll down until there is no 
more data on the spreadsheet, 
then release the mouse button.  
This selects all the rows without 
stall numbers. 

• Every ❹ row on the 
spreadsheet now has a stall 
number.

• You now have an Excel 
workbook that is your stall list.  
You can sort by Entry #, Horse 
Name, Rider Last Name, and 
Stall Number. 

• If desired, bold the title row so 
the titles stand out.

• Click ❺ Save to save the file. 

• To delete the selected rows, 
with the cursor over the gray 
area, right click. 

• From the ❷ menu that drops 
down, click ❸ Delete.

2

3

1

4

5

NOTE: This is a good time to double check to ensure you have not assigned a stall more than one time.  If you have 
a duplicate entry, go to STABLING to make corrections.
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Make a Stall List from Data Exported to Excel > Step 6. Create Separate Sorted Lists > 
Copy the Spreadsheet

STEP 6. CREATE SEPARATE SORTED LISTS > COPY THE SPREADSHEET:

SECTION IX. TIPS & TRICKS

• Since the first spreadsheet was 
sorted by stall number, rename 
the spreadsheet to reflect the 
sort.  In this example, we will 
call it StallNumberSort.

• With your cursor over the ❶
spreadsheet name, right click.

• From the menu that opens, click 
❷ Rename.

• The ❸ spreadsheet name will 
have a gray background.

• Type the ❹ new name for the 
spreadsheet.

• Next you make a copy of the 
spreadsheet.

• With your cursor over the 
spreadsheet name, right click.

• From the menu that opens, 
click ❺ Move or Copy.

• The ❻ Move or Copy form 
opens.

• Select ❼ (move to end).
• Check the ❽ Create a copy 

check box.
• Click ❾ OK.

6

7

8
9

• You now have a ❿
StallNumberSort (2), which is a 
copy of the original spreadsheet.

• Rename it, perhaps 
RiderLnameSort.

1

2
3

4

5

10
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Make a Stall List from Data Exported to Excel > Step 6. Create Separate Sorted Lists > 
Sort the New Spreadsheet

SECTION IX. TIPS & TRICKS

• To select all cells in the 
workbook, click the ❶ box at 
the top left of the 
spreadsheet.  The color of the 
spreadsheet will change to 
gray.

• Select ❷ Sort & Filter > ❸
Custom Sort.

• The ❹ Sort form opens.
• If not checked, check the ❺

My data has headers box.
• Click the ❻ Sort by down 

arrow and select ❼ Rider 
Last Name. 

• Click ❽ OK.

• The RiderLnameSort
spreadsheet is now sorted by 
❾ Rider Last Name.

• Repeat the above to create a 
spreadsheet sorted by ❿
Horse (HorseNameSort).

• Format each spreadsheet with 
header, footer, etc. (see a MS 
Excel manual).

• Print the spreadsheets for use 
by the stall manger, etc.

• If desired, save one or more 
spreadsheets as PDF files for 
distribution to riders.

STEP 6. CREATE SEPARATE SORTED LISTS > SORT THE NEW SPREADSHEET:

4

5

6

7

8

31
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SECTION IX. TIPS & TRICKS
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Make Large-Sized Results Posters

SECTION IX. TIPS & TRICKS

• Select ❶Main Menu > ❷ Reports > 
❸ During-Show > ❹ Handwritten 
Score Sheets. 

• The ❺ Handwritten Score Sheets report 
opens.

• Click ❻ Print to print the report.
• Alternately, save the report as a PDF file 

(see Print Preview > Export > PDF or XPS > 
Save Options)

• Click ❼ Close Print Preview to close the 
report.

• Take the print-out (or email the file) to your local office supply store / printing store to print them onto 
11” x 17” paper.  If you use self-serve, you will save some money.

• Some shows, particularly those that are not using FVD during the show, may need a large size results 
poster.  This procedure provides a technique.

1

2

3

4

5

6

7
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SECTION IX. TIPS & TRICKS
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• An increasing occurrence in dressage shows is to hold two one-day shows over a weekend.  The first 
show is on Saturday and the second show is on Sunday.  The venue for the shows is the same.  This 
allows riders to obtain qualifying scores for two shows by attending one venue in one weekend.

• When you open FVD using FVD.accde you can only open one show at a time; therefore, show secretarial 
duties could be difficult for two shows.  But there is an easy work-around!  Access can open two 
different database files at the same time, such as FVD.accde and FVD1.accde, each of which can open a 
different show file.

842

Working on Two (or More) Shows at the Same Time

SECTION IX. TIPS & TRICKS

• Navigate to the C: > Users > [UserName] > 
Documents > FVD.  

• In the example, we have two show files:
o ❶ XXXX-BHD1-Show.sdf
o ❷ XXXX-BHD2-Show.sdf

• In the example, there is one FVD file:
o ❸ FVD.accde

• You want to open both shows at the same time.  
• To do this, make a second copy of ❸

FVD.accde, giving the second copy a different 
name, such as ❺ FVD2.accde.  (In this example, 
the original FVD.accde was renamed to ❹
FVD1.accde.)

1

2

3

5

4

XXXX-BHD-HR.hdf

XXXX-BHD1-Show.sdf

XXXX-BHD-Test.tdf

XXXX-BHD-2-Show.sdf

XXXX-BHD-StallList.xls

XXXX-BHD-HR.hdf

XXXX-BHD1-Show.sdf

XXXX-BHD-Test.tdf

XXXX-BHD-2-Show.sdf

XXXX-BHD-StallList.xls
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Working on Two (or More) Shows at the Same Time, cont’d.

SECTION IX. TIPS & TRICKS

• For show 1, double click ❹ FVD1.accde to open the 
program with this file.

• Open ❶ 2020-BHD1-Show.sdf in the usual manner, 
including linking the HR.hdf and Test.tdf files.

• For show 2, double click ❺ FVD2.accde to open the 
program with this file.

• Open ❷ 2020-BHD2-Show.sdf in the usual manner, 
including linking the HR.hdf and Test.tdf files.

1

4

XXXX-BHD-HR.hdf

XXXX-BHD1-Show.sdf

XXXX-BHD-Test.tdf

XXXX-BHD-2-Show.sdf

XXXX-BHD-StallList.xls

5

2

XXXX-BHD-HR.hdf

XXXX-BHD1-Show.sdf

XXXX-BHD-Test.tdf

XXXX-BHD-2-Show.sdf

XXXX-BHD-StallList.xls
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Working on Two (or More) Shows at the Same Time, cont’d.

SECTION IX. TIPS & TRICKS

• You now have two shows open and can enter information in each show without having to close the other 
show.

• The following image shows two shows open on a 27” monitor.

• If you are using a laptop, you may want to get a second monitor that is connected to the laptop so one 
show is viewed on the laptop monitor and the other show is viewed on the separate monitor.  

• I use two separate monitors connected to the laptop.  Each show is on a separate monitor and other 
work is done on the laptop monitor.

SHOW 1 SHOW 2OTHER WORK

XXXX Blue Horse Dressage 1 XXXX Blue Horse Dressage 2
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SECTION IX. TIPS & TRICKS
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• Scheduling is covered at SCHEDULING.  Assigning ride times is covered at Assign Ride Times.
• When you assign ride times, you open a form for each class.  FVD allows you to open eight of these class 

forms at one time.
• If you have multiple small classes in a ring, you may have many more than eight that you need to 

schedule in succession.
• It is a bit cumbersome (and is prone to errors) to open the first eight classes, schedule them, close them, 

open and schedule the next group of classes, etc.
• Instead, you can open two copies of the FVD.accde file, then open the show file (*.sdf) in both copies of 

the FVD.accde file.

846

Open Two Copies of One Show for Scheduling

SECTION IX. TIPS & TRICKS

• In this example, the following files are opened:
o ❶ FVD1.accde
o ❷ FVD2.accde

• Then ❸ 2020-BHD1-Show.sdf is opened in both 
FVD.accde files.

• After you open the show file in each copy of 
FVD.accde, ensure you repair all links.

• Perform Assign Ride Times in the usual manner, 
opening the first group of classes in a ring in one 
FVD.accde file and the other group of classes in 
the same ring in the other FVD.accde file.

• In this example, all 13 classes in Ring 1 can be viewed at once.  This makes scheduling them MUCH 
MUCH easier!

2

1

3

FVD1.accde
2020-BHD1-Show.sdf
Ring 1 has 13 classes
Classes 1-8 in Ring 1

FVD2.accde
2020-BHD1-Show.sdf
Ring 1 has 13 classes
Classes 9-13 in Ring 1

XXXX-BHD-HR.hdf

XXXX-BHD1-Show.sdf

XXXX-BHD-Test.tdf

XXXX-BHD-2-Show.sdf

XXXX-BHD-StallList.xls
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THE END

847

This is the end of the Fox Village Dressage User Manual.  I hope it has helped make your experience 
with the software positive and has contributed to many fun and successful dressage shows.  If you 
have discovered any errors, omissions, etc., please report them to the Fox Village Dressage 
Developers at info@foxvillage.com.  They will report any needed changes to me.

Happy showing,  Leslie Raulin

mailto:info@foxvillage.com
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